
Navigating the Cary Eclipse Online Help
<< Home | Next >> 

The Cary Eclipse Help system is designed for easy navigation.  The idea is that you can find what you are after quickly and efficiently. 

So how is this achieved? 

Table of Contents Tab 

1. Contents tab (Table of Contents) 4. Plus / Minus sign
2. Search tab 5. Contents pane
3. Favorites tab

1. Contents tab (Table of Contents)

Use the Table of Contents to view the titles of the help topics. Topics are grouped together into categories to make navigation simpler.

2. Search tab

The 'Search' and 'Search within Search' features enable you to locate very specific information. You can 
refine a search further by using the 'Search within Search' feature. This feature enables you to search 
only within the results of your initial search - e.g. If you search for 'Cuvettes', you can then select 'Search 
within Search' and search only in the results are displayed in the initial 'Cuvettes' search. 

3. Favorites tab

If you are having repeated problems performing a particular task, you can store the link to that topic in the 
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See Also 

Favorites section.   This means that you can quickly go to the Favorites list next time you want to use that 
section of the Help, rather they browsing through the table of contents or using the Search mode. 

4. Plus / Minus sign

Click on the plus signs to expand a branch.  Click on the minus signs to collapse a branch.

5. Contents pane

When you click on a topic, the contents of that file will appear in the Contents pane.
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Multimedia 
<< Back | Next >> 

Multimedia Help 

The Multimedia Help system provides animated help. 

Video Clips 

Sound and vision reinforce the text based information contained within the help system.  Look for the video icon that appears throughout the help 
system. 

These video and animation sequences aid in: 

highlighting problem areas associated with installing particular accessories  
providing information about the location of important accessory and instrument components 
make the installation of accessories a quicker and more efficient process  

Trouble shooting 

If you are having troubles then check the following: 

The CD-ROM labeled "Help & Videos" is in your CD drive. 
You installed all of the video drivers and codecs when you installed Windows. 

See Also 

Help on the Varian Video Player application 

Video icon 
Whenever you see a video icon such as the one adjacent, it indicates that a video is available. 
You can click on these icons to run videos.
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Screen Resolution 
<< Back | Next >> 

For optimum viewing of the Cary Eclipse software and help your monitor resolution should be set to 800 x 600 
pixels (or greater) and High colour (16 bit) (or greater). 16 or 256 color setting may not display the video and 
multimedia correctly, 

To set the monitor resolution: 

Step 1 

Click the Windows Start button, point to Settings and then select Control Panel. The Control Panel window is 
displayed. 

Step 2 

Double-click on the Display icon to access the Display Properties dialog. 

Step 3 

From the Display Properties dialog, select the Settings tab. 

Step 4 

In the Desktop area section, drag the sliding bar so that the pixel amount is set to 800 x 600 pixels (or higher). 

Step 5 

In the Color palette section select High color (16 bit). 

Step 6 

Select OK. At the prompt, which informs you that your settings will be adjusted, select OK again. When asked if 
you wish to keep the setting, select Yes. 

Step 7 

You can then exit the Display Properties dialog and the Control Panel window. 



Software Applications 
<< Back | Next >> 

Help is available for all of the Cary Eclipse Software applications.  You can press F1 from within an application at 
any time to display the online help system for that application. Alternatively, click the Help button if available or 
select Help from the main menu. 

Multimedia Video Tour 

For a multimedia tour of all the Cary Eclipse Software applications and what they can do for you, click on the 
button below. 

Further Reading 

What is the purpose of each Cary Eclipse application? 

Each application that comes with the Cary Eclipse software has a section of the online help system devoted to it. 
If you would like to go to the help section of a specific application, click on the name of that application below. 

The application help guides you through the user interface and explains how different fields control different 
instrument, accessory and software parameters. 

ADL Shell Lifetimes
Advanced Reads Scan
Align Simple Reads
Concentration System Information
GLP Administration Validate
Kinetics

Note 
By going to a section of the software you are having problems with and pressing F1 — you can get help 
related specifically to that part of the software.
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Help System Icons 
<< Back | Next >> 

Look out for 'Tips', 'Notes' and 'See also' icons throughout the help system.  The 'Tips', 'Notes' and 'See also(s)' provide you with or link you to useful 
information that will allow you to complete various tasks with less effort, more efficiency and less chance of you damaging your equipment but more 
importantly — ensuring that things are done safely.  

These are the icons that represent 'Tips', 'Notes' and 'See also': 

By following 'Tips' and 'Notes' and reading the 'See also' links, you will become a better Cary Eclipse user.

Tips

Notes

See also
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Printing 
<< Back | Back to Start >> 

Single-page print (right-click for the options menu) 

Right-click on the page you wish to print.  The following menu is displayed. 

Select Print... from the menu.  The Print options window is displayed.
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Select the printer and print options and click OK to print. 

Multi-page print (right-click on the Table of Contents) 

Right-click on the Table of Contents. The following window is displayed. 

Select Print... from the menu.  The following window is displayed.

Page 2 of 4Printing



Select Print the selected topic if you only wish to print the topic that is displayed.  Select Print the selected 
heading and all subtopics if you wish to print all of the topics that come under the Table of Contents folder or 
topic that is currently open. Click on OK, to display the Print options window, as shown below. 

Select the printer and print options and click OK to print the topics. 
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Send away to Varian for a printed manual 

If you want a complete printed version of the Cary Eclipse Online Help system, e-mail us at 
fluorescence@varianinc.com. 
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About Safety 
<< Home | Next >> 

Your Varian Cary Eclipse instrument and accessories have been carefully designed so that when used properly 
you have an accurate, fast, flexible and safe analytical system. 

If the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment 
may be impaired. 

Information on safety practices appears throughout the documentation (both hard copy and online) provided with 
your instrument and accessories. Before using the instrument or accessories, you must thoroughly read these 
safety practices. 

Observe all relevant safety practices at all times.
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Lamp module 
<< Back | Next >> 

The lamp is enclosed in a self-contained module. This module contains components operating at high voltages. 
To avoid electric shock, NEVER disassemble the module. 

When operating, the lamp module emits high intensity visible and UV radiation which can cause serious damage 
to eyes. To avoid eye damage, never operate the lamp outside the instrument. 

See also: 
Safety Home Page
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Ultraviolet radiation 
<< Back | Next >> 

Hazardous UV radiation is emitted by the Xe flash lamp in the instrument. This radiation can cause serious 
damage to eyes. NEVER look directly at the UV source lamp. ALWAYS wear safety glasses manufactured to an 
approved standard and which are certified or otherwise warranted to protect the eyes from UV radiation when the 
lamp is operating and the sample compartment is open. 

See also: 
Safety Home Page
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Panels, covers and modules 
<< Back | Next >> 

You are permitted to remove the top colored cover to: 

- Replace the lamp module

- Adjust the lamp module

Any other panels or covers, which are retained by screws on the spectrophotometer and accessories, may be 
opened ONLY by Varian-trained, Varian-qualified, or Varian-approved service engineers. Consult the manuals or 
product labels supplied with your PC, monitor and printer/plotter to determine which parts are operator-accessible.

Operators and other unauthorized personnel are permitted access ONLY to the lamp module and the sample 
compartment of the Cary Eclipse. ALWAYS switch off the instrument and disconnect the mains cord before 
changing a lamp module. 

See also: 
Safety Home Page
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Other precautions 
<< Back | Next >> 

The lamp module operates at a high temperature, and touching it may result in burns. Before replacing a lamp 
module that has been operating, switch off the Cary Eclipse and ensure that the lamp module has cooled, or 
protect your fingers from burns. 

Do not block the ventilation grills on the spectrophotometer and accessories. Consult the manuals supplied with 
your PC, monitor and printer/plotter for their specific ventilation requirements. 

Use of the Cary Eclipse system and accessories may involve materials, solvents and solutions, which are 
flammable, corrosive, toxic or otherwise hazardous. 

Careless, improper, or unskilled use of such materials, solvents and solutions can create explosion hazards, fire 
hazards, toxicity and other hazards which can result in death, serious personal injury, and damage to equipment 
and property. 

ALWAYS ensure that laboratory safety practices governing the use, handling and disposal of such materials are 
strictly observed. These safety practices should include the wearing of appropriate safety clothing and safety 
glasses. 

See also: 
Safety Home Page
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Warnings and Cautions 
<< Back | Next >> 

Specific warnings and cautions appear in the online Help where appropriate, and these: 

detail the specific hazard;  
describe how to avoid it;  
specify the possible consequences of not heeding the warning or caution. 

A ‘Note’ is used to give advice or information.  

Read all warnings and cautions carefully and observe them at all times. 

Warning A ‘Warning’ message appears in the Help when failure to observe instructions or precautions could 
result in death or injury. Symbols depicting the nature of the specific hazard are also placed 
alongside warnings. 

Caution A ‘Caution’ message is used when failure to observe instructions could result in damage to 
equipment (Varian supplied and/or associated equipment).

See also: 
Safety Home Page
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Warning symbols 
<< Back | Next >> 

A triangular symbol indicates a warning. The meanings of the symbols that may appear alongside warnings in the 
documentation are as follows: 

Electrical shock Eye hazard

Noxious gases Hot surfaces and cryogenic 
temperatures

Fire hazard Sharp edges

Corrosive liquids Moving part

Heavy weight  
(danger to feet) 

Heavy weight 
(danger to hands) 

Part can be ejected

The following symbol may be used on warning labels attached to the 
instrument. When you see this symbol you must refer to the relevant 
operation or service manual for the correct procedure referred to by that 
warning label.

See also: 
Safety Home Page
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Color coding 
<< Back | Next >> 

The indicator light appearing on the Cary Eclipse instrument has been color coded to represent the status of the 
instrument or accessory:  

Steady green - normal / standby

Flashing green - scanning / reading

Steady orange - start up

Flashing orange - a problem, may require servicing

Steady yellow - firmware initialization

See also: 
Safety Home Page
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Information Symbols 
<< Back | Next >> 

The following symbols appear on the Cary Eclipse to provide you with additional information: 

Mains power on

Mains power off

Fuse

Single phase alternating current

When attached to the rear of the product, indicates that the product complies with the 
requirements of one or more EU Directives

Focus

Horizontal movement

Vertical movement

Attached to the rear of the product, and indicates that the product has been certified 
(evaluated) to CAN/CSA –C22.2 No 1010.1-92 and VL3101-1.

See also: 
Safety Home Page
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FCC advisory 
<< Back | Next >> 

The following is a Federal Communications Commission advisory: 

Caution This equipment generates, uses, and can radiate radio frequency energy and if not installed 
and operated in accordance with the instruction manual, may cause interference to radio 
communications. It has been tested and found to comply with the limits for a Class A 
computing device pursuant to Subpart J of Part 15 of FCC Rules, which are designed to 
provide reasonable protection against such interference when operated in a commercial 
environment. Operation of this equipment in a residential area may cause interference in 
which case the user at his or her own expense will be required to take whatever measures 
may be required to correct the interference. 

See also: 
Safety Home Page
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CE compliant products 
<< Back | Home >> 

Cary Eclipse instruments have been designed to comply with the requirements of the Electro-magnetic 
Compatibility (EMC) Directive and the Low Voltage (electrical safety) Directive (commonly referred to as the LVD) 
of the European Union. 

Varian has confirmed that each product complies with the relevant Directives by testing a prototype against the 
prescribed EN (European Norm) standards. 

Proof that a product complies with the Directives is indicated by: 

the CE Marking appearing on the rear of the product  
the documentation package that accompanies the product containing a copy of the Declaration of Conformity. 
This Declaration is the legal declaration by Varian that the product complies with the Directives, and also 
shows the EN standards to which the product was tested to demonstrate compliance.   

It is also signed by Varian's Authorized Representative in the EU, and by the representative of the manufacturing 
plant. 
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About your Cary Eclipse Instrument 

Overview 

The Cary Eclipse fluorescence spectrophotometer is ideal for routine laboratory work and offers high performance 
and advanced design features.  The instrument consists of two Czerny-Turner monochromators (excitation and 
emission), a Xenon light source, a range of fixed width selectable slits, selectable filters, attenuators and two 
photomultiplier tubes as detectors.  

Other design features include:  

A large sample compartment
Quartz overcoating—to protect the optics
A small footprint—to save bench space
Schwarzchild collection optics
A horizontal beam— less than 0.5mL needed for measurement.

All of these features combine to provide you with an instrument that is fast and efficient. 

Xenon flash lamp and Schwartzchild collection optics 

Cary Eclipse Optics - full cutaway of the Cary Eclipse. 

Multimedia 

The Schwartzchild collector mirrors collect 
the light energy from the Xenon Flash Lamp 
module. This light is then focused through a 
lens onto the excitation entry slit. 

The Xenon flash lamp flashes at a rate of up 
to 80 flashes per second and has a pulse 
width of approximately 2 to 3 microseconds. 

The Xenon lamp has a long lamp life which 
also means that you will have less downtime 
and greater productivity.  
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Cary Eclipse Optics tour

Cary Eclipse Cutaway tour

See also: 
Cary Eclipse Specifications 
Cary Eclipse Optics 
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Diagram of the Cary Eclipse Optics 

See also: 
Overview 
Cary Eclipse Specifications
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Specifications 

Source lamp
Beam arrangement
Excitation monochromator
Emission monochromator
Sample compartment

Source lamp

   Beam arrangement 

   Excitation monochromator 

Lamp Full spectrum 15W Xenon pulse lamp

Pulse width 2-3us

Power 60-75kW

Beam Splitter 92% - 8%

Detectors Photomultiplier (X2)

Reflective surfaces are designed for constant focus at 
all wavelengths and are quartz overcoated for high 
performance and corrosion resistance.

Type Czerny–Turner

Dispersing method Grating, 30 x 35 mm, 1200 lines/mm

Blaze angle 370 nm

Spectral bandwidths 1.5 nm 
2.5 nm 
5.0 nm 
10  nm 
20  nm 
10  nm round

Filters Selectable 
Open 
Closed 
250 - 395 nm      UG5 
335 - 620 nm      BG38 
550 - 1100 nm    OG550 
695 - 1100 nm    RG695 
Auto

Reciprocated Linear dispersion 3 mm/mm

Wavelength range 190 to 900 nm

Accuracy ±1.0 nm, ( ±0.5 nm at 541.92 nm)

Wavelength repeatability ±0.2 nm

Wavelength drive Software controlled motor drive. 
Non measurement phase stepping.
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   Emission monochromator 

Sample compartment 

Maximum Slew rate 24,000 nm/min

Maximum Scan rate 24,000 nm/min

Type Czerny–Turner

Dispersing method Grating, 30 x 35 mm, 1200 lines/mm

Blaze angle 440 nm

Spectral bandwidths Selectable fixed width at 

1.5 nm 
2.5 nm 
5.0 nm 
10  nm 
20  nm and 
10  nm round 

Filters Selectable 

Open 
Closed 
250 - 395   nm   UG5, 
295 - 1100 nm  WG295, 
360 - 1100 nm  9086, 
430 - 1100 nm  GG435 
550 - 1100 nm  OG550 
3%T attenuator    Mesh (1.5 Abs) 
Auto. 

Reciprocated Linear dispersion 3 mm/mm

Wavelength range 190 to 900 nm

Accuracy ±1.0 nm, ( ±0.5 nm at 541.92 nm)

Wavelength repeatability ±0.2 nm

Wavelength drive Software controlled motor drive. 
Non measurement phase stepping.

Maximum Slew rate 24,000 nm/min

Maximum Scan rate 24,000 nm/min

Dimensions 198 x 273 x 205mm (WxDxH)

Access Front and top

See also: 
Overview 
Cary Eclipse Optics 
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Software Applications Help 
The Cary Eclipse software comprises modular software applications, which means that you can choose the 
application you need, depending upon what you want to do. For example, if you want to perform quantitative 
analysis, use the Concentration application. If you want to perform scanning, use the Scan application. 

Click on the links below to learn more about the software application you're interested in. 

ADL  
ADL is pre-defined template for writing ADL 
(Applications Development Language) programs 

Lifetimes  
Use the Lifetimes Application to measure 
phosphorescence lifetimes  

ADL Shell 
ADL Shell provides pre-written commands which 
are already implemented. Use the ADL Shell to 
provide the basic functionality and build on that.  

Ratios 
Use the Ratio Application to obtain a concentration 
value for particular reactions.  

Advanced Reads  
Use the Advanced Reads Application to take 
Absorbance readings of multiple samples  

Scan  
Use the Scan Application to perform wavelength 
scanning  

Align  
Use the Align application to align the Cary Eclipse 
lamps and accessories  

Simple Reads  
Use the Simple Reads Application when you want to 
take absorbance readings at a single wavelength  

Concentration  
Use the Concentration Application when you want to 
perform quantitative measurements  

System Information  
Use the System Information Application for 
recording your company and instrument details for 
use in reports  

GLP Administration  
Use the GLP Administration Application for setting 
up file and method security and access control  

Thermal  
Use the Thermal Application to perform thermal 
analyses on DNA  

Kinetics  
Use the Kinetics Application to perform time-based 
single or multicell measurements  

Validate  
Use the Validate Application to test your instrument 
and ensure that it is working correctly  

See also: 
Application How To List 
Glossary 
Cary Application Descriptions
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Cary Application Descriptions 

Application Description
ADL Shell A pre-defined template for writing ADL programs. 

Advanced Reads For taking intensity readings of multiple samples.

Align  A utility application for aligning lamps and accessories.

Concentration  For quantitative measurements.

GLP Administration For setting up file and method security and access control.

Kinetics  For time-based single or multicell measurements.

Ratios 
Scan  For wavelength/wavenumber scanning.

Simple Reads For taking intensity readings at a single wavelength. 

System Information For recording your company and instrument details for use in reports etc. 

Thermal For performing thermal analyses on DNA. 

Validate For testing your instrument to ensure that it is working correctly. 
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Applications How To… List 
To learn how to perform many of the everyday procedures you'll use your Cary Eclipse for, just follow these 
simple step-by-step examples. 

Click on the links below to view How To's on the software application you're interested in. 

ADL  
ADL is pre-defined template for writing ADL 
(Applications Development Language) programs 

Ratios  

Advanced Reads  
Use the Advanced Reads Application to take 
Absorbance readings of multiple samples  

Scan  
Use the Scan Application to perform wavelength 
scanning  

Align  
Use the Align application to align the Cary Eclipse 
lamps and accessories  

Simple Reads  
Use the Simple Reads Application when you want to 
take absorbance readings at a single wavelength  

Concentration  
Use the Concentration Application when you want to 
perform quantitative measurements  

System Information  
Use the System Information Application for 
recording your company and instrument details for 
use in reports  

GLP Administration  
Use the GLP Administration Application for setting 
up file and method security and access control  

Thermal  
Use the Thermal Application to perform thermal 
analyses on DNA  

Kinetics  
Use the Kinetics Application to perform time-based 
single or multicell measurements  

Validate  
Use the Validate Application to test your instrument 
and ensure that it is working correctly  

Lifetimes  
Use the Lifetimes Application to measure 
phosphorescence lifetimes  

See also: 
Application Help List
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What is ADL? 
The Applications Development Language (ADL) is a BASIC-like spectroscopy language which is built-into the 
Cary software. It uses simple, English words to perform common spectroscopic functions e.g. "collect" starts a 
data collection, "curvefit" fits a curve. The Cary version of ADL uses a commerical programming lanugage—
SAXBasic® to provide basic functionality with Cary-specific commands added. 

Find out more about ADL and how to write your own controls for your instrument using 
this simple language. 
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ADL Shell Home Page 

To find out about… See the… Show me…

ADL Shell ADL Application  

Display data graphically Graphics Area  
Graph menu  

Graphics How To  

File management Open  
Save As  
Filename extensions  

How to export collected data  

Screen features Graphics Area  
Stop Instrument button  
Commands menu  
Status Line  
Function keys  

Viewing and editing 
features

View menu  
Edit menu  
Print Preview  
Print  
User Data Form  

How to use advanced reporting options  

ADL ADL Command Line  
ADL Hooks  

How to insert ADL commands using the Quick 
Reference  

Help and safety 
information

Help menu  
Safety Home Page  
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ADL Shell Application 
Introduction | Software controls

Introduction  

The ADL Shell gives you a pre-defined template for writing ADL programs. Rather than needing to write the code 
for basic functions such as graphing and filing, the ADL Shell has a number of these commands already 
implemented. In other words, you do not have to design your own interface—you can use the ADL Shell to 
provide the basic functionality and build on that. 

For example, your company may perform a particular analysis and series of calculations repeatedly. You may like 
to use the ADL Shell to write a series of prompt dialogs that will take the user through each step in sequence. 

Some frequently asked questions on the ADL Shell applications are listed below: 

What is provided by the ADL Shell? 

The ADL Shell pre-defined modules include:  

Stop button  
Connect button  
Abscissa and Ordinate display  
File handling functions  
Printer and print preview functions  
Graphics interface including the functions provided by the toolbar or graph menu 
Reports area and report editing and font functions  
Rapid Result  
Go To Wavelength  
Zero  
Function keys  
Align functions (i.e. fluorescence spectrophotometer is driven to white light)  

What sort of items would I need to program? 

Should you decide to use the ADL Shell to write your own applications, some of the items that you might like to 
program could include:  

Command buttons on the main window  
A Setup dialog as seen in other Cary Eclipse applications that includes instrument and accessory control and 
reporting and filing functions  
Instrument control via a Start button  

How do I write an ADL program? 

The easiest method is to use the ADL Editor. You can display the ADL Editor from the ADL menu item in the View 
menu. The Editor provides ready access to ADL commands and the syntax required for these commands as well 
extensive debugging tools. A further discussion on ADL commands is provided in the ADL Help. Click the button 
below to view this Help.   

Software controls 
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The application comprises the following: 

Instrument 
Status 
Readings 

The Instrument Status Readings, which display the Y and X values of the graph axes are 
displayed in the top left and right corners of the ADL Shell Application window. 

Y value 
Displays the current Y value, usually intensity. This value is continually updated during a data 
collection. 

X value 
Displays the current X values, in nanometers, for both excitation and emission. 

Stop button The Stop button at the top of the ADL Shell Application window is used to stop instrument 
analyses. The button can also be accessed from the Commands menu. 

Note 
The ADL Shell does not contain a Start button. You will need to program this button and 
its functionality in your Shell application.

Graph area The Graphics area refers to the plotting area of the application. It can contain traces of 
collected data, labels and pictures. In the Cary Eclipse system, the term 'graph' refers to the 
plotting area and is represented by a set of axes. The rectangular area defined by the axes is 
referred to as a graph box. 

To display or hide the Graphics area, select the Graphics command on the View menu. 
Double-clicking on the Graphics area enables you to toggle between half or full size display 
sizes. To manually size the Graphics area, place the mouse cursor over the border between 
the Graph and Report areas until the cursor changes to a double arrow ( ). Then hold down 
the mouse and drag it up or down to resize the areas. 

Tell me more about the Graph area 
Report area Use the ADL Shell Report area to view the current report. The report may include the results of 

your data collection, the method parameters used to collect the results and any graphics you 
have included. You can select the information to include in your report on the Reports page of 
the Setup dialog. 

You can copy the generated report onto the Windows clipboard. To do this, highlight the report 
(or the relevant section) and press CTRL+C. You can then paste the report into a word 
processor such as Microsoft® Word. 

Hot Tip 
You can edit the ADL Shell Report by pressing CTRL+R or selecting the Edit Report 
command from the Edit menu.

Menus The ADL Shell Application contains the following menus:  
File, Edit, View, Commands, Graph, Help 

See also: 
Keyboard function keys 
ADL Shell home page
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Menu line—ADL Shell 
File menu  
Edit menu  
View menu  
Commands menu  
Graph menu  
Help menu  
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File menu—ADL Shell 
Use the File menu to open or save a method or data file, print or preview a report, or exit the Cary Eclipse 
application. 

The following commands can be accessed from the File menu: 

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open it. Any 
data will be displayed in the Graphics area.

Command What it does…

New Select New to clear all method, report and graphics information and create a new file 
containing the default settings.

Open 
Method… 

Select Open Method to display the Open dialog where you can search for and load a stored 
method.

Open… Select Open to display the Open  dialog where you can search for and load method, data, 
report, graph template and batch files, as well as other file types compatible with the Cary 
Eclipse software. When you load a batch file, the method which collected the data is loaded as 
well as the associated report and graphics layout.

Save Method 
As… 

Select this option to display the Save As dialog and store the current method. You can use the 
Save As dialog to store the method, data, report, or graphics template separately or together 
as a Batch file. The data can also be saved as a comma delimited ASCII Spreadsheet file.

Save As… Select this option to display the Save As dialog and store the collected data. You can use the 
Save As dialog to store the method, data, report, or graphics template separately or together 
as a Batch file. The data can also be saved as a comma delimited ASCII file.

Print Setup… Select this option to display the Windows Print Setup dialog where you can select the printer, 
printer page size and orientation.

Print 
Preview… 

Select this option to display the Print Preview dialog where you can view the current report as 
it will be printed.

Print… Select this option to display the Windows Print dialog where you can choose the printer and 
pages to print as well as the number of copies you wish to print.

Explorer… Select this option to run Windows Explorer. This may help you locate method and data files.

History List This displays a list of the four most recently opened files.

Exit Select this option to exit the ADL Shell application. 

See also: 
Open   
Save As   
Print Preview   
Filename Extensions
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Open—ADL Shell 
Look in | File name | Files of type | Overlay Data | Open

Use the dialog to open a file previously saved by the application. To access the Open dialog, select Open or 
Open Method from the File menu. 

Look in The Look In field lists the available folders and files. Click the down arrow on the right of this 
field to view the location of the current folder in your computer's hierarchy. You can also select 
a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In field. 

Note 

To open the folder in the level that is one higher than the current folder, select  on 
the toolbar.

Look in list 
box 

The Look In List Box, which is directly below the Look In field, displays the folders and files in 
the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted text 
entry field that appears and press Enter. Then double-click on the new folder to open it.

Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the date the 
file was last modified.

Click to preview the selected trace before you load it into the application.

File name Enter the name of the file you want to open in this field. The easiest way to do this is to find 
the file in the Look in list box and then select the file. However, you can type the full path of a 
file and then select Open to open the file.

Files of type Click on the arrow on the right of this field to view a list of the different types of application files 
that can be opened in the list box. 
Methods (*.FMKN) Choose this file type to open a Method file. Only the method is 

loaded. No data is loaded.

Data (*.FDKN) Choose this file type to open a Data file. Only the data is loaded. The 
method that was used to collect the data is not loaded. The last used 
method or default method will be displayed.

Report (*.FRKN) Choose this file type to open a Report file. You can view the report in 
the Report area.

Graph Template 
(*.FGKN)

Choose this file to open a Graph Template file. The file will set up 
the layout of the Graphics area including any bitmaps as well as the 
range and style of the graph axes.

Batch (*.FBKN) Choose this file type to open a Batch file. A Batch file includes data, 
the method used to collect the data, report and graphics setup.

Spreadsheet Ascii 
(*.CSV)

This will open ASCII files that contain single comma delimited files 
with two or more columns.

GRAMS (*.SPC) Choose this file type to open a Cary Eclipse GRAMS data file. This 
allows you to use data files collected using a Cary Eclipse GRAMS 
system. The method that was used to collect the data is not loaded.

All files (*.*) This enables you to view all files in the directory so that you can 
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open any compatible file.

Tell me more about Filename Extensions

Overlay Data Select this check box to overlay individual data files in one graph box. If this is not checked 
the data from each file will appear in individual graph boxes. This option is only available if the 
Open dialog has been accessed by selecting 'Open…' from the File menu. 

Hot Tip 
Use the SHIFT or Control key to select multiple data files.

Open This button opens the highlighted file/s or the files listed in the File name field.

 
See also: 
File menu

Page 2 of 2Open

       



Save As—ADL Shell 
Look in | File name | Files of type | Save

Use the Save As dialog to save the data, method, report or graphics template individually or together as a Batch 
file. 

Traces (or data) that are currently ‘Visible’ in the Graphics area are saved, regardless of how they are displayed 
(full screen graph box or tile). 

For example, if six graph boxes are displayed in the Graphics area and each graph box has one Visible trace then 
all six traces will be saved. 

If you do not wish to save particular traces, make them not Visible in the Trace Preferences dialog. To save only 
the focused trace, select the Save only focused trace check box. 

The Save As dialog comprises the following: 

Note 
This dialog appears when you select either the Save Method As or Save As menu option in the File menu. 
When you select Save Method As this dialog appears with 'Methods' displayed in the Files of type field. 
When you select Save As this dialog appears with 'Batch' displayed in the Files of type field.

Look In The Look In field lists the available folders and files. Click the down arrow on the right of this 
field to view the location of the current folder in your computer's hierarchy. You can also select 
a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed in the list box below the Look In field. 

Note 

To open the folder in the level that is one higher than the current folder, select  on 
the toolbar.

Look in list 
box 

The Look In list box, which is directly below the Look In field, displays the folders and files in 
the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted text 
entry field that appears and press ENTER. Then double-click on the new folder to open 
it.

Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the date the 
file was last modified.

Click to preview the selected trace before you load it into the application.

File Name Enter the name of the file you want to save in this field. 
You can also type the full path of a file then select the Save button to save the file.

Files of Type Click on the arrow on the right of this field to view a list of the different types of application files 
that can be opened in the list box. 
Methods (*.FMKN) Choose this file type to only save the current method. Any collected 

data is not stored.

Data (*.FDKN) Choose this file type to only save the data currently Visible in the 
Trace Preferences dialog (for any graph box). Note that the method 

Page 1 of 2Save As

       



used to collect the data is not stored with the data.

Report (*.FRKN) Choose this file type to only save the contents currently shown in the 
Report area..

Graph Template 
(*.FGKN)

Choose this file type to save the layout of the Graphics area as a 
template. For example, any bitmaps you have added to your 
Graphics area will be saved as well as the range and style of the 
graph axes.

Batch (*.FBKN) Choose this file type to save the data that is currently Visible in the 
Trace Preferences dialog (for any graph box), the method used to 
collect the data and the currently displayed report all together as a 
batch file. The graphics setup is also stored.

Spreadsheet Ascii 
(*.CSV)

Choose this file type to save the raw intensity data currently Visible 
in the Trace Preferences dialog (for any graph box) as a comma 
delimited ASCII Spreadsheet file (*.CSV) file. The data is saved as 
XY pairs delimited by a comma. 

Note 
This file type can be easily imported into a spreadsheet 
program. For example, Microsoft Excel. You can also double-
click on the stored *.CSV file from Microsoft Explorer to load 
Excel automatically with the ASCII XY data displayed.

GRAMS (*.SPC) Choose this file type to only save the data currently Visible in the 
Trace Preferences dialog (for any graph box) as a Cary Eclipse 
GRAMS data file.

Tell me more about Filename Extensions

Save only 
focused 
trace 

Select this option to save only the focused trace in the graph box. If this option is not selected, 
all visible traces in the graph box will be saved.

Save Click this button to save the file currently present in the File name field in the directory 
specified in the Look in field.

See also: 
File menu
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Filename extensions—ADL Shell
The Cary Eclipse system uses the filename extension to distinguish between data types (e.g. method or data) and also 
to differentiate applications. (e.g. Concentration or Kinetics). 

The Syntax for file extensions is: 

The following files may be opened and saved in the ADL Shell Application, Note that the ?? can be replaced with any of 
the two letter Application identifier codes listed above if you wish to narrow down the list: 

Letter Represents Available Options
First Type of analysis F Fluorescence

Second Type of file B Batch
D Data
G Graph Template
M Method
R Report

Third and fourth Application identifier AB Advanced Reads
CN Concentration
KN Kinetics
LT Lifetimes
SR Simple Reads
SW Scan
VO Validate

Extension Available action File type
*.FM?? Open/Save A method file (e.g. *.FMKN) consists of the software setup by 

which kinetics data is collected.
*.FD?? Open/Save A data file (*.FDSR) contains data collected that is currently 

visible in the Trace Preferences dialog (for any graph box).
*.FR?? Open/Save A report file (*.FRKN) contains the report generated by the 

Cary Eclipse about the data.
*.FG?? Open/Save A graph template file (*.FGKN) contains information that sets 

up the layout of the Graphics area including any bitmaps as well 
as the range and style of the graph axes.

*.FB?? Open/Save A batch file (*.FBKN) contains the collected data that was 
Visible in the Trace Preferences dialog (for any graph box), the 
method by which the data was collected and the report and 
graphics template.

*.CSV Open/Save An ASCII spreadsheet file (*.FCSV) has the same extension 
for all applications. It consists of raw intensity data (that was 
currently Visible in the Trace Preferences dialog (for any graph 
box) saved as XY comma-delimited pairs. This file can be 
imported into a spreadsheet program such as Microsoft Excel.

Note 
Selecting All Files in the Windows Open dialog will list all available file types. 

See also: 
Open 
Save As
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Edit menu—ADL Shell 
Use the Edit menu to copy, cut, paste and delete information. You can also use the menu to access the Report 
editing commands. The menu is accessible from the menu line at the top of the ADL Shell Application window. 

The following commands can be accessed from the Edit menu: 

Note 
Some options are only available once you select Edit Report. 

Menu 
command 

Button Enables you to… 

Undo If available, this undoes the last action. 
This command is also accessible by pressing CTRL+Z.

Cut Select this command to remove the highlighted text and place it on the Windows 
Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Select this command to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.

Paste Select this command to insert the contents of the Windows Clipboard (text only) at the 
cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Select this command to remove selected text in the Report area. This option is only 
available once you select Edit Report and there is text highlighted in the Report area. 
This command is also accessible by pressing DEL.

Select All Select this option to highlight all text in the Report area. 
This command is also accessible by pressing CTRL+A.

Font This enables you to change the font of new or selected text in the report. For existing 
text, simply highlight the text in the report, select Font and make your changes in the 
Font dialog. When you select OK, the appearance of the highlighted text in the report 
will alter to reflect your font changes. You do not have to select Edit Report to use this 
command. 
This command is also accessible by pressing CTRL+F.

Edit Report Select this option to edit the report. 
This command is also accessible by pressing CTRL+R.

Clear Report Select this command to remove the contents of the Report area. If you have saved the 
report, selecting this option does not delete the contents of the report, the information is 
simply removed from the Report area.

Create 
Report 

Select this command to create a new report.

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, Microsoft Word 
or Microsoft Excel) into the report area of the of the ADL Shell application. To edit these objects, simply 
double click on them to open the associated application in which they were created.
See also: 
Menu line
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View menu—ADL Shell 
The View menu is accessible from the menu line at the top of the ADL Shell Application window. 

The following commands can be accessed from the View menu: 

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open it. Any data 
will be displayed in the Graphics area.

Command What it does…

Toolbar Select this option to toggle the Graphics and Reports toolbar on and off. You can also select to 
display or hide the toolbar Text Labels.

Buttons Select this option to toggle the left-hand button display (button area) on and off.

Graphics Select this option to toggle the Graphics area on and off.

Report Select this option to toggle the Report area on and off.

Report 
Vertical 

If the Graphics option is selected, select Report Vertical to display the Graphics area, Report 
area and/or ADL Editor side by side vertically.

ADL Select this option to toggle the ADL Editor on and off.

ADL Vertical If the ADL and Report options are selected, select ADL Vertical to display the ADL Editor 
vertically on the right hand side of the Report area.

ADL Quick 
Reference 

This displays the Quick Reference window where you can easily add a command in the correct 
syntax to your ADL program. A detailed description of all the commands in the Quick Reference 
is available by selecting the Help button.

ADL Hooks Select this to activate a link (or hook) to an ADL program at a specific point in the application, and 
then run that ADL program. For example, ADL hooks have been supplied to run specific 
programs: 

on start-up of the Cary Eclipse software; 
when the system goes online or offline;  
when the Start button is selected;  
when a run finishes;  
when a zero is performed etc.  

For the hook to work, ADL Hooks must be selected, and the appropriate ADL file for the 
application must be present in the ADL folder in the directory. 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Hints Select this option to toggle the Hints bubble text on and off. The bubble text appears when you 
place the arrow cursor over a field, button or text entry field for a short period. It offers a quick 
explanation of the item’s function.

See also: 
ADL Shell Application  
Graphics area  
ADL Hooks 
How to insert ADL commands using the Quick Reference
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Commands menu—ADL Shell 
Use the Commands menu to access major operational commands in the ADL Shell application . The menu is 
accessible from the menu line at the top of the ADL Shell Application window. 

Alternatively you can use function key shortcuts for some of the commands. These appear next to the item in the 
Commands menu. 

The Commands menu comprises the following commands: 

Command What it does…
Start Select this to start a data collection using the currently set up parameters. 

If the Connect command is displayed in place of the Start command, this indicates that 
another Cary Eclipse application is in use and has control of the Cary Eclipse instrument. To 
make the ADL Shell application active so that you can perform a read, you will need to select 
Connect. However, you will not be able to select Connect if another application is collecting 
data. 

Stop Select this to stop the data collection. 
If you have selected Storage On in the Auto Store page of the Setup dialog, all data collected 
is automatically stored in the file specified in the Batch name field of the Windows Save As 
dialog before or after the run commenced.

Clear Zero Select this option to clear the Zero command. When you select the Zero command (from the 
Commands menu or by pressing F5), the intensity at that time will be reset to zero and all 
subsequent results will have the intensity value that was reset to zero subtracted from them. 
Selecting Clear zero cancels this zeroing (and thus subtraction) effect.

Pre-scan Select Pre-scan to quickly determine the optimum instrument parameters to be used for your 
sample. At the end of this collection sequence the software will report the optimum Ex and Em 
wavelengths and PMT voltage. Once you are satisfied with the parameters, the software will 
automatically update your method setup to reflect these new parameters.

Zero order… Select the Zero order command to set one of the monochromators to zero order. If you use 
this command to zero either the excitation or emission monochromators, this will override the 
Ex. Wavelength or Em. Wavelength set on the Cary page. The Cary Eclipse software will use 
the zero setting when collecting data. 

The Zero order command is generally used during alignment procedures.  

Excitation 
Select this command to set the excitation monochromator to zero order (white light). 

Emission 
Select this command to set the emission monochromator to zero order (white light). 

Reset Select this command to re-initialize the instrument. This will perform the same initializing 
procedure that is performed when the instrument is powered on.

Rapid Result Select this to display the Rapid Result dialog. Use this dialog to take a reading of a blank and 
multiple sample readings without changing the application method. This means that between 
runs, while new samples are being prepared and loaded, other samples can quickly be 
measured. 
This command can also be accessed by pressing F6.

Zero Select this to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can 
use the Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible by pressing F5. 

Note 
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Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Go to… Select Go To… to display the Go To Wavelength dialog where you can change the 
instrument to a new wavelength. Use this command if you want to quickly go to a wavelength 
to check the intensity reading. 
This command is only available if the instrument is not currently collecting data. It can also be 
accessed by pressing F4. 

Note 
This is not the wavelength used in the application method. If your method uses a 
wavelength that is different from the 'Go To wavelength', then when you select Start the 
system will change to the wavelength selected. (In most applications, this is set in the 
Cary page of the Setup dialog.)

ADL 
Command 

Select this to display the ADL Command Line window where you can execute an ADL 
command or ADL program. (You can also press Alt-Y to display this dialog.)

Rerun ADL Select this to run the ADL command or program in the ADL Command Line window again. 
(You can also press Alt-X to rerun programs.)

See also: 
ADL Shell Application 
Zero  
Rapid Result   
Go To Wavelength 
ADL Command Line
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Go To Wavelength—ADL Shell 
Use the Go to Wavelength dialog to temporarily change the instrument to a new excitation or emission 
wavelength. You would mainly use this dialog if you want to quickly go to a wavelength and check the intensity 
reading of the sample. The lamp will flash continuously in this mode. This option is only available if the instrument 
is not currently collecting data. 

To access the Go to Wavelength dialog, select the Go To Wavelength command from the Commands menu. 
You can also select F4 to open the dialog. 

The Go to Wavelength page comprises the following: 

Note 
This is not the wavelength used in the application method. If your method uses a wavelength that is different 
from the 'Go to wavelength' setting you select, then when you select Start the system will change to the 
wavelength selected. (In most applications, this is set in the Cary page of the Setup dialog.)

Excitation Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go to the instrument will 
change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white 
light). You can then use this light for aligning accessories. 

Emission Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go to the instrument will 
change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white 
light). You can then use this light for aligning accessories. 

Go To Click Go to once you have entered a new wavelength, to change the instrument to the entered 
value.

See also: 
Function Keys
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Zero—ADL Shell 
Use the Zero button to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use the Zero 
command before commencing a data collection if you want your data to start at 0  intensity. The Cary Eclipse will 
prompt you to load a blank before performing the zero. 

Before you select Zero, ensure that you have placed the blank solution in the cell positions that are currently in 
the cell path. 

When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the ADL Shell 
Application window. 

To access the Zero option, select the Zero command from the Commands menu. Select the Clear Zero 
command from the Commands menu to remove zero correction and thus remove the subtraction effect. 

See also: 
ADL Shell Application 
Commands menu
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Rapid Result—ADL Shell 
Use the Rapid Result dialog to take a reading of a blank and sample/s, without having to change the current 
application method. This means that between runs, while new samples are being prepared and loaded, other 
samples can quickly be measured. The result is printed in the Report area. 

To access the Rapid Result dialog, select the Rapid Result command from the Commands menu or press F6. 

Excitation Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Emission Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Zero Click Zero to change the wavelength to the entered value and measure a blank.
Result Click Result to change the wavelength to the entered value and measure a sample. The X,Y 

results are corrected for the blank and the results are displayed in the Report window.
See also: 
Commands menu
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Graph menu—ADL Shell 

Introduction 

Use the Graph menu to view data in various graphical formats or in multiple graphs in the Graphics area. You can 
double-click on the Graphics area to toggle the display through graph and report to graph only. 

In the Cary Eclipse system, the term 'graph' refers to the plotting area and is represented by a set of axes. The 
rectangular area surrounding the graph is referred to as the graph box. A graph will appear in the Graphics area 
when you select Start to commence a ADL Shell run. 

The Graph menu can be accessed in the following ways:  

from the main menu at the top of the ADL Shell Application window  
by clicking the right mouse button in a graph box or the Graphics area 

Menu commands 

The following commands can be accessed from the Graph menu: 

Note 
The red trace in any graph box is the one on which all information appears and the one used for the cursor 
tracking. It is called the focused trace.

Menu 
command

Button Enables you to…

Print XY 
point 

Select this to print the cursor's current X and Y coordinates in the report area. 
Note: 
This option is only available from the Graph menu that appears when you right-
click in a graph box.

Copy Graph Select Copy Graph to copy the entire Graphics area to the Windows Clipboard. All of 
the graphs in the Graphics area will be copied to the Clipboard.

Paste to 
Graph 

Select Paste to Graph to paste the contents of the Windows Clipboard into the 
Graphics area. Text is pasted as a label, graphics are pasted as pictures.

Add Graph Select Add Graph to add a new graph box to the Graphics area. You may want to do 
this if you have, for example, a graph containing existing data and you want to collect 
some new data in a new graph.

Remove 
Graph 

Select Remove Graph to delete the selected graph box from the Graphics area. The 
graph box is removed, but the data is not deleted and is still available from the Trace 
Preferences window. 
You may want to use remove graph if you have a large number of graph boxes open 
but only want to focus on some of these. 

Note: 
You can remove multiple graph boxes by first holding down the CTRL key and 
selecting the graphs to be removed and then selecting the Remove Graph 
button or menu item. Use the SHIFT key to highlight a range of graphs for 
removal.

Clear All 
Traces 

Select Clear All Traces to delete all traces from the graph/s. Note that selecting this 
option simply turns off the Visible property for the traces in the Trace Preferences 
window. You can redisplay the traces by making the traces Visible again in the Trace 
Preferences window.

Select Add Label to display the Add Label dialog where you can enter a text label to 
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Add Label be placed on a graph or in the background of the Graphics area.

Add Picture Select Add Picture to display the Add Picture dialog where you can select a picture, 
bitmap or chemical structure to be placed on a graph or in the background of the 
Graphics area.

Edit 
Annotation 

Select Edit Annotation to alter the content or look of the selected annotation, (either a 
label or a picture) in the Graphics area. 

If the selected annotation is a label, selecting Edit Annotation will open the Edit Label 
dialog where you can change the text of the selected label. 
If the selected annotation is a picture, selecting Edit Annotation will open the Edit 
Picture dialog where you can replace the selected picture with a new picture. 

Note: 
This option can only be activated if an annotation is selected.

Delete 
Annotation 

Select Delete Annotation to remove an annotation, (such as a label or a picture) from 
the Graphics area. 
You can use this menu option to remove highlighted annotations in the Graphics area 
such as labels, pictures and ruler/fit information. 

Note: 
This option can only be activated if an annotation is selected.

Trace 
Preferences 

Select this command to display the Trace Preferences dialog where you can select 
the trace(s) to display in the selected graph.

Graph 
Preferences 

Select this command to display the Graph Preferences dialog where you can change 
the appearance of your graph. Any changes you make to the appearance of the graph 
will be applied to all graphs.

Cursor 
Mode… 

Select this command to display the Cursor Modes dialog where you can choose the 
type of cursor to be used on the screen. For example, you can select to use a free 
cursor that can move anywhere in the graph or exactly trace the focused scan (red 
scan).  Alternatively, you can select a cursor that enables you to draw a line from one 
point to another to determine the slope using either the Least Squares method or the 
Point to Point method.

Axes 
Scales… 

Select this command to display the Axes Scales dialog where you can set the scale 
range for the X and Y axes.

Auto scale 
graph 

To automatically scale the graph, point to one of the following options: 

Autoscale[XY] 
Select Autoscale[XY] to automatically scale collected data by scaling the Y height and 
X width to full screen. 

Autoscale[X] 
Select Autoscale[X] to automatically scale collected data by scaling the X width to full 
screen. 

Autoscale[Y] 
Select Autoscale[Y] to automatically scale collected data by scaling the Y height to full 
screen. 

Zoom Out Select Zoom Out to Zoom back to the original X and Y ranges which were used to 
collect the data (i.e. the method setup conditions of the focused scan). 
For example, the system will revert back to the X and Y ranges set in the method if you 
zoom in and out during a data collection.

Single/Multi 
Graph 

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note: 
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The graph highlighted in the Multi Graph view will be displayed when you toggle 
the Single Graph option.

Auto 
Arrange 
Graphs 

Select Auto Arrange Graphs to view and arrange all graphs simultaneously. 
Note: 
You can move graph boxes manually by clicking the left mouse button outside 
the graph axes and dragging the graph box to a new position. You can also 
resize graphs.

User Data 
Form 

Select User Data Form to display the User Data Form where you can enter extra 
information about the traces in the highlighted graph box. For example, you might want 
to record information about the experimental conditions you used to collect the data, 
such as the pH at which data was collected.

Calculator Select Calculator to display the Maths window where you can perform mathematical 
manipulations on collected traces. In addition, it can act as a simple numeric calculator.

History List This displays a list of the current graphs. 

See also: 
Add Label   
Add Picture  
Edit Label   
Edit Picture  
Trace Preferences 
Graph Preferences  
Cursor Modes   
Axes Scales   
Single/Multi Graph  
User Data Form   
Maths  
Graphics toolbar 
Graphics area 
Graphics How To
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Help menu—ADL Shell 
Use the Help menu to view the online Help and software information for this application. 

Command What it does…

ADL Shell 
Help 

Select this to display the ADL Shell Home Page. This contains a list of online Help topics 
specific to the ADL Shell Application.

Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.

Tip of the 
day 

View useful tips about using your Cary Eclipse instrument and software.

Eclipse Tour Select this to display the Cary Eclipse Multimedia Online Help. This will give you an animated 
introduction to the Cary Eclipse software and hardware.

About… Select About to access a dialog that displays information about the application as well as 
Varian email and Internet contact information. 
To clear this About dialog, select OK.
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Graphics area—ADL Shell 
The Graphics area of the ADL Shell application appears in the top half of the ADL Shell Application window and is 
used to display traces of collected data. In the Cary Eclipse system, the term 'graph' refers to the plotting area 
and is represented by a set of axes. The rectangular area surrounding the graph is referred to as the graph box. 

To display or hide the Graphics area, select the Graphics command on the View menu. Double-clicking on the 
Graphics area enables you to toggle between half or full size display sizes. 

You can access the functions associated with the Graphics area by doing the following: 

selecting one of the Graphics toolbar buttons;  
selecting a command from the Graph menu; or  
clicking the right mouse button in the Graphics area and select a command from the menu 

You can customize the graphics area to suit your requirements in the following ways: 

Note 
Not all functions are available on every menu.

See also: 
Graph Menu 
Toolbar 
View Menu 
Add Label 
Add Picture 
How to make a graphics template
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Graphics Toolbar—ADL Shell 
Use the Graphics toolbar buttons to gain quick access to many of the Graph menu options. You can also use the 
toolbar to select the graph you want to view and to change the look of your graphs. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Graphics. To display or 
hide the toolbar's text labels, point to the Toolbars option in the View menu and select Text Labels. 

The following commands can be accessed from the Graphics toolbar: 

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to…

Trace 
Preferences 

Click this button to display the Trace Preferences window where you can select the 
trace(s) to display in the selected graph.

Graph 
Preferences 

Click this button to display the Graph Preferences dialog where you can change the 
appearance of your graph. Any changes you make to the appearance of the graph will 
be applied to all graphs.

Cursor 
Mode 

Click this button to display the Cursor Modes dialog where you can choose the type 
of cursor to be used on the screen. For example, you can select to use a free cursor 
that can move anywhere in the graph or exactly trace the focused scan (red scan).  
Alternatively, you can select a cursor that enables you to draw a line from one point to 
another to determine the slope using either the Least Squares method or the Point to 
Point method.

Axes 
Scales…  

Click this button to display the Axes Scales dialog where you can set the scale range 
for the X and Y axes.

Autoscale
[XY] 

Click the Autoscale[XY] button to automatically scale collected data by scaling the Y 
height and X width to full screen.

Autoscale
[X] 

Click the Autoscale[X] button to automatically scale collected data by scaling the X 
width to full screen.

Autoscale
[Y] 

Click the Autoscale[Y] button to automatically scale collected data by scaling the Y 
height to full screen.

Zoom Out Click the Zoom Out button to Zoom back to the original X and Y ranges which were 
used to collect the data (i.e. the method setup conditions of the focused scan).  
For example, the system will revert back to the X and Y ranges set in the method if 
you zoom in and out during a data collection.

Add Label  Click this button to display the Add Label dialog where you can enter a text label to be 
placed on a graph or in the background of the Graphics area. 

Add Picture Click this button to display the Add Picture dialog where you can select a picture, 
bitmap or chemical structure to be placed on a graph or in the background of the 
Graphics area.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note: 
The graph highlighted in the Multi Graph view will be displayed when you toggle 
the Single Graph option.

Auto Click the Auto Arrange Graphs button to view and arrange all graphs simultaneously. 
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Arrange 
Graphs 

Note: 
You can move graph boxes manually by clicking the left mouse button outside 
the graph axes and dragging the graph box to a new position. You can also 
resize graphs.

Add Graph Click this button to add a new graph box to the Graphics area. You may want to do 
this if you have, for example, a graph containing existing data and you want to collect 
some new data in a new graph.

Remove 
Graph 

Click this button to delete the selected graph box from the Graphics area. The graph 
box is removed, but the data is not deleted and is still available from the Trace 
Preferences window. 
You may want to use remove graph if you have a large number of graph boxes open 
but only want to focus on some of these. 

Note: 
You can remove multiple graph boxes by first holding down the CTRL key and 
selecting the graphs to be removed and then selecting the Remove Graph 
button or menu item. Use the SHIFT key to highlight a range of graphs for 
removal.

Clear All 
Graphs 

Click this button to delete all traces from the graph/s. Note that selecting this option 
simply turns off the Visible property for the traces in the Trace Preferences window. 
You can redisplay the traces by making the traces Visible again in the Trace 
Preferences window.

User Data 
Form 

Click this button to display the User Data Form where you can enter extra information 
about the traces in the highlighted graph box. For example, you might want to record 
information about the experimental conditions you used to collect the data, such as the 
pH at which data was collected.

Calculator Click this button to display the Maths window where you can perform mathematical 
manipulations on collected traces. In addition, it can act as a simple numeric 
calculator.

See also: 
Add Label   
Add Picture   
Edit Label   
Edit Picture    
Trace Preferences  
Graph Preferences  
Cursor Modes   
Axes Scales   
Single/Multi Graph  
User Data Form   
Maths  
Graphics area 
Graph menu 
Graphics How to
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Add Label—ADL Shell 
Use the Add Label dialog to place a label on your graph or into the background of the Graphics area.  

To add a label to a graph box, you must have at least one trace Visible in the graph box. (You can select which 
traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple graphs, the label will 
be placed in the graph box that is currently selected. However, you can add a label outside of a graph box in the 
background of the Graphics area at any time. 

The Add Label dialog comprises the following: 

Q. Can I add a label that will print with all my graphs.
A. Yes, you can add your label to the background of the Graphics area. To do this, right-click on a section of
the background (gray area) and select Add Label from the menu. (You will notice that this menu has less
options than the menu that appears when you right-click on a graph.) In the Add Label dialog, enter the
label to be added to all graphs and select OK. The label will appear in the background of the Graphics area.

To access the Add Label dialog, select the Add Label command from the Graph menu, or select the Add 
Label button on the Graphics toolbar.

To selected 
trace

Select this option to associate a label with the selected trace. When you associate a label with 
a trace and make the trace visible in the Graph box, the label will also be displayed with the 
trace.

To selected 
graph

Select this option to associate the label with the selected graph. When you associate a label 
with a graph, the label will always be displayed in the Graph box, regardless of what traces are 
visible.

Selected trace This will identify the trace that is currently selected and display the name of the trace.
Font… Click Font to open the Windows Font dialog. In this dialog you can specify the font type, style 

and size to be used for the label.
Label Use the Label field to enter the text for the label. You can enter as many lines of text as you 

require.
Hot Tip 
If you wish to include certain XY co-ordinates on the graph as a label, position your cursor at the 
appropriate place, right-click and select Add Label from the menu. When the Add Label dialog appears, 
the co-ordinate positions will be added to the Label field. 
See also: 
How to add a label to a graph 
How to move a label 
How to edit a label 
How to delete a label

Page 1 of 1Add Label

       



Add Picture—ADL Shell 
Use the Add Picture dialog to insert a picture or bitmap into the Graphics area. The picture can be added as a 
background picture or to a particular graph box. 

To add a picture to a graph box you must have at least one trace Visible in the graph box. (You can select which 
traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple graphs, the picture 
will be placed in the graph box that is currently selected. However, you can add a picture outside of a graph box in 
the Graphics area at any time. 

The Add Picture dialog comprises the following commands: 

Q. Can I add a picture that will print with all my graphs.
A. Yes, you can add your picture to the background of the Graphics area. To do this, right-click on a section
of the background and select Add Picture from the menu. (You will notice that this menu has less options
than the menu that appears when you right-click on a graph.) In the Add Picture dialog, load the picture to
be added to all graphs and select OK. The picture will appear in the background of the Graphics area.

To access the Add Picture dialog, select the Add Picture command from the Graph menu, or select the 
Add Picture button on the Graphics toolbar.

To selected 
trace

Select this option to associate a picture with the selected trace. When you associate a picture 
with a trace and make the trace visible in the Graph box, the label will also be displayed with 
the trace.

To selected 
graph

Select this option to associate the picture with the selected graph. When you associate a 
picture with a graph, the label will always be displayed in the Graph box, regardless of what 
traces are visible.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer for the 
picture you want to insert. The picture must be one of the following formats: DIB, JPG, JPEG, 
BMP, EMF or WMF. 

If you are viewing multiple graphs the picture will be placed on the graph that is currently 
selected. If no graph is selected, the picture will be placed on the Graphics area background. 

Note 
When you save the data (as a Batch or Data file) the label is saved with its associated trace or graph. Labels 
outside graph boxes can be saved in a graphics template. 

See also: 
How to add a picture to a graph 
How to move a picture 
How to delete a picture 
How to replace a picture
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Edit Label—ADL Shell 
Use the Edit Label dialog to alter the content or look of your label. 

To access the Edit Label dialog, right-click on the label you wish to change and select Edit Annotation from the 
menu. 

The dialog comprises the following: 

Font Select Font to open the Font dialog, where you can specify the font type, style and size to be 
used for the label.

Label Use the Label field to alter the text for the label. 

See also: 
How to edit a label 
How to add a label to a graph 
How to move a label
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Edit Picture—ADL Shell 
Use the Edit Picture dialog to change a picture you have inserted into the Graphics area. 

To access the Edit Picture dialog, right-click on the picture you wish to change and select Edit Annotation from 
the menu. 

The Edit Picture dialog comprises the following commands: 

To selected 
trace/ graph

Displays whether you originally selected to add the picture to a trace or a graph. This option is 
not editable.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer for the 
picture you want to insert. The selected picture will replace the current picture. The picture must 
be one of the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

See also: 
How to replace a picture 
How to add a picture 
How to move a picture 
How to delete a picture
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Axes Scales—ADL Shell 
Use the Axes Scales dialog to manually change the axes range. This can assist in zooming in on a particular part 
of the graph. 

The dialog comprises the following: 

X Axis 

Y Axis 

To access the Axes Scales dialog, select the Axes Scales command from the Graph menu, or select the 
Axes Scales button on the Graphics toolbar.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the X axis, in the format n1 - n2 (where n1 is the 

start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can access 
by selecting the down arrow adjacent to the Scale field.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the Y axis, in the format n1 - n2 (where n1 is the 

start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can access 
by selecting the down arrow adjacent to the Scale field.

See also: 
Graph menu  
Graphics toolbar   
How to scale your graph manually 
How to scale your graph automatically 
How to zoom a graph
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Cursor Modes—ADL Shell 
Use the Cursor Modes dialog to choose the type of cursor to be used on screen. For example, you can select to 
use a free cursor that can move anywhere in the graph. 

The dialog comprises the following: 

Cursor Modes 

To access the Cursor Modes dialog, select the Cursor Modes command from the Graph menu, or select 
the Cursor Modes button on the Graphics toolbar.

Free The Free cursor is not confined to a particular trace on the graph. It can move anywhere in a 
graph box, and its ‘X,Y’ position is shown in the bottom right-hand side of the Graphics area. 
You can use the Free cursor to zoom in on a particular part of a graph. 

Note 
The Free cursor moves from pixel point to pixel point in the selected graph box. Hence 
you need to be careful when positioning the cursor over a scan to obtain an accurate 
(X,Y) reading. It is recommended that you use the Track cursor mode for this.

Track Use the Track cursor to exactly trace the focused (red) scan in a graph box. The cursor 
position is displayed in the X and Y at the bottom right-hand side of the Graphics area. 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the 
required position. Click the left mouse button, press ALT on the keyboard, then release 
the mouse button.

Track 
Intensity

Select the Track Intensity option if you want to associate an intensity value with the tracking. 
The cursor will then track from point to point on the continuum between the intensity value you 
enter. The default value will be 50% of the maximum intensity of the focused continuum.

Peaks/ 
Valleys

Choose from the options of Peaks, Valleys or Peaks Valleys to move the cursor from peak to 
peak, valley to valley or from one peak/valley to the next.

See also: 
Graph menu  
Graphics toolbar  
How to zoom a graph 
How to track the focused trace
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Example of a Graphics Template—ADL Shell 
By using the Add Label command in the Cary Eclipse graphics system, you can customize a graphics template 
such as the one shown below: 

The above is created as follows: 

The graph on the left is the collected data.  
The text on the top right is a multi-line label (added using the Add Label command).  
The logo is an inserted picture (added using the Add Picture command). 

See also: 
Add Label 
How to make a graphics template

Page 1 of 1Example of a Graphics Template

       



Graph Preferences—ADL Shell 
Axes Preferences | Advanced Options | Trace Style | Show Legend

Introduction 

Use the Graph Preferences dialog to change the appearance of your graph. 

All graphs will appear labeled with the X axis label being horizontal and the Y axis vertical. You cannot change the 
orientation of these labels. However you can alter the font and size of the axes and their labels. 

Any changes you make to the appearance of the graph will apply to all graphs until the settings are changed 
again. 

Dialog controls 

The Graph Preferences dialog comprises the following: 

Axes Preferences 

Advanced Options 

To access the Graph Preferences dialog, select the Graph Preferences command from the Graph 
menu, or select the Graph Preferences button on the Graphics toolbar.

Axes Color Select the color that you want to assign to the axes of the graph/s from the drop down list.

Axes Width Select the width of the axes from the drop down list. The width, which is in pixels, ranges 
between one and five pixels.

Grid Style Select the style of grid for the graph from the drop down list. If you do not wish to include a 
grid on the graph, select None.

Plot Area 
Color

Select the color to be used as the background of the graph from the drop down list. If you do 
not want a background color on the graph, select White.

Trace Width Select the width of the trace from the drop down list. The width is given in pixels and ranges 
between one and five pixels.

Font Click the Font button to display the Windows Font dialog where you can define the font style 
for the axes of the graph/s. The style and size of the font will be applied to all graph. The style, 
name and point size of the font appears on the font button.

Preview Box Preview any changes you make to the axes preferences in the preview box. The changes 
shown in this box will not be made until you select OK.

Auto tick 
marks

The Auto tick marks option enables you to approximately set how many tick marks (or 
points) will be included on the graph axes. The tick marks generated will be whole, rounded, 
even numbers. The Auto tick marks option is not available if you have selected Major ticks. 

Y-axis
Use the Y-axis slider bar to increase or decrease the number of tick marks (or points) to be
included on the Y axis.

X-axis
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Trace Style 

Show Legend 

Use the X-axis slider bar to increase or decrease the number of tick marks (or points) to be 
included on the X axis. 

Major ticks Use the Major Ticks option to enable you to set exactly how many ticks (or points) will be 
added to the X and Y axes. The number of marks you specify will be divided by the axis 
range, which can result in odd numbers on the axis. Note that any changes are not reflected in 
the graph bitmap at the top of the screen.

Decimals Use the Decimals option to set the number of X and Y decimal places to be displayed on the 
axes. To set the number of decimal places, select the Decimal option and enter the number in 
the Y-axis and X-axis combo boxes. Note that any changes are not reflected in the graph 
bitmap at the top of the screen.

Points Select Points to display each individual data point collected by the Cary Eclipse on the graph.

Points and 
solid lines

Select Points and solid lines to display each individual data point collected by the Cary 
Eclipse on the graph. Additionally, an interpolated line that connects the points will be drawn.

Solid lines If you select Solid lines, the Cary Eclipse system will interpolate the data between the actual, 
collected data points and show the data as a continuous line.

Style cycles 
automatically

If you select Style cycles automatically, the Cary Eclipse system will display each of the 
above three trace styles. This makes it easier to differentiate between traces, especially on 
black-and-white printers.

Show Legend Select Show Legend to display a legend in the right side of each graph box. 
A single left click on a sample name or example line within the legend will make it the focused 
or red scan. Information about the trace will be displayed below the X axis. 

Hot Tip 
Double-clicking on the legend will automatically display the Trace Preferences window, 
allowing you to view more detailed information about your trace (e.g. audit log, File 
name, etc.). 
You can also use the legend to select which trace will be the focused trace. 

See also: 
Graph Menu 
Toolbar 
Graphics area 
Graphics How To
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Single/Multi Graph—ADL Shell 
You can use the Single/Multi Graph command to toggle between a display of either one or multiple graph boxes 
in the Graphics area. 

Example of a single graph box display 

Example of a multi graph box display 

The command is accessible from the Graph menu or by selecting the Single/Multi Graph button from the 
Graphics toolbar.

Note 
Up to 100 graphs can be displayed in the Graphics area at the one time. 

See also: 
Graph Menu 
Graphics toolbar 
Graphics How To
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Trace Preferences—ADL Shell 
Trace Preferences table | Trace Audit Log

A single graph box can display many traces. This window enables you to select the trace(s) to display (make 
Visible) in the selected graph box. 

The dialog comprises the following: 

Trace Preferences table 

To access the Trace Preferences dialog, select the Trace Preferences command from the Graph menu, 
or select the Trace Preferences button on the Graphics toolbar.

Hot Tip 
The Trace Preferences menu is also available on clicking the right mouse button anywhere in the trace 
listing.

Visible Use the Visible field to select which traces will appear on the selected graph. To select or 
clear the Visible field, simply click the left mouse button in this column. A tick will appear next 
to traces that are to be displayed in the selected graph. 

If you are in single graph view, all selected traces will appear on the one graph. If you are in 
Multi Graph view the traces will appear on the graph that is currently selected.  

Hot Tip 
To make all traces Visible, right-click on the table and select the Select All command 
from the menu. Then right-click on the table again and select the Show Traces 
command from the menu.

Color The Color field enables you to view the color of each trace that appears on the selected 
graph.  To change the color of a trace, highlight it, click the right mouse button in the Trace 
Preferences table and select Change Trace Color. You can then select a color from the 
Color dialog that is displayed. 

The red trace in any graph box is the one on which all information appears. This trace, which is 
used for the cursor tracking, is called the focused trace and it is always red. When you select a 
trace in the Color column it will become the focused trace in the selected graph box. 

Note 
When you change the trace line width in the Graph Preferences dialog it also will 
change the width of the color trace line in this dialog.

Name of 
trace 

The Name of Trace field contains a description of the traces currently available for display in 
the selected graph box.

Filename This field displays the filename and path for the trace. If the name is too long to appear in the 
field you can use the keyboard arrow keys to scroll to the end of the filename or you can resize 
the Trace Preferences window. If the file path for a trace shows 'not saved' then the trace is 
unsaved data and is only stored in memory.
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The Trace Audit Log displays information about the highlighted trace. This includes instrument parameters and 
data form information relating to the trace that has been selected. It also logs all information about data 
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See also: 
Graph menu 
Graphics toolbar  
Graph Preferences  
Trace Preferences menu 
How to make multiple traces visible in a graph 
How to remove a trace from the trace list 
How to remove a trace from a graph
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Trace Preferences menu—ADL Shell 
The Trace Preferences menu is displayed when you click the right mouse anywhere on the Trace Preferences 
table. The menu contains the following commands: 

Select All This selects or highlights all the traces in the listed on the Trace Preferences page.

Select None This de-selects all the traces in the listing.

Show Traces Select Show Traces to make all of the traces currently highlighted Visible, meaning that they 
will be displayed in the current graph box.

Hide Traces Select Hide Traces to remove the Visible property from all the traces currently highlighted, 
which will remove them from the current graph box.

Delete 
Traces 

Select Delete Traces to delete all the highlighted traces in all graphs. Note that if you save the 
data file before you select Delete Traces, the traces are not deleted from the saved file, and 
they can be retrieved at a later date. 
Selecting Delete Traces will delete the traces from the application memory, and it is 
recommended that you select this option if you need to free up memory on your computer. 
This is especially relevant for the ADL Shell application where the data files can be quite large. 

Note 
If the application is controlled by the GLP Administration application, you will be 
prompted to save an unsaved data file before it is removed from the application.

Change 
Trace Color 

Select Change Trace Color to display the Windows Color dialog where you can change the 
color of the currently highlighted trace(s). The focused trace will remain red while it retains the 
focus, and will revert to the selected color when the focus is moved.

See also: 
Trace Preferences 
Graph Preferences 
How to remove a trace from the trace list 
How to remove a trace from a graph
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User Data Form—ADL Shell 
Use the User Data Form to enter extra information about the traces in the highlighted graph box. For example, 
you might want to record information about the experimental conditions you used to collect the data. 

The dialog comprises the following: 

To access the User Data Form, select the User Data Form command from the Graph menu, or select the 
User Data Form button on the Graphics toolbar. The User Data Form command is only available if you 
have selected a graph box.

Data Name This column lists the names of each visible trace in the highlighted graph box. 

Use the extra columns for recording additional information about the experimental conditions 
you used to collect the data, eg. pH. 

Other 
Columns 

Use this to record the name of the parameter in which you are interested as a column heading, 
(for example, pH, ionic concentration, substrate concentration etc.). 

Note 
You must enter a column heading, or else the data in that column will not be saved.

See also: 
Graph menu  
Graphics toolbar
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Function keys—ADL Shell 
The function keys at the top of your keyboard perform basic Cary Eclipse operations simply and quickly. 

Function 
key

What it does

F1 This displays the Help for the current dialog or window.

F4 Press F4 to display the Go to Wavelength dialog.

F5 Press F5 to perform an instrument Zero. The current intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use the 
Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible from the Commands menu or by selecting the Zero button. 

Select the Clear Zero command from the Commands menu to remove zero correction. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell positions 
that are currently in the cell path.

F6 Press F6 to display the Rapid Result dialog where you can read a blank and multiple sample 
readings without changing the application method. 
This command is also accessible from the Commands menu.

F9 If the application is online, press F9 to start a data collection. This is equivalent to selecting the Start 
button. If the application is not online, you will need to press F9 to first connect to the Cary Eclipse. 
Then press F9 to start the data collection. 
This command is also accessible from the Commands menu or by selecting the Start button. 

Note 
You will not be able to perform a Connect if another application is collecting data.

F12 Select this to stop the current measurement. This is equivalent to selecting the Stop button. This 
command is also accessible from the Commands menu or by selecting the Stop button. 

See also: 
Go To Wavelength 
Zero 
Rapid Result 
Stop Instrument Button
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Instrument Status Readings—ADL Shell 
Ordinate status 
This double-height field displays the current intensity reading (ordinate value). It is continually updated during a 
data collection. 

Abscissa status 
This double-height field displays the current wavelength reading (abscissa value) in nanometres. 

 
See also: 
Status line
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Print—ADL Shell 
Use the Print dialog to select the printer and pages to print of the currently displayed report as well as the number 
of copies you wish to print. 

To access the Print option, select the Print command from the File menu. 

All graphical information displayed on screen will be printed with the report, therefore it is advisable to edit the 
report on the screen prior to printing. You can also preview the report prior to printing by using the Print Preview 
command. 

See also: 
Edit Report 
Print Preview
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Print Preview—ADL Shell 
Use the Print Preview dialog to view the current report before you print it. From the File menu, select Print 
Preview to access the dialog. 

The contents of the Graphics area appear first in the preview area followed by the contents of the Report area. 
You can reduce or enlarge the print preview on screen. To do this, click the left mouse button in the preview area 
to toggle through the five available views. Click the right mouse button in the preview area to return to the full 
page view. 

The page comprises the following commands: 

First arrow Use this arrow to view the first page of the report.

Previous 
arrow

Use this arrow to view the previous page of the report.

Next arrow Use this arrow to view the next page of the report.

Last arrow Use this arrow to view the last page of the report. 
Q. Why are the arrow buttons grayed out?
A. The buttons will be grayed out if the report has only one page of data.

Print Use this to display the Windows Print dialog where you can choose the printer and 
pages to print as well as the number of copies you wish to print.

See also: 
File menu
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Report Toolbar—ADL Shell 
Use the Report toolbar buttons to gain quick access to many of the Edit menu options. You can also use the 
toolbar to cut, copy and paste information and to change the look of your report. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Reports. To display or 
hide the toolbar's text labels, point to the Toolbar option in the View menu and select Text Labels. 

The following commands can be accessed from the Reports toolbar: 

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Edit Report Click this button to edit the report. 
This command is also accessible by pressing CTRL+R.

Undo If available, this undoes the last action. 
This command is also accessible by pressing CTRL+Z.

Cut Click this button to remove the highlighted text and place it on the Windows Clipboard.
This command is also accessible by pressing CTRL+X.

Copy Click this button to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.

Paste Click this button to insert the contents of the Windows Clipboard (text only) at the 
cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Click this button to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
This option is only available once you select Edit Report and there is text 
highlighted in the Report area. 

Font Click this button to change the font of new or selected text in the report. For existing 
text, simply highlight the text in the report, select this button and make your changes 
in the Font dialog. When you select OK, the appearance of the highlighted text in the 
report will alter to reflect your font changes. 
This command is also accessible by pressing CTRL+F.

Preview Click this button to display the Print Preview dialog where you can view the current 
report as it will be printed.

See also: 
Print Preview 
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Right mouse menu—ADL Shell 
The following commands are accessible by clicking the right mouse button on editable fields in the Cary Eclipse 
software: 

Undo If available, this reverts to the previous value before the Edit on the field.
Cut If available, this cuts the highlighted text to the clipboard.
Copy If available, this copies the highlighted text to the clipboard.
Paste If available, this pastes the text from the clipboard to the cursor position.
Delete If available, this deletes the highlighted text/number.
Select All If available, this selects all entries.
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Status line—ADL Shell 
The Status Line is displayed at the very bottom of the ADL Shell Application window. The line will display the 
following information (from left to right): 

Hardware Status This field displays status messages indicating the current instrument activity.
Sequence Information This field displays status messages indicating the current system activity.
Current Results This field displays information on the last reading. 

ADL Shell Application window
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Stop Instrument button—ADL Shell 

Select the Stop button to end the current data collection. 

Note 
The ADL Shell does not contain a Start button. You will need to program this button and its functionality in 
your Shell application.
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ADL Hooks—ADL Shell 
The ADL Hooks command is accessible from the View menu.  

Instead of writing a full ADL program you can use ADL hooks to link into an existing application. This 
is particularly useful if you want to make small changes to the way an application works, e.g. you want 
to pop up a dialog for the user to enter some specific data before the run starts. ADL hooks are links at 
specific points in an application at which you can run an ADL program. For example, ADL hooks have 
been supplied to run the following ADL programs:  

ADL Command Line—ADL Shell 

Introduction to ADL 

Use the ADL Command Line to run Single-line or Multi-line Applications Development Language 
(ADL) commands that enable you to perform functions over and above that of the existing program 
functionality. 

Note 
Full documentation on ADL programming is available in the ADL Online Help.  
Click the button below to view this Help.      

Hook Description
AD_PreSeq.ADL This runs when the Start button is pressed.
AD_PostSeq.ADL This runs at the end of the Start button sequence.
AD_Online.ADL This runs when Cary Eclipse is detected online.
AD_OffLine.ADL This runs when Cary Eclipse ‘goes’ offline.
AD_Zero.ADL This runs when the Zero button is pressed.
AD_Recalc.ADL This runs when the Recalc button is pressed.
AD_Shutdown.ADL This runs when the application is shutting down.
AD_PreRead.ADL This runs just before a read is taken.
AD_PostRead.ADL This runs just after a read is taken (It has the reading result stored in the 

UserResult variable.)
AD_PreSetup.ADL This runs when the Setup button is pressed.
AD_PostSetup.ADL This runs when the OK button on the Setup dialog is pressed.
AD_CellChange.ADL This runs instead of the Cary Eclipse driving the Multicell Holder. It enables 

you to add your own instructions for the Cary Eclipse Multicell Holder or to 
use your own cell changing accessory.

See also: 
View menu
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ADL is not a general purpose programming language. It has been developed specifically by Varian to 
meet the needs of spectroscopists. It can be used to handle all the data collected from the Cary Eclipse—
both photometric values and entire data collections. ADL programs that you develop should be stored 
with the extension 'ADL'. 

To access the ADL Command Line, select the ADL Command item from the Commands menu. You 
can also press ALT+Y to open the dialog. 

Software controls 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help. 

Single Line Selecting this lets you enter ADL commands on a single line into the Command Line 
entry box. 

Q. Can I enter more than one ADL command on a single line?
A. Yes, provided that the commands are separated by a semicolon ‘;’.

Multi-line The Multi-line capability enlarges the Command Line entry box. Use the Multi-line 
capability to create a more complex ADL program by adding a series of commands 
over multiple lines. When Multi-line mode is selected, the Quick Reference option 
becomes available.

Quick 
Reference 

Select Quick Reference to open the Quick Reference dialog where you can easily add a 
command in the correct syntax to your ADL program. This option is only available for 
Multi-line commands. 

How to insert ADL commands using the Quick Reference 

A detailed description of all the commands in the Quick Reference is available by 
pressing the Help button on the Quick Reference dialog. 

Browse Select Browse to access the Open dialog where you can browse for and select an 
existing ADL program to load and run.

Command 
Line (entry 
box) 

This entry box enables you to use ADL commands. You can enter single ADL 
commands into this field, or you can enter a series of ADL commands. If you have the 
entry type set to Single Line, you can review previous ADL entries by selecting the 
down arrow to the right of the list box. 

The ADL commands in the Command Line are executed when you select OK. 

Note 
On entering this window, the Cary Eclipse will recall the last command or 
program executed from the Command Line entry box. The ADL commands 
entered in the last executed program are typically stored in the Varian\Cary 
Eclipse WinFLR\ADL directory on the drive on which the Cary Eclipse software 
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is installed.
Hot Tip 
You can rerun the ADL commands in the Command Line entry box from any 
screen in the Kinetics application by pressing Alt-X or selecting Re-run ADL 
from the Commands menu.

See also: 
Commands menu  
ADL Hooks 
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ADL Shell How To—ADL Shell 
Select the procedure you require below for a step-by-step informative guide on running the application 
software. 

ADL Shell How To 

How to use advanced reporting options
How to export collected data
How to insert  ADL commands using the Quick Reference

Graphics How To 

Graphics 

How to alter the look of your graphs
How to make a graphics template

Traces 

How to view a particular trace
How to select the focused trace
How to track the focused trace
How to display a trace that is not appearing in a graph box
How to track the focused trace
How to remove a trace from the trace list

Sizing and scaling 

How to resize graph boxes
How to scale your graph manually
How to scale your graph automatically
How to zoom a graph

Labels 

How to add a label to a graph
How to edit a label
How to move a label
How to delete a label

Pictures 

How to add a picture
How to replace a picture
How to move a picture
How to delete a picture

ADL Shell Home Page Index
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How to insert ADL commands using the Quick Reference—ADL 
Shell 
The Quick Reference window is accessed from the ADL Command window. It enables you to easily add 
a command in the correct syntax to your ADL program. To do this:  

1. Press Alt-Y to open the ADL Command Line window.

2. Select the Multi-line option. The Command Line entry box will expand to take multiple lines of
ADL commands and the Quick Reference check box will appear.

3. Select the Quick Reference check box. The Quick Reference window will appear.

4. If necessary, use the Go To options to jump to the appropriate part of the Quick Reference listing.

5. Highlight the command you require in the Quick Reference.

6. Click the Insert into ADL button. The selected ADL command will appear in the Command Line
entry box.

7. Where necessary, alter the defaults supplied by the inserted Quick Reference command in the
Command Line entry box to suit your program.

8. Repeat steps 4–7 to add more commands as required.

How to export collected data—ADL Shell 
If you want to export data from a Cary Eclipse application into a third-party application, then you 
simply need to save your data as an ASCII *.CSV file. To do this: 

Step 1  

Click on the File menu item. 

Step 2  

Click on Save Data As. The Save As dialog will appear. 

Step 3  

Click on the down arrow next to the Files of type list box. 

Step 4  

Select Spreadsheet ASCII (*.CSV). 

Step 5  
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Type your file name into the File name field.

Step 6  

Press Save to export your data. 

How to use advanced reporting options—ADL Shell 
When you have programmed your ADL Shell reporting options, or when you open an existing file and 
prepare to print the report, you should be aware of some of the ADL Shell's advanced reporting options. 

Options available include:  

Including header and footer information
Including a logo
Editing the text in the report
Viewing the report on screen before printing
Cutting and pasting to a word processor

Including header and footer information 

You can have text appearing at the top and bottom of every page in your report. To specify what the text 
should be, double-click on the  button in the System tray of the Windows Taskbar to display the 
Company tab in System Information. 

Including a logo 

You can include a logo on the first page of your report. To specify what the logo should be, double-click 
on the  button in the System tray of the Windows Taskbar to display the Company tab in System 
Information. If a logo is specified then it will always be included in reports. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can then 
add, delete and change text in the Report area. 

Viewing the report on the screen before printing 

Use the Print Preview selection on the File menu to view the report on screen before printing it. This 
allows you to get the report right before you print it on paper. Use the arrow keys at the bottom of the 
Print Preview screen to change pages. 

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application.

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The
Administrator of the system will have to change your privileges before you can edit reports.
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Cutting and pasting to a word processor 

To have complete control over how your report looks you may need to export it to a word processor. To 
do this: 

Step 1 

Generate a report in your ADL Shell application. 

Step  2 

Select Edit Report on the Edit menu. 

Step 3 

Click in the Report area and click and drag to highlight the text you want to export to your word 
processor. 

Step 4 

Right click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text 
into a document. 

Step 6 

Change back to the ADL Shell. If you want to add a picture of the graphics to your report, you need to 
set up the graphics the way you would like them to appear and then right click on the graphics area. 
Select Copy graph from the menu. 

Step 7 

Change back to your word processor and select Paste again. The graphics will appear as a bitmap. 

Graphics How to…—ADL Shell 
Traces  

How to track the focused trace
How to select the focused trace

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to alter the look of your graphs 
How to display a trace that is not appearing
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How to display a trace that is not appearing in a graph box
How to remove a trace from a graph
How to remove a trace from the trace List

Sizing and scale  

How to resize graph boxes
How to scale your graph manually
How to scale your graph automatically
How to alter the look of your graphs
How to zoom a graph

Labels  

How to add a label to a graph
How to edit a label
How to delete a label
How to move a label

Pictures  

How to add a picture to a graph
How to move a picture
How to delete a picture
How to replace a picture

ADL Shell Home Page Index 

How to add a label to a graph—ADL Shell 
You can add a label to your graph or Graphics area background. To do this: 

Step 1  

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area 
background. 

Step 2  

Select Add Label from the Graph menu or click the Add Label button on the toolbar.The Add Label 
dialog will appear. You can also access the Graph menu to add a label by clicking the right mouse 
button anywhere in the Graphics area. 

Step 3  

Click the Font button. The Windows Font dialog will appear.

Note 
There must be at least one trace Visible in the graph box before you can add a label to it.
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Step 4  

Select the font type, size and style you require for your label. A sample of your label font appears in the 
Sample field.  

Step 5  

Click the OK button when you are satisfied with your selections and return to the Add Label dialog.  

Step 6  

Enter the label in the text entry field and press OK. 

If necessary, you can move a label so that it is more appropriately placed on your graph.  

How to add a picture to a graph—ADL Shell 
You can add a picture to your graph or the Graphics area background. To do this: 

Step 1  

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area 
background. 

Step 2  

Select Add Picture from the Graph menu or click the Add Picture button on the toolbar. The Add Label 
dialog will appear. You can also access the Graph menu to add a picture by clicking the right mouse 
button anywhere in the Graphics area. 

Step 3  

Click the Load button. The Windows Open dialog will appear. 

Step 4  

Browse through your directories to find the picture you want to insert. All pictures must be in the bitmap 
format and will have the extension .BMP.

Note 
If you are viewing multiple graphs the label will only be placed on the graph that is currently 
selected.

See also: 
How to move a label 
How to edit a label

Note 
There must be at least one trace Visible in the graph box before you can add a picture to it.
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Step 5  

Highlight the .BMP that you want to insert and click Open. 

Step 6  

The Add Picture dialog will appear showing a preview of the bitmap. If the bitmap is the correct one 
click the OK button. The bitmap will be placed onto the graph. 

You can move a picture so that it is more appropriately placed on your graph.  

How to alter the look of your graphs—ADL Shell 
Step1 

Click the  button on the toolbar, or select Graph Preferences… from the Graph menu, or click the 
right mouse button in a graph box and select Graph Preferences…. The Graph Preferences dialog will 
appear. 

Step 2  

From the options available there, choose your preferred appearance for the graphs. A preview box in the 
top right-hand corner will demonstrate how the graphs will appear. 

Step 3  

Click OK, and all graphs will change to reflect your choices. 

Step 4  

To save your graphics setup for re-use at a later date, save it as a graphics template. 

Note 
You should take care not to add a bitmap that is too big as it will obscure part or all of your graph.

See also: 
How to move a picture to a graph 
How to delete a picture 
How to replace a picture

Note 
You can also add labels and pictures to your graphs to alter their appearance. 

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
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How to delete a label—ADL Shell 
You can delete a label from a graph or Graphics area background by doing the following: 

Step 1  

Position the cursor on the label and click the left mouse button to select it. 

Step 2*  

Click with the right mouse button. 

Step 3  

From the menu select Delete Annotation… The label will be removed from your graph or Graphics area 
background. 

* An alternative to Steps 2 is to click on the Graph option in the menu bar.

How to delete a picture—ADL Shell 
You can delete a picture from a graph or Graphics area background by doing the following: 

Step 1  

Position the cursor on the picture and click the left mouse button to select it. 

Step 2*  

Click with the right mouse button. 

Step 3  

How to move a picture 
How to resize graph boxes 
How to make a graphics template

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interferring with the label 
selection. Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label 
How to edit a label

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interferring with the graphic 
selection. Try zooming in and clicking in a different part of the picture.
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From the menu select Delete Annotation… The picture will be removed from your graph or Graphics 
area background. 

* An alternative to Steps 2 is to click on the Graph option in the menu bar.

How to display a trace that is not appearing in the graph box—
ADL Shell 
Step 1 

Click on the graph in the Graphics area. 

Step 2 

Click the  button on the toolbar, or select Trace Preferences… from the Graph menu, or click the 
right mouse button in a graph box and select Trace Preferences… The Trace Preferences dialog will 
appear. 

Step 3 

Find that trace that you wish to see and click on the Visible option. A tick should appear. Alternatively, 
for multiple traces you can:  

a. Hold down the CTRL key click on all the traces that you want to display.

b. Click the right mouse button to display the Trace Preferences menu.

c. Select Show Traces to turn on the Visible option for each file.

Step 4 

Press OK to exit the Trace Preferences window. The desired trace will appear. 

How to edit a label—ADL Shell 
Step 1  

Place the cursor on the label and click the left mouse button to select the label. 

See also: 
How to add a picture to a graph 
How to move a picture 
How to zoom a graph

See also: 
How to remove a trace from a graph 
How to remove a trace from the trace list

Hot Tip 
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Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu. Alternatively you 
can select the Edit Annotation command from the Graph menu. The Edit Label dialog is displayed. 

Step 3  

Use the Edit Label dialog to change the label. 

For example, if you want to change the font size of the label, select the Font button. In the Size field, 
scroll through the available sizes for the font and select the size you require. Alternatively, highlight the 
currently selected size in the Size entry field and enter the size you require. Click the OK button in this 
dialog to return to the Edit Label dialog. 

Step 4  

Click OK to clear the Edit Label dialog. Your label will appear with the new font size. 

How to make a graphics template - ADL Shell—ADL Shell 
A graphics template lets you set up and store the style of a graphics report for future use. You can do 
this by adding labels and pictures to the background of the Graphics area and altering any axes styles 
etc. One advantage of this over the application's built-in reporting features is that you have more 
flexibility as to where you can position graph boxes and any text that you may want to appear (e.g. 
operator name, batch number etc.) and also where you add pictures, e.g. company logos etc. 

Step 1 

Start the application and open the data file from which you want to make a graphics template. 
Alternatively, collect some new data. 

Step 2 

Make as many graph boxes as you require in your template by using the Add Graph function. 

Step 3 

Adjust the graph boxes to the correct size and position them as you want them to appear in the template. 

Step 4 

Do any of the following, if required: 

If you are having trouble selecting the label it may be that a trace is interferring with the label 
selection. Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label 
How to delete a label
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Change the appearance of the graph boxes in the Graph Preferences dialog
Use the Add Label function to append text to the Graphics area
Use the Add Picture function to add pictures, such as your company's logo to the Graphics area

Step 5 

From the File menu, select Print Preview. Use the Print Preview dialog displayed to check the 
template that you have created. 

Step 6 

When you are satisfied with the appearance of the graphics, select the Save As… command from the 
File menu. The Save As dialog is displayed. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and 
select 'Graph Template' to list all the template files. Ensure that the Save only focused trace check box 
is cleared. 

Step 8 

Enter a name for the template in the File name field. 

Step 9 

Select OK to save the graphic template. The template will be used each time you create a new file. 

How to move a label—ADL Shell 
Step 1  

Place the cursor on the label. 

Step 2  

Click and hold down the left mouse button. 

Note 
You can also make a graphic template in a similar manner from existing data. No data will be saved 
in the template. 

See also: 
Example of a Graphics Template 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture

Hot Tip 
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Step 3  

Drag the label to the appropriate position on the graph or Graphics area background.  

Step 4  

Release the mouse button. The label will appear at the new position. 

How to move a picture—ADL Shell 
You can move a picture so that it is more appropriately placed on your graph or Graphics area 
background. 

Step 1  

Place the cursor on the picture. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the picture to the correct position. 

Step 4  

Release the mouse button. 

If you are having trouble selecting the label it may be that a trace is interferring with the label 
selection. Try zooming in and clicking in a different part of the label.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interferring with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to delete a picture 
How to replace a picture
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How to remove a trace from a graph—ADL Shell 
Step 1 

Click on the graph in the Graphics area. 

Step 2 

Click the  button on the toolbar, or select Trace Preferences… from the Graph menu, or click the 
right mouse button in a graph box and select Trace Preferences…. The Trace Preferences dialog will 
appear 

Step 3 

Find that trace that you no longer wish to see and click on the Visible option. The tick should disappear. 
Alternatively, for multiple traces you can:  

a. Hold down the CTRL key click on all the traces that you no longer want to display.

b. Click the right mouse button to display the Trace Preferences menu.

c. Select Hide Traces to turn off the Visible option for each file.

Step 4 

Press OK to exit the Trace Preferences window. The sample trace will be removed from the graph. 

How to remove a trace from the trace list—ADL Shell 
Deleting a trace from the Trace Preferences window (as opposed to making it invisible) frees up 
application memory and helps system performance. 

Step 1  

Click on any graph in the Graphics area. 

Step 2  

Click the  button on the toolbar, or select Trace Preferences… from the Graph menu, or click the 
right mouse button in a graph box and select Trace Preferences…. The Trace Preferences dialog will 
appear 

Step 3  

Select the trace to be removed by clicking on it. 

See also: 
How to display a trace that is not appearing in the graph box 
How to remove a trace from the trace list
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Step 4  

Click the right mouse button to display the Trace Preferences menu. 

Step 5  

Select Delete Traces to delete the sample from the trace list. The software will prompt you to confirm 
this. 

Step 6  

Press OK to exit the Trace Preferences window. The sample trace will be removed from all graphs. 

How to replace a picture—ADL Shell 
You can change a picture that you have added to a graph or Graphics area background using the 
following: 

Step 1  

Move the cursor to the picture and click the left mouse button to select it. 

Step 2*  

Click the right mouse button. 

Step 3  

Select Edit Annotation from the Graph menu that appears. 

Step 4  

Click the Load button. The Windows Open dialog will appear. 

Step 5  

Browse through your directories to find the picture to replace the current bitmap. All pictures must be in 
the bitmap format and have the extension .BMP. 

Step 6  

Highlight the .BMP that you want to insert and click Open.

See also: 
How to remove a trace from a graph 
How to display a trace that is not appearing in the graph box

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interferring with the graphic 
selection. Try zooming in and clicking in a different part of the picture.
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Step 7  

The Edit Picture dialog will appear showing a preview of the bitmap. If the bitmap is the correct one 
click the OK button. The bitmap will be placed onto the graph. 

If you need to, move the picture so that it is more appropriately placed on your graph. 

* An alternative to Step 2 is to click on the Graph option in the menu bar.

How to resize graph boxes—ADL Shell 
Step 1  

Click on the graph that you want to resize so that the highlight box appears around it. 

Step 2  

Move the cursor to the edge of the highlight box and place it over one of the square marks (e.g. ) in the 
box until it turns into a double headed arrow ( ). 

Step 3  

Click and hold the left mouse button and drag the box to the desired size. 

Step 4  

Release the left mouse button. 

How to scale your graph manually—ADL Shell 
Step 1  

Click on the graph whose axes you want to change. 

Step 2  

Click the  button on the toolbar, or select Axes Scales… from the Graph menu, or click the right 
mouse button in a graph box and select Axes Scales… The Axes Scales… dialog will appear.

Note 
You should take care not to add a bitmap that is too big as it will obscure part or all of your graph.

See also: 
How to add a picture to a graph 
How to move a picture 
How to delete a picture

See also: 
How to alter the look of your graphs
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Step 3  

Type in your new ranges for the X and Y axes in the format ‘n-n’, or choose an option for each from the 
drop-down list. 

Step 4  

Press OK. The axes on the selected graph will change to reflect your chosen settings. 

How to scale your graph automatically—ADL Shell 
Step 1  

Click on the graph whose axes you want to change. 

Step 2  

Make sure that the trace that you wish to autoscale is the focused trace. 

Step 3  

Click the  button on the toolbar if you want the application to autoscale both X and Y axes. 

Alternatively click on the  button or the  button to autoscale only the X or Y axis. (You can also 
select these options from the Graph menu.) 

The application will scale the focused trace according to the option selected. 

How to select the focused trace—ADL Shell 
To select the scan that you want to be the focused (red) trace, do the following:  

Click the left mouse button on the trace that you want to become the focused trace in a graph box.

Hot Tip 
Click on the Zoom Out option or button to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale a graph automatically

Hot Tip 
Click on the Zoom Out option or button to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale your graph manually

Page 16 of 19ADL Shell How to

   



Click the left mouse button on the trace that you want to become the focused trace in the legend,
to the right of the graph.

Click on the trace that you want to become the focused trace in the Color column of the Trace
Preferences window.

How to track the focused trace—ADL Shell 
To track the focused (red) trace in the graph: 

Step 1  

Click on the  button on the toolbar, or select Cursor Mode from the Graph menu. The Cursor Modes 
dialog will appear. 

Step 2  

Select Track and click the OK button. 

Step 3  

Place the blue tracking cursor in the graph box you require.  

Step 4  

Move the cursor left and right across the graph box to trace the focused (red) scan. The cursor 
coordinates change (in the X, Y field at the bottom left hand corner of the Graphics area) as you move 
along the curve. 

Note 
Check the Show Legend check box in the Graph Preferences dialog to display the legend in each 
graph box. 

See also: 
How to track the focused trace 
How to view a particular trace

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the required 
position. Press 'Alt' on the keyboard, then release the mouse button. 

See also: 
How to select the focused trace 
How to view a particular trace
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How to zoom a graph—ADL Shell 
To do this, use the following procedure:  

Step 1  

Click on the  button on the toolbar, or select Cursor Mode from the Graph menu. The Cursor Modes 
dialog will appear. 

Step 2  

Select Free and click the OK button. 

Step 3  

Click and hold down left mouse button in the highlighted graph box.  

Step 4  

Drag the mouse sideways and up or down. You will see a zoom box made up of a dotted line appear on 
the screen. (See picture below.) 

The dotted line is a zoom box. 

Step 5  

Release the left mouse button. The area defined by the zoom box will be redrawn to fill the entire graph 
box, and the scans within the box will be enlarged accordingly. The abscissa (X) and ordinate (Y) 
coordinates displayed below the graph will also be changed to reflect the positions of the corners of the 
zoom box.  

You can repeat this process if you need to zoom in even further. 

Hot Tip 
To move the box on the screen, hold down the left and right mouse buttons together. You can then 
position the box anywhere in the graph box. Releasing the right mouse button will still allow you 
to resize the zoom box. 

Note 
The system may limit the extent to which you can Zoom. 

See also: 
How to scale your graph manually 
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How to scale your graph automatically
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Introduction 

Use the Advanced Reads application to set up methods and read multiple samples in a single run. 

The features of the application include:  

finding the mean of multiple readings of the sample solution  
finding the mean of multiple sample aliquots of the sample solution  
three different data modes—fluorescence, phosphorescence and chemi-/bio-luminescence 
the ability to use various accessories  

To access the Advanced Reads Application, select the Windows Start button, point to Programs, Cary Eclipse 
and then select Advanced Reads. 

Software controls 

The application comprises the following: 

Advanced Reads Application 

Instrument 
Status 
Readings 

The Instrument Status Readings, which display the Y and X values of the graph axes are 
displayed in the top left and right corners of the Advanced Reads Application window. 

Y value 
Displays the current Y value, usually intensity. This value is continually updated during a data 
collection. 

X values 
Displays the Excitation and Emission wavelengths. 

Start and 
Stop 
buttons 

The Start and Stop buttons at the top of the Advanced Reads Application window are used to 
start and stop instrument analyses. These buttons can also be accessed from the 
Commands menu. 

Tell me more about the Start and Stop buttons 

Report area In the Advanced Reads Report area you can view the current report. The report may include 
the results of your data collection and the method parameters used to collect the results. You 
can select the information to include in your report in the Reports tab of the Setup dialog. 

You can copy the generated report onto the Windows clipboard. To do this, highlight the 
report (or the relevant section) and press CTRL+C. Alternatively, you can select the Copy 
button on the Report Toolbar. You can then paste the report into a word processor such as 
Microsoft® Word. 

Hot Tip 
You can edit the Advanced Reads Report by pressing CTRL+R or selecting the Edit 
Report command from the Edit menu. Alternatively, you can select the Edit button on 
the Report Toolbar. 

Commands The Advanced Reads Application window contains the following commands, all of which can 
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also be accessed from the various menus in the application. 

Click on the buttons to view information about them:

Hot Tip 
By becoming familiar with these commands (Setup, Zero, Reread, etc.), you can 
remove the Command buttons from the Advanced Reads window. This will 
automatically enlarge the Report area, making it easier to view results. To do this, clear 
the Buttons item in the View menu. 

Menus The Advanced Reads Application contains the following menus:  
File, Edit, View, Commands, Setup, Help

 
See also: 
Advanced Reads home page 
Keyboard function keys 
Report Toolbar 
Status Line
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Validation of your Cary Eclipse for the Advanced Reads 
application 
Three files are shipped with the Advanced Reads application to enable you to validate the software. The files are 
stored on your CD in a Validation subdirectory. 

To validate your software, you should Open each file in turn and select the Recalculate button. The results 
calculated by the Cary Eclipse should match those given in the validation file listed below. These results were 
determined by exporting the data to a spreadsheet program and performing the same calculation as that used in 
the Advanced Reads application.  

Advanced Reads validate_replicates.FBAB  
Advanced Reads validate_duplicates.FBAB  
Advanced Reads validate_triplicates.FBAB
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Getting ready to read samples—Advanced Reads 
Setup dialog
Setup menu
Cary page
About collection modes
User collect example
Bio-/Chemi-luminescence and Phosphorescence Options dialog
Gate Time for Bio-/Chemi-luminescence
Gate Time for Phosphorescence
How many flashes?
Options page
Accessories page
Multicell/Temperature Control
Multicell Changer
Wellplate
Go To Well
Wellplate Sample List
Polarizer
G-Factor
Samples page
How to import sample labels
Reports page
Clear Report
How to use the advanced reporting options
Auto Store page
How to email the results

The Setup dialog enables you to set up your Cary Eclipse prior to a read. It also allows you to set up the 
Samples, Accessories, Report and Storage parameters associated with the read. 

Cary
Options
Accessories
Samples
Reports
Auto Store

Use the Setup menu to access the parameters for setting up a Advanced Read. 

Setup—Advanced Reads 

To access the Setup dialog select the Setup button from the Simple Reads Application 
window or the Setup command from the Setup menu.

Setup—Advanced Reads 
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Instrument Setup | Wavelength Setup | Status Display 

Use the Cary page to set up the instrument parameters associated with the data collection. 

From the Setup menu, select Cary to access the Cary page. You can also access the page from the 
Setup dialog by selecting the Cary tab. To access the Setup dialog, select the Setup button from the 
Advanced Reads Application window. 

The page comprises the following: 

Instrument setup 

Command What it does…
Setup Choose Setup to display the Setup dialog where you can set up your instrument for an 

Advanced Reads measurement. The Setup dialog can also be accessed from the Setup 
command button.

Cary Choose Cary to display the Cary page. You can use this page to set up the instrument 
parameters associated with the data collection.

Options Choose Options to display the Options page where you can set up your filters and set 
the detector voltage. You can also use this page to select the way the collected data is 
displayed in the Graphics area, and the type of smoothing applied (if any).

Accessories Choose Accessories to display the Accessories page. You can use this page to set up 
the accessory parameters associated with the data collection.

Samples Choose Samples to display the Samples page. Use the Samples page to specify a list 
of sample names that will be used during your analysis.

Reports Choose Reports to display the Reports page. You can use this page to set up the 
report parameters associated with data collection.

Auto Store Choose Auto Store to display the Auto Store page where you can specify if and when 
data will be stored, and in what format.

See also: 
Cary  
Options  
Accessories  
Samples  
Reports  
Auto Store

Cary—Advanced Reads 

Data mode Fluorescence 
Fluorescence refers to the emission of light from an excited single state. The 
fluorescence signal is measured when the lamp flashes. 

Bio-/Chemi-luminescence 
Bio-/Chemi-luminescence refers to bio- or chemi-luminescence, where the emission is 
generated via a chemical or biochemical reaction. The lamp does not flash in Bio-
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Wavelength setup 

/Chemi-luminescence mode.  

Phosphorescence 
Phosphorescence refers to the emission of light from an excited triplet state. 
Phosphorescence is measured after the lamp has stopped flashing.  

Options Select Options to open the Options dialog where you can set parameters such as the 
Decay, Delay and Gate times for your sample. 

The Options button is only visible if you have selected Bio-/Chemi-luminescence or 
Phosphorescence as the Data Mode. 

Multi- 
wavelength 

Select the Multi-wavelength option if you wish to compare the intensity of a sample 
at up to six different wavelengths. You can use it to compare the emission intensity of 
different excitation wavelengths and the excitation intensity of different emission 
wavelengths. Note that in Bio-/Chemi-luminescence mode, you can only compare 
emission wavelengths. 
If you select Multi-wavelength, the following options will be available: 

Number of wavelenghts 
Enter the number of wavelengths you wish to monitor. You can monitor up to six at 
one time. The number of wavelengths you select are represented as rows in the multi-
wavelength table. 

Multiwavelength table 
Enter the excitation and emission wavelengths for each wavelength in the table. (Note 
that in Bio-/Chemi-luminescence mode, you can only enter the emission wavelengths. 
If you have selected more than two wavelengths to monitor, use the up and down 
arrows to the right of the table to access all of the wavelengths. 

Ex. 
Wavelength 
(nm) 

Set the wavelength of the excitation monochromator, which is the wavelength value at 
which you want to excite your sample. Click the arrow to the right of the field to 
quickly select the most recent wavelength entries. 

Alternatively, to set the excitation monochromator to zero order (white light), from the 
Commands menu, point to Zero Order and select Excitation. A tick next to this 
option indicates that it is selected. Clear this option to return to monochromator light 
and use the value set in the Ex. Wavelength field. 

Em. 
Wavelength 
(nm) 

Set the wavelength of the emission monochromator, which is the wavelength value at 
which your sample emits. Click the arrow to the right of the field to quickly select the 
most recent wavelength entries. 

Alternatively, to set the emission monochromator to zero order (white light), from the 
Commands menu, point to Zero Order and select Emission. A tick next to this 
option indicates that it is selected. Clear this option to return to monochromator light 
and use the value set in the Em. Wavelength field. 
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User Collect Select User Collect to display the User Collect field. The Ex. Wavelength and Em. 
Wavelength fields will not be available. Note that this option is not available if you 
select Multi-wavelength mode. 

Use the User Collect entry field to enter an ADL command which applies a 
mathematical expression to the intensity value collected. The most recent user collect 
entries will be saved in the drop down list to a maximum of 10. 

The Syntax for ADL commands is: 

Read (Ex. wavelength, Em. Wavelength) 

Hot Tip 
You can perform multi-ratio and multi-equation reads using the User Collect 
option. That is, you can calculate more than one ratio or equation in the one 
read, rather than performing separate reads for each ratio or equation. 

For multi-ratios, use the format: 

Read(355, 405)/Read(355, 480); Read(355, 500)/Read(355, 600) 

An example of a multi-equation might be (without a line break): 

2.1*Read(340, 510)/Read(405, 600); 7.5*Read(350,450)-4.5*Read(525, 610)
+25.5*Read(600, 750)

The semi-colon (;) separates each ratio or equation. In addition to the results of 
each ratio or equation, the raw readings for each wavelength used will also be 
reported. 

Ex. Slit (nm) Set the slit width of the excitation monochromator. The Ex. Slit option is not available 
if you have selected Bio-/Chemi-luminescence as the Data mode. 

As a general rule: 
At a fixed emission slit width, increasing the excitation slit width will result in an 
increase in the fluorescence excitation intensity. 

Em. Slit 
(nm) 

Set the slit width of the emission monochromator 

As a general rule: 
At a fixed excitation slit width, a two-fold increase in the emission slit width will 
result in a four-fold increase in the emission intensity. Accordingly, a two-fold 
decrease in the emission slit width will result in a four-fold decrease in the emission 
intensity. 

Ave time (s) Set the amount of time, in seconds, for which data is averaged. To do this, enter the 
amount in the Ave. time field, or use the up/down arrows to the fight of the field to 
increase or decrease the time. The averaged result is displayed in the report. 

When setting the Ave Time, consider the following:  
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Status Display 

Select this check box to display the Status Display window, where you can view the status of various 
parameters during the data collection. 

About collection modes—Advanced Reads 
In the Advanced Reads application, you can choose from three types of Data Modes: Fluorescence, Bio-
/Chemi-luminescence or Phosphorescence. The Data Mode option is set on the Cary page of the Setup 
dialog. 

Fluorescence 

Fluorescence refers to the emission of light from an excited single state (lifetime 10-11–10-7 sec). The 
fluorescence signal is measured when the lamp flashes. 

If you select Fluorescence mode, the Cary Eclipse will do the following: 

Generate emission with light source
Measure the emission with the light source on

Bio-/Chemi-luminescence  

The longer the Ave Time, the longer the signal will be averaged
A longer Ave Time will result in more precise results as the averaging of the
signal reduces any contribution of background ‘noise’.

Averaging is calculated as follows: 

For fluorescence: 
the number of readings averaged are taken from consecutive flashes at 80 Hz where: 
number of consecutive flashes = averaging time/0.0125. 

For phosphorescence: 
the intensity readings are taken from different decays, where: 
number of decays = averaging time/gate time. 

For bio-/chemi-luminescence: 
a signal is collected every Gate time, and (averaging time/gate time) signals are 
averaged.  

Understanding Average Time and Gate Time 

See also:   
Options dialog   
Example of a User Collect 
Accessories  
Status Display
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Bio-/Chemi-luminescence refers to bio- or chemi-luminescence, where the emission is generated via a 
chemical or biochemical reaction. The lamp does not flash in Bio-/Chemi-luminescence mode.  

Generate emission with light source off
Measure emission with light source off

Phosphorescence 

Phosphorescence refers to the emission of light from an excited triplet state (lifetime 10-3 to 102 sec). 
Phosphorescence is measured after the lamp has stopped flashing.  

Generate emission with light source
Measure emission with light source off

User Collect examples—Advanced Reads 
You can extend the functionality of your Cary Eclipse instrument by using the built-in Read command. 

See also: 
Cary page  
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This command enables you to change the instrument to a different wavelength and take a reading. You 
can combine this command with the mathematical operators: ‘+’, ‘–’, ‘*’ and ‘/’. This is illustrated in 
the examples below. 

Read(340, 400)-Read(340, 450) 

This reads the intensity at Excitation monochromator = 340, Emission monochromator = 400 and 
subtracts the intensity read at Excitation monochromator = 340 and Emission monochromator = 450. 
This reading is performed at each data point. 

Bio-/Chemi-luminescence/Phosphorescence Options—Advanced 
Reads 

Dialog controls | Example of the options 

Use the Bio-/Chemi-luminescence/Phosphorescence Options dialog to set up the parameters 
associated with these two measurement modes. 

To access the dialog, select the Options button from the Cary page. 

Dialog controls 

The Bio-/Chemi-luminescence/Phosphorescence Options dialog comprises the following options: 

Note 
The Options button is only visible on the Cary page if you have selected Bio-/Chemi-
luminescence or Phosphorescence as the Data mode.

Total decay 
time 

Enter, in seconds, the total decay time for your sample. The total decay time is the time 
that it takes for the phosphorescence signal to decay to dark levels (zero). The lamp 
will not flash again until the total decay time has elapsed. 
The range is 0.001–1800.000 s. 

Note 
This option is not available in Bio-/Chemi-luminescence mode.

No. of flashes Enter the number of lamp flashes required, which is how many times the lamp flashes 
consecutively before the delay time is counted. 

If you are measuring phosphorescence samples that have a relatively long decay time 
(that is, a number of seconds), you can setup the Cary Eclipse to pulse the lamp 
multiple times, as this will increase the intensity of the phosphorescent signal. For short 
lived phosphorescent samples, multiple flashes will not impact on the intensity of the 
signal, and therefore only one flash is required. 

How many flashes should I perform? 

Note 
This option is not available in Bio-/Chemi-luminescence mode.
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Example of the Bio-/Chemi-luminescence/Phosphorescence Options 

Understanding Gate Time for Bio-/Chemi-luminescence Scans—
Advanced Reads 
Gate Time is set on Options page, which is accessible from the Cary page.

Delay time Enter, in milliseconds, the delay time for your sample. The delay time is the time that 
elapses between the last flash and the beginning of data collection. The default value is 
0.100 ms. Setting a delay time ensures that there is no lamp effects in the 
phosphorescence decay curve. 
The range is 0.000–5000.000 ms. 

Note 
This option is not available in Bio-/Chemi-luminescence mode.

Gate time Enter, in milliseconds, the gate time for your sample. The gate time is the overall 
reading time of the emission signal. 
The range is from 10µs–10s. 

Understanding Average Time and Gate Time for Phosphorescence scans   
Understanding Gate Time for Bio-Chemi-luminescence scans  

See also: 
Cary page
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The following diagram highlights the Gate Time setting.

The Gate Time is set to 10 and the Intensity is equal to IT.

Understanding Average Time and Gate Time for 
Phosphorescence Scans—Advanced Reads 
For Phosphorescence scans, there is a relationship between Average Time (the time for which data is 
averaged) and Gate Time (the overall reading time of the emission signal).  

Averaging is calculated as follows: 

The intensity readings are taken from different decays, where: 
Number of Decays = Averaging Time/Gate Time 

Average Time is set on the Cary page of the Setup dialog. Gate Time is set on Options page, which is 
accessible from the Cary page. 

The following diagrams highlight the relationship between Average Time and Gate Time. 

Example 1 

See also: 
Understanding Average Time and Gate Time for Phosphorescence scans  
Advanced Reads Application  
Cary page  
Options dialog   
User Collect example 

Note: 
Gate Time is not used if you select Fluorescence as the Data Mode. 
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When the Average Time and Gate Time are set to the same value:

where: 

Example 2 

When the Average Time is set to five times the Gate Time: 

Average Time/Gate Time 1

Intensity 1 (Area I1)

Total Decay Time 20 ms
Delay Time 10 ms
Average Time 5 ms
Gate Time 5 ms

Average Time/Gate Time 5
Intensity A1 + A2 + A3 + A4 + A5 

____________________ 

5 
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where: 

Total Decay Time 20 ms
Delay Time 10 ms
Average Time 5 ms
Gate Time 25 ms

See also: 
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How many flashes should I perform?—Advanced Reads 
The Number of Flashes option is set in the Bio-/Chemi-luminescence/Phosphorescence Options 
dialog. To access the dialog, select the Options button from the Cary page. 

If you are measuring phosphorescence samples that have a relatively long decay time (that is, a number 
of seconds), you can setup the Cary Eclipse to pulse the lamp multiple times, as this will increase the 
intensity of the phosphorescent signal (refer to Example 1, below). For short lived phosphorescent 
samples, multiple flashes will not impact on the intensity of the signal, and therefore only one flash is 
required (refer to Example 2, below). 

Example 1 
The above example shows that the sample does not decay before the instrument lamp flashes again. 
Therefore setting multiple flashes will result in an increase in the intensity of the signal. 

Understanding Gate Time for Bio-Chemi-luminescence scans  
Advanced Reads Application  
Cary page  
Options dialog   
User Collect example 

Note 
The Options button is only visible on the Cary page if you have selected Bio-/Chemi-
luminescence or Phosphorescence as the Data mode.
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Example 2 
The above example shows that the sample decays in less time than the time it takes the instrument to 
flash the lamp again. Therefore, setting more than 1 flash, in the No. of Flashes field will not increase 
the intensity of the signal. 

Use the Options page to set up your filters and set the detector voltage.  

From the Setup menu, select Options to access the Options page. You can also access the page from 
the Setup dialog by selecting the Options tab. To access the Setup dialog, select the Setup button from 
the Advanced Reads Application window. 

See also:   
Bio-/Chemi-luminescence/Phosphorescence Options 

Options—Advanced Reads 

Excitation 
filter 

Set the excitation filter for the Advanced Reads measurement. To do this, select the 
down arrow to the right of the field and select an option from the list. 

A range of filter settings are available: 

Auto 
If you select the Auto option, the filter wheel will be automatically moved to the 
appropriate position for the selected excitation wavelength. It is recommended that you 
set the filter to Auto (which is the default setting).  

Open 
If you select Open no filter is used. 

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 

250–395, 335–620, 550–1110, 695–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you 
can select your filter manually. Otherwise it is recommended that you set the filter to 
Auto. 

Emission 
filter 

Set the emission filter for the Advanced Reads measurement. To do this, select the 
down arrow to the right of the field and select an option from the list. 

A range of filter settings are available: 

Auto 
If you select the Auto option, the filter wheel will be automatically moved to the 
appropriate position for the selected emission wavelength. It is recommended that you 
set the filter to Auto (which is the default setting).  

Open 
If you select Open no filter is used. 

Page 13 of 33Getting Ready to read Samples

   



Use the Accessories page to set up the accessory parameters associated with the data collection. 

From the Setup menu, select Accessories to access the Accessories page. You can also access the page 
from the Setup dialog by selecting the Accessories tab. To access the Setup dialog, select the Setup 
button from the Advanced Reads Application window.

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 

250–395, 295–1110, 360–1110, 430–1110, 550–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you 
can select your filter manually. Otherwise it is recommended that you set the filter to 
Auto. 

3%T Attenuator 
Select 3%T Attenuator to decrease the fluorescence intensity and thus the amount of 
light going to the emission PMT. 

PMT 
Detector 
Voltage 

Set the EHT or sample detector PMT. To do this, select one of the following: 

Low 
Sets the PMT Detector voltage to a pre-defined value of 400 v. Typically you would 
select this setting if you are reading highly emitting samples. 

Medium 
Sets the PMT Detector voltage to a pre-defined value of 600 v. Typically you would 
select this setting if you are reading moderately emitting samples. 

High 
Sets the PMT Detector voltage to a pre-defined value of 800 v. Typically you would 
select this setting if you are reading low emitting samples. 

Manual 
Enables you to enter any PMT voltage in the adjacent Volts field. 

Volts 
Enter the PMT voltage in the adjacent field. Note that this option is only available if 
you have selected Manual as the PMT Detector voltage. 

Tip 
Increasing or decreasing the PMT Detector Voltage by 10% will double or halve 
the fluorescence intensity observed.

Status 
Display 

Select this check box to display the Status Display window. This window allows you 
to view the status of various parameters during the data collection.

See also: 
Setup 
Status Display window

Accessories—Advanced Reads 
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The Accessories page will vary, depending upon what accessory button you have selected from the 
following:  

Multicell/Temperature Control
Wellplate
Polarizer

Multicell Holder | Temperature Control | Temperature Display 

The Multicell/Temperature accessory page is displayed when you select the Multicell/Temperature tab 
on the Accessories page. 

The page comprises the following:  

Multicell Holder 

Select this option to use the Multicell Holder with the Cary Eclipse.  

See also: 
Cary

Multicell/Temperature accessories—Advanced 
Reads 

Note 
If you select the Multicell holder accessory, you will not be able to select the Wellplate reader 
accessory.

Multi-zero If you select Multi-zero, a Multi-zero will be performed when the Zero button is 
selected in the Advanced Reads Application window. A reading will be taken at the set 
Averaging Time at the specified wavelengths of one or both monochromators and at 
every selected cell position. These readings will be offset to zero and subsequent 
readings will have the corresponding offset value subtracted from each cell.

Reset Select Reset to drive the Multicell Holder to cell position 1, which is its fully retracted 
or zero position.

Go to cell… Select Go to cell to open the Multi Cell Changer dialog. You can use this dialog to 
manually move the Multicell Holder accessory to a new cell. To do this, simply select 
the corresponding button of the cell you require in the Multi Cell Changer dialog. The 
Multicell Holder will move the selected cell to the measurement position in the sample 
compartment. 

The Multi Cell Changer dialog is ‘modeless’ which means that it can remain open even 
once you have cleared the Setup dialog. This enables you to use the Rapid Read 
command to perform a reading at the cell specified in the Cell Changer. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse 
will display the intensity reading corrected by the determined zero-offset amount for 
that cell. 
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Temperature Control 

Select Temperature Control to specify the Temperature parameters for your analysis. 

Note 
You can use this option to check the intensity of a cell or perform a read at a 
particular cell.

Note 
The Temperature Control option does not control temperature accessories that are not listed in the 
Device field. For example, if you have selected the Temperature Control option and set the 
Device to None because you have a different temperature control accessory, the Cary Eclipse 
software will not control that accessory. However, it will monitor the temperature and prompt the 
software to start when the accessory reaches the temperature listed in the Temperature field.

Device Select the device that will be used to control the water temperature. 

The options available will depend upon whether or not you have selected the Multicell 
holder option. 

If you have selected the Multicell holder, 
the following Device options will be 
available for selection: 

If you have not selected the Multicell 
holder, the following Device options will 
be available for selection: 

Temperature controller
PCB 150 water bath
None

Single cell peltier
PCB 150 Water bath
None

None 
Select this option if you are using a Temperature Control device not listed in this field 
(for example, a third party water bath). Note that the Cary Eclipse software will not 
control the accessory. The software will simply monitor the temperature and prompt 
the software to start when the accessory reaches the temperature listed in the 
Temperature field. 

PCB 150 water bath 
Select this option if you are using the PCB 150 water bath. 

Single cell peltier 
Select this option if you are using the Single cell peltier.  

Temperature controller 
Select this option if you are using the Temperature controller.  

Temperature Set the temperature at which the analysis will be performed. The default value is 
20.00° C. 

When you select OK to close the Setup dialog, all buttons in the Advanced Reads 
Application window will be disabled until the temperature recorded by the Monitor 
device is within ± 0.5°C of the temperature range.  
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Temperature Display 

Select this option to view Temperature Display information in the Status Display window. 
The Temperature Display option is only available if you have selected the Temperature Control 
option. 

Status Display 

Select this check box to display the Status Display window. Use this window to view the status of 
various parameters during the data collection. 

Multi Cell Changer—Advanced Reads 
Use the Multi Cell Changer dialog to manually move the Multicell Holder accessory to a new cell. To 

If Zero or Start is selected, and the temperature is not within ± 0.5°C of the temperature 
range, then the system will wait for the temperature to fall within the temperature range 
before continuing with the measurement. Whilst waiting for the temperature, there will 
be a display on the status line at the bottom of the Advanced Reads Application 
window giving the current temperature and the elapsed time waiting to reach the set 
temperature. 

Port Select from COM1, COM2, COM3 or COM4. 
This option is only available if you have selected PCB 150 Water bath as the Device.

Monitor Select which device will be used to monitor the reaction temperature. The options in 
this field will change depending on the Device selected. 
Device selected Monitor options available
None Probe 1, Probe 2, Probe 3, Probe 4
PCB 150 water bath PCB 150, Probe 1, Probe 2, Probe 3, Probe 4
Single cell peltier Block, Probe 1, Probe 2, Probe 3, Probe 4
Temperature controller Block, Probe 1, Probe 2, Probe 3, Probe 4

Block/ 
PCB 150 

Select this option to view the temperature of the Block or the PCB 150 in the Status 
Display window. This option is not available if you have selected None as the Device 
option. 

Note that the PCB 150 option is only displayed if you have selected the PCB 150 
Water Bath as the Device option without the Multicell holder. 

Probes Select one or more of these options to view the temperature of the Probes in the Status 
Display window.

See also: 
PCB 150  
Multi Cell Changer 
Advanced Reads Application  
Cary  
Accessories  
Status Display
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access the Multi Cell Changer dialog, select the Go to cell button from the Multicell/Temperature 
Accessories page. 

The dialog comprises the following: 

The Wellplate accessory page is displayed when you select the Wellplate tab on the Accessories page. 

The page comprises the following:  

Wellplate reader 

Select this option to use the wellplate reader with the Cary Eclipse. 

Multicell 
changer 

To manually move the Multicell Holder accessory to a new cell, simply select the 
corresponding  button of the cell you require in the Multi Cell Changer dialog. The 
Multicell Holder will move the selected cell to the measurement position in the sample 
compartment. 

The Multi Cell Changer dialog is ‘modeless’ which means that it can remain open even 
once you have cleared the Setup dialog. This enables you to use the Rapid Read 
command to perform a reading at the cell specified in the cell changer. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse 
will display the intensity reading corrected by the determined zero-offset amount for that 
cell. 

Note 
You can use this option to check the intensity of a cell or perform a scan at a 
particular cell.

See also: 
Multicell/Temperature Accessories 
Rapid Read

Wellplate accessory—Advanced Reads 

Q. Why is the wellplate option unavailable?
A. The multicell holder, temperature control and/or polarization accessory has been selected. As
you cannot place any of these accessories and the wellplate reader in the Cary Eclipse sample
compartment at the same time, you must clear other accessory selections before selecting the
wellplate reader.

Plate format Select the type of wellplate to be used. The default options are 6 wells, 12 wells, 24 
wells, 48 wells, 96 wells, 192 wells or 384 wells. 
The bitmap representing the wellplate will change according to the number of wells 
chosen.

Auto-zero Select this option to perform an auto-zero when the Zero button is selected from the 
Advanced Reads Application window. A zero reading will be taken at the selected well 
position using the current method setup. To select the well position to be zeroed, use 
the Select Well option. 
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Status Display 

Select this check box to display the Status Display window. This window allows you to view the status 
of various parameters during the data collection. 

Go To Well—Advanced Reads 
You can use the Go To Well dialog to manually move the Wellplate Reader accessory to a new well. 
This enables you to check the intensity of a well or perform a read at a particular well. 

The Go To Well page is accessible from the Wellplate Accessories page by selecting the Select well or 

These readings will be offset to zero and subsequent readings will have this single 
value subtracted from each well in the sequence. The reading is taken only once, stored, 
and subtracted from the ratioed intensity reading. 

Select well Choose Select well to open the Go To Well dialog where you can select the well 
position to be zeroed. This option is only available if you have selected Auto-zero.

Well Displays the well position of the well selected for auto-zeroing. This field is not 
editable.

Sample 
names 

Select Sample Names to open the Wellplate Sample List where you can enter the 
sample names.

Go to well Select this option to open the Go To Well dialog.
Well position Displays the well position that the mouse cursor is pointing to. This field is not editable.
Reset Select Reset to move the wellplate reader to the first well position defined by the read 

sequence.
Park Select Park to move the wellplate reader to the Park position. The wellplate reader 

accessory is moved clear of the sample compartment to enable you to easily access all 
wells.

Wellplate 
reader 
diagram 

The wellplate reader diagram represents the number of wells present for the chosen 
wellplate configuration. 

The labels for the rows will be 1 .. 12 and for the columns A .. H (for a 96 wellplate). 
Similar labels will occur for different wellplates according. The sequence for 
numbering the read order will be from A1 to A12, B12 - B1, C1 - C12…etc for a 96 
wellplate. A similar sequence will be for other plates.  

To select or clear a single well, simply click or right-click on it.  

To select or clear a block of wells, hold down the cursor and drag around the block 
required. All wells within the area will be selected or cleared. 

See also: 
Accessories page  
Go To Well dialog  
Wellplate Sample List dialog   
About the Wellplate Reader  
Status Display 
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Go To Well button. 

The Go To Well dialog is ‘modeless’ which means that it can remain open even once you have cleared 
the Setup dialog. This enables you to use the Rapid Read command to perform a reading at the selected 
well. 

If you move to a new well after you have performed a Multi-zero, the Cary Eclipse will display the 
intensity reading corrected by the determined zero-offset amount for that well. 

The page comprises the following: 

Use the Wellplate Sample List dialog to enter or modify the sample names of each well in the wellplate 
reader. 

The Wellplate Sample List is accessible from the Wellplate Accessories page by selecting the Sample 
Names button. 

The page comprises the following: 

Wellplate 
reader 
diagram 

The Wellplate Reader diagram represents the number of wells present for the chosen 
wellplate configuration. 

The labels for the rows will be 1 .. 12 and for the columns A .. H (for a 96 wellplate). 
Similar labels will occur for different wellplates according. The sequence for numbering 
the read order will be from A1–A12, B12–B1, C1–C12, etc for a 96 wellplate. A similar 
sequence will be for other plates.  

To move the Wellplate Reader accessory to a new well, simply click on the 
corresponding well on this diagram. The Wellplate Reader will move the selected well 
to the measurement position in the sample compartment.  

To select or clear a single well, simply click or right-click on it.  

To select or clear a block of wells, hold down the cursor and drag around the block 
required. All wells within the area will be selected or cleared. 

X, Y, Well Displays the Well Position that the mouse cursor is pointing to. This field is not 
editable.

Reset Select Reset to move the Wellplate Reader to the first well position, which is well A1.
Park Select Park to move the Wellplate Reader to the Park position. When the accessory is in 

the park position you have full access to the Wellplate Reader platform. This is useful 
for inserting or removing wellplates from the accessory. 

See also: 
Wellplate Accessories page  
About the Wellplate Reader 

Wellplate Sample List—Advanced Reads 

No. of Displays the total number of samples that have been selected from the Wellplate Reader 
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How to import sample names into the Wellplate sample list—
Advanced Reads 
If you want to import sample names into the Wellplate sample list in the Advanced Reads application, 
then you simply need to enter your data in a *.txt file and then import this file into the Wellplate sample 
list dialog. The data should be entered in the following manner:

samples diagram on the Wellplate Accessories page. This field is not editable. 
Sample table The sample table lists the Sample Names and Well numbers of the selected samples.  

Sample Name 
Samples are named numerically, depending upon where they are located on the 
Wellplate Reader diagram. The sequence for numbering the Sample Name order is to 
read from A1 to A12, B1 to B12, C1 to C12…etc for a 96 wellplate. Therefore, if the B2 
cell is selected, its corresponding Sample Name will be Sample 14. 

To modify the name of a sample, highlight the sample name and type in a new name. 
You can enter up to 20 characters for each name. 

Well 
Displays the position of the well corresponding to the Sample Name. This field is not 
editable. 

Import names Select Import Names to display the Open dialog which you can use to select a text file 
to import into the Sample Names column. 

How to import sample names into the Wellplate Sample List 
Increment Select Increment to copy and increment the sample names in the Sample Name list. 

This will save you from entering each sample name individually when the names consist 
of a descriptor followed by a number. 

To use the increment option, highlight the name that you want to increment and select 
Increment. The Cary Eclipse will increment the names of all the files proceeding the 
first highlighted name. 

Example: 
In this example, Sample B1 is highlighted when the Increment button is selected. 

Sample Name Becomes
Samp A  Samp A

 Sample B Sample B1
Sample C Sample B2
Sample D Sample B3
Sample E Sample B4

See also: 
Wellplate Accessories page  
About the Wellplate Reader 
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Each sample name and Well position in the imported file must be on a separate line. Enter the Well 
position on the line immediately after its corresponding Sample Name. Note that any tabs in the file are 
ignored.   

To illustrate this procedure, the following Sample name file (shown on the left) will be used. The picture 
on the right shows the wells that will be selected for inclusion in the Wellplate sample list. Note that you 
do not need to include the well positions, as they are entered automatically (in this case Sample_name1–
Sample_name6 will correspond to wells A1–A6 and Sample_name7–Sample_name12 will correspond 
to wells B1–B6). 

To import sample names: 

Step 1 

Enter your data into a text editor (e.g. Notepad) and save it as a text (*.TXT) file. Refer to Figure 1 for 
an example of the correct format for entering the text. 

Step 2 

From the Advanced Reads Application window, select the Setup button to display the Setup dialog. 

Step 3 

Select the Accessories tab to display the Accessories page. Select the Wellplate tab and from the 
Wellplate page.  

Step 5 

From the Wellplate diagram, select the wells to be included in your analysis. (Refer to Figure 2.) These 

  [leave blank] 
  Sample_name1 
  Sample_name2 
  Sample_name3 
  Sample_name4 
  Sample_name5 
  Sample_name6 
  Sample_name7 
  Sample_name8 
  Sample_name9 
  Sample_name10 
  Sample_name11 
  Sample_name12

Figure 1 
An example of a Sample name text file. 

Figure 2 
An example of the wells selected on the Wellplate Accessories 
page. 

Note: 
The first line of the text file you create is not included when you import the sample names list. 
Therefore you should leave this line blank.
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wells will be included in the Wellplate sample list.

Step 6 

Select the Sample names button to display the Wellplate sample list. 

Step 7 

Select the Import Names button. The Open dialog is displayed. 

Step 8 

Browse for you text file and select Open to open the file. The Sample Names and their corresponding 
Well position will appear in the Sample Name table. 

The Polarizer accessory page is displayed when you select the Polarizer  tab on the Accessories page. 

The page comprises the following: 

Polarizer 

Select this option to use the Polarizer with the Cary Eclipse. 

See also: 
Wellplate sample list 
Wellplate Accessories page   
About the Wellplate Reader 

Polarizer accessory—Advanced Reads 

Q. Why is the Polarization option unavailable?
A. The Wellplate accessory has been selected. As you cannot place both the Wellplate accessory
and the Polarization accessory in the Cary Eclipse sample compartment at the same time, you can
only select one of these accessories.

Measurement 
Select from the following measurement types: Polarization, Anisotropy or Other.

G Factor The G Factor is a value that reflects the polarization bias of the emission 
monochromator. It is dependant upon the emission wavelength. If you do not select the 
G Factor option, then a G-factor value must be collected. If you do select the G Factor 
option then the value entered is used at the emission wavelength in subsequent 
polarization or anisotropy calculations. 
The G Factor option is not available if you select Other as the Measurement type. 

Determining the G-factor 

A check to see whether there is a valid G Factor that corresponds to the emission 
wavelength is performed when you select OK to exit the Setup dialog. If the G Factor is 
not valid, the following prompt is displayed:  
‘The current G-factor is not valid at the emission wavelength. Press the G Factor button 
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Status Display 

Select this check box to display the Status Display window. This window allows you to view the status 
of various parameters during the data collection. 

G-Factor—Advanced Reads
Select G-Factor to calculate the G Factor. You will be prompted to move your polarizers (Em and Ex) 
and perform the IHV and IHH measurements. At the end of the sequence the system will calculate the
subsequent polarization measurements which will be performed when you select the Start button. 

The G-Factor command is only available if you have selected the Polarizer accessory on the 
Accessories page. Once this option is selected, you can then select the G-Factor button from the 
Advanced Reads Application window or the G-Factor command from Commands menu.  

Use the Samples page to specify a list of sample names that will be used during your analysis. 

From the Setup menu, select Samples to access the Samples page. You can also access the page from 
the Setup dialog by selecting the Samples tab. To access the Setup dialog, select the Setup button from 
the Advanced Reads Application window. 

The page comprises the following: 

to determine a new grating factor.’ 
Select OK to clear this dialog and select the G Factor button from the Advanced Reads 
Application window. 

See also:  
Advanced Reads Application 
Accessories  
Cary  
Status Display 

 
See also: 
Advanced Reads Application

Samples—Advanced Reads 

No. of 
samples 

Enter the number of samples to be analyzed in this field. The Sample Names list below 
will expand to reflect your entry.

Replicates This sets the number of replicate readings to be taken for each sample. 

A single solution can lack homogeneity that can significantly alter the results of an 
analysis. For these reasons, common laboratory practice is to take multiple readings of 
the same sample. A maximum of five replicate readings can be taken for each sample. 

Q. Why is the Replicates numerical data entry field grayed out?
A. Select the Replicates option to activate this field. You cannot have Replicates
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and Sample Averaging selected at the same time.
Sample 
averaging 

This sets the number of readings to be taken from different aliquots of the same 
sample/standard solution. The readings are then averaged. The results of every reading, 
as well as the final averaged result, are included in the report. 

Using sample averaging helps minimize solution make-up errors. For example, 
readings from multiple solutions of samples prepared in supposedly identical manners 
may yield different results. Sample averaging minimizes this source of error. 

For duplicates, enter ‘2’ in the numerical data entry field. For triplicates, enter ‘3’. 

Q. Why is the Sample Averaging numerical data entry field grayed out?
A. Select the Sample Averaging option to activate this field. You cannot have
Sample Averaging and Replicates selected at the same time.

Sample name 
(list) 

Enter your sample names in this field. To do this, highlight the Sample name and type 
in the new name. You can enter up to 20 characters for each name.

Increment Select Increment to copy and increment the sample names in the Sample names list. 
This will save you from entering each sample name individually when the names 
consist of a descriptor followed by a number. 

To use the increment option, highlight the name that you want to increment and select 
Increment. The Cary Eclipse will increment the names of all the files proceeding the 
first highlighted name.  

Example:  
In this example, Sample Name ‘B’ is highlighted when the Increment button is selected. 

Sample Name Becomes
A A

B B1
C B2
D B3
E B4

Import 
Names 

Click this button to display the Windows Open dialog which you can use to import an 
ASCII text file of sample names. 

Note 
Each sample name in the imported file must be on a separate line; any tabs in the 
file are ignored. If you want to include duplicates or triplicates, then they must be 
on a separate line immediately after the initial sample name and called ‘Dup’ and 
‘trip’ (maintain the case as shown). Place the sample number immediately after 
the Dup or trip identifier. 

Status 
Display 

Select this check box to display the Status Display window. Use this window to view 
the status of various parameters during the data collection.

See also: 
How to import sample labels
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How to import sample labels—Advanced Reads 
If you want to import sample data into the Advanced Reads application, then you simply need to enter 
your data in a *.txt file and then open this in the Advanced Reads application. The data should be 
entered in the following manner: 

Each sample name in the imported file must be on a separate line, and any tabs in the file are ignored. If 
you want to include duplicates or triplicates, then they must be on a separate line immediately after the 
initial sample name and called ‘Dup’ and ‘trip’ (maintain the case as shown). Place the sample number 
immediately after the Dup or trip identifier.  

An example file is given below. 

Step 1 

Enter your data into a text editor and save it as a text file. 

Step 2 

Open the Advanced Reads Application window. 

Step 3 

From the Setup menu, select Cary. The Cary page is displayed. 

Step 4 

On the Cary page, set the Replicates field to that the number of replicates specified in your sample file. 

Step 5 

    Sample_name1, 
    Dup1, 
    trip1, 
    Sample_name2, 
    Dup2, 
    trip2, 
    Sample_name3, 
    Dup3,  
    trip3, 
    Sample_name4, 
    Dup4, 
    trip4, 
    Sample_name5,  
    Dup5, 
    trip5, 
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Click on the Samples tab. The Samples page is displayed.

Step 6 

Click Import Names. The Open dialog is displayed. 

Step 7 

Search for and highlight your *.txt file. Select Open to open your *.txt file. The sample names will 
appear in the Samples Name list. 

Use the Reports page to set up the report parameters associated with your data collection. 

From the Setup menu, select Reports to access the Reports page. You can also access the page from 
the Setup dialog by selecting the Reports tab. To access the Setup dialog, select the Setup button from 
the Advanced Reads Application window. 

The page comprises the following: 

Operator 

Options 

This group enables you to select the information to include in your report. 

See also: 
Cary page 
Samples page

Reports—Advanced Reads 

Name Enter the instrument operator name in this text entry field. Use the arrow to the right of 
this field to view and select one of the last ten entries in this field. 

Note 
In GLP mode the system will automatically enter the operator’s name and this 
field will not be editable.

Comment Enter operator details and comments in this text entry field.

Auto Print Select Auto Print to print a report automatically during the data collection. 
If Auto Print is selected, then the system will send the report information to the 
specified printer(s) as well as the Report area. However if Auto Print is not selected, 
the report will only be sent to the Report area. 

Parameters Select this option to include the method setup parameters within your report.
Company 
Logo 

Check this option to include your company logo in the report. 
A company logo will only be included if you have added one on the Company page of 
the System Information Application. 
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Status Display 

Select this check box to display the Status Display window, where you can view the status of your 
instrument during the data collection. 

Clear Report—Advanced Reads 
Select Clear Report to remove the contents of the Report area. If you have saved the report, selecting 
this option does not delete the contents of the report, the information is simply removed from the Report 
Area. 

You can select the Clear Report button from the Advanced Reads Application window or the Clear 
Report command from Commands menu.  

How to use advanced reporting options—Advanced Reads 
This outlines ways to fully customize your reports. Options available include:  

Including header and footer information
Including a logo
Editing the text in the report
Viewing the report on screen before printing
Cutting and pasting to a word processor

Hot Tip 
If you have not included a Company logo, select the Header/Footer button to 
open the System Information Application and use the Add Logo option to add a 
logo.

Header/ 
Footer 

Select the Header/Footer button to open the System Information application where you 
can enter the Header and Footer information to be included in your report. You can 
also enter any additional comments, and add a logo to your report. Once you have 
made all your changes, select OK to exit the System Information application and return 
to the Reports page of the Advanced Reads application.

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, 
Microsoft Word or Microsoft Excel) into the report area of the of the Lifetimes application. To 
edit these objects, simply double click on them to open the associated application in which they 
were created.
See also: 
Status Display

 
See also: 
Advanced Reads Application 
Commands menu

Page 28 of 33Getting Ready to read Samples

   



Including header and footer information

You can have text appearing at the top and bottom of every page in your report. To specify what the text 
should be, do the following:  

Step 1 

On the Windows Taskbar, click the Start button, point to Programs, Cary Eclipse and then select System 
Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter the header and footer information in the Header and Footer fields. 

Step 3 

Click OK to implement your changes. 

Including a logo 

You can include a logo on the first page of your report. To specify what the logo should be, do the 
following: 

Step 1 

On the Windows Taskbar, click the Start button, point to Programs, Cary Eclipse and then select 
System Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter a logo using the Add Logo button. This logo will always be included on the front page of reports. 

Step 3 

Click OK to implement your changes. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can 
then add, delete and change text in the Report area. 

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application.

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The
Administrator of the system will have to change your privileges before you can edit reports.
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Viewing the report on the screen before printing

You can view a report before printing it. To do this, from the File menu select Print Preview. You can 
then ensure that the report format is correct before you print it. 

Cutting and pasting to a word processor 

To have complete control over how your report looks you may wish to copy it to a word processor 
program, such as Microsoft Word. To do this: 

Step 1 

Open a report. 

How to open a previously stored report 

Step  2 

From the Edit menu, choose Edit Report. 

Step 3 

Click in the Report area and highlight the text you want to export to your word processor. 

Step 4 

Right-click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text 
into a document. 

Storage | Email | Status display 

Use the Auto Store page to specify if and when data will be stored, and in what format. You can also 
use this page to set up the system to automatically send an email at the end of a read. 

From the Setup menu, select Auto store to access the Auto store page. You can also access the page 
from the Setup dialog by selecting the Auto store tab. To access the Setup dialog, select the Setup 
button from the Advanced Reads Application window. 

The page comprises the following: 

Hot Tip 
Use the arrow keys at the bottom of the Print Preview screen to change pages.

Auto Store—Advanced Reads 
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Storage 

Email 

Select the Email check box and enter the Email details to send an email to a person once the read is 
completed. This useful facility can be used to alert you to the completion of the read, particularly if you 
are working away from the laboratory where the Cary Eclipse instrument is. You can also attach the 
collected data to the email. 

Status display 

Select this check box to display the Status Display window, where you can view the status of your 
instrument during the data collection. 

Off Select this if you do not wish to be automatically prompted to save collected data. 
Note 
If you wish to store your unsaved data manually, choose Save Data As… from 
the File Menu to save your data after the run is complete. You can save your data 
as a Batch or Data file.

On; Prompt 
At Start 

Select this to display the Windows Save As dialog at the start of the collect where you 
can enter the Batch filename for your data.

On; Prompt 
At End 

Select this to display the Windows Save As dialog at the end of a collect where you 
can enter the Batch filename for your data.

Note 
You must set up the email Host and Port options on the Email options page of the System 
Information application in order for the email facility to work correctly.

To Enter the recipient's email address. You can enter more than one recipient in this field.
From Enter your email address (or the email address associated with the computer on which 

the Cary Eclipse software is installed.
Subject Enter the subject of your email (or leave this field blank if you do not wish to include a 

subject).
Cc Enter the email address of any recipient you want to copy the email to.
Message Enter your message.
Attached… Use the Attached button include a file attachment in your email. To do this, select 

Attached and browse your computer to select a file, using the Windows® Open dialog 
that appears.

Attach 
current data 

Select this option to attach the data that has been collected during the run to the email.

How to email your results 

See also: 
Advanced Reads Application  
Save As   
Status Display
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How to email your results—Advanced Reads 
You may wish to send an email to a person once the read is completed. This useful facility can be used 
to alert you to the completion of the read, particularly if you are working away from the laboratory 
where the Cary Eclipse instrument is. 

To do this: 

Step 1 

Ensure that you have set up the Host and Port options on the Email options page of the System 
Information application in order for the email facility to work correctly. 

Step 2 

From the Setup menu, select Auto Store. The Auto Store page is displayed. 

Step 3 

Select the Email check box to enable the email options. 

Step 4 

In the To field, enter the recipient's email address (for example, anne.person@varianinc.com). To enter 
multiple recipients, simply type a comma ',' between each email address. 

Step 5 

In the From field, enter the email address of the computer on which the Cary Eclipse software is 
installed. This may be your email address, or a communal email address, if the Cary Eclipse software is 
installed on a computer that has multiple users. 

Step 6 

Enter information in the Subject and Message fields as required. 

Step 7 

Select Attach current data. The data that has been collected during the run will be attached to the 
email. 

Step 8 

Select OK to clear the Auto Store dialog. Your email will be sent once the run has been completed. 

Hot Tip 
You can attach other documents to your email. To do this, select the Attached button and browse 
your computer to select a file, using the Windows® Open dialog that is displayed.
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See also: 
Auto Store 
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Performing scans—Concentration 
Starting a read
Present Standard dialog
Present Sample dialog
Cell Loading Guide
Start/Stop buttons
Pre-scan dialog
Reread
Rapid Result dialog
Zero
Go To dialog
Commands menu
How to perform a calibration
How to perform a calibration and manually measure concentrations
How to perform a calibration and measure concentrations using the Multicell Holder

When you select Start to commence a Concentration run, the Standard/Sample Selection dialog will appear. 
Once you have selected your solutions, various prompting dialogs will appear. The sequence that occurs 
depends upon your storage and accessory selections. 

Storage selections 

Accessory selections 

Information about starting a run—Concentration 

If you have selected … as the Storage 
option on the Auto Store page

The following occurs

On, prompt at start The Windows Save As dialog will appear once you have made 
your Standard and Sample selections. You can save the current 
method, collected data, report and graph template as a Batch file.

On, prompt at End The Windows Save As dialog will appear at the end of the data 
collection. You can save the current method, collected data, 
report and graph template as a Batch file.

Off  The Windows Save As dialog will not appear.

If you have selected … on the 
Accessories page

The following is displayed

No accessories If you have included Standards in the analysis, the Present 
Standard dialog will appear after the Standard/Sample 
Selection dialog, prompting you to load the standard. You should 
manually present your first standard solution then select OK to 
commence the read. Separate Present Standard dialogs will 
appear for each standard. 

After reading the standards, the Present Sample dialog will 
appear for each selected sample. 

Multicell Holder The Cell Loading Guide dialog will appear. You should load the 
cells as depicted then select OK to commence the read. After 
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Present Standard—Concentration 
Use the Present Standard dialog enables to read each standard. The dialog will appear for each selected 
sample. 

To read the standard, place the solution in the sample compartment and then select OK. The Cary Eclipse will 
measure the standard, plot the value in the Graphics area and record the measurement in the Report area. 

Present Sample—Concentration 
After reading the standards, the Present Sample dialog will appear for each selected sample. The Present 
Sample dialog prompts you to place your sample in the sample compartment. Separate Present Sample 
dialogs will appear for each sample. 

To read the standard, place the solution in the sample compartment and then select OK. The Cary Eclipse will 
measure the sample, plot the value in the Graphics area and record the measurement in the Report area. 

Cell Loading Guide—Concentration 

reading the standards, the Cell Loading Guide will prompt you 
to load your samples.

See also: 
Standard/Sample Selection dialog 
Cell Loading Guide 
Present Standard 
Present Sample 

Switch to 
samples 

Select this check box and select OK to stop reading the standards and commence reading the 
samples. The Cary Eclipse will display the Present Sample dialog where you can start 
measuring sample concentration. 

For example, if you have set up the run to include five standards, and after the third standard 
the calibration is satisfactory, it may not be necessary to read the rest of the standards. 

Note: 
The Present Standard dialog will only be displayed once you select Start to commence an analysis 
(and have selected your standards and samples) if you do not have any accessories selected.

See also: 
Standard/Sample Selection 
Present Sample 
Information about starting a Concentration run

Note: 
The Present Sample dialog will only be displayed once you select Start to commence an analysis (and 
have selected your standards and samples) if you do not have any accessories selected.

See also: 
Standard/Sample Selection 
Present Standard 
Information about starting a Concentration run
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If you are using a Multicell Holder, the Cell Loading Guide dialog appears after the Standard/Sample 
Selection dialog when you select the Start button to commence an analysis. 

The Cell Loading Guide dialog prompts you to insert blank samples in the Multicell Holder to collect the 
scans. You can also use the dialog to name the samples in each selected cell in the Multicell Holder.  

The dialog comprises the following: 

The following buttons may be displayed at the top of the Concentration Application window. The Start and 
Connect buttons will change depending upon the status of the instrument. For example, if the instrument is 
ready for a a run, the Start button will be visible to indicate that the system is ready to commence a run. 

Loading 
Guide/Sample 
Name entry

Enter the names of the sample to be used in the concentration run in each available field. This 
sample name will be used as the Name of Trace in the Trace Preferences dialog. 

You should load the cells as depicted then select OK to commence the read. After reading 
the standards, the Cell Loading Guide will prompt you to load your samples.   

Note 
The Cell Loading Guide dialog appears only if you have 
selected the Multicell Holder option on the Accessories 
page of the Setup dialog. Only cells selected in the 
Multicell Holder diagram on the Accessories page will be 
available in the Cell Loading Guide. 

In the adjacent example, cells 1—3 will be available in the 
Loading Guide dialog, as they have been selected in the 
Multicell Holder diagram. 

See also: 
Accessories page 
Standard/Sample Selection dialog 
Present Standard 
Present Sample

Start/Stop instrument buttons—Concentration 

Select Start to commence a concentration run using the current Setup dialog 
parameters. 
If any unsaved data exists in the Graphics area you will be prompted to save the 
data. If you choose not to save, any unsaved data, pictures and labels will be deleted 
when you start the concentration run.

If another application is already online with the Cary Eclipse, the Start button will 
change to Connect, and you will need to select Connect to bring this application 
online before the Start button will re-appear. (You will not be able to connect if the 
other application is collecting data.)

Select this to end a concentration run. 
If you have selected Storage On in the Auto Store page of the Setup dialog, all data 
collected is automatically stored in the file specified in the Batch name field of the 
Windows Save As dialog before or after the run commenced.

See also: 
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Pre-scan—Concentration 
Select Pre-scan to determine the optimum instrument parameters to be used for your sample. At the end of this 
collection sequence the software will report the optimum Ex and Em wavelengths and PMT voltage. Once you 
are satisfied with the parameters, the software will automatically update your method setup to reflect these new 
parameters. 

The Pre-scan dialog comprises the following: 

Type of scatter 

Select he type of scatter you wish to search for from the following: 

Reread—Concentration 
The Reread option is only available once you have completed a data collection. Use the Reread option to re-
read samples that have already been run. 

The Reread option is accessible by selecting the Reread button from the Concentration Application window, 
or from the Commands menu by selecting Reread. When you select the Reread option, the Standard/Sample 
Selection dialog is displayed. 

Rapid Result—Concentration 
Use the Rapid Result dialog to take a reading of a blank and sample/s, without having to change the current 
application method. This means that between runs, while new samples are being prepared and loaded, other 
samples can quickly be measured. The result is printed in the Report area.

Information about starting a Concentration run 
Concentration Application 
Setup 
Auto Store

To access the Pre-scan option, select the Pre-scan command from the Commands menu, or 
select the Pre-scan button from the Concentration Application window.

Rayleigh 
scatter 

Rayleigh scatter refers to the scatter of the excitation light. It is displayed at the peak of the 
excitation wavelength.

Raman scatter Raman scatter refers to scatter due to the solvent. Its peak is at a fixed energy from the 
excitation wavelength, and is solvent dependent. Thus, the type of solvent used must be 
selected from the Solvent list.

2nd order Second order scatter refers to the scatter of higher order excitation light. Its peak is a multiple 
of the excitation wavelength.

See also: 
Commands menu  
Concentration Application

See also: 
Standard/Sample Selection dialog 
Commands menu 
Concentration Application
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To access the Rapid Result dialog, select the Rapid Result command from the Commands menu or press F6. 

Use the Zero button to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use the Zero 
command before commencing a data collection if you want your data to start at 0  intensity. The Cary Eclipse 
will prompt you to load a blank before performing the zero. 

Before you select Zero, ensure that you have placed the blank solution in the cell positions that are currently in 
the cell path. 

When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the 
Concentration Application window. 

Select the Clear Zero command from the Commands menu to remove zero correction and thus remove the 
subtraction effect. 

Use the Go To Wavelength dialog to temporarily change the instrument to a new excitation or emission 
wavelength. This dialog is useful if you want to quickly go to a wavelength and check the intensity reading of 
the sample. The lamp will flash continuously in this mode. This option is only available if the instrument is not 
currently collecting data. 

To access the Go To Wavelength dialog, select the Go To… command from the Commands menu. You can 
also select F4 to open the dialog. 

Excitation Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Emission Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Zero Click Zero to change the wavelength to the entered value and measure a blank.
Result Click Result to change the wavelength to the entered value and measure a sample. The X,Y 

results are corrected for the blank and appear in the reports area.

Zero—Concentration 

To access the Zero option, select the Zero command from the Commands menu, or select the 
Zero button from the Concentration Application window. 

See also: 
Commands menu 
Concentration Application

Go To Wavelength—Concentration 

Note 
This is not the wavelength used in the application method. If your method uses a wavelength that is 
different from the 'Go to wavelength' setting you select, then when you select Start the system will 
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The Go To Wavelength page comprises the following: 

Use the Commands menu to access major operational commands in the Concentration application . The menu 
is accessible from the menu line at the top of the Concentration Application window. 

Alternatively you can use function key shortcuts for some of the commands. These appear next to the item in 
the Commands menu. Note that not all commands appear as both button and menu items. 

The Commands menu comprises the following commands: 

change to the wavelength selected (as set on the Cary page of the Setup dialog).

Excitation Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go To the instrument 
will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white 
light). You can then use this light for aligning accessories. 

Emission Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go To the instrument 
will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white 
light). You can then use this light for aligning accessories. 

Go To Click Go To once you have entered a new wavelength, to change the instrument to the 
entered value.

See also: 
Function Keys

Commands menu—Concentration 

Hot Tip 
If you access these commands using the Commands menu, rather than from the application buttons, you 
can remove these buttons from your application window. To do this, clear the Buttons command in the 
View menu. This will enlarge the Graphics area, making viewing and selection of scans easier. 

Tell me how to remove or display the command buttons

Command What it does…
Start Select this to start a data collection using the currently set up parameters. 

Note 
If the Connect command is displayed in place of the Start command, this indicates 
that another Cary Eclipse application is in use and has control of the Cary Eclipse 
instrument. To make the Concentration application active so that you can perform a 
read, you will need to select Connect. However, you will not be able to select 
Connect if another application is collecting data.

Stop Select this to stop the data collection. 

If you have selected Storage On in the Auto Store page of the Setup dialog, all data 
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collected is automatically stored in the file specified in the Batch name field of the Windows 
Save As dialog before or after the run commenced.

Clear Zero Select this option to clear the Zero command. When you select the Zero command (from the 
Commands menu or by pressing F5), the intensity at that time will be reset to zero and all 
subsequent results will have the intensity value that was reset to zero subtracted from them. 
Selecting Clear zero cancels this zeroing (and thus subtraction) effect.

Pre-scan Select Pres-can to determine the optimum instrument parameters to be used for your 
sample. At the end of this collection sequence the software will report the optimum Ex and 
Em wavelengths and PMT voltage. Once you are satisfied with the parameters, the software 
will automatically update your method setup to reflect these new parameters.

Zero order… Select the Zero order command to set one of the monochromators to zero order. If you use 
this command to zero either the excitation or emission monochromators, this will override 
the Ex. Wavelength or Em. Wavelength set on the Cary page. The Cary Eclipse software 
will use the zero setting when collecting data. 

The Zero order command is generally used during alignment procedures.  

Excitation 
Select this command to set the excitation monochromator to zero order (white light). 

Emission 
Select this command to set the emission monochromator to zero order (white light). 

Reset Select this command to re-initialize the instrument. This will perform the same initializing 
procedure that is performed when the instrument is powered on.

Reread 
Rapid Result Select this to display the Rapid Result dialog. Use this dialog to take a reading of a blank 

and multiple sample readings without changing the application method. This means that 
between runs, while new samples are being prepared and loaded, other samples can quickly 
be measured. 
This command can also be accessed by pressing F6.

Zero Select this to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can 
use the Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Go to… Select Go To to display the Go To Wavelength dialog where you can change the instrument 
to a new wavelength. Use this command if you want to quickly go to a wavelength to check 
the intensity reading. 
This command is only available if the instrument is not currently collecting data. It can also 
be accessed by pressing F4. 

Note 
This is not the wavelength used in the application method. If your method uses a 
wavelength that is different from the 'Go To wavelength', then when you select Start 
the system will change to the wavelength selected. (In most applications, this is set in 
the Cary tab of the Setup dialog.)

ADL 
Command 

Select this to display the ADL Command Line window where you can execute an ADL 
command or ADL program. (You can also press Alt-Y to display this dialog.)
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How to perform a calibration—Concentration 
This demonstrates how to perform and store a fluorescence multi-standard calibration, without measuring any 
sample concentrations. 

Follow the steps through, adjusting them to meet the requirements of your particular data collection.  

Start the Concentration application
Set up data collection parameters
Set up instrument parameters
Set up the display options
Set up accessories
Set up the calibration
Set up your samples
Set up reporting and printing requirements
Set up storage of collected data
Set up visual system monitoring
Finish Setup
Zero the instrument
Perform the calibration

Start the Concentration application 

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan 
Application is displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select Setup to display the Setup dialog and specify the method parameters for a new method. 

To do this: 

Set up instrument parameters  

Step 3 [Setup dialog | Cary page]  

Rerun ADL Select this to run the ADL command or program in the ADL Command Line window again. 
(You can also press Alt-X to rerun programs.)

See also: 
Concentration Application  
Auto Store  
Cary page  
Rapid Result  
Go To Wavelength   
ADL Command Line 

Note 
If you are running a GLP system, you may be prompted to enter a password before accessing the 
Concentration application.
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a. In the Data mode field set the mode to Fluorescence.

b. In the Ex. Wavelength field, set the wavelength of the excitation monochromator, which is the
wavelength value at which you want to excite your sample.

c. In the Em. Wavelength field, set the wavelength of the emission monochromator, which is the
wavelength value at which your sample emits.

d. Set the slit width of the excitation monochromator.
Note that as a general rule, at a fixed emission slit width, increasing the excitation slit width will result in
an increase in the fluorescence excitation intensity.

e. Set the slit width of the emission monochromator.
Note that as a general rule, at a fixed excitation slit width, a two-fold increase in the emission slit width
will result in a four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the
emission slit width will result in a four-fold decrease in the emission intensity.

f. In the Ave Time field enter the required value. A good starting point is 0.1 sec.

Set up the display options  

Step 4 [Setup dialog | Options page]  

a. Select the Options tab. The Options page is displayed.

b. Enter the minimum and maximum Y values to be displayed on the graph axis during the data collection.

c. Set the Excitation filter for the concentration measurement. It is recommended that you set the filter to
Auto ( the default setting). This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

d. Set the Excitation filter and the Emission filter for the concentration measurement. In order to
minimize steps in the spectra, it is recommended that you set the filter to Open (the default setting).

e. Set the EHT or sample detector PMT. The setting you choose will depend upon your sample. For
example, a Low setting is recommended for highly emitting samples, while a High setting is
recommended for low emitting samples.

Set up accessories  

Step 5 [Setup dialog | Accessories page] 

Select the Accessories tab and en sure that no accessories are selected. 

Set up the calibration  

Step 6 [Setup dialog | Standards page]  

a. Select the Standards tab to access the Standards page where you can set up the standards and their
parameters associated with the data collection.

b. Set the appropriate Units for your standards for reporting purposes.

c. In the Standards field, enter the number of standards that you are using in your calibration. The table
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below this field will expand or contract to match your choice.  

d. In the Standards table, enter the concentration of each standard in the Conc column.

e. Select the type of curve fitting required for your calibration in the Fit Type group.

f. Enter the required R2 value or correlation coefficient in the Min R2 field. The closer the number is to
1.000 the better the fit. Typically, 0.95 is used.

Set up your samples  

Step 7 [Setup dialog | Samples page]  

As this is a calibration only, set the No. of Samples field to ‘0’. 

Set up reporting and printing requirements  

Step 9 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

Set up storage of collected data  

Step 10 [Setup dialog | Auto Store page] 

a. Select the Auto Store tab to display the Auto Store page.

b. Set the Storage option to Off. The method (with calibration), collected data and report will not be
automatically saved. However, you can manually save it all at the end of the collection.

c. Select the Auto Convert option you require. If you select ASCII (csv) or ASCII (csv) with log, then at
the end of the data collection the system will automatically generate a report and store the data both in
the Cary Eclipse format as well as ASCII XY pairs format. The data file will be saved in the current
folder.

Set up visual system monitoring  

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as well 
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report area 
and can be viewed by selecting the Report command from the View menu.
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Step 11 [Setup dialog] 

Select the Status Display check box on any of the Setup pages to display various information fields on your 
current reaction. 

Finish Setup  

Step 12 

Once you are satisfied with your method setup select OK to confirm any changes you have made and clear the 
Setup dialog. 

Zero the instrument  

Step 13  

a. From the Concentration Application window, select the Zero button to zero the system. Alternatively,
select the Zero command from the Commands menu. The Zero dialog will be displayed.

b. Place a blank in the sample compartment and select OK.

Perform the calibration  

Step 14  

a. Select the Start button or select Start from the Commands menu. The Standard/Sample Selection
dialog will be displayed.

b. Select the standards and samples to be used in the analysis. By default, all standards are selected.

c. Select OK to clear the Standard/Sample Selection dialog.

d. The Present Standard dialog will be displayed to prompt you to place the appropriate standard in the
sample compartment. Press OK to measure the standard.

e. Repeat Step 14 d until you have measured all the standards. The Cary Eclipse will calculate the
calibration and the correlation coefficient.

Step 15  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this Concentration run.

Hot Tip 
If you accidentally included samples on the Samples page, highlight them and use the arrow keys to
move them to the Solutions Available list so they will not be read. 

Note 
If the set correlation coefficient (R2) value is not met, the Cary Eclipse will prompt you with ‘Min R2 test 
failed’.
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c. Select Save and save the method with the calibration as a Method (*.FMCN) file.

How to perform a calibration and manually measure 
concentrations—Concentration 
This demonstrates how to perform a fluorescence multi-standard calibration and measure sample 
concentrations using no accessories. 

Follow the steps through, adjusting them to meet the requirements of your particular data collection.  

Start the Concentration application
Set up data collection parameters
Set up instrument parameters
Set up display options
Set up accessories
Set up the calibration
Set up your samples and increment names
Set up your samples for weight and volume correction
Set up reporting and printing requirements
Set up storage of collected data
Set up visual system monitoring
Finish Setup
Zero the instrument
Perform the calibration
Measure sample concentration
Save your data

Start the Concentration application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan 
Application is displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select Setup to display the Setup dialog and specify the method parameters for a new method. 

To do this: 

See also:
How to change the curve of best fit used in the calibration
How to delete a standard from the calibration
How to import samples labels, weights and volumes
How to export collected data
How to generate a report from previously calculated data

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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Set up instrument parameters 

Step 3 [Setup dialog | Cary page]  

a. In the Data mode field set the mode to Fluorescence.

b. In the Ex. Wavelength field, set the wavelength of the excitation monochromator, which is the
wavelength value at which you want to excite your sample.

c. In the Em. Wavelength field, set the wavelength of the emission monochromator, which is the
wavelength value at which your sample emits.

d. Set the slit width of the excitation monochromator.
Note that as a general rule, at a fixed emission slit width, increasing the excitation slit width will result in
an increase in the fluorescence excitation intensity.

e. Set the slit width of the emission monochromator.
Note that as a general rule, at a fixed excitation slit width, a two-fold increase in the emission slit width
will result in a four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the
emission slit width will result in a four-fold decrease in the emission intensity.

f. In the Ave Time field enter the required value. A good starting point is 0.1 sec.

Set up the options  

Step 4 [Setup dialog | Options page]  

a. Select the Options tab. The Options page is displayed.

b. Enter the minimum and maximum Y values to be displayed on the graph axis during the data collection.

c. Set the Excitation filter for the concentration measurement. It is recommended that you set the filter to
Auto ( the default setting). This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

d. Set the Excitation filter and the Emission filter for the concentration measurement. In order to
minimize steps in the spectra, it is recommended that you set the filter to Open (the default setting).

e. Set the EHT or sample detector PMT. The setting you choose will depend upon your sample. For
example, a Low setting is recommended for highly emitting samples, while a High setting is
recommended for low emitting samples.

Set up accessories 

Step 5 [Setup dialog | Accessories page] 

Select the Accessories tab and ensure that no accessories are selected. 

Set up the calibration  

Step 6 [Setup dialog | Standards page]  

a. Select the Standards tab to access the Standards page where you can set up the standards and their
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parameters associated with the data collection.  

b. Set the appropriate Units for your standards for reporting purposes.

c. In the Standards field, enter the number of standards that you are using in your calibration. The table
below this field will expand or contract to match your choice.

d. In the Standards table, enter the concentration of each standard in the Conc column.

e. Select the type of curve fitting required for your calibration in the Fit Type group.

f. Enter the required R2 value or correlation coefficient in the Min R2 field. The closer the number is to
1.000 the better the fit. Typically, 0.95 is used.

Set up your samples and increment names  

Step 7 [Setup dialog | Samples page]  

a. Select the Samples tab to display the Samples page. This page enables you to enter a list of sample
names that will be used during your analysis.

b. Enter the number of samples that you are going to use in the No. of Samples field. The table below this
field will expand or contract to match your choice.

c. In the Sample names table enter the name of each sample. You can enter up to 20 characters for each
name.

d. If you would like the samples to have the same name with a different numeric extension, enter the name
in the first sample position and then select the Increment button.

Set up weight and volume correction  

Step 8 [Setup dialog | Samples page]  

a. Select the Weight/Volume Corrections check box.

b. Enter the theoretical sample weight in the Method Weight field. This is the weight of the sample
specified in your method. (The Actual Weight is entered for each sample in the Sample Names list.)

c. Enter the units in the Weight Units field.

d. Enter the theoretical sample volume in the Method Volume field. This is the volume to which the
method tells you to make the sample. (The Actual Volume is entered for each sample in the Sample
Names list.)

e. Enter the units in the Volume Units field.

f. In the Sample Names table, enter the Actual Weight and Actual Volume for each sample.

Set up reporting and printing requirements  

Step 9 [Setup dialog | Reports page]  
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a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

Set up storage of collected data  

Step 10 [Setup dialog | Auto Store page] 

a. Select the Auto Store tab to display the Auto Store page.

b. Set the Storage option to Off. The method (with calibration), collected data and report will not be
automatically saved. However, you can manually save it all at the end of the collection.

c. Select the Auto Convert option you require. If you select ASCII (csv) or ASCII (csv) with log, then at
the end of the data collection the system will automatically generate a report and store the data both in
the Cary Eclipse format as well as ASCII XY pairs format. The data file will be saved in the current
folder.

Set up visual system monitoring  

Step 11 [Setup dialog] 

Select the Status Display check box on any of the Setup pages to display various information fields on your 
current reaction. 

Finish Setup  

Step 12 

Once you are satisfied with your method setup select OK to confirm any changes you have made and clear the 
Setup dialog. 

Zero the instrument  

Step 13  

a. From the Concentration Application window, select the Zero button to zero the system. Alternatively,
select the Zero command from the Commands menu. The Zero dialog will be displayed.

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as well 
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report area 
and can be viewed by selecting the Report command from the View menu.
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b. Place a blank in the sample compartment and select OK.

Perform the calibration  

Step 14  

a. Select the Start button or select Start from the Commands menu. The Standard/Sample Selection
dialog will be displayed.

b. Select the standards and samples to be used in the analysis. By default, all standards and samples are
selected.

c. Select OK to clear the Standard/Sample Selection dialog.

d. The Present Standard dialog will be displayed to prompt you to place the appropriate standard in the
sample compartment. Press OK to measure the standard.

e. Repeat Step 14 d until you have measured all the standards. The Cary Eclipse will calculate the
calibration and the correlation coefficient.

Measure sample concentration  

Step 15  

a. Once all the standards have been read, the Present Sample dialog will be displayed to prompt you to
place the appropriate sample in the sample compartment. Press OK to measure the sample and calculate
its concentration. (If replicates have been nominated, then the concentration is calculated after the final
sample replicate is read.)

b. Repeat Step 15 b for the remaining samples.

Save your data  

Step 16  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this Concentration run.

c. Select Save. The data will be stored as a Batch file.

Note 
If the set correlation coefficient (R2) value is not met, the Cary Eclipse will prompt you with ‘Min R2 test 
failed’. When you select OK, the Cary Eclipse will then prompt you with ‘There is no valid calibration. 
Proceed in Intensity (a.u.)?’. If you select Cancel, the Concentration run will finish. If you select OK, the 
Cary Eclipse will measure the intensity of any presented samples, but will not generate a concentration.

See also:
How to change the curve of best fit used in the calibration
How to delete a standard from the calibration
How to import samples labels, weights and volumes
How to perform a calibration and measure concentrations using the Multicell Holder accessory
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How to perform a calibration and measure concentrations using the 
Multicell Holder—Concentration 
This demonstrates how to perform a fluorescence multi-standard calibration and measure sample 
concentrations using the Multicell Holder. 

Follow the steps through, adjusting them to meet the requirements of your particular data collection.  

Start the Concentration application
Set up data collection parameters
Set up instrument parameters
Set up display options
Set up Multicell Holder accessory
Set up the calibration
Set up your samples and increment names
Set up weight and volume correction
Set up reporting and printing requirements
Set up storage of collected data before run
Set up visual system monitoring
Finish Setup
Zero the instrument
Perform the calibration and measure samples
Save your data

Start the Concentration application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan 
Application is displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select Setup to display the Setup dialog and specify the method parameters for a new method. 

To do this: 

Set up instrument parameters 

Step 3 [Setup dialog | Cary page]  

a. In the Data mode field set the mode to Fluorescence.

b. In the Ex. Wavelength field, set the wavelength of the excitation monochromator, which is the
wavelength value at which you want to excite your sample.

Note 
If you are running a GLP system, you may be prompted to enter a password before accessing the 
Concentration application.
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c. In the Em. Wavelength field, set the wavelength of the emission monochromator, which is the
wavelength value at which your sample emits.

d. Set the slit width of the excitation monochromator.
Note that as a general rule, at a fixed emission slit width, increasing the excitation slit width will result in
an increase in the fluorescence excitation intensity.

e. Set the slit width of the emission monochromator.
Note that as a general rule, at a fixed excitation slit width, a two-fold increase in the emission slit width
will result in a four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the
emission slit width will result in a four-fold decrease in the emission intensity.

f. In the Ave Time field enter the required value. A good starting point is 0.1 sec.

Set up the display options  

Step 4 [Setup dialog | Options page]  

a. Select the Options tab. The Options page is displayed.

b. Enter the minimum and maximum Y values to be displayed on the graph axis during the data collection.

c. Set the Excitation filter for the concentration measurement. It is recommended that you set the filter to
Auto ( the default setting). This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

d. Set the Excitation filter and the Emission filter for the concentration measurement. In order to
minimize steps in the spectra, it is recommended that you set the filter to Open (the default setting).

e. Set the EHT or sample detector PMT. The setting you choose will depend upon your sample. For
example, a Low setting is recommended for highly emitting samples, while a High setting is
recommended for low emitting samples.

Set up Multicell Holder accessory 

Step 5 [Setup dialog | Accessories page]  

a. Select the Accessories tab to display the Accessories page.

b. Select the Multicell Holder check box to enable the accessory.

c. Ensure that you have this accessory installed prior to commencing the run.

d. On the Cell Holder diagram select the cells you require.

e. Select the Multi Zero check box to enable the Multi Zero facility.

f. Make sure that no other accessories are selected on this page.

Set up the calibration  

Step 6 [Setup dialog | Standards page]  
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a. Select the Standards tab to access the Standards page where you can set up the standards and their
parameters associated with the data collection.

b. Set the appropriate Units for your standards for reporting purposes.

c. Select Replicates or Std Averaging if required, and enter the appropriate number.

d. In the Standards field, enter the number of standards that you are using in your calibration. The table
below this field will expand or contract to match your choice.

e. In the Standards table, enter the concentration of each standard in the Conc column.

f. Select the type of curve fitting required for your calibration in the Fit Type group.

g. Enter the required R2 value or correlation coefficient in the Min R2 field. The closer the number is to
1.000 the better the fit. Typically, 0.95 is used.

Set up your samples and increment names  

Step 7 [Setup dialog | Samples page]  

a. Select the Samples tab to display the Samples page. This page enables you to enter a list of sample
names that will be used during your analysis.

b. Enter the number of samples that you are going to use in the No. of Samples field. The table below this
field will expand or contract to match your choice.

c. In the Sample names table enter the name of each sample. You can enter up to 20 characters for each
name.

d. If you would like the samples to have the same name with a different numeric extension, enter the name
in the first sample position and then select the Increment button.

Set up weight and volume correction  

Step 8 [Setup dialog | Samples page]  

a. Select the Weight/Volume Corrections check box.

b. Enter the theoretical sample weight in the Method Weight field. This is the weight of the sample
specified in your method. (The Actual Weight is entered for each sample in the Sample Names list.)

c. Enter the units in the Weight Units field.

d. Enter the theoretical sample volume in the Method Volume field. This is the volume to which the
method tells you to make the sample. (The Actual Volume is entered for each sample in the Sample
Names list.)

e. Enter the units in the Volume Units field.

f. In the Sample Names table, enter the Actual Weight and Actual Volume for each sample.

Set up reporting and printing requirements  
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Step 9 [Setup dialog | Reports page] 

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

Set up storage of collected data before run  

Step 10 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto Store page.

b. Set the Storage option to Off. The method (with calibration), collected data and report will not be
automatically saved. However, you can manually save it all at the end of the collection.

c. Select the Auto Convert option you require. If you select ASCII (csv) or ASCII (csv) with log, then at
the end of the data collection the system will automatically generate a report and store the data both in
the Cary Eclipse format as well as ASCII XY pairs format. The data file will be saved in the current
folder.

Set up visual system monitoring  

Step 11 [Setup dialog] 

Select the Status Display check box on any of the Setup pages to display various information fields on your 
current reaction. 

Finish Setup  

Step 12 

Once you are satisfied with your method setup select OK to confirm any changes you have made and clear the 
Setup dialog. 

Zero the instrument  

Step 13  

a. From the Concentration Application window, select the Zero button to zero the system. Alternatively,

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as well 
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report area 
and can be viewed by selecting the Report command from the View menu.
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select the Zero command from the Commands menu. The Zero dialog will be displayed. 

b. Place a blank in the sample compartment and select OK.

Perform the calibration and measure samples  

Step 14  

a. Select the Start button or select Start from the Commands menu. The Standard/Sample Selection
dialog will be displayed.

b. Select the standards and samples to be used in the analysis. By default, all standards and samples are
selected.

c. Select OK to clear the Standard/Sample Selection dialog.

d. The Cell Loading Guide dialog will be displayed. Load your standards as indicated, then select OK to
start reading the standards. If additional Cell Loading Guide dialogs are displayed, continue to load
your standards as indicated and select OK to continue loading the standards. Cary Eclipse will measure
the standards and calculate the calibration curve.

e. A Cell Loading Guide will be displayed for the samples. Load your samples as indicated and select
OK. The Cary Eclipse will then measure the samples and calculate their concentration.

Save your data  

Step 15  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this Concentration run.

c. Select Save. The data will be stored as a Batch file.

Note 
If the set correlation coefficient (R2) value is not met, the Cary Eclipse will prompt you with ‘Min R2 test 
failed’. When you select OK, the Cary Eclipse will then prompt you with ‘There is no valid calibration. 
Proceed in Intensity (a.u.)?’. If you select Cancel, the Concentration run will finish. If you select OK, the 
Cary Eclipse will measure the intensity of any presented samples, but will not generate a concentration. 

See also:
How to change the curve of best fit used in the calibration
How to delete a standard from the calibration
How to import samples labels, weights and volumes
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Viewing run progress and results—Concentration 
Reports page
Reports toolbar
How to generate a report from previously stored data
How to use the advanced reporting options
View menu
Edit menu
Status display
Print Preview dialog
Print

Operator | Options | Show Status Display 

Use the Reports page to set up the report parameters associated with data collection. 

The Reports page is accessible from the Setup dialog by selecting the Reports tab. To access the Setup 
dialog, select the Setup button from the Concentration Application window or the Setup command from 
the Setup menu. 
The Reports page can also be accessed by selecting the Recalculate button and then selecting the 
Reports tab. 

The page comprises the following: 

Operator 

Options 

This group enables you to select the information to include in your report. 

Reports—Concentration 

Name Enter the instrument operator name in this text entry field. Use the arrow to the right of 
this field to view and select one of the last ten entries in this field. 

Note 
In GLP mode the system will automatically enter the operator’s name and this 
field will not be editable.

Comment Enter operator details and comments in this text entry field.

Auto Print Select Auto Print to print a report automatically during the data collection. 
If Auto Print is selected, then the system will send the report information to the 
specified printer(s) as well as the Report area. However if Auto Print is not selected, 
the report will only be sent to the Report area and can be viewed by selecting Report 
in the View menu. 

To automatically obtain a copy of the graphics, you will need to select both the Auto 
Print and Graph options (see below). In this case, all graphical information displayed 
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Status Display 

Select this check box to display the Status Display window where you can view the status of your 
instrument during the data collection. 

Use the Report toolbar buttons to gain quick access to many of the Edit menu commands. You can also 

on screen will be printed with the report. Therefore it is advisable to arrange the 
graphical information as you require on screen, prior to printing. 
For example, if you require a single graph print out, then the Single/Multi Graph 
option in the Graph menu should be changed to the correct setting. 

Parameters Select this option to include the method setup parameters within your report.
Graph Select Graph to include any graphs or graphic information associated with your report.

If you require a printout of the displayed graphics only, you must ensure that only this 
option is selected. Press the Clear Report button to clear any information in the Report 
area before you print otherwise this will be included in your printout. 
% Page Height 
Enter the size at which you want the graph to be printed, as a percentage of total page 
height. For example, if you want graphical information to take up half of the page, 
enter 50% in this field.

Company 
Logo 

Check this option to include your company logo in the report. 
A company logo will only be included if you have added one on the Company page of 
the System Information Application. 

Hot Tip 
If you have not included a Company logo, select the Header/Footer button to 
open the System Information Application and use the Add Logo option to add a 
logo.

Header/ 
Footer 

Select the Header/Footer button to open the System Information application where 
you can enter the Header and Footer information to be included in your report. You 
can also enter any additional comments, and add a logo to your report. Once you have 
made all your changes, select OK to exit the System Information application and 
return to the Reports page of the Concentration application.

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, 
Microsoft Word or Microsoft Excel) into the report area of the of the Lifetimes application. To 
edit these objects, simply double click on them to open the associated application in which they 
were created.

See also: 
Setup dialog 
Recalculate 
View menu 
Single/Multi Graph 
Status Display window

Report Toolbar—Concentration 
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use the toolbar to cut, copy and paste information and to change the look of your report. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Report. To 
display or hide the toolbar's text labels, point to the Toolbar option in the View menu and select Text 
Labels. 

The following commands can be accessed from the Report toolbar: 

How to generate a report from previously calculated data—
Concentration 
Step 1 

Select Open… from the File menu to display the Windows Open dialog.

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Edit Report Click this button to edit the report. 
This command is also accessible by pressing CTRL+R.

Undo If available, this undoes the last action. 
This command is also accessible by pressing CTRL+Z.

Cut Click this button to remove the highlighted text and place it on the Windows 
Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Click this button to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.

Paste Click this button to insert the contents of the Windows Clipboard (text only) at 
the cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Click this button to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
This option is only available once you select Edit Report and there is text 
highlighted in the Report area.

Font Click this button to change the font of new or selected text in the report. For 
existing text, simply highlight the text in the report, select this button and make 
your changes in the Font dialog. When you select OK, the appearance of the 
highlighted text in the report will alter to reflect your font changes. 
This command is also accessible by pressing CTRL+F.

Preview Click this button to display the Print Preview dialog where you can view the 
current report as it will be printed.
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Step 2 

A list of previously stored files will appear. If this is not a list of batch files, select the down arrow at the 
right of the Files of type list box and select 'Batch' to list all the batch files. 

Step 3 

Select the Batch file you require then select Open. 

The system will automatically retrieve the collected data into the Graphics area. The method that was 
used to collect the data will also be retrieved. 

Step 4 

Select the Recalculate button to display the Setup dialog. 

Step 5 

Select the Reports tab and on the Reports page specify the information you would like to include in the 
report. Select Auto Print if you require the new report to print to the Reports area and to a printer. 

Step 6 

Click OK to display the results in the Report area (and send to the printer if Auto Print is selected). 

How to use advanced reporting options—Concentration 
This outlines ways to fully customize your reports. Options available include:  

Including header and footer information
Including a logo
Editing the text in the report

Note 
You can also retrieve data from Methods (*.FMKN), Data (*.FDKN), Report (*.FRKN), 
Spreadsheet ASCII (*.CSV), GRAMS (*.SPC) and Rich Text Format (*.RTF) file types.

Note 
If you require a printout of only the current graphics in the Graphics area of a previously stored 
data file: 

a. Select the Clear Report option in the Commands menu to clear any text that may be
displayed in the Report area.

b. Press the Print button to obtain a printout of the graphics.

Alternatively tick only the Graph check box in the Reports page to obtain a printout of graphics 
only. 

See also: 
How to use advanced reporting options
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Viewing the report on screen before printing
Cutting and pasting to a word processor

Including header and footer information 

You can have text appearing at the top and bottom of every page in your report. To specify what the text 
should be, do the following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then 
select System Information. The System Information application appears with the Company page 
displayed. 

Step 2 

Enter the header and footer information in the Header and Footer fields. 

Step 3 

Click OK to implement your changes. 

Including a logo 

You can include a logo on the first page of your report. To specify what the logo should be, do the 
following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then 
select System Information. The System Information application appears with the Company page 
displayed. 

Step 2 

Enter a logo using the Add Logo button. This logo will always be included on the front page of reports. 

Step 3 

Click OK to implement your changes. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can 
then add, delete and change text in the Report area.

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application.
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Viewing the report on the screen before printing 

You can view a report before printing it. To do this, from the File menu select Print Preview. You can 
then ensure that the report format is correct before you print it. 

Cutting and pasting to a word processor 

To have complete control over how your report looks you may wish to copy it to a word processor 
program, such as Microsoft Word. To do this: 

Step 1 

Open a report. 

Step 2 

From the Edit menu, choose Edit Report. 

Step 3 

Click in the Report area and highlight the text you want to export to your word processor. 

Step 4 

Right-click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text 
into a document. 

View menu—Concentration 
The View menu is accessible from the menu line at the top of the Concentration Application window. 

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The
Administrator of the system will have to change your privileges before you can edit reports.

Hot Tip 
Use the arrow keys at the bottom of the Print Preview screen to change pages.

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to alter the look of your graphs 
How to display a trace that is not appearing

Hot Tip 
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The following commands can be accessed from the View menu: 

Highlight a method or data file in Explorer and simply drag and drop it onto the application to 
open it. Any data will be displayed in the Graphics area.

Command What it does…

Toolbars Select this option to toggle the Graphics and Reports toolbar on and off. You can also 
select to display or hide the toolbar Text Labels.

Buttons Select this option to toggle the left-hand button display (button area) on and off.

Graphics Select this option to toggle the Graphics area on and off.

Report Select this option to toggle the Report area on and off.

Report 
Vertical 

If the Graphics option is selected, select Report Vertical to display the Graphics area, 
Report area and/or ADL Editor side by side vertically.

ADL Select this option to toggle the ADL Editor on and off.

ADL 
Vertical 

If the ADL and Report options are selected, select ADL Vertical to display the ADL 
Editor vertically on the right hand side of the Report area.

ADL Quick 
Reference 

This displays the Quick Reference window which you can use to easily add a 
command in the correct syntax to your ADL program. A detailed description of all the 
commands in the Quick Reference is available by selecting the Help button on this 
window.

ADL Hooks Select this to activate a link (or hook) to an ADL program at a specific point in the 
application, and then run that ADL program. For example, ADL hooks have been 
supplied to run specific programs: 

on start-up of the Cary Eclipse software;
when the system goes online or offline;
when the Start button is selected;
when a run finishes;
when a zero is performed etc.

For the hook to work, ADL Hooks must be selected, and the appropriate ADL file for 
the application must be present in the Varian/Cary Eclipse WinFLR/ADL folder on 
the drive on which the Cary Eclipse software is installed. 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Hints Select this option to toggle the Hints bubble text on and off. Hint text appears when 
you place the arrow cursor over a field, button or text entry field for a short period. It 
offers a quick explanation of the item’s function.
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Edit menu—Concentration 
Use the Edit menu to copy, cut, paste and delete information. You can also use the menu to access the 
Report editing commands. The menu is accessible from the menu line at the top of the Concentration 
Application window. 

The following commands can be accessed from the Edit menu: 

Status 
Display 

Select this option to display the Status Display window, where you can view the 
status of various parameters during the data collection.

See also: 
Graphics area   
ADL Hooks 
How to insert ADL commands using the Quick Reference 
Graphics area 
Status Display

Note 
These commands are also accessible from the Report Toolbar. From the View menu, point to 
Toolbars and select Report to display the Report Toolbar. 

Command Button What it does… 
Undo If available, this undoes the last action that was performed in the report area. 

This command is also accessible by pressing CTRL+Z.
Cut Select this command to remove the highlighted text and place it on the 

Windows Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Select this command to copy the highlighted text onto the Windows Clipboard.
This command is also accessible by pressing CTRL+C.

Paste Select this command to insert the contents of the Windows Clipboard (text only) 
at the cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Select this command to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
This option is only available once you select Edit Report and there is text 
highlighted in the Report area. 

Select All Select this option to highlight all text in the Report area. 
This command is also accessible by pressing CTRL+A.

Font This enables you to change the font of new or selected text in the report. For 
existing text, simply highlight the text in the report, select Font and make your 
changes in the Font dialog. When you select OK, the appearance of the 
highlighted text in the report will alter to reflect your font changes. 
This command is also accessible by pressing CTRL+F. 

Note 
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Status Display—Concentration 
Use the Status Display window to view the status of your scan during the data collection. Depending 
upon settings you have for the concentration run, the following parameters may be displayed:  

Current Excitation Wavelength (nm)
Current Emission Wavelength (nm)
Excitation Slit Width (nm)
Emission Slit Width
PMT Voltage (V)

To access the Status Display, select Status Display from the View menu, or from any page of the 
Setup dialog. You can choose to view the Status Display at any time during a data collection. 

Print Preview—Concentration 
Use the Print Preview dialog to view the current report before you print it. From the File menu, select 
Print Preview to access the dialog. 

The contents of the Graphics area appear first in the preview area followed by the contents of the Report 
area. You can reduce or enlarge the print preview on screen. To do this, click the left mouse button in 
the preview area to toggle through the five available views. Click the right mouse button in the preview 
area to return to the full page view. 

The page comprises the following commands: 

You do not have to select Edit Report to use this command. 

Edit Report Select this option to edit the report. 
This command is also accessible by pressing CTRL+R.

Recalculate Use the pages accessible from the Recalculate option to perform re-calculations 
on data that has been analyzed.

Create 
Report 

Select this command to create a new report.

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, 
Microsoft Word or Microsoft Excel) into the report area of the of the Concentration application. To 
edit these objects, simply double click on them to open the associated application in which they 
were created.

See also: 
Concentration Application  
Recalculate 

See also: 
View menu 
Setup 
Status line
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Print—Concentration 
Use the Print dialog to select the printer and pages to print of the currently displayed report as well as 
the number of copies you wish to print. From the File menu, select Print to access the dialog. 

All graphical information displayed on screen will be printed with the report, therefore it is advisable to 
edit the report on the screen prior to printing. You can also preview the report prior to printing by using 
the Print Preview command. 

If you require a printout of the graphics in the Graphics area only, select the Clear Report button to 
erase the contents of the Report area before you print. 

First arrow Use this arrow to view the first page of the report.

Previous 
arrow

Use this arrow to view the previous page of the report.

Next arrow Use this arrow to view the next page of the report.

Last arrow Use this arrow to view the last page of the report. 
Q. Why are the arrow buttons grayed out?
A. The buttons will be grayed out if the report has only one page of data.

Print Use this to display the Windows Print dialog where you can choose the printer 
and pages to print as well as the number of copies you wish to print.

See also: 
Print

Note 
The options on the Reports page are used to generate the contents of the Report area during a run 
or on a recalculation. If Auto Print has been selected the Cary Eclipse will automatically print a 
report at the end of a data collection. 

See also: 
File menu  
Print Preview   
Reports  
Edit Report
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Performing Calculations—Concentration 
Recalculate
How to generate a report from previously stored data
How to change the curve of best fit used in the calibration
How to determine the absorptivity of a sample

Recalculate—Concentration 
Select the Recalculate button to access Standards and Reports pages that appear in the Setup dialog. 
These enable you to recalculate the calibration or change the information that appears on the report.  

The Recalculate button is accessible from the Concentration Application window. When you select this 
option, the Recalculate dialog will appear, containing the following page:  

Standards
Reports

How to generate a report from previously calculated data—
Concentration 
Step 1 

Select Open… from the File menu to display the Windows Open dialog. 

Step 2 

A list of previously stored files will appear. If this is not a list of batch files, select the down arrow at the 
right of the Files of type list box and select 'Batch' to list all the batch files. 

Step 3 

Select the Batch file you require then select Open. 

The system will automatically retrieve the collected data into the Graphics area. The method that was 
used to collect the data will also be retrieved. 

Step 4 

Select the Recalculate button to display the Setup dialog.

See also:
Concentration Application window
Setup

Note 
You can also retrieve data from Methods (*.FMKN), Data (*.FDKN), Report (*.FRKN), 
Spreadsheet ASCII (*.CSV), GRAMS (*.SPC) and Rich Text Format (*.RTF) file types.
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Step 5 

Select the Reports tab and on the Reports page specify the information you would like to include in the 
report. Select Auto Print if you require the new report to print to the Reports area and to a printer. 

Step 6 

Click OK to display the results in the Report area (and send to the printer if Auto Print is selected). 

How to change the curve of best fit used in the calibration—
Concentration 

Open stored calibration and sample data
Change calibration curve type
Start recalculation

Once the standards have been measured and the calibration curve plotted on the screen, you may wish to 
change the type of curve used to fit the standard points.  

Open stored calibration and sample data  

Step 1 

From the File menu, select Open to display the Windows Open dialog.  

A list of previously stored batch files will appear. Select the batch file you require then select the Open 
button.  

The system will automatically retrieve the method and calibration that was used to measure the samples 
as well as the sample data. 

Change calibration curve type  

Step 2 

Note 
If you require a printout of only the current graphics in the Graphics area of a previously stored 
data file: 

a. Select the Clear Report option in the Commands menu to clear any text that may be
displayed in the Report area.

b. Press the Print button to obtain a printout of the graphics.

Alternatively tick only the Graph check box in the Reports page to obtain a printout of graphics 
only. 

See also: 
How to use advanced reporting options
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Select the Recalculate button to display the Recalculate dialog. This dialog contains the Standards and 
Reports pages which enable you to set up the recalculation parameters. 

Step 3 

Select the Standards tab. The Standards page is displayed. 

Step 4 

Select the Fit Type algorithm by selecting the button that corresponds to the fit type you require. 

Start recalculation  

Step 5 

Select OK to perform the calibration using the selected Fit Type. 

The Cary Eclipse will create a calibration curve by fitting the selected fit curve to the data results. The 
calibration equation and correlation coefficient will also be sent to the Report area along with the 
recalculated sample results.  

How to determine the absorptivity of a sample—Concentration 
Step 1 

Using the Concentration application, prepare a calibration curve using the appropriate standards. 

Step 2 

Create a calibration curve using Linear Direct as the Fit Type. 

Step 3 

Now look at the calibration equation that is reported in the calibration report. e.g. Abs =
0.05692*Conc. Using the Beer-Lambert law, which states that: 

A=εlc 

where: 
A = absorbance 
ε = absorptivity, cm-1M-1 
l = pathlength, cm
C = concentration of the solute, M

 
See also: 
How to delete a standard from the calibration 
How to export collected data 
How to generate a report from previously calculated data 
How to remove or display the command buttons
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You can see that, in this example, 0.05692 = εl, or the slope of the calibration curve. 

Knowing the pathlength of your cell, you can therefore calculate the absorptivity.  

For example: 
If cell pathlength (l) = 1 cm, then Absorptivity (ε) = 0.05692 cm-1M-1 

If cell pathlength (l) = 0.2 cm, then Absorptivity (ε) = 0.2846 cm-1M-1 

See also: 
How to perform a calibration  
How to perform a calibration and manually measure concentrations  
How to perform a calibration and measure concentrations using the Multicell Holder accessory
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Displaying data graphically—Concentration 
Graphics area
Graphics How To
Graph menu
Graphics toolbar
Graph Labels
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label
Graph Pictures
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture
Trace Preferences dialog
Trace Preferences menu
How to select the focused trace
How to display a trace
How to remove a trace from a graph
How to remove a trace from the trace list
Graph Preferences dialog
How to alter the look of your graphs
Cursor Modes dialog
How to track the focused trace
Axes Scales dialog
How to scale your graph manually
How to scale your graph automatically
Single/Multi Graph
Graphics Templates
How to create a graphics template

The Graphics area of the Concentration Application appears in the top half of the Concentration 
Application window and is used to display traces of collected data. In the Cary Eclipse system, the term 
'graph' refers to the plotting area and is represented by a set of axes. The rectangular area surrounding the 
graph is referred to as the graph box. A graph will appear in the Graphics area when you select Start to 
commence a read. 

To display or hide the Graphics area, select the Graphics command on the View menu. Double-clicking 
on the Graphics area enables you to toggle between half or full size display sizes. 

Graphics area—Concentration 
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You can access the functions associated with the Graphics area by doing the following:  

selecting one of the Graphics toolbar buttons;
selecting a command from the Graph menu; or
clicking the right mouse button in the Graphics area and select a command from the menu

You can customize the graphics area to suit your requirements in the following ways: 

Note 
Not all functions are available on every menu.

Note 
All of the commands and dialogs listed are accessible from the Graph menu. 

To… Use the… Tell me how…

Change the axes scaling 
automatically

Autoscale graph command How to scale your graph 
automatically

Change the axes scaling manually Axes Scales dialog How to scale your graph manually

Modify the graph appearance 
(axes, trace)

Graph Preferences dialog How to alter the look of your 
graphs 

How to specify the number of tick 
marks and decimal places for your 
X and Y axes 

Add a new graph to the display Add graph command

Remove a graph from the display Remove graph command  How to remove graphs

View single or multiple graphs Single/multiple graph 
command

Resize a graph box Cursor How to resize graph boxes

Track the focused trace Cursor Mode dialog How to track the focused trace

Select the focused trace Cursor How to select the focused trace

Display a trace in the graph Trace Preferences dialog How to display a trace that is not 
appearing in a graph box

Remove a trace from a graph Trace Preferences dialog How to remove a trace from a 
graph

Remove a trace from the trace list Trace Preferences dialog How to remove a trace from the 
trace list

Zoom in and out on the graph Zoom In and Zoom Out 
commands

How to zoom a graph
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Graphics How to—Concentration 
Traces  

How to track the focused trace
How to select the focused trace
How to display a trace that is not appearing in a graph box
How to remove a trace from a graph
How to remove a trace from the trace List

Sizing and scale  

How to resize graph boxes
How to scale your graph manually
How to scale your graph automatically
How to alter the look of your graphs
How to zoom a graph

Labels  

How to add a label to a graph
How to edit a label

Add a label to the graph box Add Label dialog How to add a label to a graph

Edit labels in the graph box Edit Label dialog How to edit a label

Moving labels in the graph box Cursor How to move a label

Resizing labels in the graph box Cursor How to resize a label

Delete labels from the graph box Delete Annotation command How to delete a label

Add a picture to the graph box Add Picture dialog How to add a picture to a graph

Move pictures in the graph box Cursor How to move a picture

Replace pictures in the graph box Edit Picture dialog How to replace a picture

Delete pictures from the graph 
box

Delete annotation command How to delete a picture

Save the Graphics area you have 
set up as a graphics template

Save As dialog (from the 
File menu)

How to create a graphics template

Note 
The red trace in any graph box is the one on which all information appears and the one used for the 
cursor tracking. It is called the focused trace. 

See also: 
Graphics Toolbar
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How to delete a label
How to move a label

Pictures  

How to add a picture to a graph
How to move a picture
How to delete a picture
How to replace a picture

Concentration Home Page Index 

Introduction 

Use the Graph menu to view data in various graphical formats or in multiple graphs in the Graphics area. 
You can double-click on the Graphics area to toggle the display through graph and report to graph only. 

In the Cary Eclipse system, the term 'graph' refers to the plotting area and is represented by a set of axes. 
The rectangular area surrounding the graph is referred to as the graph box. A graph will appear in the 
Graphics area when you click Start to commence the concentration run. 

The Graph menu can be accessed in the following ways:  

from the main menu at the top of the Concentration Application window
by clicking the right mouse button in a graph box or the Graphics area

Menu commands 

The following commands can be accessed from the Graph menu: 

Graph menu—Concentration 

Note 
The red trace in any graph box is the one on which all information appears and the one used for the 
cursor tracking. It is called the focused trace.

Menu 
command 

Button Enables you to… 

Print XY 
point 

Select this to print the cursor's current X and Y coordinates in the report area.
Note that this option is only available from the Graph menu that appears 
when you right-click in a graph box.

Copy 
Graph 

Select Copy Graph to copy the entire Graphics area to the Windows 
Clipboard. All of the graphs in the Graphics area will be copied to the 
Clipboard.

Paste to 
Graph 

Select Paste to graph to paste the contents of the Windows Clipboard into 
the Graphics area. Text is pasted as a label, graphics are pasted as pictures.
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Add Graph Select Add graph to add a new graph box to the Graphics area. You may 
want to do this if you have, for example, a graph containing existing data and 
you want to collect some new data in a new graph.

Remove 
Graph 

Select Remove graph to delete the selected graph box from the Graphics 
area. The graph box is removed, but the data is not deleted and is still 
available from the Trace Preferences window. 
You may want to use remove graph if you have a large number of graph 
boxes open but only want to focus on some of these. 

Note 
You can remove multiple graph boxes by first holding down the CTRL 
key and selecting the graphs to be removed and then selecting the 
Remove Graph button or menu item. Use the SHIFT key to highlight a 
range of graphs for removal.

Clear All 
Traces 

Select Clear All Traces to delete all traces from the graph/s. Note that 
selecting this option simply turns off the Visible property for the traces in the 
Trace Preferences window. You can redisplay the traces by making the traces 
Visible again in the Trace Preferences window.

Add Label Select Add Label to display the Add Label dialog where you can enter a text 
label to be placed on a graph or in the background of the Graphics area.

Add Picture Select Add Picture to display the Add Picture dialog where you can select a 
picture, bitmap or chemical structure to be placed on a graph or in the 
background of the Graphics area.

Edit 
Annotation 

Select Edit Annotation to alter the content or look of the selected annotation, 
(either a label or a picture) in the Graphics area. 

If the selected annotation is a label, selecting Edit Annotation will open the 
Edit Label dialog where you can change the text of the selected label. 
If the selected annotation is a picture, selecting Edit Annotation will open the 
Edit Picture dialog where you can replace the selected picture with a new 
picture. 

Note 
This option can only be activated if an annotation is selected.

Delete 
Annotation 

Select Delete Annotation to remove an annotation, (such as a label or a 
picture) from the Graphics area. 
You can use this menu option to remove highlighted annotations in the 
Graphics area such as labels, pictures and ruler/fit information. 

Note 
This option can only be activated if an annotation is selected.

Trace 
Preferences 

Select this command to display the Trace Preferences window where you can 
select the trace(s) to display in the selected graph.

Graph 
Preferences 

Select this command to display the Graph Preferences dialog where you can 
change the appearance of your graph. Any changes you make to the 
appearance of the graph will be applied to all graphs.
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Use the Graphics Toolbar buttons to gain quick access to many of the Graph menu options. You can 

Cursor 
Mode… 

Select this command to display the Cursor Modes dialog where you can 
choose the type of cursor to be used on the screen. For example, you can 
select to use a free cursor that can move anywhere in the graph or exactly 
trace the focused scan (red scan).  Alternatively, you can select a cursor that 
enables you to draw a line from one point to another to determine the slope 
using either the Least Squares method or the Point to Point method.

Axes 
Scales… 

Select this command to display the Axes Scales dialog where you can set the 
scale range for the X and Y axes.

Auto scale 
graph 

To automatically scale the graph, point to one of the following options: 

Autoscale[XY] 
Select Autoscale[XY] to automatically scale collected data by scaling the Y 
height and X width to full screen. 

Autoscale[X] 
Select Autoscale[X] to automatically scale collected data by scaling the X 
width to full screen. 

Autoscale[Y] 
Select Autoscale[Y] to automatically scale collected data by scaling the Y 
height to full screen. 

Zoom Out Select Zoom Out to Zoom back to the original X and Y ranges which were 
used to collect the data (i.e. the method setup conditions of the focused scan).
For example, the system will revert back to the X and Y ranges set in the 
method if you zoom in and out during a data collection.

Single/Multi 
Graph 

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note 
The graph highlighted in the Multi Graph view will be displayed when 
you toggle the Single Graph option.

Auto 
Arrange 
Graphs 

Select Auto Arrange Graphs to view and arrange all graphs simultaneously. 
Note 
You can move graph boxes manually by clicking the left mouse button 
outside the graph axes and dragging the graph box to a new position. 
You can also resize graphs.

History List This displays a list of the current graphs. 

See also: 
Toolbar 
Graphics area 
Graphics How to…

Graphics Toolbar—Concentration 
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also use the toolbar to select the graph you want to view and to change the look of your graphs.

To display or hide the toolbar, point to the Toolbars option in the View menu and select Graphics. To 
display or hide the toolbar's text labels, point to the Toolbars option in the View menu and select Text 
Labels. 

The following commands can be accessed from the Graphics Toolbar: 

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to…

Trace 
Preferences  

Click this button to display the Trace Preferences window where you can select 
the trace(s) to display in the selected graph.

Graph 
Preferences 

Click this button to display the Graph Preferences dialog where you can change 
the appearance of your graph. Any changes you make to the appearance of the 
graph will be applied to all graphs.

Cursor 
Mode 

Click this button to display the Cursor Modes dialog where you can choose the 
type of cursor to be used on the screen. For example, you can select to use a 
free cursor that can move anywhere in the graph or exactly trace the focused 
scan (red scan).  Alternatively, you can select a cursor that enables you to draw 
a line from one point to another to determine the slope using either the Least 
Squares method or the Point to Point method.

Axes 
Scales…  

Click this button to display the Axes Scales dialog where you can set the scale 
range for the X and Y axes.

Autoscale
[XY] 

Click the Autoscale[XY] button to automatically scale collected data by scaling 
the ordinate (Y) height and abscissa (X) width to full screen.

Autoscale
[X] 

Click the Autoscale[X] button to automatically scale collected data by scaling 
the abscissa (X) width to full screen.

Autoscale
[Y] 

Click the Autoscale[Y] button to automatically scale collected data by scaling 
the ordinate (Y) height to full screen.

Zoom Out Click the Zoom Out button to Zoom back to the original X and Y ranges which 
were used to collect the data (i.e. the method setup conditions of the focused 
scan).  
For example, the system will revert back to the X and Y ranges set in the 
method if you zoom in and out during a data collection.

Add Label  Click this button to display the Add Label dialog where you can enter a text 
label to be placed on a graph or in the background of the Graphics area. 

Add Picture  Click this button to display the Add Picture dialog where you can select a 
picture, bitmap or chemical structure to be placed on a graph or in the 
background of the Graphics area.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
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Graph Labels—Concentration 
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label

Use the Add Label dialog to place a label on your graph or into the background of the Graphics area.

Note 
The graph highlighted in the Multi Graph view will be displayed when 
you toggle the Single Graph option.

Auto 
Arrange 
Graphs 

Click the Auto Arrange Graphs button to view and arrange all graphs 
simultaneously. 

Note 
You can move graph boxes manually by clicking the left mouse button 
outside the graph axes and dragging the graph box to a new position. You 
can also resize graphs.

Add Graph Click this button to add a new graph box to the Graphics area. You may want to 
do this if you have, for example, a graph containing existing data is displayed 
and you want to collect some new data in a new graph.

Remove 
Graph 

Click this button to delete the selected graph box from the Graphics area. The 
graph box is removed, but the data is not deleted and is still available from the 
Trace Preferences window. 
You may want to use remove graph if you have a large number of graph boxes 
open but only want to focus on some of these. 

Note 
You can remove multiple graph boxes by first holding down the CTRL 
key and selecting the graphs to be removed and then selecting the 
Remove Graph button or menu item. Use the SHIFT key to highlight a 
range of graphs for removal.

Clear All 
Graphs 

Click this button to delete all traces from the graph/s. Note that selecting this 
option simply turns off the Visible property for the traces in the Trace 
Preferences window. You can redisplay the traces by making the traces Visible
again in the Trace Preferences window.

See also: 
Graph menu 
Graphics Area 
Graphics How to

Add Label—Concentration 
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To add a label to a graph box, you must have at least one trace Visible in the graph box. (You can select 
which traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple 
graphs, the label will be placed in the graph box that is currently selected. However, you can add a label 
outside of a graph box in the background of the Graphics area at any time. 

The Add Label dialog comprises the following: 

Q. Can I add a label that will print with all my graphs.
A. Yes, you can add your label to the background of the Graphics area. To do this, right-click on a
section of the background (gray area) and select Add Label from the menu. (You will notice that
this menu has less options than the menu that appears when you right-click on a graph.) In the Add
Label dialog, enter the label to be added to all graphs and select OK. The label will appear in the
background of the Graphics area.

To access the Add Label dialog, select the Add Label command from the Graph menu, or select 
the Add Label button on the Graphics toolbar.

To selected 
trace

Select this option to associate a label with the selected trace. When you associate a label 
with a trace and make the trace visible in the Graph box, the label will also be displayed 
with the trace.

To selected 
graph

Select this option to associate the label with the selected graph. When you associate a 
label with a graph, the label will always be displayed in the Graph box, regardless of 
what traces are visible.

Selected trace This will identify the trace that is currently selected and display the name of the trace.
Font… Click Font to open the Windows Font dialog. In this dialog you can specify the font 

type, style and size to be used for the label.
Label Use the Label field to enter the text for the label. You can enter as many lines of text as 

you require.

Hot Tip 
If you wish to include certain XY co-ordinates on the graph as a label, position your cursor at the 
appropriate place, right-click and select Add Label from the menu. When the Add Label dialog 
appears, the co-ordinate positions will be added to the Label field. 
Note 
When you save the data (as a Batch or Data file) the label is saved with its associated trace or 
graph. Labels outside graph boxes can be saved in a graphics template. To do this, choose Graph 
Template as the Save As type in the Save As dialog. 
See Example of a Graphics Template.
See also: 
Trace Preferences  
Graph menu  
Graphics toolbar  
How to add a label to a graph 
How to move a label 
How to edit a label 
How to resize a label 
How to delete a label
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Use the Edit Label dialog to alter the content or look of your label. 

To access the Edit Label dialog, right-click on the label you wish to change and select Edit Annotation 
from the menu. 

The dialog comprises the following: 

How to add a label to a graph—Concentration 
You can add a label to your graph or Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area 
background. 

Step 2 

Click the Add Label button on the toolbar or right-click on the graph and select Add Label from the 
menu. The Add Label dialog will appear. 
The Add Label command is also accessible from the Graph menu. 

Step 3 

Click the Font button. The Windows Font dialog appears. Select the font type, size and style you require 
for your label. A sample of the font style appears in the Sample field. When you are satisfied with your 
selections, select OK to return to the Add Label dialog. 

Step 4 

Enter the label in the Label field and select OK. The label will be displayed on the selected graph. If 
necessary, you can move a label so that it is more appropriately placed on your graph. 

Edit Label—Concentration 

Font Select Font to open the Font dialog, where you can specify the font type, style and size 
to be used for the label.

Label Use the Label field to alter the text for the label. 

See also: 
How to edit a label 
How to add a label to a graph 
How to resize a label 
How to move a label

Note 
There must be at least one trace Visible in the graph box before you can add a label to it.

See also: 
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How to edit a label—Concentration 
Step 1  

Place the cursor on the label and click the left mouse button to select the label. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu. Alternatively you 
can select the Edit Annotation command from the Graph menu. The Edit Label dialog is displayed. 

Step 3  

Use the Edit Label dialog to change the label. 

For example, if you want to change the font size of the label, select the Font button. In the Size field, 
scroll through the available sizes for the font and select the size you require. Alternatively, highlight the 
currently selected size in the Size entry field and enter the size you require. Click the OK button in this 
dialog to return to the Edit Label dialog. 

Step 4  

Click OK to clear the Edit Label dialog. Your label will appear with the new font size. 

How to move a label—Concentration 
To move a label so that it is more appropriately placed on your graph or Graphics area background, do 
the following: 

Step 1  

Place the cursor on the label. 

Step 2  

Click and hold down the left mouse button. 

How to move a label 
How to edit a label  
How to resize a label 

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label 
selection. Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label 
How to delete a label
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Step 3  

Drag the label to the correct position and release the mouse button. The label will be displayed at the new 
position. 

How to resize a label—Concentration 
To resize a label so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the label by clicking on it with the mouse. A border will be displayed around the label to indicate it 
is selected. 

Step 2  

Position the cursor over one of the corner edges of the label until the cursor becomes a diagonal double-
headed arrow. Click and hold down the left mouse button. 

Example of label showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the label by dragging the mouse. The label text will also be resized. 
Release the mouse button when the label and text are the correct size. 

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label  
How to resize a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 
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How to delete a label—Concentration 
To delete a label from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the label and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The label will be 
deleted from the graph or Graphics area. 

Graph Pictures—Concentration 
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture

Use the Add Picture dialog to insert a picture or bitmap into the Graphics area. The picture can be added 
as a background picture or to a particular graph box. 

To add a picture to a graph box you must have at least one trace Visible in the graph box. (You can select 
which traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple 
graphs, the picture will be placed in the graph box that is currently selected. However, you can add a 
picture outside of a graph box in the Graphics area at any time. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label 
selection. Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label

Add Picture—Concentration 
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The Add Picture dialog comprises the following commands: 

Use the Edit Picture dialog to change a picture you have inserted into the Graphics area. 

To access the Edit Picture dialog, right-click on the picture you wish to change and select Edit 
Annotation from the menu. 

The Edit Picture dialog comprises the following commands: 

Q. Can I add a picture that will print with all my graphs.
A. Yes, you can add your picture to the background of the Graphics area. To do this, right-click on a
section of the background and select Add Picture from the menu. (You will notice that this menu
has less options than the menu that appears when you right-click on a graph.) In the Add Picture
dialog, load the picture to be added to all graphs and select OK. The picture will appear in the
background of the Graphics area.

To access the Add Picture dialog, select the Add Picture command from the Graph menu, or 
select the Add Picture button on the Graphics toolbar.

To selected 
trace

Select this option to associate a picture with the selected trace. When you associate a 
picture with a trace and make the trace visible in the Graph box, the label will also be 
displayed with the trace.

To selected 
graph

Select this option to associate the picture with the selected graph. When you associate a 
picture with a graph, the label will always be displayed in the Graph box, regardless of 
what traces are visible.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer 
for the picture you want to insert. The picture must be one of the following formats: 
DIB, JPG, PGEG, BMP, EMF or WMF. 

If you are viewing multiple graphs the picture will be placed on the graph that is 
currently selected. If no graph is selected, the picture will be placed on the Graphics area 
background. 

When you save the data (as a Batch or Data file) the picture is saved with its associated 
trace or graph. Pictures outside graph boxes can be saved in a graphics template. To do 
this, choose Graph Template as the Save As type in the Save As dialog. 
See Example of a Graphics Template. 

See also: 
How to add a picture to a graph 
How to move a picture 
How to resize a picture 
How to delete a picture 
How to replace a picture

Edit Picture—Concentration 

To selected 
trace/graph

Displays whether you originally selected to add the picture to a trace or a graph. This 
option is not editable.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer 
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How to add a picture to a graph—Concentration 
You can add a picture to your graph or the Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area 
background. 

Step 2 

Click the Add Picture button on the toolbar or right-click on the graph and select Add Picture from the 
menu. The Add Picture dialog will appear. 
The Add Picture command is also accessible from the Graph menu. 

Step 3 

Click the Load button. The Windows Open dialog appears. 

Step 4 

Browse through your directories to find the picture you want to insert. All pictures must be in the bitmap 
format and will have the extension .BMP. 

Step 5 

Highlight the .BMP that you want to insert and select Open. 

Step 6 

The Add Picture dialog will appear showing a preview of the bitmap. If the bitmap is the correct one 
select the OK button. The bitmap will be placed onto the graph. 

for the picture you want to insert. The selected picture will replace the current picture. 
The picture must be one of the following formats: DIB, JPG, JPEG, BMP, EMF or 
WMF. 

See also: 
How to replace a picture 
How to add a picture 
How to move a picture 
How to resize a picture 
How to delete a picture

Note 
There must be at least one trace Visible in the graph box before you can add a picture to it.

Note 
You should take care not to add a bitmap that is too big as it will obscure part or all of your graph.
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You can move a picture so that it is more appropriately placed on your graph.

How to replace a picture—Concentration 
To change a picture that you have added to a graph or Graphics area background do the following: 

Step 1  

Move the cursor to the picture and select the left mouse button to select it. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu or select Edit 
Annotation from the Graph menu. The Edit Picture dialog is displayed. 

Step 3  

From the Edit Picture dialog, select the Load button. The Windows Open dialog is displayed. 

Step 4  

Browse through your directories to find the picture to replace the current bitmap. Picture files must be in 
one of the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

Step 5  

Highlight the file that you want to insert and select Open to return to the Edit Picture dialog. 

Step 6  

The Edit Picture dialog will display a preview of the bitmap. If the bitmap is the correct one select the 
OK button. The bitmap will be placed onto the graph. If you need to, move the picture so that it is more 
appropriately placed on your graph. 

See also: 
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Do not to add a bitmap that is too big as it will obscure part or all of your graph. 

See also: 
How to add a picture to a graph 
How to move a picture 

Page 16 of 31Displaying data graphically

   



How to move a picture—Concentration 
To move a picture so that it is more appropriately placed on your graph or Graphics area background, do 
the following: 

Step 1  

Place the cursor on the picture. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the picture to the correct position and release the mouse button. The picture will be displayed at the 
new position. 

How to resize a picture—Concentration 
To resize a picture so that it is more appropriately sized on your graph or Graphics area background, do 
the following: 

Step 1  

Select the picture by clicking on it with the mouse. A border will be displayed around the picture to 
indicate it is selected. 

Step 2  

Position the cursor over one of the corner edges of the picture until the cursor becomes a diagonal 
double-headed arrow. Click and hold down the left mouse button.

How to delete a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.
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Example of picture showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the picture by dragging the mouse. The picture will also be resized. 
Release the mouse button when the picture is the correct size. 

How to delete a picture—Concentration 
To delete a picture from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the picture and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The picture will be 
deleted from the graph or Graphics area. 

Trace Preferences table | Trace Audit Log 

A single graph box can display many traces. Use the Trace Preferences dialog to select the trace(s) to 
display (make Visible) in the selected graph box.

See also: 
How to add a picture to a graph  
How to move a picture to a graph 
How to delete a picture 
How to replace a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to move a picture 
How to zoom a graph  
How to resize a picture

Trace Preferences—Concentration 
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The dialog comprises the following: 

Trace Preferences table 

Trace Audit Log 

The Trace Audit Log displays information about the highlighted trace. This includes instrument 
parameters and data form information relating to the trace that has been selected. It also logs all 
information about data manipulation. When more than one trace is highlighted, the Trace Audit Log will 
display information about the trace that was first selected.

To access the Trace Preferences dialog, select the Trace Preferences command from the Graph 
menu, or select the Trace Preferences button on the Graphics toolbar.

Hot Tip 
The Trace Preferences menu is also available on clicking the right mouse button anywhere in the 
trace listing.

Visible Use the Visible field to select which traces will appear on the selected graph. To select 
or clear the Visible field, simply click the left mouse button in this column. A tick will 
appear next to traces that are to be displayed in the selected graph. 

If you are in single graph view, all selected traces will appear on the one graph. If you 
are in Multi Graph view the traces will appear on the graph that is currently selected. 

Hot Tip 
To make all traces Visible, right-click on the table and select the Select All 
command from the menu. Then right-click on the table again and select the Show 
Traces command from the menu.

Color The Color field enables you to view the color of each trace that appears on the selected 
graph.  To change the color of a trace, highlight it, click the right mouse button in the 
Trace Preferences table and select Change Trace Color. You can then select a color 
from the Color dialog that is displayed. 

The red trace in any graph box is the one on which all information appears. This trace, 
which is used for the cursor tracking, is called the focused trace and it is always red. 
When you select a trace in the Color column it will become the focused trace in the 
selected graph box. 

Note 
When you change the trace line width in the Graph Preferences dialog it also 
will change the width of the color trace line in this dialog.

Name of 
trace 

The Name of Trace field contains a description of the traces currently available for 
display in the selected graph box.

Filename This field displays the filename and path for the trace. If the name is too long to appear 
in the field you can use the keyboard arrow keys to scroll to the end of the filename or 
you can resize the Trace Preferences window. If the file path for a trace shows 'not 
saved' then the trace is unsaved data and is only stored in memory.

Page 19 of 31Displaying data graphically

   



The Trace Preferences menu is displayed when you click the right mouse anywhere on the Trace 
Preferences table. The menu contains the following commands: 

How to select the focused trace—Concentration 
To select the scan that you want to be the focused (red) trace, do one the following:  

From the Graph, click the left mouse button on the trace that you want to make the focused trace.

From the Graph Legend (if displayed), click the left mouse button on the trace that you want to
make the focused trace.

From the Trace Preferences dialog, click in the Color column of the trace that you want to make

See also: 
Trace Preferences menu 
Graph menu 
Graphics toolbar  
Graph Preferences dialog  
How to make multiple traces visible in a graph 
How to remove a trace from the trace list 
How to remove a trace from a graph

Trace Preferences menu—Concentration 

Select All This selects or highlights all the traces in the listed on the Trace Preferences page.
Select None This de-selects all the traces in the listing.
Show Traces Select Show Traces to make all of the traces currently highlighted Visible, meaning 

that they will be displayed in the current graph box.
Hide Traces Select Hide Traces to remove the Visible property from all the traces currently 

highlighted, which will remove them from the current graph box.
Delete Traces Select Delete Traces to delete all the highlighted traces in all graphs. Note that if you 

save the data file before you select Delete Traces, the traces are not deleted from the 
saved file, and they can be retrieved at a later date. 
Selecting Delete Traces will delete the traces from the application memory, and it is 
recommended that you select this option if you need to free up memory on your 
computer. 

Note 
If the application is controlled by the GLP Administration application, you will be 
prompted to save an unsaved data file before it is removed from the application.

Change 
Trace Color 

Select Change Trace Color to display the Windows Color dialog where you can 
change the color of the currently highlighted trace(s). The focused trace will remain red 
while it retains the focus, and will revert to the selected color when the focus is moved.

See also: 
Trace Preferences 
Graph Preferences 
How to remove a trace from the trace list 
How to remove a trace from a graph
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the focused trace.  

How to display a trace that is not appearing in the graph box—
Concentration 
Step 1 

Click on the graph in the Graphics area. 

Step 2 

Select the Trace Preferences button  from the Graphics toolbar, or select Trace Preferences from 
the Graph menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you wish to see and select the Visible option. A tick will appear in the Visible column 
to indicate that it will now be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you want to display.
b. Click the right mouse button and select the Show Traces command from the drop-down menu.

Ticks will appear next to the selected traces to indicate that they will now be displayed.

Step 4 

Press OK to clear the Trace Preferences dialog. The selected trace(s) will be displayed. 

How to remove a trace from a graph—Concentration 
Step 1 

Select a graph in the Graphics area. 

Step 2 

Click the Trace Preferences button on the Graphics toolbar or select Trace Preferences from the 

Note 
Select the Show Legend check box in the Graph Preferences dialog to display the Graph Legend 

See also: 
How to track the focused trace 
How to view a particular trace

See also: 
How to remove a trace from a graph 
How to remove a trace from the trace list
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Graph menu. The Trace Preferences dialog is displayed.

Step 3 

Find that trace that you no longer wish to see and select the Visible option. The tick will be removed 
from the Visible column to indicate that it will not be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you no longer want to display.
b. Click the right mouse button and select the Hide Traces command from the drop-down menu. The

ticks will be removed from the selected traces to indicate that they will not be displayed.

Step 4 

Select OK to clear the Trace Preferences dialog. The trace will be removed from the graph. 

Axes Preferences | Advanced Options | Trace Style | Show Legend 

Introduction 

Use the Graph Preferences dialog to change the appearance of your graph. 

All graphs will appear labeled with the X axis label being horizontal and the Y axis vertical. You cannot 
change the orientation of these labels. However you can alter the font and size of the axes and their 
labels. 

Any changes you make to the appearance of the graph will apply to all graphs until the settings are 
changed again. 

Dialog controls 

The Graph Preferences dialog comprises the following: 

Axes Preferences 

See also: 
How to display a trace that is not appearing in the graph box 
How to remove a trace from the trace list

Graph Preferences—Concentration 

To access the Graph Preferences dialog, select the Graph Preferences command from the 
Graph menu, or select the Graph Preferences button on the Graphics toolbar.

Axes Color Select the color that you want to assign to the axes of the graph/s from the drop down 
list.

Axes Width Select the width of the axes from the drop down list. The width, which is in pixels, 
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Advanced Options 

Trace Style 

ranges between one and five pixels.

Grid Style Select the style of grid for the graph from the drop down list. If you do not wish to 
include a grid on the graph, select None.

Plot Area 
Color

Select the color to be used as the background of the graph from the drop down list. If 
you do not want a background color on the graph, select White.

Trace Width Select the width of the trace from the drop down list. The width is given in pixels and 
ranges between one and five pixels.

Font Click the Font button to display the Windows Font dialog where you can define the 
font style for the axes of the graph/s. The style and size of the font will be applied to all 
graph. The style, name and point size of the font appears on the font button.

Preview Box Preview any changes you make to the axes preferences in the preview box. The 
changes shown in this box will not be made until you select OK.

Auto tick 
marks

The Auto tick marks option enables you to approximately set how many tick marks 
(or points) will be included on the graph axes. The tick marks generated will be whole, 
rounded, even numbers. The Auto tick marks option is not available if you have 
selected Major ticks. 

Y-axis
Use the Y-axis slider bar to increase or decrease the number of tick marks (or points) to
be included on the Y axis.

X-axis
Use the X-axis slider bar to increase or decrease the number of tick marks (or points) to
be included on the X axis.

Major ticks Use the Major Ticks option to enable you to set exactly how many ticks (or points) 
will be added to the X and Y axes. The number of marks you specify will be divided by 
the axis range, which can result in odd numbers on the axis. Note that any changes are 
not reflected in the graph bitmap at the top of the screen.

Decimals Use the Decimals option to set the number of X and Y decimal places to be displayed 
on the axes. To set the number of decimal places, select the Decimal option and enter 
the number in the Y-axis and X-axis combo boxes. Note that any changes are not 
reflected in the graph bitmap at the top of the screen.

Points Select Points to display each individual data point collected by the Cary Eclipse on the 
graph.

Points and 
solid lines

Select Points and Solid Lines to display each individual data point collected by the 
Cary Eclipse on the graph. Additionally, an interpolated line that connects the points 
will be drawn.
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Show Legend 

How to alter the look of your graphs—Concentration 
Step 1 

Click the Graph Preferences button  on the Graphics toolbar, or select Graph Preferences from the 
Graph menu. The Graph Preferences dialog is displayed. 

Step 2 

Use the available options available to choose your preferred appearance for the graphs. A preview box in 
the top right-hand corner will demonstrate how the graphs will appear. 

Step 3 

Select OK to clear the Graph Preferences dialog and update all graphs to reflect your selections. 

Step 4 

To re-use your graphics setup at a later date, save the setup as a graphics template. 

Solid lines If you select Solid Lines, the Cary Eclipse system will interpolate the data between the 
actual, collected data points and show the data as a continuous line.

Style cycles 
automatically

If you select Style Cycles Automatically, the Cary Eclipse system will display each of 
the above three trace styles. This makes it easier to differentiate between traces, 
especially on black-and-white printers.

Show Legend Select Show Legend to display a legend in the right side of each graph box. 
A single left click on a sample name or example line within the legend will make it the 
focused or red trace. Information about the trace will be displayed below the X axis. 

Hot Tip 
Double-clicking on the legend will automatically display the Trace Preferences 
window, allowing you to view more detailed information about your trace (e.g. 
audit log, File name, etc.). 

See also: 
Graph Menu 
Graphics toolbar 
Graphics area 
Graphics How To

Note 
You can also add labels and pictures to your graphs to alter their appearance. 

See also: 
How to add a label to a graph 
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Use the Cursor Modes dialog to choose the type of cursor to be used on screen. For example, you can 
select to use a free cursor that can move anywhere in the graph.  

The dialog comprises the following: 

Cursor Selection 

How to track the focused trace—Concentration 
To track the focused (red) trace in the graph: 

Step 1  

How to add a picture to a graph 
How to move a label 
How to move a picture 
How to resize graph boxes 
How to make a graphics template

Cursor Modes—Concentration 

To access the Cursor Modes dialog, select the Cursor Modes command from the Graph menu, or 
select the Cursor Modes button on the Graphics toolbar.

Free The Free cursor is not confined to a particular trace on the graph. It can move 
anywhere in a graph box, and its ‘X,Y’ position is shown in the bottom right-hand side 
of the Graphics area. You can use the Free cursor to zoom in on a particular part of a 
graph. 

Note 
The Free cursor moves from point to point in the selected graph box. Hence you 
need to be careful when positioning the cursor over a trace to obtain an accurate 
(X,Y) reading. It is recommended that you use the Track cursor mode for this.

Track Use the Track cursor to exactly trace the focused (red) trace in a graph box. The cursor 
position is displayed in the X and Y at the bottom right-hand side of the Graphics area. 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the 
cursor to the required position. Click the left mouse button, press ‘Alt’ on the 
keyboard, then release the mouse button.

Track 
Intensity

Select the Track Intensity option if you want to associate an intensity value with the 
tracking. The cursor will then track from point to point on the continuum between the 
intensity value you enter. The default value will be 50% of the maximum intensity of 
the focused continuum.

Peaks Choose from the options of Peaks, Valleys or Peaks Valleys to move the cursor from 
peak to peak, valley to valley or from one peak/valley to the next.

See also: 
How to zoom a graph 
How to track the focused trace
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Click the Cursor Modes button  from the Graphics toolbar, or select Cursor Mode from the Graph 
menu. The Cursor Modes dialog will appear. 

Step 2  

Select Track and select the OK button. 

Step 3  

Place the blue tracking cursor in the graph box you require.  

Step 4  

Move the cursor left and right across the graph box to trace the focused (red) scan. The cursor coordinates 
change (in the X, Y field at the bottom left hand corner of the Graphics area) as you move along the 
curve. 

Use the Axes Scale dialog to manually change the axes range. This can assist in zooming in on a 
particular part of the graph. 

The dialog comprises the following: 

X Axis 

Y Axis 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the required 
position. Press ALT  on the keyboard, then release the mouse button. 

See also: 
How to select the focused trace 
How to view a particular trace

Axes Scales—Concentration 

To access the Axes Scale dialog, select the Axes Scale command from the Graph menu, or select 
the Axes Scale button on the Graphics toolbar.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the X axis, in the format n1 - n2 (where n1 is 

the start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can 
access by selecting the down arrow adjacent to the Scale field.
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How to scale your graph manually—Concentration 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

Click the Axes Scales button  on the toolbar, or select Axes Scales from the Graph menu. The Axes 
Scales dialog id displayed. 

Step 3  

Type in the new ranges for the X and Y axes in the format ‘n-n’, or choose an option for each from the 
drop-down list. 

Step 4  

Select OK. The axes on the selected graph will change to reflect your chosen settings. 

How to scale your graph automatically—Concentration 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

To autoscale the graph, select one of the following: 

Mode View the current units for the Y axis.
Scale Use the Scale field to enter a new range for the Y axis, in the format n1 - n2 (where n1 is 

the start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can 
access by selecting the down arrow adjacent to the Scale field.

See also: 
How to scale your graph manually 
How to scale your graph automatically 
How to zoom a graph

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale a graph automatically
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Click the Autoscale XY button  on the toolbar to autoscale both X and Y axes. 

Click the Autoscale X button  on the toolbar to autoscale the X axis only. 

Click the Autoscale Y button  on the toolbar to autoscale the Y axis only. 

The focused trace will be scaled according to the option selected. 

Select the Single/Multi Graph option to toggle between a display of either one or multiple graph boxes 
in the Graphics area. Note that up to 100 graphs can be displayed in the Graphics area at the one time.  

Example of a single graph box display 

Example of a multi graph box display 

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale your graph manually

Single/Multi Graph—Concentration 

The Single/Multi Graph option is accessible from the Graph menu or the Graphics toolbar.
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Example of a Graphics Template—Concentration 
By using the Add Label command in the Cary Eclipse graphics system, you can customize a graphics 
template such as the one shown below: 

The above is created as follows:  

The graph on the left is the collected data.
The text on the top right is a multi-line label (added using the Add Label command).
The logo is an inserted picture (added using the Add Picture command).

How to make a graphics template—Concentration 
A graphics template lets you set up and store the style of a graphics report for future use. You can do this 
by adding labels and pictures to the background of the Graphics area and altering any axes styles etc. One 
advantage of this over the application's built-in reporting features is that you have more flexibility as to 
where you can position graph boxes and any text that you may want to appear (e.g. operator name, batch 
number etc.) and also where you add pictures, e.g. company logos etc.  

Step 1 

Start the application and open the data file from which you want to make a graphics template. 

See also: 
Graph menu 
Graphics toolbar 
Graphics How To

See also:
Add Label
How to make a graphics template
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Alternatively, collect some new data. 

Step 2 

Make as many graph boxes as you require in your template by using the Add Graph function. 

Step 3 

Adjust the graph boxes to the correct size and position them as you want them to appear in the template. 

Step 4 

Do any of the following, if required: 

Change the appearance of the graph boxes in the Graph Preferences dialog
Use the Add Label function to append text to the Graphics area
Use the Add Picture function to add pictures, such as your company's logo to the Graphics area

Step 5 

From the File menu, select Print Preview. Use the Print Preview dialog displayed to check the template 
that you have created. 

Step 6 

When you are satisfied with the appearance of the graphics, select the Save As… command from the File
menu. The Save As dialog is displayed. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and 
select 'Graph Template' to list all the template files. Ensure that the Save only focused trace check box is 
cleared. 

Step 8 

Enter a name for the template in the File name field. 

Step 9 

Select OK to save the graphic template. The template will be used each time you create a new file. 

Note 
You can also make a graphic template in a similar manner from existing data. No data will be saved 
in the template. 

See also: 
Example of a Graphics Template 
How to add a label to a graph 
How to add a picture to a graph 
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How to move a label 
How to move a picture
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File Management—Concentration 
File menu
Open dialog
Save As dialog
Filename extensions
ASCII spreadsheet file
Auto Store page
How to export collected data

File menu—Concentration 
Use the File menu to open or save a method or data file, print or preview a report, or exit the Cary 
Eclipse application. 

The following commands can be accessed from the File menu: 

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to 
open it. Any data will be displayed in the Graphics area.

Command What it does…
New Select New to clear all method information and report information and create a new 

file containing the default settings for the application. The Save As dialog will be 
displayed for you to enter the name of the new file and select a location.

Open 
Method… 

Select Open Method to display the Open dialog where you can search for and load a 
stored method. 

Open… Select Open to display the Open dialog where you can search for and load method, 
data, report, graph template and batch files, as well as other file types compatible with 
the Cary Eclipse software. When you load a batch file, the method which collected the 
data is loaded as well as the associated report and graphics layout.

Save Method 
As… 

Select this option to display the Save As dialog and store the current method. You can 
use the Save As dialog to store the method, data, report, or graphics template 
separately or together as a Batch file. The data can also be saved as a comma delimited 
ASCII Spreadsheet file.

Save As… Select this option to display the Save As dialog and store the collected data. You can 
use the Save As dialog to store the method, data, report, or graphics template 
separately or together as a Batch file. The data can also be saved as a comma delimited 
ASCII file.

Print Setup… Select this option to display the Windows Print Setup dialog where you can select the 
printer, printer page size and orientation.

Print 
Preview… 

Select this option to display the Print Preview dialog where you can view the current 
report as it will be printed.

Print… Select this option to display the Windows Print dialog where you can choose the 
printer and pages to print as well as the number of copies you wish to print.

Explorer… Select this option to run Windows Explorer. This may help you locate method and data 
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Open—Concentration 
Look in | File name | Files of type | Overlay Data | Open 

Use this dialog to open a file previously saved by the application. To access the Open dialog, select 
Open or Open Method from the File menu. 

files.
History List This displays a list of the four most recently opened files.
Exit Select this option to exit the Concentration application. 

See also: 
Save As dialog 
Open dialog 
Print Preview dialog 
Filename Extensions 
ASCII Spreadsheet File

Look in The Look In field lists the available folders and files. Click the down arrow on the 
right of this field to view the location of the current folder in your computer's 
hierarchy. You can also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In 
field. 

Click to open the folder in the level that is one higher than the current folder, 
select  on the toolbar.

Look in list 
box 

The Look In List Box, which is directly below the Look In field, displays the folders 
and files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted 
text entry field that appears and press Enter. Then double-click on the new 
folder to open it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the 
date the file was last modified.
Click to preview the selected trace before you load it into the application.

File name Enter the name of the file you want to open in this field. The easiest way to do this is 
to find the file in the Look in list box and then select the file. However, you can type 
the full path of a file and then select Open to open the file.

Files of type Click on the arrow on the right of this field to view a list of the different types of 
application files that can be opened in the list box. 
Methods 
(*.FMSW)

Choose this file type to open a Method file. Only the method is 
loaded. No data is loaded.
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Save As—Concentration 
Look in | File name | Files of type | Save 

Use the Save As dialog to save the data, method, report or graphics template individually or together as 
a Batch file. 

Traces (or data) that are currently Visible in the Graphics area are saved, regardless of how they are 

Data (*.FDSW) Choose this file type to open a Data file. Only the data is 
loaded. The method that was used to collect the data is not 
loaded. The last used method or default method will be 
displayed.

Report (*.FRSW) Choose this file type to open a Report file. You can view the 
report in the Report area.

Graph Template 
(*.FGSW)

Choose this file to open a Graph Template file. The file will set 
up the layout of the Graphics area including any bitmaps as 
well as the range and style of the graph axes.

Batch (*.FBSW) Choose this file type to open a Batch file. A Batch file includes 
data, the method used to collect the data, report and graphics 
setup.

Spreadsheet Ascii 
(*.CSV)

This will open ASCII files that contain single comma 
delimited files with two or more columns.

ADL (*.ADL) This will open and run program files generated in the 
Applications Development Language (ADL).

All files (*.*) This enables you to view all files in the directory so that you 
can open any compatible file.

Tell me more about Filename Extensions

Overlay 
Data 

Select this check box to overlay individual data files in one graph box. If this is not 
checked the data from each file will appear in individual graph boxes. This option is 
only available if the Open dialog has been accessed by selecting Open… from the 
File menu. 

Hot Tip 
Use the SHIFT or CTRL key to select multiple data files.

Open This button opens the highlighted file/s or the files listed in the File name field.

See also: 
File menu 
ASCII Spreadsheet File

Note 
This dialog appears when you select either the Save method as.. or Save as… menu option from 
the File menu. When you select Save method as.. this dialog appears with 'Methods' displayed in 
the Files of type field. When you select Save as… this dialog appears with 'Batch' displayed in the 
Files of type field.
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displayed (full screen graph box or tile). For example, if six graph boxes are displayed in the Graphics 
area and each graph box has one visible trace then all six traces will be saved. 

If you do not wish to save particular traces, make them not Visible in the Trace Preferences dialog. To 
save only the focused trace, select the Save only focused trace check box. 

The dialog comprises the following: 

Look In The Look In field lists the available folders and files. Click the down arrow on the 
right of this field to view the location of the current folder in your computer's 
hierarchy. You can also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In 
field. 

Click to open the folder in the level that is one higher than the current folder, 
click on the toolbar.

Look in list 
box 

The Look In List Box, which is directly below the Look In field, displays the folders 
and files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted 
text entry field that appears and press Enter. Then double-click on the new 
folder to open it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the 
date the file was last modified.
Click to preview the selected trace before you load it into the application.

File Name Enter the name of the file you want to save in this field. 
You can also type the full path of a file then select the Save button to save the file.

Files of Type Click on the arrow on the right of this field to view a list of the different types of 
application files that can be opened in the list box. 
Methods 
(*.FMSW)

Choose this file type to only save the current method. Any 
collected data is not stored.

Data (*.FDSW) Choose this file type to only save the data currently Visible in 
the Trace Preferences dialog (for any graph box). Note that 
the method used to collect the data is not stored with the data.

Report (*.FRSW) Choose this file type to only save the contents currently shown 
in the Report area..

Graph Template 
(*.FGSW)

Choose this file type to save the layout of the Graphics area as 
a template. For example, any bitmaps you have added to your 
Graphics area will be saved as well as the range and style of 
the graph axes.

Batch (*.FBSW) Choose this file type to save the data that is currently Visible in 
the Trace Preferences dialog (for any graph box), the method 
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Filename extensions—Concentration 
The Cary Eclipse system uses the filename extension to distinguish between data types (e.g. method or 
report) and also to differentiate applications. (e.g. Concentration or Kinetics). 

The Syntax for file extensions is: 

used to collect the data and the currently displayed report all 
together as a Batch file. The graphics setup is also stored.

Spreadsheet Ascii 
(*.CSV)

Choose this file type to save the raw intensity data currently 
Visible in the Trace Preferences dialog (for any graph box) as 
a comma delimited ASCII Spreadsheet file (*.CSV) file. The 
data is saved as XY pairs delimited by a comma. 

Note 
This file type can be easily imported into a spreadsheet 
program. For example, Microsoft Excel. You can also 
double-click on the stored *.CSV file from Microsoft 
Explorer to load Excel automatically with the ASCII XY 
data displayed.

GRAMS (*.SPC) Choose this file type to only save the data currently Visible in 
the Trace Preferences dialog (for any graph box) as a Cary 
Eclipse GRAMS data file.

Tell me more about Filename Extensions

Save Click this button to save the file currently present in the File name field in the 
directory specified in the Look in field.

See also: 
File menu 
Trace Preferences dialog 
ASCII spreadsheet files

Letter Represents Available Options
First Type of analysis F Fluorescence

Second Type of file B Batch
D Data
G Graph Template
M Method
R Report

Third and fourth Application identifier AB Advanced Reads
CN Concentration
KN Kinetics
LT Lifetimes
RT Ratio
SR Simple Reads
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The following files may be opened and saved in the Concentration Application: 

SW Scan
TM Thermal
VO Validate

Note 
Selecting All Files in the Windows Open dialog will list all available file types. 

Extension Available action File type
*.FMCN Open/Save A method file (*.FMSW) consists of the software setup 

by which data is collected.
*.FDCN Open/Save A data file (*.FDSW) contains data collected that is 

currently visible in the Trace Preferences dialog (for 
any graph box).

*.FRCN Open/Save A report file (*.FRSW) contains the report generated 
by the Cary Eclipse about the data.

*.FGCN Open/Save A graph template file (*.FGSW) contains information 
that sets up the layout of the Graphics area including 
any bitmaps as well as the range and style of the graph 
axes.

*.FBCN Open/Save A batch file (*.FBSW) contains the collected data that 
was Visible in the Trace Preferences dialog (for any 
graph box), the method by which the data was collected 
and the report and graphics template.

*.CSV Open/Save An ASCII spreadsheet file (*.CSV) has the same 
extension for all applications. It consists of raw 
intensity data (that was currently Visible in the Trace 
Preferences dialog (for any graph box) saved as XY 
comma-delimited pairs. This file can be imported into a 
spreadsheet program such as Microsoft Excel.

Data.* Open A Cary DOS (Data.*) file is the equivalent of a Cary  
Windows Data file—it does not contain any Batch 
information.

*.ADL Open An ADL (*.ADL) file is a program file generated in the 
Applications Development Language (ADL).

*.SPC Open/Save A Cary GRAMS file (*.SPC ) is the equivalent of a 
Cary Eclipse Windows Data file—it does not contain 
any Batch information.

*.FADL Open An Eclipse ADL (*.FADL) file is a program file 
generated in the Applications Development Language 
(ADL) specifically for the Cary Eclipse. Eclipse ADL 
files will be associated with the relevant Eclipse 
application. When creating ADL files for the Cary 
Eclipse, it is recommended that you save them with the 
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ASCII Spreadsheet file (*.CSV)—Concentration 
An ASCII Spreadsheet file consists of raw intensity data saved as XY comma-delimited pairs. You can 
choose to import or export Cary Eclipse files to ASCII files, which can then be imported in spreadsheet 
programs such as Microsoft Excel. 

The format is as follows:  

Line 1 contains the sample name plus a comma
Line 2 contains X and Y labels. The name of the X label must be the same as that used to label the
graph. For example, in Kinetics, the graph label is Concentration (pM).
Lines 3 and onward contain the X,Y data
After the last line of X,Y pairs there must be a blank line separating the data from any text audit
strings or the end of the file.

For example, if a concentration file was collected as: 
pM = 0.0083, intensity = 0.1392 
pM = 0.01667, intensity = 0.1388 
pM = 0.02450, intensity = 0.1245 
etc. 

It would appear as follows in the ASCII file: 

Microsoft’s Excel generates a CSV file with the above format. 

There is also an alternative format for CSV files. For example,  

FADL extension. 

See also: 
Open 
Save As

  Concentration, 
  Concentration (pM); Intensity (a.u.) 
  0.0083, 0.1392, 
  0.01667, 0.1388, 
  0.02450, 0.1245, 

  Concentration, 
  etc. 

  Concentration 
  Concentration (pM); Intensity (a.u.) 
  0.0083, 0.1392 
  0.01667,0.1388 
  0.02450,0.1245 

  Concentration,  

Page 7 of 10File Management

   



Storage | Auto convert | Email | Status display 

Use the Auto store page to specify if and when data will be stored, and in what format. You can also 
use this page to set up the system to automatically send an email at the end of a read. 

From the Setup menu, select Auto store to access the Auto store page. You can also access the page 
from the Setup dialog by selecting the Auto store tab. To access the Setup dialog, select the Setup 
button from the Concentration Application window. 

The page comprises the following: 

Storage 

Auto convert 

Use the Auto convert options to convert your data into an ASCII file format that can be opened in 
spreadsheet programs such as Microsoft Excel. 

  etc. 

See also: 
Save As 
Open 
How to export collected data

Auto Store—Concentration 

Off Select this if you do not wish to be automatically prompted to save collected data. 
Note 
If you wish to store your unsaved data manually, choose Save Data As… from 
the File Menu to save your data after the run is complete. You can save your data 
as a Batch or Data file.

On; Prompt 
At Start 

Select this to display the Windows Save As dialog at the start of the collect where you 
can enter the Batch filename for your data.

On; Prompt 
At End 

Select this to display the Windows Save As dialog at the end of a collect where you 
can enter the Batch filename for your data.

None Select None if you do not need to generate an ASCII file.
ASCII (csv) Select this option to save the data as a comma delimited ASCII Spreadsheet file 

(*.CSV) file. Only the currently collected data is converted. 

ASCII files are stored in the same folder as the data file from which they were 
generated and designated the same filename as the method used to collect the data plus 
the extension ‘CSV’. 

ASCII (csv) 
with log 

Select this option to save the data as a comma delimited ASCII Spreadsheet file 
(*.CSV) file. Only the currently collected data is converted. The key method 
parameters used to collect the data are also saved in this file. 
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Email 

Select the Email check box and enter the Email details to send an email to a person once the read is 
completed. This useful facility can be used to alert you to the completion of the read, particularly if you 
are working away from the laboratory where the Cary Eclipse instrument is. You can also attach the 
collected data to the email. 

Status display 

Select this check box to display the Status Display window, where you can view the status of your 
instrument during the data collection. 

ASCII files are stored in the same folder as the data file from which they were 
generated and designated the same filename as the method used to collect the data plus 
the extension ‘CSV’. 

Note 
If you choose to auto-convert the data to an ASCII file but you have set the 
Storage option to Off, then the ASCII file will be saved with the following 
format: 
DATE TIME. CSV 

The date and time will appear in the same form that is set in the Windows 
Regional Settings Properties dialog that is accessed from the Windows Control 
Panel. 

For example, 22_4_97 1;32;08.CSV 

Tell me more about ASCII Spreadsheet Files 

Note 
You must set up the email Host and Port options on the Email options page of the System 
Information application in order for the email facility to work correctly.

To Enter the recipient's email address. You can enter more than one recipient in this field.
From Enter your email address (or the email address associated with the computer on which 

the Cary Eclipse software is installed.
Subject Enter the subject of your email (or leave this field blank if you do not wish to include a 

subject).
Cc Enter the email address of any recipient you want to copy the email to.
Message Enter your message.
Attached… Use the Attached button include a file attachment in your email. To do this, select 

Attached and browse your computer to select a file, using the Windows® Open dialog 
that appears.

Attach 
current data 

Select this option to attach the data that has been collected during the run to the email.

How to email your results 
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How to export collected data—Concentration 
If you want to export data from a Cary Eclipse application into a third-party application, then you 
simply need to save your data as an Spreadsheet ASCII (*.CSV) file or a Rich Text Format (*.RTF) file. 
Spreadsheet ASCII files are recommended if you are planning to use the data in a spreadsheet program 
such as Microsoft® Excel. Rich Text Format files are recommended if you are planning to open the data 
in a word processor program such as Microsoft® Word. 

To export collected data: 

Step 1  

From the File menu, select Save As. The Save As dialog is displayed. 

Step 2  

Click on the down arrow next to the Files of type list box and select the Spreadsheet ASCII (*.CSV) 
or Rich Text Format (*.RTF) option. 

Step 4  

Type the name of your new file in the File name field. 

Step 5  

Select Save to export your data to this new file.

See also: 
Save As   
Status Display 
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Software and Screen features—Concentration 
Status display
Menu line
Status line
Buttons
Function keys
Right mouse menu
How to remove or display the command buttons

Menu line—Concentration 
  File menu 
  Edit menu 
  View menu 
  Commands menu 
  Setup menu 
  Graph menu 
  Help menu  

Status line—Concentration 
The Status Line is displayed at the very bottom of the Concentration Application window. The line will 
display the following information (from left to right): 

The major commands in this application can be accessed both from the menu items at the top of the 
main window and from the application buttons. These buttons, which appear in the left side of the 
Concentration Application window, comprise the following: 

Hardware Status This field displays status messages indicating the current instrument activity.
Sequence Information This field displays status messages indicating the current system activity.
Current Results This field displays information on the last reading.

Buttons—Concentration 

Hot Tip 
If you wish to access these commands from the main menus, rather than from these buttons, you 
can remove the Command buttons from your application window. To do this, clear the Buttons 
command in the View menu. This will enlarge the Graphics area, making viewing and selection of 
scans easier. 

Button Enables you to…
Setup Click this button to display the Setup dialog where you can set up the collection, 

storage and analysis parameters for the concentration run. You can also set up any 
accessories that you may have and define the reporting options.

Zero Select this to zero the current ordinate value. 
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The function keys at the top of your keyboard perform basic Cary Eclipse operations simply and 
quickly. 

This command can also be accessed by pressing F5. 
Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Reread Click this to display the Standard/Sample Selection dialog where you select the 
solutions to be analyzed. This is useful when you would like to check samples that 
produced unusual results.

Pre-scan Select this to determine the optimum instrument parameters to be used for your 
sample. At the end of this collection sequence the software will report the optimum Ex 
and Em wavelengths and PMT voltage. Once you are satisfied with the parameters, the 
software will automatically update your method setup to reflect these new parameters.

Clear Report Select Clear Report to remove all of the text that appears in the Report area. If you 
have saved the report, you can view the information again. To do this, simply open the 
report file using the Open… command in the File menu.

Recalculate Use the pages accessible from the Recalculate option to perform re-calculations on 
data that has been analyzed.

Print Select Print to display the Windows Print dialog where you can choose what printer 
the report will be printed to. You can also select what pages to print as well as the 
number of copies you wish to print. 
This command can also be accessed by pressing CTRL+P. 

Note 
The options on the Reports page are used to generate the contents of the Report 
area during a run or on a recalculation. If Auto Print has been selected the Cary 
Eclipse will automatically print a report at the end of a data collection.

See also: 
Commands menu 
Setup dialog 
Standard/Sample Selection dialog  
Recalculate  
Reports page  
How to remove or display the Command buttons 

Function keys—Concentration 

Function 
key 

What it does

F1 This displays the Help for the current dialog or window.
F4 Press F4 to display the Go To Wavelength dialog.
F5 Press F5 to perform an instrument Zero. The current intensity value will be reset to zero and 

all subsequent results will have the value that was reset to zero subtracted from them. You 
can use the Zero command before selecting Start if you want your data to start at 0 
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Right mouse menu—Concentration 
The following commands are accessible by clicking the right mouse button on editable fields in the Cary 
Eclipse software. 

intensity. This command is also accessible from the Commands menu or by selecting the 
Zero button. 

Select the Clear Zero command from the Commands menu to remove zero correction. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

F6 Press F6 to display the Rapid Result dialog where you can read a blank and multiple 
sample readings without changing the application method. 
This command is also accessible from the Commands menu.

F9 If the application is online, press F9 to start a data collection. This is equivalent to selecting 
the Start button. If the application is not online, you will need to press F9 to first connect to 
the Cary Eclipse. Then press F9 to start the data collection. 
This command is also accessible from the Commands menu or by selecting the Start 
button. 

Note 
You will not be able to perform a Connect if another application is collecting data.

F12 Select this to stop the current measurement. This is equivalent to selecting the Stop button. 
This command is also accessible from the Commands menu or by selecting the Stop 
button.  

See also: 
Go To Wavelength 
Zero  
Rapid Result  
Start/Stop Instrument Buttons

Undo If available, this reverts to the previous value before the Edit on the field.
Cut If available, this cuts the highlighted text to the clipboard.
Copy If available, this copies the highlighted text to the clipboard.
Paste If available, this pastes the text from the clipboard to the cursor position.
Delete If available, this deletes the highlighted text/number.
Select All If available, this selects all entries.
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ADL—Concentration 
ADL Command Line
ADL Hooks
How to insert ADL commands

Introduction to ADL 

Use the ADL Command Line to run Single-line or Multi-line Applications Development Language 
(ADL) commands that enable you to perform functions over and above that of the existing program 
functionality. 

ADL is not a general purpose programming language. It has been developed specifically by Varian to 
meet the needs of spectroscopists. It can be used to handle all the data collected from the Cary Eclipse—
both photometric values and entire data collections. ADL programs that you develop should be stored 
with the extension 'ADL'. 

To access the ADL Command Line dialog, select the ADL Command item from the Commands 
menu. You can also press ALT+Y to open the dialog. 

Software controls 

ADL Command Line—Concentration 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help. 

Single Line Selecting this lets you enter ADL commands on a single line into the Command Line 
entry box. 

Q. Can I enter more than one ADL command on a single line?
A. Yes, provided that the commands are separated by a semicolon ‘;’.

Multi-line The Multi-line capability enlarges the Command Line entry box. Use the Multi-line 
capability to create a more complex ADL program by adding a series of commands 
over multiple lines. When Multi-line mode is selected, the Quick Reference option 
becomes available.

Quick 
Reference 

Select Quick Reference to open the Quick Reference dialog where you can easily add a 
command in the correct syntax to your ADL program. This option is only available for 
Multi-line commands. 

A detailed description of all the commands in the Quick Reference is available by 

Show me How to insert ADL commands using the Quick Reference.
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The ADL Hooks command is accessible from the View menu.  

Instead of writing a full ADL program you can use ADL hooks to link into an existing application. This 
is particularly useful if you want to make small changes to the way an application works, e.g. you want 
to pop up a dialog for the user to enter some specific data before the run starts. ADL hooks are links at 
specific points in an application at which you can run an ADL program. For example, ADL hooks have 
been supplied to run the following ADL programs:  

selecting the Help button on the Quick Reference dialog. 
Browse Select Browse to access the Open dialog where you can browse for and select an 

existing ADL program to load and run.
Command 
Line (entry 
box) 

This entry box enables you to use ADL commands. You can enter single ADL 
commands into this field, or you can enter a series of ADL commands. If you have the 
entry type set to Single Line, you can review previous ADL entries by selecting the 
down arrow to the right of the list box. 

The ADL commands in the Command Line are executed when you select OK. 

Note 
On entering this window, the Cary Eclipse will recall the last command or 
program executed from the Command Line entry box. The ADL commands 
entered in the last executed program are typically stored in the Varian\Cary 
Eclipse WinFLR\ADL directory on the drive on which the Cary Eclipse software 
is installed.
Hot Tip 
You can rerun the ADL commands in the Command Line entry box from any 
screen in the Concentration application by pressing ALT-X or selecting Re-run 
ADL from the Commands menu.

See also: 
ADL Hooks

ADL Hooks—Concentration 

Note 
Full documentation on ADL programming is available in the ADL Online Help.  
Click the button below to view this Help.      

Hook Description 

CN_Startup.ADL This is run when the Concentration application starts. For this to to 
work the application must be started from a batch or method file that 
has ADL Hooks on.

CN_PreSeq.ADL This runs when the Start button is selected.

CN_PostSeq.ADL This runs at the end of the Start button sequence.

CN_Online.ADL This runs when Cary Eclipse is detected online.
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CN_OffLine.ADL This runs when Cary Eclipse goes offline.

CN_Zero.ADL This runs when the Zero button is selected.

CN_Recalc.ADL This runs when the Recalculate button is selected.

CN_Shutdown.ADL This runs when the application is shutting down.

CN_PreRead.ADL This runs just before a read is taken.

CN_PostRead.ADL This runs just after a read is taken (It has the reading result stored 
in the UserResult variable.)

CN_PreSetup.ADL This runs when the Setup button is selected.

CN_PostSetup.ADL This runs when the OK button on the Setup dialog is selected.

CN_CellChange.ADL This runs instead of the Cary Eclipse driving the Multicell 
Holder. It enables you to add your own instructions for the Cary 
Eclipse Multicell Holder or to use your own cell changing 
accessory.

CN_UserStartReport.ADL This runs when the report is started It is used to replace the 
normal report headings with customized headings.

CN_UserReportParams.ADL This runs when the report parameters have been printed. It is used 
to add any extra user parameters to the parameter list.

CN_Userload.ADL This runs when a sample is to be loaded. It is used to replace the 
normal sample loading procedures with a customized procedure.

CN_UserReportResults.ADL This runs when results are to be reported. It is used to replace the 
normal report line for each sample with a customized one. This 
hook can be used if there is no difference in how standards and 
samples are reported. You can also use the ReportStandard and 
ReportSample hooks should be used.

CN_PreCalcStd.ADL This runs prior to the standard calculations. It is used for any pre-
treatment of the data prior to the normal calculations.

CN_ReportStandard.ADL This runs when a standard is to be reported. It is used to replace 
the normal report line for each standard with a customized one.

CN_ReportSample.ADL This runs when a sample is to be reported. It is used to replace 
the normal report line for each sample with a customized one.

CN_PreStdSeq.ADL This runs just before the standards are measured. It is used for 
preliminary procedures for the standards.

CN_StartStandardsReport.ADL This runs when the standards report is to be started. It is used to 
replace the normal report columns for the standards with 
customized columns.

CN_PostCal.ADL This runs after the calibration of a sample is requested. It is used 
to perform any extra post calibration operations.
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The following database nodes can be used to pass data between ADL and the Concentration application. 

CN_UserRecalc.ADL This runs when a recalculation is requested. It is used to do any 
pre-processing of data prior to a recalculation.

CN_PreSampSeq.ADL This runs just before the samples are run. It is used to perform 
any extra preliminary procedures for the samples.

CN_StartSamplesReport.ADL This runs just before the samples report is to be started. It is used 
to replace the normal report columns for the samples with 
customized columns.

CN_PostStdSeq.ADL This runs after the standards sequence has been completed and can 
be used for post processing of the standards.  The hook is called after 
the calibration has been completed and reported.

CN_PostStdSeq Runs after the samples sequence has been completed.  Runs after the 
report has been completed

CN_PostUserReportResults Runs after each solution has been reported

CN_PostReportStandard Runs after each standard has been reported

CN_PostReportSample Runs after each sample has been reported

Database Nodes Data Type Description 

'Current Solution 
Description'; 

String containing the solution name

'Current solution 
type';

Can have the following values: 

CNC_STANDARD = 0; 
CNC_SAMPLE = 1; 
CNC_BLANK = 2; 

'Current solution 
num';

Integer

'Current conc valid'; Boolean – used to determine if values are valid.

'Current mean valid'; Boolean – used to determine if values are valid.

'Current mean'; Real

'Current SD valid'; Boolean – used to determine if values are valid.

'Current SD'; Real

'Current RSD valid'; Boolean – used to determine if values are valid.

'Current RSD'; Real

'Current replicate 
num';

Integer
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How to insert ADL commands using the Quick Reference—
Concentration 
The Quick Reference window is accessed from the ADL Command window. It enables you to easily add 
a command in the correct syntax to your ADL program. To do this: 

Step 1 

Press Alt-Y to open the ADL Command Line window. 

Step 2 

Select the Multi-line option. The Command Line entry box will expand to take multiple lines of ADL 
commands and the Quick Reference check box is displayed. 

Step 3 

Select the Quick Reference check box. The Quick Reference window is displayed. 

Step 4 

If necessary, use the Go To field to jump to the appropriate part of the Quick Reference listing. 

Step 5 

Highlight the command you require in the Quick Reference list. 

Step 6 

Click the Insert in ADL button. The selected ADL command will appear in the Command Line entry 
box. 

Step 7 

Where necessary, alter the defaults supplied by the inserted Quick Reference command in the Command 
Line entry box to suit your program. 

Step 8 

Repeat steps 4–7 to add more commands as required. 

'Current duplicate 
num';

Integer

'Current replicates'; Comma delimited string containing the replicate readings.

See also: 
ADL Command Line
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Help and Safety information—Concentration 
Help menu
Safety home page

Help menu—Concentration 
Use the Help menu to view the online Help and software information for this application. 

Safety Home Page 
Click on the desired index entry to view the Help. 

About Safety
Lamp module
Ultraviolet radiation
Electrical hazards — Cary Eclipse
Panels, covers and modules
Other precautions
Warnings and cautions
Warning symbols
Color coding
Information symbols
FCC advisory
CE compliant products

Command What it does…
Concentration 
Help 

Select this to display the Concentration Home Page. This contains a list of online 
Help topics specific to the Concentration Application.

Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.
Tip of the day View useful tips about using your Cary Eclipse instrument and software.
Eclipse Tour Select this to display the Cary Eclipse Multimedia Online Help. This will give you an 

animated introduction to the Cary Eclipse software and hardware.
About… Select About to access a dialog that displays information about the application as 

well as Varian email and Internet contact information. 
To clear this About dialog, select OK.
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Concentration How To 
Select the procedure you require below for a step-by-step informative guide on running the application 
software. 

Standard Calibrations 

How to perform a calibration
How to delete a standard from the calibration
How to change the curve of best fit used in the calibration

Measuring Samples 

How to perform a calibration and manually measure concentrations
How to perform a calibration and measure concentrations with the Multicell Holder
How to measure concentrations manually

Other How To 

How to email your results
How to determine absorptivity
How to import sample labels, weights and volumes
How to export collected data
How to remove or display the command buttons
How to generate a report from previously calculated data
How to use advanced reporting options
How to insert ADL commands using the Quick Reference

How to perform a calibration—Concentration 
This demonstrates how to perform and store a fluorescence multi-standard calibration, without measuring any 
sample concentrations. 

Follow the steps through, adjusting them to meet the requirements of your particular data collection.  

Start the Concentration application
Set up data collection parameters
Set up instrument parameters
Set up the display options
Set up accessories
Set up the calibration
Set up your samples
Set up reporting and printing requirements
Set up storage of collected data
Set up visual system monitoring
Finish Setup
Zero the instrument
Perform the calibration

See also:
Concentration Home Page
Graphics How To
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Start the Concentration application 

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan 
Application is displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select Setup to display the Setup dialog and specify the method parameters for a new method. 

To do this: 

Set up instrument parameters  

Step 3 [Setup dialog | Cary page]  

a. In the Data mode field set the mode to Fluorescence.

b. In the Ex. Wavelength field, set the wavelength of the excitation monochromator, which is the
wavelength value at which you want to excite your sample.

c. In the Em. Wavelength field, set the wavelength of the emission monochromator, which is the
wavelength value at which your sample emits.

d. Set the slit width of the excitation monochromator.
Note that as a general rule, at a fixed emission slit width, increasing the excitation slit width will result in
an increase in the fluorescence excitation intensity.

e. Set the slit width of the emission monochromator.
Note that as a general rule, at a fixed excitation slit width, a two-fold increase in the emission slit width
will result in a four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the
emission slit width will result in a four-fold decrease in the emission intensity.

f. In the Ave Time field enter the required value. A good starting point is 0.1 sec.

Set up the display options  

Step 4 [Setup dialog | Options page]  

a. Select the Options tab. The Options page is displayed.

b. Enter the minimum and maximum Y values to be displayed on the graph axis during the data collection.

c. Set the Excitation filter for the concentration measurement. It is recommended that you set the filter to
Auto ( the default setting). This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

Note 
If you are running a GLP system, you may be prompted to enter a password before accessing the 
Concentration application.
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d. Set the Excitation filter and the Emission filter for the concentration measurement. In order to
minimize steps in the spectra, it is recommended that you set the filter to Open (the default setting).

e. Set the EHT or sample detector PMT. The setting you choose will depend upon your sample. For
example, a Low setting is recommended for highly emitting samples, while a High setting is
recommended for low emitting samples.

Set up accessories  

Step 5 [Setup dialog | Accessories page] 

Select the Accessories tab and en sure that no accessories are selected. 

Set up the calibration  

Step 6 [Setup dialog | Standards page]  

a. Select the Standards tab to access the Standards page where you can set up the standards and their
parameters associated with the data collection.

b. Set the appropriate Units for your standards for reporting purposes.

c. In the Standards field, enter the number of standards that you are using in your calibration. The table
below this field will expand or contract to match your choice.

d. In the Standards table, enter the concentration of each standard in the Conc column.

e. Select the type of curve fitting required for your calibration in the Fit Type group.

f. Enter the required R2 value or correlation coefficient in the Min R2 field. The closer the number is to
1.000 the better the fit. Typically, 0.95 is used.

Set up your samples  

Step 7 [Setup dialog | Samples page]  

As this is a calibration only, set the No. of Samples field to ‘0’. 

Set up reporting and printing requirements  

Step 9 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
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Select the Graph check box to include a calibration graph in the generated report.  

Set up storage of collected data  

Step 10 [Setup dialog | Auto Store page] 

a. Select the Auto Store tab to display the Auto Store page.

b. Set the Storage option to Off. The method (with calibration), collected data and report will not be
automatically saved. However, you can manually save it all at the end of the collection.

c. Select the Auto Convert option you require. If you select ASCII (csv) or ASCII (csv) with log, then at
the end of the data collection the system will automatically generate a report and store the data both in
the Cary Eclipse format as well as ASCII XY pairs format. The data file will be saved in the current
folder.

Set up visual system monitoring  

Step 11 [Setup dialog] 

Select the Status Display check box on any of the Setup pages to display various information fields on your 
current reaction. 

Finish Setup  

Step 12 

Once you are satisfied with your method setup select OK to confirm any changes you have made and clear the 
Setup dialog. 

Zero the instrument  

Step 13  

a. From the Concentration Application window, select the Zero button to zero the system. Alternatively,
select the Zero command from the Commands menu. The Zero dialog will be displayed.

b. Place a blank in the sample compartment and select OK.

Perform the calibration  

Step 14  

a. Select the Start button or select Start from the Commands menu. The Standard/Sample Selection
dialog will be displayed.

b. Select the standards and samples to be used in the analysis. By default, all standards are selected.

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as well 
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report area 
and can be viewed by selecting the Report command from the View menu.
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c. Select OK to clear the Standard/Sample Selection dialog.

d. The Present Standard dialog will be displayed to prompt you to place the appropriate standard in the
sample compartment. Press OK to measure the standard.

e. Repeat Step 14 d until you have measured all the standards. The Cary Eclipse will calculate the
calibration and the correlation coefficient.

Step 15  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this Concentration run.

c. Select Save and save the method with the calibration as a Method (*.FMCN) file.

How to perform a calibration and manually measure 
concentrations—Concentration 
This demonstrates how to perform a fluorescence multi-standard calibration and measure sample 
concentrations using no accessories. 

Follow the steps through, adjusting them to meet the requirements of your particular data collection.  

Start the Concentration application
Set up data collection parameters
Set up instrument parameters
Set up display options
Set up accessories
Set up the calibration
Set up your samples and increment names
Set up your samples for weight and volume correction
Set up reporting and printing requirements
Set up storage of collected data
Set up visual system monitoring
Finish Setup
Zero the instrument

Hot Tip 
If you accidentally included samples on the Samples page, highlight them and use the arrow keys to
move them to the Solutions Available list so they will not be read. 

Note 
If the set correlation coefficient (R2) value is not met, the Cary Eclipse will prompt you with ‘Min R2 test 
failed’.

See also:
How to change the curve of best fit used in the calibration
How to delete a standard from the calibration
How to import samples labels, weights and volumes
How to export collected data
How to generate a report from previously calculated data
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Perform the calibration
Measure sample concentration
Save your data

Start the Concentration application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan 
Application is displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select Setup to display the Setup dialog and specify the method parameters for a new method. 

To do this: 

Set up instrument parameters 

Step 3 [Setup dialog | Cary page]  

a. In the Data mode field set the mode to Fluorescence.

b. In the Ex. Wavelength field, set the wavelength of the excitation monochromator, which is the
wavelength value at which you want to excite your sample.

c. In the Em. Wavelength field, set the wavelength of the emission monochromator, which is the
wavelength value at which your sample emits.

d. Set the slit width of the excitation monochromator.
Note that as a general rule, at a fixed emission slit width, increasing the excitation slit width will result in
an increase in the fluorescence excitation intensity.

e. Set the slit width of the emission monochromator.
Note that as a general rule, at a fixed excitation slit width, a two-fold increase in the emission slit width
will result in a four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the
emission slit width will result in a four-fold decrease in the emission intensity.

f. In the Ave Time field enter the required value. A good starting point is 0.1 sec.

Set up the options  

Step 4 [Setup dialog | Options page]  

a. Select the Options tab. The Options page is displayed.

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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b. Enter the minimum and maximum Y values to be displayed on the graph axis during the data collection.

c. Set the Excitation filter for the concentration measurement. It is recommended that you set the filter to
Auto ( the default setting). This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

d. Set the Excitation filter and the Emission filter for the concentration measurement. In order to
minimize steps in the spectra, it is recommended that you set the filter to Open (the default setting).

e. Set the EHT or sample detector PMT. The setting you choose will depend upon your sample. For
example, a Low setting is recommended for highly emitting samples, while a High setting is
recommended for low emitting samples.

Set up accessories 

Step 5 [Setup dialog | Accessories page] 

Select the Accessories tab and ensure that no accessories are selected. 

Set up the calibration  

Step 6 [Setup dialog | Standards page]  

a. Select the Standards tab to access the Standards page where you can set up the standards and their
parameters associated with the data collection.

b. Set the appropriate Units for your standards for reporting purposes.

c. In the Standards field, enter the number of standards that you are using in your calibration. The table
below this field will expand or contract to match your choice.

d. In the Standards table, enter the concentration of each standard in the Conc column.

e. Select the type of curve fitting required for your calibration in the Fit Type group.

f. Enter the required R2 value or correlation coefficient in the Min R2 field. The closer the number is to
1.000 the better the fit. Typically, 0.95 is used.

Set up your samples and increment names  

Step 7 [Setup dialog | Samples page]  

a. Select the Samples tab to display the Samples page. This page enables you to enter a list of sample
names that will be used during your analysis.

b. Enter the number of samples that you are going to use in the No. of Samples field. The table below this
field will expand or contract to match your choice.

c. In the Sample names table enter the name of each sample. You can enter up to 20 characters for each
name.

d. If you would like the samples to have the same name with a different numeric extension, enter the name
in the first sample position and then select the Increment button.
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Set up weight and volume correction 

Step 8 [Setup dialog | Samples page]  

a. Select the Weight/Volume Corrections check box.

b. Enter the theoretical sample weight in the Method Weight field. This is the weight of the sample
specified in your method. (The Actual Weight is entered for each sample in the Sample Names list.)

c. Enter the units in the Weight Units field.

d. Enter the theoretical sample volume in the Method Volume field. This is the volume to which the
method tells you to make the sample. (The Actual Volume is entered for each sample in the Sample
Names list.)

e. Enter the units in the Volume Units field.

f. In the Sample Names table, enter the Actual Weight and Actual Volume for each sample.

Set up reporting and printing requirements  

Step 9 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

Set up storage of collected data  

Step 10 [Setup dialog | Auto Store page] 

a. Select the Auto Store tab to display the Auto Store page.

b. Set the Storage option to Off. The method (with calibration), collected data and report will not be
automatically saved. However, you can manually save it all at the end of the collection.

c. Select the Auto Convert option you require. If you select ASCII (csv) or ASCII (csv) with log, then at
the end of the data collection the system will automatically generate a report and store the data both in
the Cary Eclipse format as well as ASCII XY pairs format. The data file will be saved in the current

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as well 
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report area 
and can be viewed by selecting the Report command from the View menu.
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folder.  

Set up visual system monitoring  

Step 11 [Setup dialog] 

Select the Status Display check box on any of the Setup pages to display various information fields on your 
current reaction. 

Finish Setup  

Step 12 

Once you are satisfied with your method setup select OK to confirm any changes you have made and clear the 
Setup dialog. 

Zero the instrument  

Step 13  

a. From the Concentration Application window, select the Zero button to zero the system. Alternatively,
select the Zero command from the Commands menu. The Zero dialog will be displayed.

b. Place a blank in the sample compartment and select OK.

Perform the calibration  

Step 14  

a. Select the Start button or select Start from the Commands menu. The Standard/Sample Selection
dialog will be displayed.

b. Select the standards and samples to be used in the analysis. By default, all standards and samples are
selected.

c. Select OK to clear the Standard/Sample Selection dialog.

d. The Present Standard dialog will be displayed to prompt you to place the appropriate standard in the
sample compartment. Press OK to measure the standard.

e. Repeat Step 14 d until you have measured all the standards. The Cary Eclipse will calculate the
calibration and the correlation coefficient.

Measure sample concentration  

Step 15  

Note 
If the set correlation coefficient (R2) value is not met, the Cary Eclipse will prompt you with ‘Min R2 test 
failed’. When you select OK, the Cary Eclipse will then prompt you with ‘There is no valid calibration. 
Proceed in Intensity (a.u.)?’. If you select Cancel, the Concentration run will finish. If you select OK, the 
Cary Eclipse will measure the intensity of any presented samples, but will not generate a concentration.
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a. Once all the standards have been read, the Present Sample dialog will be displayed to prompt you to
place the appropriate sample in the sample compartment. Press OK to measure the sample and calculate
its concentration. (If replicates have been nominated, then the concentration is calculated after the final
sample replicate is read.)

b. Repeat Step 15 b for the remaining samples.

Save your data  

Step 16  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this Concentration run.

c. Select Save. The data will be stored as a Batch file.

How to perform a calibration and measure concentrations using the 
Multicell Holder—Concentration 
This demonstrates how to perform a fluorescence multi-standard calibration and measure sample 
concentrations using the Multicell Holder. 

Follow the steps through, adjusting them to meet the requirements of your particular data collection.  

Start the Concentration application
Set up data collection parameters
Set up instrument parameters
Set up display options
Set up Multicell Holder accessory
Set up the calibration
Set up your samples and increment names
Set up weight and volume correction
Set up reporting and printing requirements
Set up storage of collected data before run
Set up visual system monitoring
Finish Setup
Zero the instrument
Perform the calibration and measure samples
Save your data

Start the Concentration application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan 
Application is displayed. 

See also:
How to change the curve of best fit used in the calibration
How to delete a standard from the calibration
How to import samples labels, weights and volumes
How to perform a calibration and measure concentrations using the Multicell Holder accessory
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Set up data collection parameters  

Step 2 [Setup dialog] 

Select Setup to display the Setup dialog and specify the method parameters for a new method. 

To do this: 

Set up instrument parameters 

Step 3 [Setup dialog | Cary page]  

a. In the Data mode field set the mode to Fluorescence.

b. In the Ex. Wavelength field, set the wavelength of the excitation monochromator, which is the
wavelength value at which you want to excite your sample.

c. In the Em. Wavelength field, set the wavelength of the emission monochromator, which is the
wavelength value at which your sample emits.

d. Set the slit width of the excitation monochromator.
Note that as a general rule, at a fixed emission slit width, increasing the excitation slit width will result in
an increase in the fluorescence excitation intensity.

e. Set the slit width of the emission monochromator.
Note that as a general rule, at a fixed excitation slit width, a two-fold increase in the emission slit width
will result in a four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the
emission slit width will result in a four-fold decrease in the emission intensity.

f. In the Ave Time field enter the required value. A good starting point is 0.1 sec.

Set up the display options  

Step 4 [Setup dialog | Options page]  

a. Select the Options tab. The Options page is displayed.

b. Enter the minimum and maximum Y values to be displayed on the graph axis during the data collection.

c. Set the Excitation filter for the concentration measurement. It is recommended that you set the filter to
Auto ( the default setting). This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

d. Set the Excitation filter and the Emission filter for the concentration measurement. In order to
minimize steps in the spectra, it is recommended that you set the filter to Open (the default setting).

e. Set the EHT or sample detector PMT. The setting you choose will depend upon your sample. For
example, a Low setting is recommended for highly emitting samples, while a High setting is
recommended for low emitting samples.

Note 
If you are running a GLP system, you may be prompted to enter a password before accessing the 
Concentration application.
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Set up Multicell Holder accessory 

Step 5 [Setup dialog | Accessories page]  

a. Select the Accessories tab to display the Accessories page.

b. Select the Multicell Holder check box to enable the accessory.

c. Ensure that you have this accessory installed prior to commencing the run.

d. On the Cell Holder diagram select the cells you require.

e. Select the Multi Zero check box to enable the Multi Zero facility.

f. Make sure that no other accessories are selected on this page.

Set up the calibration  

Step 6 [Setup dialog | Standards page]  

a. Select the Standards tab to access the Standards page where you can set up the standards and their
parameters associated with the data collection.

b. Set the appropriate Units for your standards for reporting purposes.

c. Select Replicates or Std Averaging if required, and enter the appropriate number.

d. In the Standards field, enter the number of standards that you are using in your calibration. The table
below this field will expand or contract to match your choice.

e. In the Standards table, enter the concentration of each standard in the Conc column.

f. Select the type of curve fitting required for your calibration in the Fit Type group.

g. Enter the required R2 value or correlation coefficient in the Min R2 field. The closer the number is to
1.000 the better the fit. Typically, 0.95 is used.

Set up your samples and increment names  

Step 7 [Setup dialog | Samples page]  

a. Select the Samples tab to display the Samples page. This page enables you to enter a list of sample
names that will be used during your analysis.

b. Enter the number of samples that you are going to use in the No. of Samples field. The table below this
field will expand or contract to match your choice.

c. In the Sample names table enter the name of each sample. You can enter up to 20 characters for each
name.

d. If you would like the samples to have the same name with a different numeric extension, enter the name
in the first sample position and then select the Increment button.
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Set up weight and volume correction

Step 8 [Setup dialog | Samples page]  

a. Select the Weight/Volume Corrections check box.

b. Enter the theoretical sample weight in the Method Weight field. This is the weight of the sample
specified in your method. (The Actual Weight is entered for each sample in the Sample Names list.)

c. Enter the units in the Weight Units field.

d. Enter the theoretical sample volume in the Method Volume field. This is the volume to which the
method tells you to make the sample. (The Actual Volume is entered for each sample in the Sample
Names list.)

e. Enter the units in the Volume Units field.

f. In the Sample Names table, enter the Actual Weight and Actual Volume for each sample.

Set up reporting and printing requirements  

Step 9 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

Set up storage of collected data before run  

Step 10 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto Store page.

b. Set the Storage option to Off. The method (with calibration), collected data and report will not be
automatically saved. However, you can manually save it all at the end of the collection.

c. Select the Auto Convert option you require. If you select ASCII (csv) or ASCII (csv) with log, then at
the end of the data collection the system will automatically generate a report and store the data both in
the Cary Eclipse format as well as ASCII XY pairs format. The data file will be saved in the current

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as well 
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report area 
and can be viewed by selecting the Report command from the View menu.
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folder.  

Set up visual system monitoring  

Step 11 [Setup dialog] 

Select the Status Display check box on any of the Setup pages to display various information fields on your 
current reaction. 

Finish Setup  

Step 12 

Once you are satisfied with your method setup select OK to confirm any changes you have made and clear the 
Setup dialog. 

Zero the instrument  

Step 13  

a. From the Concentration Application window, select the Zero button to zero the system. Alternatively,
select the Zero command from the Commands menu. The Zero dialog will be displayed.

b. Place a blank in the sample compartment and select OK.

Perform the calibration and measure samples  

Step 14  

a. Select the Start button or select Start from the Commands menu. The Standard/Sample Selection
dialog will be displayed.

b. Select the standards and samples to be used in the analysis. By default, all standards and samples are
selected.

c. Select OK to clear the Standard/Sample Selection dialog.

d. The Cell Loading Guide dialog will be displayed. Load your standards as indicated, then select OK to
start reading the standards. If additional Cell Loading Guide dialogs are displayed, continue to load
your standards as indicated and select OK to continue loading the standards. Cary Eclipse will measure
the standards and calculate the calibration curve.

e. A Cell Loading Guide will be displayed for the samples. Load your samples as indicated and select
OK. The Cary Eclipse will then measure the samples and calculate their concentration.

Save your data  

Note 
If the set correlation coefficient (R2) value is not met, the Cary Eclipse will prompt you with ‘Min R2 test 
failed’. When you select OK, the Cary Eclipse will then prompt you with ‘There is no valid calibration. 
Proceed in Intensity (a.u.)?’. If you select Cancel, the Concentration run will finish. If you select OK, the 
Cary Eclipse will measure the intensity of any presented samples, but will not generate a concentration. 
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Step 15  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this Concentration run.

c. Select Save. The data will be stored as a Batch file.

How to measure concentrations manually—Concentration 
You can use the Concentration application without calibrating the system to measure samples in intensity 
mode. You can also use the duplicate/triplicate or replicate feature of the Concentration software to allow 
simple statistical calculations to be applied to your measurements. These measurements modes can be used in 
conjunction with the accessories. 

Start the Concentration application
Set up data collection parameters
Set up instrument parameters
Set up the options
Set up accessories
Set up the calibration
Set up your samples and increment names
Set up reporting and printing requirements
Set up storage of collected data
Set up visual system monitoring
Finish Setup
Zero the instrument
Measure sample intensity
Save your data

Start the Concentration application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan 
Application is displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select Setup to display the Setup dialog and specify the method parameters for a new method. 

To do this: 

See also:
How to change the curve of best fit used in the calibration
How to delete a standard from the calibration
How to import samples labels, weights and volumes

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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Set up instrument parameters 

Step 3 [Setup dialog | Cary page]  

a. In the Data mode field set the mode to Fluorescence.

b. In the Ex. Wavelength field, set the wavelength of the excitation monochromator, which is the
wavelength value at which you want to excite your sample.

c. In the Em. Wavelength field, set the wavelength of the emission monochromator, which is the
wavelength value at which your sample emits.

d. Set the slit width of the excitation monochromator.
Note that as a general rule, at a fixed emission slit width, increasing the excitation slit width will result in
an increase in the fluorescence excitation intensity.

e. Set the slit width of the emission monochromator.
Note that as a general rule, at a fixed excitation slit width, a two-fold increase in the emission slit width
will result in a four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the
emission slit width will result in a four-fold decrease in the emission intensity.

f. In the Ave Time field enter the required value. A good starting point is 0.1 sec.

Set up the options  

Step 4 [Setup dialog | Options page]  

a. Select the Options tab. The Options page is displayed.

b. Enter the minimum and maximum Y values to be displayed on the graph axis during the data collection.

c. Set the Excitation filter for the concentration measurement. It is recommended that you set the filter to
Auto ( the default setting). This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

d. Set the Excitation filter and the Emission filter for the concentration measurement. In order to
minimize steps in the spectra, it is recommended that you set the filter to Open (the default setting).

e. Set the EHT or sample detector PMT. The setting you choose will depend upon your sample. For
example, a Low setting is recommended for highly emitting samples, while a High setting is
recommended for low emitting samples.

Set up accessories 

Step 5 [Setup dialog | Accessories page] 

Select the Accessories tab and en sure that no accessories are selected. 

Set up the calibration  

Step 7 [Setup dialog | Standards tab]  

a. Select the Standards tab. The Standards page is displayed.
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b. Set the Standards field to '1', (It is not possible to set this field to '0'.

Set up your samples and increment names  

Step 7 [Setup dialog | Samples page]  

a. Select the Samples tab to display the Samples page. This page enables you to enter a list of sample
names that will be used during your analysis.

b. Enter the number of samples that you are going to use in the No. of Samples field. The table below this
field will expand or contract to match your choice.

c. In the Sample names table enter the name of each sample. You can enter up to 20 characters for each
name.

d. If you would like the samples to have the same name with a different numeric extension, enter the name
in the first sample position and then select the Increment button.

Set up storage of collected data  

Step 8 [Setup dialog | Auto Store page] 

a. Select the Auto Store tab to display the Auto Store page.

b. Set the Storage option to Off. The method (with calibration), collected data and report will not be
automatically saved. However, you can manually save it all at the end of the collection.

c. Select the Auto Convert option you require. If you select ASCII (csv) or ASCII (csv) with log, then at
the end of the data collection the system will automatically generate a report and store the data both in
the Cary Eclipse format as well as ASCII XY pairs format. The data file will be saved in the current
folder.

Set up reporting and printing requirements  

Step 9 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as well 
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report area 
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Set up visual system monitoring  

Step 10 [Setup dialog] 

Select the Status Display check box on any of the Setup pages to display various information fields on your 
current reaction. 

Finish Setup  

Step 11 

Once you are satisfied with your method setup select OK to confirm any changes you have made and clear the 
Setup dialog. 

Zero the instrument  

Step 12  

a. From the Concentration Application window, select the Zero button to zero the system. Alternatively,
select the Zero command from the Commands menu. The Zero dialog will be displayed.

b. Place a blank in the sample compartment and select OK.

Measure sample intensity  

Step 13  

a. Select the Start button or select Start from the Commands menu. The Standard/Sample Selection
dialog will appear.

b. In the Selected for Analysis list, highlight the standard and select  to transfer it to the Solutions 
Available list. The standard will not be included in the analysis.

c. Select the samples to be used in the analysis. By default, all samples are selected.

d. Select OK to clear the Standard/Sample Selection dialog. As no standards have been selected the
message ‘There is no valid calibration. Proceed in Intensity (a.u.)?’ will be displayed.

e. Select OK to continue.

f. The Present Sample dialog will be displayed to prompt you to place the appropriate sample in the
sample compartment.

and can be viewed by selecting the Report command from the View menu.

Note 
As a calibration is not to be performed it is recommended the display of the graphics area is turned off. To 
do this, clear the Graphics option in the View. At this stage you should consider saving the method from 
the File menu, Save method as, for future use.

Note 
If you are using an accessory, a dialog specific to that accessory will appear in place of the Present 
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g. Select OK to measure the sample and display the intensity. (If replicates have been nominated, then the
mean intensity is calculated after the final sample replicate is read.)

h. Repeat Steps 13 f and 13 g for the remaining samples.

Save your data  

Step 14  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this Concentration run.

c. Select Save. The data will be stored as a Batch file.

How to change the curve of best fit used in the calibration—
Concentration 

Open stored calibration and sample data
Change calibration curve type
Start recalculation

Once the standards have been measured and the calibration curve plotted on the screen, you may wish to 
change the type of curve used to fit the standard points.  

Open stored calibration and sample data  

Step 1 

From the File menu, select Open to display the Windows Open dialog.  

A list of previously stored batch files will appear. Select the batch file you require then select the Open button. 

The system will automatically retrieve the method and calibration that was used to measure the samples as well 
as the sample data. 

Change calibration curve type  

Step 2 

Select the Recalculate button to display the Recalculate dialog. This dialog contains the Standards and 
Reports pages which enable you to set up the recalculation parameters. 

Step 3 

Sample dialog.

See also:
How to import samples labels, weights and volumes
How to export collected data
How to generate a report from previously calculated data
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Select the Standards tab. The Standards page is displayed. 

Step 4 

Select the Fit Type algorithm by selecting the button that corresponds to the fit type you require. 

Start recalculation  

Step 5 

Select OK to perform the calibration using the selected Fit Type. 

The Cary Eclipse will create a calibration curve by fitting the selected fit curve to the data results. The 
calibration equation and correlation coefficient will also be sent to the Report area along with the recalculated 
sample results.  

How to delete a standard from the calibration—Concentration 
Open stored calibration and sample data
Change the calibration parameters
Start recalculation

Once the standards have been measured and the calibration curve plotted on the screen, you may wish to delete 
one or more of the standards from the calibration curve if they are obviously in error.  

Open stored calibration and sample data  

Step 1 

From the File menu, select Open to display the Windows Open dialog.  

A list of previously stored batch files will appear. Select the batch file you require then select the Open button. 

The system will automatically retrieve the method and calibration that was used to measure the samples as well 
as the sample data. 

Change the calibration parameters  

Step 2 

Select the Recalculate button to display the Recalculate dialog. This dialog contains the Standards and 
Reports pages which enable you to set up the recalculation parameters. 

Step 3 

Select the Standards tab. The Standards page is displayed.

 
See also: 
How to delete a standard from the calibration 
How to export collected data 
How to generate a report from previously calculated data 
How to remove or display the command buttons
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Step 4 

In the Use column of the Standards table, clear the standard/s you do not want to be read. To do this, double-
click on the relevant cell to toggle to No. (You can also highlight the cell and select any key on the keyboard). 
The standards that you require for the calibration should be set to Yes. 

Start recalculation  

Step 5 

Select OK to perform the calibration of the selected standards. 

The Cary Eclipse will create a calibration curve by fitting the selected fit curve to the data results. The 
calibration equation and correlation coefficient will also be sent to the Report area along with the recalculated 
sample results.  

How to determine the absorptivity of a sample—Concentration 
Step 1 

Using the Concentration application, prepare a calibration curve using the appropriate standards. 

Step 2 

Create a calibration curve using Linear Direct as the Fit Type. 

Step 3 

Now look at the calibration equation that is reported in the calibration report. e.g. Abs = 0.05692*Conc.
Using the Beer-Lambert law, which states that: 

A=εlc 

where: 
A = absorbance 
ε = absorptivity, cm-1M-1 
l = pathlength, cm
C = concentration of the solute, M

You can see that, in this example, 0.05692 = εl, or the slope of the calibration curve. 

 
See also: 
How to change the curve of best fit used in the calibration 
How to export collected data 
How to generate a report from previously calculated data 
How to remove or display the command buttons
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Knowing the pathlength of your cell, you can therefore calculate the absorptivity.  

For example: 
If cell pathlength (l) = 1 cm, then Absorptivity (ε) = 0.05692 cm-1M-1 

If cell pathlength (l) = 0.2 cm, then Absorptivity (ε) = 0.2846 cm-1M-1 

How to import sample labels, weights and volumes—Concentration 
If you want to import sample data into the Concentration application, then you simply need to enter your data 
in a *.txt file and then open this in the Concentration application. The data should be entered in the following 
manner: 

Each sample name in the imported file must be on a separate line, and any tabs in the file are ignored. If you 
want to include duplicates or triplicates, then they must be on a separate line immediately after the initial 
sample name and called ‘Dup’ and ‘trip’ (maintain the case as shown). Place the sample number immediately 
after the Dup or trip identifier.  

Weight correction and volume correction can be added immediately after the sample name in that order. (i.e. 
sample_name, weight_correction, volume_correction). If no entry is added for weight and volume, the Cary 
Eclipse will assign a value of '1'.  

An example file is given below. 

See also: 
How to perform a calibration  
How to perform a calibration and manually measure concentrations  
How to perform a calibration and measure concentrations using the Multicell Holder accessory

Sample_name1, 1.0001, 1.01, 
Dup1, 1.0002, 1.02, 
trip1,1.0003, 1.03, 
Sample_name2, 1.0004, 1.04, 
Dup2, 1.0005, 1.05, 
trip2,1.0006, 1.06, 
Sample_name3, 1.0007, 1.07, 
Dup3, 1.0008, 1.08, 
trip3,1.0009, 1.09, 
Sample_name4, 1.0010, 1.10, 
Dup4, 1.0011, 1.11, 
trip4,1.0012, 1.12, 
Sample_name5, 1.0013, 1.13, 
Dup5, 1.0014, 1.14, 
trip5,1.0015, 1.15,
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Step 1 

Enter your data into a text editor and save it as a text file. 

Step 2 

From the Concentration Application window, select the Setup button to display the Setup dialog. 

Step 3 

Select the Samples tab to display the Samples page. Set the Sample Averaging field to that the number of 
repeat samples specified in your in your sample file (the example above, would be 3).  

Step 5 

If you are using weight or volume corrections in your sample file, select Weight/volume corrections. 

Step 6 

Select the Import Names button. The Open dialog is displayed. 

Step 7 

Browse for you text file and select Open to open the file. The sample names will appear in the Sample Names 
table. 

How to email your results—Concentration 
You may wish to send an email to a person once the read is completed. This useful facility can be used to alert 
you to the completion of the read, particularly if you are working away from the laboratory where the Cary 
Eclipse instrument is. 

To do this: 

Step 1 

Ensure that you have set up the Host and Port options on the Email options page of the System Information 
application in order for the email facility to work correctly. 

Step 2 

From the Setup menu, select Auto Store. The Auto Store page is displayed. 

Step 3 

See also: 
How to export collected data 
How to generate a report from previously calculated data 
How to remove the command buttons from the application window
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Select the Email check box to enable the email options. 

Step 4 

In the To field, enter the recipient's email address (for example, rchandler@varianinc.com). To enter multiple 
recipients, simply type a comma ',' between each email address. 

Step 5 

In the From field, enter the email address of the computer on which the Cary Eclipse software is installed. This 
may be your email address, or a communal email address, if the Cary Eclipse software is installed on a 
computer that has multiple users. 

Step 6 

Enter information in the Subject and Message fields as required. 

Step 7 

Select Attach current data. The data that has been collected during the run will be attached to the email. 

Step 8 

Select OK to clear the Auto Store dialog. Your email will be sent once the run has been completed. 

How to generate a report from previously calculated data—
Concentration 
Step 1 

Select Open… from the File menu to display the Windows Open dialog. 

Step 2 

A list of previously stored files will appear. If this is not a list of batch files, select the down arrow at the right 
of the Files of type list box and select 'Batch' to list all the batch files. 

Step 3 

Select the Batch file you require then select Open. 

The system will automatically retrieve the collected data into the Graphics area. The method that was used to 
collect the data will also be retrieved. 

Hot Tip 
You can attach other documents to your email. To do this, select the Attached button and browse your 
computer to select a file, using the Windows® Open dialog that is displayed.

See also: 
Auto Store 
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Step 4 

Select the Recalculate button to display the Setup dialog. 

Step 5 

Select the Reports tab and on the Reports page specify the information you would like to include in the report. 
Select Auto Print if you require the new report to print to the Reports area and to a printer. 

Step 6 

Click OK to display the results in the Report area (and send to the printer if Auto Print is selected). 

How to use advanced reporting options—Concentration 
This outlines ways to fully customize your reports. Options available include:  

Including header and footer information
Including a logo
Editing the text in the report
Viewing the report on screen before printing
Cutting and pasting to a word processor

Including header and footer information 

You can have text appearing at the top and bottom of every page in your report. To specify what the text 
should be, do the following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then select 
System Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter the header and footer information in the Header and Footer fields.

Note 
You can also retrieve data from Methods (*.FMKN), Data (*.FDKN), Report (*.FRKN), Spreadsheet 
ASCII (*.CSV), GRAMS (*.SPC) and Rich Text Format (*.RTF) file types.

Note 
If you require a printout of only the current graphics in the Graphics area of a previously stored data file: 

a. Select the Clear Report option in the Commands menu to clear any text that may be displayed in
the Report area.

b. Press the Print button to obtain a printout of the graphics.

Alternatively tick only the Graph check box in the Reports page to obtain a printout of graphics only. 

See also: 
How to use advanced reporting options

Page 25 of 42Concentration How to

   



Step 3 

Click OK to implement your changes. 

Including a logo 

You can include a logo on the first page of your report. To specify what the logo should be, do the following: 

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then select 
System Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter a logo using the Add Logo button. This logo will always be included on the front page of reports. 

Step 3 

Click OK to implement your changes. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can then add, 
delete and change text in the Report area. 

Viewing the report on the screen before printing 

You can view a report before printing it. To do this, from the File menu select Print Preview. You can then 
ensure that the report format is correct before you print it. 

Cutting and pasting to a word processor 

To have complete control over how your report looks you may wish to copy it to a word processor program, 
such as Microsoft Word. To do this: 

Step 1 

Open a report. 

Step 2 

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application.

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The
Administrator of the system will have to change your privileges before you can edit reports.

Hot Tip 
Use the arrow keys at the bottom of the Print Preview screen to change pages.
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From the Edit menu, choose Edit Report. 

Step 3 

Click in the Report area and highlight the text you want to export to your word processor. 

Step 4 

Right-click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text into a 
document. 

How to export collected data—Concentration 
If you want to export data from a Cary Eclipse application into a third-party application, then you simply need 
to save your data as an Spreadsheet ASCII (*.CSV) file or a Rich Text Format (*.RTF) file. Spreadsheet ASCII 
files are recommended if you are planning to use the data in a spreadsheet program such as Microsoft® Excel. 
Rich Text Format files are recommended if you are planning to open the data in a word processor program 
such as Microsoft® Word. 

To export collected data: 

Step 1  

From the File menu, select Save As. The Save As dialog is displayed. 

Step 2  

Click on the down arrow next to the Files of type list box and select the Spreadsheet ASCII (*.CSV) or Rich 
Text Format (*.RTF) option. 

Step 4  

Type the name of your new file in the File name field. 

Step 5  

Select Save to export your data to this new file. 

How to remove or display the command buttons—Concentration 
The command buttons (Setup, Zero, Reread, Pre-scan, Clear Report, Recalculate and Print) appear on the 
left side of the Concentration Application window.

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to alter the look of your graphs 
How to display a trace that is not appearing
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To remove the command buttons 

Step 1 

From the Concentration Application window, select the View menu. 

Step 2 

Clear the Buttons menu item. 

The buttons will disappear from the application screen, giving you more room to display reports. 

To show the command buttons 

Step 1 

From the Concentration Application window, select the View menu. 

Step 2 

Select the Buttons menu item. 

The buttons will re-appear in the application screen. 

Graphics How to—Concentration 
Traces  

How to track the focused trace
How to select the focused trace
How to display a trace that is not appearing in a graph box
How to remove a trace from a graph
How to remove a trace from the trace List

Sizing and scale  

How to resize graph boxes
How to scale your graph manually
How to scale your graph automatically
How to alter the look of your graphs
How to zoom a graph

Labels  

How to add a label to a graph
How to edit a label
How to delete a label
How to move a label

Pictures  
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How to add a picture to a graph
How to move a picture
How to delete a picture
How to replace a picture

Concentration Home Page Index 

How to add a label to a graph—Concentration 
You can add a label to your graph or Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area background. 

Step 2 

Click the Add Label button on the toolbar or right-click on the graph and select Add Label from the menu. 
The Add Label dialog will appear. 
The Add Label command is also accessible from the Graph menu. 

Step 3 

Click the Font button. The Windows Font dialog appears. Select the font type, size and style you require for 
your label. A sample of the font style appears in the Sample field. When you are satisfied with your selections, 
select OK to return to the Add Label dialog. 

Step 4 

Enter the label in the Label field and select OK. The label will be displayed on the selected graph. If 
necessary, you can move a label so that it is more appropriately placed on your graph. 

How to edit a label—Concentration 
Step 1  

Place the cursor on the label and click the left mouse button to select the label. 

Step 2  

Note 
There must be at least one trace Visible in the graph box before you can add a label to it.

See also: 
How to move a label 
How to edit a label  
How to resize a label 

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label selection. 
Try zooming in and clicking in a different part of the label.
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Click the right mouse button and select Edit Annotation from the drop-down menu. Alternatively you can 
select the Edit Annotation command from the Graph menu. The Edit Label dialog is displayed. 

Step 3  

Use the Edit Label dialog to change the label. 

For example, if you want to change the font size of the label, select the Font button. In the Size field, scroll 
through the available sizes for the font and select the size you require. Alternatively, highlight the currently 
selected size in the Size entry field and enter the size you require. Click the OK button in this dialog to return 
to the Edit Label dialog. 

Step 4  

Click OK to clear the Edit Label dialog. Your label will appear with the new font size. 

How to move a label—Concentration 
To move a label so that it is more appropriately placed on your graph or Graphics area background, do the 
following: 

Step 1  

Place the cursor on the label. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the label to the correct position and release the mouse button. The label will be displayed at the new 
position. 

How to resize a label—Concentration 

See also: 
How to add a label to a graph 
How to move a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label  
How to resize a label 
How to delete a label
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To resize a label so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the label by clicking on it with the mouse. A border will be displayed around the label to indicate it is 
selected. 

Step 2  

Position the cursor over one of the corner edges of the label until the cursor becomes a diagonal double-headed 
arrow. Click and hold down the left mouse button. 

Example of label showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the label by dragging the mouse. The label text will also be resized. Release the 
mouse button when the label and text are the correct size. 

How to delete a label—Concentration 
To delete a label from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the label and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The label will be 
deleted from the graph or Graphics area. 

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label selection. 
Try zooming in and clicking in a different part of the label.
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How to add a picture to a graph—Concentration 
You can add a picture to your graph or the Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area background. 

Step 2 

Click the Add Picture button on the toolbar or right-click on the graph and select Add Picture from the menu. 
The Add Picture dialog will appear. 
The Add Picture command is also accessible from the Graph menu. 

Step 3 

Click the Load button. The Windows Open dialog appears. 

Step 4 

Browse through your directories to find the picture you want to insert. All pictures must be in the bitmap 
format and will have the extension .BMP. 

Step 5 

Highlight the .BMP that you want to insert and select Open. 

Step 6 

The Add Picture dialog will appear showing a preview of the bitmap. If the bitmap is the correct one select the 
OK button. The bitmap will be placed onto the graph. 

You can move a picture so that it is more appropriately placed on your graph. 

How to replace a picture—Concentration 

See also: 
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label

Note 
There must be at least one trace Visible in the graph box before you can add a picture to it.

Note 
You should take care not to add a bitmap that is too big as it will obscure part or all of your graph.

See also: 
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture
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To change a picture that you have added to a graph or Graphics area background do the following: 

Step 1  

Move the cursor to the picture and select the left mouse button to select it. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu or select Edit Annotation 
from the Graph menu. The Edit Picture dialog is displayed. 

Step 3  

From the Edit Picture dialog, select the Load button. The Windows Open dialog is displayed. 

Step 4  

Browse through your directories to find the picture to replace the current bitmap. Picture files must be in one of 
the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

Step 5  

Highlight the file that you want to insert and select Open to return to the Edit Picture dialog. 

Step 6  

The Edit Picture dialog will display a preview of the bitmap. If the bitmap is the correct one select the OK 
button. The bitmap will be placed onto the graph. If you need to, move the picture so that it is more 
appropriately placed on your graph. 

How to move a picture—Concentration 
To move a picture so that it is more appropriately placed on your graph or Graphics area background, do the 
following: 

Step 1  

Place the cursor on the picture. 

Step 2  

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Do not to add a bitmap that is too big as it will obscure part or all of your graph. 

See also: 
How to add a picture to a graph 
How to move a picture 
How to delete a picture  
How to resize a picture
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Click and hold down the left mouse button. 

Step 3  

Drag the picture to the correct position and release the mouse button. The picture will be displayed at the new 
position. 

How to resize a picture—Concentration 
To resize a picture so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the picture by clicking on it with the mouse. A border will be displayed around the picture to indicate it 
is selected. 

Step 2  

Position the cursor over one of the corner edges of the picture until the cursor becomes a diagonal double-
headed arrow. Click and hold down the left mouse button. 

Example of picture showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the picture by dragging the mouse. The picture will also be resized. Release the 
mouse button when the picture is the correct size. 

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph  
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How to delete a picture—Concentration 
To delete a picture from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the picture and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The picture will be 
deleted from the graph or Graphics area. 

How to select the focused trace—Concentration 
To select the scan that you want to be the focused (red) trace, do one the following:  

From the Graph, click the left mouse button on the trace that you want to make the focused trace.

From the Graph Legend (if displayed), click the left mouse button on the trace that you want to make the
focused trace.

From the Trace Preferences dialog, click in the Color column of the trace that you want to make the
focused trace.

How to display a trace that is not appearing in the graph box—
Concentration 
Step 1 

Click on the graph in the Graphics area. 

How to move a picture to a graph 
How to delete a picture 
How to replace a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to move a picture 
How to zoom a graph  
How to resize a picture

Note
Select the Show Legend check box in the Graph Preferences dialog to display the Graph Legend

See also:
How to track the focused trace
How to view a particular trace
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Step 2 

Select the Trace Preferences button  from the Graphics toolbar, or select Trace Preferences from the 
Graph menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you wish to see and select the Visible option. A tick will appear in the Visible column to 
indicate that it will now be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you want to display.
b. Click the right mouse button and select the Show Traces command from the drop-down menu. Ticks

will appear next to the selected traces to indicate that they will now be displayed.

Step 4 

Press OK to clear the Trace Preferences dialog. The selected trace(s) will be displayed. 

How to remove a trace from a graph—Concentration 
Step 1 

Select a graph in the Graphics area. 

Step 2 

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the Graph 
menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you no longer wish to see and select the Visible option. The tick will be removed from the 
Visible column to indicate that it will not be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you no longer want to display.
b. Click the right mouse button and select the Hide Traces command from the drop-down menu. The ticks

will be removed from the selected traces to indicate that they will not be displayed.

Step 4 

Select OK to clear the Trace Preferences dialog. The trace will be removed from the graph. 

See also: 
How to remove a trace from a graph 
How to remove a trace from the trace list

See also: 
How to display a trace that is not appearing in the graph box 
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How to remove a trace from the trace list—Concentration 
If your graphs contain unwanted traces, you may wish to delete them (rather than simply making them 
invisible) in order to free up application memory and aid system performance. 

Step 1  

Select a graph in the Graphics area. 

Step 2  

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the Graph 
menu. The Trace Preferences dialog is displayed. 

Step 3  

Select the trace to be removed by clicking on it. 

Step 4  

Click the right mouse button to display the Trace Preferences menu. 

Step 5  

Select Delete Traces to delete the sample from the trace list. You will be prompted to confirm this action. 

Step 6  

Select OK to clear the Trace Preferences dialog. The trace will be removed from all graphs. 

How to alter the look of your graphs—Concentration 
Step 1 

Click the Graph Preferences button  on the Graphics toolbar, or select Graph Preferences from the 
Graph menu. The Graph Preferences dialog is displayed. 

Step 2 

Use the available options available to choose your preferred appearance for the graphs. A preview box in the 
top right-hand corner will demonstrate how the graphs will appear. 

Step 3 

Select OK to clear the Graph Preferences dialog and update all graphs to reflect your selections. 

How to remove a trace from the trace list

See also: 
How to remove a trace from a graph 
How to display a trace that is not appearing in the graph box
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Step 4 

To re-use your graphics setup at a later date, save the setup as a graphics template. 

How to track the focused trace—Concentration 
To track the focused (red) trace in the graph: 

Step 1  

Click the Cursor Modes button  from the Graphics toolbar, or select Cursor Mode from the Graph menu. 
The Cursor Modes dialog will appear. 

Step 2  

Select Track and select the OK button. 

Step 3  

Place the blue tracking cursor in the graph box you require. 

Step 4  

Move the cursor left and right across the graph box to trace the focused (red) scan. The cursor coordinates 
change (in the X, Y field at the bottom left hand corner of the Graphics area) as you move along the curve. 

How to scale your graph manually—Concentration 
Step 1  

Note 
You can also add labels and pictures to your graphs to alter their appearance. 

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture 
How to resize graph boxes 
How to make a graphics template

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the required 
position. Press ALT  on the keyboard, then release the mouse button. 

See also: 
How to select the focused trace 
How to view a particular trace
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Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

Click the Axes Scales button  on the toolbar, or select Axes Scales from the Graph menu. The Axes 
Scales dialog id displayed. 

Step 3  

Type in the new ranges for the X and Y axes in the format ‘n-n’, or choose an option for each from the drop-
down list. 

Step 4  

Select OK. The axes on the selected graph will change to reflect your chosen settings. 

How to scale your graph automatically—Concentration 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

To autoscale the graph, select one of the following:  

Click the Autoscale XY button  on the toolbar to autoscale both X and Y axes. 

Click the Autoscale X button  on the toolbar to autoscale the X axis only. 

Click the Autoscale Y button  on the toolbar to autoscale the Y axis only. 

The focused trace will be scaled according to the option selected. 

How to make a graphics template—Concentration 

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale a graph automatically

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale your graph manually
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A graphics template lets you set up and store the style of a graphics report for future use. You can do this by 
adding labels and pictures to the background of the Graphics area and altering any axes styles etc. One 
advantage of this over the application's built-in reporting features is that you have more flexibility as to where 
you can position graph boxes and any text that you may want to appear (e.g. operator name, batch number etc.) 
and also where you add pictures, e.g. company logos etc.  

Step 1 

Start the application and open the data file from which you want to make a graphics template. Alternatively, 
collect some new data. 

Step 2 

Make as many graph boxes as you require in your template by using the Add Graph function. 

Step 3 

Adjust the graph boxes to the correct size and position them as you want them to appear in the template. 

Step 4 

Do any of the following, if required: 

Change the appearance of the graph boxes in the Graph Preferences dialog
Use the Add Label function to append text to the Graphics area
Use the Add Picture function to add pictures, such as your company's logo to the Graphics area

Step 5 

From the File menu, select Print Preview. Use the Print Preview dialog displayed to check the template that 
you have created. 

Step 6 

When you are satisfied with the appearance of the graphics, select the Save As… command from the File 
menu. The Save As dialog is displayed. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and select 
'Graph Template' to list all the template files. Ensure that the Save only focused trace check box is cleared. 

Step 8 

Enter a name for the template in the File name field. 

Step 9 

Select OK to save the graphic template. The template will be used each time you create a new file. 

Note 
You can also make a graphic template in a similar manner from existing data. No data will be saved in the 
template. 
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How to resize graph boxes—Concentration 
Step 1  

Click on the graph that you want to resize so that the highlight box appears around it. 

Step 2  

Move the cursor to the edge of the highlight box and place it over one of the square marks (e.g. ) in the box 
until it turns into a double headed arrow ( ). 

Step 3  

Click and hold the left mouse button and drag the box to the desired size. 

Step 4  

Release the left mouse button. 

How to zoom a graph—Concentration 
To zoom a graph, do the following: 

Step 1  

Click on the  button on the toolbar, or select Cursor Mode from the Graph menu. The Cursor Modes 
dialog will appear. 

Step 2  

Select Free and select the OK button. 

Step 3  

Click and hold down left mouse button in the highlighted graph box. 

Step 4  

Drag the mouse sideways and up or down. You will see a zoom box made up of a dotted line appear on the 
screen. (See picture below.) 

See also: 
Example of a Graphics Template 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture

See also: 
How to alter the look of your graphs
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The dotted line is a zoom box. 

Step 5  

Release the left mouse button. The area defined by the zoom box will be redrawn to fill the entire graph box, 
and the scans within the box will be enlarged accordingly. The abscissa (X) and ordinate (Y) coordinates 
displayed below the graph will also be changed to reflect the positions of the corners of the zoom box. 

You can repeat this process if you need to zoom in even further. 

Hot Tip 
To move the box on the screen, hold down the left and right mouse buttons together. You can then 
position the box anywhere in the graph box. Releasing the right mouse button will still allow you to 
resize the zoom box.

Note 
The system may limit the extent to which you can Zoom. 

See also: 
How to scale your graph manually 
How to scale your graph automatically
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GLP Administration Home Page 

Introduction 

The GLP (Good Laboratory Practice) Administration application is used to protect the system from 
unauthorized use, enabling application-specific privileges to be turned on or off by the system 
administrator. 

The GLP Administration application controls the access privileges of user groups operating the Cary 
Eclipse. The method of control includes the access of workgroups (which can be groups of one user) to 
the Cary Eclipse software, including the ability to reset the instrument or modify reports and methods, 
and the establishment of passwords. If this application is operational, users will need to be registered, 
have a user name and a valid password before they can access the various privileges. 

At installation, select Custom and nominate GLP to install the GLP Administration application. Your 
system administrator will then need to set up the application to control the other Cary Eclipse 
applications. 

After installation, the system administrator must assign a user name, workgroup and password to every 
person that will be running a Cary Eclipse application. The system administrator must also set up the 
various options available for each workgroup for every nominated Cary Eclipse application.

To find out about… See the… Show me…
GLP Application GLP Application How to run GLP for the first time and set up

an Administrator password  
Administration features Users

Privileges
Groups
Applications

How to create a workgroup
How to remove or restore a workgroup's
access to the Cary Eclipse software
How to assign User Names and Passwords
How to modify User Names and Passwords
How to change the privileges of a group for
a Cary Eclipse application

Menu information View menu
GLP log

Help and safety 
information

Help menu
Safety Home Page

GLP Administration Application 

Note 
Selecting Typical (the default setting) at installation will not install the GLP Administration 
application and all applications will have unrestricted access. You can install only the GLP 
Administration application at any stage by using the Custom installation option.
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To access the GLP Administration Application, select the Windows Start button, point to Programs, 
Cary Eclipse and then select GLP Administration. 

Software controls 

The GLP Administration Application comprises the following tabbed pages:  

Users
Privileges
Groups
Applications

The System Information Application also contains the following menus:  

View
Help

This dialog requires the administrator to enter an administration name and password to start the GLP 
Administration application. 

Application Name 
The application into which you are logging is listed beside here. 

User Name 
Enter your Administrator user name to login to the GLP Administration application. The default 
password is 'Admin', and must be typed exactly as shown. 

Password 
Enter your current Administrator password. The default password is 'Admin', and must be typed exactly 
as shown. 

New Password 
Check this box to nominate a new password. You will be required to enter your new password. 

(Confirmation) 
Re-enter your new password to confirm its nomination. 

See also:
GLP Administration Home Page
GLP Administration How to

GLP Login—GLP Administration 

Note 
You are required to enter the correct password before you can designate a new password. If you 
forget the password, please send us an email at fluorescence@osi.varianinc.com and we will try to 
help you.

Note 
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GLP Log—GLP Administration 
This dialog lists all the changes made to GLP privileges since the application was installed. You cannot 
reset this list. 

Print 
Press this button to display the Windows Print Setup dialog which allows you to print the list. 

Menu line—GLP Administration 
View menu
Help menu

View menu—GLP Administration 
Use the View menu to display the following. 

Help menu—GLP Administration 
Use the Help menu to view the online Help and software information for this application. 

The Users page enables you to nominate or alter the identity and privileges of a Cary Eclipse instrument 
operator. 

The Users page is displayed when you open the GLP Administration Application. To access the GLP 

All password entries are case-sensitive, and you can include numerics and spaces. 

Command What it does…
Hints Select this option to toggle the Hints bubble text on and off. The bubble text appears 

when you place the arrow cursor over a field, button or text entry field for a short 
period.

Log Select Log to display a read-only information dialog that tracks the changes made to 
GLP Privileges. The log will display the current privilege status of each User and 
Group for each nominated Cary Eclipse application.

Command What it does…
GLP 
Administration  
Help 

Select this to display the GLP Administration Home Page. This contains a list of 
online Help topics specific to the GLP Administration Application.

Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.
About… Select About to access a dialog that displays information about the application as 

well as Varian email and Internet contact information.  
To clear this About dialog, select OK.

Users—GLP Administration 
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Administration Application, click the Windows Start button, point to Programs, Cary Eclipse and then 
select GLP Administration. 
Once you are in the application, you can access the Users page at any time by selecting the Users tab. 

The page comprises the following: 

Status table 

This table identifies the current people allowed to use the Cary Eclipse applications. You must select the 
appropriate user before making any changes. 

Software controls 

Use the Add User dialog to do the following:  

Add a new user
Assign a new user to a group
Nominate a new user password
Set the user privilege status

The Add User dialog is accessible from the Users page by selecting Add….

Note 
A  in the first column of the table indicates the currently nominated user. Any modifications you 
make to the User Name, Group Name or Suspended status will be made to this nominated user 
only. 

User Name  This field displays the names of all current operators or users. Use the Add or Modify 
buttons to add to or modify this list of users.

Group Name This field displays a workgroup to which each user is assigned. Use the Modify button 
to change the workgroup that a user belongs to.

Suspended This field displays the access rights of the user. The suspended status is either True or 
False. If a user has a Suspended status of True, then that user cannot run any Cary 
Eclipse applications. Use the Modify button to change the access rights of users.

Add… Select the Add button to display the Add User dialog where you can add a new user. 
Note 
You can only add one new user at a time.

Modify… Select the Modify button to display the Modify User dialog where you can modify the 
nominated group or password of an existing user.

Delete… Select Delete to remove the nominated user in the status table. You will be prompted to 
confirm your action.

Bypass GLP 
checks 

Select this box to turn off the GLP password protection, access and privilege status 
requirements for operation of all Cary Eclipse applications.

Add User—GLP Administration 

Page 4 of 15GLP Administration Home Page



The dialog comprises the following: 

Use the Modify User dialog to modify the following:  

The name of a current user
The group to which the user is assigned
The user password
The user privilege status

The dialog comprises the following: 

User Name Enter the name of the new user in this field. Note that you can have groups consisting 
of only one user. This enables you to set privileges for each individual user rather than 
groups of users.

Group Name Assign a user to a workgroup by selecting one of the following options: 

Existing 
Select Existing to add a new user to an existing workgroup. To do this, simply select 
the workgroup from the existing list. 

New 
Select New to create a new workgroup name. 

Same As User Name 
Select this option to add a new workgroup that will have the same name as the new 
user name. 

Note 
A new workgroup can also be added by selecting Add… from the Groups page.

Password Enter a password for the new user. The password may be up to 16 characters long. 
Q. Why does the Cary Eclipse gives me an error message when I select OK on
the Add User dialog?
A. You may not have entered and confirmed a password for the new user. You
must set a password for a new user or the Cary Eclipse will not accept the new
user details.

(Confirmation) You must re-enter the new password in this field to confirm your nomination.
Suspend Select Suspend to suspend the access rights of the nominated user. Once suspended, 

the user will be unable to run any Cary Eclipse application. To restore a user’s 
privileges, select Modify (Modify User) from the Users page and clear the Suspend 
check box.

Modify User—GLP Administration 

User Name This read-only field displays the name of the user whose details are to be modified.
Group Name You can assign the user to a new group simply by selecting a Group Name from the 

list.
Password If required, enter a new password for the user in this field.
(Confirmation) Re-enter the new password in this field to confirm it.
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Use the Privileges page to add or restrict a workgroup’s access to Cary Eclipse applications. 

The Privileges page is accessible from the GLP Administration Application by selecting the Privileges 
tab. To access the GLP Administration Application, click the Windows Start button, point to 
Programs, Cary Eclipse and then select GLP Administration. 
The page comprises the following: 

Status table 

This table identifies the current groups nominated to use each Cary Eclipse application. Select the 
appropriate group to make changes to their privileges. 

Privilege check boxes 

Select these check boxes to nominate the privilege level for each selected group and application. The 
available check boxes will vary depending upon the application. Select the application you are interested 
in to view its privileges. 

ADL Shell 

Advanced Reads 

Align 

Concentration 

Kinetics 

Lifetimes 

Suspend Select Suspend to suspend access to Cary Eclipse applications, or clear the check box 
to restore access.

Privileges—GLP Administration 

Note 
A  in the first column of the table indicates the currently nominated Group Name. Any 
modifications you make to the User Name or Application Name status will be made to this 
nominated user only.   

Note 
The GLP Administration application automatically identifies the software applications that have 
been installed.

Group Name The Group Name field displays a list of the current workgroups. Group names are 
repeated when more than one application is available to a group.

App Name This field identifies the applications that are available to members of that workgroup.
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Scan 

Simple Reads 

Validate 

Commands 

Use the Add Privileges dialog to add your privileges to an additional application. 

The dialog comprises the following: 

Use the Groups page to nominate or alter the identity and privileges of a workgroup. 

The Groups page is accessible from the GLP Administration Application by selecting the Groups tab. 
To access the GLP Administration Application, click the Windows Start button, point to Programs, 
Cary Eclipse and then select GLP Administration. 

The page comprises the following: 

Cancel Changes 
(Esc) 

Click Cancel Changes to cancel any modifications you have made to the privilege 
nominations or a group.

Apply Changes 
Now 

Click this button to apply any changes to the privilege nominations or a group.

Add… selecting Add to display the Add Privilege dialog where you can add software 
privileges to a nominated group.

Delete… Click Delete to delete the privileges of the nominated group for the selected 
application in the Status table.

Bypass GLP 
Checks 

Select Bypass GLP Checks to turn off the GLP password protection, access and 
privilege status requirements for operation of all Cary Eclipse applications.

See also: 
Add Privileges

Add Privilege—GLP Administration 

Note 
Each application has to be individually assigned to each group.

Group Name Select the required group. If the group you want does not already exist, clear this dialog 
and add a new User to the Users page or add a new Group to the Groups page.

Application 
Name 

Select the Cary Eclipse application and select OK to assign the application to the 
selected group.

Groups—GLP Administration 

Note 
A  in the first column of the table indicates the currently nominated Group Name. Any 
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Status table 

This table identifies the current groups and their access rights. You can select the appropriate group 
before making any changes to their privileges. 

Commands 

Use the Add User dialog to do the following:  

Add a new group
Change the group's privilege status

The Add Group dialog is accessible from the Groups page by selecting Add…. 

The dialog comprises the following: 

modifications you make to the Group Name or Suspended status will be made to this nominated 
user only. 

Group Name This field identifies all currently defined workgroups.
Suspended This field identifies the access rights for each group. The suspended status is either 

True or False. If a group has a Suspended status of True, then that group cannot run any 
Cary Eclipse applications.

Add… Click Add to display the Add Group dialog where you can add a new group.
Modify… Click Modify to display the Modify Group dialog where you can alter the access rights 

of the selected group.
Delete… This button deletes the group highlighted in the status table. 

Note 
To avoid deleting a required group, you must first delete all Users from that 
group (on the Users tab), before deleting it.

Bypass GLP 
Checks 

Select Bypass GLP Checks to turn off the GLP password protection, access and 
privilege status requirements for operating all Cary Eclipse applications.

See also: 
Add Group 
Modify Group 
Users page

Add Group—GLP Administration 

Group Name Enter the name of the new workgroup.
Suspend Select Suspend to suspend the access rights of the nominated group. Once suspended, 

any users in the group  will be unable to run any Cary Eclipse application. To restore a 
group’s privileges, select Modify (Modify Group) from the Groups page and clear the 
Suspend check box.
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Use the Modify Group dialog to modify the nominated group’s privilege status. 

The dialog comprises the following: 

Use the Applications page to nominate or alter the list of Cary Eclipse applications under the control of 
the GLP Administration application. 

The Applications page is accessible from the GLP Administration Application by selecting the 
Applications tab. To access the GLP Administration Application, click the Windows Start button, point 
to Programs, Cary Eclipse and then select GLP Administration. 
The page comprises the following: 

Status table 

This table identifies the current applications nominated at administration level. Select the appropriate 
application before making any changes. The table contains the following: 

Commands 

Modify Group—GLP Administration 

Group Name This read-only field displays the name of the group whose details are to be modified.
Suspend Select Suspend to suspend access to Cary Eclipse applications, or clear the check box 

to restore access.

Applications—GLP Administration 

Note 
All Cary Eclipse applications are nominated for control by the GLP Administration application at 
the time of installation.

Note 
A  in the first column of the table indicates the currently nominated Group Name. Any 
modifications you make to the User Name or Application Name status will be made to this 
nominated user only.   

App Name This field identifies all available Cary Eclipse applications.

Add… Click Add to display the Add Application dialog where you can add a new application 
to GLP Administration.

Delete… Click Delete to remove the highlighted application from GLP Administration (after 
requesting confirmation). 

Note 
To avoid deleting a required application, you must first delete the application 
anywhere it appears in the Privileges table.

Bypass GLP Select Bypass GLP Checks to turn off the GLP password protection, access and 
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Use the Add Application dialog to control the addition of a Cary Eclipse Application to GLP 
Administration. 

The Add Application dialog is accessible from the Groups page by selecting Add…. 

The dialog comprises the following: 

GLP Administration How to 
Select the procedure you require below for a step-by-step informative guide on running the GLP 
Administration software:  

How to run GLP for the first time and set up an Administrator password
How to create a workgroup
How to remove or restore a workgroup's access to the Cary Eclipse software
How to assign User Names and Passwords
How to modify User Names and Passwords
How to change the privileges of a group for a Cary Eclipse application

GLP Administration Home Page Index 

How to run GLP for the first time and set up an Administrator 
password—GLP Administration 
A default password is provided for the GLP Administration Application. However, you should change 
this password to prevent unauthorized access to the application's settings. 

Step 1 

Checks privilege status requirements for operation of all Cary Eclipse applications.
See also: 
Privileges

Add Application—GLP Administration 

Application 
Name 

Insert the application name in this field. 

The Cary Eclipse application names that you can enter are:  

ADL Shell
Advanced Reads
Align
Concentration
Kinetics
Lifetimes
Scan
Simple Reads
System Information
Validate
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Click the Windows Start button, point to Programs, Cary Eclipse and then select GLP 
Administration. The GLP Administration Application and the GLP Login dialog are displayed. 

Step 2 

As this is the first time you have run GLP,  the User Name field will display the word 'Admin'. Enter 
Admin in the Password field.  

Step 3 

Select the New Password check box. A New Password and Confirmation field will be displayed to 
enable you to change the administrator access to GLP from the default settings. 

Step 4 

Enter a new password in the field next to the New Password check box. 

Step 5 

Confirm the new password in the (Confirmation) field. 

Step 6 

Select OK to change the administrator password for the GLP application and open the main window of 
the application. 

How to create a workgroup—GLP Administration 
Step 1 

From the GLP Administration Application, select the Groups tab. The Groups page is displayed. 

Step 2 

Select Add…. The Add Group dialog is displayed.

Note 
Ensure that you enter the password correctly, as it is case-sensitive.

Note 
If you forget Administrator password, please send us an email at fluorescence@osi.varianinc.com 
and we will try to help you. 

See also: 
How to create a workgroup 
How to remove or restore a workgroup's access to the Cary Eclipse software 
How to assign User Names and Passwords 
How to modify User Names and Passwords 
How to change the privileges of a group for a Cary Eclipse application
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Step 3 

Enter a new group name in the Group Name field. Select Suspend if you want to suspend the access 
privileges of the new group. 

Step 4 

Select OK to add the new group. 

How to remove or restore a workgroup's access to the Cary 
Eclipse software—GLP Administration 
Step 1 

From the GLP Administration Application, select the Groups tab. The Groups page is displayed. 

Step 2 

Highlight the required group in the table. A  in the first column of the table indicates the currently 
nominated group.  

Step 3 

Select Modify. The Modify Group dialog is displayed. 

Step 4 

Select the Suspend check box to suspend the access privileges of a group, or clear the check box to 
restore a group’s access. 

Step 5 

Select OK to implement the change you have made to the group's access. 

How to assign user names and passwords—GLP Administration 
Step 1 

From the GLP Administration Application window, select the Users tab. The Users page is displayed.

Note 
You should now assign the group's privileges. See How to change the privileges of a group for a 
Cary Eclipse application.

See also: 
How to create a workgroup 
How to assign User Names and Passwords 
How to modify User Names and Passwords 
How to change the privileges of a group for a Cary Eclipse application
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Step 2 

Select Add. The Add User dialog is displayed. 

Step 3 

In the User Name field, enter the new user name. 

Step 4 

From the Group Name field, select the group that the name will be assigned to by doing one of the 
following:  

a. Select Existing to add User Name to an existing group. You then need to highlight one of the
existing group names in the list box.

b. Select New to create a new group. You then need to enter the name of the group in the field.

c. Select Same As User Name to create a new group. In this case, the group will have the same
name as the entered User Name.

Step 5 

Enter the password for the new  user in the Password field. 

Step 6 

Confirm the new password in the (Confirmation) field. 

Step 7 

Select Suspend if you want to suspend the access privileges of the new user. 

Step 8 

Select OK. The new user will be added to the system.  

How to modify user names and passwords—GLP Administration
Step 1 

Note
A new group can also be added by selecting the Groups tab and selecting Add from the Groups
page.

Note 
If the user has been added to a new group, you should now assign the group's privileges. To do 
this, refer to How to change the privileges of a group for a Cary Eclipse application.
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From the GLP Administration Application, select the Users tab. The Users page is displayed.

Step 2 

Highlight the required user information in the table. A  in the first column of the table indicates the 
currently nominated user.  

Step 3 

Select Modify. The Modify Group dialog is displayed. 

Step 4 

You can do one or more of the following:  

To change the user's group, select a new group in the Group Name list box.
To change the user's password, enter a new password (and confirmation) in the Password and
(Confirmation) fields.
To modify a user's access privileges, select or clear the Suspend check box.

Step 5 

Select OK to implement the changes you have made to the user's access. 

How to change the privileges of a group for a Cary Eclipse 
application—GLP Administration 
Step 1 

From the GLP Administration Application, select the Privileges tab. The Privileges page is displayed. 

Step 2 

Select Add. The Add Group dialog is displayed. 

Step 3 

Highlight a nominated group and application, and select OK to exit the Add Privilege dialog. 
Note that the applications are automatically loaded at installation. Select the Applications page to add or 
delete applications from GLP. 

See also: 
How to create a workgroup 
How to assign User Names and Passwords 
How to remove or restore a workgroup's access to the Cary Eclipse software 
How to change the privileges of a group for a Cary Eclipse application

Q. Why do I get a message when I try to add an application to a group?
A. You cannot add an application to a group that already has that application listed as a privilege.
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Step 4 

On the Privileges page, select the required check boxes to nominate the privilege level for the selected 
group and application. Privilege levels are assigned for running each application. 

Step 5 

Click Apply Changes Now to confirm the group’s privilege status or Cancel Changes to cancel 
privilege changes. Alternatively you can select the ESC key on your keyboard to cancel the changes. 

See also: 
How to create a workgroup 
How to remove or restore a workgroup's access to the Cary Eclipse software 
How to assign User Names and Passwords 
How to modify User Names and Passwords
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Kinetics Home Page 

Introduction 

Use the Kinetics application to measure the increase or decrease in emission intensity as a function of time. 
From this you can obtain an intensity versus time plot. The features of the application include:  

To… Use the… Show me…
Get ready to collect data Setup dialog

Perform data collections Commands menu How to perform a single-wavelength kinetics
run
How to perform a multi-wavelength,
temperature controlled kinetics run

View run progress and 
results

Status Display
Reports
Print Preview

How to generate a report from previously
collected data
How to use advanced reporting options

Display data graphically Graphics Area
Graph menu

Graphics How To

Perform calculations Analyze page How to perform post run calculations on stored
data  

To find out about… See the… Show me…
Kinetics Application Kinetics application

File management Open
Save As
Filename extensions
Auto Store

How to export collected data
How to email your results

Screen features Buttons
Toolbar
Status Line
Menu Line

How to remove or display the command
buttons

Examples Example of a user collect
Example of a multi-stage kinetics run
Example of a multi-stage kinetics calculations
Example of a single-stage, multicell kinetics
run
Example using the stop time

ADL ADL Command
Line
ADL Hooks

Help and safety 
information

Help menu
Safety Home Page

Kinetics Application 
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Calculation of Zero order, First order and Second order reaction rates from intensity versus time data.
Selectable time window for calculation.
Overlay of the best-fit line on raw data.
Automatic or manual estimates for the first order and second order Marquardt fitting.

To access the Kinetics Application, click the Windows Start button, point to Programs, Cary Eclipse and 
then select Kinetics. 

Software controls 

The application comprises the following: 

Hot Tip:
The Kinetics application enables you to determine whether a single wavelength is changing over time. If
you wish to collect scans as a function of time in order to determine whether the spectrum is changing,
use the Cycle mode option in the Scan application. The Cycle mode option is available from the
Options page of the Setup dialog.

Instrument 
Status 
Readings 

The Instrument Status Readings, which display the Y and X values of the graph axes are 
displayed in the top left and right corners of the Kinetics Application Window. 

Y value 
Displays the current Y value, usually intensity. This value is continually updated during a 
data collection. 

X value 
Displays the current X value, which is the current reading for the Time. On the Cary page of 
the Setup dialog, choose whether to display the time value in minutes or seconds. 

Start and Stop 
buttons 

The Start and Stop buttons at the top of the Kinetics Application window are used to start 
and stop instrument analyses. These buttons can also be accessed from the Commands 
menu. 

Tell me more about the Start and Stop buttons 
Graphics area The Graphics area refers to the plotting area of the application. It can contain traces of 

collected data, labels and pictures. In the Cary Eclipse system, the term 'graph' refers to the 
plotting area and is represented by a set of axes. The rectangular area defined by the axes is 
referred to as a graph box. 

To display or hide the Graphics area, select the Graphics command on the View menu. 
Double-clicking on the Graphics area enables you to toggle between half or full size display 
sizes. To manually size the Graphics area, place the mouse cursor over the border between 
the Graph and Report areas until the cursor changes to a double arrow ( ). Then hold down 
the mouse and drag it up or down to resize the areas.  

Tell me more about the Graphics area  
Report area Use the Kinetics Report area to view the current report. The report may include the results of 

your data collection, the method parameters used to collect the results and any graphics you 
have included. You can select the information to include in your report in the Reports tab of 
the Setup dialog. 
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Validation of your Cary Eclipse for the Kinetics application 
The following files are shipped with the Kinetics application to enable you to validate the software. The files 
are stored on your CD in a Validation subdirectory. 

To validate your software, you should Open each file in turn and select the Recalculate button. The results 
calculated by the Cary Eclipse should match those given in the validation files listed below. These results were 
determined by exporting the data to a spreadsheet program and performing the same calculation as that used in 
the Kinetics application.  

Kinetics validate_first order fit.FBKN

Kinetics validate_second order fit.FBKN

Kinetics validate_zero order fit.FBKN

Getting ready for a run—Kinetics 

To display or hide the Report area, select the Report command from the View menu. Double-
clicking on the Report area enables you to toggle between half or full size display sizes. To 
manually size the Report area, place the mouse cursor over the border between the Graph 
and Report areas until the cursor changes to a double arrow ( ). Then hold down the mouse 
and drag it up or down to resize the areas. 

You can copy the generated report onto the Windows clipboard. To do this, highlight the 
report (or a relevant section of it) and press CTRL+C. You can then paste the report into a 
word processor such as Microsoft® Word. 

Hot Tip 
You can edit the Kinetics Report by pressing CTRL+R or selecting the Edit Report 
command from the Edit menu.

Commands The Kinetics Application window contains the following commands, all of which can also be 
accessed from the various menus in the application. 

Click on the buttons to view information about them: 

Hot Tip 
By becoming familiar with these commands (Setup, Zero, Pre-scan, etc.), you can 
remove these buttons from the Kinetics window. This will enlarge the Report area and 
make it easier to view results. To do this, clear the Buttons item in the View menu. 

Menus The Kinetics Application contains the following menus: 
File, Edit, View, Commands, Setup, Graph, Help

See also: 
Status Display 
Status Line 
Keyboard function keys 
Kinetics home page
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Setup dialog
Setup menu
Cary page
User collect example
Bio-/Chemi-luminescence and Phosphorescence Options dialog
Gate Time for Bio-/Chemi-luminescence
Gate Time for Phosphorescence
How many flashes?
Options page
About smoothing
Accessories page
Multicell/Temperature accessory
Multicell Changer
Wellplate accessory
Display Options dialog
Wellplate Sample List
Go To Well dialog
Analyze page
Rate calculations
Reports page
Report toolbar
Clear Report
How to use the advanced reporting options
Auto Store page
How to email the results

Use the Setup dialog to set up your instrument and accessories for a Kinetics run. You can also use the dialog 
to set up the Analysis, Report and Storage parameters associated with the run. 

The Setup dialog comprises the following tabbed pages: 

Cary
Options
Accessories
Analyze
Reports
Auto Store

Use the Setup menu to access the parameters for setting up a Kinetics read. 

Setup—Kinetics 

To access the Setup dialog select the Setup button from the Kinetics Application window or the 
Setup command from the Setup menu. 

See also:
Kinetics Application

Setup menu—Kinetics 

Command What it does…
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Instrument Setup | Wavelength Setup | Collect Timing | Status Display 

Use the Cary page to set up the instrument parameters associated with the data collection. 

From the Setup menu, select Cary to access the Cary page. You can also access the page from the Setup 
dialog by selecting the Cary tab. To access the Setup dialog, select the Setup button from the Kinetics 
Application window. 

Instrument setup 

Setup Choose Setup to display the Setup dialog where you can set up your instrument for a 
Kinetics measurement. The Setup dialog can also be accessed from the Setup command 
button.

Cary Choose Cary to display the Cary page. You can use this page to set up the instrument 
parameters associated with the data collection.

Options Choose Options to display the Options page where you can set up your filters and set the 
detector voltage. You can also use this page to select the way the collected data is displayed 
in the Graphics area, and the type of smoothing applied (if any).

Accessories Choose Accessories to display the Accessories page. You can use this page to set up the 
accessory parameters associated with the data collection.

Analyze Choose Analyze to display the Analyze page where you can select from various 
mathematical equations and set the parameters used to generate the calculation of reaction 
rates.

Reports Choose Reports to display the Reports page. You can use this page to set up the report 
parameters associated with data collection.

Auto Store Choose Auto Store to display the Auto Store page where you can specify if and when data 
will be stored, and in what format.

See also: 
Setup  
Cary  
Options  
Accessories  
Analyze  
Reports  
Auto Store 

Cary—Kinetics 

Data mode Fluorescence 
Fluorescence refers to the emission of light from an excited single state. The fluorescence 
signal is measured when the lamp flashes. 

Bio-/Chemi-luminescence 
Bio-/Chemi-luminescence refers to bio- or chemi-luminescence, where the emission is 
generated via a chemical or biochemical reaction.  

Phosphorescence 
Phosphorescence refers to the emission of light from an excited triplet state. 
Phosphorescence is measured after the lamp has stopped flashing. 
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Wavelength setup 

Options Click Options to open the Options dialog where you can set parameters such as the Decay, 
Delay and Gate times for your sample. 

The Options button is only visible if you have selected Bio-/Chemi-luminescence or 
Phosphorescence as the Data mode. 

Multi 
wavelength 

Use Multiwavelength to monitor more than one wavelength in your reaction. If you select 
Multiwavelength, the following options will be available: 

Number of wavelengths 
Use the Up/Down arrows to enter the number of emission and excitation wavelengths you 
wish to monitor. You can monitor up to six at one time. The number of rows in the 
Multiwavelength table will be expanded to match the number of wavelengths selected. 

Multiwavelength table 
Use the Multiwavelength table to enter the excitation and emission wavelengths to be 
monitored for each wavelengths. The number of rows in the Multiwavelength table will 
correspond the number of wavelengths selected. If you have selected more than two 
wavelengths, use the arrows to the right of the table to access all of the wavelength rows. 

If you have selected Bio-/Chemi-luminescence as the Data mode, the Multiwavelength 
table will display the Em.wavelength only, as Ex. wavelengths are not applicable in this 
mode. 

Note 
The Multiwavelength option is not available if you have selected the Polarizer on 
the Accessories page. You can select the Multiwavelength option and then select the 
Polarizer on the Accessories page, however you will only be able to select Other as 
the Polarization Measurement Type.

Ex. 
Wavelength 
(nm) 

Set the wavelength of the excitation monochromator, which is the wavelength value at 
which you want to excite your sample. Click the arrow to the right of the field to quickly 
select the most recent wavelength entries. The Ex. wavelength option is not available if you 
have selected Multiwavelength setup. 

Alternatively, to set the excitation monochromator to zero order (white light), from the 
Commands menu, point to Zero Order and select Excitation. A tick next to this option 
indicates that it is selected. Clear this option to return to monochromator light and use the 
value set in the Ex. Wavelength field. 

The Ex. Wavelength option is not available if you have selected Bio-/Chemi-
luminescence as the Data mode.  

Em. 
Wavelength 
(nm) 

Set the wavelength of the emission monochromator, which is the wavelength value at which 
your sample emits. Click the arrow to the right of the field to quickly select the most recent 
wavelength entries. The Em. wavelength option is not available if you have selected 
Multiwavelength setup. 

Alternatively, to set the emission monochromator to zero order (white light), from the 
Commands menu, point to Zero Order and select Emission. A tick next to this option 
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Collect timing 

indicates that it is selected. Clear this option to return to monochromator light and use the 
value set in the Em. Wavelength field. 

User Collect Select User Collect to display the User Collect field. The Ex. Wavelength and Em. 
Wavelength fields will not be available. Note that this option is not available if you select 
Multiwavelength mode. 

Use the User Collect entry field to enter an ADL command which applies a mathematical 
expression to the intensity value collected. The most recent user collect entries will be saved 
in the drop down list to a maximum of 10. 

The Syntax for ADL commands is: 

Read (Ex. wavelength, Em. Wavelength) 

The User Collect option is not available under the following conditions: 

if you have selected Multiwavelength setup, or
if you have selected the Polarizer on the Accessories page

Note
You can select the User Collect option and then select the Polarizer on the
Accessories page, however you will only be able to select Other as the Polarization
Measurement Type.

Ex. Slit (nm) Set the slit width of the excitation monochromator. The Ex. Slit option is not available if 
you have selected Bio-/Chemi-luminescence as the Data mode. 

As a general rule: 
At a fixed emission slit width, increasing the excitation slit width will result in an increase 
in the fluorescence excitation intensity.  

Em. Slit (nm) Set the slit width of the emission monochromator. 

As a general rule: 
At a fixed excitation slit width, a two-fold increase in the emission slit width will result in a 
four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the 
emission slit width will result in a four-fold decrease in the emission intensity. 

Simple collect Select this option to set the Number of Stages to '1'. Use one stage if you require only one 
collection rate for the entire kinetics run. 

Advanced 
collect 

Check this option to enable the Number of Stages entry field and specify the collect time 
profile of a run, enabling you to vary the rate at which data is collected over the period of 
the run. Enter the times required in the fields in the Cycles table. 

Q. When do I choose an Advanced Collect?
A. The Advanced Collection option allows you to divide the length of the run into
different sections or ‘stages’. You can nominate a different data collection rate for
each stage. This means that you can collect lots of data points during the stage when
the reaction is happening quickly and then reduce the number of data points collected
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No. of stages 
Use this to set the number of time segments into which you wish to divide the total data 
collection time, each having a different data collection rate. The Cycles table will expand to 
fit the number you enter. 

when the intensity change is slower.

Q. Why isn't the Number of Stages entry field active?
A. You have selected Simple Collect. On selecting Advanced Collect, the field will
be activated.

X Mode This enables you to set the units of time for the abscissa (or X axis). 

Choose your desired abscissa mode by selecting one of the following buttons: 

Min 
Select this to time the run in minutes. 

Sec 
Select this to time the run in seconds. 

Ave time (s) Set the amount of time, in seconds, for which data is averaged. To do this, enter the amount 
in the Ave. time field, or use the up/down arrows to the fight of the field to increase or 
decrease the time. The averaged result is displayed in the report. 

When setting the Ave Time, consider the following:  

The longer the Ave Time, the longer the signal will be averaged
A longer Ave Time will result in more precise results as the averaging of the signal
reduces any contribution of background ‘noise’.

Averaging is calculated as follows: 

For fluorescence: 
the number of readings averaged are taken from consecutive flashes at 80 Hz where: 
number of consecutive flashes = averaging time/0.0125. 

For phosphorescence: 
the intensity readings are taken from different decays, where: 
number of decays = averaging time/gate time. 

For bio-/chemi-luminescence: 
a signal is collected every Gate Time, and (averaging time/gate time) signals are averaged 
at each data interval 

Cycles Table This table enables you to vary the data collection rates within the one kinetics run. This 
feature is particularly useful when analyzing slow reactions and multi-step reactions. 

Stage 
This column displays the stage number/s. 

Cycle 
Enter a number in this numeric field to set the rate at which the system will cycle the 
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Status Display 

Select this check box to display the Status Display window, where you can view the status of various 
parameters during the data collection. 

Example of a User Collect—Kinetics 
You can extend the functionality of your Cary Eclipse instrument by using the built-in Read command. This 
command enables you to change the instrument to a different wavelength and take a reading. You can combine 
this command with the mathematical operators: ‘+’, ‘–’, ‘*’ and ‘/’. This is illustrated in the example below. 

Read(340, 400)-Read(340, 450) 
This reads the intensity at Excitation monochromator = 340, Emission monochromator = 400 and subtracts the 
intensity read at Excitation monochromator = 340 and Emission monochromator = 450. This reading is 
performed at each data point. 

The User collect command can be selected on the Cary page of the Setup dialog. Enter the Read command in 
the User collect result field. 

Dialog controls | Example of the options

Use the Bio-/Chemi-luminescence/Phosphorescence Options dialog to set up the parameters associated with 
these two measurement modes. 

To access the Bio-/Chemi-luminescence/Phosphorescence dialog, select the Options button from the Cary 
page. 

specified cell setup. 

Stop 
Type a number in this numeric field to set the Stop Time to establish how long you require 
a kinetics analysis to continue.  

Note 
Stop Time overrides Cycle Time so make sure that the Stop Time is long enough to 
allow the measurement of all Cycles.

See also: 
Options  
Accessories 
Example of a User Collect 
Example using the Stop time 
Example of a multi-stage Kinetics run, without Dwell time 
Example of a multi-stage Kinetics run, using Dwell time 
Status Display 

See also: 
Cary

Bio-/Chemi-luminescence/Phosphorescence Options—
Kinetics 
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Dialog controls 

The Bio-/Chemi-luminescence/Phosphorescence Options dialog comprises the following options: 

Example of the Bio-/Chemi-luminescence/Phosphorescence Options 

Note 
The Options button is only visible on the Cary page if you have selected Bio-/Chemi-luminescence or 
Phosphorescence as the Data Mode.

Total decay 
time 

Enter, in seconds, the total decay time for your sample. The total decay time is the time that 
it takes for the phosphorescence signal to decay to dark levels (zero). The lamp will not flash 
again until the total decay time has elapsed. 
The range is 0.001–1800.000 s. 

Note 
This option is not available in Bio-/Chemi-luminescence mode.

No. of flashes Enter the number of lamp flashes required, which is how many times the lamp flashes 
consecutively before the delay time is counted. 

If you are measuring phosphorescence samples that have a relatively long decay time (that is, 
a number of seconds), you can setup the Cary Eclipse to pulse the lamp multiple times, as 
this will increase the intensity of the phosphorescent signal. For short lived phosphorescent 
samples, multiple flashes will not impact on the intensity of the signal, and therefore only 
one flash is required. 

How many flashes should I perform? 

Note 
This option is not available in Bio-/Chemi-luminescence mode.

Delay time Enter, in milliseconds, the delay time for your sample. The delay time is the time that elapses 
between the last flash and the beginning of data collection. The default value is 0.100 ms, 
which is the time it takes for the lamp intensity to decay to zero. Setting a delay time ensures 
that there is no lamp effects in the phosphorescence decay curve. 
The range is 0.000–5000.000 s. 

Note 
This option is not available in Bio-/Chemi-luminescence mode.

Gate time Enter, in milliseconds, the gate time for your sample. The gate time is the overall reading 
time of the emission signal. 
The range is from 10µs–10s 

Understanding Average Time and Gate Time for Phosphorescence scans   
Understanding Gate Time for Bio-/Chemi-luminescence scans  
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Understanding Gate Time for Bio-/Chemi-luminescence scans—
Kinetics 
Gate Time is set on Options page, which is accessible from the Cary page. 

The following diagram highlights the Gate Time setting. 

The Gate Time is set to 10 and the Intensity is equal to IT.

See also: 
Cary page

Page 11 of 124Kinetics Home Page

   



Understanding Average Time and Gate Time for Phosphorescence 
Scans—Kinetics 
For Phosphorescence scans, there is a relationship between Average Time (the time for which data is averaged) 
and Gate Time (the overall reading time of the emission signal).  

Averaging is calculated as follows: 

The data point at each wavelength will be the average of the signals from a number of gate time measurements 
that occur during this averaging time, that is: 
Averaging Time/Gate Time 

These signals are accumulated from successive decay curves so that the actual time taken to generate a point at 
a single wavelength will be approximately: 
(Averaging Time/Gate Time x Total Decay Time) 

In phosphorescence mode, the Averaging Time ranges from the Gate Time to a maximum of 1000 s. 

See also: 
Understanding Average Time and Gate Time for Phosphorescence scans  
Kinetics Application   
Cary page  
Options dialog 

Note: 
Gate Time is not used if you select Fluorescence as the Data Mode. 
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Average Time is set on the Cary page of the Setup dialog. Gate Time is set on Options page, which is 
accessible from the Cary page. 

The following diagrams highlight the relationship between Average Time and Gate Time. 

Example 1 

When the Average Time and Gate Time are set to the same value: 

where: 

Example 2 

When the Average Time is set to five times the Gate Time: 

Average Time/Gate Time 1

Intensity
1 (Area IA,
IB)

Total Decay Time 20 ms
Delay Time 10 ms
Cycle Time 1 sec
Stop Time 3 sec
Average Time 5 ms
Gate Time 5 ms

Average Time/Gate Time 5
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where: 

Intensity (Area I2) A1 + A2 + A3 + A4 + 
A5
__________________ 

5 

Total Decay Time 20 ms
Delay Time 10 ms
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How many flashes should I perform?—Kinetics 
The Number of Flashes option is set in the Bio-/Chemi-luminescence/Phosphorescence Options dialog. To 
access the dialog, select the Options button from the Cary page. 

If you are measuring phosphorescence samples that have a relatively long decay time (that is, a number of 
seconds), you can setup the Cary Eclipse to pulse the lamp multiple times, as this will increase the intensity of 
the phosphorescent signal (refer to Example 1, below). For short lived phosphorescent samples, multiple 
flashes will not impact on the intensity of the signal, and therefore only one flash is required (refer to Example 
2, below). 

Example 1 
The above example shows that the sample does not decay before the instrument lamp flashes again. Therefore 
setting multiple flashes will result in an increase in the intensity of the signal.

Cycle Time 1 sec
Stop Time 3 sec
Average Time 25 ms
Gate Time 5 ms

See also: 
Understanding Gate Time for Bio-/Chemi-luminescence scans  
Kinetics Application  
Cary page 
Options dialog 

Note 
The Options button is only visible on the Cary page if you have selected Bio-/Chemi-luminescence or 
Phosphorescence as the Data mode.
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Example 2 
The above example shows that the sample decays in less time than the time it takes the instrument to flash the 
lamp again. Therefore, setting more than 1 flash, in the No. of Flashes field will not increase the intensity of 
the signal. 

Display Options | Smoothing | Excitation Filter | Emission Filter | PMT Detector Voltage | Status Display 

Use the Options page to set up your filters and set the detector voltage. You can also use this page to select the 
way the collected data is displayed in the Graphics area, and the type of smoothing applied (if any). 

From the Setup menu, select Options to access the Options page. You can also access the page from the 
Setup dialog by selecting the Options tab. To access the Setup dialog, select the Setup button from the 
Kinetics Application window. 

See also:   
Bio-/Chemi-luminescence/Phosphorescence Options

Options—Kinetics 

Display 
Options 

Overlay traces 
Select this option to superimpose the collected data of each sample in the run in one graph 
box. If you select this option, a graph box is created at the start of the collect in the Graphics 
area and each sample’s data is overlaid in that box as the data is collected. Traces will always 
be overlaid in the same graph, regardless of what multicell/well accessory is used. 
Clear this option to display all of the traces in individual graphs. 

Y minimum/Y maximum 
Enter the minimum and maximum Y values to be displayed on the graph axis. The software 
will update the Y axes to reflect these settings during the kinetics run. 

Smoothing Select Smoothing to reduce the noise of your collected data. When you select this option, 
smoothing will be applied to the ratioed intensity signal using the algorithms defined below. 
You can select one of the three types of smoothing that can be performed during a run. Only 
the smoothed trace is displayed during data collection, however the ratioed unsmoothed data 
is also saved with the experiment. 

Type 
Savitzky-Golay 
This algorithm will take the number of Filter points, apply the Savitzky and Golay smoothing 
algorithm  and display the smoothed value at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_SG'. 
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Tell me more about Savitzky-Golay smoothing 

Boxcar average 
This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_Box'. 

Tell me more about Boxcar averaging 

Moving average 
This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_Mov'. 

Tell me more about Moving average 

Filter size 
Enter the Filter size, which determines the number of points that will be used in the 
smoothing procedures. The higher the filter size (and thus the number of points used), the 
greater the amount of smoothing that will be performed.  

Filter sizes must be odd values. For Boxcar and Moving averages, the range is 3–101. For 
Savitzky-Golay smoothing, the range is 5–101.  

Excitation 
filter 

Set the excitation filter for the Kinetics measurement. To do this, select the down arrow to 
the right of the field and select an option from the list. 

A range of filter settings are available: 

Auto 
If you select the Auto option, the filter wheel will be automatically moved to the appropriate 
position for the selected excitation wavelength. It is recommended that you set the filter to 
Auto (which is the default setting).  

Open 
If you select Open no filter is used. 

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 

250–395, 335–620, 550–1110, 695–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you can 
select your filter manually. Otherwise it is recommended that you set the filter to Auto. 

Emission filter Set the emission filter for the Kinetics measurement. To do this, select the down arrow to the 
right of the field and select an option from the list. 

A range of filter settings are available: 

Auto 
If you select the Auto option, the filter wheel will be automatically moved to the appropriate 
position for the selected emission wavelength. It is recommended that you set the filter to 
Auto (which is the default setting).  
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About Smoothing—Kinetics 
Savitzky-Golay | Boxcar average | Moving average 

Savitzky-Golay 

Savitzky-Golay smoothing is used to obtain good noise reduction with sharp peaks. The equation constants are 

Open 
If you select Open no filter is used. 

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 

250–395, 295–1110, 360–1110, 430–1110, 550–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you can 
select your filter manually. Otherwise it is recommended that you set the filter to Auto. 

3%T Attenuator 
Select 3%T Attenuator to decrease the fluorescence intensity and thus the amount of light 
going to the emission PMT. This setting is useful for highly fluorescent samples when you 
are using wide slits. 

PMT Detector 
Voltage 

Set the EHT or sample detector PMT. To do this, select one of the following: 

Low 
Sets the PMT Detector voltage to a pre-defined value of 400 v. Typically you would select 
this setting if you are reading highly emitting samples. 

Medium 
Sets the PMT Detector voltage to a pre-defined value of 600 v. Typically you would select 
this setting if you are reading moderately emitting samples. 

High 
Sets the PMT Detector voltage to a pre-defined value of 800 v. Typically you would select 
this setting if you are reading low emitting samples. 

Manual 
Enables you to enter any PMT voltage in the adjacent Volts field. 

Volts 
Enter the PMT voltage in the adjacent field. Note that this option is only available if you 
have selected Manual as the PMT Detector voltage. 

Tip 
Increasing or decreasing the PMT Detector Voltage by 10% will double or halve the 
fluorescence intensity observed.

Status Display Select this check box to display the Status Display window. This window allows you to 
view the status of various parameters during the data collection.

See also: 
Setup 
Status Display window
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specific to Filter Size. The constants for each filter size are published in the Savitzky-Golay paper (A. 
Savitzky, M.J.E. Golay, Anal. Chem., 36 (1964) 1627). The equation also requires that Filter Sizes entered 
must be odd values, between 5 and 101. 

Example 

Result 

The first smoothed data point will be: 
(x3, (Y1*a1+Y2*a2+Y3*a3+Y4*a4+y5*a5)/b), 

the next: 
(x4, (y2*a1+y3*a2+y4*a3+y5*a4+y6*a5)/b) …  
(xn-2, sum(yn-4*a1+yn-3*a2+yn-2*a3+yn-1*a4+yn*a5)/b), 

where a1..a5, b are constants defined by Savitzky and Golay. 

Each smoothed point is calculated using the previous and next data points. For this reason, calculations cannot 
be performed on the very first and very last data points in a data set. Hence, smoothed traces will lack the first 
and last X values of the original trace. 

Boxcar average 

Boxcar averaging can be used when the change in intensity is minimal. 

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size 5
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Example 

Result 

The first smoothed data point will be: 
(x3, sum(Y1:y5)/5), 

the next: 
(x8, sum(y6:y10)/5) … (xn-2, sum(yn-4:yn)/5). 

If there are not enough points at the end of the data set to complete the filter size, then these points will be 
ignored, hence, the gap at the end may be larger than the gap in the beginning. 

Moving average 

Example 

Result 

The first smoothed data point will be: 
(x3, sum(Y1:y5)/5), 

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size 5

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size 5
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the next: 
(x4, sum(y2:y6)/5) … (xn-2, sum(yn-4:yn)/5). 

Use the Accessories page to set up the accessory parameters associated with the data collection. 

From the Setup menu, select Accessories to access the Accessories page. You can also access the page from 
the Setup dialog by selecting the Accessories tab. To access the Setup dialog, select the Setup button from the 
Kinetics Application window. 

The Accessories page will vary, depending upon what accessory button you have selected from the following: 

Multicell/Temperature
Microplate reader

The Multicell and Temperature accessory page is displayed when you select the Multicell/Temperature tab 
on the Accessories page. 

The page comprises the following: 

Multicell Holder 

Select this option to use the Multicell Holder and cells with the Cary Eclipse. 

Accessories—Kinetics 

See also: 
Cary page

Multicell and Temperature accessories—Kinetics 

Note 
By selecting this accessory you will prohibit the use of some combinations of other accessories that are 
also controlled by the Accessory Controller Board.

Multi-zero If you select Multi-zero, a Multi-zero will be performed when the Zero button is selected in 
the Kinetics Application window. Because cuvettes can have different intensities, and 
samples vary, this field is used when you require all blank readings to consistently start at 
zero intensity. 

A reading will be taken at the set Averaging Time at the set Ex. and Em. wavelengths and at 
every selected cell position. These readings will be offset to zero and subsequent readings 
will have the corresponding offset value subtracted from each cell. 

Reset Select Reset to drive the Multicell Holder to cell position 1, which is its fully retracted or 
zero position.

Go to cell… Select Go to cell to open the Multicell Changer dialog. You can use this dialog to manually 
move the Multicell Holder accessory to a new cell. To do this, simply select the 
corresponding button of the cell you require in the Multi Cell Changer dialog. The Multicell 
Holder will move the selected cell to the measurement position in the sample compartment. 

The Multicell Changer dialog is ‘modeless’ which means that it can remain open even once 
you have cleared the Setup dialog. This enables you to use the Rapid Read command to 
perform a reading at the cell specified in the Cell Changer. 
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Temperature Control 

Select this option to use the Temperature Controller with the Cary Eclipse. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse will 
display the intensity reading corrected by the determined zero-offset amount for that cell. 

 
Note 
You can use this option to check the intensity of a cell or start a kinetics run at a 
particular cell.

 
Note 
The Temperature Control option does not control temperature accessories that are not listed in the 
Device field. For example, if you have selected the Temperature Control option and set the Device to 
None because you have a different temperature control accessory, the Cary Eclipse software will not 
control that accessory. However, it will monitor the temperature and prompt the software to start when the 
accessory reaches the temperature listed in the Temperature field.

Device Select the device that will be used to control the water temperature. 

The options available will depend upon whether or not you have selected the Multicell 
holder option. 

None 
Select this option if you are using a Temperature Control device not listed in this field (for 
example, a third party water bath). Note that the Cary Eclipse software will not control the 
accessory. The software will simply monitor the temperature and prompt the software to start 
when the accessory reaches the temperature listed in the Temperature field. 

PCB 150 Water Bath 
Select this option if you are using the PCB 150 water bath. 

Single cell peltier 
Select this option if you are using the Single cell peltier. 

Temperature controller 
Select this option if you are using the Temperature controller. 

If you have selected the Multicell holder, the 
following Device options will be available 
for selection: 

Temperature controller
PCB 150 water bath
None

If you have not selected the Multicell holder, 
the following Device options will be 
available for selection: 

Single cell peltier
PCB 150 Water bath
None

Temperature Set the temperature at which the reaction will be performed. The default value is 20.00° C. 

When you select OK to close the Setup dialog, all buttons in the Kinetics Application 
window will be disabled until the temperature recorded by the Monitor device is within ± 
0.5°C of the temperature range. 

If Zero or Start is selected, and the temperature is not within ± 0.5°C of the temperature 
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Temperature Display 

Select this option to view Temperature Display information in the Status Display window. 
The Temperature Display option is only available if you have selected the Temperature Control option. 

Status Display 

Select this check box to display the Status Display window. Use this window to view the status of various 
parameters during the data collection. 

Use the Multi Cell Changer dialog to manually move the Multicell Holder accessory to a new cell. To access 
the Multi Cell Changer dialog, select the Go to cell button from the Multicell/Temperature Accessories 
page. 

The dialog comprises the following: 

range, then the system will wait for the temperature to fall within the temperature range 
before continuing with the measurement. Whilst waiting for the temperature, there will be a 
display on the status line at the bottom of the Kinetics Application window giving the current 
temperature and the elapsed time waiting to reach the set temperature. 

Port Select from COM1, COM2, COM3 or COM4. 
This option is not available if you have selected None as the Device.

Monitor Select which device will be used to monitor the reaction temperature. Select from Block, 
Probe 1, Probe 2, Probe 3 or Probe 4. 
Note that the the options in this field may change depending on the Device selected.

Block/ 
PCB 150 

Select this option to view the temperature of the Block (if you have selected the Single Cell 
Peltier device) or the PCB 150 (if you have selected the PCB 150 Water Bath) in the Status 
Display window.

Probes Select one or more of these options to view the temperature of the Probes in the Status 
Display window.

See also: 
Accessories  
Multi Cell Changer 
Status Display

Multi Cell Changer—Kinetics 

Multicell 
changer 

To manually move the Multicell Holder accessory to a new cell, simply select the 
corresponding  button of the cell you require in the Multi Cell Changer dialog. The Multicell 
Holder will move the selected cell to the measurement position in the sample compartment. 

The Multi Cell Changer dialog is ‘modeless’ which means that it can remain open even once 
you have cleared the Setup dialog. This enables you to use the Rapid Read command to 
perform a reading at the cell specified in the Cell Changer. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse will 
display the intensity reading corrected by the determined zero-offset amount for that cell. 

Note 
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The Wellplate accessory page is displayed when you select the Wellplate tab on the Accessories page. 

The page comprises the following: 

Wellplate reader 

The Wellplate accessory page is displayed when you select the Wellplate tab on the Accessories page. 

The page comprises the following: 

Wellplate reader 

Select this option to use the wellplate reader with the Cary Eclipse. 

You can use this option to check the intensity of a cell or perform a scan at a particular 
cell.

See also: 
Multicell/Temperature Accessories  
Rapid Read

Wellplate accessory—Kinetics 

Q. Why is the wellplate reader option unavailable?
A. The multicell holder, temperature control and/or polarization accessory has been selected. As you
cannot place any of these accessories and the wellplate reader in the Cary Eclipse sample compartment at
the same time, you must clear other accessory selections before selecting the wellplate reader.

Plate format Select the type of wellplate to be used. The default options are 6 wells, 12 wells, 24 wells, 48 
wells, 96 wells, 192 wells or 384 wells. 
The graphical representation of the wellplate will change according to the number of wells 
chosen.

Auto-zero Select this option to perform an auto-zero when the Zero button is selected from the Kinetics 
Application window. A zero reading will be taken at the selected well position using the 
current method setup. To select the well position to be zeroed, use the Select Well option. 

These readings will be offset to zero and subsequent readings will have this single value 
subtracted from each well in the sequence. The reading is taken only once, stored, and 
subtracted from the ratioed intensity reading. 

Select well Choose Select well to open the Go To well dialog where you can select the well position to 
be zeroed. This option is only available if you have selected Auto-zero.

Well Displays the well position of the well selected for auto-zeroing. This field is not editable.
Display 
options 

Select this option to open the Display Options dialog where you can set up the display 
parameters associated with the wellplate reader.

Sample names Select Sample Names to open the wellplate Sample List dialog where you can enter or 
modify the sample names. Highlight one or more wells on the wellplate reader diagram to 
view and change their sample information.

Go to well Select this option to open the Go To Well dialog.
Well position Displays the well position that the mouse cursor is pointing to. This field is not editable.
Reset Select Reset to move the wellplate reader to the first well position defined by the read 

sequence.
Park Select Park to move the wellplate reader to the Park position. The wellplate reader accessory 
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Status Display 

Select this check box to display the Status Display window. This window allows you to view the status of 
various parameters during the data collection. 

Display Options—Kinetics 
Use the Display Options page to set up the display parameters associated with the Wellplate Reader. 

The Display Options page is accessible from the Wellplate Accessories page by selecting the Display 
Options button. 

The page comprises the following: 

Display 

is moved clear of the sample compartment to enable you to easily access all wells.
Wellplate 
reader 
diagram 

The wellplate reader diagram represents the number of wells present for the chosen wellplate 
configuration. 

The labels for the rows will be 1 .. 12 and for the columns A .. H (for a 96 wellplate). Similar 
labels will occur for different wellplates according. The sequence for numbering the read 
order will be from A1 to A12, B12 - B1, C1 - C12…etc for a 96 wellplate. A similar 
sequence will be for other plates. 

To select or clear a single well, simply click or right-click on it. 

To select or clear a block of wells, hold down the left mouse and drag around the block 
required. All wells within the area will be selected or cleared. 

See also: 
Accessories page  
Display Options dialog   
Go To Well dialog  
Wellplate Sample List dialog   
How to import sample names into the Wellplate sample list 
About the Wellplate Reader  
Status Display window

Individual 
graphs 

Select this option to display the collected data of each sample in individual graph boxes, 
rather than overlaid on each other in one box. 

At the start of a scan, a separate box is created for each sample. Similarly, the collected data 
for each sample is displayed in a separate graph box. 

Overlay all 
traces 

Select this option to superimpose the collected data of each sample in the run in one graph 
box. 

One box is created at the start of the collect in the Graphics area and each sample’s data is 
overlaid in that box as the data is collected. 

User defined Select this option if you wish to specify the exact number of traces to be included on one 
graph. 
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Wellplate Sample List—Kinetics 
Use the Wellplate Sample List dialog to enter or modify the sample names of each well in the wellplate 
reader. 

The Wellplate Sample List is accessible from the Wellplate Accessories page by selecting the Sample Names 
button. 

The page comprises the following: 

Number of traces per graph 
Enter the number of traces to be displayed per graph. 

Overlay rows Select Overlay rows to view overlaid graphs of the 
wells you have selected. Wells in the same row of the 
wellplate reader will be overlaid. If you had selected 
wells as shown in the adjacent diagram, a total of  
seven graphs would be displayed (as seven rows 
contain selected wells). The first graph would contain 
overlaid scans of well A1 and A6, the second graph 
would contain a scan of well B8, etc.

Overlay 
columns 

Select Overlay columns to view overlaid graphs of 
the wells you have selected. Wells in the same column 
of the wellplate reader will be overlaid. If you had 
selected wells as shown in the adjacent diagram, a 
total of 11 graphs would be displayed (as 11 rows 
contain selected wells). The first graph would contain 
overlaid scans of well A1 and D1, the second graph 
would contain a scan of well H2, etc.

See also: 
Wellplate Accessories 

No. of samples Displays the total number of samples that have been selected from the Wellplate Reader 
diagram on the Wellplate Accessories page. This field is not editable.

Sample table The sample table lists the Sample Names and Well numbers of the selected samples. 
Sample Name 
Samples are named numerically, depending upon where they are located on the Wellplate 
Reader diagram. The sequence for numbering the Sample Name order is to read from A1 to 
A12, B1 to B12, C1 to C12…etc for a 96 wellplate. Therefore, if the B2 cell is selected, its 
corresponding Sample Name will be Sample 14. 

To modify the name of a sample, highlight the sample name and type in a new name. You can 
enter up to 20 characters for each name. 

Well 
Displays the position of the well corresponding to the Sample Name. This field is not editable.

Import names Select Import Names to display the Open dialog which you can use to select a text file to 
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Go To Well—Kinetics 
You can use the Go To Well dialog to manually move the Wellplate Reader accessory to a new well. This 
enables you to check the intensity of a well or perform a read at a particular well. 

The Go To Well page is accessible from the Wellplate Accessories page by selecting the Select well or Go To 
Well button. 

The Go To Well dialog is ‘modeless’ which means that it can remain open even once you have cleared the 
Setup dialog. This enables you to use the Rapid Read command to perform a reading at the selected well. 

If you move to a new well after you have performed a Multi-zero, the Cary Eclipse will display the intensity 
reading corrected by the determined zero-offset amount for that well. 

The page comprises the following: 

import into the Sample Names column. 

How to import sample names into the Wellplate sample list 
Increment Select Increment to copy and increment the sample names in the Sample Name list. This will 

save you from entering each sample name individually when the names consist of a descriptor 
followed by a number. 

To use the increment option, highlight the name that you want to increment and select 
Increment. The Cary Eclipse will increment the names of all the files proceeding the first 
highlighted name. 

Example: 
In this example, Sample B1 is highlighted when the Increment button is selected. 

Sample Name Becomes
Samp A  Samp A

 Sample B Sample B1
Sample C Sample B2
Sample D Sample B3
Sample E Sample B4

See also: 
Wellplate Accessories page  
About the Wellplate Reader 

Wellplate 
reader 
diagram 

The Wellplate Reader diagram represents the number of wells present for the chosen 
Wellplate configuration. 

The labels for the rows will be 1 .. 12 and for the columns A .. H (for a 96 Wellplate). Similar 
labels will occur for different Wellplates according. The sequence for numbering the read 
order will be from A1– A12, B12– B1, C1– C12, etc for a 96 Wellplate. A similar sequence 
will be for other plates. 
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Analysis | Manual Guess | Status Display 

Use the Analyze page to select from various mathematical equations and set the parameters used to generate 
the calculation of reaction rates. 

From the Setup menu, select Analyze to access the Analyze page. You can also access the page from the 
Setup dialog by selecting the Analyze tab. To access the Setup dialog, select the Setup button from the 
Kinetics Application window. 

The page comprises the following: 

Analysis 

To move the Wellplate Reader accessory to a new well, simply click on the corresponding 
well on this diagram. The Wellplate Reader will move the selected well to the measurement 
position in the sample compartment. 

To select or clear a single well, simply click or right-click on it. 

To select or clear a block of wells, hold down the cursor and drag around the block required. 
All wells within the area will be selected or cleared. 

X, Y, Well Displays the Well Position that the mouse cursor is pointing to. This field is not editable.
Reset Select Reset to move the Wellplate Reader to the first well position, which is well A1.
Park Select Park to move the Wellplate Reader to the Park position. When the accessory is in the 

park position you have full access to the Wellplate Reader platform. This is useful for 
inserting or removing wellplates from the accessory. 

See also: 
Wellplate Accessories page  
About the Wellplate Reader 

Analyze—Kinetics 

Auto Calculate Select the Auto Calculate option to automatically perform a rate calculation on collected 
data at the end of each run. If you do not select this option, you can still set up the calculation 
options, however, you will need to perform the calculation manually at the end of the run.

Simple 
Calculate 

Select this option if you require only one rate calculation for the entire kinetics run. The 
Number of Stages option will be unavailable as only one stage will be calculated.

Advanced 
Calculate 

Check this option to specify the number of abscissa ranges. You can specify this in the 
Number of Stages field. Up to five stages can be chosen and individual calculations and 
reports will be generated for each.

Number of 
Stages 

Enter the number of sections in the data collection on which the Cary Eclipse will perform 
rate calculations. Up to five stages can be entered. The Time Ranges table will expand to fit 
the number entered. 

Note 
This option is only available if you select the Advanced Calculate option.

Factor Use the Factor field to enter a value that will be used to calculate enzyme activity. This 
factor will be multiplied by the rate calculation result.

Conc Enter the initial concentration of substrate before the reaction. This concentration is only 
required for second order reactions. Therefore, this option is only available when you have 
set one of the Stages to Second in the Order column of the Time Ranges table. 
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Q. I have selected Second Order but the Conc (mol/L) field is still grayed out—why?
A. You must select ‘Second’ in the Order column of the Time Ranges table and then
select the cursor elsewhere to activate this field.

Time Ranges 
Table 

Use the Time Ranges table to enter the calculation Start and Stop times (in minutes or 
seconds) for each stage. These will be used to set the abscissa range over which the rate 
calculation is performed. Up to five stages can be chosen. 

The table comprises the following: 

Stage 
This column lists the stage number/s. 

Start 
Use these fields to enter the starting point, in minutes, for a rate calculation analysis. 

Stop 
Use these fields to enter the end point, in minutes, for a rate calculation analysis. 

Order 
Click in this field to access a drop down list where you can select the order equation to be 
used for calculating reaction rates using intensity versus time data. The following options are 
available: 

Zero 
Select this to determine the reaction rate using a zero order equation. 

First 
Select this to determine the reaction rate using a first order equation. The rate is 
determined using the Marquardt non-linear regression analysis. 

Second 
Select this to determine the reaction rate using a second order equation. The rate 
is determined using the Marquardt non-linear regression analysis. 

Note 
This option is only available if you select the Advanced Calculate option.

Plot Select the way in which the plot will be displayed from the following options: 

Fit 
Select Fit to automatically overlay the calculated lines of best fit onto the plotted data. 

Example of Fit overlay 

[fit.gif]
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Manual Guess 

If you have selected a 'first order' or 'second order' Simple Calculate rate calculation you can use this group to 
manually enter the parameters: Intensity(0), Intensity(∞) and Rate (k). You will need to have a reasonable 
estimate of the values for these fit parameters, as they will be used as a first guess for the Marquardt non-linear 
regression analysis. 

For some non-linear reactions you will get a result faster if you put in an initial estimate in the manual guess 
field. 

Status Display 

Select this check box to display the Status Display window. This window allows you to view the status of 
various parameters during the data collection. 

Difference 
Select  this option to automatically generate a difference curve between the fitted curve and 
the collected decay curve. This difference curve will be a new continuum and will be 
displayed on a new graph. 

Note 
If you do not choose Manual Guess then the Cary Eclipse system will automatically calculate the values 
for Intensity(0), Intensity(∞) and Rate when you select OK to exit the Setup dialog.

Manual Guess Select this option to manually select the parameters with which to calculate a first order or 
second order reaction rate. 

The value of these parameters will be used as a first guess for the Marquardt non-linear 
regression analysis. 

Q. Why is the Use Manual Guess check box unavailable?
A. You can only perform a manual guess when Simple Calculate is selected in the
Analyze group, and First or Second is selected in the Order column of the Time
Ranges Table. Once you have made these selections and clicked the cursor elsewhere,
this check box will become activated. When you select Manual Guess, the other
options in the group will also be activated.

Intensity (0) Enter the estimated intensity at zero time for first and second order fits.
Intensity (∞) Enter the estimated intensity at infinite time for first or second order kinetics reaction. When 

Zero order calculations are performed, the value of this field is automatically set to zero by 
the Cary Eclipse system.

k Enter the rate estimate in this field.

 
See also: 
Setup  
Status Display  
Example of multi-stage kinetics calculations 
Rate calculations 
How to use the kinetics ruler

Rate Calculations—Kinetics 
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Reaction rates may be determined in the Kinetics application using zero order, first order or second order 
equations using intensity versus time data over defined time ranges.  

Alternatively you can manually determine the range over which to calculate the reaction rate by using the 
kinetics ruler. 

Zero Order 

When the Rate calculation of the Kinetics application is set to 'zero order', a linear equation is fitted to the data 
using a least-squares technique. The slope of the line of best fit is reported as the kinetics rate in the equation: 

ABS = kt + ABS0 

where: 

ABS = intensity at time t 
ABS0= intensity at time t = 0 
k = rate constant 
t = time 

The units typically used are intensity per minute. 

First order and Second order 

First order and Second order fits are performed using a Marquardt non-linear fit technique. The values of ABS0
and Rate are estimated using a technique outlined in 'Alternative Method of Analyzing First-Order Kinetic 
Data' by Lowell M. Schwartz and Robert I. Gelb (Analytical Chemistry 1978, Volume 50, Number 11). 

The estimates are then used as the first guess for the Marquardt non-linear regression analysis. The Marquardt 
analysis calculates new values that are subsequently used as the next guess in a recursive manner, until the 
change in the values is very small, or until a certain number of cycles (default of 100) have been completed. 

The first-order equation is: 

where: 

ABS = intensity at time t 
ABS0= intensity at time t = 0 
ABS∞ = intensity at time t = infinity 
k = rate constant 
t = time 

The second-order equation is: 

where: 

ABS = ABS∞ + (ABS0—ABS∞) e-kt

ABS = (ABS0—ABS∞) + ABS∞
-----------------------------

      X0 .kt + 1 
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ABS = intensity at time t 
ABS0= intensity at time t = 0 
ABS∞ = intensity at time t = infinity 
k = rate constant 
t = time 
X0 = initial concentration of one component 

Operator | Options | X-Y Pairs Table | Status Display 

Use the Reports page to set up the report parameters associated with data collection. 

From the Setup menu, select Reports to access the Reports page. You can also access the page from the 
Setup dialog by selecting the Reports tab. To access the Setup dialog, select the Setup button from the 
Kinetics Application window. 

The page comprises the following: 

Operator 

Options 

This group enables you to select the information to include in your report. 

 
See also: 
How to use the kinetics ruler

Reports—Kinetics 

Hot Tip 
You can view your generated report before you print it out using the Print Preview command in the 
File menu 

If you decide to make changes to the report layout, select  (Edit Report) from the Report toolbar. 
This enables you to directly edit the report.

Name Enter the instrument operator name in this text entry field. Use the arrow to the right of this 
field to view and select one of the last ten entries in this field. 

Note 
In GLP mode the system will automatically enter the operator’s name and this field 
will not be editable.

Comment Enter operator details and comments in this text entry field.

Auto Print Select Auto Print to print a report automatically during the data collection. 
If Auto Print is selected, then the system will send the report information to the specified 
printer(s) as well as the Report area. However if Auto Print is not selected, the report will 
only be sent to the Report area and can be viewed by selecting Report in the View menu. 

To automatically obtain a copy of the graphics, you will need to select both the Auto Print 
and Graph options (see below). In this case, all graphical information displayed on screen 
will be printed with the report. Therefore it is advisable to arrange the graphical information 
as you require on screen, prior to printing.  
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X-Y Pairs Table

Select this if you want to print a table showing the X-Y pairs of the collected data in your report. 

Status Display 

Select this check box to display the Status Display window, where you can view the status of your kinetics run 
during the data collection. 

For example, if you require a single graph print out, then the Single/Multi Graph option in 
the Graph menu should be changed to the correct setting. 

Parameters Select this option to include the method setup parameters within your report.

User data 
form 

Select this option to include in the report any information entered in the User Data Form.

Graph Select Graph to include any graphs or graphic information associated with your report.  
If you require a printout of the displayed graphics only, you must ensure that only this 
option is selected. Select the Clear Report button to clear any information in the Report 
area before you print otherwise this will be included in your printout. 
% Page Height 
Enter the size at which you want the graph to be printed, as a percentage of total page 
height. For example, if you want graphical information to take up half of the page, enter 
50% in this field.

Company 
Logo 

Check this option to include your company logo in the report. 
A company logo will only be included if you have added one on the Company page of the 
System Information Application. 

Hot Tip 
If you have not included a Company logo, select the Header/Footer button to open the 
System Information Application and use the Add Logo option to add a logo.

Header/ 
Footer 

Select the Header/Footer button to open the System Information application where you can 
enter the Header and Footer information to be included in your report. You can also enter 
any additional comments, and add a logo to your report. Once you have made all your 
changes, select OK to exit the System Information application and return to the Reports 
page of the Kinetics application.

Focused trace Select this option to apply the Report selections to the focused trace only.

All traces Select this option to apply the Report selections to all visible traces.

Data Interval Actual 
Select Actual to report the X-Y pairs table for the trace at the actual Data Interval at which 
the data was collected. 

Interpolated 
Select Interpolated to report the X-Y pairs table for the trace at an interpolated data 
interval. Enter this data interval in the adjacent field. If no data has been collected at the 
interval you enter, the Cary Eclipse software will interpolate the data to produce an X-Y 
result. 

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, Microsoft 
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Report Toolbar—Kinetics 
Use the Report toolbar buttons to gain quick access to many of the Edit menu options. You can also use the 
toolbar to cut, copy and paste information and to change the look of your report. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Reports. To display 
or hide the toolbar's text labels, point to the Toolbar option in the View menu and select Text Labels. 

The following commands can be accessed from the Reports Toolbar: 

Clear Report—Kinetics 

Word or Microsoft Excel) into the report area of the of the Lifetimes application. To edit these objects, 
simply double click on them to open the associated application in which they were created.

See also: 
User Data Form 
View menu  
Status Display window

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Edit Report Click this button to edit the report. 
This command is also accessible by pressing CTRL+R.

Undo If available, this undoes the last action. 
This command is also accessible by pressing CTRL+Z.

Cut Click this button to remove the highlighted text and place it on the Windows 
Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Click this button to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.

Paste Click this button to insert the contents of the Windows Clipboard (text only) at the 
cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Click this button to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
This option is only available once you select Edit Report and there is text 
highlighted in the Report area. 

Font Click this button to change the font of new or selected text in the report. For 
existing text, simply highlight the text in the report, select this button and make your 
changes in the Font dialog. When you select OK, the appearance of the highlighted 
text in the report will alter to reflect your font changes. 
This command is also accessible by pressing CTRL+F.

Preview Click this button to display the Print Preview dialog where you can view the current 
report as it will be printed.
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Select the Clear Report command to remove the contents of the Report Area in the Kinetics Application 
window. If you have saved the report, selecting this option does not delete the contents of the report, the 
information is simply removed from the Report Area. 

How to use advanced reporting options—Kinetics 
This outlines ways to fully customize your reports. Options available include:  

Including header and footer information
Including a logo
Editing the text in the report
Viewing the report on screen before printing
Cutting and pasting to a word processor

Including header and footer information 

You can have text appearing at the top and bottom of every page in your report. To specify what the text 
should be, do the following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then select 
System Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter the header and footer information in the Header and Footer fields. 

Step 3 

Click OK to implement your changes. 

Including a logo 

You can include a logo on the first page of your report. To specify what the logo should be, do the following: 

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then select 
System Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter a logo using the Add Logo button. This logo will always be included on the front page of reports.

To access the Clear Report option, select the Clear Report command from the Commands 
menu, or select the Clear Report button from the Kinetics Application window. 

See also: 
Kinetics Application 
Commands menu
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Step 3 

Click OK to implement your changes. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can then add, 
delete and change text in the Report area. 

Viewing the report on the screen before printing 

You can view a report before printing it. To do this, from the File menu select Print Preview. You can then 
ensure that the report format is correct before you print it. 

Cutting and pasting to a word processor 

To have complete control over how your report looks you may wish to copy it to a word processor program, 
such as Microsoft Word. To do this: 

Step 1 

Open a report. 

Step 2 

From the Edit menu, choose Edit Report. 

Step 3 

Click in the Report area and highlight the text you want to export to your word processor. 

Step 4 

Right-click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text into a 
document. 

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application.

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The
Administrator of the system will have to change your privileges before you can edit reports.

Hot Tip 
Use the arrow keys at the bottom of the Print Preview screen to change pages.
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Storage | Auto convert | Email | Status display 

Use the Auto Store page to specify if and when data will be stored, and in what format. You can also use this 
page to set up the system to automatically send an email at the end of a read. 

From the Setup menu, select Auto store to access the Auto store page. You can also access the page from the 
Setup dialog by selecting the Auto store tab. To access the Setup dialog, select the Setup button from the 
Kinetics Application window. 

The page comprises the following: 

Storage 

Auto convert 

Use the Auto convert options to convert your data into an ASCII file format that can be opened in spreadsheet 
programs such as Microsoft Excel. 

Auto Store—Kinetics 

Off Select this if you do not wish to be automatically prompted to save collected data. 
Note 
If you wish to store your unsaved data manually, choose Save Data As… from the File 
Menu to save your data after the run is complete. You can save your data as a Batch or 
Data file.

On; Prompt 
At Start 

Select this to display the Windows Save As dialog at the start of the collect where you can 
enter the Batch filename for your data.

On; Prompt 
At End 

Select this to display the Windows Save As dialog at the end of a collect where you can 
enter the Batch filename for your data.

None Select None if you do not need to generate an ASCII file.
ASCII (csv) Select this option to save the data as a comma delimited ASCII Spreadsheet file (*.CSV) file. 

Only the currently collected data is converted. 

ASCII files are stored in the same folder as the data file from which they were generated and 
designated the same filename as the method used to collect the data plus the extension 
‘CSV’. 

ASCII (csv) 
with log 

Select this option to save the data as a comma delimited ASCII Spreadsheet file (*.CSV) file. 
Only the currently collected data is converted. The key method parameters used to collect the 
data are also saved in this file. 

ASCII files are stored in the same folder as the data file from which they were generated and 
designated the same filename as the method used to collect the data plus the extension 
‘CSV’. 

Note 
If you choose to auto-convert the data to an ASCII file but you have set the Storage 
option to Off, then the ASCII file will be saved with the following format: 
DATE TIME. CSV 
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Email 

Select the Email check box and enter the Email details to send an email to a person once the read is completed. 
This useful facility can be used to alert you to the completion of the read, particularly if you are working away 
from the laboratory where the Cary Eclipse instrument is. You can also attach the collected data to the email. 

Status display 

Select this check box to display the Status Display window, where you can view the status of your kinetics run 
during the data collection. 

How to email your results—Kinetics 
You may wish to send an email to a person once the read is completed. This useful facility can be used to alert 
you to the completion of the read, particularly if you are working away from the laboratory where the Cary 
Eclipse instrument is. 

To do this: 

Step 1 

Ensure that you have set up the Host and Port options on the Email options page of the System Information 

The date and time will appear in the same form that is set in the Windows Regional 
Settings Properties dialog that is accessed from the Windows Control Panel. 

For example, 22_4_97 1;32;08.CSV 

Note 
You must set up the email Host and Port options on the Email options page of the System Information 
application in order for the email facility to work correctly.

To Enter the recipient's email address. You can enter more than one recipient in this field.
From Enter your email address (or the email address associated with the computer on which the 

Cary Eclipse software is installed.
Subject Enter the subject of your email (or leave this field blank if you do not wish to include a 

subject).
Cc Enter the email address of any recipient you want to copy the email to.
Message Enter your message.
Attached… Use the Attached button include a file attachment in your email. To do this, select Attached 

and browse your computer to select a file, using the Windows® Open dialog that appears.
Attach current 
data 

Select this option to attach the data that has been collected during the run to the email.

How to email your results 

See also: 
Kinetics Application window   
Save As dialog   
Status Display window 
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application in order for the email facility to work correctly. 

Step 2 

From the Setup menu, select Auto Store. The Auto Store page is displayed. 

Step 3 

Select the Email check box to enable the email options. 

Step 4 

In the To field, enter the recipient's email address (for example, rchandler@varianinc.com). To enter multiple 
recipients, simply type a comma ',' between each email address. 

Step 5 

In the From field, enter the email address of the computer on which the Cary Eclipse software is installed. This 
may be your email address, or a communal email address, if the Cary Eclipse software is installed on a 
computer that has multiple users. 

Step 6 

Enter information in the Subject and Message fields as required. 

Step 7 

Select Attach current data. The data that has been collected during the run will be attached to the email. 

Step 8 

Select OK to clear the Auto Store dialog. Your email will be sent once the run has been completed. 

Performing scans—Kinetics 
Starting a run
Sample Name dialog
Cell Loading Guide
Sync Start dialog
Start/Stop buttons
Pre-scan dialog
Stop Time dialog
Go To dialog

Hot Tip 
You can attach other documents to your email. To do this, select the Attached button and browse your 
computer to select a file, using the Windows® Open dialog that is displayed.

See also: 
Auto Store 
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Go To Temperature dialog
Rapid Result dialog
Commands menu
How to perform a single-wavelength kinetics run
How to perform a multi-wavelength, temperature controlled kinetics run

Information about starting a collect—Kinetics 
The sequence that occurs when you select Start to commence the kinetics run depends upon your storage and 
accessory selections. 

Storage selections 

Accessory selections 

If you have selected … as the 
Storage option on the Auto Store 
page

The following occurs

On, prompt at start The Windows Save As dialog will appear as soon as you select Start. 
You can save the current method, collected data, report and graph 
template as a Batch file.

On, prompt at end The Windows Save As dialog will appear at the end of the data 
collection. You can save the current method, collected data, report and 
graph template as a Batch file.

Off The Windows Save As dialog will not appear.

If you have selected … on the 
Accessories page

The following dialog is displayed

No accessories The Sample Name dialog will appear when you select Start, 
prompting you to load the sample and enter your sample name. Select 
OK to display the Sync Start dialog and commence the kinetics run.

Multicell Holder The Cell Loading Guide dialog will appear. Enter the sample name 
of each activated cell then select OK to display the Sync Start dialog. 

When you select OK to clear the Cell Loading Guide dialog, the cell 
changer will move to cell position 4, enabling you to easily access all 
of the cell positions and load your samples. 

If you need to start data collection immediately: 
Load the cells into the cell changer and select Reset Slide from the 
Sync Start dialog. The cell changer will move to cell position 1. You 
should then add the reactants to the cells as quickly as possible, close 
the lid and select  OK on the Sync Start dialog. The collect will start 
immediately without performing another reset command. 

If you do not need to start the data collection immediately: 
Add the reactants to all the cuvettes and select OK on the Sync Start 
dialog. The system will automatically reset the cell changer to cell 
position 1 and start measurements on the selected cuvettes.  

Wellplate Reader The Sync Start dialog will appear after you press Start. The sample 
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Sample Name—Kinetics 
If you are using a single cell holder, the Sample Name dialog appears once you select the Start button to 
commence an analysis. 

The page comprises the following: 

Cell Loading Guide—Kinetics 
If you are using a Multicell Holder, the Cell Loading Guide dialog appears once you select the Start button to 
commence an analysis. 

The Cell Loading Guide dialog prompts you to insert blank samples in the Multicell Holder to collect the 
Kinetics scans. You can also use the dialog to name the samples in each selected cell in the Multicell Holder. 

The dialog comprises the following: 

labels and the positions in the wellplate that you wish to use have been 
set up before you press Start.

See also: 
Sample Name 
Cell Loading Guide 
Sync Start 
Start/Stop buttons 
Setup 
Accessories 
Auto Store

Sample Name Enter the name of the sample to be used in the kinetics run. Click on the arrow to the right of 
the field to view and select the most recently entered sample names. 
Once you have entered the Sample Name, select OK to display the Sync Start dialog and 
commence the kinetics run. 

 
See also: 
Cell Loading Guide

Loading 
Guide/Sample 
Name entry

Enter the names of the sample to be used in the kinetics run in each available field. This 
sample name will be used as the Name of Trace in the Trace Preferences dialog. 

Once you have entered the Sample Name, select OK to display the Sync Start dialog and 
commence the Kinetics run. 

Note 
The Cell Loading Guide dialog appears only if you have 
selected the Multicell Holder option on the Accessories 
page of the Setup dialog. Only cells selected in the 
Multicell Holder diagram on the Accessories page will be 
available in the Loading Guide. 

In the adjacent example, cells 1—3 will be available in the 
Loading Guide dialog, as they have been selected in the 
Multicell Holder diagram. 
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Sync Start—Kinetics 
Use the Sync Start dialog to synchronize the start of a reaction and the start of the kinetics data collection. 
Before displaying the Sync Start dialog, the Cary Eclipse will set up all the instrument and graphing parameters 
so that data collection can start as soon as the countdown finishes or you select OK. 

The sequence for a Sync Start is as follows: 

Set up your data collection parameters
Click the Start button (and load the samples if necessary)
Once the Sync Start dialog is displayed, add your active reagent
Commence the data collection by selecting the OK button

The dialog comprises the following: 

The following buttons may be displayed at the top of the Kinetics Application window. The Start, Pause, 
Continue and Connect buttons will change depending upon the status of the run. For example, if a run has not 
been started, the Start button will be visible to indicate that the system is ready to commence a run. 

See also: 
Accessories 
Sample Name

Count Down This field displays a two minute countdown in seconds. If you want to start your data 
collection before the two minute countdown ends select the OK button. Alternatively, you 
can wait for the countdown to end and the data collection will start automatically. 

Note 
If you are using a Multicell Holder and you select the OK button, the system will 
automatically Reset this accessory and immediately start the kinetics run.

Reset Slide Click this button to drive the Multicell Holder to its zero point (Cell position 1).

Start/Stop Instrument buttons—Kinetics 

Select Start to commence a kinetics run using the current Setup parameters. 
If any unsaved data exists in the Graphics area you will be prompted to save the 
data. If you choose not to save, any unsaved data, pictures and labels will be deleted 
when you start the kinetics run. 

When a kinetics run is started, the Start button will change to Pause. 

The Pause button is displayed in place of the Start button once you have selected 
Start to commence a run. Click Pause to temporarily suspend the data collection, so 
that you can modify your solutions during the kinetics run. 
While the system is in the paused state, it will continue to keep track of the elapsed 
time, however data collection will stop until the Continue button is selected. 

The benefit of using Pause instead of Stop is that you are able to add a secondary 
substrate to your kinetics solution(s) and then continue to monitor a secondary 
reaction, without having to Stop and Start the collect again. It also means that you 
will not get a spike in your data when you open the sample compartment to add the 
reagent. 
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Zero—Kinetics 
Use the Zero button to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use the Zero 
command before commencing a data collection if you want your data to start at 0  intensity. The Cary Eclipse 
will prompt you to load a blank before performing the zero. 

Before you select Zero, ensure that you have placed the blank solution in the cell positions that are currently in 
the cell path. 

When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the 
Kinetics Application window. 

Select the Clear Zero command from the Commands menu to remove zero correction and thus remove the 
subtraction effect. 

Pre-scan—Kinetics 
Select Pre-scan to determine the optimum instrument parameters to be used for your sample. At the end of this 
collection sequence the software will report the optimum Ex and Em wavelengths and PMT voltage. Once you 
are satisfied with the parameters, the software will automatically update your method setup to reflect these new 
parameters. 

When a kinetics run is paused, the Pause button will change to Continue. 

The Continue button is displayed in place of the Pause button when you have 
paused the run. Click Continue to proceed with the kinetics run after it has been 
paused. 

Once you select Continue, is selected the button changes back to Pause. 

If another application is already online with the Cary Eclipse, the Start button will 
change to Connect, and you will need to select Connect to bring this application 
online before the Start button will re-appear. (You will not be able to Connect if the 
other application is collecting data.)

Select this to end a kinetics run. 
If you have selected Storage On in the Auto Store page of the Setup dialog, all data 
collected is automatically stored in the file specified in the Batch name field of the 
Windows Save As dialog before or after the run commenced. 

 
See also: 
Graphics area 
Commands menu

To access the Zero option, select the Zero command from the Commands menu, or select the 
Zero button from the Kinetics Application window. 

See also: 
Kinetics Application 
Commands menu 
Cell Loading Guide

To access the Pre-scan option, select the Pre-scan command from the Graph menu, or select 
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The Pre-scan dialog comprises the following: 

Type of scatter 

Select he type of scatter you wish to search for from the following: 

Stop Time—Kinetics 
Use the Stop Time dialog to extend the length of a kinetics run while the run is in progress. Extending a run 
may be necessary if you decide whilst a run is in progress that the data collection period is too short. The Stop 
Time command is not available until a run is in progress (that is, the Start button is selected). 

To extend the length of a kinetics run in progress: 

1. Select the Stop time option from the Kinetics Application window or the Commands menu. The Stop
Time dialog is displayed.

2. In the Stop Time field, the minimum allowable Stop Time will be displayed. This is the Stop Time that
has been specified on the Cary page of the Setup dialog.
In the Stop Time field, enter the new Stop Time and select OK. The X axis (Time) of the graph in the
Graphics Area will be updated to reflect the new setting.

Use the Go to Wavelength dialog to temporarily change the instrument to a new excitation or emission 
wavelength. You would mainly use this dialog if you want to quickly go to a wavelength and check the 
intensity reading of the sample. The lamp will flash continuously in this mode. This option is only available if 
the instrument is not currently collecting data. 

To access the Go to Wavelength dialog, select the Go To Wavelength command from the Commands menu. 
You can also select F4 to open the dialog. 

the Pre-scan button from the Kinetics Application window.

Rayleigh 
scatter 

Rayleigh scatter refers to the scatter of the excitation light. It is displayed at the peak of the 
excitation wavelength.

Raman scatter Raman scatter refers to scatter due to the solvent. Its peak is at a fixed energy from the 
excitation wavelength, and is solvent dependent. Thus, the type of solvent used must be 
selected from the Solvent list.

2nd order Second order scatter refers to the scatter of higher order excitation light. Its peak is a multiple 
of the excitation wavelength.

See also: 
Graph menu  
Kinetics Application

To access the Stop Time dialog, select the Stop Time button from the Kinetics Application 
window or the Stop Time command from the Commands menu. 

See also:
Kinetics Application
Cary page
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The Go to Wavelength page comprises the following: 

Use the Go to Temperature dialog to change the current temperature to a new value. 

The Set Temp button is only accessible if you are using a thermostatted accessory. (On the Accessories page, 
the Temperature control option must be selected.) 

You can access the Go to Temperature dialog prior to starting a run or once a run is in progress. 

To change the current temperature of a run in progress: 

1. Access the Set Temp button by selecting the Pause button to pause the run. You can then select the Set
Temp button.

2. In the Set temp field, enter the temperature you want the instrument to change to. Select OK to return to
the Kinetics Application window.

3. Select Continue to proceed with the run.

Note 
This is not the wavelength used in the application method. If your method uses a wavelength that is 
different from the 'Go to wavelength' setting you select, then when you select Start the system will change 
to the wavelength selected. (In most applications, this is set in the Cary page of the Setup dialog.) 

Excitation Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go to the instrument 
will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white 
light). You can then use this light for aligning accessories. 

Emission Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go to the instrument 
will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white 
light). You can then use this light for aligning accessories. 

Go To Click Go to once you have entered a new wavelength, to change the instrument to the entered 
value.

See also: 
Commands menu  
Function Keys

Go to Temperature—Kinetics 

To access the Go to Temperature dialog, select the Set temp button from the Kinetics 
Application window or the Set temp command from the Commands menu.

See also:
Kinetics Application

Page 45 of 124Kinetics Home Page



Use the Rapid Result dialog to take a reading of a blank and sample/s, without having to change the current 
application method. You can use the Multi Cell Changer dialog to specify the cell you want to read. This 
means that between runs, while new samples are being prepared and loaded, other samples can quickly be 
measured. The result is printed in the Report area. 

To access the Rapid Result dialog, select the Rapid Result command from the Commands menu or press F6.

Use the Commands menu to access major operational commands in the Kinetics application . The menu is 
accessible from the menu line at the top of the Kinetics Application window. 

Alternatively you can use function key shortcuts for some of the commands. These appear next to the item in 
the Commands menu. Note that not all commands appear as both button and menu items. 

The Commands menu comprises the following commands: 

Rapid Result—Kinetics 

Excitation Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Emission Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Zero Click Zero to change the wavelength to the entered value and measure a blank.
Result Click Result to change the wavelength to the entered value and measure a sample. The X,Y 

results are corrected for the blank and the results are displayed in the Report window.
See also: 
Multi Cell Changer  
Commands menu 

Commands menu—Kinetics 

Hot Tip 
If you access these commands using the Commands menu, rather than from the application buttons, you 
can remove these buttons from your application window. To do this, clear the Buttons command in the 
View menu. This will enlarge the Graphics area, making viewing and selection of scans easier. 

Tell me how to remove or display the command buttons  

Command What it does…
Start Select this to start a data collection using the currently set up parameters. 

If the Connect command is displayed in place of the Start command, this indicates that 
another Cary Eclipse application is in use and has control of the Cary Eclipse instrument. To 
make the Kinetics application active so that you can perform a read, you will need to select 
Connect. However, you will not be able to select Connect if another application is 
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collecting data. 
Stop Select this to stop the data collection. 

If you have selected Storage On in the Auto Store page of the Setup dialog, all data 
collected is automatically stored in the file specified in the Batch name field of the 
Windows Save As dialog before or after the run commenced. 

Clear Zero Select this option to clear the Zero command. When you select the Zero command (from the 
Commands menu or by pressing F5), the intensity at that time will be reset to zero and all 
subsequent results will have the intensity value that was reset to zero subtracted from them. 
Selecting Clear zero cancels this zeroing (and thus subtraction) effect.

Pre-scan Select Pre-scan to quickly determine the optimum instrument parameters to be used for your 
sample. At the end of this collection sequence the software will report the optimum Ex and 
Em wavelengths and PMT voltage. Once you are satisfied with the parameters, the software 
will automatically update your method setup to reflect these new parameters.

Zero order… Select the Zero order command to set one of the monochromators to zero order. If you use 
this command to zero either the excitation or emission monochromators, this will override 
the Ex. Wavelength or Em. Wavelength set on the Cary page. The Cary Eclipse software 
will use the zero setting when collecting data. 

The Zero order command is generally used during alignment procedures.  

Excitation 
Select this command to set the excitation monochromator to zero order (white light). 

Emission 
Select this command to set the emission monochromator to zero order (white light). 

Reset Select this command to re-initialize the instrument. This will perform the same initializing 
procedure that is performed when the instrument is powered on.

Rapid Result Select this to display the Rapid Result dialog. Use this dialog to take a reading of a blank 
and multiple sample readings without changing the application method. This means that 
between runs, while new samples are being prepared and loaded, other samples can quickly 
be measured. 
This command can also be accessed by pressing F6.

Zero Select this to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can 
use the Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Go to… Select Go To… to display the Go To Wavelength dialog where you can change the 
instrument to a new wavelength. Use this command if you want to quickly go to a 
wavelength to check the intensity reading. 
This command is only available if the instrument is not currently collecting data. It can also 
be accessed by pressing F4. 

Note 
This is not the wavelength used in the application method. If your method uses a 
wavelength that is different from the 'Go To wavelength', then when you select Start 
the system will change to the wavelength selected. (In most applications, this is set in 
the Cary page of the Setup dialog.) 

Set temp Select Set temp to open the Set Temperature dialog where you can change the temperature 
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How to perform a single-wavelength kinetics run—Kinetics 
This demonstrates how to perform a fluorescence single-wavelength kinetics run at ambient temperature. 

Follow the steps through, adjusting them to meet the requirements of your particular data collection.  

Start the Kinetics application
Set up data collection parameters
Set up instrument parameters
Set up rate parameters
Set up the options
Set up accessories
Set up rate calculation, rate order and other rate parameters
Set up reporting and printing requirements
Set up storage of collected data
Set up email options
Set up visual system monitoring
Finish Setup
Zero the instrument
Start the kinetics run
Save your data

Start the Kinetics application  

Step 1 

during a kinetics run. 

The Set temp command button is only accessible if you are using a thermostatted accessory. 
(On the Accessories page, the Temperature control option must be selected.) Once you 
have started a run, select the Pause button to pause the run and then select the Set temp 
command. 

Stop time Select the Stop Time command to open the Stop Time dialog which you can use to extend 
the length of a kinetics run while the run is in progress. Extending a run may be necessary if 
you decide whilst a run is in progress that the data collection period is too short. The Stop 
Time command is not available until a run is in progress (that is, the Start button is 
selected).

ADL 
Command 

Select this to display the ADL Command Line window where you can execute an ADL 
command or ADL program. (You can also press Alt-Y to display this dialog.)

Rerun ADL Select this to run the ADL command or program in the ADL Command Line window again. 
(You can also press Alt-X to rerun programs.)

See also: 
Kinetics Application window 
Auto Store  
Zero  
Cary page  
Rapid Result   
Go To Wavelength 
Set Temperature  
Stop Time 
ADL Command Line 
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Click the Windows Start button, point to Programs, Cary Eclipse and then select Kinetics. The Kinetics 
Application is displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select Setup to display the Setup dialog and specify the method parameters for a new method. 

To do this: 

Set up instrument parameters 

Step 3 [Setup dialog | Cary page]  

a. In the Data mode field set the mode to Fluorescence.

b. In the Ex. Wavelength field, set the wavelength of the excitation monochromator to a wavelength at
which the chromophore absorbs light. For example, if you were measuring quinine, this absorbs at
350 nm.

c. In the Em. Wavelength field, set the wavelength of the emission monochromator. For quinine this
would be approximately 450 nm.

d. Set the slit width of the excitation and emission monochromators to 5.
Note that as a general rule, at a fixed emission slit width, increasing the excitation slit width will result in
an increase in the fluorescence excitation intensity. You can therefore choose to increase the slit width if
the resultant intensity is too low, however it is recommended that you initially try to increase intensity by
using the PMT Detector Voltage setting (on the Options page).

Set up rate parameters such as the number of different rates in the reaction, the speed, and 
the duration of the data collection  

Step 4 [Setup dialog | Cary page]  

a. In the Collect Timing group, select the Simple Collect option. This sets up a single rate for your
reaction.

b. Enter a Cycle time of 0. The Ave time will therefore be used to determine the distance between points.

c. Specify the duration of the kinetics run by setting the Stop time for the rate stage. You will need to have
knowledge of your experiment to determine this value.

d. In the Ave Time field enter the required value. If the sample you are measuring is highly fluorescent,

Note 
If you are running a GLP system, you may be prompted to enter a password before accessing the Kinetics 
application.

Hot Tip 
If you have a long, slow reaction, use the Cycle time to limit the number of data points that are colle

Page 49 of 124Kinetics Home Page



then 0.1 sec is a good starting point. If the sample fluoresces quickly, you may need to decrease the Ave 
time to 0.0125 sec in order to ensure that you produce a data point each time the lamp is flashed. Note 
however that decreasing the Ave time will increase the signal-to-noise ratio.  

Set up the options  

Step 5 [Setup dialog | Options page]  

a. Select the Options tab. The Options page is displayed.

b. In the Display Options group, select the way in which you want the data displayed as it is collected. For
example, select the Overlay Data button to superimpose the collected data of each sample in the kinetics
run in one graph box

c. Enter the minimum and maximum Y values to be displayed on the graph axis during the data collection.

d. Set the Excitation filter and the Emission filter for the concentration measurement to Auto. It is not
necessary to set the Emission filter to the default setting of Open, as you are only looking at a single
wavelength.

e. Set the PMT Detector voltage to Medium. To determine whether this setting is most suitable for
obtaining the highest possible intensity, use the Rapid Result option, which is accessible from the
Commands menu.

Set up accessories  

Step 6 [Setup dialog | Accessories page] 

Select the Accessories tab and ensure that no accessories are selected. 

Set up rate calculation, rate order and other rate parameters  

Step 7 [Setup dialog | Analyze tab]  

a. Select the Analyze tab. The Analyze page is displayed.

b. Select the Auto Calculate check box to automatically perform a rate calculation on collected data at the
end of each run.

c. Select Simple Calculate to set up one rate calculation for the entire kinetics run.

d. Enter a Start time of 0 min and Stop time that is the same as the Stop time entered on the Cary page..

e. The Order you set will depend upon the reaction you are performing. Choose from Zero, First or
Second.

Set up reporting and printing requirements  

Step 8 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.
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b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

e. Select the X-Y Pairs Table check box to view a list of abscissa values and their corresponding intensity
values.

Set up storage of collected data  

Step 9 [Setup dialog | Auto Store page] 

a. Select the Auto Store tab to display the Auto Store page.

b. Set the Storage option to Off. The method (with calibration), collected data and report will not be
automatically saved. However, you can manually save it all at the end of the collection.

c. Select the Auto Convert option you require. If you select ASCII (csv) or ASCII (csv) with log, then at
the end of the data collection the system will automatically generate a report and store the data both in
the Cary Eclipse format as well as ASCII XY pairs format. The data file will be saved in the current
folder.

Set up email options 

Step 10 [Setup dialog | Auto Store page] 

Refer to How to email your results for instructions on setting up the email options. 

Set up visual system monitoring  

Step 11 [Setup dialog] 

Select the Status Display check box on any of the Setup pages to display various information fields on your 
current reaction. 

Finish Setup  

Step 12 

Once you are satisfied with your method setup select OK to confirm any changes you have made and clear the 
Setup dialog. 

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as w
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report a
and can be viewed by selecting the Report command from the View menu.
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Zero the instrument  

Step 13 

a. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

b. Select the Zero button to zero the system. Alternatively, select Zero from the Commands menu to
perform a zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top
left corner of the Scan Application window.

Start the kinetics run  

Step 14  

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands
menu. Do not add your active reagent at this time. The Sample Name dialog is displayed.

b. Place the sample in the sample compartment and select OK. The Sync Start dialog will be displayed.

c. Add your active reagent just before the Count Down reaches 0:00 or commence the data collection by
selecting the OK button.

Save your data  

Step 15  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this kinetics run.

c. Select Save. The data will be stored as a Batch file.

How to perform a multi-wavelength, temperature controlled kinetics 
run—Kinetics 
This demonstrates how to perform a multi-wavelength, temperature controlled kinetics run using the PCB 150 
Water bath. 

Follow the steps through, adjusting them to meet the requirements of your particular data collection.  

Start the Kinetics application
Set up data collection parameters
Set up instrument parameters
Set up rate parameters
Set up collection display options
Ensure Multicell Holder accessory is not selected
Set up accessories for reaction temperature control and temperature display
Set up rate calculation, rate order an other rate parameters
Set up reporting and printing requirements

See also:
How to perform post run calculations on previously stored data
How to export collected data
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Set up storage of collected data
Set up the email options
Set up visual system monitoring
Finish Setup
Start the kinetics run

Start the Kinetics application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Kinetics. The Kinetics 
Application is displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select Setup to display the Setup dialog and specify the method parameters for a new method. 

To do this: 

Set up instrument parameters  

Step 3 [Setup dialog | Cary page]  

a. In the Data mode field set the mode to Fluorescence.

b. In the Wavelength setup group, select Multiwavelength. The Multiwavelength table will be displayed.
Enter the following parameters in the Multiwavelength table. For the purpose of this example, FURA-2
will be used.

c. Set the slit width of the excitation and emission monochromators to 5.
Note that as a general rule, at a fixed emission slit width, increasing the excitation slit width will result in
an increase in the fluorescence excitation intensity. You can therefore choose to increase the slit width if
the resultant intensity is too low, however it is recommended that you initially try to increase intensity by
using the PMT Detector Voltage setting (on the Options page).

Set up rate parameters  

Step 4 [Setup dialog | Cary page]  

a. In the Collect Timing group, select the Advanced Collect option. This enables you to set up different
data collection procedures for the multiple rates in your reaction.

Note 
If you are running a GLP system, you may be prompted to enter a password before accessing the Kinetics 
application.

Name Ex. wavelength (nm) Em. wavelength (nm)
Wavelength 1 340 510
Wavelength 2 380 510
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b. Set the value in the Number of Stages field to 3. The table below will expand to three rows.

c. Set the Ave time to 0.0125 sec.

d. Enter the following parameters in the Stages table:

Therefore, from 1–20 min, a cycle will be performed every 0.0125 sec. (When the Cycle time is set to 0, 
the Ave time is used to determine the distance between points.) From 21–60 min, a cycle will be 
performed every 1.0000 min and from 61–100 min, a cycle will be performed every 5.0000 min. 

Set up collection display options 

Step 5 [Setup dialog | Options page]  

a. Select the Options tab. The Options page is displayed.

b. Enter the minimum and maximum Y values to be displayed on the graph axis during the data collection.

c. Set the Excitation filter for the concentration measurement. It is recommended that you set the filter to
Auto ( the default setting). This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

d. Set the Emission filter for the concentration measurement. In order to minimize steps in the spectra, it is
recommended that you set the filter to Open (the default setting).

e. Set the PMT Detector Voltage. The setting you choose will depend upon your sample. For example, a
Low setting is recommended for highly emitting samples, while a High setting is recommended for low
emitting samples.

Ensure Multicell Holder accessory is not selected 

Step 6 [Setup dialog | Accessories page] 

Select the Accessories tab to display the Accessories page. On the Multicell/Temperature tab, 
ensure that the Multicell Holder accessory is not selected. 

Set up accessories for reaction temperature control and temperature display 

Step 7 [Setup dialog | Accessories page]  

a. Select the Temperature control check box to enable the Temperature group.

b. Click on the down arrow adjacent to the Device field and select the PCB 150 Water bath accessory.

Note 
The Advanced Collect facility enables you to collect data more frequently during the crucial stages o
your reaction and to collect data less frequently where you know there will not be much activity. 

Stage Cycle (min) Stop (min)
1 0.0000 20.0000
2 1.0000 60.0000
3 5.0000 100.0000
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c. Set the Temperature to 37°C.

d. Set the appropriate Communications port from the Port drop down list.

e. Set the Monitor to PCB 150.

f. In the Temperature Display group, select Probe 1 to view the temperature of one temperature probe in
the Status Display window.

Set up rate calculation, rate order and other rate parameters  

Step 8 [Setup dialog | Analyze page]  

a. Select the Analyze tab. The Analyze page is displayed.

b. Select the Auto Calculate check box so that a rate calculation will be automatically performed on
collected data at the end of each run.

c. Select Advanced Calculate to set up multiple rate calculations for the kinetics run. If you select
Advanced Calculate, the Cary Eclipse system will also automatically calculate the values: A0, AInf and
Rate when the Start button is selected.

d. In the Number of stages field, enter a value of 3. The Stages table will be expanded to three rows.

e. Enter the following parameters in the Stages table:

Set up reporting and printing requirements  

Step 9 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

Stage Start (min) Stop (min) Order
1 0.00 20.00 Depends on reaction
2 21.00 60.00 Depends on reaction
3 61.00 100.00 Depends on reaction

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as w
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report a
and can be viewed by selecting the Report command from the View menu.
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e. Select the X-Y Pairs Table check box to view a list of abscissa values and their corresponding intensity
values.

Set up storage of collected data  

Step 10 [Setup dialog | Auto Store page] 

a. Select the Auto Store tab to display the Auto Store page.

b. Set the Storage option to On; prompt at start. You will be prompted to save your method (with
calibration), collected data and report when you commence the run.

c. Select the Auto Convert option you require. If you select ASCII (csv) or ASCII (csv) with log, then at
the end of the data collection the system will automatically generate a report and store the data both in
the Cary Eclipse format as well as ASCII XY pairs format. The data file will be saved in the current
folder.

Set up email options 

Step 11 [Setup dialog | Auto Store page] 

Refer to How to email your results for instructions on setting up the email options. 

Set up visual system monitoring  

Step 12 [Setup dialog] 

Select the Status Display check box on any of the Setup pages to display various information fields on your 
current reaction. 

Finish Setup  

Step 13 

Once you are satisfied with your method setup select OK to confirm any changes you have made and clear the 
Setup dialog. 

Zero the instrument  

Step 14  

a. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

b. Select the Zero button to zero the system. Alternatively, select Zero from the Commands menu to
perform a zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top
left corner of the Scan Application window.

Start the kinetics run  

Step 15  

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands
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menu. Do not add your active reagent at this time. The system will display the Save As dialog. 

b. Enter the file name for this kinetics run in the File name field and select Save. The system will display
the Sample Name dialog.

c. Place the sample solution in the correct cell position and select OK. The Sync Start dialog will be
displayed.

d. Add your active reagent just before the Count Down reaches 0:00 or commence the data collection by
selecting the OK button.

Viewing run progress and results—Kinetics 
Reports page
Reports toolbar
View menu
Edit menu
Status display
Print Preview dialog
Print

The View menu is accessible from the menu line at the top of the Kinetics Application window. 

The following commands can be accessed from the View menu: 

See also: 
How to perform post run calculations on previously stored data 
How to export collected data

View menu—Kinetics 

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open it. 
Any data will be displayed in the Graphics area.

Command What it does…
Toolbar Select this option to toggle the Graphics and Reports toolbar on and off. You can also 

select to display or hide the toolbar Text Labels.
Buttons Select this option to toggle the left-hand button display (button area) on and off.
Graphics Select this option to toggle the Graphics area on and off. 
Report Select this option to toggle the Report area on and off.
Report 
Vertical 

If the Graphics option is selected, select Report Vertical to display the Graphics area, 
Report area and/or ADL Editor side by side vertically.

ADL Select this option to toggle the ADL Editor on and off.
ADL Vertical If the ADL and Report options are selected, select ADL Vertical to display the ADL Editor 

vertically on the right hand side of the Report area.
ADL Quick 
Reference 

This displays the Quick Reference window where you can easily add a command in the 
correct syntax to your ADL program. A detailed description of all the commands in the 
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Edit menu—Kinetics 
Use the Edit menu to copy, cut, paste and delete information. You can also use the menu to access the Report 
editing commands. The menu is accessible from the menu line at the top of the Kinetics Application window. 

The following commands can be accessed from the Edit menu: 

Quick Reference is available by selecting the Help button.
ADL Hooks Select this to activate a link (or hook) to an ADL program at a specific point in the 

application, and then run that ADL program. For example, ADL hooks have been supplied 
to run specific programs: 

on start-up of the Cary Eclipse software;
when the system goes online or offline;
when the Start button is selected;
when a run finishes;
when a zero is performed etc.

For the hook to work, ADL Hooks must be selected, and the appropriate ADL file for the 
application must be present in the ADL folder in the directory. 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Hints Select this option to toggle the Hints bubble text on and off. The bubble text appears when 
you place the arrow cursor over a field, button or text entry field for a short period. It offers 
a quick explanation of the item’s function.

Status Display Select this option to display the Status Display window, where you can view the status of 
various parameters during the data collection.

See also: 
Kinetics Application 
Graphics area   
Status Display  
ADL Hooks 
How to insert ADL commands using the Quick Reference

Note 
Some options are only available once you select Edit Report. 

Command Button What it does… 
Undo If available, this undoes the last action. 

This command is also accessible by pressing CTRL+Z.
Cut Select this command to remove the highlighted text and place it on the Windows 

Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Select this command to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.
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Status Display—Kinetics 
Use the Status Display window to view the status of your kinetics run during the data collection. Depending 
upon settings you have for the Kinetics run, the following parameters may be displayed:  

Current Excitation Wavelength (nm)
Current Emission Wavelength (nm)
Excitation Slit Width (nm)
Emission Slit Width
PMT Voltage (V)

To access the Status Display window, select Status Display from the View menu, or from any page of the 
Setup dialog. You can choose to view the Status Display at any time during a kinetics run. 

Print Preview—Kinetics 

Paste Select this command to insert the contents of the Windows Clipboard (text only) at 
the cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Select this command to remove selected text in the Report area. This option is only 
available once you select Edit Report and there is text highlighted in the Report area.
This command is also accessible by pressing DEL.

Select All Select this option to highlight all text in the Report area. 
This command is also accessible by pressing CTRL+A.

Font This enables you to change the font of new or selected text in the report. For existing 
text, simply highlight the text in the report, select Font and make your changes in the 
Font dialog. When you select OK, the appearance of the highlighted text in the report 
will alter to reflect your font changes. You do not have to select Edit Report to use 
this command. 
This command is also accessible by pressing CTRL+F.

Edit Report Select this option to edit the report. 
This command is also accessible by pressing CTRL+R.

Clear Report Select this command to remove the contents of the Report area. If you have saved the 
report, selecting this option does not delete the contents of the report, the information 
is simply removed from the Report area.

Recalculate Use the pages accessible from the Recalculate option to perform re-calculations on 
data that has been analyzed. 

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, Microsoft 
Word or Microsoft Excel) into the report area of the of the Kinetics application. To edit these objects, 
simply double click on them to open the associated application in which they were created. 

See also: 
Kinetics Application  
Recalculate 

See also: 
View menu  
Setup  
Status Line
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Use the Print Preview dialog to view the current report before you print it. From the File menu, select Print 
Preview to access the dialog. 

The contents of the Graphics area appear first in the preview area followed by the contents of the Report area. 
You can reduce or enlarge the print preview on screen. To do this, click the left mouse button in the preview 
area to toggle through the five available views. Click the right mouse button in the preview area to return to the 
full page view.  

The page comprises the following commands: 

Print—Kinetics 
Use the Print dialog to select the printer and pages to print of the currently displayed report as well as the 
number of copies you wish to print. 

All graphical information displayed on screen will be printed with the report, therefore it is advisable to edit 
the report on the screen prior to printing. You can also preview the report prior to printing by using the Print 
Preview command. 

If you require a printout of the graphics in the Graphics area only, select the Clear Report button to erase the 
contents of the Report area before you print. 

First arrow Use this arrow to view the first page of the report. 

Previous 
arrow

Use this arrow to view the previous page of the report. 

Next arrow Use this arrow to view the next page of the report. 

Last arrow Use this arrow to view the last page of the report. 
Q. Why are the arrow buttons grayed out?
A. The buttons will be grayed out if the report has only one page of data.

Print Use this to display the Windows Print dialog where you can choose the printer and 
pages to print as well as the number of copies you wish to print.

See also: 
File menu

To access the Print option, select the Print command from the File menu, or select the Print 
button from the Kinetics Application window. 

Note 
The options on the Report page are used to generate the contents of the Report area during a run or on a 
recalculation. If Auto Print has been selected the Cary Eclipse will automatically print a report at the 
end of a data collection. 

See also: 
Print Preview 
Report page  
Edit Report 
Kinetics Application
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Performing Calculations—Kinetics—Kinetics 
Recalculate
How to perform post run calculations on previously stored data
How to generate a report from previously stored data
How to use advanced reporting options
Analyze
Rate Calculations
Maths Calculator
Maths Operations
Maths How To
User Data Form

Recalculate—Kinetics 
Use the pages accessible from the Recalculate option to perform re-calculations on data that has been 
analyzed. These re-calculations can be made using new Setup parameters. For example you may wish to 
change the order of a reaction. You can also use the Recalculate button to access Report options. 

When you select this option, the Setup dialog will appear, containing the following tabbed pages:  

Analyze
Reports

How to perform post run calculations on previously stored data—
Kinetics 

Retrieve the data
Set up the recalculation
Print the report

Retrieve the data  

Step 1 

From the File menu, select Open to display the Windows Open dialog.  

Step 2 

A list of previously stored Batch files will appear. Select the Batch file you require then select Open.  

The system will automatically retrieve the collected data into the Graphics area. The method that was used to 
collect the data will also be retrieved. 

To access the Recalculate option, select the Recalculate button from the Kinetics Application 
window.

See also:
Kinetics Application

Note 
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Set up the recalculation  

Step 3 

Select the Recalculate button to display the Setup dialog. The Analyze and Reports pages will be displayed 
to enable you to set up the recalculation parameters. 

Step 4 

Select the Analyze tab to access the Analyze page where you can set the analysis parameters you require. 

For example, select the Auto Calculate option to automatically perform a rate calculation on collected data at 
the end of each run. 

Step 5 

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

Step 6 

Select OK to clear the Setup dialog and start the recalculations. The results will be displayed in the Report 
area. 

Print the report  

Step 7  

a. From the File menu, select Print. The Windows Print dialog is displayed.

b. Set up your printing parameters and select OK to print your report.

You can also retrieve data from Data (*.FDKN), Method (*FMKN) and Spreadsheet ASCII (*.CSV) file 
types.

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as well 
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report area 
and can be viewed by selecting the Report command from the View menu.

See also:
How to generate a report from previously collected data
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How to generate a report from previously stored data—Kinetics 
Step 1 

Select Open… from the File menu to display the Windows Open dialog.  

Step 2 

A list of previously stored files will appear. If this is not a list of batch files, select the down arrow at the right 
of the Files of type list box and select 'Batch' to list all the batch files.  

Step 3 

Select the Batch file you require then select Open.  

The system will automatically retrieve the collected data into the Graphics area. The method that was used to 
collect the data will also be retrieved. 

Step 4 

Select the Recalculate button to display the Setup dialog. 

Step 5 

Select the Reports tab and on the Reports page specify the information you would like to include in the report. 
Select Auto Print if you require the new report to print to the Reports area and to a printer. 

Step 6 

Click OK to display the results in the Report area (and send to the printer if Auto Print is selected). 

Maths window 
Calculation Field | Selected/Focused Trace | Trace | Display Options | Functions

Use the Maths window to perform mathematical manipulations on collected traces. In addition, it can act as a 
simple numeric calculator. 

Note 
You can also retrieve data from Methods (*.FMKN), Data (*.FDKN), Report (*.FRKN), Spreadsheet 
ASCII (*.CSV), GRAMS (*.SPC) and Rich Text Format (*.RTF) file types.

Note 
If you require a printout of only the current graphics in the Graphics area of a previously stored data file: 

a. Select the Clear Report option in the Commands menu to clear any text that may be displayed in
the Report area.

b. Press the Print button to obtain a printout of the graphics.

Alternatively tick only the Graph check box in the Reports page to obtain a printout of graphics only. 

See also: 
How to use advanced reporting options
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The Maths window comprises the following: 

To access the Maths window, select the Calculator command from the Graph menu, or select the 
Calculator button on the Graphics toolbar. 
The Maths window is only available in the Kinetics, Lifetimes, Scan and Validate applications.

Calculation 
display field 

View the current calculation, including the trace/s being used, the trace operation being 
carried out and any functions that have been applied to the trace. 

Hot Tip 
Click on the down arrow adjacent to this field to view the last ten unique calculations 
that have taken place. Use this list to keep track of previous manipulations and repeat 
calculations quickly by simply selecting and then applying the desired calculation.

Selected 
Trace/Focused 
Trace 

Choosing either of these options selects the highlighted (red) trace in the current Graph box 
for manipulation. When choosing between these options, use this simple rule: 

Use the Selected Trace option when the selected calculation is only to be applied to
one trace.
Use the Focused Trace option when the same calculation is to be applied to a number
of traces.

The following example illustrates the difference between these options. 

To perform the same manipulation on several traces:  

a. Highlight a trace by clicking on it with the mouse. The trace will become red.
b. Select Selected Trace, Apply and then = to plot the result of the calculation
c. Highlight the next trace and repeat step b.

OR  

a. Highlight the first trace.
b. Select Focused Trace, Apply and then = to plot the result of the calculation;
c. Highlight the next trace and select the = button to perform the same calculation on the

newly selected trace.
Trace Use the Trace group options to select the operation to be performed on the traces, the filter 

size and the interval (where applicable). 
Click Apply to insert the selected operation into the equation 
Click = (equals) to display the result of the calculations. 

Operation 
Click on an operation to find out more about it 

Anisotropy
Polarization
Sum Function
Mean
Boxcar Averaging
Moving Average
Savitzky-Golay
Spline
Deriv 1
Deriv 2
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Deriv 3
Deriv 4

Display 
Options 

Select whether the results of the operation performed on the trace will be viewed in a New 
Graph box or in the Selected Graph box. If you choose the Selected Graph option, you will 
be able to directly compare the results with existing traces.

Functions This group contains number and function buttons that can be used as a standard calculator in 
addition to being applied to traces. 

To use the functions: 

1. select a trace or value
2. select either a second trace or number
3. select the equals (=) button to display the result

All the basic mathematical functions are available (addition, subtraction, multiplication and 
division), as well as logarithm (Log) and square root (Sqrt) functions. When used as a 
calculator, the results of equations appear in the Report area. 

Additional 
buttons 

C 
Click C to clear the entire operation in the calculation display field. 
CE 
Click CE to clear the last entry entered in the calculation display field. 
= 
Click = (equals) to start the operation shown in the calculation display field.

See also: 
Maths Home Page 
Maths How To

Maths Operations 

The following operations can be selected on the Maths window. To access the Maths window, select 
the Calculator command from the Graph menu, or select the Calculator button on the Graphics 
toolbar.

Anisotropy, 
Polarization 
and Sum 
Function 

The term Anisotropy refers to an unequal angular distribution about a point in space. 
Anisotropy also refers specifically to a simple expression for measuring the degree of 
polarization of the fluorescence.  It is almost identical to the expression for polarization apart 
from having a factor of two in the denominator.  Anisotropy is usually represented by the 
lowercase letter " r ", while polarization by an uppercase  " P ". 

The two expressions are listed below: 

Anisotropy 
r = (Ivv - GIvh) / (Ivv + 2GIvh) 

Polarisation 
P = (Ivv - GIvh) / (Ivv + GIvh) 

where 

Ivv equals the intensity of fluorescence with excitation polarizer = vertical, emission 
polarizer = vertical 
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Ivh equals the intensity of fluorescence with excitation polarizer = vertical, emission 
polarizer = horizontal 

G is a factor that accounts for the polarization bias of the instrument. In particular it accounts 
for the wavelength-dependent polarization bias of the emission side of the instrument 
(dominated by the polarization bias of the emission grating). 

The G factor is given by:  
G = Ihv/Ihh 

where 

Ihv equals the intensity of fluorescence with excitation polarizer = horizontal, emission 
polarizer = vertical 

Ihh equals the intensity of fluorescence with excitation polarizer = horizontal, emission 
polarizer = horizontal 

The expression for the anisotropy is a quotient.  The denominator of the expression, as given 
by Ivv + 2GIvh is the ‘sum’ function, and actually represents the total emission unbiased by 
any sample polarization effects. 

Mean The Mean operation allows the average of two or more traces to be taken and the resulting 
trace to be plotted. The mean of the traces can also be used in conjunction with other 
functions. 

The equation used in mean calculations is: 

(scan 1 + scan 2...+ scan x)/x 

The calculation is performed over the common X range of the traces and the trace with the 
most dense data is used to determine the data points. The other traces are interpolated at the 
relevant data points. 

Boxcar 
Averaging 

This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 

For example, for the following: 

 The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x8, sum(y6:y10)/5) ….. 
(xn-2, sum(yn-4:yn)/5). 

If there are not enough points at the end of the data set to complete the filter size, then these 
points will be ignored, hence, the gap at the end may be larger than the gap in the beginning. 
There will be a gap before the first point and after the last point of the smoothed continuum, 
with respect to the original unsmoothed data. This algorithm is only valid for evenly x-
spaced data points.  

Within a time scan, (e.g., Advanced collect in kinetics) the data points may be unevenly 
spaced between different stages.  Each stage will be treated as a new collect, hence, there 
may be large gaps between stages.  If there are not enough points at the end of a stage to 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5
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complete the filter size, then these points are ignored, hence, there may be large gaps at the 
end of a stage.  The filter size will be limited to odd numbers, with the minimum of 3 to a 
maximum of 101. 

Moving 
Average 

This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 

For example, for the following: 

The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x4, sum(y2:y6)/5) ….. 
(xn-2, sum(yn-4:yn)/5). There will be a gap before the first point and after the last point of 
the smoothed continuum, with respect to the original unsmoothed data. This algorithm is 
only valid for evenly x-spaced data points. Within a time scan, (e.gg, Advanced collect in 
kinetics), the data points may be unevenly spaced between different stages. This will be 
treated by interpolation of data from the previous stage so as to give evenly spaced data 
points into the next stage. If there is not enough data for interpolation, then the next stage 
will be treated as a new collect, hence, there may be gaps and further delays in displaying the 
point. The filter size will be limited to odd numbers, with the minimum of 3 to a maximum 
of 101. 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5

Savitzky-
Golay 

The Savitzky-Golay technique operation enables  you to reduce the noise in the currently 
selected Maths scan by using smoothing. 

When you select this operation you will be prompted to enter a Filter Size from 5 to 101. The 
larger the Filter Size, the more data points that will be smoothed. 

You will also need to enter an Interval. The Interval refers to how many of the averaged 
points will be plotted on the smoothed trace. The smaller the interval, the more detail there 
will be in the trace. 

Consider selecting an Interval of 1. This would mean that when the smoothed continuum is 
plotted, every smoothed point will be displayed. 

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an even
number.

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select Smooth in the Operation field.

Spline 
Deriv 1–4 The Deriv operations allow you to obtain derivatives of a selected scan. The derivative can 

be of the orders 1 to 4. The resulting trace is then plotted.  The Savitzky-Golay technique is 
used for derivative calculations. 

On selection of the Deriv operation you will be prompted to enter a Filter Size from 5 to 101. 
The Filter Size refers to the number of points around a particular point that will be averaged 
to produce a new derived Y value. The lower the Filter Size, the more data points that will be 
used in the derivative trace. 

Q. I cannot enter a particular value; it keeps changing to another number — why?
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Maths How To… 
How to perform a spectral subtraction
How to perform a mean calculation
How to smooth a trace
How to derive a trace

User Data Form—Kinetics 
Use the User Data Form to enter extra information about the traces in the highlighted graph box. For example, 
you might want to record information about the experimental conditions you used to collect the data. 

The dialog comprises the following: 

Displaying data graphically—Kinetics 
Graphics area
Graphics How To
Graph menu
Graphics toolbar

You will also need to enter an Interval. The Interval refers to how many of the derived points 
will be plotted on the resulting trace. The smaller the Interval, the more detail there will be in 
the trace. 

A. The Savitzky-Golay technique requires an odd number to be entered, not an even
number.

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select one of the ‘Derivs’ in the Operation field.

See also: 
About smoothing

See also:
Maths Home Page

To access the User Data Form, select the User Data Form command from the Graph menu, or select 
the User Data Form button on the Graphics toolbar. The User Data Form command is only available 
if you have selected a graph box.

Data Name This column lists the names of each visible trace in the highlighted graph box. 

Use the extra columns for recording additional information about the experimental conditions 
you used to collect the data, eg. pH. 

Other 
Columns 

Use this to record the name of the parameter in which you are interested as a column 
heading, (for example, pH, ionic concentration, substrate concentration etc.). 

Note 
You must enter a column heading, or else the data in that column will not be saved.

See also: 
Graph menu  
Graphics toolbar
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Graph Labels
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label
Graph Pictures
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture
Trace Preferences dialog
Trace Preferences menu
How to select the focused trace
How to display a trace
How to remove a trace from a graph
How to remove a trace from the trace list
Graph Preferences dialog
How to alter the look of your graphs
Cursor Modes dialog
How to track the focused trace
Axes Scales dialog
How to scale your graph manually
How to scale your graph automatically
Single/Multi Graph
User Data Form
Graphics Templates
How to create a graphics template
Kinetics Ruler
How to use the kinetics ruler

The Graphics area of the Kinetics application appears in the top half of the Kinetics Application window and is 
used to display traces of collected data. In the Cary Eclipse system, the term 'graph' refers to the plotting area 
and is represented by a set of axes. The rectangular area surrounding the graph is referred to as the graph box. 
A graph will appear in the Graphics area when you select Start to commence a Kinetics run. 

To display or hide the Graphics area, select the Graphics command on the View menu. Double-clicking on the 
Graphics area enables you to toggle between half or full size display sizes. 

You can access the functions associated with the Graphics area by doing the following:  

selecting one of the Graphics toolbar buttons;
selecting a command from the Graph menu; or
clicking the right mouse button in the Graphics area and select a command from the menu

Graphics area—Kinetics 

Note 
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You can customize the graphics area to suit your requirements in the following ways: 

Not all functions are available on every menu.

Note 
All of the commands and dialogs listed are accessible from the Graph menu. 

To… Use the… Tell me how…

Change the axes scaling 
automatically

Autoscale graph command How to scale your graph 
automatically

Change the axes scaling manually Axes Scales dialog How to scale your graph manually

Modify the graph appearance (axes, 
trace)

Graph Preferences dialog How to alter the look of your graphs 

How to specify the number of tick 
marks and decimal places for your 
X and Y axes 

Add a new graph to the display Add graph command

Remove a graph from the display Remove graph command How to remove graphs 

View single or multiple graphs Single/multiple graph 
command

Resize a graph box Cursor How to resize graph boxes

Track the focused trace Cursor Mode dialog How to track the focused trace 

Select the focused trace Cursor How to select the focused trace

Display a trace in the graph Trace Preferences dialog How to display a trace that is not 
appearing in a graph box

Remove a trace from a graph Trace Preferences dialog How to remove a trace from a graph

Remove a trace from the trace list Trace Preferences dialog How to remove a trace from the 
trace List

Zoom in and out on the graph Zoom In and Zoom Out 
commands

How to zoom a graph

Add a label to the graph box Add Label dialog How to add a label to a graph

Edit labels in the graph box Edit Label dialog How to edit a label

Moving labels in the graph box Cursor How to move a label

Resizing labels in the graph box Cursor How to resize a label

Delete labels from the graph box Delete Annotation command How to delete a label

Add a picture to the graph box Add Picture dialog How to add a picture to a graph
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Graphics How to—Kinetics 

Traces  

How to track the focused trace
How to select the focused trace
How to display a trace that is not appearing in a graph box
How to remove a trace from a graph
How to remove a trace from the trace List

Sizing and scale  

How to resize graph boxes
How to scale your graph manually
How to scale your graph automatically
How to alter the look of your graphs
How to zoom a graph

Labels  

How to add a label to a graph
How to edit a label
How to delete a label
How to move a label

Pictures  

How to add a picture to a graph
How to move a picture
How to delete a picture
How to replace a picture

Move pictures in the graph box Cursor How to move a picture

Resizing pictures in the graph box Cursor How to resize a picture

Replace pictures in the graph box Edit Picture dialog How to replace a picture

Delete pictures from the graph box Delete annotation command How to delete a picture

Save the Graphics area you have set 
up as a graphics template

Save As dialog (from the File 
menu)

How to create a graphics template

Note 
The red trace in any graph box is the one on which all information appears and the one used for the cursor 
tracking. It is called the focused trace. 

See also: 
Toolbar 
Graphics How To

Graph menu—Kinetics 
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Introduction 

Use the Graph menu to view data in various graphical formats or in multiple graphs in the Graphics area. You 
can double-click on the Graphics area to toggle the display through graph and report to graph only.  

In the Cary Eclipse system, the term 'graph' refers to the plotting area and is represented by a set of axes. The 
rectangular area surrounding the graph is referred to as the graph box. A graph will appear in the Graphics area 
when you select Start to commence a Kinetics run. 

The Graph menu can be accessed in the following ways:  

from the main menu at the top of the Kinetics Application window
by clicking the right mouse button in a graph box or the Graphics area

Menu commands 

The following commands can be accessed from the Graph menu: 

Note 
The red trace in any graph box is the one on which all information appears and the one used for the cursor 
tracking. It is called the focused trace.

Menu 
command 

Button Enables you to…

Print XY 
point 

Select this to print the cursor's current X and Y coordinates in the report area. 
Note: 
This option is only available from the Graph menu that appears when you 
right-click in a graph box.

Copy Graph Select Copy Graph to copy the entire Graphics area to the Windows Clipboard. All 
of the graphs in the Graphics area will be copied to the Clipboard.

Paste to 
Graph 

Select Paste to Graph to paste the contents of the Windows Clipboard into the 
Graphics area. Text is pasted as a label, graphics are pasted as pictures.

Add Graph  Select Add Graph to add a new graph box to the Graphics area. You may want to do 
this if you have, for example, a graph containing existing data and you want to 
collect some new data in a new graph.

Remove 
Graph  

Select Remove Graph to delete the selected graph box from the Graphics area. The 
graph box is removed, but the data is not deleted and is still available from the Trace 
Preferences window. 
You may want to use remove graph if you have a large number of graph boxes open 
but only want to focus on some of these. 

Note: 
You can remove multiple graph boxes by first holding down the CTRL key and 
selecting the graphs to be removed and then selecting the Remove Graph 
button or menu item. Use the SHIFT key to highlight a range of graphs for 
removal.

Clear All 
Traces 

Select Clear All Traces to delete all traces from the graph/s. Note that selecting this 
option simply turns off the Visible property for the traces in the Trace Preferences 
window. You can redisplay the traces by making the traces Visible again in the 
Trace Preferences window.
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Add Label  Select Add Label to display the Add Label dialog where you can enter a text label 
to be placed on a graph or in the background of the Graphics area. 

Add Picture Select Add Picture to display the Add Picture dialog where you can select a picture, 
bitmap or chemical structure to be placed on a graph or in the background of the 
Graphics area. 

Edit 
Annotation 

Select Edit Annotation to alter the content or look of the selected annotation, (either 
a label or a picture) in the Graphics area. 

If the selected annotation is a label, selecting Edit Annotation will open the Edit 
Label dialog where you can change the text of the selected label. 
If the selected annotation is a picture, selecting Edit Annotation will open the Edit 
Picture dialog where you can replace the selected picture with a new picture. 

Note: 
This option can only be activated if an annotation is selected.

Delete 
Annotation  

Select Delete Annotation to remove an annotation, (such as a label or a picture) 
from the Graphics area. 
You can use this menu option to remove highlighted annotations in the Graphics area 
such as labels, pictures and ruler/fit information. 

Note: 
This option can only be activated if an annotation is selected.

Trace 
Preferences 

Select this command to display the Trace Preferences dialog where you can select 
the trace(s) to display in the selected graph.

Graph 
Preferences 

Select this command to display the Graph Preferences dialog where you can change 
the appearance of your graph. Any changes you make to the appearance of the graph 
will be applied to all graphs.

Cursor 
Mode… 

Select this command to display the Cursor Modes dialog where you can choose the 
type of cursor to be used on the screen. For example, you can select to use a free 
cursor that can move anywhere in the graph or exactly trace the focused scan (red 
scan).  Alternatively, you can select a cursor that enables you to draw a line from one 
point to another to determine the slope using either the Least Squares method or the 
Point to Point method.

Axes 
Scales…  

Select this command to display the Axes Scales dialog where you can set the scale 
range for the X and Y axes.

Auto scale 
graph 

To automatically scale the graph, point to one of the following options: 

Autoscale[XY] 
Select Autoscale[XY] to automatically scale collected data by scaling the Y height 
and X width to full screen. 

Autoscale[X] 
Select Autoscale[X] to automatically scale collected data by scaling the X width to 
full screen. 

Autoscale[Y] 
Select Autoscale[Y] to automatically scale collected data by scaling the Y height to 
full screen. 

Zoom Out Select Zoom Out to Zoom back to the original X and Y ranges which were used to 
collect the data (i.e. the method setup conditions of the focused scan).  
For example, the system will revert back to the X and Y ranges set in the method if 
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Graphics Toolbar—Kinetics 
Use the Graphics toolbar buttons to gain quick access to many of the Graph menu options. You can also use 
the toolbar to select the graph you want to view and to change the look of your graphs. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Graphics. To display 
or hide the toolbar's text labels, point to the Toolbars option in the View menu and select Text Labels. 

The following commands can be accessed from the Graphics toolbar: 

you zoom in and out during a data collection.
Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note: 
The graph highlighted in the Multi Graph view will be displayed when you 
toggle the Single Graph option.

Auto 
Arrange 
Graphs 

Select Auto Arrange Graphs to view and arrange all graphs simultaneously. 
Note: 
You can move graph boxes manually by clicking the left mouse button outside 
the graph axes and dragging the graph box to a new position. You can also 
resize graphs.

User Data 
Form  

Select User Data Form to display the User Data Form where you can enter extra 
information about the traces in the highlighted graph box. For example, you might 
want to record information about the experimental conditions you used to collect the 
data, such as the pH at which data was collected.

Calculator Select Calculator to display the Maths window where you can perform 
mathematical manipulations on collected traces. In addition, it can act as a simple 
numeric calculator.

History List This displays a list of the current graphs. 

See also: 
Add Label   
Add Picture   
Edit Label   
Edit Picture    
Trace Preferences  
Graph Preferences  
Cursor Modes   
Axes Scales   
Single/Multi Graph   
User Data Form   
Maths   
Graphics toolbar 
Graphics area

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to…
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Trace 
Preferences  

Click this button to display the Trace Preferences window where you can select the 
trace(s) to display in the selected graph.

Graph 
Preferences 

Click this button to display the Graph Preferences dialog where you can change the 
appearance of your graph. Any changes you make to the appearance of the graph 
will be applied to all graphs.

Cursor 
Mode 

Click this button to display the Cursor Modes dialog where you can choose the type 
of cursor to be used on the screen. For example, you can select to use a free cursor 
that can move anywhere in the graph or exactly trace the focused scan (red scan).  
Alternatively, you can select a cursor that enables you to draw a line from one point 
to another to determine the slope using either the Least Squares method or the Point 
to Point method.

Axes 
Scales…  

Click this button to display the Axes Scales dialog where you can set the scale range 
for the X and Y axes.

Autoscale
[XY] 

Click the Autoscale[XY] button to automatically scale collected data by scaling the 
Y height and X width to full screen.

Autoscale
[X] 

Click the Autoscale[X] button to automatically scale collected data by scaling the X 
width to full screen.

Autoscale
[Y] 

Click the Autoscale[Y] button to automatically scale collected data by scaling the Y 
height to full screen.

Zoom Out Click the Zoom Out button to Zoom back to the original X and Y ranges which 
were used to collect the data (i.e. the method setup conditions of the focused scan).  
For example, the system will revert back to the X and Y ranges set in the method if 
you zoom in and out during a data collection.

Add Label  Click this button to display the Add Label dialog where you can enter a text label to 
be placed on a graph or in the background of the Graphics area. 

Add Picture  Click this button to display the Add Picture dialog where you can select a picture, 
bitmap or chemical structure to be placed on a graph or in the background of the 
Graphics area.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note: 
The graph highlighted in the Multi Graph view will be displayed when you 
toggle the Single Graph option.

Auto 
Arrange 
Graphs 

Click the Auto Arrange Graphs button to view and arrange all graphs 
simultaneously. 

Note: 
You can move graph boxes manually by clicking the left mouse button outside 
the graph axes and dragging the graph box to a new position. You can also 
resize graphs.

Add Graph Click this button to add a new graph box to the Graphics area. You may want to do 
this if you have, for example, a graph containing existing data and you want to 
collect some new data in a new graph.

Remove 
Graph 

Click this button to delete the selected graph box from the Graphics area. The graph 
box is removed, but the data is not deleted and is still available from the Trace 
Preferences window. 
You may want to use remove graph if you have a large number of graph boxes open 
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Graph Labels—Kinetics 
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label

Use the Add Label dialog to place a label on your graph or into the background of the Graphics area.  

To add a label to a graph box, you must have at least one trace Visible in the graph box. (You can select which 
traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple graphs, the label 

but only want to focus on some of these. 
Note: 
You can remove multiple graph boxes by first holding down the CTRL key 
and selecting the graphs to be removed and then selecting the Remove Graph 
button or menu item. Use the SHIFT key to highlight a range of graphs for 
removal.

Clear All 
Graphs 

Click this button to delete all traces from the graph/s. Note that selecting this option 
simply turns off the Visible property for the traces in the Trace Preferences 
window. You can redisplay the traces by making the traces Visible again in the 
Trace Preferences window.

User Data 
Form 

Click this button to display the User Data Form where you can enter extra 
information about the traces in the highlighted graph box. For example, you might 
want to record information about the experimental conditions you used to collect the 
data, such as the pH at which data was collected.

Calculator Click this button to display the Maths window where you can perform mathematical 
manipulations on collected traces. In addition, it can act as a simple numeric 
calculator.

See also: 
Add Label   
Add Picture   
Edit Label   
Edit Picture    
Trace Preferences  
Graph Preferences  
Cursor Modes   
Axes Scales   
Single/Multi Graph   
User Data Form   
Maths  
Graphics area 
Graph menu 
Graphics How to

Add Label—Kinetics 
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will be placed in the graph box that is currently selected. However, you can add a label outside of a graph box 
in the background of the Graphics area at any time. 

The Add Label dialog comprises the following: 

Use the Edit Label dialog to alter the content or look of your label. 

To access the Edit Label dialog, right-click on the label you wish to change and select Edit Annotation from 

Q. Can I add a label that will print with all my graphs.
A. Yes, you can add your label to the background of the Graphics area. To do this, right-click on a section
of the background (gray area) and select Add Label from the menu. (You will notice that this menu has
less options than the menu that appears when you right-click on a graph.) In the Add Label dialog, enter
the label to be added to all graphs and select OK. The label will appear in the background of the Graphics
area.

To access the Add Label dialog, select the Add Label command from the Graph menu, or select the 
Add Label button on the Graphics toolbar.

To selected 
trace

Select this option to associate a label with the selected trace. When you associate a label with 
a trace and make the trace visible in the Graph box, the label will also be displayed with the 
trace.

To selected 
graph

Select this option to associate the label with the selected graph. When you associate a label 
with a graph, the label will always be displayed in the Graph box, regardless of what traces 
are visible.

Selected trace This will identify the trace that is currently selected and display the name of the trace.
Font… Click Font to open the Windows Font dialog. In this dialog you can specify the font type, 

style and size to be used for the label.
Label Use the Label field to enter the text for the label. You can enter as many lines of text as you 

require.
Hot Tip 
If you wish to include certain XY co-ordinates on the graph as a label, position your cursor at the 
appropriate place, right-click and select Add Label from the menu. When the Add Label dialog appears, 
the co-ordinate positions will be added to the Label field. 
Note 
When you save the data (as a Batch or Data file) the label is saved with its associated trace or graph. 
Labels outside graph boxes can be saved in a graphics template. To do this, choose Graph Template as 
the Save As type in the Save As dialog. 
See Example of a Graphics Template 

See also: 
Trace Preferences dialog  
Graph menu  
Graphics toolbar  
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label  
How to delete a label

Edit Label—Kinetics 
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the menu. 

The dialog comprises the following: 

How to add a label to a graph—Kinetics 
You can add a label to your graph or Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area background. 

Step 2 

Click the Add Label button on the toolbar or right-click on the graph and select Add Label from the menu. 
The Add Label dialog will appear. 
The Add Label command is also accessible from the Graph menu. 

Step 3 

Click the Font button. The Windows Font dialog appears. Select the font type, size and style you require for 
your label. A sample of the font style appears in the Sample field. When you are satisfied with your selections, 
select OK to return to the Add Label dialog. 

Step 4 

Enter the label in the Label field and select OK. The label will be displayed on the selected graph. If 
necessary, you can move a label so that it is more appropriately placed on your graph. 

How to edit a label—Kinetics 
Step 1  

Place the cursor on the label and click the left mouse button to select the label.

Font Select Font to open the Font dialog, where you can specify the font type, style and size to be 
used for the label.

Label Use the Label field to alter the text for the label. 

See also: 
How to edit a label 
How to add a label to a graph 
How to resize a label 
How to move a label

Note 
There must be at least one trace Visible in the graph box before you can add a label to it.

See also: 
Graphics Area 
How to move a label 
How to edit a label  
How to resize a label
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Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu. Alternatively you can 
select the Edit Annotation command from the Graph menu. The Edit Label dialog is displayed. 

Step 3  

Use the Edit Label dialog to change the label. 

For example, if you want to change the font size of the label, select the Font button. In the Size field, scroll 
through the available sizes for the font and select the size you require. Alternatively, highlight the currently 
selected size in the Size entry field and enter the size you require. Click the OK button in this dialog to return 
to the Edit Label dialog. 

Step 4  

Click OK to clear the Edit Label dialog. Your label will appear with the new font size. 

How to move a label—Kinetics 
To move a label so that it is more appropriately placed on your graph or Graphics area background, do the 
following: 

Step 1  

Place the cursor on the label. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the label to the correct position and release the mouse button. The label will be displayed at the new 
position. 

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label selection. 
Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label  
How to resize a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 
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How to resize a label—Kinetics 
To resize a label so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the label by clicking on it with the mouse. A border will be displayed around the label to indicate it is 
selected. 

Step 2  

Position the cursor over one of the corner edges of the label until the cursor becomes a diagonal double-headed 
arrow. Click and hold down the left mouse button. 

Example of label showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the label by dragging the mouse. The label text will also be resized. Release the 
mouse button when the label and text are the correct size. 

How to delete a label—Kinetics 
To delete a label from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the label and click the left mouse button to select it. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label  
How to resize a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label

Hot Tip 
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Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The label will be 
deleted from the graph or Graphics area. 

Graph Pictures—Kinetics 
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture

Use the Add Picture dialog to insert a picture or bitmap into the Graphics area. The picture can be added as a 
background picture or to a particular graph box. 

To add a picture to a graph box you must have at least one trace Visible in the graph box. (You can select 
which traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple graphs, 
the picture will be placed in the graph box that is currently selected. However, you can add a picture outside of 
a graph box in the Graphics area at any time. 

The Add Picture dialog comprises the following commands: 

If you are having trouble selecting the label it may be that a trace is interfering with the label selection. 
Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label

Add Picture—Kinetics 

Q. Can I add a picture that will print with all my graphs.
A. Yes, you can add your picture to the background of the Graphics area. To do this, right-click on a
section of the background and select Add Picture from the menu. (You will notice that this menu has less
options than the menu that appears when you right-click on a graph.) In the Add Picture dialog, load the
picture to be added to all graphs and select OK. The picture will appear in the background of the
Graphics area.

To access the Add Picture dialog, select the Add Picture command from the Graph menu, or select 
the Add Picture button on the Graphics toolbar.

To selected 
trace

Select this option to associate a picture with the selected trace. When you associate a picture 
with a trace and make the trace visible in the Graph box, the label will also be displayed with 
the trace.
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Use the Edit Picture dialog to change a picture you have inserted into the Graphics area.  

To access the Edit Picture dialog, right-click on the picture you wish to change and select Edit Annotation 
from the menu. 

The Edit Picture dialog comprises the following commands: 

How to add a picture to a graph—Kinetics 
You can add a picture to your graph or the Graphics area background. To do this: 

Step 1 

To selected 
graph

Select this option to associate the picture with the selected graph. When you associate a 
picture with a graph, the label will always be displayed in the Graph box, regardless of what 
traces are visible.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer for 
the picture you want to insert. The picture must be one of the following formats: DIB, JPG, 
JPEG, BMP, EMF or WMF. 

If you are viewing multiple graphs the picture will be placed on the graph that is currently 
selected. If no graph is selected, the picture will be placed on the Graphics area background. 

Note 
When you save the data (as a Batch or Data file) the label is saved with its associated trace or graph. 
Labels outside graph boxes can be saved in a graphics template. To do this, choose Graph Template as 
the Save As type in the Save As dialog. 
See 'Example of a Graphics Template'. 

See also: 
Trace Preferences  
Graph menu  
Graphics toolbar 
How to add a picture to a graph 
How to move a picture 
How to delete a picture 
How to resize a picture 
How to replace a picture

Edit Picture—Kinetics 

To selected 
trace/ graph

Displays whether you originally selected to add the picture to a trace or a graph. This option 
is not editable.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer for 
the picture you want to insert. The selected picture will replace the current picture. The 
picture must be one of the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

See also: 
How to replace a picture 
How to add a picture 
How to move a picture  
How to resize a picture 
How to delete a picture
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Click on the graph box you require or click outside the graph box(es) to choose the Graphics area background. 

Step 2 

Click the Add Picture button on the toolbar or right-click on the graph and select Add Picture from the menu. 
The Add Picture dialog will appear. 
The Add Picture command is also accessible from the Graph menu. 

Step 3 

Click the Load button. The Windows Open dialog appears. 

Step 4 

Browse through your directories to find the picture you want to insert. All pictures must be in the bitmap 
format and will have the extension .BMP. 

Step 5 

Highlight the .BMP that you want to insert and select Open. 

Step 6 

The Add Picture dialog will appear showing a preview of the bitmap. If the bitmap is the correct one select the 
OK button. The bitmap will be placed onto the graph. 

You can move a picture so that it is more appropriately placed on your graph. 

How to replace a picture—Kinetics 
To change a picture that you have added to a graph or Graphics area background do the following: 

Step 1  

Move the cursor to the picture and select the left mouse button to select it. 

Note 
There must be at least one trace Visible in the graph box before you can add a picture to it.

Note 
You should take care not to add a bitmap that is too big as it will obscure part or all of your graph.

See also: 
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.
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Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu or select Edit Annotation 
from the Graph menu. The Edit Picture dialog is displayed. 

Step 3  

From the Edit Picture dialog, select the Load button. The Windows Open dialog is displayed. 

Step 4  

Browse through your directories to find the picture to replace the current bitmap. Picture files must be in one of 
the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

Step 5  

Highlight the file that you want to insert and select Open to return to the Edit Picture dialog. 

Step 6  

The Edit Picture dialog will display a preview of the bitmap. If the bitmap is the correct one select the OK 
button. The bitmap will be placed onto the graph. If you need to, move the picture so that it is more 
appropriately placed on your graph. 

How to move a picture—Kinetics 
To move a picture so that it is more appropriately placed on your graph or Graphics area background, do the 
following: 

Step 1  

Place the cursor on the picture. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the picture to the correct position and release the mouse button. The picture will be displayed at the new 

Note 
Do not to add a bitmap that is too big as it will obscure part or all of your graph. 

See also: 
How to add a picture to a graph 
How to move a picture 
How to delete a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Page 84 of 124Kinetics Home Page

   



position. 

How to resize a picture—Kinetics 
To resize a picture so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the picture by clicking on it with the mouse. A border will be displayed around the picture to indicate it 
is selected. 

Step 2  

Position the cursor over one of the corner edges of the picture until the cursor becomes a diagonal double-
headed arrow. Click and hold down the left mouse button. 

Example of picture showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the picture by dragging the mouse. The picture will also be resized. Release the 
mouse button when the picture is the correct size. 

How to delete a picture—Kinetics 
To delete a picture from a graph or Graphics area background, do the following: 

Step 1  

See also: 
How to add a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph  
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture
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Position the cursor on the picture and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The picture will be 
deleted from the graph or Graphics area. 

Trace Preferences table | Trace Audit Log 

A single graph box can display many traces. This window enables you to select the trace(s) to display (make 
Visible) in the selected graph box.  

The dialog comprises the following: 

Trace Preferences table 

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to move a picture 
How to zoom a graph  
How to resize a picture

Trace Preferences—Kinetics 

To access the Trace Preferences dialog, select the Trace Preferences command from the Graph 
menu, or select the Trace Preferences button on the Graphics toolbar.

Hot Tip 
The Trace Preferences menu is also available on clicking the right mouse button anywhere in the trace 
listing.

Visible Use the Visible field to select which traces will appear on the selected graph. To select or 
clear the Visible field, simply click the left mouse button in this column. A tick will appear 
next to traces that are to be displayed in the selected graph. 

If you are in single graph view, all selected traces will appear on the one graph. If you are in 
Multi Graph view the traces will appear on the graph that is currently selected.  

Hot Tip 
To make all traces Visible, right-click on the table and select the Select All command 
from the menu. Then right-click on the table again and select the Show Traces 
command from the menu.

Color The Color field enables you to view the color of each trace that appears on the selected 
graph.  To change the color of a trace, highlight it, click the right mouse button in the Trace 
Preferences table and select Change Trace Color. You can then select a color from the 
Color dialog that is displayed. 
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Trace Audit Log 

The Trace Audit Log displays information about the highlighted trace. This includes instrument parameters 
and data form information relating to the trace that has been selected. It also logs all information about data 
manipulation.  When more than one trace is highlighted, the Trace Audit Log will display information about 
the trace that was first selected. 

Trace Preferences menu—Kinetics 
The Trace Preferences menu is displayed when you click the right mouse anywhere on the Trace Preferences 
table. The menu contains the following commands: 

The red trace in any graph box is the one on which all information appears. This trace, which 
is used for the cursor tracking, is called the focused trace and it is always red. When you 
select a trace in the Color column it will become the focused trace in the selected graph box. 

Note 
When you change the trace line width in the Graph Preferences dialog it also will 
change the width of the color trace line in this dialog.

Name of trace The Name of Trace field contains a description of the traces currently available for display 
in the selected graph box.

Filename This field displays the filename and path for the trace. If the name is too long to appear in 
the field you can use the keyboard arrow keys to scroll to the end of the filename or you can 
resize the Trace Preferences window. If the file path for a trace shows 'not saved' then the 
trace is unsaved data and is only stored in memory.

See also: 
Graph menu 
Graphics toolbar 
Graph Preferences  
Trace Preferences menu 
How to make multiple traces visible in a graph 
How to remove a trace from the trace list 
How to remove a trace from a graph

Select All This selects or highlights all the traces in the listed on the Trace Preferences page.
Select None This de-selects all the traces in the listing.
Show Traces Select Show Traces to make all of the traces currently highlighted Visible, meaning that 

they will be displayed in the current graph box.
Hide Traces Select Hide Traces to remove the Visible property from all the traces currently highlighted, 

which will remove them from the current graph box.
Delete Traces Select Delete Traces to delete all the highlighted traces in all graphs. Note that if you save 

the data file before you select Delete Traces, the traces are not deleted from the saved file, 
and they can be retrieved at a later date. 
Selecting Delete Traces will delete the traces from the application memory, and it is 
recommended that you select this option if you need to free up memory on your computer. 
This is especially relevant for the Kinetics application where the data files can be quite large. 

Note 
If the application is controlled by the GLP Administration application, you will be 
prompted to save an unsaved data file before it is removed from the application. 
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How to select the focused trace—Kinetics 
To select the scan that you want to be the focused (red) trace, do one the following:  

From the Graph, click the left mouse button on the trace that you want to make the focused trace.

From the Graph Legend (if displayed), click the left mouse button on the trace that you want to make the
focused trace.

From the Trace Preferences dialog, click in the Color column of the trace that you want to make the
focused trace.

How to display a trace that is not appearing in the graph box—
Kinetics 
Step 1 

Click on the graph in the Graphics area. 

Step 2 

Select the Trace Preferences button  from the Graphics toolbar, or select Trace Preferences from the 
Graph menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you wish to see and select the Visible option. A tick will appear in the Visible column to 
indicate that it will now be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you want to display.

b. Click the right mouse button and select the Show Traces command from the drop-down menu. Ticks
will appear next to the selected traces to indicate that they will now be displayed.

Change Trace 
Color 

Select Change Trace Color to display the Windows Color dialog where you can change the 
color of the currently highlighted trace(s). The focused trace will remain red while it retains 
the focus, and will revert to the selected color when the focus is moved.

See also: 
Trace Preferences page 
Graph Preferences page 
How to remove a trace from the trace list 
How to remove a trace from a graph

Note
Select the Show Legend check box in the Graph Preferences dialog to display the Graph Legend.

See also:
How to track the focused trace
How to view a particular trace
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Step 4 

Press OK to clear the Trace Preferences dialog. The selected trace(s) will be displayed. 

How to remove a trace from a graph—Kinetics 
Step 1 

Select a graph in the Graphics area. 

Step 2 

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the Graph 
menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you no longer wish to see and select the Visible option. The tick will be removed from the 
Visible column to indicate that it will not be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you no longer want to display.

b. Click the right mouse button and select the Hide Traces command from the drop-down menu. The ticks
will be removed from the selected traces to indicate that they will not be displayed.

Step 4 

Select OK to clear the Trace Preferences dialog. The trace will be removed from the graph. 

How to remove a trace from the trace list—Kinetics 
If your graphs contain unwanted traces, you may wish to delete them (rather than simply making them 
invisible) in order to free up application memory and aid system performance. 

Step 1  

Select a graph in the Graphics area. 

Step 2  

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the Graph 
menu. The Trace Preferences dialog is displayed.

See also: 
How to remove a trace from a graph 
How to remove a trace from the trace list

See also: 
How to display a trace that is not appearing in the graph box 
How to remove a trace from the trace list
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Step 3  

Select the trace to be removed by clicking on it. 

Step 4  

Click the right mouse button to display the Trace Preferences menu. 

Step 5  

Select Delete Traces to delete the sample from the trace list. You will be prompted to confirm this action. 

Step 6  

Select OK to clear the Trace Preferences dialog. The trace will be removed from all graphs. 

Axes Preferences | Advanced Options | Trace Style | Show Legend 

Introduction 

Use the Graph Preferences dialog to change the appearance of your graph. 

All graphs will appear labeled with the X axis label being horizontal and the Y axis vertical. You cannot 
change the orientation of these labels. However you can alter the font and size of the axes and their labels. 

Any changes you make to the appearance of the graph will apply to all graphs until the settings are changed 
again. 

Dialog controls 

The Graph Preferences dialog comprises the following: 

Axes Preferences 

See also: 
How to remove a trace from a graph 
How to display a trace that is not appearing in the graph box

Graph Preferences—Kinetics 

To access the Graph Preferences dialog, select the Graph Preferences command from the Graph 
menu, or select the Graph Preferences button on the Graphics toolbar.

Axes Color Select the color that you want to assign to the axes of the graph/s from the drop down list.

Axes Width Select the width of the axes from the drop down list. The width, which is in pixels, ranges 
between one and five pixels.

Grid Style Select the style of grid for the graph from the drop down list. If you do not wish to include a 
grid on the graph, select None.

Plot Area 
Color

Select the color to be used as the background of the graph from the drop down list. If you do 
not want a background color on the graph, select White.
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Advanced Options 

Trace Style 

Show Legend 

Trace Width Select the width of the trace from the drop down list. The width is given in pixels and 
ranges between one and five pixels.

Font Click the Font button to display the Windows Font dialog where you can define the font 
style for the axes of the graph/s. The style and size of the font will be applied to all graph. 
The style, name and point size of the font appears on the font button.

Preview Box Preview any changes you make to the axes preferences in the preview box. The changes 
shown in this box will not be made until you select OK.

Auto tick 
marks

The Auto tick marks option enables you to approximately set how many tick marks (or 
points) will be included on the graph axes. The tick marks generated will be whole, 
rounded, even numbers. The Auto tick marks option is not available if you have selected 
Major ticks. 

Y-axis
Use the Y-axis slider bar to increase or decrease the number of tick marks (or points) to be
included on the Y axis.

X-axis
Use the X-axis slider bar to increase or decrease the number of tick marks (or points) to be
included on the X axis.

Major ticks Use the Major Ticks option to enable you to set exactly how many ticks (or points) will be 
added to the X and Y axes. The number of marks you specify will be divided by the axis 
range, which can result in odd numbers on the axis. Note that any changes are not reflected 
in the graph bitmap at the top of the screen.

Decimals Use the Decimals option to set the number of X and Y decimal places to be displayed on 
the axes. To set the number of decimal places, select the Decimal option and enter the 
number in the Y-axis and X-axis combo boxes. Note that any changes are not reflected in 
the graph bitmap at the top of the screen.

Points Select Points to display each individual data point collected by the Cary Eclipse on the 
graph.

Points and 
solid lines

Select Points and solid lines to display each individual data point collected by the Cary 
Eclipse on the graph. Additionally, an interpolated line that connects the points will be 
drawn.

Solid lines If you select Solid lines, the Cary Eclipse system will interpolate the data between the 
actual, collected data points and show the data as a continuous line.

Style cycles 
automatically

If you select Style cycles automatically, the Cary Eclipse system will display each of the 
above three trace styles. This makes it easier to differentiate between traces, especially on 
black-and-white printers.
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How to alter the look of your graphs—Kinetics 
Step 1 

Click the Graph Preferences button  on the Graphics toolbar, or select Graph Preferences from the 
Graph menu. The Graph Preferences dialog is displayed. 

Step 2 

Use the available options available to choose your preferred appearance for the graphs. A preview box in the 
top right-hand corner will demonstrate how the graphs will appear. 

Step 3 

Select OK to clear the Graph Preferences dialog and update all graphs to reflect your selections. 

Step 4 

To re-use your graphics setup at a later date, save the setup as a graphics template. 

Use the Cursor Modes dialog to choose the type of cursor to be used on screen. For example, you can select to 
use a free cursor that can move anywhere in the graph.  Alternatively, you can select a cursor that enables you 
to draw a line from one point to another to determine the slope using either the Least Squares method or the 

Show Legend Select Show Legend to display a legend in the right side of each graph box. 
A single left click on a sample name or example line within the legend will make it the 
focused or red scan. Information about the trace will be displayed below the X axis. 

Hot Tip 
Double-clicking on the legend will automatically display the Trace Preferences 
window, allowing you to view more detailed information about your trace (e.g. audit 
log, File name, etc.). 
You can also use the legend to select which trace will be the focused trace. 

See also: 
Graph menu 
Graphics toolbar 
Graphics area 
Graphics How To

Note 
You can also add labels and pictures to your graphs to alter their appearance. 

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture 
How to resize graph boxes 
How to make a graphics template

Cursor Modes—Kinetics 
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Point to Point method. 

The dialog comprises the following: 

Cursor Modes 

How to track the focused trace—Kinetics 
To track the focused (red) trace in the graph: 

Step 1  

Click the Cursor Modes button  from the Graphics toolbar, or select Cursor Mode from the Graph menu. 

To access the Cursor Modes dialog, select the Cursor Modes command from the Graph menu, or select 
the Cursor Modes button on the Graphics toolbar.

None Select this for no cursor tracking.

Free The Free cursor is not confined to a particular trace on the graph. It can move anywhere in a 
graph box, and its ‘X,Y’ position is shown in the bottom right-hand side of the Graphics 
area. You can use the Free cursor to zoom in on a particular part of a graph. 

Note 
The Free cursor moves from pixel point to pixel point in the selected graph box. 
Hence you need to be careful when positioning the cursor over a scan to obtain an 
accurate (X,Y) reading. It is recommended that you use the Track cursor mode for 
this.

Track Use the Track cursor to exactly trace the focused (red) scan in a graph box. The cursor 
position is displayed in the X and Y at the bottom right-hand side of the Graphics area. 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to 
the required position. Click the left mouse button, press ‘Alt’ on the keyboard, then 
release the mouse button.

Ruler-Least 
Squares

This uses a least-squares technique to determine the slope and thus the reaction rate between 
the start and end points. 
This kinetics ruler function can be used for measuring zero order reaction rates in kinetics 
traces. You apply the ruler after kinetics data is collected to manually select the range over 
which to calculate the reaction rate. The slope is then determined and thus the rate of 
reaction.

Ruler-Point 
to Point

This uses the slope of the line drawn between two selected points to determine the point to 
point slope and thus the reaction rate. 
This kinetics ruler function can be used for measuring zero order reaction rates in kinetics 
traces. You apply the ruler after kinetics data is collected to manually select the range over 
which to calculate the reaction rate. The slope is then determined and thus the rate of 
reaction.

See also: 
About the kinetics ruler 
How to use the kinetics ruler 
How to zoom a graph 
How to track the focused trace
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The Cursor Modes dialog will appear. 

Step 2  

Select Track and select the OK button. 

Step 3  

Place the blue tracking cursor in the graph box you require. 

Step 4  

Move the cursor left and right across the graph box to trace the focused (red) scan. The cursor coordinates 
change (in the X, Y field at the bottom left hand corner of the Graphics area) as you move along the curve. 

Use the Axes Scales dialog to manually change the axes range. This can assist in zooming in on a particular 
part of the graph. 

The dialog comprises the following: 

X Axis 

Y Axis 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the required 
position. Press 'Alt' on the keyboard, then release the mouse button. 

See also: 
How to select the focused trace 
How to view a particular trace

Axes Scales—Kinetics 

To access the Axes Scales dialog, select the Axes Scales command from the Graph menu, or select the 
Axes Scales button on the Graphics toolbar.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the X axis, in the format n1 - n2 (where n1 is the 

start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can access 
by selecting the down arrow adjacent to the Scale field.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the Y axis, in the format n1 - n2 (where n1 is the 

start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can access 
by selecting the down arrow adjacent to the Scale field.
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How to scale your graph manually—Kinetics 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

Click the Axes Scales button  on the toolbar, or select Axes Scales from the Graph menu. The Axes 
Scales dialog id displayed. 

Step 3  

Type in the new ranges for the X and Y axes in the format ‘n-n’, or choose an option for each from the drop-
down list. 

Step 4  

Select OK. The axes on the selected graph will change to reflect your chosen settings. 

How to scale your graph automatically—Kinetics 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

To autoscale the graph, select one of the following:  

Click the Autoscale XY button  on the toolbar to autoscale both X and Y axes. 

Click the Autoscale X button  on the toolbar to autoscale the X axis only.  

Click the Autoscale Y button  on the toolbar to autoscale the Y axis only.  

The focused trace will be scaled according to the option selected. 

See also: 
Graph menu  
Graphics toolbar  
How to scale your graph manually 
How to scale your graph automatically 
How to zoom a graph

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale a graph automatically
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You can use the Single/Multi Graph command to toggle between a display of either one or multiple graph 
boxes in the Graphics area.  

Example of a single graph box display 

Example of a multi graph box display 

How to make a graphics template—Kinetics 
A graphics template lets you set up and store the style of a graphics report for future use. You can do this by 

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale your graph manually

Single/Multi Graph—Kinetics 

The command is accessible from the Graph menu or by selecting the Single/Multi Graph button from 
the Graphics toolbar.

Note 
Up to 100 graphs can be displayed in the Graphics area at the one time. 

See also: 
Graph menu   
Graphics toolbar  
Graphics How To
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adding labels and pictures to the background of the Graphics area and altering any axes styles etc. One 
advantage of this over the application's built-in reporting features is that you have more flexibility as to where 
you can position graph boxes and any text that you may want to appear (e.g. operator name, batch number etc.) 
and also where you add pictures, e.g. company logos etc.  

Step 1 

Start the application and open the data file from which you want to make a graphics template. Alternatively, 
collect some new data. 

Step 2 

Make as many graph boxes as you require in your template by using the Add Graph function. 

Step 3 

Adjust the graph boxes to the correct size and position them as you want them to appear in the template. 

Step 4 

Do any of the following, if required: 

Change the appearance of the graph boxes in the Graph Preferences dialog
Use the Add Label function to append text to the Graphics area
Use the Add Picture function to add pictures, such as your company's logo to the Graphics area

Step 5 

From the File menu, select Print Preview. Use the Print Preview dialog displayed to check the template that 
you have created. 

Step 6 

When you are satisfied with the appearance of the graphics, select the Save As… command from the File 
menu. The Save As dialog is displayed. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and select 
'Graph Template' to list all the template files. Ensure that the Save only focused trace check box is cleared. 

Step 8 

Enter a name for the template in the File name field. 

Step 9 

Select OK to save the graphic template. The template will be used each time you create a new file. 

Note 
You can also make a graphic template in a similar manner from existing data. No data will be saved in the 
template. 
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The ‘ruler’ function in the Kinetics Application enables you to measure zero order reaction rates in kinetics 
traces. Use the ruler after kinetics data is collected to manually select the range over which to calculate the 
reaction rate. From this data, the slope the rate of reaction is determined. 

To access the Ruler Rate dialog, do the following: 

1. From the Graph menu select Cursor Modes. In the Cursor Modes dialog, select Ruler-Least Squares or
Ruler-Point to Point option as the cursor mode. See More Information on Least Squares and Point to
Point calculations.

2. Select a region of the trace that is relatively straight and place the cursor on the point of the trace where
you wish to start drawing the ruler. Click and hold down the left mouse button and drag the cursor to the
second point on the trace. A ruler line will draw as you move the cursor.

3. Release the mouse button. The Ruler Rate dialog is displayed.

The Ruler Rate dialog comprises the following: 

More information on Least Squares and Point to Point calculations 

Least squares slope calculation 

You can calculate the rate of a zero order reaction by manually selecting the range over which  to calculate the 
reaction rate of a kinetics plot using the ruler on a particular graph. 

A linear equation is fitted to the data using a Ruler-Least Squares technique. The slope of the line of best fit is 
reported as the kinetics rate in the Ruler Rate dialog using the previous zero order equation. 

Point to point slope calculation 

You can choose to calculate the point to point slope instead of the least squares slope value. 

The point to point slope is calculated from the slope of a line drawn between two ordinate values at two, 
specified abscissa points. 

See also: 
Example of a Graphics Template 
How to add a label to a graph  
How to add a picture to a graph  
How to move a label  
How to move a picture

Ruler Rate—Kinetics 

Slope Displays the slope of the line of best fit in the region you selected. 
X Start/ 
X Stop 

Displays the beginning and end X co-ordinates of the region you selected. 

Y Start/ 
Y Stop 

Displays the beginning and end Y co-ordinates of the region you selected. 

Retry Select Retry to re-select a region of the trace. 
Add Label Select Add Label to add a label to the graph that diplays the slope of the line you have 

selected.
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If you choose OK or Add Label in the Ruler Rate dialog then a corresponding Results table will appear in the 
Report area that includes the manually selected abscissa, ordinate range, calculated reaction rate (Slope) and 
Standard Deviation (SD). 

The SD results means that the system looks at the difference between the actual Y value and the fitted Y value 
after the linear least squares fit or point to point fit has been applied. The system takes the difference of each 
point over the selected region and calculates the SD using the following equation: 

where, 

The Factor* Slope result is also displayed. This is the product of the Factor multiplied by the calculated 
kinetics ruler slope. The Factor value (entered in the Analyze tab) also appears above the result table in the 
report. 

How to use the kinetics ruler—Kinetics 
The ‘ruler’ function can be used for measuring zero order reaction rates in kinetics traces. You can use the ruler 
after kinetics data is collected to manually select the range over which to calculate the reaction rate. The slope 
is then determined and thus the rate of reaction.

 are measured values

 are calculated values

 is the number of points

Note 
You can only perform a manual zero order rate calculation after the data is collected. Once the data is 
collected, select Cursor modes in the Graph menu and choose the kinetics ruler type you require. You can 
then select the range over which to calculate the reaction rate. 

See also: 
How to use the kinetics ruler
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To use the ruler: 

Step 1 

From the Graph menu, select Cursor Modes. Alternatively, select the  button on the toolbar. The Cursor 
Modes dialog is displayed 

Step 2 

Select Ruler—Least Squares to use a least-squares technique to determine the slope and thus the rate of the 
reaction over the selected range. Alternatively, select Ruler—Point to Point to use a line drawn between two 
selected points to determine the point to point slope and thus the reaction rate. 

Step 3 

Select OK to clear the Cursor Modes dialog and return to the Kinetics Application window. 

Step 4 

Select a region of the trace that is relatively straight and then place the cursor on the first point on the trace 
where you wish to start drawing the ruler. Press and hold down the left mouse button. 

Step 5 

Move the cursor to the second point on the trace (you will see the ruler line drawing as you move the cursor) 
and release the mouse button. 

The Ruler Rate dialog will be displayed to enable you to view the start and end positions of the calculation 
range that you selected. The value of the calculated slope is also displayed. 

If you are not satisfied with the rate result, select the Retry button to repeat Steps 3 to 5, this time selecting 
another range. 

Step 7 

Select Add Label to add the determined slope value of the ruler trace to the graph. The Ruler Rate dialog will 
be cleared.  

If you do not wish to add a label, simply select OK to clear the Ruler Rate dialog. 

The results of the manual determination of the reaction rate will appear in a table in the Report area. The 
ordinate and abscissa start and end values are reported as well as the calculated slope. The result table will also 
include the calculated standard deviation as well as the Factor*slope result.  

Note 
If you wish to exit the kinetics ruler mode, select Cancel. The kinetics ruler trace will be removed from 
the graph.

See also: 
Cursor modes
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Examples—Kinetics 
User Collect
Multi-stage kinetics run
Multi-stage kinetics calculations
Single-stage, multicell kinetics run
Example of a graphics template
Using the stop time

Example of a multi-stage kinetics run—Kinetics 
Number of Stages = 3, Single Cell kinetics 

The Ave Time is set to 0.500 s 

Graphical representation of data points for the above example 

Stage 1: 0-10 minutes. The run will commence taking data readings at the set Ave Time of 0.5 s and cycle 
every 2 minutes. Five cycles will be completed in the first 10 minutes (Stop Time 10 mins) of the run.  

Stage 2: 10-26 minutes. The run will continue taking data readings at the set Ave Time of 0.5 s but cycle every 
4 minutes. Four cycles will be completed in the next 16 minutes (Stop Time 26 (10+16) mins) of the run.  

Stage 3: 26-45 minutes. The run will continue taking data readings at the set Ave Time of 0.5 s but cycle every 
5 minutes. Four cycles will be completed in the next 20 minutes (Stop Time 45 (10+16+20) mins) of the run.  

Example of multi-stage kinetics calculations—Kinetics 

Stage Cycle (min) Stop (min)
1 2 10
2 4 26
3 5 45

See also: 
Example using the Stop time 
Example of a User Collect
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The table to follow indicates the regions that would be selected to perform an Advanced analysis, on the above 
example. 

Number of stages (steps) = 2 

Examples of single-stage, multicell kinetics runs using Dwell and 
Cycle Time—Kinetics 

Example 1 

Number of Stages = 1, Multicell kinetics (cells chosen = 3), Ave Time = 0.0125 seconds 

Stage Start (min) Stop (min) Order
1 1 2 Zero
2 4 5 Zero

Stage Dwell (s) Cycle (s) Stop (s)
1 0.13 6 24
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Graphical representation of data points for this example. The inset shows the points collected for one cell 
during one Dwell Time period. 

In the example above, the run will commence by taking readings of the first cell for the Dwell Time of 0.13 s. 
Since the Ave Time is set to 0.0125 s, the Cary will take ten readings during that Dwell Time. The system will 
then move to the next cell and take further data readings for 0.0125 s for a Dwell Time of 0.13 s. The system 
will continue to collect data, at cells 2 and 3 in this manner. 

The system will then wait until a Cycle time of 6 s has expired before recommencing the run. The run will end 
at the selected Stop Time of 24 s. 

Example 2 

Number of Stages = 1, Multicell kinetics (cells chosen = 6), Ave Time = 0.5 seconds 

Ave Time = 0.5 s 
Dwell time = 2 s 
Cycle time = 2 min 
(Cells chosen = 6) 

The run will average the readings every 0.5 s to produce a data point. It will do this for a Dwell Time of 2 s. It 
will then take data readings of the next five cells using these parameters.  

The system will then wait until a Cycle Time of 2 min has elapsed before continuing with further readings of 
the selected cells. The run will end at the selected Stop Time. 

Stage Dwell (s) Cycle (min) Stop (min)
1 2 2 10

See also: 
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Example of a Graphics Template—Kinetics 
By using the Add Label command in the Cary Eclipse graphics system, you can customize a graphics template 
such as the one shown below: 

The above is created as follows: 

The graph on the left is the collected data.
The text on the top right is a multi-line label (added using the Add Label command).
The logo is an inserted picture (added using the Add Picture command).

Example using the Stop time—Kinetics 
Example 

Cycle time = 5 minutes 
Stop time = 30 minutes 

In the above example the run will complete 6 cycles of the chosen cells, each with a Cycle time of 5 minutes. 
The run will end at the selected Stop time of 30 minutes. 

Example of a User Collect 
Example using the Stop time 
Example of a multi-stage Kinetics run, without Dwell time

See also:
Add Label
How to make a graphics template

Note 
If the Stop time was set to 28 mins, the run would continue for 30 mins, as the Cycle time overrides the 
Stop time. 
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File Management—Kinetics 
File menu
Open dialog
Save As dialog
Filename extensions
ASCII spreadsheet file
Auto Store page
How to perform post run calculations on previously stored data
How to combine data files into a batch file
How to export collected data
How to combine data files into a batch file

File menu—Kinetics 
Use the File menu to open or save a method or data file, print or preview a report, or exit the Cary Eclipse 
application. 

The following commands can be accessed from the File menu: 

See also: 
Example of a User Collect 
Example of a multi-stage Kinetics run, without Dwell time

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open it. 
Any data will be displayed in the Graphics area.

Command What it does…
New Select New to clear all method, report and graphics information and create a new file 

containing the default settings.
Open 
Method… 

Select Open Method to display the Open dialog where you can search for and load a stored 
method. 

Open… Select Open to display the Open  dialog where you can search for and load method, data, 
report, graph template and batch files, as well as other file types compatible with the Cary 
Eclipse software. When you load a batch file, the method which collected the data is loaded 
as well as the associated report and graphics layout.

Save Method 
As… 

Select this option to display the Save As dialog and store the current method. You can use 
the Save As dialog to store the method, data, report, or graphics template separately or 
together as a Batch file. The data can also be saved as a comma delimited ASCII 
Spreadsheet file.

Save As… Select this option to display the Save As dialog and store the collected data. You can use the 
Save As dialog to store the method, data, report, or graphics template separately or together 
as a Batch file. The data can also be saved as a comma delimited ASCII file.

Print Setup… Select this option to display the Windows Print Setup dialog where you can select the 
printer, printer page size and orientation.

Print Select this option to display the Print Preview dialog where you can view the current report 
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Look in | File name | Files of type | Overlay Data | Open 

Use the dialog to open a file previously saved by the application. To access the Open dialog, select Open or 
Open Method from the File menu. 

Preview… as it will be printed.
Print… Select this option to display the Windows Print dialog where you can choose the printer and 

pages to print as well as the number of copies you wish to print.
Explorer… Select this option to run Windows Explorer. This may help you locate method and data files.
History List This displays a list of the four most recently opened files.
Exit Select this option to exit the Kinetics application. 

See also: 
Open   
Save As   
Print Preview   
Filename Extensions 
ASCII Spreadsheet File

Open—Kinetics 

Look in The Look In field lists the available folders and files. Click the down arrow on the right of 
this field to view the location of the current folder in your computer's hierarchy. You can 
also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In 
field. 

Note 
To open the folder in the level that is one higher than the current folder, select on 
the toolbar.

Look in list 
box  

The Look In List Box, which is directly below the Look In field, displays the folders and 
files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted text 
entry field that appears and press Enter. Then double-click on the new folder to open 
it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the date the 
file was last modified.
Click to preview the selected trace before you load it into the application.

File name Enter the name of the file you want to open in this field. The easiest way to do this is to find 
the file in the Look in list box and then select the file. However, you can type the full path 
of a file and then select Open to open the file.

Files of type  Click on the arrow on the right of this field to view a list of the different types of application 
files that can be opened in the list box. 
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Save As—Kinetics 
Look in | File name | Files of type | Save 

Use the Save As dialog to save the data, method, report or graphics template individually or together as a 
Batch file. 

Methods (*.FMKN) Choose this file type to open a Method file. Only the method is 
loaded. No data is loaded.

Data (*.FDKN) Choose this file type to open a Data file. Only the data is loaded. 
The method that was used to collect the data is not loaded. The last 
used method or default method will be displayed.

Report (*.FRKN) Choose this file type to open a Report file. You can view the report 
in the Report area.

Graph Template 
(*.FGKN) 

Choose this file to open a Graph Template file. The file will set up 
the layout of the Graphics area including any bitmaps as well as the 
range and style of the graph axes.

Batch (*.FBKN) Choose this file type to open a Batch file. A Batch file includes 
data, the method used to collect the data, report and graphics setup.

Spreadsheet Ascii 
(*.CSV)

This will open ASCII files that contain single comma delimited 
files with two or more columns.

GRAMS (*.SPC) Choose this file type to open a Cary Eclipse GRAMS data file. 
This allows you to use data files collected using a Cary Eclipse 
GRAMS system. The method that was used to collect the data is 
not loaded.

ADL (*.ADL) This will open and run program files generated in the Applications 
Development Language (ADL). 

All files (*.*) This enables you to view all files in the directory so that you can 
open any compatible file.

Tell me more about Filename Extensions

Overlay Data Select this check box to overlay individual data files in one graph box. If this is not checked 
the data from each file will appear in individual graph boxes. This option is only available if 
the Open dialog has been accessed by selecting 'Open…' from the File menu. 

Hot Tip 
Use the SHIFT or Control key to select multiple data files.

Open This button opens the highlighted file/s or the files listed in the File name field.

 
See also: 
File menu 
ASCII Spreadsheet File

Note 
This dialog appears when you select either the Save Method As or Save As menu option in the File 
menu. When you select Save Method As this dialog appears with 'Methods' displayed in the Files of type
field. When you select Save As this dialog appears with 'Batch' displayed in the Files of type field.
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Traces (or data) that are currently ‘Visible’ in the Graphics area are saved, regardless of how they are displayed 
(full screen graph box or tile).  

For example, if six graph boxes are displayed in the Graphics area and each graph box has one Visible trace 
then all six traces will be saved.  

If you do not wish to save particular traces, make them not Visible in the Trace Preferences dialog. To save 
only the focused trace, select the Save only focused trace check box. 

The Save As dialog comprises the following: 

Look In The Look In field lists the available folders and files. Click the down arrow on the right of 
this field to view the location of the current folder in your computer's hierarchy. You can 
also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed in the list box below the Look In 
field. 

Note 
To open the folder in the level that is one higher than the current folder, select on 
the toolbar.

Look in list 
box 

The Look In list box, which is directly below the Look In field, displays the folders and 
files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted text 
entry field that appears and press ENTER. Then double-click on the new folder to 
open it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the date the 
file was last modified.
Click to preview the selected trace before you load it into the application.

File Name Enter the name of the file you want to save in this field. 
You can also type the full path of a file then select the Save button to save the file. 

Files of Type  Click on the arrow on the right of this field to view a list of the different types of application 
files that can be opened in the list box. 
Methods (*.FMKN) Choose this file type to only save the current method. Any 

collected data is not stored.
Data (*.FDKN) Choose this file type to only save the data currently Visible in the 

Trace Preferences dialog (for any graph box). Note that the 
method used to collect the data is not stored with the data.

Report (*.FRKN) Choose this file type to only save the contents currently shown in 
the Report area..

Graph Template 
(*.FGKN) 

Choose this file type to save the layout of the Graphics area as a 
template. For example, any bitmaps you have added to your 
Graphics area will be saved as well as the range and style of the 
graph axes.

Batch (*.FBKN) Choose this file type to save the data that is currently Visible in the 
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Filename extensions—Kinetics 
The Cary Eclipse system uses the filename extension to distinguish between data types (e.g. method or data) 
and also to differentiate applications. (e.g. Concentration or Kinetics). 

The Syntax for file extensions is: 

Trace Preferences dialog (for any graph box), the method used to 
collect the data and the currently displayed report all together as a 
batch file. The graphics setup is also stored. 

Spreadsheet Ascii 
(*.CSV)

Choose this file type to save the raw intensity data currently 
Visible in the Trace Preferences dialog (for any graph box) as a 
comma delimited ASCII Spreadsheet file (*.CSV) file. The data is 
saved as XY pairs delimited by a comma. 

Note 
This file type can be easily imported into a spreadsheet 
program. For example, Microsoft Excel. You can also 
double-click on the stored *.CSV file from Microsoft 
Explorer to load Excel automatically with the ASCII XY data 
displayed.

GRAMS (*.SPC) Choose this file type to only save the data currently Visible in the 
Trace Preferences dialog (for any graph box) as a Cary Eclipse 
GRAMS data file.

Tell me more about Filename Extensions

Save only 
focused trace 

Select this option to save only the focused trace in the graph box. If this option is not 
selected, all visible traces in the graph box will be saved.

Save Click this button to save the file currently present in the File name field in the directory 
specified in the Look in field.

See also: 
File menu  
ASCII Spreadsheet file (*.CSV) 

Letter Represents Available Options
First Type of analysis F Fluorescence

Second Type of file B Batch
D Data
G Graph Template
M Method
R Report

Third and fourth Application identifier AB Advanced Reads
CN Concentration
KN Kinetics
LT Lifetimes
RT Ratio
SR Simple Reads
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The following files may be opened and saved in the Kinetics Application: 

SW Scan
TM Thermal
VO Validate

Extension Available action File type
*.FMKN Open/Save A method file (*.FMKN) consists of the software setup by 

which data is collected.
*.FDKN Open/Save A data file (*.FDKN) contains data collected that is 

currently visible in the Trace Preferences dialog (for any 
graph box). 

*.FRKN Open/Save A report file (*.FRKN) contains the report generated by the 
Cary Eclipse about the data.

*.FGKN Open/Save A graph template file (*.FGKN) contains information that 
sets up the layout of the Graphics area including any 
bitmaps as well as the range and style of the graph axes.

*.FBKN Open/Save A batch file (*.FBKN) contains the collected data that was 
Visible in the Trace Preferences dialog (for any graph box), 
the method by which the data was collected and the report 
and graphics template.

*.CSV Open/Save An ASCII spreadsheet file (*.FCSV) has the same 
extension for all applications. It consists of raw intensity 
data (that was currently Visible in the Trace Preferences 
dialog (for any graph box) saved as XY comma-delimited 
pairs. This file can be imported into a spreadsheet program 
such as Microsoft Excel.

Data.* Open A Cary DOS (Data.*) file is the equivalent of a Cary 
Windows Data file—it does not contain any Batch 
information.

*.ADL Open only An ADL file (*.ADL) is a program file generated in the 
Applications Development Language (ADL). 

*.SPC Open/Save A Cary GRAMS file (*.SPC ) is the equivalent of a Cary 
Eclipse Windows Data file—it does not contain any Batch 
information.

*.FADL Open An Eclipse ADL (*.FADL) file is a program file generated 
in the Applications Development Language (ADL) 
specifically for the Cary Eclipse. Eclipse ADL files will be 
associated with the relevant Eclipse application. When 
creating ADL files for the Cary Eclipse, it is recommended 
that you save them with the FADL extension.

Note 
Selecting All Files in the Windows Open dialog will list all available file types. 

See also: 
Open 
Save As
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ASCII Spreadsheet file (*.CSV)—Kinetics 
An ASCII Spreadsheet file consists of raw intensity data saved as XY comma-delimited pairs. You can choose 
to import or export Cary Eclipse files to ASCII files, which can then be imported in spreadsheet programs such 
as Microsoft Excel. 

The format is as follows:  

Line 1 contains the sample name plus a comma
Line 2 contains X and Y labels. The name of the X label must be the same as that used to label the graph.
For example, in Kinetics, the graph label is Time (secs). The Y axis must be labeled as Intensity (a.u.).
Lines 3 and onward contain the X,Y data
After the last line of X,Y pairs there must be a blank line separating the data from any text audit strings
or the end of the file.

For example, if a Kinetics file was collected as: 
s = 0.025, Intensity = 471.607 
s = 5.025, Intensity = 462.810 
s = 10.025, Intensity = 438.042 
etc. 

It would appear as follows in the ASCII file: 

Microsoft’s Excel generates a CSV file with the above format. 

There is also an alternative format for CSV files. For example, 

  Kinetics, 
  Time (secs); Intensity (a.u.) 
  0.025, 471.607, 
  5.025, 462.810, 
  10.025, 438.042, 

  Kinetics, 
  Collection time; 
  etc. 

  Kinetics 
  Time (secs); Intensity (a.u.) 
  0.025, 471.607, 
  5.025, 462.810, 
  10.025, 438.042, 

  Kinetics, 
  Collection time; 
  etc. 

Note 
The Time units for Kinetics can be either (mins) or (secs).
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How to combine data files into a batch file—Kinetics 
To combine a number of data files into a batch file, do the following: 

Step 1  

Select Open… from the File menu to display the Windows Open dialog. 

Step 2  

A list of stored batch files will appear. Select the down arrow to the right of the Files of type field and select 
'Data' to list all the data files. 

Step 3  

Select the Overlay Data check box. 

Step 4  

Highlight the data files that you require. Hold down the CTRL key to select multiple files. 

Step 5 

Select Open. The highlighted data files will load into the application and appear in the same graph box. 

Step 6 

Select Save As… from the File menu to display the Windows Save As dialog. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and select 
'Batch' to list all the batch files. Ensure that the Save only focused trace check box is cleared. 

Step 8 

In the File name field, type in the file name for your new batch file. 

Step 9 

Select Save to create the new batch file. The current method will be stored with the batch file. 

All the data files are now combined into the one batch file.

See also: 
Save As 
Open 
How to export collected data
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How to export collected data—Kinetics 
If you want to export data from a Cary Eclipse application into a third-party application, then you simply need 
to save your data as an Spreadsheet ASCII (*.CSV) file or a Rich Text Format (*.RTF) file. Spreadsheet ASCII 
files are recommended if you are planning to use the data in a spreadsheet program such as Microsoft® Excel. 
Rich Text Format files are recommended if you are planning to open the data in a word processor program 
such as Microsoft® Word. 

To export collected data: 

Step 1  

From the File menu, select Save As. The Save As dialog is displayed. 

Step 2  

Click on the down arrow next to the Files of type list box and select the Spreadsheet ASCII (*.CSV) or Rich 
Text Format (*.RTF) option. 

Step 4  

Type the name of your new file in the File name field. 

Step 5  

Select Save to export your data to this new file. 

Software and Screen features—Kinetics 
Menu line
Status display
Status line
Buttons
Function keys
Right mouse menu
How to remove or display the command buttons

Menu line—Kinetics 
 File menu 
 Edit menu 
 View menu 
 Commands menu 
 Setup menu 
 Graph menu 
 Help menu 

Status Line—Kinetics 
The Status Line is displayed at the very bottom of the Kinetics Application window. The line will display the 
following information (from left to right): 
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The major commands in this application can be accessed both from the menu items at the top of the main 
window and from the application buttons. These buttons, which appear in the left side of the Kinetics 
Application window, comprise the following: 

Hardware Status This field displays status messages indicating the current instrument activity.
Sequence Information This field displays status messages indicating the current system activity.
Current Results This field displays information on the last reading. 

Kinetics Application window

Buttons—Kinetics 

Hot Tip 
If you wish to access these commands from the main menus, rather than from these buttons, you can 
remove the Command buttons from your application window. To do this, clear the Buttons command in 
the View menu. This will enlarge the Graphics area, making viewing and selection of scans easier. 

Button Enables you to…
Setup Click this button to display the Setup dialog where you can set up your Cary Eclipse for the 

collection, storage and analysis of the kinetics run. You can also set up any accessories that 
you may have and define the reporting options.

Zero Select this to zero the current ordinate value. 
This command can also be accessed by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Pre-scan Select Pre-scan to quickly determine the optimum instrument parameters to be used for 
your sample. At the end of this collection sequence the software will report the optimum Ex 
and Em wavelengths and PMT voltage. Once you are satisfied with the parameters, the 
software will automatically update your method setup to reflect these new parameters.

Set Temp Click Set temp to open the Set Temperature dialog where you can change the temperature 
during a kinetics run. 

Q. Why is the Set Temp button unavailable?
A. The Set Temp button is only accessible if you are using a thermostatted accessory.
(On the Accessories page, the Temperature control option must be selected.) Once
you have started a run, you can access the Set Temp button by selecting the Pause
button to pause the run. You can then select the Set Temp button.

Stop Time Click the Stop Time button to access the Stop Time dialog. Use this dialog to extend the 
length of a kinetics run while the run is in progress. Extending a run may be necessary if you 
decide whilst a run is in progress that the data collection period too short.

Clear Report Select Clear Report to remove all of the text that appears in the Report area. If you have 
saved the report, you can view the information again. To do this, simply open the report file 
using the Open… command in the File menu.

Recalculate Use the pages accessible from the Recalculate option to perform re-calculations on data that 
has been analyzed.

Print Select Print to display the Windows Print dialog where you can choose what printer the 
report will be printed to. You can also select what pages to print as well as the number of 
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Function keys—Kinetics 
The function keys at the top of your keyboard perform basic Cary Eclipse operations simply and quickly. 

copies you wish to print. 
This command can also be accessed by pressing CTRL+P. 

Note 
The options on the Report page are used to generate the contents of the Report area 
during a run or on a recalculation. If Auto Print has been selected the Cary Eclipse 
will automatically print a report at the end of a data collection.

See also: 
Kinetics Application  
Setup  
Set Temperature  
Stop Time   
Recalculate 
Commands menu 

Function 
key 

What it does

F1 This displays the Help for the current dialog or window.
F4 Press F4 to display the Go to Wavelength dialog.
F5 Press F5 to perform an instrument Zero. The current intensity value will be reset to zero and all 

subsequent results will have the value that was reset to zero subtracted from them. You can use 
the Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible from the Commands menu or by selecting the Zero button. 

Select the Clear Zero command from the Commands menu to remove zero correction. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell positions 
that are currently in the cell path.

F6 Press F6 to display the Rapid Result dialog where you can read a blank and multiple sample 
readings without changing the application method. 
This command is also accessible from the Commands menu.

F9 If the application is online, press F9 to start a data collection. This is equivalent to selecting the 
Start button. If the application is not online, you will need to press F9 to first connect to the Cary 
Eclipse. Then press F9 to start the data collection. 
This command is also accessible from the Commands menu or by selecting the Start button. 

Note 
You will not be able to perform a Connect if another application is collecting data.

F12 Select this to stop the current measurement. This is equivalent to selecting the Stop button. This 
command is also accessible from the Commands menu or by selecting the Stop button. 

See also: 
Go to Wavelength 
Zero  
Rapid Result  
Start/Stop Instrument Buttons
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Right mouse menu—Kinetics 
The following commands are accessible by clicking the right mouse button on editable fields in the Cary 
Eclipse software: 

How to remove or display the command buttons—Kinetics 
The command buttons (Setup, Zero, Pre-scan, Set Temp, Stop Time, Clear Report, Recalculate and Print) 
appear on the left side of the Kinetics Application window. 

To remove the command buttons 

Step 1 

From the Kinetics Application window, select the View menu. 

Step 2 

Clear the Buttons menu item. 

The buttons will disappear from the application screen, giving you more room to display reports. 

To show the command buttons 

Step 1 

From the Kinetics Application window, select the View menu. 

Step 2 

Select the Buttons menu item. 

The buttons will re-appear in the application screen. 

ADL—Kinetics 
ADL Command Line
ADL Hooks
How to insert ADL commands

Introduction to ADL 

Undo If available, this reverts to the previous value before the Edit on the field.
Cut If available, this cuts the highlighted text to the clipboard.
Copy If available, this copies the highlighted text to the clipboard.
Paste If available, this pastes the text from the clipboard to the cursor position.
Delete If available, this deletes the highlighted text/number.
Select All If available, this selects all entries.

ADL Command Line—Kinetics 
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Use the ADL Command Line to run Single-line or Multi-line Applications Development Language (ADL) 
commands that enable you to perform functions over and above that of the existing program functionality.  

ADL is not a general purpose programming language. It has been developed specifically by Varian to meet the 
needs of spectroscopists. It can be used to handle all the data collected from the Cary Eclipse—both 
photometric values and entire data collections. ADL programs that you develop should be stored with the 
extension 'ADL'. 

To access the ADL Command Line, select the ADL Command item from the Commands menu. You can also 
press ALT+Y to open the dialog. 

Software controls 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help. 

Single Line Selecting this lets you enter ADL commands on a single line into the Command Line entry 
box. 

Q. Can I enter more than one ADL command on a single line?
A. Yes, provided that the commands are separated by a semicolon ‘;’.

Multi-line The Multi-line capability enlarges the Command Line entry box. Use the Multi-line 
capability to create a more complex ADL program by adding a series of commands over 
multiple lines. When Multi-line mode is selected, the Quick Reference option becomes 
available.

Quick 
Reference 

Select Quick Reference to open the Quick Reference dialog where you can easily add a 
command in the correct syntax to your ADL program. This option is only available for Multi-
line commands. 

Show me How to insert ADL commands using the Quick Reference 

A detailed description of all the commands in the Quick Reference is available by pressing 
the Help button on the Quick Reference dialog. 

Browse Select Browse to access the Open dialog where you can browse for and select an existing 
ADL program to load and run.

Command 
Line (entry 
box) 

This entry box enables you to use ADL commands. You can enter single ADL commands 
into this field, or you can enter a series of ADL commands. If you have the entry type set to 
Single Line, you can review previous ADL entries by selecting the down arrow to the right of 
the list box. 

The ADL commands in the Command Line are executed when you select OK. 

Note 
On entering this window, the Cary Eclipse will recall the last command or program 
executed from the Command Line entry box. The ADL commands entered in the last 
executed program are typically stored in the Varian\Cary Eclipse WinFLR\ADL 
directory on the drive on which the Cary Eclipse software is installed.
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The ADL Hooks command is accessible from the View menu. 

Instead of writing a full ADL program you can use ADL hooks to link into an existing application. This is 
particularly useful if you want to make small changes to the way an application works, e.g. you want to pop up 
a dialog for the user to enter some specific data before the run starts. ADL hooks are links at specific points in 
an application at which you can run an ADL program. For example, ADL hooks have been supplied to run the 
following ADL programs:  

Hot Tip 
You can rerun the ADL commands in the Command Line entry box from any screen in 
the Kinetics application by pressing Alt-X or selecting Re-run ADL from the 
Commands menu. 

 
See also: 
ADL Hooks

ADL Hooks—Kinetics 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Hook Description

KN_Startup.ADL This is run when the Kinetics application starts. For this to to work the application must 
be started from a batch or method file that has ADL Hooks on.

KN_PreSeq.ADL This runs when the Start button is selected.

KN_PostSeq.ADL This runs at the end of the Start button sequence.

KN_Online.ADL This runs when Cary Eclipse is detected online.

KN_OffLine.ADL This runs when Cary Eclipse goes offline.

KN_Zero.ADL This runs when the Zero button is selected.

KN_Recalc.ADL This runs when the Recalculate button is selected.

KN_Shutdown.ADL This runs when the application is shutting down.

KN_PreRead.ADL This runs just before a read is taken.

KN_PostRead.ADL This runs just after a read is taken (It has the reading result stored in the 
UserResult variable.)

KN_PreSetup.ADL This runs when the Setup button is selected.

KN_PostSetup.ADL This runs when the OK button on the Setup dialog is selected.

KN_CellChange.ADL This runs instead of the Cary Eclipse driving the Multicell Holder. It enables you 
to add your own instructions for the Cary Eclipse Multicell Holder or to use your 
own cell changing accessory.

KN_PreStage.ADL This runs prior to each collection stage. It determines the stage by checking the 
UserResult variable as UserResult = stage number.
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How to insert ADL commands using the Quick Reference—Kinetics 
The Quick Reference window is accessed from the ADL Command window. It enables you to easily add a 
command in the correct syntax to your ADL program. To do this: 

Step 1 

Press Alt-Y to open the ADL Command Line window. 

Step 2 

Select the Multi-line option. The Command Line entry box will expand to take multiple lines of ADL 
commands and the Quick Reference check box is displayed. 

Step 3 

Select the Quick Reference check box. The Quick Reference window is displayed. 

Step 4 

If necessary, use the Go To field to jump to the appropriate part of the Quick Reference listing. 

Step 5 

Highlight the command you require in the Quick Reference list. 

Step 6 

Click the Insert in ADL button. The selected ADL command will appear in the Command Line entry box. 

Step 7 

Where necessary, alter the defaults supplied by the inserted Quick Reference command in the Command Line 
entry box to suit your program. 

KN_PreUserRecalc.ADL This runs just after the Recalculate button has been selected and performs any pre-
processing required prior to a recalculation.  If the ADL Variable UserBoolean is set to 
FALSE, it can also replace the normal recalculations.

KN_UserRecalc.ADL This runs just prior to the calculations and can also be used to replace the calculations

KN_PostUserRecalc.ADL Runs after the Recalculate sequence has been completed

KN_TraceName.ADL Allows the name of the sample to be obtained from an ADL file, instead of being entered 
by typing into the sample loading dialog. This only works for single samples. 

KN_UserPreCalc.ADL This runs just prior to the calculations. Any pre-processing of data should be done here.

KN_UserPostCalc.ADL This runs after the calculations. Any post processing of data should be done here

KN_DuringSeq.ADL Runs when the collect sequence has been paused

KN_PreStage.ADL Runs prior to each stage in a multistage (advanced) run

KN_PostStage.ADL Runs after each stage in a multistage (advanced) run
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Step 8 

Repeat steps 4–7 to add more commands as required. 

Help and Safety information—Kinetics 
Help menu
Safety home page

Help menu—Kinetics 
Use the Help menu to view the online Help and software information for this application. 

Safety Home Page 
Click on the desired index entry to view the Help. 

About Safety
Lamp module
Ultraviolet radiation
Electrical hazards — Cary Eclipse
Panels, covers and modules
Other precautions
Warnings and cautions
Warning symbols
Color coding
Information symbols
FCC advisory
CE compliant products

Kinetics How To—Kinetics 
Select the procedure you require below for a step-by-step informative guide on running the application 
software. 

See also: 
ADL Command Line

Command What it does…
Kinetics Help Select this to display the Kinetics Home Page. This contains a list of online Help topics 

specific to the Kinetics Application.
Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.
Tip of the day View useful tips about using your Cary Eclipse instrument and software.
Eclipse Tour Select this to display the Cary Eclipse Multimedia Online Help. This will give you an 

animated introduction to the Cary Eclipse software and hardware.
About… Select About to access a dialog that displays information about the application as well as 

Varian email and Internet contact information.  
To clear this About dialog, select OK.
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Procedural 

How to perform a single-wavelength kinetics run
How to perform a multi-wavelength, temperature controlled kinetics run

Calculations and reporting 

How to use the kinetics ruler
How to generate a report from previously collected data
How to perform post run calculations on previously stored data
How to use advanced reporting options

General 

How to email your results
How to export collected data
How to combine data files into a batch file
How to remove or display the command buttons
How to insert ADL commands using the Quick Reference

How to resize graph boxes—Kinetics 
Step 1  

Click on the graph that you want to resize so that the highlight box appears around it. 

Step 2  

Move the cursor to the edge of the highlight box and place it over one of the square marks (e.g. ) in the box 
until it turns into a double headed arrow ( ). 

Step 3  

Click and hold the left mouse button and drag the box to the desired size. 

Step 4  

Release the left mouse button. 

How to zoom a graph—Kinetics 
To zoom a graph, do the following: 

Step 1  

Click on the  button on the toolbar, or select Cursor Mode from the Graph menu. The Cursor Modes

See also:
Kinetics Home Page
Graphics How To

See also: 
How to alter the look of your graphs
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dialog will appear. 

Step 2  

Select Free and select the OK button. 

Step 3  

Click and hold down left mouse button in the highlighted graph box. 

Step 4  

Drag the mouse sideways and up or down. You will see a zoom box made up of a dotted line appear on the 
screen. (See picture below.) 

The dotted line is a zoom box. 

Step 5  

Release the left mouse button. The area defined by the zoom box will be redrawn to fill the entire graph box, 
and the scans within the box will be enlarged accordingly. The abscissa (X) and ordinate (Y) coordinates 
displayed below the graph will also be changed to reflect the positions of the corners of the zoom box. 

You can repeat this process if you need to zoom in even further. 

How to take the derivative of a trace 
Some uses of derivatives are: 

To resolve partly overlapping peaks
To quantitatively determine trace compounds
To characterize pure compounds
Purity testing

To take the derivative of a collected trace and plot the result, follow these steps: 

Step 1 

Hot Tip 
To move the box on the screen, hold down the left and right mouse buttons together. You can then 
position the box anywhere in the graph box. Releasing the right mouse button will still allow you to 
resize the zoom box.

Note 
The system may limit the extent to which you can Zoom. 
See also: 
How to scale your graph manually 
How to scale your graph automatically
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Click on the trace to be smoothed. It will become red (highlighted). 

Step 2 

Click the Selected Trace or Focused Trace button. The name of the highlighted trace will appear in the 
calculation display field. 

Step 3 

In the Trace group, select your derivative order in the Operation field. Choose from derivatives 1 to 4 (Deriv1, 
Deriv2, Deriv3, Deriv4). You may have to scroll to find the derivative you require. 

Step 4 

Enter a Filter Size and an Interval in the corresponding fields. 

Step 5 

In the Display Options group, select New Graph to plot the result in a new graph box, or Selected Graph to plot 
the result in the current graph box. 

Step 6 

Click the Apply button in the Trace group. Your Deriv selection will be displayed before the trace name in the 
calculation display field. 

Step 7 

Click on the equals (=) button. The result will be displayed in the Graphics area. 

How to smooth a trace 
To smooth a collected trace and plot the result, follow these steps: 

Step 1 

Click on the trace to be smoothed. It will become red (highlighted). 

Step 2 

Click on the Maths button in the toolbar (it's on the far right) or select the Maths menu. 

Step 3 

Click the Selected Trace or Focused Trace button. The name of the highlighted trace will appear in the 
calculation display field. 

Step 4 

In the Trace group, select Smooth in the Operation field. (You may have to scroll to find it.) 

See also: 
About derivatives
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Step 5 

Enter a Filter Size and an Interval in the corresponding fields. 

Step 6 

In the Display Options group select New Graph to plot the result in a new graph box, or Selected Graph to plot 
the result in the current graph box. 

Step 7 

Click the Apply button in the Trace group. The word ‘Smooth’ will appear before the trace name in the 
calculation display field. 

Step 8 

Click on the equals (=) button. The result will be displayed in the Graphics area.
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Lifetimes Home Page 

Introduction 

The Lifetimes application is used to measure phosphorescence lifetimes, and therefore is only available in 
phosphorescence mode. 

The Lifetimes application measures the average amount of time a molecule remains in the excited state 
following excitation. Where: 

Lifetimes (time resolved) 

A + Excitation -> A*  

To… Use the… Show me…
Get ready to collect data Setup dialog

Perform data collections Commands menu

Display data graphically Graphics Area
Graph menu

Graphics How To

View run progress and 
results

Status Display
Reports
Print Preview

How to generate a report from previously
collected data
How to use advanced reporting options

Perform calculations Analyze page How to perform post run calculations on stored
data  

To find out about… See the… Show me…
Lifetimes Application Lifetimes

application
File management Open dialog

Save As dialog
Filename extensions
Auto Store page

How to export collected data
How to email your results

Screen features Buttons
Graphics Toolbar
Report Toolbar
Status Line

How to remove or display the command
buttons

ADL ADL Command
Line
ADL Hooks

Help and safety 
information

Help menu
Safety Home Page

Lifetimes Application 
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A* -> A + Emission 

It is a time-based measurement (like Kinetics) where the change in intensity is usually due to uni-molecular 
processes.  

The shape of the decay curve produced by a Lifetimes measurement is sensitive to the environment that the 
molecule is in. For this reason, it is often used as a probe technique to determine what the molecule is 
experiencing. 

To access the Lifetimes Application, click the Windows Start button, point to Programs, Cary Eclipse and 
then select Lifetimes. 

Software controls 

The application comprises the following: 

Instrument 
Status 
Readings 

The Instrument Status Readings, which display the Y and X values of the graph axes are 
displayed in the top left and right corners of the Lifetimes Application Window. 

Y value 
Displays the current Y value, usually intensity. This value is continually updated during a 
data collection. 

X value 
Displays the current X value, which is the current reading for the Time. On the Cary page 
of the Setup dialog, choose whether to display the time value in minutes or seconds. 

Start and 
Stop buttons 

The Start and Stop buttons at the top of the Lifetimes Application window are used to start 
and stop instrument analyses. These buttons can also be accessed from the Commands 
menu. 

Tell me more about the Start and Stop buttons 

Graphics 
area 

The Graphics area refers to the plotting area of the application. It can contain traces of 
collected data, labels and pictures. In the Cary Eclipse system, the term 'graph' refers to the 
plotting area and is represented by a set of axes. The rectangular area defined by the axes is 
referred to as a graph box. 

To display or hide the Graphics area, select the Graphics command on the View menu. 
Double-clicking on the Graphics area enables you to toggle between half or full size display 
sizes.  

Tell me more about the Graphics area  

Report area Use the Lifetimes Report area to view the current report. The report may include the results 
of your data collection, the method parameters used to collect the results and any graphics 
you have included. You can select the information to include in your report on the Reports 
page of the Setup dialog. 

To display or hide the Report area, select the Report command from the View menu. 
Double-clicking on the Report area enables you to toggle between half or full size display 
sizes. 
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Validation of your Cary Eclipse for the Lifetimes application 
The files listed below are shipped with the Lifetimes application to enable you to validate the software. The 
files are stored on your CD in a Validation subdirectory. 

To validate your software, you should Open each file in turn and select the Recalculate button. The results 
calculated by the Cary Eclipse should match those given in the validation files listed belowa. These results 
were determined by exporting the data to a spreadsheet program and performing the same calculation as that 
used in the Lifetimes application.  

Lifetimes validate_single exp.FBLT

Lifetimes validate_double exp.FBLT

Getting ready for a run—Lifetimes 
Setup dialog
Setup menu
Cary page
About Gate Time
How many flashes?
Options page

You can copy the generated report onto the Windows clipboard. To do this, highlight the 
report (or a relevant section of it) and press CTRL+C. You can then paste the report into a 
word processor such as Microsoft® Word. 

Hot Tip 
You can edit the Lifetimes Report by pressing CTRL+R or selecting the Edit Report 
command from the Edit menu.

Commands The Lifetimes Application window contains the following commands, all of which can also 
be accessed from the various menus in the application. 

Click on the buttons to view information about them: 

Hot Tip 
By becoming familiar with these commands (Setup, Zero, Pre-scan, etc.), you can 
remove these buttons from the Lifetimes window. This will enlarge the Report area 
and make it easier to view results. To do this, clear the Buttons item in the View 
menu. 

Menus The Lifetimes Application contains the following menus:  
File, Edit, View, Commands, Setup, Graph, Help

 
See also: 
Status Display 
Status Line 
Keyboard function keys 
Lifetimes Home Page
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Accessories page
Multicell Changer
Analyze page
Recalculate
Reports page
Report toolbar
Clear Report
How to use the advanced reporting options
Auto Store page
How to email the results

Use the Setup dialog to set up your instrument and accessories for a Lifetimes run. You can also use the dialog 
to set up the Analysis, Report and Storage parameters associated with the run. 

The dialog comprises the following tabbed pages: 

Cary
Options
Accessories
Analyze
Reports
Auto Store

Use the Setup menu to access the parameters for setting up a Lifetimes read. 

Setup—Lifetimes 

To access the Setup dialog select the Setup button from the Lifetimes Application window or the 
Setup command from the Setup menu.

See also:
Lifetimes Application

Setup—Lifetimes 

Command What it does…
Setup Choose Setup to display the Setup dialog where you can set up your instrument for a 

Kinetics measurement. The Setup dialog can also be accessed from the Setup command 
button.

Cary Choose Cary to display the Cary page. You can use this page to set up the instrument 
parameters associated with the data collection.

Options Choose Options to display the Options page where you can set up your filters and set the 
detector voltage. You can also use this page to select the way the collected data is displayed 
in the Graphics area, and the type of smoothing applied (if any).

Accessories Choose Accessories to display the Accessories page. You can use this page to set up the 
accessory parameters associated with the data collection.

Analyze Choose Analyze to display the Analyze page where you can select from various 
mathematical equations and set the parameters used to generate the calculation of reaction 
rates.
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Instrument Setup | Wavelength Setup | Status Display 

Use the Cary page to set up the instrument parameters associated with the data collection. 

From the Setup menu, select Cary to access the Cary page. You can also access the page from the Setup 
dialog by selecting the Cary tab. To access the Setup dialog, select the Setup button from the Lifetimes 
Application window. 

Instrument setup 

Wavelength setup 

Reports Choose Reports to display the Reports page. You can use this page to set up the report 
parameters associated with data collection.

Auto Store Choose Auto Store to display the Auto Store page where you can specify if and when data 
will be stored, and in what format.

See also: 
Lifetimes Application   
Cary   
Options   
Accessories 
Analyze   
Reports   
Auto Store 

Cary—Lifetimes 

Note 
The Lifetimes Application operates in Phosphorescence mode only.

Delay time Enter, in milliseconds, the delay time for your sample. The delay time is the time that 
elapses between the last flash and the beginning of data collection. The default value is 
0.100 ms, which is the time it takes for the lamp intensity to decay to zero. Setting a delay 
time ensures that there is no lamp effects in the phosphorescence decay curve. 
The range is 0.000–5000.000 s.

Gate time Enter, in milliseconds, the gate time for your sample. The gate time is the overall reading 
time of the emission signal. 
The range is from 10µs–10s.

No. of flashes Enter the number of lamp flashes required, which is how many times the lamp flashes 
consecutively before the delay time is counted. 

How many flashes should I perform? 

Ex. 
Wavelength 
(nm) 

Set the wavelength of the excitation monochromator, which is the wavelength value at 
which you want to excite your sample. Click the arrow to the right of the field to quickly 
select the most recent wavelength entries. 

Alternatively, to set the excitation monochromator to zero order (white light), from the 
Commands menu, point to Zero Order and select Excitation. A tick next to this option 
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Collect timing 

Status Display 

Select this check box to display the Status Display window, where you can view the status of various 
parameters during the data collection. 

Understanding Gate Time and Average Time—Lifetimes 
For Phosphorescence scans, there is a relationship between Average Time (the time for which data is averaged) 
and Gate Time (the overall reading time of the emission signal). 

indicates that it is selected. Clear this option to return to monochromator light and use the 
value set in the Ex. Wavelength field. 

Em. 
Wavelength 
(nm) 

Set the wavelength of the emission monochromator, which is the wavelength value at which 
your sample emits. Click the arrow to the right of the field to quickly select the most recent 
wavelength entries. 

Alternatively, to set the emission monochromator to zero order (white light), from the 
Commands menu, point to Zero Order and select Emission. A tick next to this option 
indicates that it is selected. Clear this option to return to monochromator light and use the 
value set in the Em. Wavelength field. 

Ex. Slit (nm) Set the slit width of the excitation monochromator. Choose from 1.5, 2.5, 5, 10 or 20 nm or 
10 Round.

Em. Slit (nm) Set the slit width of the emission monochromator. Choose from 1.5, 2.5, 5, 10 or 20 nm or 
10 R.

Total decay 
time 

Enter the time, in milliseconds, over which the decay will be measured. You should enter a 
time that will allow for the phosphorescence signal to decay to approximately zero. The 
lamp will not flash until the total decay time has elapsed.

No. of cycles Enter the number of cycles (or decay curves) over which the run will be collected. This 
number will be used to average the data. 
Entering a number of cycles value enables you to obtain better signal to noise ratios as 
multiple traces can be averaged.  Once more than two traces have been collected, the 
average is applied at the end of each decay curve (a cycle).

X Mode This enables you to set the units of time for the abscissa (or X axis). 

Choose your desired abscissa mode by selecting one of the following buttons: 

ms 
Select this to time the run in milliseconds. 

Sec 
Select this to time the run in seconds. 

See also: 
Accessories  
Status Display

Page 6 of 97Lifetimes Home Page

   



Averaging is calculated as follows: 

The intensity readings are taken from different decays, where: 
Number of Decays = Averaging Time/Gate Time 

Average Time is set on the Cary page of the Setup dialog. Gate Time is set on Options page, which is 
accessible from the Cary page. 

The following diagram highlights the relationship between Average Time and Gate Time. In this example, the 
Average Time is set to five times the Gate Time: 

Note: 
Gate Time is not used if you select Fluorescence as the Data Mode. 

Average Time/Gate Time 5
Intensity A1 + A2 + A3 

__________ 

         3 
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where: 

Total Decay Time 25 ms
Delay Time 1 ms
No. of cycles 3
Average Time 5 ms
Gate Time 25 ms

See also: 
Lifetimes Application  
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How many flashes should I perform?—Lifetimes 
The Number of Flashes option is set in the Instrument Setup group on the Cary page. 

Example of the Instrument Setup Options 

Setting the number of flashes 

If you are measuring phosphorescence samples that have a relatively long decay time (that is, a number of 
seconds), you can setup the Cary Eclipse to pulse the lamp multiple times, as this will increase the intensity of 
the phosphorescent signal (refer to Example 1, below). For short lived phosphorescent samples, multiple 
flashes will not impact on the intensity of the signal, and therefore only one flash is required (refer to Example 
2, below). 

Example 1 
The above example shows that the sample does not decay before the instrument lamp flashes again. Therefore 
setting multiple flashes will result in an increase in the intensity of the signal.

Cary page 
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Example 2 
The above example shows that the sample decays in less time than the time it takes the instrument to flash the 
lamp again. Therefore, setting more than 1 flash, in the No. of Flashes field will not increase the intensity of 
the signal. 

Display Options | Excitation Filter | Emission Filter | PMT Detector Voltage | Status Display 

Use the Options page to set up your filters and set the detector voltage. You can also use this page to select the 
way the collected data is displayed in the Graphics area, and the type of smoothing applied (if any). 

From the Setup menu, select Options to access the Options page. You can also access the page from the 
Setup dialog by selecting the Options tab. To access the Setup dialog, select the Setup button from the 
Lifetimes Application window. 

Options—Lifetimes 

Display 
Options 

Overlay traces 
Select this option to superimpose the collected data of each sample in the run in one graph 
box. If you select this option, a graph box is created at the start of the collect in the Graphics 
area and each sample’s data is overlaid in that box as the data is collected. Traces will always 
be overlaid in the same graph, regardless of what multicell/well accessory is used. 
Clear this option to display all of the traces in individual graphs. 

Y minimum/Y maximum 
Enter the minimum and maximum Y values to be displayed on the graph axis. The software 
will update the Y axes to reflect these settings during the lifetimes run. 

Excitation 
filter 

Set the excitation filter for the Lifetimes measurement. To do this, select the down arrow to 
the right of the field and select an option from the list. 

A range of filter settings are available: 

Auto 
If you select the Auto option, the filter wheel will be automatically moved to the appropriate 
position for the selected excitation wavelength. It is recommended that you set the filter to 
Auto (which is the default setting).  

Open 
If you select Open no filter is used. 

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 
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250–395, 335–620, 550–1110, 695–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you can 
select your filter manually. Otherwise it is recommended that you set the filter to Auto. 

Emission filter Set the emission filter for the Lifetimes measurement. To do this, select the down arrow to 
the right of the field and select an option from the list. 

A range of filter settings are available: 

Auto 
If you select the Auto option, the filter wheel will be automatically moved to the appropriate 
position for the selected emission wavelength. It is recommended that you set the filter to 
Auto (which is the default setting).  

Open 
If you select Open no filter is used. 

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 

250–395, 295–1110, 360–1110, 430–1110, 550–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you can 
select your filter manually. Otherwise it is recommended that you set the filter to Auto. 

3%T Attenuator 
Select 3%T Attenuator to decrease the fluorescence intensity and thus the amount of light 
going to the emission PMT. This setting is useful for highly fluorescent samples when you 
are using wide slits. 

PMT Detector 
Voltage 

Set the EHT or sample detector PMT. To do this, select one of the following: 

Low 
Sets the PMT Detector voltage to a pre-defined value of 400 v. Typically you would select 
this setting if you are reading highly emitting samples. 

Medium 
Sets the PMT Detector voltage to a pre-defined value of 600 v. Typically you would select 
this setting if you are reading moderately emitting samples. 

High 
Sets the PMT Detector voltage to a pre-defined value of 800 v. Typically you would select 
this setting if you are reading low emitting samples. 

Manual 
Enables you to enter any PMT voltage in the adjacent Volts field. 

Volts 
Enter the PMT voltage in the adjacent field. Note that this option is only available if you 
have selected Manual as the PMT Detector voltage. 

Tip 
Increasing or decreasing the PMT Detector Voltage by 10% will double or halve the 
fluorescence intensity observed.
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Use the Accessories page to set up the accessory parameters associated with the data collection. 

From the Setup menu, select Accessories to access the Accessories page. You can also access the page from 
the Setup dialog by selecting the Accessories tab. To access the Setup dialog, select the Setup button from the 
Lifetimes Application window. 

The page comprises the following:  

Multicell Holder 

Select this option to use the Multicell Holder with the Cary Eclipse.  

Temperature Control 

Select this option to specify the temperature parameters for your analysis. 

Status Display Select this check box to display the Status Display window. This window allows you to 
view the status of various parameters during the data collection.

 
See also: 
Setup  
Status Display 

Accessories—Lifetimes 

 
Note 
By selecting this accessory you will prohibit the use of some combinations of other accessories that are 
also controlled by the Accessory Controller Board. 

Multi-zero If you select Multi-zero, a Multi-zero will be performed when the Zero button is selected in 
the Lifetimes Application window. A reading will be taken at the set Averaging Time at the 
specified wavelength(s) of one or both monochromators and at every selected cell position. 
These readings will be offset to zero and subsequent readings will have the corresponding 
offset value subtracted from each cell.

Reset Select Reset to drive the Multicell Holder to cell position 1, which is its fully retracted or 
zero position.

Go to cell… Select Go to cell to open the Multi Cell Changer dialog. You can use this dialog to 
manually move the Multicell Holder accessory to a new cell. To do this, simply select the 
corresponding button of the cell you require in the Multi Cell Changer dialog. The Multicell 
Holder will move the selected cell to the measurement position in the sample compartment. 

The Multi Cell Changer dialog is ‘modeless’ which means that it can remain open even 
once you have cleared the Setup dialog. This enables you to use the Rapid Read command 
to perform a reading at the cell specified in the Cell Changer. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse will 
display the intensity reading corrected by the determined zero-offset amount for that cell. 

 
Note 
You can use this option to check the intensity of a cell or perform a lifetimes run at a 
particular cell.

Note 
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Temperature Display 

Select this option to view Temperature Display information in the Status Display window. 

The Temperature Control option does not control temperature accessories that are not listed in the 
Device field. For example, if you have selected the Temperature Control option and set the Device to 
None because you have a different temperature control accessory, the Cary Eclipse software will not 
control that accessory. However, it will monitor the temperature and prompt the software to start when the 
accessory reaches the temperature listed in the Temperature field.

Device Select the device that will be used to control the water temperature. 

The options available will depend upon whether or not you have selected the Multicell 
holder option. 

If you have selected the Multicell holder, the 
following Device options will be available 
for selection: 

If you have not selected the Multicell holder, 
the following Device options will be 
available for selection: 

Temperature controller
PCB 150 water bath
None

Single cell peltier
PCB 150 Water bath
None

None 
Select this option if you are using a Temperature Control device not listed in this field (for 
example, a third party water bath). Note that the Cary Eclipse software will not control the 
accessory. The software will simply monitor the temperature and prompt the software to 
start when the accessory reaches the temperature listed in the Temperature field. 

PCB 150 water bath 
Select this option if you are using the PCB 150 water bath. 

Temperature controller 
Select this option if you are using the Temperature controller. 

Temperature Set the temperature at which the analysis will be performed. The default value is 20.00° C. 

When you select OK to close the Setup dialog, all buttons in the Advanced Reads 
Application window will be disabled until the temperature recorded by the Monitor device is 
within ± 0.5°C of the temperature range.  

If Zero or Start is selected, and the temperature is not within ± 0.5°C of the temperature 
range, then the system will wait for the temperature to fall within the temperature range 
before continuing with the measurement. Whilst waiting for the temperature, there will be a 
display on the status line at the bottom of the Advanced Reads Application window giving 
the current temperature and the elapsed time waiting to reach the set temperature. 

Port Select from COM1, COM2, COM3 or COM4. 
This option is only available if you have selected PCB 150 Water bath as the Device.

Monitor Select which device will be used to monitor the reaction temperature. The options in this 
field will change depending on the Device selected. 
Device selected Monitor options available
None Probe 1, Probe 2, Probe 3, Probe 4
PCB 150 water bath PCB 150, Probe 1, Probe 2, Probe 3, Probe 4
Temperature controller Block, Probe 1, Probe 2, Probe 3, Probe 4
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The Temperature Display option is only available if you have selected the Temperature Control option. 

Status Display 

Select this check box to display the Status Display window. Use this window to view the status of various 
parameters during the data collection. 

Use the Multi Cell Changer dialog to manually move the Multicell Holder accessory to a new cell. To access 
the Multi Cell Changer dialog, select the Go to cell button from the Multicell/Temperature Accessories 
page. 

The dialog comprises the following: 

Decay time | Manual Guess | Status Display 

Use the Analyze page to select from various mathematical equations and set the parameters used to generate 

Block/ 
PCB 150 

Select this option to view the temperature of the Block or the PCB 150 in the Status Display 
window. This option is not available if you have selected None as the Device option. 

Note that the PCB 150 option is only displayed if you have selected the PCB 150 Water 
Bath as the Device option without the Multicell holder. 

Probes Select one or more of these options to view the temperature of the Probes in the Status 
Display window.

See also: 
Lifetimes Application  
Multi Cell Changer 
Cary page  
Status Display window 

Multi Cell Changer—Lifetimes 

Multicell 
changer 

To manually move the Multicell Holder accessory to a new cell, simply select the 
corresponding button of the cell you require in the Multi Cell Changer dialog. The Multicell 
Holder will move the selected cell to the measurement position in the sample compartment. 

The Multi Cell Changer dialog is ‘modeless’ which means that it can remain open even once 
you have cleared the Setup dialog. This enables you to use the Rapid Read command to 
perform a reading at the cell specified in the Cell Changer. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse will 
display the intensity reading corrected by the determined zero-offset amount for that cell. 

 
Note 
You can use this option to check the intensity of a cell or start a lifetimes run at a 
particular cell.

See also: 
Multicell/Temperature Accessories  
Rapid Read

Analyze—Lifetimes 
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the calculation of reaction rates. 

From the Setup menu, select Analyze to access the Analyze page. You can also access the page from the 
Setup dialog by selecting the Analyze tab. To access the Setup dialog, select the Setup button from the 
Kinetics Application window. 

The page comprises the following: 

Decay time 

Calculate Select whether to perform a decay time calculation of the rate or the lifetime. The units of ms 
or s will vary depending upon the X Mode chosen on the Cary page.  The Manual guess 
equations will also vary according to the type of calculation you select.

Auto Calculate Select this option to automatically perform a rate calculation on collected data at the end of 
each run. Otherwise you can perform the calculation manually, once the run is completed, by 
selecting Recalculate from the Lifetimes Application window.

Decay Time 
Table 

Use the Decay Time Table to enter the calculation Start and Stop times (in minutes or 
seconds) for a rate or lifetime calculation analysis. 

The table comprises the following: 

Start 
Use these fields to enter the starting point, in minutes, for a rate calculation analysis. 

Stop 
Use these fields to enter the end point, in minutes, for a rate calculation analysis. 

Function type 
Click in this field to access a drop down list where you can select the function to be used for 
calculating the decay time. The following options are available: 

Single Exp 
Select this to fit the data with a single exponential decay curve. The form of the 
equation will vary depending on whether the Rates or Lifetimes option is 
chosen. The lifetime is defined as the time taken for the intensity to decay to 1/e 
of it’s initial value. 

Double Exp 
Select this to fit the data with a double exponential decay curve. The form of the 
equation will vary depending on whether the Rates or Lifetimes option is 
chosen. The lifetime is defined as the time taken for the intensity to decay to 1/e 
of it’s initial value. 

Note 
This option is only available if you select the Advanced Calculate option.

Plot Select the way in which the plot will be displayed from the following options: 

Fit 
Select Fit to automatically overlay the calculated lines of best fit onto the plotted data. 
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Manual guess 

This option enables you to manually enter the parameters for the decay rate calculation. You will need to have 
a reasonable estimate of the values for these fit parameters, as they will be used as a first guess in the fitting 
procedure. 

Status Display 

Select this check box to display the Status Display window. This window allows you to view the status of 
various parameters during the data collection.

Example of Fit overlay 

Difference 
Select this option to automatically generate a difference curve between the fitted curve and 
the collected decay curve. This difference curve will be a new continuum and will be 
displayed on a new graph. 

Note 
If you do not choose Manual Guess then the Cary Eclipse system will automatically calculate the values 
for Intensity(0), Intensity(∞) and Rate when you select OK to exit the Setup dialog.

Manual Guess Select this option to manually select the parameters with which to calculate a first order or 
second order reaction rate. 

The value of these parameters will be used as a first guess in the fitting procedure. 
Parameters A1 

Enter the estimated intensity of the pre-exponential for the first decay process 

A2 
Enter the estimated intensity of the pre-exponential for the second decay process. This option 
is only accessible if you have selected Double Exp as the Function type in the Decay Time 
table. 

k1/τ1 
Enter the estimated value of the rate or lifetime for the first decay process. 

K2/τ2 
Enter the estimated value of the rate or lifetime for the second decay process. This option is 
only accessible if you have selected Double Exp as the Function type in the Decay Time 
table. 

C 
Enter the estimated value of the intensity at the end of decay. 
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Recalculate—Lifetimes 
Use the pages accessible via the Recalculate option to perform re-calculations on data that has been analyzed. 
These re-calculations can be made using new Setup parameters. For example you may wish to change the order 
of a reaction. You can also use the Recalculate button to access Report options. 

The Recalculate button is accessible from the Lifetimes Application window. When you select the 
Recalculate option, the Setup dialog will appear, containing the following tabbed pages:  

Analyze
Reports

Operator | Options | X-Y Pairs Table | Status Display 

Use the Reports page to set up the report parameters associated with data collection. 

From the Setup menu, select Reports to access the Reports page. You can also access the page from the 
Setup dialog by selecting the Reports tab. To access the Setup dialog, select the Setup button from the 
Lifetimes Application window. 

The page comprises the following: 

Operator 

Options 

This group enables you to select the information to include in your report. 

See also: 
Setup 
How to use the lifetimes ruler  
Status Display 

See also:
Lifetimes Application

Reports—Lifetimes 

Hot Tip 
You can view your generated report before you print it out using the Print Preview command in the 
File menu 

If you decide to make changes to the report layout, select  (Edit Report) from the Report toolbar. 
This enables you to directly edit the report.

Name Enter the instrument operator name in this text entry field. Use the arrow to the right of this 
field to view and select one of the last ten entries in this field. 

Note 
In GLP mode the system will automatically enter the operator’s name and this field 
will not be editable.

Comment Enter operator details and comments in this text entry field.
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X-Y Pairs Table

Select this if you want to print a table showing the X-Y pairs of the collected data in your report. 

Auto Print Select Auto Print to print a report automatically during the data collection. 
If Auto Print is selected, then the system will send the report information to the specified 
printer(s) as well as the Report area. However if Auto Print is not selected, the report will 
only be sent to the Report area and can be viewed by selecting Report in the View menu. 

To automatically obtain a copy of the graphics, you will need to select both the Auto Print 
and Graph options (see below). In this case, all graphical information displayed on screen 
will be printed with the report. Therefore it is advisable to arrange the graphical information 
as you require on screen, prior to printing.  
For example, if you require a single graph print out, then the Single/Multi Graph option in 
the Graph menu should be changed to the correct setting. 

Parameters Select this option to include the method setup parameters within your report.
User data 
form 

Select this option to include in the report any information entered in the User Data Form.

Graph Select Graph to include any graphs or graphic information associated with your report.  
If you require a printout of the displayed graphics only, you must ensure that only this option 
is selected. Press the Clear Report button to clear any information in the Report area before 
you print otherwise this will be included in your printout. 
% Page Height 
Enter the size at which you want the graph to be printed, as a percentage of total page height. 
For example, if you want graphical information to take up half of the page, enter 50% in this 
field.

Company 
Logo 

Check this option to include your company logo in the report. 
A company logo will only be included if you have added one on the Company page of the 
System Information Application. 

Hot Tip 
If you have not included a company logo, select the Header/Footer button to open the 
System Information Application and use the Add Logo option to add a logo.

Header/ 
Footer 

Select the Header/Footer button to open the System Information application where you can 
enter the Header and Footer information to be included in your report. You can also enter 
any additional comments, and add a logo to your report. Once you have made all your 
changes, select OK to exit the System Information application and return to the Reports 
page of the Lifetimes application.

Focused trace Select this option to apply the Report selections to the focused trace only.
All traces Select this option to apply the Report selections to all visible traces.

Data Interval Actual 
Select Actual to report the X-Y pairs table for the trace at the actual Data Interval at which 
the data was collected. 

Interpolated 
Select Interpolated to report the X-Y pairs table for the trace at an interpolated data 
interval. Enter this data interval in the adjacent field. If no data has been collected at the 
interval you enter, the Cary Eclipse software will interpolate the data to produce an X-Y 
result. 
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Status Display 

Select this check box to display the Status Display window, where you can view the status of your lifetimes 
run during the data collection. 

Reports Toolbar—Lifetimes 
Use the Reports toolbar buttons to gain quick access to many of the Edit menu options. You can also use the 
toolbar to cut, copy and paste information and to change the look of your report. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Reports. To display 
or hide the toolbar's text labels, point to the Toolbar option in the View menu and select Text Labels. 

The following commands can be accessed from the Reports toolbar: 

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, Microsoft 
Word or Microsoft Excel) into the report area of the of the Lifetimes application. To edit these objects, 
simply double click on them to open the associated application in which they were created.

See also: 
View menu  
User Data Form  
Status Display

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Edit Report Click this button to edit the report. 
This command is also accessible by pressing CTRL+R.

Undo If available, this undoes the last action. 
This command is also accessible by pressing CTRL+Z.

Cut Click this button to remove the highlighted text and place it on the Windows 
Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Click this button to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.

Paste Click this button to insert the contents of the Windows Clipboard (text only) at the 
cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Click this button to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
This option is only available once you select Edit Report and there is text 
highlighted in the Report area.  

Font Click this button to change the font of new or selected text in the report. For existing 
text, simply highlight the text in the report, select this button and make your changes 
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Clear Report—Lifetimes 
Select Clear Report to remove the contents of the Report area. If you have saved the report, selecting this 
option does not delete the contents of the report, the information is simply removed from the Report Area. 

You can select the Clear Report button from the Lifetimes Application window or the Clear Report 
command from Commands menu.  

How to use advanced reporting options—Lifetimes 
This outlines ways to fully customize your reports. Options available include:  

Including header and footer information
Including a logo
Editing the text in the report
Viewing the report on screen before printing
Cutting and pasting to a word processor

Including header and footer information 

You can have text appearing at the top and bottom of every page in your report. To specify what the text 
should be, do the following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then select 
System Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter the header and footer information in the Header and Footer fields. 

Step 3 

Click OK to implement your changes. 

Including a logo 

in the Font dialog. When you select OK, the appearance of the highlighted text in the 
report will alter to reflect your font changes. 
This command is also accessible by pressing CTRL+F.

Preview Click this button to display the Print Preview dialog where you can view the current 
report as it will be printed.

See also: 
Print Preview 

See also: 
Lifetimes Application 
Commands menu
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You can include a logo on the first page of your report. To specify what the logo should be, do the following: 

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then select 
System Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter a logo using the Add Logo button. This logo will always be included on the front page of reports. 

Step 3 

Click OK to implement your changes. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can then add, 
delete and change text in the Report area. 

Viewing the report on the screen before printing 

You can view a report before printing it. To do this, from the File menu select Print Preview. You can then 
ensure that the report format is correct before you print it. 

Cutting and pasting to a word processor 

To have complete control over how your report looks you may wish to copy it to a word processor program, 
such as Microsoft Word. To do this: 

Step 1 

Open a report. 

Step 2 

From the Edit menu, choose Edit Report. 

Step 3 

Click in the Report area and highlight the text you want to export to your word processor. 

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application.

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The
Administrator of the system will have to change your privileges before you can edit reports.

Hot Tip 
Use the arrow keys at the bottom of the Print Preview screen to change pages.
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Step 4 

Right-click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text into a 
document. 

Storage | Auto convert | Email | Status display 

Use the Auto store page to specify if and when data will be stored, and in what format. You can also use this 
page to set up the system to automatically send an email at the end of a read. 

From the Setup menu, select Auto store to access the Auto store page. You can also access the page from the 
Setup dialog by selecting the Auto store tab. To access the Setup dialog, select the Setup button from the 
Lifetimes Application window. 

The page comprises the following: 

Storage 

Auto convert 

Use the Auto convert options to convert your data into an ASCII file format that can be opened in spreadsheet 
programs such as Microsoft Excel. 

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to alter the look of your graphs 
How to display a trace that is not appearing

Auto Store—Lifetimes 

Off Select this if you do not wish to be automatically prompted to save collected data. 
Note 
If you wish to store your unsaved data manually, choose Save Data As… from the 
File Menu to save your data after the run is complete. You can save your data as a 
Batch or Data file.

On; Prompt 
At Start 

Select this to display the Windows Save As dialog at the start of the collect where you can 
enter the Batch filename for your data.

On; Prompt 
At End 

Select this to display the Windows Save As dialog at the end of a collect where you can 
enter the Batch filename for your data.

None Select None if you do not need to generate an ASCII file.
ASCII (csv) Select this option to save the data as a comma delimited ASCII Spreadsheet file (*.CSV) file. 

Only the currently collected data is converted. 

ASCII files are stored in the same folder as the data file from which they were generated and 
designated the same filename as the method used to collect the data plus the extension 
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Email 

Select the Email check box and enter the Email details to send an email to a person once the read is completed. 
This useful facility can be used to alert you to the completion of the read, particularly if you are working away 
from the laboratory where the Cary Eclipse instrument is. You can also attach the collected data to the email. 

Status display 

‘CSV’. 
ASCII (csv) 
with log 

Select this option to save the data as a comma delimited ASCII Spreadsheet file (*.CSV) file. 
Only the currently collected data is converted. The key method parameters used to collect the 
data are also saved in this file. 

ASCII files are stored in the same folder as the data file from which they were generated and 
designated the same filename as the method used to collect the data plus the extension 
‘CSV’. 

Note 
If you choose to auto-convert the data to an ASCII file but you have set the Storage 
option to Off, then the ASCII file will be saved with the following format: 
DATE TIME. CSV 

The date and time will appear in the same form that is set in the Windows Regional 
Settings Properties dialog that is accessed from the Windows Control Panel. 

For example, 22_4_97 1;32;08.CSV 

Q. Why are the Auto Convert options grayed out?
A. The Auto Convert options are only applicable when setting up data collection
reports. Therefore, they are only available when you access the Setup dialog by
selecting the Setup button or selecting the Setup command from the Setup menu.
When you access the Setup dialog by selecting the Recalculate button, the Auto
Convert options are grayed out.

Tell me more about ASCII Spreadsheet Files 

Note 
You must set up the email Host and Port options on the Email options page of the System Information 
application in order for the email facility to work correctly.

To Enter the recipient's email address. You can enter more than one recipient in this field.
From Enter your email address (or the email address associated with the computer on which the 

Cary Eclipse software is installed.
Subject Enter the subject of your email (or leave this field blank if you do not wish to include a 

subject).
Cc Enter the email address of any recipient you want to copy the email to.
Message Enter your message.
Attached… Use the Attached button include a file attachment in your email. To do this, select Attached 

and browse your computer to select a file, using the Windows® Open dialog that appears.
Attach current 
data 

Select this option to attach the data that has been collected during the run to the email.

How to email your results  
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Select this check box to display the Status Display window, where you can view the status of your lifetimes 
run during the data collection. 

How to email your results—Lifetimes 
You may wish to send an email to a person once the read is completed. This useful facility can be used to alert 
you to the completion of the read, particularly if you are working away from the laboratory where the Cary 
Eclipse instrument is. 

To do this: 

Step 1 

Ensure that you have set up the Host and Port options on the Email options page of the System Information 
application in order for the email facility to work correctly. 

Step 2 

From the Setup menu, select Auto Store. The Auto Store page is displayed. 

Step 3 

Select the Email check box to enable the email options. 

Step 4 

In the To field, enter the recipient's email address (for example, rchandler@varianinc.com). To enter multiple 
recipients, simply type a comma ',' between each email address. 

Step 5 

In the From field, enter the email address of the computer on which the Cary Eclipse software is installed. This 
may be your email address, or a communal email address, if the Cary Eclipse software is installed on a 
computer that has multiple users. 

Step 6 

Enter information in the Subject and Message fields as required. 

Step 7 

Select Attach current data. The data that has been collected during the run will be attached to the email. 

Step 8 

See also: 
Save As dialog   
Status Display 

Hot Tip 
You can attach other documents to your email. To do this, select the Attached button and browse your 
computer to select a file, using the Windows® Open dialog that is displayed.
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Select OK to clear the Auto Store dialog. Your email will be sent once the run has been completed. 

Performing scans—Lifetimes 
Starting a run
Sample Name dialog
Cell Loading Guide
Start/Stop buttons
Pre-scan dialog
Rapid Result dialog
Zero dialog
Go To dialog
Commands menu
How to perform a temperature controlled run

The sequence that occurs when you select Start to commence the lifetimes run depends upon your storage and 
accessory selections. 

Storage selections 

Accessory selections 

See also: 
Auto Store 

Information about starting a collect—Lifetimes 

If you have selected … as the Storage 
option on the Auto Store page 

The following occurs 

On, prompt at start The Windows Save As dialog will appear as soon as you select 
Start. You can save the current method, collected data, report and 
graph template as a Batch file.

On, prompt at End The Windows Save As dialog will appear at the end of the data 
collection. You can save the current method, collected data, report 
and graph template as a Batch file.

Off  The Windows Save As dialog will not appear.

If you have selected … on the 
Accessories page 

The following dialog is displayed 

No accessories The Sample Name dialog will appear when you select Start, 
prompting you to load the sample and enter your sample name. 
Select OK to commence the lifetimes run.

Multicell Holder The Cell Loading Guide dialog will appear. Enter the sample 
name of each activated cell then select OK to commence the 
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Sample Name—Lifetimes 
If you are using a single cell holder, the Sample Name dialog appears once you select the Start button to 
commence an analysis. 

The page comprises the following: 

Cell Loading Guide—Lifetimes 
If you are using a Multicell Holder, the Cell Loading Guide dialog appears once you click the Start button to 
commence an analysis. 

The Cell Loading Guide dialog prompts you to insert blank samples in the Multicell Holder to collect the 
Lifetimes scans. You can also use the dialog to name the samples in each selected cell in the Multicell Holder. 

The dialog comprises the following: 

lifetimes run.

See also: 

Sample Name 
Cell Loading Guide 
Start/Stop buttons 
Setup 
Accessories 
Auto Store 

Sample Name Enter the name of the sample to be used in the lifetimes run. Click on the arrow to the right of 
the field to view and select the most recently entered sample names. 
Once you have entered the Sample Name, select OK to commence the lifetimes run. 

See also: 
Cell Loading Guide

Loading 
Guide/Sample 
Name entry

Enter the names of the sample to be used in the lifetimes run in each available field. This 
sample name will be used as the Name of Trace in the Trace Preferences dialog. 

Once you have entered the Sample Name, select OK to commence the Lifetimes run. 

Note 
The Cell Loading Guide dialog appears only if you have 
selected the Multicell Holder option on the Accessories 
page of the Setup dialog. Only cells selected in the 
Multicell Holder diagram on the Accessories page will be 
available in the Loading Guide. 

In the adjacent example, cells 1—3 will be available in the 
Loading Guide dialog, as they have been selected in the 
Multicell Holder diagram. 

See also: 
Accessories 
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The following buttons may be displayed at the top of the Lifetimes Application window. The Start and 
Connect buttons will change depending upon the status of the run. For example, if a run has not been started, 
the Start button will be visible to indicate that the system is ready to commence a run. 

Zero—Lifetimes 
Use the Zero button to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use the Zero 
command before commencing a data collection if you want your data to start at 0  intensity. The Cary Eclipse 
will prompt you to load a blank before performing the zero. 

Before you select Zero, ensure that you have placed the blank solution in the cell positions that are currently in 
the cell path. 

When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the 
Lifetimes Application window. 

Select the Clear Zero command from the Commands menu to remove zero correction and thus remove the 
subtraction effect. 

Pre-scan—Lifetimes 

Sample Name

Start/Stop Instrument buttons—Lifetimes 

Select Start to commence a lifetimes run using the current Setup parameters. 
If any unsaved data exists in the Graphics area you will be prompted to save the 
data. If you choose not to save, any unsaved data, pictures and labels will be deleted 
when you start the lifetimes run. 

If another application is already online with the Cary Eclipse, the Start button will 
change to Connect, and you will need to select Connect to bring this application 
online before the Start button will re-appear. However, you will not be able to 
Connect if the other application is collecting data.

Select this to end a lifetimes run. 
If you have selected Storage On on the Auto Store page of the Setup dialog, all 
data collected is automatically stored in the file specified in the Batch name field of 
the Windows Save As dialog before or after the run commenced. 

See also: 
Graphics area 
Auto Store 
Command buttons 
Commands menu

To access the Zero option, select the Zero command from the Commands menu, or select the 
Zero button from the Lifetimes Application window. 

See also: 
Lifetimes Application window 
Commands menu 
Cell Loading Guide
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Select Pre-scan to determine the optimum instrument parameters to be used for your sample. At the end of this 
collection sequence the software will report the optimum Ex and Em wavelengths and PMT voltage. Once you 
are satisfied with the parameters, the software will automatically update your method setup to reflect these new 
parameters. 

The Pre-scan dialog comprises the following: 

Type of scatter 

Select he type of scatter you wish to search for from the following: 

Use the Go to Wavelength dialog to temporarily change the instrument to a new excitation or emission 
wavelength. You would mainly use this dialog if you want to quickly go to a wavelength and check the 
intensity reading of the sample. The lamp will flash continuously in this mode. This option is only available if 
the instrument is not currently collecting data. 

To access the Go to Wavelength dialog, select the Go To Wavelength command from the Commands menu. 
You can also select F4 to open the dialog. 

The Go to Wavelength page comprises the following: 

To access the Pre-scan option, select the Pre-scan command from the Graph menu, or select 
the Pre-scan button from the Lifetimes Application window.

Rayleigh 
scatter 

Rayleigh scatter refers to the scatter of the excitation light. It is displayed at the peak of the 
excitation wavelength.

Raman scatter Raman scatter refers to scatter due to the solvent. Its peak is at a fixed energy from the 
excitation wavelength, and is solvent dependent. Thus, the type of solvent used must be 
selected from the Solvent list.

2nd order Second order scatter refers to the scatter of higher order excitation light. Its peak is a multiple 
of the excitation wavelength.

See also: 
Graph menu  
Lifetimes Application

Go to Wavelength—Lifetimes 

Note 
This is not the wavelength used in the application method. If your method uses a wavelength that is 
different from the 'Go to wavelength' setting you select, then when you select Start the system will 
change to the wavelength selected. (In most applications, this is set in the Cary page of the Setup dialog.) 

Excitation Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go tothe instrument 
will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white 
light). You can then use this light for aligning accessories. 

Emission Wavelength 
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Use the Rapid Result dialog to take a reading of a blank and sample/s, without having to change the current 
application method. You can use the Multi Cell Changer dialog to specify the cell you want to read. This 
means that between runs, while new samples are being prepared and loaded, other samples can quickly be 
measured. The result is printed in the Report area. 

To access the Rapid Result dialog, select Rapid Result from the Commands menu or press F6. 

Use the Commands menu to access major operational commands in the Advanced Reads application. The 
menu is accessible from the menu line at the top of the Lifetimes Application window. 

Alternatively you can use function key shortcuts for some of the commands. These appear next to the item in 
the Commands menu. Note that not all commands appear as both button and menu items. 

Enter the new wavelength in this numeric entry field. When you select Go to the instrument 
will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white 
light). You can then use this light for aligning accessories. 

Go To Click Go to once you have entered a new wavelength, to change the instrument to the entered 
value.

See also: 
Commands menu 
Function Keys

Rapid Result—Lifetimes 

Excitation Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Emission Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Zero Click Zero to change the wavelength to the entered value and measure a blank.
Result Click Result to change the wavelength to the entered value and measure a sample. The X,Y 

results are corrected for the blank and the results appear in the report window.
See also: 
Multi Cell Changer  
Commands menu 

Commands menu—Lifetimes 

Hot Tip 
If you access these commands using the Commands menu, rather than from the application buttons, you 
can remove these buttons from your application window. To do this, clear the Buttons command in the 
View menu. 
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The Commands menu comprises the following commands: 

Tell me how to remove or display the command buttons   

Command What it does

Start Select this to start a data collection using the currently set up parameters. 
Note 
If the Connect command is displayed in place of the Start command, this indicates 
that another Cary Eclipse application is in use and has control of the Cary Eclipse 
instrument. To make the Advanced Reads application active so that you can perform a 
read, you will need to select Connect. However, you will not be able to select 
Connect if another application is collecting data.

Stop Select this to stop the data collection. 
If you have selected Storage On in the Auto Store page of the Setup dialog, all data 
collected is automatically stored in the file specified in the Batch name field of the 
Windows Save As dialog before or after the run commenced. 

Clear Zero Select this option to clear the Zero command. When you select the Zero command (from 
the Commands menu or by pressing F5), the intensity at that time will be reset to zero and 
all subsequent results will have the intensity value that was reset to zero subtracted from 
them. Selecting Clear zero cancels this zeroing (and thus subtraction) effect.

Pre-scan Select Pre-scan to quickly determine the optimum instrument parameters to be used for 
your sample. At the end of this collection sequence the software will report the optimum Ex 
and Em wavelengths and PMT voltage. Once you are satisfied with the parameters, the 
software will automatically update your method setup to reflect these new parameters.

Zero order… Select the Zero order command to set one of the monochromators to zero order. If you use 
this command to zero either the excitation or emission monochromators, this will override 
the Ex. Wavelength or Em. Wavelength set on the Cary page. The Cary Eclipse software 
will use the zero setting when collecting data. 

The Zero order command is generally used during alignment procedures.  

Excitation 
Select this command to set the excitation monochromator to zero order (white light). 

Emission 
Select this command to set the emission monochromator to zero order (white light). 

Reset Select this command to re-initialize the instrument. This will perform the same initializing 
procedure that is performed when the instrument is powered on. 

Rapid Result Select this to display the Rapid Result dialog. Use this dialog to take a reading of a blank 
and multiple sample readings without changing the application method. This means that 
between runs, while new samples are being prepared and loaded, other samples can quickly 
be measured. 
This command can also be accessed by pressing F6.

Zero Select this to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can 
use the Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible by pressing F5. 

Note 
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How to perform a temperature controlled lifetimes run—Lifetimes 
This demonstrates how to perform a fluorescence single cell, multi-rate lifetimes run at 37°C using the single 
cell Peltier accessory. 

Follow the steps through, adjusting them to meet the requirements of your particular data collection.  

Start the Lifetimes application
Set up data collection parameters
Ensure Multicell Holder accessory is not selected
Set up accessories for reaction temperature control and temperature display
Set up instrument parameters
Set up rate parameters
Set up collection display options
Set up rate calculation, rate order an other rate parameters
Set up reporting and printing requirements
Set up storage of collected data
Set up visual system monitoring
Finish Setup
Start the lifetimes run

Start the Lifetimes application  

Step 1 

Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Go to… Select Go to… to display the Go To Wavelength dialog where you can change the 
instrument to a new wavelength. Use this command if you want to quickly go to a 
wavelength to check the intensity reading. 
This command is only available if the instrument is not currently collecting data. It can also 
be accessed by pressing F4. 

Note 
This is not the wavelength used in the application method. If your method uses a 
wavelength that is different from the Go To wavelength, then when you select Start 
the system will change to the wavelength selected. (In most applications, this is set in 
the Cary tab of the Setup dialog.) 

ADL 
Command 

Select this to display the ADL Command Line window where you can execute an ADL 
command or ADL program. (You can also press Alt-Y to display this dialog.)

Re-run ADL Select this to run the ADL command or program in the ADL Command Line window again. 
(You can also press Alt-X to rerun programs.)

See also: 
Lifetimes Application   
Auto Store  
Cary  
Pre-scan 
Rapid Result  
Go To Wavelength   
ADL Command Line 
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Click the Windows Start button, point to Programs, Cary Eclipse and then select Lifetimes. The Lifetimes 
Application is displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select Setup to display the Setup dialog and specify the method parameters for a new method. 

To do this: 

Ensure Multicell Holder accessory is not selected 

Step 3 [Setup dialog | Accessories page] 

Select the Accessories tab to display the Accessories page. On the Multicell/Temperature tab, 
ensure that the Multicell Holder accessory is not selected. 

Set up accessories for reaction temperature control and temperature display 

Step 4 [Setup dialog | Accessories page]  

a. Select the Temperature control check box to enable the Temperature group.

b. Click on the down arrow adjacent to the Device field and select the Single Cell Peltier accessory.

c. Set the Temperature to 37°C.

d. In the Temperature Display group, select Probe 1 to view the temperature of one temperature probe in
the Status Display window.

Set up instrument parameters  

Step 5 [Setup dialog | Cary page]  

a. Enter the Delay Time, which is the time that elapses between the last flash and the beginning of data
collection. Setting a delay time ensures that there is no lamp effects in the phosphorescence decay curve.

b. Enter, in milliseconds, the Gate Time for your sample. The gate time is the overall reading time of the
emission signal.

c. Enter the No. of Flashes, which is how many times the lamp flashes consecutively before the delay time
is counted.

d. In the Ex. Wavelength field, set the wavelength of the excitation monochromator, which is the
wavelength value at which you want to excite your sample.

e. In the Em. Wavelength field, set the wavelength of the emission monochromator, which is the
wavelength value at which your sample emits.

Note 
If you are running a GLP system, you may be prompted to enter a password before accessing the 
Lifetimes application.
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f. Set the slit width of the excitation monochromator.
Note that as a general rule, at a fixed emission slit width, increasing the excitation slit width will result in
an increase in the fluorescence excitation intensity.

g. Set the slit width of the emission monochromator.
Note that as a general rule, at a fixed excitation slit width, a two-fold increase in the emission slit width
will result in a four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the
emission slit width will result in a four-fold decrease in the emission intensity.

Set up rate parameters  

Step 6 [Setup dialog | Cary tab] 

a. Enter the Total Decay Time. You should enter a time that will allow for the phosphorescence signal to
decay to approximately zero. The lamp will not flash until the total decay time has elapsed.

b. Enter the No. of Cycles (or decay curves) over which the run will be collected. This number will be used
to average the data. Entering a number of cycles value enables you to obtain better signal to noise ratios
as multiple traces can be averaged.

Set up collection display options 

Step 7 [Setup dialog | Options page]  

a. Select the Options tab. The Options page is displayed.

b. Enter the minimum and maximum Y values to be displayed on the graph axis during the data collection.

c. Set the Excitation filter for the concentration measurement. It is recommended that you set the filter to
Auto ( the default setting). This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

d. Set the Excitation filter and the Emission filter for the concentration measurement. In order to
minimize steps in the spectra, it is recommended that you set the filter to Open (the default setting).

e. Set the PMT Detector Voltage. The setting you choose will depend upon your sample. For example, a
Low setting is recommended for highly emitting samples, while a High setting is recommended for low
emitting samples.

Set up rate calculation, rate order and other rate parameters  

Step 8 [Setup dialog | Analyze page]  

a. Select the Analyze tab. The Analyze page is displayed.

b. Select the Auto Calculate check box to automatically perform a rate calculation on collected data at the
end of each run.

c. In the Decay Time table, enter the calculation Start and Stop times (in minutes or seconds) for a rate or
lifetime calculation analysis and select the Function Type.

d. You can select the Manual Guess check box and manually enter the parameters: Intensity(0), Intensity
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(∞) and Rate. It is presumed that you have a reasonable idea of the values for these fit parameters, as 
they will be used as a first guess in the fitting procedure. 

f. Set the Plot type to Fit to automatically overlay the calculated lines of best fit onto the plotted data.

Set up reporting and printing requirements  

Step 9 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

e. Select the X-Y Pairs Table check box to view a list of abscissa values and their corresponding intensity
values.

Set up storage of collected data  

Step 10 [Setup dialog | Auto Store page] 

a. Select the Auto Store tab to display the Auto Store page.

b. Set the Storage option to On; prompt at start. You will be prompted to save your method (with
calibration), collected data and report when you commence the run.

c. Select the Auto Convert option you require. If you select ASCII (csv) or ASCII (csv) with log, then at
the end of the data collection the system will automatically generate a report and store the data both in
the Cary Eclipse format as well as ASCII XY pairs format. The data file will be saved in the current
folder.

Set up visual system monitoring  

Step 11 [Setup dialog] 

Note 
If you do not choose Manual Guess, the Cary Eclipse system will automatically calculate the values
Intensity(0), Intensity(∞) and Rate when you select OK to exit the Setup dialog. 

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as w
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report a
and can be viewed by selecting the Report command from the View menu.
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Select the Status Display check box on any of the Setup pages to display various information fields on your 
current reaction. 

Finish Setup  

Step 11 

Once you are satisfied with your method setup select OK to confirm any changes you have made and clear the 
Setup dialog. 

Zero the instrument  

Step 13  

a. Select the Zero button to zero the system. Alternatively, select Zero from the Commands menu to
perform a zero. The Cell Loading Guide dialog will be displayed.

b. Place the blank solution in the sample compartment and select OK. The system will perform an
instrument zero on the blank solution.

Start the lifetimes run  

Step 14  

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands
menu. Do not add your active reagent at this time. The system will display the Save As dialog.

b. Enter the file name for this lifetimes run in the File name field and select Save. The system will display
the Cell Loading Guide dialog.

c. Place the sample solution in the correct cell position and select OK. The Sync Start dialog will be
displayed.

d. Add your active reagent just before the Count Down reaches 0:00 or commence the data collection by
selecting the OK button.

Viewing run progress and results—Lifetimes 
Reports page
Reports toolbar
Clear Report
View menu
Edit menu
Status display
User Data Form
Print Preview dialog
Print

See also: 
How to perform post run calculations on previously stored data 
How to export collected data
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The View menu is accessible from the menu line at the top of the Lifetimes Application window. 

The following commands can be accessed from the View menu: 

View menu—Lifetimes 

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open it. 
Any data will be displayed in the Graphics area.

Command What it does…

Toolbar Select this option to toggle the Graphics and Reports toolbar on and off. You can also 
select to display or hide the toolbar Text Labels.

Buttons Select this option to toggle the left-hand button display (button area) on and off.

Graphics Select this option to toggle the Graphics area on and off. 

Report Select this option to toggle the Report area on and off.

Report 
Vertical 

If the Graphics option is selected, select Report Vertical to display the Graphics area, 
Report area and/or ADL Editor side by side vertically.

ADL Select this option to toggle the ADL Editor on and off.

ADL Vertical If the ADL and Report options are selected, select ADL Vertical to display the ADL 
Editor vertically on the right hand side of the Report area.

ADL Quick 
Reference 

This displays the Quick Reference window where you can easily add a command in the 
correct syntax to your ADL program. A detailed description of all the commands in the 
Quick Reference is available by selecting the Help button.

ADL Hooks Select this to activate a link (or hook) to an ADL program at a specific point in the 
application, and then run that ADL program. For example, ADL hooks have been supplied 
to run specific programs: 

on start-up of the Cary Eclipse software;
when the system goes online or offline;
when the Start button is selected;
when a run finishes;
when a zero is performed etc.

For the hook to work, ADL Hooks must be selected, and the appropriate ADL file for the 
application must be present in the ADL folder in the directory. 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Hints Select this option to toggle the Hints bubble text on and off. The bubble text appears when 
you place the arrow cursor over a field, button or text entry field for a short period. It offers 
a quick explanation of the item’s function.
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Edit menu—Lifetimes 
Use the Edit menu to copy, cut, paste and delete information. You can also use the menu to access the Report 
editing commands. The menu is accessible from the menu line at the top of the Lifetimes Application window. 

The following commands can be accessed from the Edit menu: 

Status 
Display 

Select this option to display the Status Display window, where you can view the status of 
various parameters during the data collection.

See also: 
Lifetimes Application  
Graphics area   
Status Display   
ADL Hooks 
How to insert ADL commands using the Quick Reference

Command Button What it does… 
Undo If available, this undoes the last action. 

This command is also accessible by pressing CTRL+Z.
Cut Select this command to remove the highlighted text and place it on the Windows 

Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Select this command to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.

Paste Select this command to insert the contents of the Windows Clipboard (text only) at 
the cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Clear/Delete Select this command to remove selected text in the Report area. This option is only 
available once you select Edit Report and there is text highlighted in the Report 
area. 
This command is also accessible by pressing DEL.

Select All Select this option to highlight all text in the Report area. 
This command is also accessible by pressing CTRL+A.

Font This enables you to change the font of new or selected text in the report. For existing 
text, simply highlight the text in the report, select Font and make your changes in the 
Font dialog. When you select OK, the appearance of the highlighted text in the 
report will alter to reflect your font changes. You do not have to select Edit Report 
to use this command. 
This command is also accessible by pressing CTRL+F.

Edit Report Select this option to edit the report. 
This command is also accessible by pressing CTRL+R.

Clear Report Select this command to remove the contents of the Report area. If you have saved the 
report, selecting this option does not delete the contents of the report, the information 
is simply removed from the Report area.

Recalculate Use the pages accessible from the Recalculate option to perform re-calculations on 
data that has been analyzed. 

Hot Tip 
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Status Display—Lifetimes 
Use the Status Display window to view the status of your lifetimes run during the data collection. Depending 
upon settings you have for the lifetimes run, the following parameters may be displayed:  

Current Excitation Wavelength (nm)
Current Emission Wavelength (nm)
Excitation Slit Width (nm)
Emission Slit Width
PMT Voltage (V)

To access the Status Display, select Status Display from the View menu, or from any page of the Setup dialog. 
You can choose to view the Status Display at any time during a lifetimes run. 

User Data Form—Lifetimes 
Use the User Data Form to enter extra information about the traces in the highlighted graph box. For example, 
you might want to record information about the experimental conditions you used to collect the data. 

The dialog comprises the following: 

Print Preview—Lifetimes 
Use the Print Preview dialog to view the current report before you print it. From the File menu, select Print 
Preview to access the dialog. 

You can copy a picture, spreadsheet file or document from another application (for example, Microsoft 
Word or Microsoft Excel) into the report area of the of the Lifetimes application. To edit these objects, 
simply double click on them to open the associated application in which they were created.
See also: 
Lifetimes Application

See also: 
Status Line  
View menu 
Setup

To access the User Data Form, select the User Data Form command from the Graph menu, or select 
the User Data Form button on the Graphics toolbar. The User Data Form command is only available if 
you have selected a graph box.

Data Name This column lists the names of each visible trace in the highlighted graph box. 

Use the extra columns for recording additional information about the experimental conditions 
you used to collect the data, for example, pH. 

Other 
Columns 

Use this to record the name of the parameter in which you are interested as a column 
heading, (for example, pH, ionic concentration, substrate concentration etc.). 

Note 
You must enter a column heading, or else the data in that column will not be saved.

See also: 
Graph menu  
Graphics toolbar
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The contents of the Graphics area appear first in the preview area followed by the contents of the Report area. 
You can reduce or enlarge the print preview on screen. To do this, click the left mouse button in the preview 
area to toggle through the five available views. Click the right mouse button in the preview area to return to the 
full page view.  

The page comprises the following commands: 

Print—Lifetimes 
Use the Print dialog to select the printer and pages to print of the currently displayed report as well as the 
number of copies you wish to print. 

All graphical information displayed on screen will be printed with the report, therefore it is advisable to edit 
the report on the screen prior to printing. You can also preview the report prior to printing by using the Print 
Preview command. 

If you require a printout of the graphics in the Graphics area only, select the Clear Report button to erase the 
contents of the Report area before you print. 

Performing Calculations—Lifetimes—Lifetimes 

First arrow Use this arrow to view the first page of the report. 

Previous 
arrow

Use this arrow to view the previous page of the report. 

Next arrow Use this arrow to view the next page of the report. 

Last arrow Use this arrow to view the last page of the report. 
Q. Why are the arrow buttons grayed out?
A. The buttons will be grayed out if the report has only one page of data.

Print Use this to display the Windows Print dialog where you can choose the printer and 
pages to print as well as the number of copies you wish to print.

See also: 
File menu 
Print

To access the Print option, select the Print command from the File menu, or select the Print 
button from the Lifetimes Application window. 

Note 
The options on the Report page are used to generate the contents of the Report area during a run or on a 
recalculation. If Auto Print has been selected the Cary Eclipse will automatically print a report at the 
end of a data collection. 

See also:  
Print Preview  
Report page 
Edit Report  
Lifetimes Application
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Recalculate
Analyze
How to perform post run calculations on previously stored data
How to generate a report from previously stored data
How to use advanced reporting options
Maths Calculator
Maths Operations
Maths How To
User Data Form

How to perform post run calculations on previously stored data—
Lifetimes 

Retrieve the data
Set up the recalculation
Print the report

Retrieve the data 

Step 1 

From the File menu, select Open to display the Windows Open dialog. 

Step 2 

A list of previously stored Batch files will appear. Select the Batch file you require then select Open. 

The system will automatically retrieve the collected data into the Graphics area. The method that was used to 
collect the data will also be retrieved. 

Set up the recalculation 

Step 3 

Select the Recalculate button to display the Setup dialog. The Analyze and Reports pages will be displayed 
to enable you to set up the recalculation parameters. 

Step 4 

Select the Analyze tab to access the Analyze page where you can set the analysis parameters you require. 

For example, select the Auto Calculate option to automatically perform a rate calculation on collected data at 
the end of each run. 

Step 5 

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements
for this method.

Note 
You can also retrieve data from Data (*.FDLT), Method (*FMLT) and Spreadsheet ASCII (*.CSV) file 
types.
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b. Enter your name in the Name field.

c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

Step 6 

Select OK to clear the Setup dialog and start the recalculations. The results will be displayed in the Report 
area. 

Print the report 

Step 7  

a. From the File menu, select Print. The Windows Print dialog is displayed.

b. Set up your printing parameters and select OK to print your report.

How to generate a report from previously stored data—Lifetimes 
Step 1 

Select Open… from the File menu to display the Windows Open dialog. 

Step 2 

A list of previously stored files will appear. If this is not a list of batch files, select the down arrow at the right 
of the Files of type list box and select 'Batch' to list all the batch files. 

Step 3 

Select the Batch file you require then select Open. 

The system will automatically retrieve the collected data into the Graphics area. The method that was used to 
collect the data will also be retrieved. 

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as well 
as the Report area. However if Auto Print is not selected, the report will only be sent to the Report area 
and can be viewed by selecting the Report command from the View menu.

See also:
How to generate a report from previously collected data

Note 
You can also retrieve data from Methods (*.FMLTN), Data (*.FDLT), Report (*.FRLT), Spreadsheet 
ASCII (*.CSV), GRAMS (*.SPC) and Rich Text Format (*.RTF) file types.
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Step 4 

Select the Recalculate button to display the Setup dialog. 

Step 5 

Select the Reports tab and on the Reports page specify the information you would like to include in the report. 
Select Auto Print if you require the new report to print to the Reports area and to a printer. 

Step 6 

Click OK to display the results in the Report area (and send to the printer if Auto Print is selected). 

Maths window 
Calculation Field | Selected/Focused Trace | Trace | Display Options | Functions

Use the Maths window to perform mathematical manipulations on collected traces. In addition, it can act as a 
simple numeric calculator. 

The Maths window comprises the following: 

Note 
If you require a printout of only the current graphics in the Graphics area of a previously stored data file: 

a. Select the Clear Report option in the Commands menu to clear any text that may be displayed in
the Report area.

b. Press the Print button to obtain a printout of the graphics.

Alternatively tick only the Graph check box in the Reports page to obtain a printout of graphics only. 

See also: 
How to use advanced reporting options

To access the Maths window, select the Calculator command from the Graph menu, or select the 
Calculator button on the Graphics toolbar. 
The Maths window is only available in the Kinetics, Lifetimes, Scan and Validate applications.

Calculation 
display field 

View the current calculation, including the trace/s being used, the trace operation being 
carried out and any functions that have been applied to the trace. 

Hot Tip 
Click on the down arrow adjacent to this field to view the last ten unique calculations 
that have taken place. Use this list to keep track of previous manipulations and repeat 
calculations quickly by simply selecting and then applying the desired calculation.

Selected 
Trace/Focused 
Trace 

Choosing either of these options selects the highlighted (red) trace in the current Graph box 
for manipulation. When choosing between these options, use this simple rule: 

Use the Selected Trace option when the selected calculation is only to be applied to
one trace.
Use the Focused Trace option when the same calculation is to be applied to a number
of traces.
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The following example illustrates the difference between these options. 

To perform the same manipulation on several traces:  

a. Highlight a trace by clicking on it with the mouse. The trace will become red.
b. Select Selected Trace, Apply and then = to plot the result of the calculation
c. Highlight the next trace and repeat step b.

OR  

a. Highlight the first trace.
b. Select Focused Trace, Apply and then = to plot the result of the calculation;
c. Highlight the next trace and select the = button to perform the same calculation on the

newly selected trace.
Trace Use the Trace group options to select the operation to be performed on the traces, the filter 

size and the interval (where applicable). 
Click Apply to insert the selected operation into the equation 
Click = (equals) to display the result of the calculations. 

Operation 
Click on an operation to find out more about it 

Anisotropy
Polarization
Sum Function
Mean
Boxcar Averaging
Moving Average
Savitzky-Golay
Spline
Deriv 1
Deriv 2
Deriv 3
Deriv 4

Display 
Options 

Select whether the results of the operation performed on the trace will be viewed in a New 
Graph box or in the Selected Graph box. If you choose the Selected Graph option, you will 
be able to directly compare the results with existing traces.

Functions This group contains number and function buttons that can be used as a standard calculator in 
addition to being applied to traces. 

To use the functions: 

1. select a trace or value
2. select either a second trace or number
3. select the equals (=) button to display the result

All the basic mathematical functions are available (addition, subtraction, multiplication and 
division), as well as logarithm (Log) and square root (Sqrt) functions. When used as a 
calculator, the results of equations appear in the Report area. 

Additional 
buttons 

C 
Click C to clear the entire operation in the calculation display field. 
CE 
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Click CE to clear the last entry entered in the calculation display field. 
= 
Click = (equals) to start the operation shown in the calculation display field.

See also: 
Maths Home Page 
Maths How To

Maths Operations 

The following operations can be selected on the Maths window. To access the Maths window, select 
the Calculator command from the Graph menu, or select the Calculator button on the Graphics 
toolbar.

Anisotropy, 
Polarization 
and Sum 
Function 

The term Anisotropy refers to an unequal angular distribution about a point in space. 
Anisotropy also refers specifically to a simple expression for measuring the degree of 
polarization of the fluorescence.  It is almost identical to the expression for polarization apart 
from having a factor of two in the denominator.  Anisotropy is usually represented by the 
lowercase letter " r ", while polarization by an uppercase  " P ". 

The two expressions are listed below: 

Anisotropy 
r = (Ivv - GIvh) / (Ivv + 2GIvh) 

Polarisation 
P = (Ivv - GIvh) / (Ivv + GIvh) 

where 

Ivv equals the intensity of fluorescence with excitation polarizer = vertical, emission 
polarizer = vertical 
Ivh equals the intensity of fluorescence with excitation polarizer = vertical, emission 
polarizer = horizontal 

G is a factor that accounts for the polarization bias of the instrument. In particular it accounts 
for the wavelength-dependent polarization bias of the emission side of the instrument 
(dominated by the polarization bias of the emission grating). 

The G factor is given by:  
G = Ihv/Ihh 

where 

Ihv equals the intensity of fluorescence with excitation polarizer = horizontal, emission 
polarizer = vertical 

Ihh equals the intensity of fluorescence with excitation polarizer = horizontal, emission 
polarizer = horizontal 

The expression for the anisotropy is a quotient.  The denominator of the expression, as given 
by Ivv + 2GIvh is the ‘sum’ function, and actually represents the total emission unbiased by 
any sample polarization effects. 
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Mean The Mean operation allows the average of two or more traces to be taken and the resulting 
trace to be plotted. The mean of the traces can also be used in conjunction with other 
functions. 

The equation used in mean calculations is: 

(scan 1 + scan 2...+ scan x)/x 

The calculation is performed over the common X range of the traces and the trace with the 
most dense data is used to determine the data points. The other traces are interpolated at the 
relevant data points. 

Boxcar 
Averaging 

This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 

For example, for the following: 

 The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x8, sum(y6:y10)/5) ….. 
(xn-2, sum(yn-4:yn)/5). 

If there are not enough points at the end of the data set to complete the filter size, then these 
points will be ignored, hence, the gap at the end may be larger than the gap in the beginning. 
There will be a gap before the first point and after the last point of the smoothed continuum, 
with respect to the original unsmoothed data. This algorithm is only valid for evenly x-
spaced data points.  

Within a time scan, (e.g., Advanced collect in kinetics) the data points may be unevenly 
spaced between different stages.  Each stage will be treated as a new collect, hence, there 
may be large gaps between stages.  If there are not enough points at the end of a stage to 
complete the filter size, then these points are ignored, hence, there may be large gaps at the 
end of a stage.  The filter size will be limited to odd numbers, with the minimum of 3 to a 
maximum of 101. 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5

Moving 
Average 

This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 

For example, for the following: 

The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x4, sum(y2:y6)/5) ….. 
(xn-2, sum(yn-4:yn)/5). There will be a gap before the first point and after the last point of 
the smoothed continuum, with respect to the original unsmoothed data. This algorithm is 
only valid for evenly x-spaced data points. Within a time scan, (e.gg, Advanced collect in 
kinetics), the data points may be unevenly spaced between different stages. This will be 
treated by interpolation of data from the previous stage so as to give evenly spaced data 
points into the next stage. If there is not enough data for interpolation, then the next stage 
will be treated as a new collect, hence, there may be gaps and further delays in displaying the 
point. The filter size will be limited to odd numbers, with the minimum of 3 to a maximum 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5
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Displaying data graphically—Lifetimes 
Graphics area
Graphics How To
Graph menu
Graphics toolbar
Graph Labels
Add Label dialog

of 101. 
Savitzky-
Golay 

The Savitzky-Golay technique operation enables  you to reduce the noise in the currently 
selected Maths scan by using smoothing. 

When you select this operation you will be prompted to enter a Filter Size from 5 to 101. The 
larger the Filter Size, the more data points that will be smoothed. 

You will also need to enter an Interval. The Interval refers to how many of the averaged 
points will be plotted on the smoothed trace. The smaller the interval, the more detail there 
will be in the trace. 

Consider selecting an Interval of 1. This would mean that when the smoothed continuum is 
plotted, every smoothed point will be displayed. 

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an even
number.

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select Smooth in the Operation field.

Spline 
Deriv 1–4 The Deriv operations allow you to obtain derivatives of a selected scan. The derivative can 

be of the orders 1 to 4. The resulting trace is then plotted.  The Savitzky-Golay technique is 
used for derivative calculations. 

On selection of the Deriv operation you will be prompted to enter a Filter Size from 5 to 101. 
The Filter Size refers to the number of points around a particular point that will be averaged 
to produce a new derived Y value. The lower the Filter Size, the more data points that will be 
used in the derivative trace. 

You will also need to enter an Interval. The Interval refers to how many of the derived points 
will be plotted on the resulting trace. The smaller the Interval, the more detail there will be in 
the trace. 

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an even
number.

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select one of the ‘Derivs’ in the Operation field.

See also: 
About smoothing
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Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label
Graph Pictures
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture
Trace Preferences dialog
Trace Preferences menu
How to select the focused trace
How to display a trace
How to remove a trace from a graph
How to remove a trace from the trace list
Graph Preferences dialog
How to alter the look of your graphs
Cursor Modes dialog
How to track the focused trace
Axes Scales dialog
How to scale your graph manually
How to scale your graph automatically
Single/Multi Graph
User Data Form
Graphics Templates
How to create a graphics template
Lifetimes Ruler
How to use the lifetimes ruler

Graphics area—Lifetimes 
The Graphics area of the Lifetimes application appears in the top half of the Lifetimes Application window and 
is used to display traces of collected data. In the Cary Eclipse system, the term 'graph' refers to the plotting area 
and is represented by a set of axes. The rectangular area surrounding the graph is referred to as the graph box. 
A graph will appear in the Graphics area when you select Start to commence a Lifetimes run. 

To display or hide the Graphics area, select the Graphics command on the View menu. Double-clicking on the 
Graphics area enables you to toggle between half or full size display sizes. 

You can access the functions associated with the Graphics area by doing the following:  

selecting one of the Graphics toolbar buttons;
selecting a command from the Graph menu; or
clicking the right mouse button in the Graphics area and select a command from the menu

Note 
Not all functions are available on every menu.
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You can customize the graphics area to suit your requirements in the following ways: 

Note 
All of the commands and dialogs listed are accessible from the Graph menu. 

To… Use the… Tell me how…

Change the axes scaling 
automatically

Autoscale graph command How to scale your graph 
automatically

Change the axes scaling manually Axes Scales dialog How to scale your graph manually

Modify the graph appearance (axes, 
trace)

Graph Preferences dialog How to alter the look of your graphs

Add a new graph to the display Add graph command

Remove a graph from the display Remove graph command

View single or multiple graphs Single/multiple graph 
command

Resize a graph box Cursor How to resize graph boxes

Track the focused trace Cursor Mode dialog How to track the focused trace 

Select the focused trace Cursor How to select the focused trace

Display a trace in the graph Trace Preferences dialog How to display a trace that is not 
appearing in a graph box

Remove a trace from a graph Trace Preferences dialog How to remove a trace from a graph

Remove a trace from the trace list Trace Preferences dialog How to remove a trace from the 
trace List

Zoom in and out on the graph Zoom In and Zoom Out 
commands

How to zoom a graph

Add a label to the graph box Add Label dialog How to add a label to a graph

Edit labels in the graph box Edit Label dialog How to edit a label

Moving labels in the graph box Cursor How to move a label

Delete labels from the graph box Delete Annotation command How to delete a label

Add a picture to the graph box Add Picture dialog How to add a picture to a graph

Move pictures in the graph box Cursor How to move a picture

Replace pictures in the graph box Edit Picture dialog How to replace a picture

Delete pictures from the graph box Delete annotation command How to delete a picture

Save the Graphics area you have set 
up as a graphics template

Save As dialog (from the File 
menu)

How to create a graphics template
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Graphics How To—Lifetimes 

Traces  

How to track the focused trace
How to select the focused trace
How to display a trace that is not appearing in a graph box
How to remove a trace from a graph
How to remove a trace from the trace List

Sizing and scale  

How to resize graph boxes
How to scale your graph manually
How to scale your graph automatically
How to alter the look of your graphs
How to zoom a graph

Labels  

How to add a label to a graph
How to edit a label
How to delete a label
How to move a label

Pictures  

How to add a picture to a graph
How to move a picture
How to delete a picture
How to replace a picture

Introduction 

Use the Graph menu to view data in various graphical formats or in multiple graphs in the Graphics area. You 
can double-click on the Graphics area to toggle the display through graph and report to graph only.  

In the Cary Eclipse system, the term 'graph' refers to the plotting area and is represented by a set of axes. The 
rectangular area surrounding the graph is referred to as the graph box. A graph will appear in the Graphics area 
when you select Start to commence a Lifetimes run. 

The Graph menu can be accessed in the following ways: 

Note 
The red trace in any graph box is the one on which all information appears and the one used for the cursor 
tracking. It is called the focused trace. 

See also: 
Graphics toolbar 
Graphics How To

Graph menu—Lifetimes 
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from the main menu at the top of the Lifetimes Application window
by clicking the right mouse button in a graph box or the Graphics area

Menu commands 

The following commands can be accessed from the Graph menu: 

Note 
The red trace in any graph box is the one on which all information appears and the one used for the cursor 
tracking. It is called the focused trace.

Command Button What it does…
Print XY 
point 

Select this to print the cursor's current X and Y coordinates in the report area. 
Note 
This option is only available from the Graph menu that appears when you 
right-click in a graph box.

Copy Graph Select Copy Graph to copy the entire Graphics area to the Windows Clipboard. All 
of the graphs in the Graphics area will be copied to the Clipboard.

Paste to 
Graph 

Select Paste to Graph to paste the contents of the Windows Clipboard into the 
Graphics area. Text is pasted as a label, graphics are pasted as pictures.

Add Graph  Select Add Graph to add a new graph box to the Graphics area. You may want to do 
this if you have, for example, a graph containing existing data is displayed and you 
want to collect some new data in a new graph.

Remove 
Graph  

Select Remove Graph to delete the selected graph box from the Graphics area. The 
graph box is removed, but the data is not deleted and is still available from the Trace 
Preferences window. 
You may want to use remove graph if you have a large number of graph boxes open 
but only want to focus on some of these. 

Note 
You can remove multiple graph boxes by first holding down the CTRL key and 
selecting the graphs to be removed and then selecting the Remove Graph 
button or menu item.

Clear All 
Traces 

Select Clear All Traces to delete all traces from the graph/s. Note that selecting this 
option simply turns off the Visible property for the traces in the Trace Preferences 
window. You can redisplay the traces by making the traces Visible again in the Trace 
Preferences window.

Add Label  Select Add Label to display the Add Label dialog where you can enter a text label 
to be placed on a graph or in the background of the Graphics area.  

Add Picture Select Add Picture to display the Add Picture dialog where you can select a picture, 
bitmap or chemical structure to be placed on a graph or in the background of the 
Graphics area. 

Edit 
Annotation 

Select Edit Annotation to alter the content or look of the selected annotation, (either 
a label or a picture) in the Graphics area. This option can only be activated if an 
annotation is selected. 

If the selected annotation is a label, selecting Edit Annotation will open the Edit 
Label dialog where you can change the text of the selected label. 
If the selected annotation is a label, selecting Edit Annotation will open the Edit 
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Picture dialog where you can replace the selected picture with a new picture. 
Delete 
Annotation  

Select Delete Annotation to remove an annotation, (such as a label or a picture) 
from the Graphics area. This option can only be activated if an annotation is selected.
You can use this menu option to remove highlighted annotations in the Graphics area 
such as labels, pictures and ruler/fit information.

Trace 
Preferences 

Select this command to display the Trace Preferences window where you can select 
the trace(s) to display in the selected graph.

Graph 
Preferences 

Select this command to display the Graph Preferences dialog where you can change 
the appearance of your graph. Any changes you make to the appearance of the graph 
will be applied to all graphs.

Cursor 
Mode… 

Select this command to display the Cursor Modes dialog where you can choose the 
type of cursor to be used screen. For example, you can select to use a free cursor that 
can move anywhere in the graph or exactly trace the focused scan (red scan).  
Alternatively, you can select a cursor that enables you to draw a line from one point 
to another to determine the slope using either the Least Squares method or the Point 
to Point method.

Axes 
Scales…  

Select this command to display the Axes Scales dialog where you can set the scale 
range for the X and Y axes.

Auto scale 
graph 

To automatically scale the graph, point to one of the following options: 

Autoscale[XY] 
Select Autoscale[XY] to automatically scale collected data by scaling the ordinate 
(Y) height and abscissa (X) width to full screen.

Autoscale[X] 
Select Autoscale[X] to automatically scale collected data by scaling the abscissa (X) 
width to full screen. 

Autoscale[Y] 
Select Autoscale[Y] to automatically scale collected data by scaling the ordinate (Y) 
height to full screen. 

Zoom Out Select Zoom Out to zoom back to the original X and Y ranges which were used to 
collect the data (i.e. the method setup conditions of the focused scan).  
For example, the system will revert back to the X and Y ranges set in the method if 
you zoom in and out during a data collection. 

Tell me How to zoom a graph 
Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note 
The graph highlighted in the Multi Graph view will be displayed when you 
toggle the Single Graph option.

Auto 
Arrange 
Graphs 

Select Auto Arrange Graphs to view and arrange all graphs simultaneously. 
Note 
You can move graph boxes manually by clicking the left mouse button outside 
the graph axes and dragging the graph box to a new position. You can also 
resize graphs.

User Data 
Form  

Select User Data Form to display the User Data Form where you can enter extra 
information about the traces in the highlighted graph box. For example, you might 
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Use the Graphics toolbar buttons to gain quick access to many of the Graph menu options. You can also use 
the toolbar to select the graph you want to view and to change the look of your graphs. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Graphics. To display 
or hide the toolbar's text labels, point to the Toolbars option in the View menu and select Text Labels. 

The following commands can be accessed from the Graphics Toolbar: 

want to record information about the experimental conditions you used to collect the 
data, such as the pH at which data was collected.

Calculator Select Calculator to display the Maths window where you can perform 
mathematical manipulations on collected traces. In addition, it can act as a simple 
numeric calculator.

History List This displays a list of the current graphs.  

See also: 
Add Label  
Add Picture  
Edit Label  
Edit Picture  
Trace Preferences  
Graph Preferences  
Cursor Modes  
Axes Scales  
Single/Multi Graph   
User Data Form   
Maths  
Graphics toolbar 
Graphics area 

Graphics Toolbar—Lifetimes 

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Trace 
Preferences  

Select this button to display the Trace Preferences window where you can select the 
trace(s) to display in the selected graph.

Graph 
Preferences 

Select this button to display the Graph Preferences dialog where you can change the 
appearance of your graph. Any changes you make to the appearance of the graph will 
be applied to all graphs.

Cursor 
Mode 

Select this button to display the Cursor Modes dialog where you can choose the type 
of cursor to be used screen. For example, you can select to use a free cursor that can 
move anywhere in the graph or exactly trace the focused scan (red 
scan). Alternatively, you can select a cursor that enables you to draw a line from one 
point to another to determine the slope using either the Least Squares method or the 
Point to Point method.

Axes 
Scales…  

Select this button to display the Axes Scales dialog where you can set the scale range 
for the X and Y axes.
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Autoscale
[XY] 

Select the Autoscale[XY] button to automatically scale collected data by scaling the 
ordinate (Y) height and abscissa (X) width to full screen.

Autoscale[X] Select the Autoscale[X] button to automatically scale collected data by scaling the 
abscissa (X) width to full screen.

Autoscale[Y] Select the Autoscale[Y] button to automatically scale collected data by scaling the 
ordinate (Y) height to full screen.

Zoom Out Select the Zoom Out button to Zoom back to the original X and Y ranges which 
were used to collect the data (i.e. the method setup conditions of the focused scan).  
For example, the system will revert back to the X and Y ranges set in the method if 
you zoom in and out during a data collection.

Add Label  Select this button to display the Add Label dialog where you can enter a text label to 
be placed on a graph or in the background of the Graphics area. 

Add Picture  Select this button to display the Add Picture dialog where you can select a picture, 
bitmap or chemical structure to be placed on a graph or in the background of the 
Graphics area.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note 
The graph highlighted in the Multi Graph view will be displayed when you 
toggle the Single Graph option.

Auto 
Arrange 
Graphs 

Select the Auto Arrange Graphs button to view and arrange all graphs 
simultaneously. 
You can move graph boxes manually by clicking the left mouse button outside the 
graph axes and dragging the graph box to a new position. You can also resize graphs.

Add Graph Select this button to add a new graph box to the Graphics area. You may want to do 
this if you have, for example, a graph containing existing data is displayed and you 
want to collect some new data in a new graph.

Remove 
Graph 

Select this button to delete the selected graph box from the Graphics area. The graph 
box is removed, but the data is not deleted and is still available from the Trace 
Preferences dialog. 
You may want to use remove graph if you have a large number of graph boxes open 
but only want to focus on some of these. 

Note 
You can remove multiple graph boxes by first holding down the CTRL key and 
selecting the graphs to be removed and then selecting the Remove Graph 
button or menu item.

Clear All 
Graphs 

Select this button to delete all traces from the graph/s. Note that selecting this option 
simply turns off the Visible property for the traces in the Trace Preferences window. 
You can redisplay the traces by making the traces Visible again in the Trace 
Preferences window.

User Data 
Form 

Select this button to display the User Data Form where you can enter extra 
information about the traces in the highlighted graph box. For example, you might 
want to record information about the experimental conditions you used to collect the 
data, such as the pH at which data was collected.

Calculator Select this button to display the Maths window where you can perform mathematical 
manipulations on collected traces. In addition, it can act as a simple numeric 
calculator.
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Graph Labels—Lifetimes 
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label

Use the Add Label dialog to place a label on your graph or into the background of the Graphics area.  

To add a label to a graph box, you must have at least one trace Visible in the graph box. (You can select which 
traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple graphs, the label 
will be placed in the graph box that is currently selected. However, you can add a label outside of a graph box 
in the background of the Graphics area at any time. 

The Add Label dialog comprises the following: 

See also: 
Trace Preferences 
Graph Preferences 
Cursor Modes 
Axes Scales 
Add Label 
Add Picture 
Single/Multi Graph 
User Data Form 
Maths 
Graph menu 
Graphics Area 
Graphics How to

Add Label—Lifetimes 

Q. Can I add a label that will print with all my graphs.
A. Yes, you can add your label to the background of the Graphics area. To do this, right-click on a section
of the background (gray area) and select Add Label from the menu. (You will notice that this menu has
less options than the menu that appears when you right-click on a graph.) In the Add Label dialog, enter
the label to be added to all graphs and select OK. The label will appear in the background of the Graphics
area.

To access the Add Label dialog, select the Add Label command from the Graph menu, or select the 
Add Label button on the Graphics toolbar.

To selected 
trace

Select this option to associate a label with the selected trace. When you associate a label with 
a trace and make the trace visible in the Graph box, the label will also be displayed with the 
trace.

To selected 
graph

Select this option to associate the label with the selected graph. When you associate a label 
with a graph, the label will always be displayed in the Graph box, regardless of what traces 
are visible.
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Use the Edit Label dialog to alter the content or look of your label. 

To access the Edit Label dialog, right-click on the label you wish to change and select Edit Annotation from 
the menu. 

The dialog comprises the following: 

How to add a label to a graph—Lifetimes 
You can add a label to your graph or Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area background. 

Selected trace This will identify the trace that is currently selected and display the name of the trace.
Font… Click Font to open the Windows Font dialog. In this dialog you can specify the font type, 

style and size to be used for the label.
Label Use the Label field to enter the text for the label. You can enter as many lines of text as you 

require.
Hot Tip 
If you wish to include certain XY co-ordinates on the graph as a label, position your cursor at the 
appropriate place, right-click and select Add Label from the menu. When the Add Label dialog appears, 
the co-ordinate positions will be added to the Label field. 
Note 
When you save the data (as a Batch or Data file) the label is saved with its associated trace or graph. 
Labels outside graph boxes can be saved in a graphics template. To do this, choose Graph Template as 
the Save As type in the Save As dialog. 

See also: 
Trace Preferences  
Graph menu  
Graphics toolbar 
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label 
How to delete a label

Edit Label—Lifetimes 

Font Select Font to open the Font dialog, where you can specify the font type, style and size to be 
used for the label.

Label Use the Label field to alter the text for the label. 

See also: 
How to edit a label 
How to add a label to a graph 
How to move a label

Note 
There must be at least one trace Visible in the graph box before you can add a label to it.
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Step 2 

Click the Add Label button on the toolbar or right-click on the graph and select Add Label from the menu. 
The Add Label dialog will appear. 
The Add Label command is also accessible from the Graph menu. 

Step 3 

Click the Font button. The Windows Font dialog appears. Select the font type, size and style you require for 
your label. A sample of the font style appears in the Sample field. When you are satisfied with your selections, 
select OK to return to the Add Label dialog. 

Step 4 

Enter the label in the Label field and select OK. The label will be displayed on the selected graph. If 
necessary, you can move a label so that it is more appropriately placed on your graph. 

How to edit a label—Lifetimes 
Step 1  

Place the cursor on the label and click the left mouse button to select the label. 

Step 2*  

Click the right mouse button and select Edit Annotation from the drop-down menu. Alternatively you can 
select the Edit Annotation command from the Graph menu. The Edit Label dialog is displayed. 

Step 3  

Use the Edit Label dialog to change the label. 

For example, if you want to change the font size of the label, select the Font button. In the Size field, scroll 
through the available sizes for the font and select the size you require. Alternatively, highlight the currently 
selected size in the Size entry field and enter the size you require. Click the OK button in this dialog to return 
to the Edit Label dialog. 

Step 4  

Click OK to clear the Edit Label dialog. Your label will appear with the new font size. 

See also: 
How to move a label 
How to edit a label  
How to resize a label

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label selection. 
Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 

Page 56 of 97Lifetimes Home Page



How to move a label—Lifetimes 
To move a label so that it is more appropriately placed on your graph or Graphics area background, do the 
following: 

Step 1  

Place the cursor on the label. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the label to the correct position and release the mouse button. The label will be displayed at the new 
position. 

How to resize a label—Lifetimes 
To resize a label so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the label by clicking on it with the mouse. A border will be displayed around the label to indicate it is 
selected. 

Step 2  

Position the cursor over one of the corner edges of the label until the cursor becomes a diagonal double-headed 
arrow. Click and hold down the left mouse button.

How to move a label  
How to resize a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label  
How to resize a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.
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Example of label showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the label by dragging the mouse. The label text will also be resized. Release the 
mouse button when the label and text are the correct size. 

How to delete a label—Lifetimes 
To delete a label from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the label and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The label will be 
deleted from the graph or Graphics area. 

Graph Pictures—Lifetimes 
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label selection. 
Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label
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Use the Add Picture dialog to insert a picture or bitmap into the Graphics area. The picture can be added as a 
background picture or to a particular graph box. 

To add a picture to a graph box you must have at least one trace Visible in the graph box. (You can select 
which traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple graphs, 
the picture will be placed in the graph box that is currently selected. However, you can add a picture outside of 
a graph box in the Graphics area at any time. 

The Add Picture dialog comprises the following commands: 

Add Picture—Lifetimes 

Q. Can I add a picture that will print with all my graphs.
A. Yes, you can add your picture to the background of the Graphics area. To do this, right-click on a
section of the background and select Add Picture from the menu. (You will notice that this menu has less
options than the menu that appears when you right-click on a graph.) In the Add Picture dialog, load the
picture to be added to all graphs and select OK. The picture will appear in the background of the
Graphics area.

To access the Add Picture dialog, select the Add Picture command from the Graph menu, or select 
the Add Picture button on the Graphics toolbar.

To selected 
trace

Select this option to associate a picture with the selected trace. When you associate a picture 
with a trace and make the trace visible in the Graph box, the label will also be displayed with 
the trace.

To selected 
graph

Select this option to associate the picture with the selected graph. When you associate a 
picture with a graph, the label will always be displayed in the Graph box, regardless of what 
traces are visible.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer for 
the picture you want to insert. The picture must be one of the following formats: DIB, JPG, 
JPEG, BMP, EMF or WMF. 

If you are viewing multiple graphs the picture will be placed on the graph that is currently 
selected. If no graph is selected, the picture will be placed on the Graphics area background. 

Note 
When you save the data (as a Batch or Data file) the label is saved with its associated trace or graph. 
Labels outside graph boxes can be saved in a graphics template. To do this, choose Graph Template as 
the Save As type in the Save As dialog. 

See also: 
Trace Preferences  
Graph menu 
Graphics toolbar  
How to add a picture to a graph 
How to move a picture 
How to delete a picture 
How to resize a picture 
How to replace a picture

Edit Picture—Lifetimes 
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Use the Edit Picture dialog to change a picture you have inserted into the Graphics area. 

To access the Edit Picture dialog, right-click on the picture you wish to change and select Edit Annotation 
from the menu. 

The Edit Picture dialog comprises the following commands: 

How to add a picture to a graph—Lifetimes 
You can add a picture to your graph or the Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area background. 

Step 2 

Click the Add Picture button on the toolbar or right-click on the graph and select Add Picture from the menu. 
The Add Picture dialog will appear. 
The Add Picture command is also accessible from the Graph menu. 

Step 3 

Click the Load button. The Windows Open dialog appears. 

Step 4 

Browse through your directories to find the picture you want to insert. All pictures must be in the bitmap 
format and will have the extension .BMP. 

Step 5 

Highlight the .BMP that you want to insert and select Open. 

Step 6 

The Add Picture dialog will appear showing a preview of the bitmap. If the bitmap is the correct one select the 

To selected 
trace/graph

Displays whether you originally selected to add the picture to a trace or a graph. This option 
is not editable.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer for 
the picture you want to insert. The selected picture will replace the current picture. The 
picture must be one of the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

See also: 
How to replace a picture 
How to add a picture 
How to move a picture 
How to delete a picture

Note 
There must be at least one trace Visible in the graph box before you can add a picture to it.
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OK button. The bitmap will be placed onto the graph. 

You can move a picture so that it is more appropriately placed on your graph. 

How to replace a picture—Lifetimes 
To change a picture that you have added to a graph or Graphics area background do the following: 

Step 1  

Move the cursor to the picture and select the left mouse button to select it. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu or select Edit Annotation 
from the Graph menu. The Edit Picture dialog is displayed. 

Step 3  

From the Edit Picture dialog, select the Load button. The Windows Open dialog is displayed. 

Step 4  

Browse through your directories to find the picture to replace the current bitmap. Picture files must be in one of 
the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

Step 5  

Highlight the file that you want to insert and select Open to return to the Edit Picture dialog. 

Step 6  

The Edit Picture dialog will display a preview of the bitmap. If the bitmap is the correct one select the OK 
button. The bitmap will be placed onto the graph. If you need to, move the picture so that it is more 
appropriately placed on your graph. 

Note 
You should take care not to add a bitmap that is too big as it will obscure part or all of your graph.

See also: 
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture 

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Do not to add a bitmap that is too big as it will obscure part or all of your graph. 
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How to move a picture—Lifetimes 
To move a picture so that it is more appropriately placed on your graph or Graphics area background, do the 
following: 

Step 1  

Place the cursor on the picture. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the picture to the correct position and release the mouse button. The picture will be displayed at the new 
position. 

How to resize a picture—Lifetimes 
To resize a picture so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the picture by clicking on it with the mouse. A border will be displayed around the picture to indicate it 
is selected. 

Step 2  

Position the cursor over one of the corner edges of the picture until the cursor becomes a diagonal double-
headed arrow. Click and hold down the left mouse button.

See also: 
How to add a picture to a graph 
How to move a picture 
How to delete a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.
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Example of picture showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the picture by dragging the mouse. The picture will also be resized. Release the 
mouse button when the picture is the correct size. 

How to delete a picture—Lifetimes 
To delete a picture from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the picture and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The picture will be 
deleted from the graph or Graphics area. 

Trace Preferences table | Trace Audit Log 

A single graph box can display many traces. This window enables you to select the trace(s) to display (make 
Visible) in the selected graph box.  

See also: 
How to add a picture to a graph  
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to move a picture 
How to zoom a graph  
How to resize a picture

Trace Preferences—Lifetimes 

To access the Trace Preferences dialog, select the Trace Preferences command from the Graph menu, 
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The dialog comprises the following: 

Trace Preferences table 

Trace Audit Log 

The Trace Audit Log displays information about the highlighted trace. This includes instrument parameters and 
data form information relating to the trace that has been selected. It also logs all information about data 
manipulation.  When more than one trace is highlighted, the Trace Audit Log will also display information 
about the trace that was last selected. 

or select the Trace Preferences button on the Graphics toolbar.

Hot Tip 
The Trace Preferences menu is also available on clicking the right mouse button anywhere in the trace 
listing.

Visible Use the Visible field to select which traces will appear on the selected graph. To select or 
clear the Visible field, simply click the left mouse button in this column. A tick will appear 
next to traces that are to be displayed in the selected graph. 

If you are in single graph view, all selected traces will appear on the one graph. If you are in 
Multi Graph view the traces will appear on the graph that is currently selected.  

Hot Tip 
To make all traces Visible, right-click on the table and select the Select All command 
from the menu. Then right-click on the table again and select the Show Traces 
command from the menu.

Color The Color field enables you to view the color of each trace that appears on the selected 
graph.  To change the color of a trace, highlight it, click the right mouse button in the Trace 
Preferences table and select Change Trace Color. You can then select a color from the Color 
dialog that is displayed. 

The red trace in any graph box is the one on which all information appears. This trace, which 
is used for the cursor tracking, is called the focused trace and it is always red. When you 
select a trace in the Color column it will become the focused trace in the selected graph box.  

Note 
When you change the trace line width in the Graph Preferences dialog it also will 
change the width of the color trace line in this dialog.

Name of trace The Name of Trace field contains a description of the traces currently available for display 
in the selected graph box.

Filename This field displays the filename and path for the trace. If the name is too long to appear in 
the field you can use the keyboard arrow keys to scroll to the end of the filename or you can 
resize the Trace Preferences window. If the file path for a trace shows 'not saved' then the 
trace is unsaved data and is only stored in memory.

See also: 
Graph menu 
Graphics toolbar 
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Trace Preferences menu—Lifetimes 
The Trace Preferences menu is displayed when you click the right mouse anywhere on the Trace Preferences 
table. The menu contains the following commands: 

How to select the focused trace—Lifetimes 
To select the scan that you want to be the focused (red) trace, do one the following:  

From the Graph, click the left mouse button on the trace that you want to make the focused trace.

From the Graph Legend (if displayed), click the left mouse button on the trace that you want to make the
focused trace.

From the Trace Preferences dialog, click in the Color column of the trace that you want to make the
focused trace.

Graph Preferences  
Trace Preferences menu 
How to remove a trace from the trace list 
How to remove a trace from a graph

Select All This selects or highlights all the traces in the listed on the Trace Preferences page.
Select None This de-selects all the traces in the listing.
Show Traces Select Show Traces to make all of the traces currently highlighted Visible, meaning that 

they will be displayed in the current graph box.
Hide Traces Select Hide Traces to remove the Visible property from all the traces currently highlighted, 

which will remove them from the current graph box.
Delete Traces Select Delete Traces to delete all the highlighted traces in all graphs. Note that if you save 

the data file before you select Delete Traces, the traces are not deleted from the saved file, 
and they can be retrieved at a later date. 
Selecting Delete Traces will delete the traces from the application memory, and it is 
recommended that you select this option if you need to free up memory on your computer. 

Note 
If the application is controlled by the GLP Administration application, you will be 
prompted to save an unsaved data file before it is removed from the application. 

Change Trace 
Color 

Select Change Trace Color to display the Windows Color dialog where you can change the 
color of the currently highlighted trace(s). The focused trace will remain red while it retains 
the focus, and will revert to the selected color when the focus is moved.

See also: 
Trace Preferences 
Graph Preferences 
How to remove a trace from the trace list 
How to remove a trace from a graph

Note
Select the Show Legend check box in the Graph Preferences dialog to display the Graph Legend.

See also:
How to track the focused trace
How to view a particular trace
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How to display a trace that is not appearing in the graph box—
Lifetimes 
Step 1 

Click on the graph in the Graphics area. 

Step 2 

Select the Trace Preferences button  from the Graphics toolbar, or select Trace Preferences from the 
Graph menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you wish to see and select the Visible option. A tick will appear in the Visible column to 
indicate that it will now be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you want to display.

b. Click the right mouse button and select the Show Traces command from the drop-down menu. Ticks
will appear next to the selected traces to indicate that they will now be displayed.

Step 4 

Press OK to clear the Trace Preferences dialog. The selected trace(s) will be displayed. 

How to remove a trace from a graph—Lifetimes 
Step 1 

Select a graph in the Graphics area. 

Step 2 

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the Graph 
menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you no longer wish to see and select the Visible option. The tick will be removed from the 
Visible column to indicate that it will not be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you no longer want to display.

See also: 
How to remove a trace from a graph 
How to remove a trace from the trace list
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b. Click the right mouse button and select the Hide Traces command from the drop-down menu. The ticks
will be removed from the selected traces to indicate that they will not be displayed.

Step 4 

Select OK to clear the Trace Preferences dialog. The trace will be removed from the graph. 

How to remove a trace from the trace list—Lifetimes 
If your graphs contain unwanted traces, you may wish to delete them (rather than simply making them 
invisible) in order to free up application memory and aid system performance. 

Step 1  

Select a graph in the Graphics area. 

Step 2  

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the Graph 
menu. The Trace Preferences dialog is displayed. 

Step 3  

Select the trace to be removed by clicking on it. 

Step 4  

Click the right mouse button to display the Trace Preferences menu. 

Step 5  

Select Delete Traces to delete the sample from the trace list. You will be prompted to confirm this action. 

Step 6  

Select OK to clear the Trace Preferences dialog. The trace will be removed from all graphs. 

Axes Preferences | Advanced Options | Trace Style | Show Legend 

Introduction 

Use the Graph Preferences dialog to change the appearance of your graph. 

See also: 
How to display a trace that is not appearing in the graph box 
How to remove a trace from the trace list

See also: 
How to remove a trace from a graph 
How to display a trace that is not appearing in the graph box

Graph Preferences—Lifetimes 
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All graphs will appear labeled with the X axis label being horizontal and the Y axis vertical. You cannot 
change the orientation of these labels. However you can alter the font and size of the axes and their labels. 

Any changes you make to the appearance of the graph will apply to all graphs until the settings are changed 
again. 

Dialog controls 

The Graph Preferences dialog comprises the following: 

Axes Preferences 

Advanced Options 

To access the Graph Preferences dialog, select the Graph Preferences command from the Graph 
menu, or select the Graph Preferences button on the Graphics toolbar.

Axes Color Select the color that you want to assign to the axes of the graph/s from the drop down list.

Axes Width Select the width of the axes from the drop down list. The width, which is in pixels, ranges 
between one and five pixels.

Grid Style Select the style of grid for the graph from the drop down list. If you do not wish to include a 
grid on the graph, select None.

Plot Area 
Color

Select the color to be used as the background of the graph from the drop down list. If you do 
not want a background color on the graph, select White.

Trace Width Select the width of the trace from the drop down list. The width is given in pixels and 
ranges between one and five pixels.

Font Select the Font button to display the Windows Font dialog where you can define the font 
style for the axes of the graph/s. The style and size of the font will be applied to all graph. 
The style, name and point size of the font appears on the font button.

Preview Box Preview any changes you make to the axes preferences in the preview box. The changes 
shown in this box will not be made until you select OK.

Auto tick 
marks

The Auto tick marks option enables you to approximately set how many tick marks (or 
points) will be included on the graph axes. The tick marks generated will be whole, 
rounded, even numbers. The Auto tick marks option is not available if you have selected 
Major ticks. 

Y-axis
Use the Y-axis slider bar to increase or decrease the number of tick marks (or points) to be
included on the Y axis.

X-axis
Use the X-axis slider bar to increase or decrease the number of tick marks (or points) to be
included on the X axis.

Major ticks Use the Major Ticks option to enable you to set exactly how many ticks (or points) will be 
added to the X and Y axes. The number of marks you specify will be divided by the axis 
range, which can result in odd numbers on the axis. Note that any changes are not reflected 
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Trace Style 

Show Legend 

How to alter the look of your graphs—Lifetimes 
Step 1 

Click the Graph Preferences button  on the Graphics toolbar, or select Graph Preferences from the 
Graph menu. The Graph Preferences dialog is displayed. 

Step 2 

Use the available options available to choose your preferred appearance for the graphs. A preview box in the 
top right-hand corner will demonstrate how the graphs will appear. 

Step 3 

in the graph bitmap at the top of the screen.

Decimals Use the Decimals option to set the number of X and Y decimal places to be displayed on 
the axes. To set the number of decimal places, select the Decimal option and enter the 
number in the Y-axis and X-axis combo boxes. Note that any changes are not reflected in 
the graph bitmap at the top of the screen.

Points Select Points to display each individual data point collected by the Cary Eclipse on the 
graph.

Points and 
solid lines

Select Points and Solid Lines to display each individual data point collected by the Cary 
Eclipse on the graph. Additionally, an interpolated line that connects the points will be 
drawn.

Solid lines If you select Solid Lines, the Cary Eclipse system will interpolate the data between the 
actual, collected data points and show the data as a continuous line.

Style cycles 
automatically

If you select Style Cycles Automatically, the Cary Eclipse system will display each of the 
above three trace styles. This makes it easier to differentiate between traces, especially on 
black-and-white printers.

Show Legend Select Show Legend to display a legend in the right side of each graph box. 
A single left click on a sample name or example line within the legend will make it the 
focused or red scan. Information about the trace will be displayed below the X axis. 

Hot Tip 
Double-clicking on the legend will automatically display the Trace Preferences 
window, enabling you to view more detailed information about your trace (e.g. audit 
log, File name, etc.). 

See also: 
Graph menu 
Graphics toolbar 
Graphics area 
Graphics How To
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Select OK to clear the Graph Preferences dialog and update all graphs to reflect your selections. 

Step 4 

To re-use your graphics setup at a later date, save the setup as a graphics template. 

Use the Cursor Modes dialog to choose the type of cursor to be used screen. For example, you can select to 
use a free cursor that can move anywhere in the graph or exactly trace the focused scan (red scan).  
Alternatively, you can select a cursor that enables you to draw a line from one point to another to determine the 
slope using either the Least Squares method or the Point to Point method. 

The dialog comprises the following: 

Cursor Modes 

Note 
You can also add labels and pictures to your graphs to alter their appearance. 

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture 
How to resize graph boxes 
How to make a graphics template

Cursor Modes—Lifetimes 

To access the Cursor Modes dialog, select the Cursor Mode command from the Graph menu, or 
select the Cursor Mode button on the Graphics toolbar.

None Select this for no cursor tracking.

Free The Free cursor is not confined to a particular trace on the graph. It can move anywhere in a 
graph box, and its ‘X,Y’ position is shown in the bottom right-hand side of the Graphics 
area. You can use the Free cursor to zoom in on a particular part of a graph. 

Note 
The Free cursor moves from pixel point to pixel point in the selected graph box. 
Hence you need to be careful when positioning the cursor over a scan to obtain an 
accurate (X,Y) reading. It is recommended that you use the Track cursor mode for 
this.

Track Use the Track cursor to exactly trace the focused (red) scan in a graph box. The cursor 
position is displayed in the X and Y at the bottom right-hand side of the Graphics area. 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to 
the required position. Click the left mouse button, press ALT on the keyboard, then 
release the mouse button.

Ruler-Least 
Squares

This uses a least-squares technique to determine the slope and thus the reaction rate between 
the start and end points. 
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How to track the focused trace—Lifetimes 
To track the focused (red) trace in the graph: 

Step 1  

Click the Cursor Modes button  from the Graphics toolbar, or select Cursor Mode from the Graph menu. 
The Cursor Modes dialog will appear. 

Step 2  

Select Track and select the OK button. 

Step 3  

Place the blue tracking cursor in the graph box you require. 

Step 4  

Move the cursor left and right across the graph box to trace the focused (red) scan. The cursor coordinates 
change (in the X, Y field at the bottom left hand corner of the Graphics area) as you move along the curve. 

Use the Axes Scales dialog to manually change the axes range. This can assist in zooming in on a particular 

This lifetimes ruler function can be used for measuring zero order reaction rates in lifetimes 
traces. You apply the ruler after lifetimes data is collected to manually select the range over 
which to calculate the reaction rate. The slope is then determined and thus the rate of 
reaction.

Ruler-Point 
to Point

This uses the slope of the line drawn between two selected points to determine the point to 
point slope and thus the reaction rate. 
This lifetimes ruler function can be used for measuring zero order reaction rates in lifetimes 
traces. You apply the ruler after lifetimes data is collected to manually select the range over 
which to calculate the reaction rate. The slope is then determined and thus the rate of 
reaction.

See also: 
Graph menu  
Graphics toolbar  
About the lifetimes ruler 
How to use the lifetimes ruler 
How to zoom a graph 
How to track the focused trace

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the required 
position. Press 'Alt' on the keyboard, then release the mouse button. 

See also: 
How to select the focused trace 
How to view a particular trace

Axes Scales—Lifetimes 
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part of the graph. 

The dialog comprises the following: 

X Axis 

Y Axis 

How to scale your graph manually—Lifetimes 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

Click the Axes Scales button  on the toolbar, or select Axes Scales from the Graph menu. The Axes 
Scales dialog id displayed. 

Step 3  

Type in the new ranges for the X and Y axes in the format ‘n-n’, or choose an option for each from the drop-
down list. 

Step 4  

Select OK. The axes on the selected graph will change to reflect your chosen settings. 

To access the Axes Scales dialog, select the Axes Scales command from the Graph menu, or select the 
Axes Scales button on the Graphics toolbar.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the X axis, in the format n1 - n2 (where n1 is the 

start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can access 
by selecting the down arrow adjacent to the Scale field.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the Y axis, in the format n1 - n2 (where n1 is the 

start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can access 
by selecting the down arrow adjacent to the Scale field.

See also: 
Graph menu 
Graphics toolbar 
How to scale your graph manually 
How to scale your graph automatically 
How to zoom a graph
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How to scale your graph automatically—Lifetimes 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

To autoscale the graph, select one of the following:  

Click the Autoscale XY button  on the toolbar to autoscale both X and Y axes. 

Click the Autoscale X button  on the toolbar to autoscale the X axis only.  

Click the Autoscale Y button  on the toolbar to autoscale the Y axis only.  

The focused trace will be scaled according to the option selected. 

Single/Multi Graph—Lifetimes 
Select this option to toggle between a display of either one or multiple graph boxes in the Graphics area.  

Example of a single graph box display 

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale a graph automatically

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale your graph manually
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Example of a multi graph box display 

Example of a Graphics Template—Lifetimes 
By using the Add Label command in the Cary Eclipse graphics system, you can customize a graphics template 
such as the one shown below: 

The above is created as follows: 

The graph on the left is the collected data.
The text on the top right is a multi-line label (added using the Add Label command).
The logo is an inserted picture (added using the Add Picture command).

Note 
Up to 100 graphs can be displayed in the Graphics area at the one time. 

See also: 
Graph menu 
Graphics toolbar 
Graphics How To
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How to create a graphics template—Lifetimes 
A graphics template lets you set up and store the style of a graphics report for future use. You can do this by 
adding labels and pictures to the background of the Graphics area and altering any axes styles etc. One 
advantage of this over the application's built-in reporting features is that you have more flexibility as to where 
you can position graph boxes and any text that you may want to appear (e.g. operator name, batch number etc.) 
and also where you add pictures, e.g. company logos etc. 

Step 1 

Start the application and open the data file from which you want to make a graphics template. Alternatively, 
collect some new data. 

Step 2 

Make as many graph boxes as you require in your template by using the Add Graph function. 

Step 3 

Adjust the graph boxes to the correct size and position them as you want them to appear in the template. 

Step 4 

Do any of the following, if required: 

Change the appearance of the graph boxes in the Graph Preferences dialog
Use the Add Label function to append text to the Graphics area
Use the Add Picture function to add pictures, such as your company's logo to the Graphics area

Step 5 

From the File menu, select Print Preview. Use the Print Preview dialog displayed to check the template that 
you have created. 

Step 6 

When you are satisfied with the appearance of the graphics, select the Save As… command from the File 
menu. The Save As dialog is displayed. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and select 
'Graph Template' to list all the template files. Ensure that the Save only focused trace check box is cleared. 

Step 8 

Enter a name for the template in the File name field. 

Step 9 

See also: 
Add Label 
How to make a graphics template 
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Select OK to save the graphic template. The template will be used each time you create a new file. 

Use the ‘ruler’ function in the Lifetimes Application to measure zero order reaction rates in lifetimes traces. 
The ruler can be used after lifetimes data is collected to manually select the range over which to calculate the 
reaction rate. From this data, the slope the rate of reaction is determined. 

To access the Ruler Result dialog, do the following: 

1. From the Graph menu select Cursor Modes. In the Cursor Modes dialog, select Ruler-Least Squares
or Ruler-Point to Point option as the cursor mode. See More Information on Least Squares and Point to
Point calculations.

2. Select a region of the trace that is relatively straight and place the cursor on the point of the trace where
you wish to start drawing the ruler. Click and hold down the left mouse button and drag the cursor to the
second point on the trace. A ruler line will draw as you move the cursor.

3. Release the mouse button. The Ruler Result dialog is displayed.

The Ruler Result dialog comprises the following: 

More information on Least Squares and Point to Point calculations 

Least squares slope calculation 

You can calculate the rate of a zero order reaction by manually selecting the range over which  to calculate the 
reaction rate of a lifetimes plot using the ruler on a particular graph. 

A linear equation is fitted to the data using a Ruler-Least Squares technique. The slope of the line of best fit is 
reported as the lifetimes rate in the Ruler Result dialog using the previous zero order equation. 

Point to point slope calculation 

You can choose to calculate the point to point slope instead of the least squares slope value. 

Note 
You can also make a graphic template in a similar manner from existing data. No data will be saved in the 
template. 

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture

Ruler Result—Lifetimes 

Slope Displays the slope of the line of best fit in the region you selected. 
X Start/ 
X Stop 

Displays the beginning and end X co-ordinates of the region you selected. 

Y Start/ 
Y Stop 

Displays the beginning and end Y co-ordinates of the region you selected. 

Retry Select Retry to re-select a region of the trace. 
Add Label Select Add Label to add a label to the graph that displays the slope of the line you have 

selected.
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The point to point slope is calculated from the slope of a line drawn between two ordinate values at two, 
specified abscissa points. 

If you choose OK or Add Label in the Ruler Result dialog then a corresponding Results table will appear in the 
Report area that includes the manually selected abscissa, ordinate range, calculated reaction rate (Slope) and 
Standard Deviation (SD). 

The SD results means that the system looks at the difference between the actual Y value and the fitted Y value 
after the linear least squares fit or point to point fit has been applied. The system takes the difference of each 
point over the selected region and calculates the SD using the following equation: 

where, 

The Factor* Slope result is also displayed. This is the product of the Factor multiplied by the calculated 
lifetimes ruler slope. The Factor value (entered in the Analyze tab) also appears above the result table in the 
report. 

How to use the lifetimes ruler—Lifetimes 
The ‘ruler’ function can be used for measuring zero order reaction rates in lifetimes traces. You can use the 
ruler after lifetimes data is collected to manually select the range over which to calculate the reaction rate. The 
slope is then determined and thus the rate of reaction. 

To use the ruler: 

Step 1 

From the Graph menu, select Cursor Modes. Alternatively, select the  button on the toolbar. The Cursor 
Modes dialog is displayed 

Step 2 

Select Ruler—Least Squares to use a least-squares technique to determine the slope and thus the rate of the 

 are measured values

 are calculated values

 is the number of points

Note 
You can only perform a manual zero order rate calculation after the data is collected. Once the data is 
collected, select Cursor modes in the Graph menu and choose the lifetimes ruler type you require. You 
can then select the range over which to calculate the reaction rate. 

See also: 
Cursor modes  
How to use the lifetimes ruler
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reaction over the selected range. Alternatively, select Ruler—Point to Point to use a line drawn between two 
selected points to determine the point to point slope and thus the reaction rate. 

Step 3 

Select OK to clear the Cursor Modes dialog and return to the Lifetimes Application window. 

Step 4 

Select a region of the trace that is relatively straight and then place the cursor on the first point on the trace 
where you wish to start drawing the ruler. Press and hold down the left mouse button. 

Step 5 

Move the cursor to the second point on the trace (you will see the ruler line drawing as you move the cursor) 
and release the mouse button. 

The Ruler Rate dialog will be displayed to enable you to view the start and end positions of the calculation 
range that you selected. The value of the calculated slope is also displayed. 

If you are not satisfied with the rate result, select the Retry button to repeat Steps 3 to 5, this time selecting 
another range. 

Step 7 

Select Add Label to add the determined slope value of the ruler trace to the graph. The Ruler Rate dialog will 
be cleared. 

If you do not wish to add a label, simply select OK to clear the Ruler Rate dialog. 

The results of the manual determination of the reaction rate will appear in a table in the Report area. The 
ordinate and abscissa start and end values are reported as well as the calculated slope. The result table will also 
include the calculated standard deviation as well as the Factor*slope result. 

File Management—Lifetimes 
File menu
Open dialog
Save As dialog
Filename extensions
ASCII spreadsheet file
Auto Store page
How to export collected data
How to combine data files into a batch file

Note 
If you wish to exit the lifetimes ruler mode, select Cancel. The lifetimes ruler trace will be removed from 
the graph.

See also: 
Cursor modes
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File menu—Lifetimes 
Use the File menu to open or save a method or data file, print or preview a report, or exit the Cary Eclipse 
application. 

The following commands can be accessed from the File menu: 

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open it. 
Any data will be displayed in the Graphics area.

Command What it does…
New Select New to create a new file. The Save As dialog will be displayed for you to enter the 

name of the new file and select a location.
Open 
Method… 

Select Open Method to display the Open dialog where you can search for and load a stored 
method. 

Open… Select Open to display the Open dialog where you can search for and load method, data, 
report, graph template and batch files, as well as other file types compatible with the Cary 
Eclipse software. When you load a batch file, the method which collected the data is loaded 
as well as the associated report and graphics layout.

Save Method 
As… 

Select this option to display the Save As dialog and store the current method. You can use 
the Save As dialog to store the method, data, report, or graphics template separately or 
together as a Batch file. The data can also be saved as a comma delimited ASCII 
Spreadsheet file.

Save As… Select this option to display the Save As dialog and store the collected data. You can use the 
Save As dialog to store the method, data, report, or graphics template separately or together 
as a Batch file. The data can also be saved as a comma delimited ASCII file.

Print Setup… Select this option to display the Windows Print Setup dialog where you can select the 
printer, printer page size and orientation.

Print 
Preview… 

Select this option to display the Print Preview dialog where you can view the current report 
as it will be printed.

Print… Select this option to display the Windows Print dialog where you can choose the printer and 
pages to print as well as the number of copies you wish to print.

Explorer… Select this option to run Windows Explorer. This may help you locate method and data files.
History List This displays a list of the four most recently opened files.
Exit Select this option to exit the Lifetimes application. 

See also: 
Open  
Save As  
Print Preview  
Filename Extensions 
ASCII Spreadsheet File

Open—Lifetimes 

Page 79 of 97Lifetimes Home Page



Look in | File name | Files of type | Overlay Data | Open 

Use the dialog to open a file previously saved by the application. To access the Open dialog, select Open or 
Open Method from the File menu. 

Look in The Look In field lists the available folders and files. Click the down arrow on the right of 
this field to view the location of the current folder in your computer's hierarchy. You can 
also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In field. 

Note 
To open the folder in the level that is one higher than the current folder, click  on 
the toolbar.

Look in list 
box  

The Look In List Box, which is directly below the Look In field, displays the folders and 
files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted text 
entry field that appears and press Enter. Then double-click on the new folder to open 
it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the date the 
file was last modified.
Click to preview the selected trace before you load it into the application.

File name Enter the name of the file you want to open in this field. The easiest way to do this is to find 
the file in the Look in list box and then select the file. However, you can type the full path of 
a file and then select Open to open the file.

Files of type Click on the arrow on the right of this field to view a list of the different types of application 
files that can be opened in the list box. 
Methods (*.FMLT) Choose this file type to open a Method file. Only the method is 

loaded. No data is loaded.
Data (*.FDLT) Choose this file type to open a Data file. Only the data is loaded. 

The method that was used to collect the data is not loaded. The last 
used method or default method will be displayed.

Report (*.FRLT) Choose this file type to open a Report file. You can view the report 
in the Report area.

Graph Template 
(*.FGLT)

Choose this file to open a Graph Template file. The file will set up 
the layout of the Graphics area including any bitmaps as well as the 
range and style of the graph axes.

Batch (*.FBLT) Choose this file type to open a Batch file. A Batch file includes 
data, the method used to collect the data, report and graphics setup.

Spreadsheet Ascii 
(*.CSV)

This will open ASCII files that contain single comma delimited files 
with two or more columns.

All files (*.*) This enables you to view all files in the directory so that you can 
open any compatible file.

Tell me more about Filename Extensions

Overlay Data Select this check box to overlay individual data files in one graph box. If this is not checked 
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Save As—Lifetimes 
Look in | File name | Files of type | Save 

Use the Save As dialog to save the data, method, report or graphics template individually or together as a Batch 
file. 

Traces (or data) that are currently Visible in the Graphics area are saved, regardless of how they are displayed 
(full screen graph box or tile).  

For example, if six graph boxes are displayed in the Graphics area and each graph box has one Visible trace 
then all six traces will be saved.  

If you do not wish to save particular traces, make them not Visible in the Trace Preferences dialog. 

The Save As dialog comprises the following: 

the data from each file will appear in individual graph boxes. This option is only available if 
the Open dialog has been accessed by selecting Open… from the File menu. 

Hot Tip 
Use the SHIFT or Control key to select multiple data files.

Open This button opens the highlighted file/s or the files listed in the File name field.

See also: 
File menu 
ASCII Spreadsheet File

Note 
This dialog appears when you select either the Save Method As… or Save Data As… menu option in 
the File menu. When you select Save Method As… this dialog appears with 'Methods' displayed in the 
Files of type field. When you select Save Data As… this dialog appears with 'Batch' displayed in the 
Files of type field.

Look In The Look In field lists the available folders and files. Click the down arrow on the right of 
this field to view the location of the current folder in your computer's hierarchy. You can 
also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In 
field. 

Note 
To open the folder in the level that is one higher than the current folder, select on 
the toolbar.

Look in list 
box 

The Look In List Box, which is directly below the Look In field, displays the folders and 
files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted text 
entry field that appears and press Enter. Then double-click on the new folder to open 
it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the date the 
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Filename extensions—Lifetimes 
The Cary Eclipse system uses the filename extension to distinguish between data types (e.g. method or data) 
and also to differentiate applications. (e.g. Concentration or Kinetics). 

The Syntax for file extensions is: 

file was last modified.

Click to preview the selected trace before you load it into the application.

File Name Enter the name of the file you want to save in this field. 
You can also type the full path of a file then select the Save button to save the file. 

Files of Type  Click on the arrow on the right of this field to view a list of the different types of application 
files that can be opened in the list box. 
Methods (*.FMLT) Choose this file type to only save the current Method. Any 

collected data is not stored.
Data (*.FDLT) Choose this file type to only save the data currently Visible in the 

Trace Preferences dialog (for any graph box). Note that the method 
used to collect the data is not stored with the data.

Report (*.FRLT) Choose this file type to only save the contents currently shown in 
the Report area..

Graph Template 
(*.FGLT) 

Choose this file type to save the layout of the Graphics area as a 
template. For example, any bitmaps you have added to your 
Graphics area will be saved as well as the range and style of the 
graph axes.

Batch (*.FBLT) Choose this file type to save the data that is currently Visible in the 
Trace Preferences dialog (for any graph box), the method used to 
collect the data and the currently displayed report all together as a 
Batch file. The graphics setup is also stored. 

Spreadsheet Ascii 
(*.CSV)

Choose this file type to save the raw intensity data currently 
Visible in the Trace Preferences dialog (for any graph box) as a 
comma delimited ASCII Spreadsheet File. The data is saved as XY 
pairs delimited by a comma. 

Note 
This file type can be easily imported into a spreadsheet 
program. For example, Microsoft Excel. You can also 
double-click on the stored *.CSV file from Microsoft 
Explorer to load Excel automatically with the ASCII XY data 
displayed.

GRAMS (*.SPC) Choose this file type to only save the data currently Visible in the 
Trace Preferences dialog (for any graph box) as a Cary Eclipse 
GRAMS data file.

Tell me more about Filename Extensions

Save Click this button to save the file currently present in the File name field in the directory 
specified in the Look in field.

See also: 
File menu
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The following files may be opened and saved in the Lifetimes Application: 

Letter Represents Available Options
First Type of analysis F Fluorescence

Second Type of file B Batch
D Data
G Graph Template
M Method
R Report

Third and fourth Application identifier AB Advanced Reads
CN Concentration
KN Kinetics
LT Lifetimes
RT Ratio
SR Simple Reads
SW Scan
TM Thermal
VO Validate

Extension Available action File type
*.FMLT Open/Save A method file (*.FMLT) consists of the software setup by 

which data is collected.
*.FDLT Open/Save A data file (*.FDLT) contains data collected that is 

currently visible in the Trace Preferences dialog (for any 
graph box). 

*.FRLT Open/Save A report file (*.FRLT) contains the report generated by the 
Cary Eclipse about the data.

*.FGLT Open/Save A graph template file (*.FGLT) contains information that 
sets up the layout of the Graphics area including any 
bitmaps as well as the range and style of the graph axes.

*.FBLT Open/Save A batch file (*.FBLT) contains the collected data that was 
Visible in the Trace Preferences dialog (for any graph box), 
the method by which the data was collected and the report 
and graphics template.

*.CSV Open/Save An ASCII spreadsheet file (*.FCSV) has the same 
extension for all applications. It consists of raw intensity 
data (that was currently Visible in the Trace Preferences 
dialog (for any graph box) saved as XY comma-delimited 
pairs. This file can be imported into a spreadsheet program 
such as Microsoft Excel.

Data.* Open A Cary DOS (Data.*) file is the equivalent of a Cary 
Windows Data file—it does not contain any Batch 
information.

*.ADL Open An ADL file (*.ADL) is a program file generated in the 
Applications Development Language (ADL). 
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ASCII Spreadsheet file (*.CSV)—Lifetimes 
An ASCII Spreadsheet file consists of raw intensity data saved as XY comma-delimited pairs. You can choose 
to import or export Cary Eclipse files to ASCII files, which can then be imported in spreadsheet programs such 
as Microsoft Excel. 

The format is as follows:  

Line 1 contains the sample name plus a comma
Line 2 contains X and Y labels. The name of the X label must be the same as that used to label the graph.
For example, in Lifetimes, the graph label is Time (ms).
Lines 3 and onward contain the X,Y data
After the last line of X,Y pairs there must be a blank line separating the data from any text audit strings
or the end of the file.

For example, if a lifetime file was collected as: 
ms = 0.0083, intensity = 0.0255 
ms = 0.01667, intensity = 0.0500 
ms = 0.02450, intensity = 0.0750 
etc. 

It would appear as follows in the ASCII file: 

Microsoft’s Excel generates a CSV file with the above format.

*.SPC Open/Save A Cary GRAMS file (*.SPC ) is the equivalent of a Cary 
Eclipse Windows Data file—it does not contain any Batch 
information.

*.FADL Open An Eclipse ADL (*.FADL) file is a program file generated 
in the Applications Development Language (ADL) 
specifically for the Cary Eclipse. Eclipse ADL files will be 
associated with the relevant Eclipse application. When 
creating ADL files for the Cary Eclipse, it is recommended 
that you save them with the FADL extension.

Note 
Selecting All Files in the Windows Open dialog will list all available file types. 

See also: 
Open 
Save As

  Lifetimes, 
  Time (ms); Intensity (a.u.) 
  0.0083, 0.0255, 
  0.01667, 0.0500, 
  0.02450, 0.0750, 

  Lifetimes, 
  Collection time; 
  etc. 
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There is also an alternative format for CSV files. For example, 

How to export collected data—Lifetimes 
If you want to export data from a Cary Eclipse application into a third-party application, then you simply need 
to save your data as an Spreadsheet ASCII (*.CSV) file or a Rich Text Format (*.RTF) file. Spreadsheet ASCII 
files are recommended if you are planning to use the data in a spreadsheet program such as Microsoft® Excel. 
Rich Text Format files are recommended if you are planning to open the data in a word processor program 
such as Microsoft® Word. 

To export collected data: 

Step 1  

From the File menu, select Save As. The Save As dialog is displayed. 

Step 2  

Click on the down arrow next to the Files of type list box and select the Spreadsheet ASCII (*.CSV) or Rich 
Text Format (*.RTF) option. 

Step 4  

Type the name of your new file in the File name field. 

Step 5  

Select Save to export your data to this new file. 

How to combine data files into a batch file—Lifetimes 
To combine a number of data files into a batch file, do the following: 

Step 1  

Select Open… from the File menu to display the Windows Open dialog.

  Lifetimes 
  Time (ms); Intensity (a.u.) 
  0.0083,0.0255 
  0.01667,0.0500 
  0.02450,0.0750 

  Lifetimes, 
  Collection time; 
  etc. 

See also: 
Save As 
Open 
How to export collected data
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Step 2  

A list of stored batch files will appear. Select the down arrow to the right of the Files of type field and select 
'Data' to list all the data files. 

Step 3  

Select the Overlay Data check box. 

Step 4  

Highlight the data files that you require. Hold down the CTRL key to select multiple files. 

Step 5 

Select Open. The highlighted data files will load into the application and appear in the same graph box. 

Step 6 

Select Save As… from the File menu to display the Windows Save As dialog. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and select 
'Batch' to list all the batch files. Ensure that the Save only focused trace check box is cleared. 

Step 8 

In the File name field, type in the file name for your new batch file. 

Step 9 

Select Save to create the new batch file. The current method will be stored with the batch file. 

All the data files are now combined into the one batch file. 

Software and Screen features—Lifetimes 
Menu line
Status display
Status line
Buttons
Function keys
Right mouse menu
How to remove or display the command buttons

Menu line—Lifetimes 
 File menu 
 Edit menu 
 View menu 
 Commands menu 
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 Setup menu 
 Graph menu 
 Help menu 

Status Line—Lifetimes 
The Status Line is displayed at the very bottom of the Lifetimes Application window. The line will display the 
following information (from left to right): 

The major commands in the Lifetimes application can be accessed both from the menu items at the top of the 
main window and from the application buttons. These buttons, which appear in the left side of the Lifetimes 
Application window, comprise the following: 

Hardware Status This field displays status messages indicating the current instrument activity.
Sequence Information This field displays status messages indicating the current system activity.
Current Results This field displays information on the last reading.

See also: 
Lifetimes Application window

Buttons—Lifetimes 

Hot Tip 
If you wish to access these commands from the main menus, rather than from these buttons, you can 
remove the Command buttons from your application window. To do this, clear the Buttons command in 
the View menu. This will enlarge the Graphics area, making viewing and selection of scans easier. 

Button Enables you to…
Setup Click this button to display the Setup dialog where you can set up your Cary Eclipse for the 

collection, storage and analysis of the lifetimes run. You can also set up any accessories that 
you may have and define the reporting options.

Zero Select this to Zero the current ordinate value. 
This command can also be accessed by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Pre-scan Select Pre-scan to quickly determine the optimum instrument parameters to be used for 
your sample. At the end of this collection sequence the software will report the optimum Ex 
and Em wavelengths and PMT voltage. Once you are satisfied with the parameters, the 
software will automatically update your method setup to reflect these new parameters.

Clear Report Select Clear Report to remove all of the text that appears in the Report area. If you have 
saved the report, you can view the information again. To do this, simply open the report file 
using the Open… command in the Report menu.

Recalculate Select Recalculate to display the Analyze and Reports pages of the Setup dialog. You can 
use the Analyze page to recalculate the rate, using the current data. The Reports page is 
used to enter and select information that will appear in the report.

Print Select Print to display the Windows Print dialog where you can choose what printer the 
report will be printed to. You can also select what pages to print as well as the number of 
copies you wish to print. 
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Function keys—Lifetimes 
The function keys at the top of your keyboard perform basic Cary Eclipse operations simply and quickly. 

This command can also be accessed by pressing CTRL+P. 
Note 
The options on the Report page are used to generate the contents of the Report area 
during a run or on a recalculation. If Auto Print has been selected the Cary Eclipse 
will automatically print a report at the end of a data collection.

See also: 
Commands menu   
Setup   
Zero 
Analyze   
Reports  
How to remove or display the command buttons

Function 
key 

What it does

F1 This displays the Help for the current dialog or window.

F4 Press F4 to display the Go to Wavelength dialog.

F5 Press F5 to perform an instrument Zero. The current intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use 
the Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible from the Commands menu or by selecting the Zero button. 

Select the Clear Zero command from the Commands menu to remove zero correction. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell positions 
that are currently in the cell path.

F6 Press F6 to display the Rapid Result dialog where you can read a blank and multiple sample 
readings without changing the application method. 
This command is also accessible from the Commands menu.

F9 If the application is online, press F9 to start a data collection. This is equivalent to selecting the 
Start button. If the application is not online, you will need to press F9 to first connect to the Cary 
Eclipse. Then press F9 to start the data collection. 
This command is also accessible from the Commands menu or by selecting the Start button. 

Note 
You will not be able to perform a Connect if another application is collecting data.

F12 Select this to stop the current measurement. This is equivalent to selecting the Stop button. This 
command is also accessible from the Commands menu or by selecting the Stop button. 

See also: 
Go to Wavelength 
Zero  
Rapid Result  
Start/Stop buttons
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Right mouse menu—Lifetimes 
The following commands are accessible by clicking the right mouse button on editable fields in the Cary 
Eclipse software: 

How to remove or display the command buttons—Lifetimes 
The command buttons (Setup, Zero, Pre-scan, Clear Report, Recalculate and Print) appear on the left side 
of the Lifetimes Application window. 

To remove the command buttons 

Step 1 

From the Lifetimes Application window, select the View menu. 

Step 2 

Clear the Buttons menu item. 

The buttons will disappear from the application screen, giving you more room to display reports. 

To show the command buttons 

Step 1 

From the Lifetimes Application window, select the View menu. 

Step 2 

Select the Buttons menu item. 

The buttons will re-appear in the application screen. 

ADL—Lifetimes 
ADL Command Line
ADL Hooks
How to insert ADL commands

Introduction to ADL 

Undo If available, this reverts to the previous value before the Edit on the field.
Cut If available, this cuts the highlighted text to the clipboard.
Copy If available, this copies the highlighted text to the clipboard.
Paste If available, this pastes the text from the clipboard to the cursor position.
Delete If available, this deletes the highlighted text/number.
Select All If available, this selects all entries.

ADL Command Line—Lifetimes 
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Use the ADL Command Line to run Single-line or Multi-line Applications Development Language (ADL) 
commands that enable you to perform functions over and above that of the existing program functionality.  

ADL is not a general purpose programming language. It has been developed specifically by Varian to meet the 
needs of spectroscopists. It can be used to handle all the data collected from the Cary Eclipse—both 
photometric values and entire data collections. ADL programs that you develop should be stored with the 
extension 'ADL'. 

To access the ADL Command Line, select the ADL Command item from the Commands menu. You can also 
press ALT+Y to open the dialog. 

Software controls 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help. 

Single Line Selecting this lets you enter ADL commands on a single line into the Command Line entry 
box. 

Q. Can I enter more than one ADL command on a single line?
A. Yes, provided that the commands are separated by a semicolon ‘;’.

Multi-line The Multi-line capability enlarges the Command Line entry box. Use the Multi-line 
capability to create a more complex ADL program by adding a series of commands over 
multiple lines. When Multi-line mode is selected, the Quick Reference option becomes 
available.

Quick 
Reference 

Select Quick Reference to open the Quick Reference dialog where you can easily add a 
command in the correct syntax to your ADL program. This option is only available for Multi-
line commands. 

Show me How to insert ADL commands using the Quick Reference 

A detailed description of all the commands in the Quick Reference is available by selecting 
the Help button on the Quick Reference dialog. 

Browse Click Browse to browse your release CD for ADL programming examples that you can load 
and run. Alternatively, you can select and load ADL programs that you may have created.

Command 
Line (entry 
box) 

This entry box enables you to use ADL commands. You can enter single ADL commands 
into this field, or you can enter a series of ADL commands. If you have the entry type set to 
Single Line, you can review previous ADL entries by selecting the down arrow to the right of 
the list box. 

The ADL commands in the Command Line are executed when you select OK. 

Note 
On entering this window, the Cary Eclipse will recall the last command or program 
executed from the Command Line entry box. The ADL commands entered in the last 
executed program are stored in the Adl folder (accessed from the Varian/Cary Eclipse 
softwarefolder) as CaryEquation.ADL.
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ADL Hooks—Lifetimes 
The ADL Hooks command is accessible from the View menu. 

Instead of writing a full ADL program you can use ADL hooks to link into an existing application. This is 
particularly useful if you want to make small changes to the way an application works, e.g. you want to pop up 
a dialog for the user to enter some specific data before the run starts. ADL hooks are links at specific points in 
an application at which you can run an ADL program. For example, ADL hooks have been supplied to run the 
following ADL programs:  

Hot Tip 
You can rerun the ADL commands in the Command Line entry box 
(CaryEquation.ADL) from any screen in the Simple Reads application by pressing Alt-
X or select Rerun ADL from the Commands menu. The 

 
See also: 
ADL Hooks

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Command Description

LT_Startup.ADL This is run when the Lifetimes application starts. For this to to work the application must 
be started from a batch or method file that has ADL Hooks on.

LT_PreSeq.ADL This runs when the Start button is selected.

LT_PostSeq.ADL This runs at the end of the Start button sequence.

LT_Online.ADL This runs when Cary Eclipse is detected online.

LT_OffLine.ADL This runs when Cary Eclipse ‘goes’ offline.

LT_Zero.ADL This runs when the Zero button is selected.

LT_Recalc.ADL This runs when the Recalculate button is selected.

LT_Shutdown.ADL This runs when the application is shutting down.

LT_PreRead.ADL This runs just before a read is taken.

LT_PostRead.ADL This runs just after a read is taken (It has the reading result stored in the 
UserResult variable.)

LT_PreSetup.ADL This runs when the Setup button is selected.

LT_PostSetup.ADL This runs when the OK button on the Setup dialog is selected.

LT_CellChange.ADL This runs instead of the Cary Eclipse driving the Multicell Holder. It enables you 
to add your own instructions for the Cary Eclipse Multicell Holder or to use your 
own cell changing accessory.

LT_PreStage.ADL This runs prior to each collection stage. It determines the stage by checking the 
UserResult variable as UserResult = stage number.
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How to insert ADL commands using the Quick Reference—Lifetimes 
The Quick Reference window is accessed from the ADL Command window. It enables you to easily add a 
command in the correct syntax to your ADL program. To do this: 

Step 1 

Press Alt-Y to open the ADL Command Line window. 

Step 2 

Select the Multi-line option. The Command Line entry box will expand to take multiple lines of ADL 
commands and the Quick Reference check box is displayed. 

Step 3 

Select the Quick Reference check box. The Quick Reference window is displayed. 

Step 4 

If necessary, use the Go To field to jump to the appropriate part of the Quick Reference listing. 

Step 5 

Highlight the command you require in the Quick Reference list. 

Step 6 

Click the Insert in ADL button. The selected ADL command will appear in the Command Line entry box. 

Step 7 

Where necessary, alter the defaults supplied by the inserted Quick Reference command in the Command Line 
entry box to suit your program. 

Step 8 

Repeat steps 4–7 to add more commands as required. 

LT_PreUserRecalc This runs just after the Recalculate button has been selected and performs any pre-
processing required prior to a recalculation.  If the ADL Variable UserBoolean is set to 
FALSE, it can also replace the normal recalculations.

LT_UserRecalc Runs just prior to the calculations. Can also be used to replace the calculations

LT_PostUserRecalc Runs after the Recalculate sequence has been completed

LT_TraceName Allows the name of the sample to be obtained from an ADL file, instead of being entered 
by typing into the sample loading dialog. This only works for single samples. 

LT_UserPreCalc This runs just prior to the calculations. Any preprocessing of data should be done here.

LT_UserPostCalc This runs after the calculations. Any post processing of data should be done here

See also: 
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Help and Safety information—Lifetimes 
Help menu
Safety home page

Help menu—Lifetimes 
Use the Help menu to view the online help and software information for this application. 

Safety Home Page 
Click on the desired index entry to view the Help. 

About Safety
Lamp module
Ultraviolet radiation
Electrical hazards — Cary Eclipse
Panels, covers and modules
Other precautions
Warnings and cautions
Warning symbols
Color coding
Information symbols
FCC advisory
CE compliant products

Lifetimes How To—Lifetimes 
Select the procedure you require below for a step-by-step informative guide on running the application 
software. 

Lifetimes How To 

ADL Command Line

Command What it does…
Lifetimes 
Help 

Select this to display the Lifetimes Home Page. This contains a list of online Help topics 
specific to the Lifetimes Application.

Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.
Tip of the day View useful tips about using your Cary Eclipse instrument and software.
Eclipse Tour Select this to display the Cary Eclipse Multimedia Online Help. This will give you an 

animated introduction to the Cary Eclipse software and hardware.
About… Select About to access a dialog that displays information about the application as well as 

Varian email and Internet contact information.  
To clear the About dialog, select OK.

See also: 
Lifetimes home page
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Calculation and reporting How To 

How to perform post run calculations on previously stored data
How to use the lifetimes ruler
How to generate a report from previously collected data
How to use advanced reporting options

Other How To 

How to email your results
How to export collected data
How to combine data files into a batch file
How to remove or display the command buttons
How to insert  ADL commands using the Quick Reference

How to resize graph boxes—Lifetimes 
Step 1  

Click on the graph that you want to resize so that the highlight box appears around it. 

Step 2  

Move the cursor to the edge of the highlight box and place it over one of the square marks (e.g. ) in the box 
until it turns into a double headed arrow ( ). 

Step 3  

Click and hold the left mouse button and drag the box to the desired size. 

Step 4  

Release the left mouse button. 

How to zoom a graph—Lifetimes 
To zoom a graph, do the following: 

Step 1  

Click on the  button on the toolbar, or select Cursor Mode from the Graph menu. The Cursor Modes 
dialog will appear. 

Step 2  

Select Free and select the OK button. 

See also:
Lifetimes Application Home Page
Graphics How To

See also: 
How to alter the look of your graphs
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Step 3  

Click and hold down left mouse button in the highlighted graph box. 

Step 4  

Drag the mouse sideways and up or down. You will see a zoom box made up of a dotted line appear on the 
screen. (See picture below.) 

The dotted line is a zoom box. 

Step 5  

Release the left mouse button. The area defined by the zoom box will be redrawn to fill the entire graph box, 
and the scans within the box will be enlarged accordingly. The abscissa (X) and ordinate (Y) coordinates 
displayed below the graph will also be changed to reflect the positions of the corners of the zoom box. 

You can repeat this process if you need to zoom in even further. 

Maths How To… 
How to perform a spectral subtraction
How to perform a mean calculation
How to smooth a trace
How to derive a trace

How to take the derivative of a trace 
Some uses of derivatives are: 

To resolve partly overlapping peaks
To quantitatively determine trace compounds
To characterize pure compounds
Purity testing

Hot Tip 
To move the box on the screen, hold down the left and right mouse buttons together. You can then 
position the box anywhere in the graph box. Releasing the right mouse button will still allow you to 
resize the zoom box.

Note 
The system may limit the extent to which you can Zoom. 
See also: 
How to scale your graph manually 
How to scale your graph automatically

See also:
Maths Home Page
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To take the derivative of a collected trace and plot the result, follow these steps: 

Step 1 

Click on the trace to be smoothed. It will become red (highlighted). 

Step 2 

Click the Selected Trace or Focused Trace button. The name of the highlighted trace will appear in the 
calculation display field. 

Step 3 

In the Trace group, select your derivative order in the Operation field. Choose from derivatives 1 to 4 (Deriv1, 
Deriv2, Deriv3, Deriv4). You may have to scroll to find the derivative you require. 

Step 4 

Enter a Filter Size and an Interval in the corresponding fields. 

Step 5 

In the Display Options group, select New Graph to plot the result in a new graph box, or Selected Graph to plot 
the result in the current graph box. 

Step 6 

Click the Apply button in the Trace group. Your Deriv selection will be displayed before the trace name in the 
calculation display field. 

Step 7 

Click on the equals (=) button. The result will be displayed in the Graphics area. 

How to smooth a trace 
To smooth a collected trace and plot the result, follow these steps: 

Step 1 

Click on the trace to be smoothed. It will become red (highlighted). 

Step 2 

Click on the Maths button in the toolbar (it's on the far right) or select the Maths menu. 

Step 3 

Click the Selected Trace or Focused Trace button. The name of the highlighted trace will appear in the 
calculation display field. 

See also: 
About derivatives
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Step 4 

In the Trace group, select Smooth in the Operation field. (You may have to scroll to find it.) 

Step 5 

Enter a Filter Size and an Interval in the corresponding fields. 

Step 6 

In the Display Options group select New Graph to plot the result in a new graph box, or Selected Graph to plot 
the result in the current graph box. 

Step 7 

Click the Apply button in the Trace group. The word ‘Smooth’ will appear before the trace name in the 
calculation display field. 

Step 8 

Click on the equals (=) button. The result will be displayed in the Graphics area.
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Ratio Home Page 

Introduction 

The Ratio application is used to measure a change in the intensity at two different wavelengths. It is used 

To… Use the… Show me…
Get ready to collect data Setup dialog

Perform data collections Commands menu

View run progress and 
results

Status Display
Reports
Print Preview

How to generate a report from previously
collected data
How to use advanced reporting options

Display data graphically Graphics Area
Graph menu

Graphics How To

Perform calculations Analyze page Grynkiewitz equation calculations
To find out about… See the… Show me…
Ratio Application Ratio application How to determine the autofluorescence of a

reaction
How to subtract autofluorescence from a
reaction
How to create a ratioed trace
Using the Grynkiewitz equation to obtain a
concentration graph
by entering the values manually
by determining the values from the graph

File management Open
Save As
Filename extensions
Auto Store

How to export collected data
How to email your results

Screen features Buttons
Toolbar
Status Line
Menu Line

How to remove or display the command
buttons

Examples Example of a multi-stage ratio run
Example of a multi-stage ratio calculations
Example using the stop time

ADL ADL Command
Line
ADL Hooks

Help and safety 
information

Help menu
Safety Home Page

Ratio Application 
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primarily to measure wavelength shifting dyes which shift their wavelength maxima when they bind to ions. 

Use the Ratio application to measure excitation or emission shifting dyes at two different emission or 
excitation wavelengths as a function of time. From this you can obtain an intensity versus time plot. The 
features of the application include: 

Calculation of Zero order, First order and Second order reaction rates from intensity versus time data.
Selectable time window for calculation.
Overlay of the best-fit line on raw data.
Automatic or manual estimates for the first order and second order Marquardt fitting.

To access the Ratio Application, click the Windows Start button, point to Programs, Cary Eclipse and then 
select Ratio. 

Software controls 

The application comprises the following: 

Hot Tip:
The Ratio application enables you to monitor the influx of intracellular ions by ratioing two wavelengths
changing over time. If you wish to collect scans as a function of time in order to determine whether the
spectrum is changing, use the Cycle mode option in the Scan application. The Cycle mode option is
available from the Options page of the Setup dialog.

Instrument 
Status 
Readings 

The Instrument Status Readings, which display the X and Y values of the graph axes are 
displayed in the top left and right corners respectively of the Ratio Application Window. 

Y value 
Displays the current Y value, intensity. This value is continually updated during data 
collection. 

X value 
Displays the current X value, which is the current reading for Time. On the Cary page of the 
Setup dialog, choose whether to display the time value in minutes or seconds. 

Start and Stop 
buttons 

The Start and Stop buttons at the top of the Ratio Application window are used to start and 
stop instrument analyses. These buttons can also be accessed from the Commands menu. 

Tell me more about the Start and Stop buttons 
Graphics area The Graphics area refers to the plotting area of the application. It can contain traces of 

collected data, labels and pictures. In the Cary Eclipse system, the term 'graph' refers to the 
plotting area and is represented by a set of axes. The rectangular area defined by the axes is 
referred to as a graph box. 

To display or hide the Graphics area, select the Graphics command on the View menu. 
Double-clicking on the Graphics area enables you to toggle between half or full size display 
sizes. To manually size the Graphics area, place the mouse cursor over the border between 
the Graph and Report areas until the cursor changes to a double arrow ( ). Then hold down 
the mouse and drag it up or down to resize the areas.  

Tell me more about the Graphics area  
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Validation of your Cary Eclipse for the Ratio application 
Two files are shipped with the Ratio application to enable you to validate the software. The files are stored on 
your CD in a Validation subdirectory. 

To validate your software, you should Open each file in turn and select the Recalculate button. The results 
calculated by the Cary Eclipse should match those given in the validation files listed below. These results were 
determined by exporting the data to a spreadsheet program and performing the same calculation as that used in 
the Ratio application.  

Calcium Fura 2 final results.FBRT
Calcium single wavelength final results.FBRT

Getting ready for a run—Ratio 

Report area Use the Ratio Report area to view the current report. The report may include the results of 
your data collection, the method parameters used to collect the results and any graphics you 
have included. You can select the information to include in your report in the Reports tab of 
the Setup dialog. 

To display or hide the Report area, select the Report command from the View menu. Double-
clicking on the Report area enables you to toggle between half or full size display sizes. To 
manually size the Report area, place the mouse cursor over the border between the Graph 
and Report areas until the cursor changes to a double arrow ( ). Then hold down the mouse 
and drag it up or down to resize the areas. 

You can copy the generated report onto the Windows clipboard. To do this, highlight the 
report (or a relevant section of it) and press CTRL+C. You can then paste the report into a 
word processor such as Microsoft® Word. 

Hot Tip 
You can edit the Ratio Report by pressing CTRL+R or selecting the Edit Report 
command from the Edit menu.

Commands The Ratio Application window contains the following commands, all of which can also be 
accessed from the various menus in the application. 

Click on the buttons to view information about them: 

Hot Tip 
By becoming familiar with these commands (Setup, Zero, Set Temp, etc.), you can 
remove these buttons from the Ratio window. This will enlarge the Report area and 
make it easier to view results. To do this, clear the Buttons item in the View menu. 

Menus The Ratio Application contains the following menus: 
File, Edit, View, Commands, Setup, Graph, Help

See also: 
Status Display 
Status Line 
Keyboard function keys 
Ratio home page
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Setup dialog
Setup menu
Cary page
Options page
About smoothing
Accessories page
Multicell/Temperature accessories
Multicell Changer
Wellplate accessory
Display Options dialog
Wellplate Sample List
Go To Well dialog
Fast Filter accessory
Analyze page
Rate calculations
Reports page
Report toolbar
Clear Report
How to use the advanced reporting options
Auto Store page
How to email the results

Use the Setup dialog to set up your instrument and accessories for a Ratio run. You can also use the dialog to 
set up the Analysis, Report and Storage parameters associated with the run. 

The Setup dialog comprises the following tabbed pages: 

Cary
Options
Accessories
Analyze
Reports
Auto Store

Use the Setup menu to access the parameters for setting up a Ratio read. 

Setup—Ratio 

To access the Setup dialog select the Setup button from the Ratio Application window or the 
Setup command from the Setup menu. 

See also:
Ratio Application

Setup menu—Ratio 

Command What it does…
Setup Choose Setup to display the Setup dialog where you can set up your instrument for a Ratio 

measurement. The Setup dialog can also be accessed from the Setup command button.
Cary Choose Cary to display the Cary page. You can use this page to set up the instrument 

parameters associated with the data collection.

Page 4 of 106Ratio Home Page

   



Instrument Setup | Wavelength Setup | Collect Timing | Status Display 

Use the Cary page to set up the instrument parameters associated with the data collection. 

From the Setup menu, select Cary to access the Cary page. You can also access the page from the Setup 
dialog by selecting the Cary tab. To access the Setup dialog, select the Setup button from the Ratio 
Application window. 

Instrument setup 

Wavelength setup 

Options Choose Options to display the Options page where you can set up your filters and set the 
detector voltage. You can also use this page to select the way the collected data is displayed 
in the Graphics area, and the type of smoothing applied (if any).

Accessories Choose Accessories to display the Accessories page. You can use this page to set up the 
accessory parameters associated with the data collection.

Analyze Choose Analyze to display the Analyze page where you can select from various 
mathematical equations and set the parameters used to generate the calculation of reaction 
rates.

Reports Choose Reports to display the Reports page. You can use this page to set up the report 
parameters associated with data collection.

Auto Store Choose Auto Store to display the Auto Store page where you can specify if and when data 
will be stored, and in what format.

See also: 
Setup  
Cary  
Options  
Accessories  
Analyze  
Reports  
Auto Store 

Cary—Ratio 

Note 
The Ratios application operates in Fluorescence mode only.

Data mode Fluorescence 
Fluorescence refers to the emission of light from an excited single state. The fluorescence 
signal is measured when the lamp flashes.

Collection 
type 

Choose from the following: 

Single wavelength 
Select this option to monitor a single wavelength in your reaction, reading the intensity of 
one wavelength over time. Select this option for non wavelength shifting dyes. 

Multi wavelength 
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Select this option to monitor two wavelengths in your reaction. Select this option if you are 
using wavelength shifting dyes whose wavelength maxima shift in the presence of the dye 
they measure. If you select Multi wavelength, the Multi wavelength table will be 
displayed. 

Multiwavelength table 
Use the Multi wavelength table to enter the excitation and emission 
wavelengths to be monitored for each wavelength. 

Excitation fast filter 
Select this option to use the fast filter accessory to collect excitation wavelengths. This 
option can be used to measure the excitation of wavelength shifting dyes when the ion 
response rate is very fast. 

Emission fast filter 
Select this option to use the fast filter accessory to collect emission wavelengths. This 
option can be used to measure the emission of wavelength shifting dyes when the ion 
response rate is very fast. 

Note 
You will need to install the fast filter accessory if you wish to select this option.

Note 
You will need to install the fast filter accessory if you wish to select this option.

Ex. 
Wavelength 
(nm) 

Set the wavelength of the excitation monochromator, which is the wavelength value at 
which you want to excite your sample. Click the arrow to the right of the field to quickly 
select the most recent wavelength entries. The Ex. wavelength option is not available if you 
have selected the Multi wavelength or Excitation fast filter options. 

Alternatively, to set the excitation monochromator to zero order (white light), from the 
Commands menu, point to Zero Order and select Excitation. A tick next to this option 
indicates that it is selected. Clear this option to return to monochromator light and use the 
value set in the Ex. Wavelength field. 

Em. 
Wavelength 
(nm) 

Set the wavelength of the emission monochromator, which is the wavelength value at which 
your sample emits. Click the arrow to the right of the field to quickly select the most recent 
wavelength entries. The Em. wavelength option is not available if you have selected the 
Multi wavelength or Emission fast filter options. 

Alternatively, to set the emission monochromator to zero order (white light), from the 
Commands menu, point to Zero Order and select Emission. A tick next to this option 
indicates that it is selected. Clear this option to return to monochromator light and use the 
value set in the Em. Wavelength field. 

Ex. Slit (nm) Set the slit width of the excitation monochromator. 

As a general rule: 
At a fixed emission slit width, increasing the excitation slit width will result in an increase 
in the fluorescence excitation intensity.  

Em. Slit (nm) Set the slit width of the emission monochromator. 
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Collect timing 

As a general rule: 
At a fixed excitation slit width, a two-fold increase in the emission slit width will result in a 
four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the 
emission slit width will result in a four-fold decrease in the emission intensity. 

Hot Tip 
Increase your slit width and decrease your PMT to get an increase in the signal intensity and a decrease 
in noise. Be careful not to start with too high an intensity as this may lead to an over range.

Simple collect Select this option to set the Number of Stages to '1'. Use one stage if you require only one 
collection rate for the entire ratio run. 

Advanced 
collect 

Check this option to enable the Number of Stages entry field and specify the collect time 
profile of a run, enabling you to vary the rate at which data is collected over the period of 
the run. Enter the times required in the fields in the Cycles table. 

No. of stages 
Use this to set the number of time segments into which you wish to divide the total data 
collection time, each having a different data collection rate. The Cycles table will expand to 
fit the number you enter. 

Q. When do I choose an Advanced Collect?
A. The Advanced Collection option allows you to divide the length of the run into
different sections or ‘stages’. You can nominate a different data collection rate for
each stage. This means that you can collect lots of data points during the stage when
the reaction is happening quickly and then reduce the number of data points collected
when the intensity change is slower.

Q. Why isn't the Number of Stages entry field active?
A. You have selected Simple Collect. On selecting Advanced Collect, the field will
be activated.

X Mode This enables you to set the units of time for the abscissa (or X axis). 

Choose your desired abscissa mode by selecting one of the following buttons: 

Min 
Select this to time the run in minutes. 

Sec 
Select this to time the run in seconds. 

Ave time (s) Set the amount of time, in seconds, for which data is averaged. To do this, enter the amount 
in the Ave. time field, or use the up/down arrows to the right of the field to increase or 
decrease the time. The averaged result is displayed in the report. 

When setting the Ave Time, consider the following:  

The longer the Ave Time, the longer the signal will be averaged
A longer Ave Time will result in more precise results as the averaging of the signal
reduces any contribution of background ‘noise’.
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Status Display 

Select this check box to display the Status Display window, where you can view the status of various 
parameters during the data collection. 

Display Options | Smoothing | Excitation Filter | Emission Filter | PMT Detector Voltage | Status Display 

Use the Options page to set up your filters and set the detector voltage. You can also use this page to select the 
way the collected data is displayed in the Graphics area, and the type of smoothing applied (if any). 

From the Setup menu, select Options to access the Options page. You can also access the page from the 
Setup dialog by selecting the Options tab. To access the Setup dialog, select the Setup button from the Ratio 
Application window. 

Averaging is calculated as follows: 
the number of readings averaged are taken from consecutive flashes at 80 Hz where: 
number of consecutive flashes = averaging time/0.0125. 

Hot Tip 
By increasing the averaging time it is possible to collect more data points, up to 
80 points/sec. This is useful if you have a fast run.

Cycles Table This table enables you to vary the data collection rates within the one ratio run. This feature 
is particularly useful when analyzing slow reactions and multi-step reactions. 

Stage 
This column displays the stage number/s. 

Cycle 
Enter a number in this numeric field to set the rate at which the system will cycle the 
specified cell setup.  

Stop 
Type a number in this numeric field to set the Stop Time to establish how long you require 
the ratio analysis to continue.  

Note 
Stop Time overrides Cycle Time so make sure that the Stop Time is long enough to 
allow the measurement of all Cycles.

See also: 
Accessories  
Example of a multi-stage run  
Example using the Stop time  
Status Display 

Options—Ratio 

Display 
Options 

Overlay traces 
Select this option to superimpose the collected data of each sample in the run in one graph 
box. If you select this option, a graph box is created at the start of the collect in the Graphics 
area and each sample’s data is overlaid in that box as the data is collected. Traces will always 
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be overlaid in the same graph, regardless of what multicell/well accessory is used. 
Clear this option to display all of the traces in individual graphs. 

Y minimum/Y maximum 
Enter the minimum and maximum Y values to be displayed on the graph axis. The software 
will update the Y axes to reflect these settings during the ratio run. 

Note 
When using the Wellplate reader it is possible to define how you want to overlay the 
traces. This is done on the Accessories tab when the Wellplate reader has been 
selected, using the Display options button.

Smoothing Select Smoothing to reduce the noise of your collected data. When you select this option, 
smoothing will be applied to the ratioed intensity signal using the algorithms defined below. 
You can select one of the three types of smoothing that can be performed during a run. Only 
the smoothed trace is displayed during data collection, however the ratioed unsmoothed data 
is also saved with the experiment. 

Type 
Savitzky-Golay 
This algorithm will take the number of Filter points, apply the Savitzky and Golay smoothing 
algorithm  and display the smoothed value at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_SG'. 

Tell me more about Savitzky-Golay smoothing 

Boxcar average 
This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_Box'. 

Tell me more about Boxcar averaging 

Moving average 
This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_Mov'. 

Tell me more about Moving average 

Filter size 
Enter the Filter size, which determines the number of points that will be used in the 
smoothing procedures. The higher the filter size (and thus the number of points used), the 
greater the amount of smoothing that will be performed.  

Filter sizes must be odd values. For Boxcar and Moving averages, the range is 3–101. For 
Savitzky-Golay smoothing, the range is 5–101.  

Excitation 
filter 

Set the excitation filter for the Ratio measurement. To do this, select the down arrow to the 
right of the field and select an option from the list. 

A range of filter settings are available: 

Auto 
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If you select the Auto option, the filter wheel will be automatically moved to the appropriate 
position for the selected excitation wavelength. It is recommended that you set the filter to 
Auto (which is the default setting). 

Open 
If you select Open no filter is used. 

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 

250–395, 335–620, 550–1110, 695–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you can 
select your filter manually. Otherwise it is recommended that you set the filter to Auto. 

Emission filter Set the emission filter for the Ratio measurement. To do this, select the down arrow to the 
right of the field and select an option from the list. 

A range of filter settings are available: 

Auto 
If you select the Auto option, the filter wheel will be automatically moved to the appropriate 
position for the selected emission wavelength. It is recommended that you set the filter to 
Auto (which is the default setting). 

Open 
If you select Open no filter is used. 

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 

250–395, 295–1110, 360–1110, 430–1110, 550–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you can 
select your filter manually. Otherwise it is recommended that you set the filter to Auto. 

3%T Attenuator 
Select 3%T Attenuator to decrease the fluorescence intensity and thus the amount of light 
going to the emission PMT. This setting is useful for highly fluorescent samples when you 
are using wide slits. 

Hot Tip 
If you have a low fluorescence signal you may want to set the emission filter to open 
to allow all the light to hit the detector.

PMT Detector 
Voltage 

Set the EHT or sample detector PMT. To do this, select one of the following: 

Low 
Sets the PMT Detector voltage to a pre-defined value of 400 v. Typically you would select 
this setting if you are reading highly emitting samples. 

Medium 
Sets the PMT Detector voltage to a pre-defined value of 600 v. Typically you would select 
this setting if you are reading moderately emitting samples. 

High 
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About Smoothing—Ratio 
Savitzky-Golay | Boxcar average | Moving average 

Savitzky-Golay 

Savitzky-Golay smoothing is used to obtain good noise reduction with sharp peaks. The equation constants are 
specific to Filter Size. The constants for each filter size are published in the Savitzky-Golay paper (A. 
Savitzky, M.J.E. Golay, Anal. Chem., 36 (1964) 1627). The equation also requires that Filter Sizes entered 
must be odd values, between 5 and 101. 

Example 

Result 

The first smoothed data point will be: 
(x3, (Y1*a1+Y2*a2+Y3*a3+Y4*a4+y5*a5)/b), 

the next: 

Sets the PMT Detector voltage to a pre-defined value of 800 v. Typically you would select 
this setting if you are reading low emitting samples. 

Manual 
Enables you to enter any PMT voltage in the adjacent Volts field. 

Volts 
Enter the PMT voltage in the adjacent field. Note that this option is only available if you 
have selected Manual as the PMT Detector voltage. 

Tip 
Increasing or decreasing the PMT Detector Voltage by 10% will double or halve the 
fluorescence intensity observed.

Reagent list Select this option to display the Reagents List. To set the list of reagents: 
Enter your solutions to be used during the reaction in the Reagent Name list, typing the 
reagent name in the available entry fields. Be sure to set the reagent number to five even if 
five reagents are not used. 

To display the Reagent List once you have exited the Setup dialog simply select the Reagent 
List button . If you wish to time stamp the point at which a particular reagent was added 
simply click on the reagent entry field in the open Reagent List and this will note on the 
graph at what time the selected reagent was added to the reaction. 

Status Display Select this check box to display the Status Display window. This window allows you to 
view the status of various parameters during the data collection.

See also: 
Setup 
Status Display window

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size 5
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(x4, (y2*a1+y3*a2+y4*a3+y5*a4+y6*a5)/b) …  
(xn-2, sum(yn-4*a1+yn-3*a2+yn-2*a3+yn-1*a4+yn*a5)/b), 

where a1..a5, b are constants defined by Savitzky and Golay. 

Each smoothed point is calculated using the previous and next data points. For this reason, calculations cannot 
be performed on the very first and very last data points in a data set. Hence, smoothed traces will lack the first 
and last X values of the original trace. 

Boxcar average 

Boxcar averaging can be used when the change in intensity is minimal. 

Example 

Result 

The first smoothed data point will be: 
(x3, sum(Y1:y5)/5), 

the next: 
(x8, sum(y6:y10)/5) … (xn-2, sum(yn-4:yn)/5). 

If there are not enough points at the end of the data set to complete the filter size, then these points will be 

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size 5
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ignored, hence, the gap at the end may be larger than the gap in the beginning. 

Moving average 

Example 

Result 

The first smoothed data point will be: 
(x3, sum(Y1:y5)/5), 

the next: 
(x4, sum(y2:y6)/5) … (xn-2, sum(yn-4:yn)/5). 

Use the Accessories page to set up the accessory parameters associated with the data collection. 

From the Setup menu, select Accessories to access the Accessories page. You can also access the page from 
the Setup dialog by selecting the Accessories tab. To access the Setup dialog, select the Setup button from the 
Ratio Application window. 

The Accessories page will vary, depending upon what accessory button you have selected from the following: 

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size 5

Accessories—Ratio 
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Multicell/Temperature
Wellplate reader
Fast Filter

The Multicell and Temperature accessory page is displayed when you select the Multicell/Temperature tab 
on the Accessories page. 

The page comprises the following: 

Multicell Holder 

Select this option to use the Multicell Holder and cells with the Cary Eclipse. 

Temperature Control 

Select this option to use the Temperature Controller with the Cary Eclipse. 

See also: 
Cary page

Multicell and Temperature accessories—Ratio 

Note 
By selecting this accessory you will prohibit the use of some combinations of other accessories that are 
also controlled by the Accessory Controller Board.

Multi-zero If you select Multi-zero, a Multi-zero will be performed when the Zero button is selected in 
the Ratio Application window. Because cuvettes can have different intensities, and samples 
vary, this field is used when you require all blank readings to consistently start at zero 
intensity. Please refer to the read me file for Multi-zero. 

A reading will be taken at the set Averaging Time at the set Ex. and Em. wavelengths and at 
every selected cell position. These readings will be offset to zero and subsequent readings 
will have the corresponding offset value subtracted from each cell. 

Reset Select Reset to drive the Multicell Holder to cell position 1, which is its fully retracted or 
zero position.

Go to cell… Select Go to cell to open the Multicell Changer dialog. You can use this dialog to manually 
move the Multicell Holder accessory to a new cell. To do this, simply select the 
corresponding button of the cell you require in the Multi Cell Changer dialog. The Multicell 
Holder will move the selected cell to the measurement position in the sample compartment. 

The Multicell Changer dialog is ‘modeless’ which means that it can remain open even once 
you have cleared the Setup dialog. This enables you to use the Rapid Read command to 
perform a reading at the cell specified in the Cell Changer. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse will 
display the intensity reading corrected by the determined zero-offset amount for that cell. 

 
Note 
You can use this option to check the intensity of a cell or start a ratio run at a particular 
cell.

Note 
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Temperature Display 

Select this option to view Temperature Display information in the Status Display window. 

 
The Temperature Control option does not control temperature accessories that are not listed in the 
Device field. For example, if you have selected the Temperature Control option and set the Device to 
None because you have a different temperature control accessory, the Cary Eclipse software will not 
control that accessory. However, it will monitor the temperature and prompt the software to start when the 
accessory reaches the temperature listed in the Temperature field. 

Device Select the device that will be used to control the solution temperature. 

The options available will depend upon whether or not you have selected the Multicell 
holder option. 

None 
Select this option if you are using a Temperature Control device not listed in this field (for 
example, a third party water bath). Note that the Cary Eclipse software will not control the 
accessory. The software will simply monitor the temperature and prompt the software to start 
when the accessory reaches the temperature listed in the Temperature field. 

PCB 150 Water Bath 
Select this option if you are using the PCB 150 water bath. 

Single cell peltier 
Select this option if you are using the Single cell peltier. 

Temperature controller 
Select this option if you are using the Temperature controller. 

If you have selected the Multicell holder, the 
following Device options will be available 
for selection: 

Temperature controller
PCB 150 water bath
None

If you have not selected the Multicell holder, 
the following Device options will be 
available for selection: 

Single cell peltier
PCB 150 Water bath
None

Temperature Set the temperature at which the reaction will be performed. The default value is 20.00° C. 

When you select OK to close the Setup dialog, all buttons including the Start button in the 
Ratio Application window will be disabled until the temperature recorded by the Monitor 
device is within ± 0.5°C of the temperature range. 

If Zero or Start is selected, and the temperature is not within ± 0.5°C of the temperature 
range, then the system will wait for the temperature to be within the set range before 
continuing with the measurement. Whilst waiting for the temperature, there will be a display 
on the status line at the bottom of the Ratio Application window giving the current 
temperature and the elapsed time waiting to reach the set temperature. 

Port Select from COM1, COM2, COM3 or COM4. 
This option is not available if you have selected None as the Device.

Monitor Select which device will be used to monitor the reaction temperature. Select from Block, 
Probe 1, Probe 2, Probe 3 or Probe 4. 
Note that the the options in this field may change depending on the Device selected.
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The Temperature Display option is only available if you have selected the Temperature Control option. 

Status Display 

Select this check box to display the Status Display window. Use this window to view the status of various 
parameters during the data collection. 

Use the Multi Cell Changer dialog to manually move the Multicell Holder accessory to a new cell. To access 
the Multi Cell Changer dialog, select the Go to cell button from the Multicell/Temperature Accessories 
page. 

The dialog comprises the following: 

The Wellplate accessory page is displayed when you select the Wellplate tab on the Accessories page. 

The page comprises the following: 

Wellplate reader 

Block/ 
PCB 150 

Select this option to view the temperature of the Block (if you have selected the Single Cell 
Peltier device) or the PCB 150 (if you have selected the PCB 150 Water Bath) in the Status 
Display window.

Probes Select one or more of these options to view the temperature of the Probes in the Status 
Display window.

See also: 
Accessories  
Multi Cell Changer 
Fast Filter Accessory 
Status Display

Multi Cell Changer—Ratio 

Multicell 
changer 

To manually move the Multicell Holder accessory to a new cell, simply select the 
corresponding  button of the cell you require in the Multi Cell Changer dialog. The Multicell 
Holder will move the selected cell to the measurement position in the sample compartment. 

The Multi Cell Changer dialog is ‘modeless’ which means that it can remain open even once 
you have cleared the Setup dialog. This enables you to use the Rapid Read command to 
perform a reading at the cell specified in the Cell Changer. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse will 
display the intensity reading corrected by the determined zero-offset amount for that cell. 

Note 
You can use this option to check the intensity of a cell or perform a scan at a particular 
cell.

See also: 
Multicell/Temperature Accessories  
Rapid Read

Wellplate accessory—Ratio 
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The Wellplate accessory page is displayed when you select the Wellplate tab on the Accessories page. 

The page comprises the following: 

Wellplate reader 

Select this option to use the Wellplate reader with the Cary Eclipse. 

Q. Why is the Wellplate reader option unavailable?
A. The multicell holder, temperature control and/or polarization accessory has been selected. As you
cannot place any of these accessories and the Wellplate reader in the Cary Eclipse sample compartment at
the same time, you must clear other accessory selections before selecting the Wellplate reader.

Plate format Select the type of Wellplate to be used. The default options are 96 wells, 192 wells or 384 
wells. 
The graphical representation of the Wellplate will change according to the number of wells 
chosen.

Auto-zero Select this option to perform an auto-zero when the Zero button is selected from the Ratio 
Application window. A zero reading will be taken at the selected well position using the 
current method setup. To select the well position to be zeroed, use the Select Well option. 

These readings will be offset to zero and subsequent readings will have this single value 
subtracted from each well in the sequence. The reading is taken only once, stored, and 
subtracted from the ratioed intensity reading. Refer to the Fluorescence Late Breaking news 
for additional information on ratioed intensities. 

Select well Choose Select well to open the Go To well dialog where you can select the well position to 
be zeroed. This option is only available if you have selected Auto-zero.

Well Displays the well position of the well selected for auto-zeroing. This field is not editable.

Display 
options 

Select this option to open the Display Options dialog where you can set up the display 
parameters associated with the Wellplate reader.

Sample names Select Sample Names to open the Wellplate Sample List dialog where you can enter or 
modify the sample names. Highlight one or more wells on the Wellplate reader diagram to 
view and change their sample information.

Go to well Select this option to open the Go To Well dialog. Select a well on the Wellplate reader 
diagram and a Go to well dialog will be displayed. This dialog will remain open once the 
Setup dialog is closed allowing you to select individual wells before each run. This option is 
only available if you have disabled the Wellplate reader check box.

Well position Displays the well position that the mouse cursor is pointing to. This field is not editable.

Reset Select Reset to move the Wellplate reader to the first well position defined by the read 
sequence.

Park Select Park to move the Wellplate reader to the Park position. The Wellplate reader 
accessory is moved clear of the sample compartment to enable you to easily access all wells.

Wellplate 
reader 
diagram 

The Wellplate reader diagram represents the number of wells present for the Wellplate 
configuration you have chosen. 

The labels for the rows will be 1 .. 12 and for the columns A .. H (for a 96 Wellplate). 
Similar labels will occur for different Wellplates according. The sequence for numbering the 
read order will be from A1 to A12, B12 - B1, C1 - C12…etc for a 96 Wellplate. A similar 
sequence will be valid for other plates. 
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Status Display 

Select this check box to display the Status Display window. This window allows you to view the status of 
various parameters during the data collection. 

Display Options—Ratio 
Use the Display Options page to set up the display parameters associated with the Wellplate Reader. 

The Display Options page is accessible from the Wellplate Accessories page by selecting the Display 
Options button. 

The page comprises the following: 

Display 

To select or clear a single well, simply click or right-click on it. 

To select or clear a block of wells, hold down the left mouse and drag around the block 
required. All wells within the area will be selected or cleared. 

See also: 
Accessories page  
Display Options dialog   
Go To Well dialog  
Wellplate Sample List dialog   
How to import sample names into the Wellplate sample list 
Status Display window

Individual 
graphs 

Select this option to display the collected data of each sample in individual graph boxes, 
rather than overlaid on each other in one box. 

At the start of a scan, a separate box is created for each sample. Similarly, the collected data 
for each sample is displayed in a separate graph box. 

Overlay all 
traces 

Select this option to superimpose the collected data of each sample in the run in one graph 
box. 

One box is created at the start of the collect in the Graphics area and each sample’s data is 
overlaid in that box as the data is collected. 

User defined Select this option if you wish to specify the exact number of traces to be included on one 
graph. 
Number of traces per graph 
Enter the number of traces to be displayed per graph. 

Overlay rows Select Overlay rows to view overlaid graphs of the 
wells you have selected. Wells in the same row of the 
wellplate reader will be overlaid. If you had selected 
wells as shown in the adjacent diagram, a total of  
seven graphs would be displayed (as seven rows 
contain selected wells). The first graph would contain 
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Wellplate Sample List—Ratio 
Use the Wellplate Sample List dialog to enter or modify the sample names of each well in the wellplate 
reader. 

The Wellplate Sample List is accessible from the Wellplate Accessories page by selecting the Sample Names 
button. 

The page comprises the following: 

overlaid scans of well A1 and A6, the second graph 
would contain a scan of well B8, etc.

Overlay 
columns 

Select Overlay columns to view overlaid graphs of 
the wells you have selected. Wells in the same column 
of the wellplate reader will be overlaid. If you had 
selected wells as shown in the adjacent diagram, a 
total of 11 graphs would be displayed (as 11 rows 
contain selected wells). The first graph would contain 
overlaid scans of well A1 and D1, the second graph 
would contain a scan of well H2, etc.

See also: 
Wellplate Accessories 

No. of samples Displays the total number of samples that have been selected from the Wellplate Reader 
diagram on the Wellplate Accessories page. This field is not editable.

Sample table The sample table lists the Sample Names and Well numbers of the selected samples. 
Sample Name 
Samples are named numerically, depending upon where they are located on the Wellplate 
Reader diagram. The sequence for numbering the Sample Name order is to read from A1 to 
A12, B1 to B12, C1 to C12…etc for a 96 wellplate. Therefore, if the B2 cell is selected, its 
corresponding Sample Name will be Sample 14. 

To modify the name of a sample, highlight the sample name and type in a new name. You can 
enter up to 20 characters for each name. 

Well 
Displays the position of the well corresponding to the Sample Name. This field is not editable.

Import names Select Import Names to display the Open dialog which you can use to select a text file to 
import into the Sample Names column. 

How to import sample names into the Wellplate sample list 
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Go To Well—Ratio 
You can use the Go To Well dialog to manually move the Wellplate Reader accessory to a new well. This 
enables you to check the intensity of a well or perform a read at a particular well. 

The Go To Well page is accessible from the Wellplate Accessories page by selecting the Select well or Go To 
Well button. 

The Go To Well dialog is ‘modeless’ which means that it can remain open even once you have cleared the 
Setup dialog. This enables you to use the Rapid Read command to perform a reading at the selected well. 

If you move to a new well after you have performed a Multi-zero, the Cary Eclipse will display the intensity 
reading corrected by the determined zero-offset amount for that well. 

The page comprises the following: 

Hot Tip 
If your samples are the same for a number of reactions, create a text file containing the 
name of each sample and simply import the file into the Sample Names Column for 
each run.

Increment Select Increment to copy and increment the sample names in the Sample Name list. This will 
save you from entering each sample name individually when the names consist of a descriptor 
followed by a number. 

To use the increment option, highlight the name that you want to increment and select 
Increment. The Cary Eclipse will increment the names of all the files proceeding the first 
highlighted name. 

Example: 
In this example, Sample B1 is highlighted when the Increment button is selected. 

Sample Name Becomes
Samp A  Samp A

 Sample B Sample B1
Sample C Sample B2
Sample D Sample B3
Sample E Sample B4

See also: 
Wellplate Accessories page  
About the Wellplate Reader 

Wellplate 
reader 
diagram 

The Wellplate Reader diagram represents the number of wells present for the chosen wellplate 
configuration. 

The labels for the rows will be 1 .. 12 and for the columns A .. H (for a 96 wellplate). Similar 
labels will occur for different wellplates accordingly. The sequence for numbering the read 
order will be from A1– A12, B12– B1, C1– C12, etc for a 96 wellplate. A similar sequence 
will be for other plates. 
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If you are using the Fast Filter accessory, this page enables you to setup the filters. The Fast Filter accessory 
page is displayed when you select the Fast Filter tab on the Accessories page. 

The page comprises the following:  

Fast Filter 

To move the Wellplate Reader accessory to a new well, simply click on the corresponding 
well on this diagram. The Wellplate Reader will move the selected well to the measurement 
position in the sample compartment. 

To select or clear a single well, simply click or right-click on it. 

To select or clear a block of wells, hold down the cursor and drag around the block required. 
All wells within the area will be selected or cleared. 

X, Y, Well Displays the Well Position that the mouse cursor is pointing to. This field is not editable.
Reset Select Reset to move the Wellplate Reader to the first well position, which is well A1.
Park Select Park to move the Wellplate Reader to the Park position. When the accessory is in the 

park position you have full access to the Wellplate Reader platform. This is useful for 
inserting or removing wellplates from the accessory. 

See also: 
Wellplate Accessories page  
About the Wellplate Reader 

Fast Filter accessory—Ratio 

Result 1 
or 
Result 2 

The Result and Filter options reflect the setup of the fast filter accessory and are used 
to indicate what positions the filters have been placed in. Once you have set up your 
fast filter accessory, you must indicate the positions of the filters using these options.

Note 
These options are only available if you have set the Collection type on the Cary 
page to Excitation fast filter or Emission fast filter.

Note 
When placing filters in the fast filter 
accessory, you must place them in opposite 
positions (e.g., Positions 1 and 3 or Positions 
2 and 4) so that the fast filter accessory does 
not become unbalanced. The filters must also 
be the same dimensions and of similar mass.  

Black discs supplied with the accessory must 
also be placed in the filter positions which 
are not in use to ensure the filter wheel is 
adequately balanced. For example if filters 
are placed in positions 1 and 3, black discs 
must be placed in positions 2 and 4. 

Dots on the accessory indicate the position 
number (refer adjacent diagram).
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Status Display 

Select this check box to display the Status Display window. Use this window to view the status of various 
parameters during the data collection. 

Subtract autofluorescence | Dual wavelength analysis | Single wavelength analysis | Status Display 

Use the Analyze page to select from various mathematical equations and set the parameters used to generate 

If you have filters in positions 1 and 3:  

Select the Result 1 option to calculate and display the intensity of Filter 1 and Filter 
3. You can then choose to determine the ratio of Filter 1:Filter 3 or the ratio of Filter
3:Filter 1 by selecting the appropriate filters in the adjacent fields. For example, to
determine the ratio of Filter 3:Filter 1, select Filter 3 in the first field. Filter 1 will
then be automatically selected in the second field.

If you have filters in positions 2 and 4:  

Select the Result 2 option to calculate and display the intensity of Filter 2 and Filter 
4. You can then choose to determine the ratio of Filter 2:Filter 4 or the ratio of Filter
4:Filter 2 by selecting the appropriate filters in the adjacent fields. For example, to
determine the ratio of Filter 4:Filter 2, select Filter 4 in the first field. Filter 2 will
then be automatically selected in the second field.

Position 

Select this to specify the filter position at which data collection at a single wavelength 
(specified on the Cary page) will be performed. The options are: Park, Filter 1, 
Filter 2, Filter 3 or Filter 4. If you select the Park position, the accessory will be 
rotated 45° from position 1 (to the 'Flag' position shown in the above diagram), 
ensuring that a beam does not pass through any of the four positions. The fast filter 
accessory will drive to the selected position when you close the Setup dialog.   

Note 
This option is only available if you have set the Collection type on the Cary page 
Excitation fast filter or Emission fast filter AND the Result 1 and Result 2 
options are not selected.

Filter 1/ Filter 2/ 
Filter 3/ Filter 4 

These fields enable you to enter information about the types of filters you are using in 
the fast filter accessory. This information is for your reference only. It will not be 
used in any software calculations. The following information can be entered: 

Name 
Enter the name of the filter used. 

Wavelength 
Enter the wavelength of the filter.  

See also: 
Cary tab 
Accessories  
Multi Cell Changer 
Status Display

Analyze—Ratio 
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the calculation of reaction rates. 

From the Setup menu, select Analyze to access the Analyze page. You can also access the page from the 
Setup dialog by selecting the Analyze tab. To access the Setup dialog, select the Setup button from the Ratio 
Application window. 

Subtract autofluorescence 

Select this option if you wish to remove the intrinsic fluorescence value associated with cells from your ratioed 
trace. 

In the Enter value to subtract from trace field, enter the fluorescence value that you wish to be subtracted 
from your post reaction ratioed trace. Selecting this option disables both the Dual wavelength analysis and 
Single wavelength analysis options. 

Dual wavelength analysis 

Select this option when performing ratio calculations for wavelength shifting dyes and when you are required 
to monitor two wavelength pairs. 

Enter Rmin and Rmax manually:  
Select this option if you wish to determine the concentration value by entering previously determined Rmin, 
Rmax, Sf(λ2), Sb(λ2) and Kd values directly into the Ratio software.  

Determine Rmin and Rmax from the graph: 
Select this option if you require the Rmin, Rmax, Sf(λ2), Sb(λ2) values to be calculated from the graph. 

For more information on the ratio calculations see the Grynkiewitz equation. 

Single wavelength analysis 

Select this option when performing calculations for non-wavelength shifting dyes. 

Enter Fmin and Fmax manually 
Select this option if you wish to manually enter the Fmin and Fmax values for the Grynkiewitz equation. 

Determine Fmin and Fmax from graph 
Select this option if you require the Fmin and Fmax values to be calculated from the graph. 

Status Display 

Select this check box to display the Status Display window. This window allows you to view the status of 
various parameters during the data collection.

Q Why are the Subtract autofluorescence, Dual wavelength analysis or Single wavelength analysis 
options not available? 

A If one of the above options are not available deselect the option currently in use to make each of the 
options available. 
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To determine the true fluorescence value of a reaction it is necessary to subtract the autofluorescence of the 
reaction. That is it is necessary to subtract the intrinsic cell fluorescence from the overall calculated 
fluorescence of the reaction. 

Step 1 

Using the Trace Preferences option  display the two traces with the autofluorescence subtracted as two 
separate graphs. 

Select the individual traces by clicking in the Visible column next to the trace. 

Step 2 

Return to the main graphics area and select a trace by clicking in the graphics area. 

Step 3 

Using the calculator button  in the toolbar, open the Math's dialog box. 

Step 4 

Enter your first trace in the Calculation entry field by using the Selected Trace button. 

Step 5 

Divide the Selected Trace by the Focused Trace by simply selecting the divide option and then using the 
Focused Trace button. 

Step 6 

Under Trace select Ratio mode from the operation types. Click Apply and then equals. 

Step 7 

A ratioed trace is will now be visible in the graphics window and will be named after the two initial traces with 
_AF1 ending the name. 

To obtain a concentration graph from the ratioed trace it is necessary to use the Grynkiewitz equation. 

Step 8 

Select the Recalculate button in the bottom left hand corner of the application. On the Analyze tab, select the 

 
See also: 
How to determine autofluorescence 
Subtracting autofluorescence 

How to obtain a ratioed trace—Ratio 

Note 
The ratioed trace has not been saved. Save the new trace as a batch file.
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Dual Wavelength checkbox. 

There are two ways of performing the Grynkiewitz equation: 

1. By manually entering the required data

2. Gathering the required data from the graph

Status Display 

Select this check box to display the Status Display window. This window allows you to view the status of 
various parameters during the data collection. 

Operator | Options | X-Y Pairs Table | Status Display 

Use the Reports page to set up the report parameters associated with data collection. 

From the Setup menu, select Reports to access the Reports page. You can also access the page from the 
Setup dialog by selecting the Reports tab. To access the Setup dialog, select the Setup button from the Ratio 
Application window. 

The page comprises the following: 

Operator 

Note 
If the reaction has been performed previously and is relatively stable it is possible to use the Rmin a
Rmax values previously calculated.

Note 
If you are performing the reaction for the first time, or the reaction is unstable and varaible the Rmin
Rmax should be determined from the graph.

 
See also: 
How to obtain an autofluorescence value 
How to subtract autofluorescence 
Manually entering data in the Grynkiewitz equation 
Gathering the required data from the graph for the Grynkiewitz equation 
More information on The Grynkiewitz equation 

Reports—Ratio 

Hot Tip 
You can view your generated report before you print it out using the Print Preview command in the 
File menu 

If you decide to make changes to the report layout, select  (Edit Report) from the Report toolbar. 
This enables you to directly edit the report.

Name Enter the instrument operator name in this text entry field. Use the arrow to the right of this 
field to view and select one of the last ten entries in this field. 
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Options 

This group enables you to select the information to include in your report. 

X-Y Pairs Table

Note 
In GLP mode the system will automatically enter the operator’s name and this field 
will not be editable.

Comment Enter operator details and comments in this text entry field.

Auto Print Select Auto Print to print a report automatically during the data collection. 
If Auto Print is selected, then the system will send the report information to the specified 
printer(s) as well as the Report area. However if Auto Print is not selected, the report will 
only be sent to the Report area and can be viewed by selecting Report in the View menu. 

To automatically obtain a copy of the graphics, you will need to select both the Auto Print 
and Graph options (see below). In this case, all graphical information displayed on screen 
will be printed with the report. Therefore it is advisable to arrange the graphical information 
as you require on screen, prior to printing.  
For example, if you require a single graph print out, then the Single/Multi Graph option in 
the Graph menu should be changed to the correct setting. 

Parameters Select this option to include the method setup parameters within your report.

User data 
form 

Select this option to include in the report any information entered in the User Data Form.

Graph Select Graph to include any graphs or graphic information associated with your report.  
If you require a printout of the displayed graphics only, you must ensure that only this 
option is selected. Select the Clear Report button to clear any information in the Report 
area before you print otherwise this will be included in your printout. 
% Page Height 
Enter the size at which you want the graph to be printed, as a percentage of total page 
height. For example, if you want graphical information to take up half of the page, enter 
50% in this field.

Company 
Logo 

Check this option to include your company logo in the report. 
A company logo will only be included if you have added one on the Company page of the 
System Information Application. 

Hot Tip 
If you have not included a Company logo, select the Header/Footer button to open the 
System Information Application and use the Add Logo option to add a logo.

Header/ 
Footer 

Select the Header/Footer button to open the System Information application where you can 
enter the Header and Footer information to be included in your report. You can also enter 
any additional comments, and add a logo to your report. Once you have made all your 
changes, select OK to exit the System Information application and return to the Reports 
page of the Ratio application.

Focused trace Select this option to apply the Report selections to the focused trace only.

All traces Select this option to apply the Report selections to all visible traces.
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Select this if you want to print a table showing the X-Y pairs of the collected data in your report. 

Status Display 

Select this check box to display the Status Display window, where you can view the status of your ratio run 
during the data collection. 

Report Toolbar—Ratio 
Use the Report toolbar buttons to gain quick access to many of the Edit menu options. You can also use the 
toolbar to cut, copy and paste information and to change the look of your report. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Reports. To display 
or hide the toolbar's text labels, point to the Toolbar option in the View menu and select Text Labels. 

The following commands can be accessed from the Reports Toolbar: 

Data Interval Actual 
Select Actual to report the X-Y pairs table for the trace at the actual Data Interval at which 
the data was collected. 

Interpolated 
Select Interpolated to report the X-Y pairs table for the trace at an interpolated data 
interval. Enter this data interval in the adjacent field. If no data has been collected at the 
interval you enter, the Cary Eclipse software will interpolate the data to produce an X-Y 
result. 

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, Microsoft 
Word or Microsoft Excel) into the report area of the of the Lifetimes application. To edit these objects, 
simply double click on them to open the associated application in which they were created.

See also: 
User Data Form 
View menu  
Status Display window

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Edit Report Click this button to edit the report. 
This command is also accessible by pressing CTRL+R.

Undo If available, this undoes the last action. 
This command is also accessible by pressing CTRL+Z.

Cut Click this button to remove the highlighted text and place it on the Windows 
Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Click this button to copy the highlighted text onto the Windows Clipboard. 
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Clear Report—Ratio 
Select the Clear Report command to remove the contents of the Report Area in the Ratio Application window. 
If you have saved the report, selecting this option does not delete the contents of the report, the information is 
simply removed from the Report Area. 

How to use advanced reporting options—Ratio 
This outlines ways to fully customize your reports. Options available include:  

Including header and footer information
Including a logo
Editing the text in the report
Viewing the report on screen before printing
Cutting and pasting to a word processor

Including header and footer information 

You can have text appearing at the top and bottom of every page in your report. To specify what the text 
should be, do the following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then select 
System Information. The System Information application appears with the Company page displayed. 

Step 2 

This command is also accessible by pressing CTRL+C.
Paste Click this button to insert the contents of the Windows Clipboard (text only) at the 

cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Click this button to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
This option is only available once you select Edit Report and there is text 
highlighted in the Report area. 

Font Click this button to change the font of new or selected text in the report. For 
existing text, simply highlight the text in the report, select this button and make your 
changes in the Font dialog. When you select OK, the appearance of the highlighted 
text in the report will alter to reflect your font changes. 
This command is also accessible by pressing CTRL+F.

Preview Click this button to display the Print Preview dialog where you can view the current 
report as it will be printed.

To access the Clear Report option, select the Clear Report command from the Commands 
menu, or select the Clear Report button from the Ratio Application window. 

See also: 
Ratio Application 
Commands menu
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Enter the header and footer information in the Header and Footer fields. 

Step 3 

Click OK to implement your changes. 

Including a logo 

You can include a logo on the first page of your report. To specify what the logo should be, do the following: 

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then select 
System Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter a logo using the Add Logo button. This logo will always be included on the front page of reports. 

Step 3 

Click OK to implement your changes. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can then add, 
delete and change text in the Report area. 

Viewing the report on the screen before printing 

You can view a report before printing it. To do this, from the File menu select Print Preview. You can then 
ensure that the report format is correct before you print it. 

Cutting and pasting to a word processor 

To have complete control over how your report looks you may wish to copy it to a word processor program, 
such as Microsoft Word. To do this: 

Step 1 

Open a report. 

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application.

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The
Administrator of the system will have to change your privileges before you can edit reports.

Hot Tip 
Use the arrow keys at the bottom of the Print Preview screen to change pages.
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Step 2 

From the Edit menu, choose Edit Report. 

Step 3 

Click in the Report area and highlight the text you want to export to your word processor. 

Step 4 

Right-click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text into a 
document. 

Storage | Auto convert | Email | Status display 

Use the Auto Store page to specify if and when data will be stored, and in what format. You can also use this 
page to set up the system to automatically send an email at the end of a read. 

From the Setup menu, select Auto store to access the Auto store page. You can also access the page from the 
Setup dialog by selecting the Auto store tab. To access the Setup dialog, select the Setup button from the 
Ratio Application window. 

The page comprises the following: 

Storage 

Auto convert 

Use the Auto convert options to convert your data into an ASCII file format that can be opened in spreadsheet 
programs such as Microsoft Excel. 

Auto Store—Ratio 

Off Select this if you do not wish to be automatically prompted to save collected data. 
Note 
If you wish to store your unsaved data manually, choose Save Data As… from the File 
Menu to save your data after the run is complete. You can save your data as a Batch or 
Data file.

On; Prompt 
At Start 

Select this to display the Windows Save As dialog at the start of the collect where you can 
enter the Batch filename for your data.

On; Prompt 
At End 

Select this to display the Windows Save As dialog at the end of a collect where you can 
enter the Batch filename for your data.

None Select None if you do not need to generate an ASCII file.
ASCII (csv) Select this option to save the data as a comma delimited ASCII Spreadsheet file (*.CSV) file. 

Only the currently collected data is converted. 
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Email 

Select the Email check box and enter the Email details to send an email to a person once the read is completed. 
This useful facility can be used to alert you to the completion of the read, particularly if you are working away 
from the laboratory where the Cary Eclipse instrument is. You can also attach the collected data to the email. 

Status display 

Select this check box to display the Status Display window, where you can view the status of your ratio run 
during the data collection. 

ASCII files are stored in the same folder as the data file from which they were generated and 
designated the same filename as the method used to collect the data plus the extension 
‘CSV’. 

ASCII (csv) 
with log 

Select this option to save the data as a comma delimited ASCII Spreadsheet file (*.CSV) file. 
Only the currently collected data is converted. The key method parameters used to collect the 
data are also saved in this file. 

ASCII files are stored in the same folder as the data file from which they were generated and 
designated the same filename as the method used to collect the data plus the extension 
‘CSV’. 

Note 
If you choose to auto-convert the data to an ASCII file but you have set the Storage 
option to Off, then the ASCII file will be saved with the following format: 
DATE TIME. CSV 

The date and time will appear in the same form that is set in the Windows Regional 
Settings Properties dialog that is accessed from the Windows Control Panel. 

For example, 22_4_97 1;32;08.CSV 

Note 
You must set up the email Host and Port options on the Email options page of the System Information 
application in order for the email facility to work correctly.

To Enter the recipient's email address. You can enter more than one recipient in this field.
From Enter your email address (or the email address associated with the computer on which the 

Cary Eclipse software is installed.
Subject Enter the subject of your email (or leave this field blank if you do not wish to include a 

subject).
Cc Enter the email address of any recipient you want to copy the email to.
Message Enter your message.
Attached… Use the Attached button include a file attachment in your email. To do this, select Attached 

and browse your computer to select a file, using the Windows® Open dialog that appears.
Attach current 
data 

Select this option to attach the data that has been collected during the run to the email.

How to email your results 
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How to email your results—Ratio 
You may wish to send an email to a person once the read is completed. This useful facility can be used to alert 
you to the completion of the read, particularly if you are working away from the laboratory where the Cary 
Eclipse instrument is. 

To do this: 

Step 1 

Ensure that you have set up the Host and Port options on the Email options page of the System Information 
application in order for the email facility to work correctly. 

Step 2 

From the Setup menu, select Auto Store. The Auto Store page is displayed. 

Step 3 

Select the Email check box to enable the email options. 

Step 4 

In the To field, enter the recipient's email address (for example, rchandler@varianinc.com). To enter multiple 
recipients, simply type a comma ',' between each email address. 

Step 5 

In the From field, enter the email address of the computer on which the Cary Eclipse software is installed. This 
may be your email address, or a communal email address, if the Cary Eclipse software is installed on a 
computer that has multiple users. 

Step 6 

Enter information in the Subject and Message fields as required. 

Step 7 

Select Attach current data. The data that has been collected during the run will be attached to the email. 

Step 8 

Select OK to clear the Auto Store dialog. Your email will be sent once the run has been completed.

See also: 
Ratio Application window   
Save As dialog   
Status Display window 

Hot Tip 
You can attach other documents to your email. To do this, select the Attached button and browse your 
computer to select a file, using the Windows® Open dialog that is displayed.
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Performing scans—Ratio 
Starting a run
Sample Name dialog
Cell Loading Guide
Sync Start dialog
Start/Stop buttons
Stop Time dialog
Go To dialog
Go To Temperature dialog
Rapid Result dialog
Commands menu
How to perform a single-wavelength ratio run
How to perform a multi-wavelength, temperature controlled ratio run

Information about starting a collect—Ratio 
The sequence that occurs when you select Start to commence the ratio run depends upon your storage and 
accessory selections. 

Storage selections 

Accessory selections 

See also: 
Auto Store 

If you have selected … as the 
Storage option on the Auto Store 
page

The following occurs

On, prompt at start The Windows Save As dialog will appear as soon as you select Start. 
You can save the current method, collected data, report and graph 
template as a Batch file.

On, prompt at end The Windows Save As dialog will appear at the end of the data 
collection. You can save the current method, collected data, report and 
graph template as a Batch file.

Off The Windows Save As dialog will not appear.

If you have selected … on the 
Accessories page

The following dialog is displayed

No accessories The Sample Name dialog will appear when you select Start, 
prompting you to load the sample and enter your sample name. Select 
OK to display the Sync Start dialog and commence the ratio run.

Multicell Holder The Cell Loading Guide dialog will appear. Enter the sample name 
of each activated cell then select OK to display the Sync Start dialog. 

When you select OK to clear the Cell Loading Guide dialog, the cell 
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Sample Name—Ratio 
If you are using a single cell holder, the Sample Name dialog appears once you select the Start button to 
commence an analysis. 

The page comprises the following: 

Cell Loading Guide—Ratio 
If you are using a Multicell Holder, the Cell Loading Guide dialog appears once you select the Start button to 
commence an analysis. 

The Cell Loading Guide dialog prompts you to insert blank samples in the Multicell Holder to collect the 
Ratio scans. You can also use the dialog to name the samples in each selected cell in the Multicell Holder. 

The dialog comprises the following: 

changer will move to cell position 4, enabling you to easily access all 
of the cell positions and load your samples. 

If you need to start data collection immediately: 
Load the cells into the cell changer and select Reset Slide from the 
Sync Start dialog. The cell changer will move to cell position 1. You 
should then add the reactants to the cells as quickly as possible, close 
the lid and select  OK on the Sync Start dialog. The collect will start 
immediately without performing another reset command. 

If you do not need to start the data collection immediately: 
Add the reactants to all the cuvettes and select OK on the Sync Start 
dialog. The system will automatically reset the cell changer to cell 
position 1 and start measurements on the selected cuvettes.  

Wellplate Reader The Sync Start dialog will appear after you press Start. The sample 
labels and the positions in the wellplate that you wish to use have been 
set up before you press Start.

Fast Filter

See also: 
Sample Name 
Cell Loading Guide 
Sync Start 
Start/Stop buttons 
Setup 
Accessories 
Auto Store

Sample Name Enter the name of the sample to be used in the ratio run. Click on the arrow to the right of the 
field to view and select the most recently entered sample names. 
Once you have entered the Sample Name, select OK to display the Sync Start dialog and 
commence the ratio run. 

 
See also: 
Cell Loading Guide
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Sync Start—Ratio 
Use the Sync Start dialog to synchronize the start of a reaction and the start of the ratio data collection. Before 
displaying the Sync Start dialog, the Cary Eclipse will set up all the instrument and graphing parameters so that 
data collection can start as soon as the countdown finishes or you select OK. 

The sequence for a Sync Start is as follows: 

Set up your data collection parameters
Click the Start button (and load the samples if necessary)
Once the Sync Start dialog is displayed, add your active reagent
Commence the data collection by selecting the OK button

The dialog comprises the following: 

The following buttons may be displayed at the top of the Ratio Application window. The Start, Pause, 
Continue and Connect buttons will change depending upon the status of the run. For example, if a run has not 
been started, the Start button will be visible to indicate that the system is ready to commence a run. 

Loading 
Guide/Sample 
Name entry

Enter the names of the sample to be used in the ratio run in each available field. This sample 
name will be used as the Name of Trace in the Trace Preferences dialog. 

Once you have entered the Sample Name, select OK to display the Sync Start dialog and 
commence the Ratio run. 

Note 
The Cell Loading Guide dialog appears only if you have 
selected the Multicell Holder option on the Accessories 
page of the Setup dialog. Only cells selected in the 
Multicell Holder diagram on the Accessories page will be 
available in the Loading Guide. 

In the adjacent example, cells 1—3 will be available in the 
Loading Guide dialog, as they have been selected in the 
Multicell Holder diagram. 

See also: 
Accessories 
Sample Name

Count Down This field displays a two minute countdown in seconds. If you want to start your data 
collection before the two minute countdown ends select the OK button. Alternatively, you 
can wait for the countdown to end and the data collection will start automatically. 

Note 
If you are using a Multicell Holder and you select the OK button, the system will 
automatically Reset this accessory and immediately start the ratio run.

Reset Slide Click this button to drive the Multicell Holder to its zero point (Cell position 1).

Start/Stop Instrument buttons—Ratio 

Select Start to commence a ratio run using the current Setup parameters. 
If any unsaved data exists in the Graphics area you will be prompted to save the 
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Zero—Ratio 
Use the Zero button to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use the Zero 
command before commencing a data collection if you want your data to start at 0  intensity. The Cary Eclipse 
will prompt you to load a blank before performing the zero. 

Before you select Zero, ensure that you have placed the blank solution in the cell positions that are currently in 
the cell path. 

When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the Ratio 
Application window. 

Select the Clear Zero command from the Commands menu to remove zero correction and thus remove the 
subtraction effect. 

data. If you choose not to save, any unsaved data, pictures and labels will be deleted 
when you start the ratio run. 

When a ratio run is started, the Start button will change to Pause. 

The Pause button is displayed in place of the Start button once you have selected 
Start to commence a run. Click Pause to temporarily suspend the data collection, so 
that you can modify your solutions during the ratio run. 
While the system is in the paused state, it will continue to keep track of the elapsed 
time, however data collection will stop until the Continue button is selected. 

The benefit of using Pause instead of Stop is that you are able to add a secondary 
substrate to your ratio solution(s) and then continue to monitor a secondary reaction, 
without having to Stop and Start the collect again. It also means that you will not get 
a spike in your data when you open the sample compartment to add the reagent. 

When a ratio run is paused, the Pause button will change to Continue. 

The Continue button is displayed in place of the Pause button when you have 
paused the run. Click Continue to proceed with the ratio run after it has been 
paused. 

Once you select Continue, is selected the button changes back to Pause. 

If another application is already online with the Cary Eclipse, the Start button will 
change to Connect, and you will need to select Connect to bring this application 
online before the Start button will re-appear. (You will not be able to Connect if the 
other application is collecting data.)

Select this to end a ratio run. 
If you have selected Storage On in the Auto Store page of the Setup dialog, all data 
collected is automatically stored in the file specified in the Batch name field of the 
Windows Save As dialog before or after the run commenced. 

 
See also: 
Graphics area 
Commands menu

To access the Zero option, select the Zero command from the Commands menu, or select the 

Page 36 of 106Ratio Home Page



Stop Time—Ratio 
Use the Stop Time dialog to extend the length of a ratio run while the run is in progress. Extending a run may 
be necessary if you decide whilst a run is in progress that the data collection period is too short. The Stop Time
command is not available until a run is in progress (that is, the Start button is selected). 

To extend the length of a ratio run in progress: 

1. Select the Stop time option from the Ratio Application window or the Commands menu. The Stop
Time dialog is displayed.

2. In the Stop Time field, the minimum allowable Stop Time will be displayed. This is the Stop Time that
has been specified on the Cary page of the Setup dialog.
In the Stop Time field, enter the new Stop Time and select OK. The X axis (Time) of the graph in the
Graphics Area will be updated to reflect the new setting.

Use the Go to Wavelength dialog to temporarily change the instrument to a new excitation or emission 
wavelength. You would mainly use this dialog if you want to quickly go to a wavelength and check the 
intensity reading of the sample. The lamp will flash continuously in this mode. This option is only available if 
the instrument is not currently collecting data. 

To access the Go to Wavelength dialog, select the Go To Wavelength command from the Commands menu. 
You can also select F4 to open the dialog. 

The Go to Wavelength page comprises the following: 

Zero button from the Ratio Application window. 

See also: 
Ratio Application 
Commands menu 
Cell Loading Guide

To access the Stop Time dialog, select the Stop Time button from the Ratio Application window 
or the Stop Time command from the Commands menu. 

See also:
Ratio Application
Cary page

Go to Wavelength—Ratio 

Note 
This is not the wavelength used in the application method. If your method uses a wavelength that is 
different from the 'Go to wavelength' setting you select, then when you select Start the system will change 
to the wavelength selected. (In most applications, this is set in the Cary page of the Setup dialog.) 

Excitation Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go to the instrument 
will change to the new value. 
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Use the Go to Temperature dialog to change the current temperature to a new value. 

The Set Temp button is only accessible if you are using a thermostatted accessory. (On the Accessories page, 
the Temperature control option must be selected.) 

You can access the Go to Temperature dialog prior to starting a run or once a run is in progress. 

To change the current temperature of a run in progress: 

1. Access the Set Temp button by selecting the Pause button to pause the run. You can then select the Set
Temp button.

2. In the Set temp field, enter the temperature you want the instrument to change to. Select OK to return to
the Ratio Application window.

3. Select Continue to proceed with the run.

Use the Rapid Result dialog to take a reading of a blank and sample/s, without having to change the current 
application method. You can use the Multi Cell Changer dialog to specify the cell you want to read. This 
means that between runs, while new samples are being prepared and loaded, other samples can quickly be 
measured. The result is printed in the Report area. 

To access the Rapid Result dialog, select the Rapid Result command from the Commands menu or press F6.

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white 
light). You can then use this light for aligning accessories. 

Emission Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go to the instrument 
will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white 
light). You can then use this light for aligning accessories. 

Go To Click Go to once you have entered a new wavelength, to change the instrument to the entered 
value.

See also: 
Commands menu  
Function Keys

Go to Temperature—Ratio 

To access the Go to Temperature dialog, select the Set temp button from the Ratio Application 
window or the Set temp command from the Commands menu.

See also:
Ratio Application

Rapid Result—Ratio 

Excitation Wavelength 
Enter the wavelength at which you want to take a reading. 
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Use the Commands menu to access major operational commands in the Ratio application . The menu is 
accessible from the menu line at the top of the Ratio Application window. 

Alternatively you can use function key shortcuts for some of the commands. These appear next to the item in 
the Commands menu. Note that not all commands appear as both button and menu items. 

The Commands menu comprises the following commands: 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Emission Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Zero Click Zero to change the wavelength to the entered value and measure a blank.
Result Click Result to change the wavelength to the entered value and measure a sample. The X,Y 

results are corrected for the blank and the results are displayed in the Report window.
See also: 
Multi Cell Changer  
Commands menu 

Commands menu—Ratio 

Hot Tip 
If you access these commands using the Commands menu, rather than from the application buttons, you 
can remove these buttons from your application window. To do this, clear the Buttons command in the 
View menu. This will enlarge the Graphics area, making viewing and selection of scans easier. 

Tell me how to remove or display the command buttons  

Command What it does…
Start Select this to start a data collection using the currently set up parameters. 

If the Connect command is displayed in place of the Start command, this indicates that 
another Cary Eclipse application is in use and has control of the Cary Eclipse instrument. To 
make the Ratio application active so that you can perform a read, you will need to select 
Connect. However, you will not be able to select Connect if another application is 
collecting data. 

Stop Select this to stop the data collection. 
If you have selected Storage On in the Auto Store page of the Setup dialog, all data 
collected is automatically stored in the file specified in the Batch name field of the 
Windows Save As dialog before or after the run commenced. 

Clear Zero Select this option to clear the Zero command. When you select the Zero command (from the 
Commands menu or by pressing F5), the intensity at that time will be reset to zero and all 
subsequent results will have the intensity value that was reset to zero subtracted from them. 
Selecting Clear zero cancels this zeroing (and thus subtraction) effect.

Pre-scan Select Pre-scan to quickly determine the optimum instrument parameters to be used for your 
sample. At the end of this collection sequence the software will report the optimum Ex and 
Em wavelengths and PMT voltage. Once you are satisfied with the parameters, the software 
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will automatically update your method setup to reflect these new parameters.
Zero order… Select the Zero order command to set one of the monochromators to zero order. If you use 

this command to zero either the excitation or emission monochromators, this will override 
the Ex. Wavelength or Em. Wavelength set on the Cary page. The Cary Eclipse software 
will use the zero setting when collecting data. 

The Zero order command is generally used during alignment procedures.  

Excitation 
Select this command to set the excitation monochromator to zero order (white light). 

Emission 
Select this command to set the emission monochromator to zero order (white light). 

Reset Select this command to re-initialize the instrument. This will perform the same initializing 
procedure that is performed when the instrument is powered on.

Rapid Result Select this to display the Rapid Result dialog. Use this dialog to take a reading of a blank 
and multiple sample readings without changing the application method. This means that 
between runs, while new samples are being prepared and loaded, other samples can quickly 
be measured. 
This command can also be accessed by pressing F6.

Zero Select this to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can 
use the Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Go to… Select Go To… to display the Go To Wavelength dialog where you can change the 
instrument to a new wavelength. Use this command if you want to quickly go to a 
wavelength to check the intensity reading. 
This command is only available if the instrument is not currently collecting data. It can also 
be accessed by pressing F4. 

Note 
This is not the wavelength used in the application method. If your method uses a 
wavelength that is different from the 'Go To wavelength', then when you select Start 
the system will change to the wavelength selected. (In most applications, this is set in 
the Cary page of the Setup dialog.) 

Set temp Select Set temp to open the Set Temperature dialog where you can change the temperature 
during a ratio run. 

The Set temp command button is only accessible if you are using a thermostatted accessory. 
(On the Accessories page, the Temperature control option must be selected.) Once you 
have started a run, select the Pause button to pause the run and then select the Set temp 
command. 

Stop time Select the Stop Time command to open the Stop Time dialog which you can use to extend 
the length of a ratio run while the run is in progress. Extending a run may be necessary if 
you decide whilst a run is in progress that the data collection period is too short. The Stop 
Time command is not available until a run is in progress (that is, the Start button is 
selected).

ADL Select this to display the ADL Command Line window where you can execute an ADL 
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Viewing run progress and results—Ratio 
Reports page
Reports toolbar
View menu
Edit menu
Status display
Print Preview dialog
Print

The View menu is accessible from the menu line at the top of the Ratio Application window. 

The following commands can be accessed from the View menu: 

Command command or ADL program. (You can also press Alt-Y to display this dialog.)
Rerun ADL Select this to run the ADL command or program in the ADL Command Line window again. 

(You can also press Alt-X to rerun programs.)

See also: 
Ratio Application window 
Auto Store  
Zero  
Cary page  
Rapid Result   
Go To Wavelength 
Set Temperature  
Stop Time 
ADL Command Line 

View menu—Ratio 

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open it. 
Any data will be displayed in the Graphics area.

Command What it does…
Toolbar Select this option to toggle the Graphics and Reports toolbar on and off. You can also 

select to display or hide the toolbar Text Labels.
Buttons Select this option to toggle the left-hand button display (button area) on and off.
Graphics Select this option to toggle the Graphics area on and off. 
Report Select this option to toggle the Report area on and off.
Report 
Vertical 

If the Graphics option is selected, select Report Vertical to display the Graphics area, 
Report area and/or ADL Editor side by side vertically.

ADL Select this option to toggle the ADL Editor on and off.
ADL Vertical If the ADL and Report options are selected, select ADL Vertical to display the ADL Editor 

vertically on the right hand side of the Report area.
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Edit menu—Ratio 
Use the Edit menu to copy, cut, paste and delete information. You can also use the menu to access the Report 
editing commands. The menu is accessible from the menu line at the top of the Ratio Application window. 

The following commands can be accessed from the Edit menu: 

ADL Quick 
Reference 

This displays the Quick Reference window where you can easily add a command in the 
correct syntax to your ADL program. A detailed description of all the commands in the 
Quick Reference is available by selecting the Help button.

ADL Hooks Select this to activate a link (or hook) to an ADL program at a specific point in the 
application, and then run that ADL program. For example, ADL hooks have been supplied 
to run specific programs: 

on start-up of the Cary Eclipse software;
when the system goes online or offline;
when the Start button is selected;
when a run finishes;
when a zero is performed etc.

For the hook to work, ADL Hooks must be selected, and the appropriate ADL file for the 
application must be present in the ADL folder in the directory. 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Hints Select this option to toggle the Hints bubble text on and off. The bubble text appears when 
you place the arrow cursor over a field, button or text entry field for a short period. It offers 
a quick explanation of the item’s function.

Status Display Select this option to display the Status Display window, where you can view the status of 
various parameters during the data collection.

See also: 
Ratio Application 
Graphics area   
Status Display  
ADL Hooks

Note 
Some options are only available once you select Edit Report. 

Command Button What it does… 
Undo If available, this undoes the last action. 

This command is also accessible by pressing CTRL+Z.
Cut Select this command to remove the highlighted text and place it on the Windows 

Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Select this command to copy the highlighted text onto the Windows Clipboard. 
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Status Display—Ratio 
Use the Status Display window to view the status of your ratio run during the data collection. Depending upon 
settings you have for the Ratio run, the following parameters may be displayed:  

Current Excitation Wavelength (nm)
Current Emission Wavelength (nm)
Excitation Slit Width (nm)
Emission Slit Width
PMT Voltage (V)

To access the Status Display window, select Status Display from the View menu, or from any page of the 
Setup dialog. You can choose to view the Status Display at any time during a ratio run. 

This command is also accessible by pressing CTRL+C.

Paste Select this command to insert the contents of the Windows Clipboard (text only) at 
the cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Select this command to remove selected text in the Report area. This option is only 
available once you select Edit Report and there is text highlighted in the Report area.
This command is also accessible by pressing DEL.

Select All Select this option to highlight all text in the Report area. 
This command is also accessible by pressing CTRL+A.

Font This enables you to change the font of new or selected text in the report. For existing 
text, simply highlight the text in the report, select Font and make your changes in the 
Font dialog. When you select OK, the appearance of the highlighted text in the report 
will alter to reflect your font changes. You do not have to select Edit Report to use 
this command. 
This command is also accessible by pressing CTRL+F.

Edit Report Select this option to edit the report. 
This command is also accessible by pressing CTRL+R.

Clear Report Select this command to remove the contents of the Report area. If you have saved the 
report, selecting this option does not delete the contents of the report, the information 
is simply removed from the Report area.

Recalculate Use the pages accessible from the Recalculate option to perform re-calculations on 
data that has been analyzed. 

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, Microsoft 
Word or Microsoft Excel) into the report area of the of the Ratio application. To edit these objects, simply 
double click on them to open the associated application in which they were created. 

See also: 
Ratio Application  
Recalculate 

See also: 
View menu  
Setup  
Status Line
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Print Preview—Ratio 
Use the Print Preview dialog to view the current report before you print it. From the File menu, select Print 
Preview to access the dialog. 

The contents of the Graphics area appear first in the preview area followed by the contents of the Report area. 
You can reduce or enlarge the print preview on screen. To do this, click the left mouse button in the preview 
area to toggle through the five available views. Click the right mouse button in the preview area to return to the 
full page view.  

The page comprises the following commands: 

Print—Ratio 
Use the Print dialog to select the printer and pages to print of the currently displayed report as well as the 
number of copies you wish to print. 

All graphical information displayed on screen will be printed with the report, therefore it is advisable to edit 
the report on the screen prior to printing. You can also preview the report prior to printing by using the Print 
Preview command. 

If you require a printout of the graphics in the Graphics area only, select the Clear Report button to erase the 
contents of the Report area before you print. 

First arrow Use this arrow to view the first page of the report. 

Previous 
arrow

Use this arrow to view the previous page of the report. 

Next arrow Use this arrow to view the next page of the report. 

Last arrow Use this arrow to view the last page of the report. 
Q. Why are the arrow buttons grayed out?
A. The buttons will be grayed out if the report has only one page of data.

Print Use this to display the Windows Print dialog where you can choose the printer and 
pages to print as well as the number of copies you wish to print.

See also: 
File menu

To access the Print option, select the Print command from the File menu, or select the Print 
button from the Ratio Application window. 

Note 
The options on the Report page are used to generate the contents of the Report area during a run or on a 
recalculation. If Auto Print has been selected the Cary Eclipse will automatically print a report at the 
end of a data collection. 

See also: 
Print Preview 
Report page  
Edit Report 
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Performing Calculations—Ratio 
Recalculate
How to generate a report from previously stored data
How to use advanced reporting options
How to calculate autofluorescence
How to subtract autofluorescence
How to obtain a ratioed trace
How to use the Grynkiewitz equation to create a concentration graph
Analyze
Maths Calculator
Maths Operations
Maths How To
User Data Form

Recalculate—Ratio 
Use the pages accessible from the Recalculate option to perform re-calculations on data that has been 
analyzed. These re-calculations can be made using new Setup parameters. For example you may wish to 
change the order of a reaction. You can also use the Recalculate button to access Report options. 

When you select this option, the Setup dialog will appear, containing the following tabbed pages:  

Analyze
Reports

How to generate a report from previously stored data—Ratio 
Step 1 

Select Open… from the File menu to display the Windows Open dialog.  

Step 2 

A list of previously stored files will appear. If this is not a list of batch files, select the down arrow at the right 
of the Files of type list box and select 'Batch' to list all the batch files.  

Step 3 

Select the Batch file you require then select Open.  

The system will automatically retrieve the collected data into the Graphics area. The method that was used to 
collect the data will also be retrieved. 

Ratio Application

To access the Recalculate option, select the Recalculate button from the Ratio Application 
window.

See also:
Ratio Application
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Step 4 

Select the Recalculate button to display the Setup dialog. 

Step 5 

Select the Reports tab and on the Reports page specify the information you would like to include in the report. 
Select Auto Print if you require the new report to print to the Reports area and to a printer. 

Step 6 

Click OK to display the results in the Report area (and send to the printer if Auto Print is selected). 

The Grynkiewitz equation is used to create a concentration graph from your ratioed trace. 

The equation consists of a number of variables: 

Use the Analyze tab to select from various mathematical equations and set the parameters used to generate the 
calculation of reaction rates. 

Note 
You can also retrieve data from Methods (*.FMRT), Data (*.FDRT), Report (*.FRRT), Spreadsheet 
ASCII (*.CSV), GRAMS (*.SPC) and Rich Text Format (*.RTF) file types.

Note 
If you require a printout of only the current graphics in the Graphics area of a previously stored data file: 

a. Select the Clear Report option in the Commands menu to clear any text that may be displayed in
the Report area.

b. Press the Print button to obtain a printout of the graphics.

Alternatively tick only the Graph check box in the Reports page to obtain a printout of graphics only. 

See also: 
How to use advanced reporting options

The Grynkiewitz Equation—Ratio 

[Ion]t  The concentration of the target ion at time t.

Kd The dissociation constant (Kd) measures the ability of a chelation agent or dye to associate itself to a 
target ion.

Rt The fluorescence intensity ratio for the dye at time t.
Rmin The fluorescence intensity ratio for the probe dye (unbound)

Rmax The fluorescence intensity ratio for the ion-bound probe in the presence of saturating ion 
concentrations.

Sf2/Sb2 The ratio of the fluorescent intensities of the free and bound ion probe. This factor eliminates any
instrument dependent artifacts.
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Maths window 
Calculation Field | Selected/Focused Trace | Trace | Display Options | Functions

Use the Maths window to perform mathematical manipulations on collected traces. In addition, it can act as a 
simple numeric calculator. 

The Maths window comprises the following: 

 
See also: 
What is autofluorescence 
How to get a ratioed trace 
Using the Grynkiewitz equation and entering the values manually 
Using the Grynkiewitz equation and determining the values from the graph

To access the Maths window, select the Calculator command from the Graph menu, or select the 
Calculator button on the Graphics toolbar. 
The Maths window is only available in the Kinetics, Lifetimes, Scan and Validate applications.

Calculation 
display field 

View the current calculation, including the trace/s being used, the trace operation being 
carried out and any functions that have been applied to the trace. 

Hot Tip 
Click on the down arrow adjacent to this field to view the last ten unique calculations 
that have taken place. Use this list to keep track of previous manipulations and repeat 
calculations quickly by simply selecting and then applying the desired calculation.

Selected 
Trace/Focused 
Trace 

Choosing either of these options selects the highlighted (red) trace in the current Graph box 
for manipulation. When choosing between these options, use this simple rule: 

Use the Selected Trace option when the selected calculation is only to be applied to
one trace.
Use the Focused Trace option when the same calculation is to be applied to a number
of traces.

The following example illustrates the difference between these options. 

To perform the same manipulation on several traces:  

a. Highlight a trace by clicking on it with the mouse. The trace will become red.
b. Select Selected Trace, Apply and then = to plot the result of the calculation
c. Highlight the next trace and repeat step b.

OR  

a. Highlight the first trace.
b. Select Focused Trace, Apply and then = to plot the result of the calculation;
c. Highlight the next trace and select the = button to perform the same calculation on the

newly selected trace.
Trace Use the Trace group options to select the operation to be performed on the traces, the filter 

size and the interval (where applicable). 
Click Apply to insert the selected operation into the equation 
Click = (equals) to display the result of the calculations. 
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Operation 
Click on an operation to find out more about it 

Anisotropy
Polarization
Sum Function
Mean
Boxcar Averaging
Moving Average
Savitzky-Golay
Spline
Deriv 1
Deriv 2
Deriv 3
Deriv 4

Display 
Options 

Select whether the results of the operation performed on the trace will be viewed in a New 
Graph box or in the Selected Graph box. If you choose the Selected Graph option, you will 
be able to directly compare the results with existing traces.

Functions This group contains number and function buttons that can be used as a standard calculator in 
addition to being applied to traces. 

To use the functions: 

1. select a trace or value
2. select either a second trace or number
3. select the equals (=) button to display the result

All the basic mathematical functions are available (addition, subtraction, multiplication and 
division), as well as logarithm (Log) and square root (Sqrt) functions. When used as a 
calculator, the results of equations appear in the Report area. 

Additional 
buttons 

C 
Click C to clear the entire operation in the calculation display field. 
CE 
Click CE to clear the last entry entered in the calculation display field. 
= 
Click = (equals) to start the operation shown in the calculation display field.

See also: 
Maths Home Page 
Maths How To

Maths Operations 

The following operations can be selected on the Maths window. To access the Maths window, select 
the Calculator command from the Graph menu, or select the Calculator button on the Graphics 
toolbar.

Anisotropy, 
Polarization 
and Sum 
Function 

The term Anisotropy refers to an unequal angular distribution about a point in space. 
Anisotropy also refers specifically to a simple expression for measuring the degree of 
polarization of the fluorescence.  It is almost identical to the expression for polarization apart 
from having a factor of two in the denominator.  Anisotropy is usually represented by the 
lowercase letter " r ", while polarization by an uppercase  " P ". 
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The two expressions are listed below: 

Anisotropy 
r = (Ivv - GIvh) / (Ivv + 2GIvh) 

Polarisation 
P = (Ivv - GIvh) / (Ivv + GIvh) 

where 

Ivv equals the intensity of fluorescence with excitation polarizer = vertical, emission 
polarizer = vertical 
Ivh equals the intensity of fluorescence with excitation polarizer = vertical, emission 
polarizer = horizontal 

G is a factor that accounts for the polarization bias of the instrument. In particular it accounts 
for the wavelength-dependent polarization bias of the emission side of the instrument 
(dominated by the polarization bias of the emission grating). 

The G factor is given by:  
G = Ihv/Ihh 

where 

Ihv equals the intensity of fluorescence with excitation polarizer = horizontal, emission 
polarizer = vertical 

Ihh equals the intensity of fluorescence with excitation polarizer = horizontal, emission 
polarizer = horizontal 

The expression for the anisotropy is a quotient.  The denominator of the expression, as given 
by Ivv + 2GIvh is the ‘sum’ function, and actually represents the total emission unbiased by 
any sample polarization effects. 

Mean The Mean operation allows the average of two or more traces to be taken and the resulting 
trace to be plotted. The mean of the traces can also be used in conjunction with other 
functions. 

The equation used in mean calculations is: 

(scan 1 + scan 2...+ scan x)/x 

The calculation is performed over the common X range of the traces and the trace with the 
most dense data is used to determine the data points. The other traces are interpolated at the 
relevant data points. 

Boxcar 
Averaging 

This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 

For example, for the following: 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5
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 The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x8, sum(y6:y10)/5) ….. 
(xn-2, sum(yn-4:yn)/5). 

If there are not enough points at the end of the data set to complete the filter size, then these 
points will be ignored, hence, the gap at the end may be larger than the gap in the beginning. 
There will be a gap before the first point and after the last point of the smoothed continuum, 
with respect to the original unsmoothed data. This algorithm is only valid for evenly x-
spaced data points.  

Within a time scan, (e.g., Advanced collect in kinetics) the data points may be unevenly 
spaced between different stages.  Each stage will be treated as a new collect, hence, there 
may be large gaps between stages.  If there are not enough points at the end of a stage to 
complete the filter size, then these points are ignored, hence, there may be large gaps at the 
end of a stage.  The filter size will be limited to odd numbers, with the minimum of 3 to a 
maximum of 101. 

Moving 
Average 

This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 

For example, for the following: 

The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x4, sum(y2:y6)/5) ….. 
(xn-2, sum(yn-4:yn)/5). There will be a gap before the first point and after the last point of 
the smoothed continuum, with respect to the original unsmoothed data. This algorithm is 
only valid for evenly x-spaced data points. Within a time scan, (e.gg, Advanced collect in 
kinetics), the data points may be unevenly spaced between different stages. This will be 
treated by interpolation of data from the previous stage so as to give evenly spaced data 
points into the next stage. If there is not enough data for interpolation, then the next stage 
will be treated as a new collect, hence, there may be gaps and further delays in displaying the 
point. The filter size will be limited to odd numbers, with the minimum of 3 to a maximum 
of 101. 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5

Savitzky-
Golay 

The Savitzky-Golay technique operation enables  you to reduce the noise in the currently 
selected Maths scan by using smoothing. 

When you select this operation you will be prompted to enter a Filter Size from 5 to 101. The 
larger the Filter Size, the more data points that will be smoothed. 

You will also need to enter an Interval. The Interval refers to how many of the averaged 
points will be plotted on the smoothed trace. The smaller the interval, the more detail there 
will be in the trace. 

Consider selecting an Interval of 1. This would mean that when the smoothed continuum is 
plotted, every smoothed point will be displayed. 

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an even
number.

Q. Why can't I see the Filter Size and Interval fields?
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Maths How To… 
How to perform a spectral subtraction
How to perform a mean calculation
How to smooth a trace
How to derive a trace

User Data Form—Ratio 
Use the User Data Form to enter extra information about the traces in the highlighted graph box. For example, 
you might want to record information about the experimental conditions you used to collect the data. 

The dialog comprises the following: 

A. These will be displayed when you select Smooth in the Operation field.
Spline 
Deriv 1–4 The Deriv operations allow you to obtain derivatives of a selected scan. The derivative can 

be of the orders 1 to 4. The resulting trace is then plotted.  The Savitzky-Golay technique is 
used for derivative calculations. 

On selection of the Deriv operation you will be prompted to enter a Filter Size from 5 to 101. 
The Filter Size refers to the number of points around a particular point that will be averaged 
to produce a new derived Y value. The lower the Filter Size, the more data points that will be 
used in the derivative trace. 

You will also need to enter an Interval. The Interval refers to how many of the derived points 
will be plotted on the resulting trace. The smaller the Interval, the more detail there will be in 
the trace. 

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an even
number.

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select one of the ‘Derivs’ in the Operation field.

See also: 
About smoothing

See also:
Maths Home Page

To access the User Data Form, select the User Data Form command from the Graph menu, or select 
the User Data Form button on the Graphics toolbar. The User Data Form command is only available 
if you have selected a graph box.

Data Name This column lists the names of each visible trace in the highlighted graph box. 

Use the extra columns for recording additional information about the experimental conditions 
you used to collect the data, eg. pH. 

Other 
Columns 

Use this to record the name of the parameter in which you are interested as a column 
heading, (for example, pH, ionic concentration, substrate concentration etc.). 
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Displaying data graphically—Ratio 
Graphics area
Graphics How To
Graph menu
Graphics toolbar
Graph Labels
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label
Graph Pictures
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture
Trace Preferences dialog
Trace Preferences menu
How to select the focused trace
How to display a trace
How to remove a trace from a graph
How to remove a trace from the trace list
Graph Preferences dialog
How to alter the look of your graphs
Cursor Modes dialog
How to track the focused trace
Axes Scales dialog
How to scale your graph manually
How to scale your graph automatically
Single/Multi Graph
User Data Form
Graphics Templates
How to create a graphics template
Ratio Ruler
How to use the ratio ruler

The Graphics area of the Ratio application appears in the top half of the Ratio Application window and is used 
to display traces of collected data. In the Cary Eclipse system, the term 'graph' refers to the plotting area and is 

Note 
You must enter a column heading, or else the data in that column will not be saved.

See also: 
Graph menu  
Graphics toolbar

Graphics area—Ratio 
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represented by a set of axes. The rectangular area surrounding the graph is referred to as the graph box. A 
graph will appear in the Graphics area when you select Start to commence a Ratio run. 

To display or hide the Graphics area, select the Graphics command on the View menu. Double-clicking on the 
Graphics area enables you to toggle between half or full size display sizes. 

You can access the functions associated with the Graphics area by doing the following:  

selecting one of the Graphics toolbar buttons;
selecting a command from the Graph menu; or
clicking the right mouse button in the Graphics area and select a command from the menu

You can customize the graphics area to suit your requirements in the following ways: 

Note 
Not all functions are available on every menu.

Note 
All of the commands and dialogs listed are accessible from the Graph menu. 

To… Use the… Tell me how…

Change the axes scaling 
automatically

Autoscale graph command How to scale your graph 
automatically

Change the axes scaling manually Axes Scales dialog How to scale your graph manually

Modify the graph appearance (axes, 
trace)

Graph Preferences dialog How to alter the look of your graphs 

How to specify the number of tick 
marks and decimal places for your 
X and Y axes 

Add a new graph to the display Add graph command

Remove a graph from the display Remove graph command How to remove graphs 

View single or multiple graphs Single/multiple graph 
command

Resize a graph box Cursor How to resize graph boxes

Track the focused trace Cursor Mode dialog How to track the focused trace 

Select the focused trace Cursor How to select the focused trace

Display a trace in the graph Trace Preferences dialog How to display a trace that is not 
appearing in a graph box

Remove a trace from a graph Trace Preferences dialog How to remove a trace from a graph

Remove a trace from the trace list Trace Preferences dialog How to remove a trace from the 
trace List

Zoom in and out on the graph Zoom In and Zoom Out How to zoom a graph
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Graphics How to—Ratio 

Traces  

How to track the focused trace
How to select the focused trace
How to display a trace that is not appearing in a graph box
How to remove a trace from a graph
How to remove a trace from the trace List

Sizing and scale  

How to resize graph boxes
How to scale your graph manually
How to scale your graph automatically
How to alter the look of your graphs
How to zoom a graph

Labels  

How to add a label to a graph
How to edit a label

commands

Add a label to the graph box Add Label dialog How to add a label to a graph

Edit labels in the graph box Edit Label dialog How to edit a label

Moving labels in the graph box Cursor How to move a label

Resizing labels in the graph box Cursor How to resize a label

Delete labels from the graph box Delete Annotation command How to delete a label

Add a picture to the graph box Add Picture dialog How to add a picture to a graph

Move pictures in the graph box Cursor How to move a picture

Resizing pictures in the graph box Cursor How to resize a picture

Replace pictures in the graph box Edit Picture dialog How to replace a picture

Delete pictures from the graph box Delete annotation command How to delete a picture

Save the Graphics area you have set 
up as a graphics template

Save As dialog (from the File 
menu)

How to create a graphics template

Note 
The red trace in any graph box is the one on which all information appears and the one used for the cursor 
tracking. It is called the focused trace. 

See also: 
Toolbar 
Graphics How To
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How to delete a label
How to move a label

Pictures  

How to add a picture to a graph
How to move a picture
How to delete a picture
How to replace a picture

Introduction 

Use the Graph menu to view data in various graphical formats or in multiple graphs in the Graphics area. You 
can double-click on the Graphics area to toggle the display through graph and report to graph only.  

In the Cary Eclipse system, the term 'graph' refers to the plotting area and is represented by a set of axes. The 
rectangular area surrounding the graph is referred to as the graph box. A graph will appear in the Graphics area 
when you select Start to commence a Ratio run. 

The Graph menu can be accessed in the following ways:  

from the main menu at the top of the Ratio Application window
by clicking the right mouse button in a graph box or the Graphics area

Menu commands 

The following commands can be accessed from the Graph menu: 

Graph menu—Ratio 

Note 
The red trace in any graph box is the one on which all information appears and the one used for the cursor 
tracking. It is called the focused trace.

Menu 
command 

Button Enables you to…

Print XY 
point 

Select this to print the cursor's current X and Y coordinates in the report area. 
Note: 
This option is only available from the Graph menu that appears when you 
right-click in a graph box.

Copy Graph Select Copy Graph to copy the entire Graphics area to the Windows Clipboard. All 
of the graphs in the Graphics area will be copied to the Clipboard.

Paste to 
Graph 

Select Paste to Graph to paste the contents of the Windows Clipboard into the 
Graphics area. Text is pasted as a label, graphics are pasted as pictures.

Add Graph  Select Add Graph to add a new graph box to the Graphics area. You may want to do 
this if you have, for example, a graph containing existing data and you want to 
collect some new data in a new graph.

Remove 
Graph  

Select Remove Graph to delete the selected graph box from the Graphics area. The 
graph box is removed, but the data is not deleted and is still available from the Trace 
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Preferences window. 
You may want to use remove graph if you have a large number of graph boxes open 
but only want to focus on some of these. 

Note: 
You can remove multiple graph boxes by first holding down the CTRL key and 
selecting the graphs to be removed and then selecting the Remove Graph 
button or menu item. Use the SHIFT key to highlight a range of graphs for 
removal.

Clear All 
Traces 

Select Clear All Traces to delete all traces from the graph/s. Note that selecting this 
option simply turns off the Visible property for the traces in the Trace Preferences 
window. You can redisplay the traces by making the traces Visible again in the 
Trace Preferences window.

Add Label  Select Add Label to display the Add Label dialog where you can enter a text label 
to be placed on a graph or in the background of the Graphics area. 

Add Picture Select Add Picture to display the Add Picture dialog where you can select a picture, 
bitmap or chemical structure to be placed on a graph or in the background of the 
Graphics area. 

Edit 
Annotation 

Select Edit Annotation to alter the content or look of the selected annotation, (either 
a label or a picture) in the Graphics area. 

If the selected annotation is a label, selecting Edit Annotation will open the Edit 
Label dialog where you can change the text of the selected label. 
If the selected annotation is a picture, selecting Edit Annotation will open the Edit 
Picture dialog where you can replace the selected picture with a new picture. 

Note: 
This option can only be activated if an annotation is selected.

Delete 
Annotation  

Select Delete Annotation to remove an annotation, (such as a label or a picture) 
from the Graphics area. 
You can use this menu option to remove highlighted annotations in the Graphics area 
such as labels, pictures and ruler/fit information. 

Note: 
This option can only be activated if an annotation is selected.

Trace 
Preferences 

Select this command to display the Trace Preferences dialog where you can select 
the trace(s) to display in the selected graph.

Graph 
Preferences 

Select this command to display the Graph Preferences dialog where you can change 
the appearance of your graph. Any changes you make to the appearance of the graph 
will be applied to all graphs.

Cursor 
Mode… 

Select this command to display the Cursor Modes dialog where you can choose the 
type of cursor to be used on the screen. For example, you can select to use a free 
cursor that can move anywhere in the graph or exactly trace the focused scan (red 
scan).  Alternatively, you can select a cursor that enables you to draw a line from one 
point to another to determine the slope using either the Least Squares method or the 
Point to Point method.

Axes 
Scales…  

Select this command to display the Axes Scales dialog where you can set the scale 
range for the X and Y axes.

Auto scale 
graph 

To automatically scale the graph, point to one of the following options: 

Autoscale[XY] 
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Graphics Toolbar—Ratio 
Use the Graphics toolbar buttons to gain quick access to many of the Graph menu options. You can also use 

Select Autoscale[XY] to automatically scale collected data by scaling the Y height 
and X width to full screen. 

Autoscale[X] 
Select Autoscale[X] to automatically scale collected data by scaling the X width to 
full screen. 

Autoscale[Y] 
Select Autoscale[Y] to automatically scale collected data by scaling the Y height to 
full screen. 

Zoom Out Select Zoom Out to Zoom back to the original X and Y ranges which were used to 
collect the data (i.e. the method setup conditions of the focused scan).  
For example, the system will revert back to the X and Y ranges set in the method if 
you zoom in and out during a data collection.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note: 
The graph highlighted in the Multi Graph view will be displayed when you 
toggle the Single Graph option.

Auto 
Arrange 
Graphs 

Select Auto Arrange Graphs to view and arrange all graphs simultaneously. 
Note: 
You can move graph boxes manually by clicking the left mouse button outside 
the graph axes and dragging the graph box to a new position. You can also 
resize graphs.

User Data 
Form  

Select User Data Form to display the User Data Form where you can enter extra 
information about the traces in the highlighted graph box. For example, you might 
want to record information about the experimental conditions you used to collect the 
data, such as the pH at which data was collected.

Calculator Select Calculator to display the Maths window where you can perform 
mathematical manipulations on collected traces. In addition, it can act as a simple 
numeric calculator.

History List This displays a list of the current graphs. 

See also: 
Add Label   
Add Picture   
Edit Label   
Edit Picture    
Trace Preferences  
Graph Preferences  
Cursor Modes   
Axes Scales   
Single/Multi Graph   
User Data Form   
Maths   
Graphics toolbar 
Graphics area
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the toolbar to select the graph you want to view and to change the look of your graphs. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Graphics. To display 
or hide the toolbar's text labels, point to the Toolbars option in the View menu and select Text Labels. 

The following commands can be accessed from the Graphics toolbar: 

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to…

Trace 
Preferences  

Click this button to display the Trace Preferences window where you can select the 
trace(s) to display in the selected graph.

Graph 
Preferences 

Click this button to display the Graph Preferences dialog where you can change the 
appearance of your graph. Any changes you make to the appearance of the graph 
will be applied to all graphs.

Cursor 
Mode 

Click this button to display the Cursor Modes dialog where you can choose the type 
of cursor to be used on the screen. For example, you can select to use a free cursor 
that can move anywhere in the graph or exactly trace the focused scan (red scan).  
Alternatively, you can select a cursor that enables you to draw a line from one point 
to another to determine the slope using either the Least Squares method or the Point 
to Point method.

Axes 
Scales…  

Click this button to display the Axes Scales dialog where you can set the scale range 
for the X and Y axes.

Autoscale
[XY] 

Click the Autoscale[XY] button to automatically scale collected data by scaling the 
Y height and X width to full screen.

Autoscale
[X] 

Click the Autoscale[X] button to automatically scale collected data by scaling the X 
width to full screen.

Autoscale
[Y] 

Click the Autoscale[Y] button to automatically scale collected data by scaling the Y 
height to full screen.

Zoom Out Click the Zoom Out button to Zoom back to the original X and Y ranges which 
were used to collect the data (i.e. the method setup conditions of the focused scan).  
For example, the system will revert back to the X and Y ranges set in the method if 
you zoom in and out during a data collection.

Add Label  Click this button to display the Add Label dialog where you can enter a text label to 
be placed on a graph or in the background of the Graphics area. 

Add Picture  Click this button to display the Add Picture dialog where you can select a picture, 
bitmap or chemical structure to be placed on a graph or in the background of the 
Graphics area.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note: 
The graph highlighted in the Multi Graph view will be displayed when you 
toggle the Single Graph option.

Auto 
Arrange 

Click the Auto Arrange Graphs button to view and arrange all graphs 
simultaneously. 
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Graph Labels—Ratio 
Add Label dialog
Edit Label dialog
How to add a label to a graph

Graphs Note: 
You can move graph boxes manually by clicking the left mouse button outside 
the graph axes and dragging the graph box to a new position. You can also 
resize graphs.

Add Graph Click this button to add a new graph box to the Graphics area. You may want to do 
this if you have, for example, a graph containing existing data and you want to 
collect some new data in a new graph.

Remove 
Graph 

Click this button to delete the selected graph box from the Graphics area. The graph 
box is removed, but the data is not deleted and is still available from the Trace 
Preferences window. 
You may want to use remove graph if you have a large number of graph boxes open 
but only want to focus on some of these. 

Note: 
You can remove multiple graph boxes by first holding down the CTRL key 
and selecting the graphs to be removed and then selecting the Remove Graph 
button or menu item. Use the SHIFT key to highlight a range of graphs for 
removal.

Clear All 
Graphs 

Click this button to delete all traces from the graph/s. Note that selecting this option 
simply turns off the Visible property for the traces in the Trace Preferences 
window. You can redisplay the traces by making the traces Visible again in the 
Trace Preferences window.

User Data 
Form 

Click this button to display the User Data Form where you can enter extra 
information about the traces in the highlighted graph box. For example, you might 
want to record information about the experimental conditions you used to collect the 
data, such as the pH at which data was collected.

Calculator Click this button to display the Maths window where you can perform mathematical 
manipulations on collected traces. In addition, it can act as a simple numeric 
calculator.

See also: 
Add Label   
Add Picture   
Edit Label   
Edit Picture    
Trace Preferences  
Graph Preferences  
Cursor Modes   
Axes Scales   
Single/Multi Graph   
User Data Form   
Maths  
Graphics area 
Graph menu 
Graphics How to
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How to edit a label
How to move a label
How to resize a label
How to delete a label

Use the Add Label dialog to place a label on your graph or into the background of the Graphics area.  

To add a label to a graph box, you must have at least one trace Visible in the graph box. (You can select which 
traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple graphs, the label 
will be placed in the graph box that is currently selected. However, you can add a label outside of a graph box 
in the background of the Graphics area at any time. 

The Add Label dialog comprises the following: 

Add Label—Ratio 

Q. Can I add a label that will print with all my graphs.
A. Yes, you can add your label to the background of the Graphics area. To do this, right-click on a section
of the background (gray area) and select Add Label from the menu. (You will notice that this menu has
less options than the menu that appears when you right-click on a graph.) In the Add Label dialog, enter
the label to be added to all graphs and select OK. The label will appear in the background of the Graphics
area.

To access the Add Label dialog, select the Add Label command from the Graph menu, or select the 
Add Label button on the Graphics toolbar.

To selected 
trace

Select this option to associate a label with the selected trace. When you associate a label with 
a trace and make the trace visible in the Graph box, the label will also be displayed with the 
trace.

To selected 
graph

Select this option to associate the label with the selected graph. When you associate a label 
with a graph, the label will always be displayed in the Graph box, regardless of what traces 
are visible.

Selected trace This will identify the trace that is currently selected and display the name of the trace.
Font… Click Font to open the Windows Font dialog. In this dialog you can specify the font type, 

style and size to be used for the label.
Label Use the Label field to enter the text for the label. You can enter as many lines of text as you 

require.
Hot Tip 
If you wish to include certain XY co-ordinates on the graph as a label, position your cursor at the 
appropriate place, right-click and select Add Label from the menu. When the Add Label dialog appears, 
the co-ordinate positions will be added to the Label field. 
Note 
When you save the data (as a Batch or Data file) the label is saved with its associated trace or graph. 
Labels outside graph boxes can be saved in a graphics template. To do this, choose Graph Template as 
the Save As type in the Save As dialog. 
See Example of a Graphics Template 

See also: 
Trace Preferences dialog  
Graph menu  

Page 60 of 106Ratio Home Page



Use the Edit Label dialog to alter the content or look of your label. 

To access the Edit Label dialog, right-click on the label you wish to change and select Edit Annotation from 
the menu. 

The dialog comprises the following: 

How to add a label to a graph—Ratio 
You can add a label to your graph or Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area background. 

Step 2 

Click the Add Label button on the toolbar or right-click on the graph and select Add Label from the menu. 
The Add Label dialog will appear. 
The Add Label command is also accessible from the Graph menu. 

Step 3 

Click the Font button. The Windows Font dialog appears. Select the font type, size and style you require for 
your label. A sample of the font style appears in the Sample field. When you are satisfied with your selections, 
select OK to return to the Add Label dialog. 

Step 4 

Enter the label in the Label field and select OK. The label will be displayed on the selected graph. If 

Graphics toolbar  
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label  
How to delete a label

Edit Label—Ratio 

Font Select Font to open the Font dialog, where you can specify the font type, style and size to be 
used for the label.

Label Use the Label field to alter the text for the label. 

See also: 
How to edit a label 
How to add a label to a graph  
How to resize a label 
How to move a label

Note 
There must be at least one trace Visible in the graph box before you can add a label to it.
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necessary, you can move a label so that it is more appropriately placed on your graph. 

How to edit a label—Ratio 
Step 1  

Place the cursor on the label and click the left mouse button to select the label. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu. Alternatively you can 
select the Edit Annotation command from the Graph menu. The Edit Label dialog is displayed. 

Step 3  

Use the Edit Label dialog to change the label. 

For example, if you want to change the font size of the label, select the Font button. In the Size field, scroll 
through the available sizes for the font and select the size you require. Alternatively, highlight the currently 
selected size in the Size entry field and enter the size you require. Click the OK button in this dialog to return 
to the Edit Label dialog. 

Step 4  

Click OK to clear the Edit Label dialog. Your label will appear with the new font size. 

How to move a label—Ratio 
To move a label so that it is more appropriately placed on your graph or Graphics area background, do the 
following: 

Step 1  

Place the cursor on the label. 

Step 2  

See also: 
Graphics Area 
How to move a label 
How to edit a label  
How to resize a label

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label selection. 
Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label  
How to resize a label 
How to delete a label
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Click and hold down the left mouse button. 

Step 3  

Drag the label to the correct position and release the mouse button. The label will be displayed at the new 
position. 

How to resize a label—Ratio 
To resize a label so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the label by clicking on it with the mouse. A border will be displayed around the label to indicate it is 
selected. 

Step 2  

Position the cursor over one of the corner edges of the label until the cursor becomes a diagonal double-headed 
arrow. Click and hold down the left mouse button. 

Example of label showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the label by dragging the mouse. The label text will also be resized. Release the 
mouse button when the label and text are the correct size. 

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label  
How to resize a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 
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How to delete a label—Ratio 
To delete a label from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the label and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The label will be 
deleted from the graph or Graphics area. 

Graph Pictures—Ratio 
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture

Use the Add Picture dialog to insert a picture or bitmap into the Graphics area. The picture can be added as a 
background picture or to a particular graph box. 

To add a picture to a graph box you must have at least one trace Visible in the graph box. (You can select 
which traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple graphs, 
the picture will be placed in the graph box that is currently selected. However, you can add a picture outside of 
a graph box in the Graphics area at any time. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label selection. 
Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label

Add Picture—Ratio 

Q. Can I add a picture that will print with all my graphs.
A. Yes, you can add your picture to the background of the Graphics area. To do this, right-click on a
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The Add Picture dialog comprises the following commands: 

Use the Edit Picture dialog to change a picture you have inserted into the Graphics area.  

To access the Edit Picture dialog, right-click on the picture you wish to change and select Edit Annotation 
from the menu. 

The Edit Picture dialog comprises the following commands: 

section of the background and select Add Picture from the menu. (You will notice that this menu has less 
options than the menu that appears when you right-click on a graph.) In the Add Picture dialog, load the 
picture to be added to all graphs and select OK. The picture will appear in the background of the 
Graphics area. 

To access the Add Picture dialog, select the Add Picture command from the Graph menu, or select 
the Add Picture button on the Graphics toolbar.

To selected 
trace

Select this option to associate a picture with the selected trace. When you associate a picture 
with a trace and make the trace visible in the Graph box, the label will also be displayed with 
the trace.

To selected 
graph

Select this option to associate the picture with the selected graph. When you associate a 
picture with a graph, the label will always be displayed in the Graph box, regardless of what 
traces are visible.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer for 
the picture you want to insert. The picture must be one of the following formats: DIB, JPG, 
JPEG, BMP, EMF or WMF. 

If you are viewing multiple graphs the picture will be placed on the graph that is currently 
selected. If no graph is selected, the picture will be placed on the Graphics area background. 

Note 
When you save the data (as a Batch or Data file) the label is saved with its associated trace or graph. 
Labels outside graph boxes can be saved in a graphics template. To do this, choose Graph Template as 
the Save As type in the Save As dialog. 
See 'Example of a Graphics Template'. 

See also: 
Trace Preferences  
Graph menu  
Graphics toolbar 
How to add a picture to a graph 
How to move a picture 
How to delete a picture 
How to replace a picture

Edit Picture—Ratio 

To selected 
trace/ graph

Displays whether you originally selected to add the picture to a trace or a graph. This option 
is not editable.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer for 
the picture you want to insert. The selected picture will replace the current picture. The 
picture must be one of the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 
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How to add a picture to a graph—Ratio 
You can add a picture to your graph or the Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area background. 

Step 2 

Click the Add Picture button on the toolbar or right-click on the graph and select Add Picture from the menu. 
The Add Picture dialog will appear. 
The Add Picture command is also accessible from the Graph menu. 

Step 3 

Click the Load button. The Windows Open dialog appears. 

Step 4 

Browse through your directories to find the picture you want to insert. All pictures must be in the bitmap 
format and will have the extension .BMP. 

Step 5 

Highlight the .BMP that you want to insert and select Open. 

Step 6 

The Add Picture dialog will appear showing a preview of the bitmap. If the bitmap is the correct one select the 
OK button. The bitmap will be placed onto the graph. 

You can move a picture so that it is more appropriately placed on your graph. 

See also: 
How to replace a picture 
How to add a picture 
How to move a picture  
How to resize a picture 
How to delete a picture

Note 
There must be at least one trace Visible in the graph box before you can add a picture to it.

Note 
You should take care not to add a bitmap that is too big as it will obscure part or all of your graph.

See also: 
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture
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How to replace a picture—Ratio 
To change a picture that you have added to a graph or Graphics area background do the following: 

Step 1  

Move the cursor to the picture and select the left mouse button to select it. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu or select Edit Annotation 
from the Graph menu. The Edit Picture dialog is displayed. 

Step 3  

From the Edit Picture dialog, select the Load button. The Windows Open dialog is displayed. 

Step 4  

Browse through your directories to find the picture to replace the current bitmap. Picture files must be in one of 
the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

Step 5  

Highlight the file that you want to insert and select Open to return to the Edit Picture dialog. 

Step 6  

The Edit Picture dialog will display a preview of the bitmap. If the bitmap is the correct one select the OK 
button. The bitmap will be placed onto the graph. If you need to, move the picture so that it is more 
appropriately placed on your graph. 

How to move a picture—Ratio 
To move a picture so that it is more appropriately placed on your graph or Graphics area background, do the 
following: 

Step 1  

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Do not to add a bitmap that is too big as it will obscure part or all of your graph. 

See also: 
How to add a picture to a graph 
How to move a picture 
How to delete a picture  
How to resize a picture
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Place the cursor on the picture. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the picture to the correct position and release the mouse button. The picture will be displayed at the new 
position. 

How to resize a picture—Ratio 
To resize a picture so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the picture by clicking on it with the mouse. A border will be displayed around the picture to indicate it 
is selected. 

Step 2  

Position the cursor over one of the corner edges of the picture until the cursor becomes a diagonal double-
headed arrow. Click and hold down the left mouse button. 

Example of picture showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the picture by dragging the mouse. The picture will also be resized. Release the 
mouse button when the picture is the correct size.

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Page 68 of 106Ratio Home Page



How to delete a picture—Ratio 
To delete a picture from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the picture and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The picture will be 
deleted from the graph or Graphics area. 

Trace Preferences table | Trace Audit Log 

A single graph box can display many traces. This window enables you to select the trace(s) to display (make 
Visible) in the selected graph box.  

The dialog comprises the following: 

Trace Preferences table 

See also: 
How to add a picture to a graph  
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to move a picture 
How to zoom a graph  
How to resize a picture

Trace Preferences—Ratio 

To access the Trace Preferences dialog, select the Trace Preferences command from the Graph 
menu, or select the Trace Preferences button on the Graphics toolbar.

Hot Tip 
The Trace Preferences menu is also available on clicking the right mouse button anywhere in the trace 
listing.

Visible Use the Visible field to select which traces will appear on the selected graph. To select or 
clear the Visible field, simply click the left mouse button in this column. A tick will appear 
next to traces that are to be displayed in the selected graph. 
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Trace Audit Log 

The Trace Audit Log displays information about the highlighted trace. This includes instrument parameters 
and data form information relating to the trace that has been selected. It also logs all information about data 
manipulation.  When more than one trace is highlighted, the Trace Audit Log will display information about 
the trace that was first selected. 

Trace Preferences menu—Ratio 
The Trace Preferences menu is displayed when you click the right mouse anywhere on the Trace Preferences 
table. The menu contains the following commands: 

If you are in single graph view, all selected traces will appear on the one graph. If you are in 
Multi Graph view the traces will appear on the graph that is currently selected.  

Hot Tip 
To make all traces Visible, right-click on the table and select the Select All command 
from the menu. Then right-click on the table again and select the Show Traces 
command from the menu.

Color The Color field enables you to view the color of each trace that appears on the selected 
graph.  To change the color of a trace, highlight it, click the right mouse button in the Trace 
Preferences table and select Change Trace Color. You can then select a color from the 
Color dialog that is displayed. 

The red trace in any graph box is the one on which all information appears. This trace, which 
is used for the cursor tracking, is called the focused trace and it is always red. When you 
select a trace in the Color column it will become the focused trace in the selected graph box. 

Note 
When you change the trace line width in the Graph Preferences dialog it also will 
change the width of the color trace line in this dialog.

Name of trace The Name of Trace field contains a description of the traces currently available for display 
in the selected graph box.

Filename This field displays the filename and path for the trace. If the name is too long to appear in 
the field you can use the keyboard arrow keys to scroll to the end of the filename or you can 
resize the Trace Preferences window. If the file path for a trace shows 'not saved' then the 
trace is unsaved data and is only stored in memory.

See also: 
Graph menu 
Graphics toolbar 
Graph Preferences  
Trace Preferences menu 
How to make multiple traces visible in a graph 
How to remove a trace from the trace list 
How to remove a trace from a graph

Select All This selects or highlights all the traces in the listed on the Trace Preferences page.
Select None This de-selects all the traces in the listing.
Show Traces Select Show Traces to make all of the traces currently highlighted Visible, meaning that 
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How to select the focused trace—Ratio 
To select the scan that you want to be the focused (red) trace, do one the following:  

From the Graph, click the left mouse button on the trace that you want to make the focused trace.

From the Graph Legend (if displayed), click the left mouse button on the trace that you want to make the
focused trace.

From the Trace Preferences dialog, click in the Color column of the trace that you want to make the
focused trace.

How to display a trace that is not appearing in the graph box—Ratio 
Step 1 

Click on the graph in the Graphics area. 

Step 2 

Select the Trace Preferences button  from the Graphics toolbar, or select Trace Preferences from the 
Graph menu. The Trace Preferences dialog is displayed.

they will be displayed in the current graph box.
Hide Traces Select Hide Traces to remove the Visible property from all the traces currently highlighted, 

which will remove them from the current graph box.
Delete Traces Select Delete Traces to delete all the highlighted traces in all graphs. Note that if you save 

the data file before you select Delete Traces, the traces are not deleted from the saved file, 
and they can be retrieved at a later date. 
Selecting Delete Traces will delete the traces from the application memory, and it is 
recommended that you select this option if you need to free up memory on your computer. 
This is especially relevant for the Ratio application where the data files can be quite large. 

Note 
If the application is controlled by the GLP Administration application, you will be 
prompted to save an unsaved data file before it is removed from the application. 

Change Trace 
Color 

Select Change Trace Color to display the Windows Color dialog where you can change the 
color of the currently highlighted trace(s). The focused trace will remain red while it retains 
the focus, and will revert to the selected color when the focus is moved.

See also: 
Trace Preferences page 
Graph Preferences page 
How to remove a trace from the trace list 
How to remove a trace from a graph

Note
Select the Show Legend check box in the Graph Preferences dialog to display the Graph Legend.

See also:
How to track the focused trace
How to view a particular trace
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Step 3 

Find that trace that you wish to see and select the Visible option. A tick will appear in the Visible column to 
indicate that it will now be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you want to display.

b. Click the right mouse button and select the Show Traces command from the drop-down menu. Ticks
will appear next to the selected traces to indicate that they will now be displayed.

Step 4 

Press OK to clear the Trace Preferences dialog. The selected trace(s) will be displayed. 

How to remove a trace from a graph—Ratio 
Step 1 

Select a graph in the Graphics area. 

Step 2 

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the Graph 
menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you no longer wish to see and select the Visible option. The tick will be removed from the 
Visible column to indicate that it will not be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you no longer want to display.

b. Click the right mouse button and select the Hide Traces command from the drop-down menu. The ticks
will be removed from the selected traces to indicate that they will not be displayed.

Step 4 

Select OK to clear the Trace Preferences dialog. The trace will be removed from the graph. 

How to remove a trace from the trace list—Ratio 

See also: 
How to remove a trace from a graph 
How to remove a trace from the trace list

See also: 
How to display a trace that is not appearing in the graph box 
How to remove a trace from the trace list
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If your graphs contain unwanted traces, you may wish to delete them (rather than simply making them 
invisible) in order to free up application memory and aid system performance. 

Step 1  

Select a graph in the Graphics area. 

Step 2  

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the Graph 
menu. The Trace Preferences dialog is displayed. 

Step 3  

Select the trace to be removed by clicking on it. 

Step 4  

Click the right mouse button to display the Trace Preferences menu. 

Step 5  

Select Delete Traces to delete the sample from the trace list. You will be prompted to confirm this action. 

Step 6  

Select OK to clear the Trace Preferences dialog. The trace will be removed from all graphs. 

Axes Preferences | Advanced Options | Trace Style | Show Legend 

Introduction 

Use the Graph Preferences dialog to change the appearance of your graph. 

All graphs will appear labeled with the X axis label being horizontal and the Y axis vertical. You cannot 
change the orientation of these labels. However you can alter the font and size of the axes and their labels. 

Any changes you make to the appearance of the graph will apply to all graphs until the settings are changed 
again. 

Dialog controls 

The Graph Preferences dialog comprises the following:

See also: 
How to remove a trace from a graph 
How to display a trace that is not appearing in the graph box

Graph Preferences—Ratio 

To access the Graph Preferences dialog, select the Graph Preferences command from the Graph 
menu, or select the Graph Preferences button on the Graphics toolbar.
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Axes Preferences 

Advanced Options 

Trace Style 

Axes Color Select the color that you want to assign to the axes of the graph/s from the drop down list.

Axes Width Select the width of the axes from the drop down list. The width, which is in pixels, ranges 
between one and five pixels.

Grid Style Select the style of grid for the graph from the drop down list. If you do not wish to include a 
grid on the graph, select None.

Plot Area 
Color

Select the color to be used as the background of the graph from the drop down list. If you do 
not want a background color on the graph, select White.

Trace Width Select the width of the trace from the drop down list. The width is given in pixels and 
ranges between one and five pixels.

Font Click the Font button to display the Windows Font dialog where you can define the font 
style for the axes of the graph/s. The style and size of the font will be applied to all graph. 
The style, name and point size of the font appears on the font button.

Preview Box Preview any changes you make to the axes preferences in the preview box. The changes 
shown in this box will not be made until you select OK.

Auto tick 
marks

The Auto tick marks option enables you to approximately set how many tick marks (or 
points) will be included on the graph axes. The tick marks generated will be whole, 
rounded, even numbers. The Auto tick marks option is not available if you have selected 
Major ticks. 

Y-axis
Use the Y-axis slider bar to increase or decrease the number of tick marks (or points) to be
included on the Y axis.

X-axis
Use the X-axis slider bar to increase or decrease the number of tick marks (or points) to be
included on the X axis.

Major ticks Use the Major Ticks option to enable you to set exactly how many ticks (or points) will be 
added to the X and Y axes. The number of marks you specify will be divided by the axis 
range, which can result in odd numbers on the axis. Note that any changes are not reflected 
in the graph bitmap at the top of the screen.

Decimals Use the Decimals option to set the number of X and Y decimal places to be displayed on 
the axes. To set the number of decimal places, select the Decimal option and enter the 
number in the Y-axis and X-axis combo boxes. Note that any changes are not reflected in 
the graph bitmap at the top of the screen.

Points Select Points to display each individual data point collected by the Cary Eclipse on the 
graph.

Points and Select Points and solid lines to display each individual data point collected by the Cary 
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Show Legend 

How to alter the look of your graphs—Ratio 
Step 1 

Click the Graph Preferences button  on the Graphics toolbar, or select Graph Preferences from the 
Graph menu. The Graph Preferences dialog is displayed. 

Step 2 

Use the available options available to choose your preferred appearance for the graphs. A preview box in the 
top right-hand corner will demonstrate how the graphs will appear. 

Step 3 

Select OK to clear the Graph Preferences dialog and update all graphs to reflect your selections. 

Step 4 

To re-use your graphics setup at a later date, save the setup as a graphics template. 

solid lines Eclipse on the graph. Additionally, an interpolated line that connects the points will be 
drawn.

Solid lines If you select Solid lines, the Cary Eclipse system will interpolate the data between the 
actual, collected data points and show the data as a continuous line.

Style cycles 
automatically

If you select Style cycles automatically, the Cary Eclipse system will display each of the 
above three trace styles. This makes it easier to differentiate between traces, especially on 
black-and-white printers.

Show Legend Select Show Legend to display a legend in the right side of each graph box. 
A single left click on a sample name or example line within the legend will make it the 
focused or red scan. Information about the trace will be displayed below the X axis. 

Hot Tip 
Double-clicking on the legend will automatically display the Trace Preferences 
window, allowing you to view more detailed information about your trace (e.g. audit 
log, File name, etc.). 
You can also use the legend to select which trace will be the focused trace. 

See also: 
Graph menu 
Graphics toolbar 
Graphics area 
Graphics How To

Note 
You can also add labels and pictures to your graphs to alter their appearance. 

See also: 
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Use the Cursor Modes dialog to choose the type of cursor to be used on screen. For example, you can select to 
use a free cursor that can move anywhere in the graph.  Alternatively, you can select a cursor that enables you 
to draw a line from one point to another to determine the slope using either the Least Squares method or the 
Point to Point method. 

The dialog comprises the following: 

Cursor Modes 

How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture 
How to resize graph boxes 
How to make a graphics template

Cursor Modes—Ratio 

To access the Cursor Modes dialog, select the Cursor Modes command from the Graph menu, or select 
the Cursor Modes button on the Graphics toolbar.

None Select this for no cursor tracking.

Free The Free cursor is not confined to a particular trace on the graph. It can move anywhere in a 
graph box, and its ‘X,Y’ position is shown in the bottom right-hand side of the Graphics 
area. You can use the Free cursor to zoom in on a particular part of a graph. 

Note 
The Free cursor moves from pixel point to pixel point in the selected graph box. 
Hence you need to be careful when positioning the cursor over a scan to obtain an 
accurate (X,Y) reading. It is recommended that you use the Track cursor mode for 
this.

Track Use the Track cursor to exactly trace the focused (red) scan in a graph box. The cursor 
position is displayed in the X and Y at the bottom right-hand side of the Graphics area. 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to 
the required position. Click the left mouse button, press ‘Alt’ on the keyboard, then 
release the mouse button.

Ruler-Least 
Squares

This uses a least-squares technique to determine the slope and thus the reaction rate between 
the start and end points. 
This ratio ruler function can be used for measuring zero order reaction rates in ratio traces. 
You apply the ruler after ratio data is collected to manually select the range over which to 
calculate the reaction rate. The slope is then determined and thus the rate of reaction.

Ruler-Point 
to Point

This uses the slope of the line drawn between two selected points to determine the point to 
point slope and thus the reaction rate. 
This ratio ruler function can be used for measuring zero order reaction rates in ratio traces. 
You apply the ruler after ratio data is collected to manually select the range over which to 
calculate the reaction rate. The slope is then determined and thus the rate of reaction.

See also: 
About the ratio ruler 
How to use the ratio ruler 
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How to track the focused trace—Ratio 
To track the focused (red) trace in the graph: 

Step 1  

Click the Cursor Modes button  from the Graphics toolbar, or select Cursor Mode from the Graph menu. 
The Cursor Modes dialog will appear. 

Step 2  

Select Track and select the OK button. 

Step 3  

Place the blue tracking cursor in the graph box you require. 

Step 4  

Move the cursor left and right across the graph box to trace the focused (red) scan. The cursor coordinates 
change (in the X, Y field at the bottom left hand corner of the Graphics area) as you move along the curve. 

Use the Axes Scales dialog to manually change the axes range. This can assist in zooming in on a particular 
part of the graph. 

The dialog comprises the following: 

X Axis 

How to zoom a graph 
How to track the focused trace

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the required 
position. Press 'Alt' on the keyboard, then release the mouse button. 

See also: 
How to select the focused trace 
How to view a particular trace

Axes Scales—Ratio 

To access the Axes Scales dialog, select the Axes Scales command from the Graph menu, or select the 
Axes Scales button on the Graphics toolbar.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the X axis, in the format n1 - n2 (where n1 is the 

start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can access 
by selecting the down arrow adjacent to the Scale field.
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Y Axis 

How to scale your graph manually—Ratio 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

Click the Axes Scales button  on the toolbar, or select Axes Scales from the Graph menu. The Axes 
Scales dialog id displayed. 

Step 3  

Type in the new ranges for the X and Y axes in the format ‘n-n’, or choose an option for each from the drop-
down list. 

Step 4  

Select OK. The axes on the selected graph will change to reflect your chosen settings. 

How to scale your graph automatically—Ratio 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

To autoscale the graph, select one of the following: 

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the Y axis, in the format n1 - n2 (where n1 is the 

start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can access 
by selecting the down arrow adjacent to the Scale field.

See also: 
Graph menu  
Graphics toolbar  
How to scale your graph manually 
How to scale your graph automatically 
How to zoom a graph

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale a graph automatically
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Click the Autoscale XY button  on the toolbar to autoscale both X and Y axes. 

Click the Autoscale X button  on the toolbar to autoscale the X axis only.  

Click the Autoscale Y button  on the toolbar to autoscale the Y axis only.  

The focused trace will be scaled according to the option selected. 

You can use the Single/Multi Graph command to toggle between a display of either one or multiple graph 
boxes in the Graphics area.  

Example of a single graph box display 

Example of a multi graph box display 

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale your graph manually

Single/Multi Graph—Ratio 

The command is accessible from the Graph menu or by selecting the Single/Multi Graph button from 
the Graphics toolbar.

Note 
Up to 100 graphs can be displayed in the Graphics area at the one time. 

Page 79 of 106Ratio Home Page



How to make a graphics template—Ratio 
A graphics template lets you set up and store the style of a graphics report for future use. You can do this by 
adding labels and pictures to the background of the Graphics area and altering any axes styles etc. One 
advantage of this over the application's built-in reporting features is that you have more flexibility as to where 
you can position graph boxes and any text that you may want to appear (e.g. operator name, batch number etc.) 
and also where you add pictures, e.g. company logos etc.  

Step 1 

Start the application and open the data file from which you want to make a graphics template. Alternatively, 
collect some new data. 

Step 2 

Make as many graph boxes as you require in your template by using the Add Graph function. 

Step 3 

Adjust the graph boxes to the correct size and position them as you want them to appear in the template. 

Step 4 

Do any of the following, if required: 

Change the appearance of the graph boxes in the Graph Preferences dialog
Use the Add Label function to append text to the Graphics area
Use the Add Picture function to add pictures, such as your company's logo to the Graphics area

Step 5 

From the File menu, select Print Preview. Use the Print Preview dialog displayed to check the template that 
you have created. 

Step 6 

When you are satisfied with the appearance of the graphics, select the Save As… command from the File 
menu. The Save As dialog is displayed. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and select 
'Graph Template' to list all the template files. Ensure that the Save only focused trace check box is cleared. 

Step 8 

Enter a name for the template in the File name field.

See also: 
Graph menu   
Graphics toolbar  
Graphics How To
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Step 9 

Select OK to save the graphic template. The template will be used each time you create a new file. 

The ‘ruler’ function in the Ratio Application enables you to measure zero order reaction rates in ratio traces. 
Use the ruler after ratio data is collected to manually select the range over which to calculate the reaction rate. 
From this data, the slope the rate of reaction is determined. 

To access the Ruler Rate dialog, do the following: 

1. From the Graph menu select Cursor Modes. In the Cursor Modes dialog, select Ruler-Least Squares or
Ruler-Point to Point option as the cursor mode. See More Information on Least Squares and Point to
Point calculations.

2. Select a region of the trace that is relatively straight and place the cursor on the point of the trace where
you wish to start drawing the ruler. Click and hold down the left mouse button and drag the cursor to the
second point on the trace. A ruler line will draw as you move the cursor.

3. Release the mouse button. The Ruler Rate dialog is displayed.

The Ruler Rate dialog comprises the following: 

More information on Least Squares and Point to Point calculations 

Least squares slope calculation 

You can calculate the rate of a zero order reaction by manually selecting the range over which  to calculate the 
reaction rate of a ratio plot using the ruler on a particular graph. 

A linear equation is fitted to the data using a Ruler-Least Squares technique. The slope of the line of best fit is 
reported as the ratio rate in the Ruler Rate dialog using the previous zero order equation. 

Note 
You can also make a graphic template in a similar manner from existing data. No data will be saved in the 
template. 

See also: 
Example of a Graphics Template 
How to add a label to a graph  
How to add a picture to a graph  
How to move a label  
How to move a picture

Ruler Rate—Ratio 

Slope Displays the slope of the line of best fit in the region you selected. 
X Start/ 
X Stop 

Displays the beginning and end X co-ordinates of the region you selected. 

Y Start/ 
Y Stop 

Displays the beginning and end Y co-ordinates of the region you selected. 

Retry Select Retry to re-select a region of the trace. 
Add Label Select Add Label to add a label to the graph that diplays the slope of the line you have 

selected.
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Point to point slope calculation 

You can choose to calculate the point to point slope instead of the least squares slope value. 

The point to point slope is calculated from the slope of a line drawn between two ordinate values at two, 
specified abscissa points. 

If you choose OK or Add Label in the Ruler Rate dialog then a corresponding Results table will appear in the 
Report area that includes the manually selected abscissa, ordinate range, calculated reaction rate (Slope) and 
Standard Deviation (SD). 

The SD results means that the system looks at the difference between the actual Y value and the fitted Y value 
after the linear least squares fit or point to point fit has been applied. The system takes the difference of each 
point over the selected region and calculates the SD using the following equation: 

where, 

The Factor* Slope result is also displayed. This is the product of the Factor multiplied by the calculated ratio 
ruler slope. The Factor value (entered in the Analyze tab) also appears above the result table in the report. 

 are measured values

 are calculated values

 is the number of points

Note 
You can only perform a manual zero order rate calculation after the data is collected. Once the data is 
collected, select Cursor modes in the Graph menu and choose the ratio ruler type you require. You can 
then select the range over which to calculate the reaction rate. 

See also: 
How to use the ratio ruler
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How to use the ratio ruler—Ratio 
The ‘ruler’ function can be used for measuring zero order reaction rates in ratio traces. You can use the ruler 
after ratio data is collected to manually select the range over which to calculate the reaction rate. The slope is 
then determined and thus the rate of reaction. 

To use the ruler: 

Step 1 

From the Graph menu, select Cursor Modes. Alternatively, select the  button on the toolbar. The Cursor 
Modes dialog is displayed 

Step 2 

Select Ruler—Least Squares to use a least-squares technique to determine the slope and thus the rate of the 
reaction over the selected range. Alternatively, select Ruler—Point to Point to use a line drawn between two 
selected points to determine the point to point slope and thus the reaction rate. 

Step 3 

Select OK to clear the Cursor Modes dialog and return to the Ratio Application window. 

Step 4 

Select a region of the trace that is relatively straight and then place the cursor on the first point on the trace 
where you wish to start drawing the ruler. Press and hold down the left mouse button. 

Step 5 

Move the cursor to the second point on the trace (you will see the ruler line drawing as you move the cursor) 
and release the mouse button. 

The Ruler Rate dialog will be displayed to enable you to view the start and end positions of the calculation 
range that you selected. The value of the calculated slope is also displayed. 

If you are not satisfied with the rate result, select the Retry button to repeat Steps 3 to 5, this time selecting 
another range. 

Step 7 

Select Add Label to add the determined slope value of the ruler trace to the graph. The Ruler Rate dialog will 
be cleared.  

If you do not wish to add a label, simply select OK to clear the Ruler Rate dialog. 

The results of the manual determination of the reaction rate will appear in a table in the Report area. The 
ordinate and abscissa start and end values are reported as well as the calculated slope. The result table will also 

Note 
If you wish to exit the ratio ruler mode, select Cancel. The ratio ruler trace will be removed from the 
graph.
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include the calculated standard deviation as well as the Factor*slope result.  

Examples—Ratio 
Multi-stage ratio run
Multi-stage ratio calculations
Example of a graphics template
Using the stop time

Example of a multi-stage ratio run—Ratio 
Number of Stages = 3, Single Cell ratio 

The Ave Time is set to 0.500 s 

Graphical representation of data points for the above example 

Stage 1: 0-10 minutes. The run will commence taking data readings at the set Ave Time of 0.5 s and cycle 
every 2 minutes. Five cycles will be completed in the first 10 minutes (Stop Time 10 mins) of the run.  

Stage 2: 10-26 minutes. The run will continue taking data readings at the set Ave Time of 0.5 s but cycle every 
4 minutes. Four cycles will be completed in the next 16 minutes (Stop Time 26 (10+16) mins) of the run.  

Stage 3: 26-45 minutes. The run will continue taking data readings at the set Ave Time of 0.5 s but cycle every 
5 minutes. Four cycles will be completed in the next 20 minutes (Stop Time 45 (10+16+20) mins) of the run.  

Example of multi-stage ratio calculations—Ratio 

See also: 
Cursor modes

Stage Cycle (min) Stop (min)
1 2 10
2 4 26
3 5 45

See also: 
Example using the Stop time
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The table to follow indicates the regions that would be selected to perform an Advanced analysis, on the above 
example. 

Number of stages (steps) = 2 

Example of a Graphics Template—Ratio 
By using the Add Label command in the Cary Eclipse graphics system, you can customize a graphics template 
such as the one shown below: 

The above is created as follows: 

The graph on the left is the collected data.

Stage Start (min) Stop (min) Order
1 1 2 Zero
2 4 5 Zero
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The text on the top right is a multi-line label (added using the Add Label command).
The logo is an inserted picture (added using the Add Picture command).

Example using the Stop time—Ratio 
Example 

Cycle time = 5 minutes 
Stop time = 30 minutes 

In the above example the run will complete 6 cycles of the chosen cells, each with a Cycle time of 5 minutes. 
The run will end at the selected Stop time of 30 minutes. 

File Management—Ratio 
File menu
Open dialog
Save As dialog
Filename extensions
ASCII spreadsheet file
Auto Store page
How to combine data files into a batch file
How to export collected data
How to combine data files into a batch file

File menu—Ratio 
Use the File menu to open or save a method or data file, print or preview a report, or exit the Cary Eclipse 
application. 

The following commands can be accessed from the File menu: 

See also:
Add Label
How to make a graphics template

Note 
If the Stop time was set to 28 mins, the run would continue for 30 mins, as the Cycle time overrides the 
Stop time. 

See also: 
Example of a multi-stage Ratio run

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open it. 
Any data will be displayed in the Graphics area.

Command What it does…
New Select New to clear all method, report and graphics information and create a new file 

containing the default settings.
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Look in | File name | Files of type | Overlay Data | Open 

Use the dialog to open a file previously saved by the application. To access the Open dialog, select Open or 
Open Method from the File menu. 

Open 
Method… 

Select Open Method to display the Open dialog where you can search for and load a stored 
method. 

Open… Select Open to display the Open  dialog where you can search for and load method, data, 
report, graph template and batch files, as well as other file types compatible with the Cary 
Eclipse software. When you load a batch file, the method which collected the data is loaded 
as well as the associated report and graphics layout.

Save Method 
As… 

Select this option to display the Save As dialog and store the current method. You can use 
the Save As dialog to store the method, data, report, or graphics template separately or 
together as a Batch file. The data can also be saved as a comma delimited ASCII 
Spreadsheet file.

Save As… Select this option to display the Save As dialog and store the collected data. You can use the 
Save As dialog to store the method, data, report, or graphics template separately or together 
as a Batch file. The data can also be saved as a comma delimited ASCII file.

Print Setup… Select this option to display the Windows Print Setup dialog where you can select the 
printer, printer page size and orientation.

Print 
Preview… 

Select this option to display the Print Preview dialog where you can view the current report 
as it will be printed.

Print… Select this option to display the Windows Print dialog where you can choose the printer and 
pages to print as well as the number of copies you wish to print.

Explorer… Select this option to run Windows Explorer. This may help you locate method and data files.
History List This displays a list of the four most recently opened files.
Exit Select this option to exit the Ratio application. 

See also: 
Open   
Save As   
Print Preview   
Filename Extensions 
ASCII Spreadsheet File

Open—Ratio 

Look in The Look In field lists the available folders and files. Click the down arrow on the right of 
this field to view the location of the current folder in your computer's hierarchy. You can 
also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In 
field. 

Note 
To open the folder in the level that is one higher than the current folder, select on 
the toolbar.

Look in list 
box  

The Look In List Box, which is directly below the Look In field, displays the folders and 
files in the selected location. To view the contents of a folder, double-click it. 
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Click to create a new folder. Type the name of the new folder in the highlighted text 
entry field that appears and press Enter. Then double-click on the new folder to open 
it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the date the 
file was last modified.
Click to preview the selected trace before you load it into the application.

File name Enter the name of the file you want to open in this field. The easiest way to do this is to find 
the file in the Look in list box and then select the file. However, you can type the full path 
of a file and then select Open to open the file.

Files of type  Click on the arrow on the right of this field to view a list of the different types of application 
files that can be opened in the list box. 
Methods (*.FMRT) Choose this file type to open a Method file. Only the method is 

loaded. No data is loaded.
Data (*.FDRT) Choose this file type to open a Data file. Only the data is loaded. 

The method that was used to collect the data is not loaded. The last 
used method or default method will be displayed.

Report (*.FRRT) Choose this file type to open a Report file. You can view the report 
in the Report area.

Graph Template 
(*.FGRT) 

Choose this file to open a Graph Template file. The file will set up 
the layout of the Graphics area including any bitmaps as well as the 
range and style of the graph axes.

Batch (*.FBRT) Choose this file type to open a Batch file. A Batch file includes 
data, the method used to collect the data, report and graphics setup.

Spreadsheet Ascii 
(*.CSV)

This will open ASCII files that contain single comma delimited 
files with two or more columns.

GRAMS (*.SPC) Choose this file type to open a Cary Eclipse GRAMS data file. 
This allows you to use data files collected using a Cary Eclipse 
GRAMS system. The method that was used to collect the data is 
not loaded.

ADL (*.ADL) This will open and run program files generated in the Applications 
Development Language (ADL). 

All files (*.*) This enables you to view all files in the directory so that you can 
open any compatible file.

Tell me more about Filename Extensions

Overlay Data Select this check box to overlay individual data files in one graph box. If this is not checked 
the data from each file will appear in individual graph boxes. This option is only available if 
the Open dialog has been accessed by selecting 'Open…' from the File menu. 

Hot Tip 
Use the SHIFT or Control key to select multiple data files.

Open This button opens the highlighted file/s or the files listed in the File name field.
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Save As—Ratio 
Look in | File name | Files of type | Save 

Use the Save As dialog to save the data, method, report or graphics template individually or together as a 
Batch file. 

Traces (or data) that are currently ‘Visible’ in the Graphics area are saved, regardless of how they are displayed 
(full screen graph box or tile).  

For example, if six graph boxes are displayed in the Graphics area and each graph box has one Visible trace 
then all six traces will be saved.  

If you do not wish to save particular traces, make them not Visible in the Trace Preferences dialog. To save 
only the focused trace, select the Save only focused trace check box. 

The Save As dialog comprises the following: 

 
See also: 
File menu

Note 
This dialog appears when you select either the Save Method As or Save As menu option in the File 
menu. When you select Save Method As this dialog appears with 'Methods' displayed in the Files of type
field. When you select Save As this dialog appears with 'Batch' displayed in the Files of type field.

Look In The Look In field lists the available folders and files. Click the down arrow on the right of 
this field to view the location of the current folder in your computer's hierarchy. You can 
also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed in the list box below the Look In 
field. 

Note 
To open the folder in the level that is one higher than the current folder, select on 
the toolbar.

Look in list 
box 

The Look In list box, which is directly below the Look In field, displays the folders and 
files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted text 
entry field that appears and press ENTER. Then double-click on the new folder to 
open it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the date the 
file was last modified.
Click to preview the selected trace before you load it into the application.

File Name Enter the name of the file you want to save in this field. 
You can also type the full path of a file then select the Save button to save the file. 
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Filename extensions—Ratio 
The Cary Eclipse system uses the filename extension to distinguish between data types (e.g. method or data) 
and also to differentiate applications. (e.g. Concentration or Ratio). 

The Syntax for file extensions is: 

Files of Type  Click on the arrow on the right of this field to view a list of the different types of application 
files that can be opened in the list box. 
Methods (*.FMRT) Choose this file type to only save the current method. Any 

collected data is not stored.
Data (*.FDRT) Choose this file type to only save the data currently Visible in the 

Trace Preferences dialog (for any graph box). Note that the 
method used to collect the data is not stored with the data.

Report (*.FRRT) Choose this file type to only save the contents currently shown in 
the Report area..

Graph Template 
(*.FGRT) 

Choose this file type to save the layout of the Graphics area as a 
template. For example, any bitmaps you have added to your 
Graphics area will be saved as well as the range and style of the 
graph axes.

Batch (*.FBRT) Choose this file type to save the data that is currently Visible in the 
Trace Preferences dialog (for any graph box), the method used to 
collect the data and the currently displayed report all together as a 
batch file. The graphics setup is also stored. 

Spreadsheet Ascii 
(*.CSV)

Choose this file type to save the raw intensity data currently 
Visible in the Trace Preferences dialog (for any graph box) as a 
comma delimited ASCII Spreadsheet file (*.CSV) file. The data is 
saved as XY pairs delimited by a comma. 

Note 
This file type can be easily imported into a spreadsheet 
program. For example, Microsoft Excel. You can also 
double-click on the stored *.CSV file from Microsoft 
Explorer to load Excel automatically with the ASCII XY data 
displayed.

GRAMS (*.SPC) Choose this file type to only save the data currently Visible in the 
Trace Preferences dialog (for any graph box) as a Cary Eclipse 
GRAMS data file.

Tell me more about Filename Extensions

Save only 
focused trace 

Select this option to save only the focused trace in the graph box. If this option is not 
selected, all visible traces in the graph box will be saved.

Save Click this button to save the file currently present in the File name field in the directory 
specified in the Look in field.

See also: 
File menu  
ASCII Spreadsheet file (*.CSV) 

Letter Represents Available Options
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The following files may be opened and saved in the Ratio Application: 

First Type of analysis F Fluorescence

Second Type of file B Batch
D Data
G Graph Template
M Method
R Report

Third and fourth Application identifier AB Advanced Reads
CN Concentration
KN Kinetics
LT Lifetimes
RT Ratio
SR Simple Reads
SW Scan
TM Thermal
VO Validate

Extension Available action File type
*.FMRT Open/Save A method file (*.FMRT) consists of the software setup by 

which data is collected.
*.FDRT Open/Save A data file (*.FDRT) contains data collected that is 

currently visible in the Trace Preferences dialog (for any 
graph box). 

*.FRRT Open/Save A report file (*.FRRT) contains the report generated by the 
Cary Eclipse about the data.

*.FGRT Open/Save A graph template file (*.FGRT) contains information that 
sets up the layout of the Graphics area including any 
bitmaps as well as the range and style of the graph axes.

*.FBRT Open/Save A batch file (*.FBRT) contains the collected data that was 
Visible in the Trace Preferences dialog (for any graph box), 
the method by which the data was collected and the report 
and graphics template.

*.CSV Open/Save An ASCII spreadsheet file (*.FCSV) has the same 
extension for all applications. It consists of raw intensity 
data (that was currently Visible in the Trace Preferences 
dialog (for any graph box) saved as XY comma-delimited 
pairs. This file can be imported into a spreadsheet program 
such as Microsoft Excel.

Data.* Open A Cary DOS (Data.*) file is the equivalent of a Cary 
Windows Data file—it does not contain any Batch 
information.

*.ADL Open only An ADL file (*.ADL) is a program file generated in the 
Applications Development Language (ADL). 

*.SPC Open/Save A Cary GRAMS file (*.SPC ) is the equivalent of a Cary 
Eclipse Windows Data file—it does not contain any Batch 
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ASCII Spreadsheet file (*.CSV)—Ratio 
An ASCII Spreadsheet file consists of raw intensity data saved as XY comma-delimited pairs. You can choose 
to import or export Cary Eclipse files to ASCII files, which can then be imported in spreadsheet programs such 
as Microsoft Excel. 

The format is as follows:  

Line 1 contains the sample name plus a comma
Line 2 contains X and Y labels. The name of the X label must be the same as that used to label the graph.
For example, in Ratio, the graph label is Time (secs).
Lines 3 and onward contain the X,Y data
After the last line of X,Y pairs there must be a blank line separating the data from any text audit strings
or the end of the file.

For example, if a Ratio file was collected as: 
s = 0.025, intensity = 1.422 
s = 0.075, intensity = 1.403 
s = 0.125, intensity = 1.384 
etc. 

It would appear as follows in the ASCII file: 

Microsoft’s Excel generates a CSV file with the above format. 

There is also an alternative format for CSV files. For example, 

information.
*.FADL Open An Eclipse ADL (*.FADL) file is a program file generated 

in the Applications Development Language (ADL) 
specifically for the Cary Eclipse. Eclipse ADL files will be 
associated with the relevant Eclipse application. When 
creating ADL files for the Cary Eclipse, it is recommended 
that you save them with the FADL extension.

Note 
Selecting All Files in the Windows Open dialog will list all available file types. 

See also: 
Open 
Save As

  Ratio, 
  Time (secs); Intensity (a.u.) 
  0.025, 1.422 
  0.075, 1.403, 
  0.125, 1.384, 

  Ratio, 
  Collection time; 
  etc. 
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How to combine data files into a batch file—Ratio 
To combine a number of data files into a batch file, do the following: 

Step 1  

Select Open… from the File menu to display the Windows Open dialog. 

Step 2  

A list of stored batch files will appear. Select the down arrow to the right of the Files of type field and select 
'Data' to list all the data files. 

Step 3  

Select the Overlay Data check box. 

Step 4  

Highlight the data files that you require. Hold down the CTRL key to select multiple files. 

Step 5 

Select Open. The highlighted data files will load into the application and appear in the same graph box. 

Step 6 

Select Save As… from the File menu to display the Windows Save As dialog. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and select 
'Batch' to list all the batch files. Ensure that the Save only focused trace check box is cleared. 

Step 8 

In the File name field, type in the file name for your new batch file.

  Ratio 
  Time (secs); Intensity (a.u.) 
  0.025, 1.422 
  0.075, 1.403 
  0.125, 1.384 

  Ratio, 
  Collection time; 
  etc. 

See also: 
Save As 
Open 
How to export collected data

Page 93 of 106Ratio Home Page



Step 9 

Select Save to create the new batch file. The current method will be stored with the batch file. 

All the data files are now combined into the one batch file. 

How to export collected data—Ratio 
If you want to export data from a Cary Eclipse application into a third-party application, then you simply need 
to save your data as an Spreadsheet ASCII (*.CSV) file or a Rich Text Format (*.RTF) file. Spreadsheet ASCII 
files are recommended if you are planning to use the data in a spreadsheet program such as Microsoft® Excel. 
Rich Text Format files are recommended if you are planning to open the data in a word processor program 
such as Microsoft® Word. 

To export collected data: 

Step 1  

From the File menu, select Save As. The Save As dialog is displayed. 

Step 2  

Click on the down arrow next to the Files of type list box and select the Spreadsheet ASCII (*.CSV) or Rich 
Text Format (*.RTF) option. 

Step 4  

Type the name of your new file in the File name field. 

Step 5  

Select Save to export your data to this new file. 

Software and Screen features—Ratio 
Menu line
Status display
Status line
Buttons
Function keys
Right mouse menu
How to remove or display the command buttons

Menu line—Ratio 
 File menu 
 Edit menu 
 View menu 
 Commands menu 
 Setup menu 
 Graph menu 
 Help menu 
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Status Line—Ratio 
The Status Line is displayed at the very bottom of the Ratio Application window. The line will display the 
following information (from left to right): 

The major commands in this application can be accessed both from the menu items at the top of the main 
window and from the application buttons. These buttons, which appear in the left side of the Ratio Application 
window, comprise the following: 

Hardware Status This field displays status messages indicating the current instrument activity.
Sequence Information This field displays status messages indicating the current system activity.
Current Results This field displays information on the last reading. 

Ratio Application window

Buttons—Ratio 

Hot Tip 
If you wish to access these commands from the main menus, rather than from these buttons, you can 
remove the Command buttons from your application window. To do this, clear the Buttons command in 
the View menu. This will enlarge the Graphics area, making viewing and selection of scans easier. 

Button Enables you to…
Setup Click this button to display the Setup dialog where you can set up your Cary Eclipse for the 

collection, storage and analysis of the ratio run. You can also set up any accessories that you 
may have and define the reporting options.

Zero Select this to zero the current ordinate value. 
This command can also be accessed by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Set Temp Click Set temp to open the Set Temperature dialog where you can change the temperature 
during a ratio run. 

Q. Why is the Set Temp button unavailable?
A. The Set Temp button is only accessible if you are using a thermostatted accessory.
(On the Accessories page, the Temperature control option must be selected.) Once
you have started a run, you can access the Set Temp button by selecting the Pause
button to pause the run. You can then select the Set Temp button.

Stop Time Click the Stop Time button to access the Stop Time dialog. Use this dialog to extend the 
length of a ratio run while the run is in progress. Extending a run may be necessary if you 
decide whilst a run is in progress that the data collection period too short.

Clear Report Select Clear Report to remove all of the text that appears in the Report area. If you have 
saved the report, you can view the information again. To do this, simply open the report file 
using the Open… command in the File menu.

Recalculate Use the pages accessible from the Recalculate option to perform re-calculations on data that 
has been analyzed.

Print Select Print to display the Windows Print dialog where you can choose what printer the 
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Function keys—Ratio 
The function keys at the top of your keyboard perform basic Cary Eclipse operations simply and quickly. 

report will be printed to. You can also select what pages to print as well as the number of 
copies you wish to print. 
This command can also be accessed by pressing CTRL+P. 

Note 
The options on the Report page are used to generate the contents of the Report area 
during a run or on a recalculation. If Auto Print has been selected the Cary Eclipse 
will automatically print a report at the end of a data collection.

See also: 
Ratio Application  
Setup  
Set Temperature  
Stop Time   
Recalculate 
Commands menu 

Function 
key 

What it does

F1 This displays the Help for the current dialog or window.
F4 Press F4 to display the Go to Wavelength dialog.
F5 Press F5 to perform an instrument Zero. The current intensity value will be reset to zero and all 

subsequent results will have the value that was reset to zero subtracted from them. You can use 
the Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible from the Commands menu or by selecting the Zero button. 

Select the Clear Zero command from the Commands menu to remove zero correction. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell positions 
that are currently in the cell path.

F6 Press F6 to display the Rapid Result dialog where you can read a blank and multiple sample 
readings without changing the application method. 
This command is also accessible from the Commands menu.

F9 If the application is online, press F9 to start a data collection. This is equivalent to selecting the 
Start button. If the application is not online, you will need to press F9 to first connect to the Cary 
Eclipse. Then press F9 to start the data collection. 
This command is also accessible from the Commands menu or by selecting the Start button. 

Note 
You will not be able to perform a Connect if another application is collecting data.

F12 Select this to stop the current measurement. This is equivalent to selecting the Stop button. This 
command is also accessible from the Commands menu or by selecting the Stop button. 

See also: 
Go to Wavelength 
Zero  
Rapid Result  
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Right mouse menu—Ratio 
The following commands are accessible by clicking the right mouse button on editable fields in the Cary 
Eclipse software: 

How to remove or display the command buttons—Ratio 
The command buttons (Setup, Zero, Pre-scan, Set Temp, Stop Time, Clear Report, Recalculate and Print) 
appear on the left side of the Ratio Application window. 

To remove the command buttons 

Step 1 

From the Ratio Application window, select the View menu. 

Step 2 

Clear the Buttons menu item. 

The buttons will disappear from the application screen, giving you more room to display reports. 

To show the command buttons 

Step 1 

From the Ratio Application window, select the View menu. 

Step 2 

Select the Buttons menu item. 

The buttons will re-appear in the application screen. 

ADL—Ratio 
ADL Command Line
ADL Hooks

Introduction to ADL 

Start/Stop Instrument Buttons

Undo If available, this reverts to the previous value before the Edit on the field.
Cut If available, this cuts the highlighted text to the clipboard.
Copy If available, this copies the highlighted text to the clipboard.
Paste If available, this pastes the text from the clipboard to the cursor position.
Delete If available, this deletes the highlighted text/number.
Select All If available, this selects all entries.

ADL Command Line—Ratio 
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Use the ADL Command Line to run Single-line or Multi-line Applications Development Language (ADL) 
commands that enable you to perform functions over and above that of the existing program functionality.  

ADL is not a general purpose programming language. It has been developed specifically by Varian to meet the 
needs of spectroscopists. It can be used to handle all the data collected from the Cary Eclipse—both 
photometric values and entire data collections. ADL programs that you develop should be stored with the 
extension 'ADL'. 

To access the ADL Command Line, select the ADL Command item from the Commands menu. You can also 
press ALT+Y to open the dialog. 

Software controls 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help. 

Single Line Selecting this lets you enter ADL commands on a single line into the Command Line entry 
box. 

Q. Can I enter more than one ADL command on a single line?
A. Yes, provided that the commands are separated by a semicolon ‘;’.

Multi-line The Multi-line capability enlarges the Command Line entry box. Use the Multi-line 
capability to create a more complex ADL program by adding a series of commands over 
multiple lines. When Multi-line mode is selected, the Quick Reference option becomes 
available.

Quick 
Reference 

Select Quick Reference to open the Quick Reference dialog where you can easily add a 
command in the correct syntax to your ADL program. This option is only available for Multi-
line commands. 

A detailed description of all the commands in the Quick Reference is available by pressing 
the Help button on the Quick Reference dialog. 

Browse Select Browse to access the Open dialog where you can browse for and select an existing 
ADL program to load and run.

Command 
Line (entry 
box) 

This entry box enables you to use ADL commands. You can enter single ADL commands 
into this field, or you can enter a series of ADL commands. If you have the entry type set to 
Single Line, you can review previous ADL entries by selecting the down arrow to the right of 
the list box. 

The ADL commands in the Command Line are executed when you select OK. 

Note 
On entering this window, the Cary Eclipse will recall the last command or program 
executed from the Command Line entry box. The ADL commands entered in the last 
executed program are typically stored in the Varian\Cary Eclipse WinFLR\ADL 
directory on the drive on which the Cary Eclipse software is installed.
Hot Tip 
You can rerun the ADL commands in the Command Line entry box from any screen in 
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The ADL Hooks command is accessible from the View menu. 

Instead of writing a full ADL program you can use ADL hooks to link into an existing application. This is 
particularly useful if you want to make small changes to the way an application works, e.g. you want to pop up 
a dialog for the user to enter some specific data before the run starts. ADL hooks are links at specific points in 
an application at which you can run an ADL program. For example, ADL hooks have been supplied to run the 
following ADL programs:  

the Ratio application by pressing Alt-X or selecting Re-run ADL from the Commands
menu. 

 
See also: 
ADL Hooks

ADL Hooks—Ratio 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Hook Description

RT_Startup.ADL This is run when the Ratio application starts. For this to to work the application 
must be started from a batch or method file that has ADL Hooks on.

RT_PreSeq.ADL This runs when the Start button is selected.

RT_PostSeq.ADL This runs at the end of the Start button sequence.

RT_Online.ADL This runs when Cary Eclipse is detected online.

RT_OffLine.ADL This runs when Cary Eclipse goes offline.

RT_Zero.ADL This runs when the Zero button is selected.

RT_Recalc.ADL This runs when the Recalculate button is selected.

RT_Shutdown.ADL This runs when the application is shutting down.

RT_PreRead.ADL This runs just before a read is taken.

RT_PostRead.ADL This runs just after a read is taken (It has the reading result stored in the 
UserResult variable.)

RT_PreSetup.ADL This runs when the Setup button is selected.

RT_PostSetup.ADL This runs when the OK button on the Setup dialog is selected.

RT_CellChange.ADL This runs instead of the Cary Eclipse driving the Multicell Holder. It enables 
you to add your own instructions for the Cary Eclipse Multicell Holder or to 
use your own cell changing accessory.

RT_PreStage.ADL This runs prior to each collection stage. It determines the stage by checking the 
UserResult variable as UserResult = stage number.

RT_PreUserRecalc.ADL This runs just after the Recalculate button has been selected and performs any 
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Help and Safety information—Ratio 
Help menu
Safety home page

Help menu—Ratio 
Use the Help menu to view the online Help and software information for this application. 

Safety Home Page 
Click on the desired index entry to view the Help. 

About Safety
Lamp module

pre-processing required prior to a recalculation. If the ADL Variable 
UserBoolean is set to FALSE, it can also replace the normal recalculations.

RT_UserRecalc.ADL This runs just prior to the calculations and can also be used to replace the 
calculations.

RT_PostUserRecalc.ADL Runs after the Recalculate sequence has been completed

RT_TraceName.ADL Allows the name of the sample to be obtained from an ADL file, instead of 
being entered by typing into the sample loading dialog. This only works for 
single samples.

RT_UserPreCalc.ADL This runs just prior to the calculations. Any pre-processing of data should be 
done here.

RT_UserPostCalc.ADL This runs after the calculations. Any post processing of data should be done 
here.

RT_DuringSeq.ADL Runs when the collect sequence has been paused

RT_PreStage.ADL Runs prior to each stage in a multistage (advanced) run.

RT_PostStage.ADL Runs after each stage in a multistage (advanced) run

Command What it does…
Ratio Help Select this to display the Ratio Home Page. This contains a list of online Help topics specific 

to the Ratio Application.
Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.
Tip of the day View useful tips about using your Cary Eclipse instrument and software.
Eclipse Tour Select this to display the Cary Eclipse Multimedia Online Help. This will give you an 

animated introduction to the Cary Eclipse software and hardware.
About… Select About to access a dialog that displays information about the application as well as 

Varian email and Internet contact information.  
To clear this About dialog, select OK.
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Ultraviolet radiation
Electrical hazards — Cary Eclipse
Panels, covers and modules
Other precautions
Warnings and cautions
Warning symbols
Color coding
Information symbols
FCC advisory
CE compliant products

Ratio How To—Ratio 
Select the procedure you require below for a step-by-step informative guide on running the application 
software. 

Procedural 

Calculations and reporting 

How to determine the autofluorescence of a reaction
How to subtract autofluorescence from your reaction
How to create a ratioed trace
How to use the Grynkiewitz equation
How to use the ratio ruler
How to generate a report from previously collected data
How to use advanced reporting options

General 

How to email your results
How to export collected data
How to combine data files into a batch file
How to remove or display the command buttons

To determine the true fluorescence value of a reaction it is necessary to subtract the autofluorescence of the 
reaction. That is it is necessary to subtract the intrinsic cell fluorescence from the overall calculated 
fluorescence of the reaction. 

To determine an autofluorescence value of a reaction: 

If using Sample Averaging, place a sample in a cuvette and open Advanced Reads to take a reading to obtain 
your autofluorescence value. 

Alternatively 

If you are using information from a continuum, place your sample in a cuvette to be read over time and using 

See also:
Ratio Home Page
Graphics How To

Autofluorescence correction—Ratio 
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Kinetics to collect and average the data points get your autofluorescence value. 

Status Display 

Select this check box to display the Status Display window. This window allows you to view the status of 
various parameters during the data collection. 

To determine the true fluorescence value of a reaction it is necessary to subtract the autofluorescence of the 
reaction. That is it is necessary to subtract the intrinsic cell fluorescence from the overall calculated 
fluorescence of the reaction. 

The Autofluorescence value has to be subtracted post run. 

Step 1 

Using the Trace Preferences option  display the trace(s) from your run as separate graphs. 

The individual traces will be listed as your substance run at a particular wavelength. Select the individual traces 
by clicking in the Visible column next to the trace. 

Step 2 

Return to the main graphics area and select the trace you wish to correct by subtracting an autofluorescence 
value. 

Step 3 

In the Setup dialog select the Analyze tab and check the Subtract autofluorescence check box. 

Step 4 

In the Enter value to subtract from trace entry field, type in the autofluorescence value obtained previously 
for the selected trace. Select OK. 

Step 5 

A new corrected trace will be generated showing the initial trace minus the autofluorescence value, and will be 
named as such _AF1. This trace will be listed in the Trace Preferences window but has not been saved. Save 
the new trace as a batch file. 

Step 6 

Note 
If you are using multiwavelength analysis you will need to do this for both wavelengths. If you are using 
single wavelength analysis you will only be require to do this once and collect one autofluorescence 
value.

 
See also: 
Subtracting autofluorescence 

Subtracting Autofluorescence—Ratio 
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Repeat this procedure for each trace. 

Status Display 

Select this check box to display the Status Display window. This window allows you to view the status of 
various parameters during the data collection. 

How to resize graph boxes—Ratio 
Step 1  

Click on the graph that you want to resize so that the highlight box appears around it. 

Step 2  

Move the cursor to the edge of the highlight box and place it over one of the square marks (e.g. ) in the box 
until it turns into a double headed arrow ( ). 

Step 3  

Click and hold the left mouse button and drag the box to the desired size. 

Step 4  

Release the left mouse button. 

How to zoom a graph—Ratio 
To zoom a graph, do the following: 

Step 1  

Click on the  button on the toolbar, or select Cursor Mode from the Graph menu. The Cursor Modes 
dialog will appear. 

Step 2  

Select Free and select the OK button. 

Step 3  

Click and hold down left mouse button in the highlighted graph box. 

Step 4  

 
See also: 
Determining autofluorescence 
Using traces with autofluorescnce subtracted to obtain a ratioed trace 

See also: 
How to alter the look of your graphs
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Drag the mouse sideways and up or down. You will see a zoom box made up of a dotted line appear on the 
screen. (See picture below.) 

The dotted line is a zoom box. 

Step 5  

Release the left mouse button. The area defined by the zoom box will be redrawn to fill the entire graph box, 
and the scans within the box will be enlarged accordingly. The abscissa (X) and ordinate (Y) coordinates 
displayed below the graph will also be changed to reflect the positions of the corners of the zoom box. 

You can repeat this process if you need to zoom in even further. 

How to take the derivative of a trace 
Some uses of derivatives are: 

To resolve partly overlapping peaks
To quantitatively determine trace compounds
To characterize pure compounds
Purity testing

To take the derivative of a collected trace and plot the result, follow these steps: 

Step 1 

Click on the trace to be smoothed. It will become red (highlighted). 

Step 2 

Click the Selected Trace or Focused Trace button. The name of the highlighted trace will appear in the 
calculation display field. 

Step 3 

In the Trace group, select your derivative order in the Operation field. Choose from derivatives 1 to 4 (Deriv1, 
Deriv2, Deriv3, Deriv4). You may have to scroll to find the derivative you require.

Hot Tip 
To move the box on the screen, hold down the left and right mouse buttons together. You can then 
position the box anywhere in the graph box. Releasing the right mouse button will still allow you to 
resize the zoom box.

Note 
The system may limit the extent to which you can Zoom. 
See also: 
How to scale your graph manually 
How to scale your graph automatically
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Step 4 

Enter a Filter Size and an Interval in the corresponding fields. 

Step 5 

In the Display Options group, select New Graph to plot the result in a new graph box, or Selected Graph to plot 
the result in the current graph box. 

Step 6 

Click the Apply button in the Trace group. Your Deriv selection will be displayed before the trace name in the 
calculation display field. 

Step 7 

Click on the equals (=) button. The result will be displayed in the Graphics area. 

How to smooth a trace 
To smooth a collected trace and plot the result, follow these steps: 

Step 1 

Click on the trace to be smoothed. It will become red (highlighted). 

Step 2 

Click on the Maths button in the toolbar (it's on the far right) or select the Maths menu. 

Step 3 

Click the Selected Trace or Focused Trace button. The name of the highlighted trace will appear in the 
calculation display field. 

Step 4 

In the Trace group, select Smooth in the Operation field. (You may have to scroll to find it.) 

Step 5 

Enter a Filter Size and an Interval in the corresponding fields. 

Step 6 

In the Display Options group select New Graph to plot the result in a new graph box, or Selected Graph to plot 
the result in the current graph box. 

Step 7 

See also: 
About derivatives
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Click the Apply button in the Trace group. The word ‘Smooth’ will appear before the trace name in the 
calculation display field. 

Step 8 

Click on the equals (=) button. The result will be displayed in the Graphics area.
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Scan Home Page 

Introduction 

Use the Scan application to scan samples across a wavelength or wavenumber range and manipulate the collected 
data. You can choose various display modes for the collected data depending on the type of sample you are 
measuring and the Cary Eclipse accessories that you are using. 

To access the Scan Application, click the Windows Start button, point to Programs, Cary Eclipse and then select 
Scan. 

To… Use the… Show me…
Get ready to read samples Setup dialog

Performing scans Commands menu How to perform a fluorescence scan
How to perform a phosphorescence scan
How to perform a bio-/chemi-luminescence scan

Viewing run progress and 
results

Reports
View menu
Status Display
Print Preview

How to generate a report from previously collected
data  
How to use advanced reporting options

Performing calculations Maths Calculator
User Data Form

Maths How To

Display data graphically Graph menu
Graphics area

Graphics How To

To find out about… See the… Show me…
Scan Application Scan Application

File management File menu
Open
Save As
Filename extensions
Auto Store

How to export collected data
How to combine data files into a batch file
How to email your results

Software and screen 
features

Menu Line
Status Line
Buttons
Function keys
Right mouse menu

How to remove or display the command buttons

ADL ADL Command Line
ADL Hooks

How to insert ADL commands

Help and safety information Help menu
Safety Home Page

See also: 
Scan How To

Scan Application 
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Software controls 

The application comprises the following: 

Instrument 
Status 
Readings 

The Instrument Status Readings, which display the Y and X values of the graph axes are 
displayed in the top left and right corners of the Scan Application window. 

Y value 
Displays the current Y value, usually intensity. This value is continually updated during a data 
collection. 

X value 
Displays the current X values for both excitation and emission. You can choose to display these 
values as either Angstroms, Wavelengths, Wavenumbers or Electron Volts. Select how the 
values will be displayed on the Cary page of the Setup dialog. 

Start and Stop 
buttons 

The Start and Stop buttons at the top of the Scan Application window are used to start and stop 
instrument analyses. These buttons can also be accessed from the Commands menu. 

Tell me more about the Start and Stop buttons

Graphics area The Graphics area refers to the plotting area of the application. It can contain traces of collected 
data, labels and pictures. In the Cary Eclipse system, the term 'graph' refers to the plotting area 
and is represented by a set of axes. The rectangular area defined by the axes is referred to as a 
graph box. 

To display or hide the Graphics area, select the Graphics command on the View menu. Double-
clicking on the Graphics area enables you to toggle between half or full size display sizes. To 
manually size the Graphics area, place the mouse cursor over the border between the Graph and 
Report areas until the cursor changes to a double arrow ( ). Then hold down the mouse and 
drag it up or down to resize the areas.  

Tell me more about the Graphics area

Report area Use the Scan Report area to view the current report. The report may include the results of your 
data collection, the method parameters used to collect the results and any graphics you have 
included. You can select the information to include in your report in the Reports tab of the Setup 
dialog. 

To display or hide the Report area, select the Report command from the View menu. Double-
clicking on the Report area enables you to toggle between half or full size display sizes. To 
manually size the Graphics area, place the mouse cursor over the border between the Graph and 
Report areas until the cursor changes to a double arrow ( ). Then hold down the mouse and 
drag it up or down to resize the areas. 

You can copy the generated report onto the Windows clipboard. To do this, highlight the report 
(or a relevant section of it) and press CTRL+C. You can then paste the report into a word 
processor such as Microsoft® Word. 

Hot Tip 
You can edit the Scan Report by pressing CTRL+R or selecting the Edit Report command 
from the Edit menu.

Commands The Scan Application window contains the following commands, all of which can also be 
accessed from the various menus in the application. 
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Getting ready for a run—Scan 
Setup dialog
Setup menu
Cary page
Bio-/Chemi-luminescence and Phosphorescence Options dialog
Gate Time for Bio-/Chemi-luminescence
Gate Time for Phosphorescence
How many flashes?
Options page
About smoothing
Accessories page
Multicell/Temperature accessory
Multicell Changer
Wellplate Reader accessory
Display Options dialog
Wellplate Sample List
Go To Well dialog
Polarizer accessory
Reports page
Report toolbar
Create Report
Clear Report
Label Options
Peak Labels
How to use the advanced reporting options
Auto Store page
How to email the results

Use the Setup dialog to set up your instrument and accessories for a scan. You can also use the dialog to set up the 
Analysis, Report and Storage parameters associated with the run. 

Click on the buttons to view information about them: 

Hot Tip 
By becoming familiar with these commands (Setup, Zero, Pre-scan, etc.), you can 
remove these buttons from the Scan window. This will enlarge the Graphics and Report 
areas and make it easier to view results. To do this, clear the Buttons item in the View 
menu. 

Menus The Scan Application contains the following menus: 
File, Edit, View, Commands, Setup, Help

 
See also: 
Status Display 
Status Line 
Keyboard function keys 
Scan Home Page

Setup—Scan 
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The dialog comprises the following tabbed pages:  

Cary
Options
Accessories
Reports
Auto Store

Use the Setup menu to access the parameters for setting up a Scan. 

Instrument Setup | Scan Setup | 3-D Mode | Scan Control | Status Display 

Use the Cary page to set up the instrument parameters associated with the data collection. 

To access the Cary page, select the Cary command from the Setup menu. You can also access the page from the 
Setup dialog, by selecting the Cary tab. To access the Setup dialog, select the Setup button from the Scan 
Application window or the Setup command from the Setup menu. 

Instrument setup 

To access the Setup dialog select the Setup button from the Scan Application window or the Setup 
command from the Setup menu.

See also:
Scan Application window

Setup menu—Scan 

Command What it does…
Setup Choose Setup to display the Setup dialog where you can set up your instrument for a Scan 

measurement. The Setup dialog can also be accessed from the Setup command button.
Instrument Choose Instrument to display the Cary page. You can use this page to set up the instrument 

parameters associated with the data collection.
Options Choose Options to display the Options page where you can set up your filters and set the 

detector voltage. You can also use this page to select the way the collected data is displayed in the 
Graphics area, and the type of smoothing applied (if any).

Accessories Choose Accessories to display the Accessories page. You can use this page to set up the 
accessory parameters associated with the data collection.

Reports Choose Reports to display the Reports page. You can use this page to set up the report 
parameters associated with data collection.

Auto Store Choose Auto Store to display the Auto Store page where you can specify if and when data will 
be stored, and in what format.

See also: 
Setup  
Cary  
Options  
Accessories  
Reports  
Auto Store 

Cary—Scan 
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Scan Setup 

Data Mode Select from one of the following three data modes: 

Fluorescence 
Fluorescence refers to the emission of light from an excited single state. The fluorescence 
signal is measured when the lamp flashes. 

Bio-/Chemi-luminescence 
Bio-/Chemi-luminescence refers to bio- or chemi-luminescence, where the emission is 
generated via a chemical or biochemical reaction. 

Phosphorescence 
Phosphorescence refers to the emission of light from an excited triplet state. 
Phosphorescence is measured after the lamp has stopped flashing. 

Options Select Options to open the Bio-/Chemi-luminescence/Phosphorescence Options dialog 
where you can set parameters such as the Decay, Delay and Gate times for your sample. 

This Options button is only visible if you have selected Bio-/Chemi-luminescence or 
Phosphorescence as the Data Mode. 

Scan Mode Select from one of the following three scan modes: 

Excitation 
Select Excitation to perform an excitation scan, which is a qualitative absorption spectrum. 
During the scan, the emission monochromator is set to a fixed wavelength and the 
excitation monochromator is scanned over a wavelength range. This is often referred to as 
the emission spectrum or the fluorescence spectrum. 
This option is not available if you have selected Bio-/Chemi-luminescence as the Data 
Mode. 

Example of an emission spectrum 

Emission 
Select Emission to perform an emission scan. During the scan, the excitation 
monochromator is set to a fixed wavelength and the emission monochromator is scanned 
over a wavelength range. This results in a fluorescence excitation spectrum. 

Example of an excitation spectrum 

Synchronous 
Select Synchronous to scan the excitation and emission monochromators synchronously 
with a fixed delta (which is a real number and may be zero), between both 
monochromators. Delta may be entered in wavelength (nm) or wavenumber (cm-1) for the 
scan performed. 
This option is not available if you have selected Bio-/Chemi-luminescence as the Data 
Mode.  

Example of a synchronous scan 

X Mode To set the X axis data display, select from the following options, which are accessible from 
the drop down menu: 

Angstroms
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Wavelength
Wavenumber
Electron volts

This option is not available if you have selected Synchronous as the Scan Setup mode. 

Start Enter the value (in angstroms, wavelength, wavenumber or electron volts) at which you 
want the Cary Eclipse to start to collect data. 

If you have selected Excitation as the Scan Setup mode, the Start value refers to the 
excitation monochromator. 

If you have selected Emission as the Scan Setup mode, the Start value refers to the 
emission monochromator. 

If you have selected Synchronous as the Scan Setup mode, the Start value refers to the 
excitation monochromator. Note that the emission monochromator always starts at a higher 
wavelength than the excitation monochromator (Start + Delta). 

Stop Enter the value (in angstroms, wavelength, wavenumber or electronvolts) at which you 
want the Cary Eclipse to stop collecting data. 

If you have selected Excitation as the Scan Setup mode, the Stop value refers to the 
excitation monochromator. 

If you have selected Emission as the Scan Setup mode, the Stop value refers to the 
emission monochromator. 

If you have selected Synchronous as the Scan Setup mode, the Stop value refers to the 
excitation monochromators. Note that the emission monochromator always ends at (Stop + 
Delta). 

Emission/ 
Excitation/ Delta 

Depending upon the Scan Setup mode selected, of the following options is displayed. 
These options are not available if you have selected Bio-/Chemi-luminescence as the Data 
Mode. 

Emission 
This option is displayed if you select Excitation as the Scan Setup mode. Enter the value  
that the Excitation monochromator will be set to. 

Excitation 
This option is displayed if you select Emission as the Scan Setup mode. Enter the value 
that the Emission monochromator will be set to. 

Delta 
This option is displayed if you select Synchronous as the Scan Setup mode. Enter the 
Delta in wavelength (nm) or wavenumber (cm-1). This enables you to set a fixed difference 
between the wavelength (or wavenumber) at which the excitation and emission 
monochromators will be synchronously scanned. The Delta range is 0–500 nm (or -
7575.76–   wavenumbers). If Delta is set to zero, both monochromators will be scanned at 
the same wavelength (or wavenumber).  

Zero order When Excitation is selected as the Scan Setup mode, select this command to set the 
Emission monochromator to zero order (white light). 

When Emission is selected as the Scan Setup mode, select this command to set the 
Excitation monochromator to zero order (white light).  
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3-D Mode

The 3-D Mode options are not available if you have selected Bio-/Chemi-luminescence as the Data Mode. 

This option is not available if you have selected Synchronous as the Scan Setup mode. 

Excitation Slit Set the slit width of the excitation monochromator. This option is not available if you have 
selected Bio-/Chemi-luminescence as the Data Mode. 

As a general rule: 
At a fixed emission slit width, increasing the excitation slit width will result in an increase 
in the fluorescence excitation intensity. 

Emission Slit Set the slit width of the emission monochromator. 

As a general rule: 
At a fixed excitation slit width, a two-fold increase in the emission slit width will result in a 
four-fold increase in the emission intensity. Accordingly, a two-fold decrease in the 
emission slit width will result in a four-fold decrease in the emission intensity. 

Ex/Em/Delta Stop Depending upon the Scan Setup mode selected, of the following options is displayed: 

Em Stop 
This option is displayed if you select Excitation as the scan mode. Enter the stop 
wavelength of the Emission monochromator (in angstroms, wavelength, wavenumber or 
electron volts). The number of scans performed is equal to the [(Excitation stop - 
Excitation)/(Excitation increment) + 1]. 

Ex Stop 
This option is displayed if you select Emission as the scan mode. Enter the stop 
wavelength of the Excitation monochromator (in angstroms, wavelength, wavenumber or 
electron volts). The number of scans performed is equal to the [(Emission stop - Emission)/
(Emission increment) + 1]. 

Delta Stop 
This option is displayed if you select Synchronous as the scan mode. Enter the Delta Stop 
value in cm-1 or nm. The Delta will be incremented after each scan by the value entered in 
the Delta Increment field until the Delta Stop value is reached. Therefore, the number of 
scans performed is equal to the [(Delta stop - Delta)/(Delta increment) + 1]. 

Ex/Em/Delta 
Increment 

Depending upon the Scan Setup mode selected, of the following options is displayed: 

Em Increment 
This option is displayed if you select Excitation as the data mode. Enter the step, in nm, 
that the Emission monochromator moves prior to the next scan. For example, if you 
perform an excitation scan from 400–600nm with an emission wavelength of 350 nm, and 
an emission increment of 10 nm, then the next scan will be performed with an emission 
wavelength of 360 nm between 400–600nm. This is repeated until the Emission Stop 
wavelength is reached. 

Ex Increment 
This option is displayed if you select Emission as the data mode. Enter the step, in nm, that 
the Excitation monochromator moves prior to the next scan. For example, if you perform 
an emission scan from 400–600nm with an excitation wavelength of 350 nm, and an 
excitation increment of 10 nm, then the next scan will be performed with an excitation 
wavelength of 360 nm between 400–600nm. This is repeated until the Excitation Stop 
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Scan Control 

wavelength is reached. 

Delta Increment 
This option is displayed if you select Synchronous as the data mode. Enter the Delta 
Increment, in nm or cm-1. When you perform a series of synchronous scans, you can 
increment the Delta after each scan by the amount entered in this field. Both 
monochromators are scanned from the Start wavelength to the Stop wavelength and the 
Delta will be incremented until the Delta Stop has been reached.  

Examples of Excitation, Emission and Synchronous 3D collects 

Speed These Speed options are only available if you have selected Angstroms or Wavelength as 
the X Mode. 

Slowest, Slow, Medium, Fast, Fastest, Survey 
These buttons control the speed at which the Cary Eclipse moves. They are available if you 
select an X Mode of Angstroms or Wavelength, and will automatically assign the values 
for the Scan rate, Averaging time and Data interval parameters. Click on the links below to 
view these preset values. 

Angstroms  

Wavelength (nm) 

Manual 
Select Manual to precisely set the Cary Eclipse data collection. Use the Scan Rate, 
Averaging Time and Data Interval fields (which are inter-related) to do this. Note that 
setting a value in one field may affect one or both of the others. 

Scan rate Scan rate Averaging time Data interval
Slowest 300 A/min 1.0000 s 5.0000 A
Slow 1200 A/min 0.5000 s 10.000 A
Medium 6000 A/min 0.1000 s 10.000 A
Fast 12000 A/min 0.1000 s 20.000 A
Fastest 96000 A/min 0.0125 s 20.000 A
Survey 240000 A/min 0.0125 s 50.000 A

Scan rate Scan rate Averaging time Data interval
Slowest 30.000 nm/min 1.0000 s 0.5000 nm
Slow 120.000 nm/min 0.5000 s 1.0000 nm
Medium 600.000 nm/min 0.1000 s 1.0000 nm
Fast 1200.000 nm/min 0.1000 s 2.0000 nm
Fastest 9600.000 nm/min 0.0125 s 2.0000 nm
Survey 24000.000 nm/min 0.0125 s 5.0000 nm

Scan Rate This sets the rate at which the fluorescence spectrophotometer scans the abscissa or X axis. 
As the Scan Rate and Data Interval values are inter-dependant, when you adjust the Scan 
Rate, the Data Interval will be adjusted accordingly. Therefore you can either set the Scan 
Rate manually or set the Data Interval rate and allow the software to calculate the 
corresponding Scan Rate. 
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Status Display 

Select this check box to display the Status Display window where you can view the status of various parameters 
during the data collection. 

The Scan Rate field will be unavailable in the following circumstances:  

You have selected Bio-/Chemi-luminescence or Phosphorescence as the Data
Mode. In this case, the Scan Rate will be dependant on the values set for the
Averaging Time and Data Interval, and will be adjusted accordingly.
You have selected Wavenumber or Electron Volts as the X Mode. In this case, the
Scan Rate will be dependant on the values set for the Averaging Time and Data
Interval, and will be adjusted accordingly.
You have selected one of the Speed settings (Slowest, Slow, Medium, Fast, Fastest,
Survey). As a result, the Scan Rate will be preset, depending upon the setting you
have chosen.

Averaging Time Enter the signal averaging time to be used during data collection. The way in which the the 
Averaging Time is calculated depends upon the Data Mode you have chosen.  

Fluorescence 
In Fluorescence mode, the data point at each wavelength will be an average of the signals 
from a number of flashes that occur during this averaging time, that is: Averaging 
Time/0.0125. The range is 0.0125–1000 s. 

Phosphorescence 
In Phosphorescence mode, the data point at each wavelength will be the average of the 
signals from a number of gate time measurements that occur during this averaging time, 
that is: Averaging Time/Gate Time. These signals are accumulated from successive decay 
curves so that the actual time taken to generate a point at a single wavelength will be 
approximately: (Averaging Time/Gate Time x Total Decay Time). In phosphorescence 
mode, the Averaging Time ranges from the Gate Time to a maximum of 1000 s. 

For bio-/chemi-luminescence: 
In Bio-/Chemi-luminescence mode, the data point at each wavelength will the average of 
the signals from a number of gate time measurements that occur during this averaging time, 
that is: Averaging Time/Gate Time. In bioluminescence mode, the Averaging Time ranges 
from the Gate Time to a maximum of 1000 s. 

Understanding Average Time and Gate Time for Phosphorescence  

Note 
While Scan Rate, Averaging Time and Data Interval are all inter-related, Averaging 
Time is the dominant field, and entering a new Averaging Time will, first cause the 
Speed (Scan rate) to change, and then the Data Interval, if the previously set Speed 
(Scan rate) cannot compensate for the new Averaging Time. 

Data Interval Enter the value at which to collect and display a data point. This value determines the size 
of the steps between each data point in the X range. The smaller the interval, the more 
detail there will be in the collected traces. Therefore, to obtain a plot with high resolution, 
you should set a small interval. With a large interval, the data points will be far apart and 
the scan will be completed more quickly. 

See also: 
Scan Application window 
Bio-/Chemi-luminescence/Phosphorescence Options  
Accessories 
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Dialog controls | Example of the options

Use the Bio-/Chemi-luminescence/Phosphorescence Options dialog to set up the parameters associated with these 
two measurement modes. 

To access the Bio-/Chemi-luminescence/Phosphorescence dialog, select the Options button from the Cary page. 

Dialog controls 

The Bio-/Chemi-luminescence/Phosphorescence Options dialog comprises the following options: 

Individual Data and Overlay Data options 
Status Display window 

Bio-/Chemi-luminescence/Phosphorescence Options—
Scan 

Note 
The Options button is only visible on the Cary page if you have selected Bio-/Chemi-luminescence or 
Phosphorescence as the Data mode.

Total decay 
time 

Enter, in seconds, the total decay time for your sample. The total decay time is the time that it 
takes for the phosphorescence signal to decay to dark levels (zero). The lamp will not flash again 
until the total decay time has elapsed. 
The range is 0.001–1800.000 s. 

Note 
This option is not available in Bio-/Chemi-luminescence mode.

No. of flashes Enter the number of lamp flashes required, which is how many times the lamp flashes 
consecutively before the delay time is counted. 

If you are measuring phosphorescence samples that have a relatively long decay time (that is, a 
number of seconds), you can setup the Cary Eclipse to pulse the lamp multiple times, as this will 
increase the intensity of the phosphorescent signal. For short lived phosphorescent samples, 
multiple flashes will not impact on the intensity of the signal, and therefore only one flash is 
required. 

How many flashes should I perform? 

Note 
This option is not available in Bio-/Chemi-luminescence mode.

Delay time Enter, in milliseconds, the delay time for your sample. The delay time is the time that elapses 
between the last flash and the beginning of data collection. The default value is 0.100 ms. Setting 
a delay time ensures that there is no lamp effects in the phosphorescence decay curve. 
The range is 0.000–5000.000 s. 

Note 
This option is not available in Bio-/Chemi-luminescence mode.

Gate time Enter, in milliseconds, the gate time for your sample. The gate time is the overall reading time of 
the emission signal. 
The range is from 10µs–10s 

Understanding Average Time and Gate Time for Phosphorescence scans  
Understanding Gate Time for Bio-/Chemi-luminescence scans 
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Example of the Bio-/Chemi-luminescence/Phosphorescence Options

Understanding Gate Time for Bio-/Chemi-luminescence scans—Scan 
Gate Time is set on Options page, which is accessible from the Cary page. 

The following diagram highlights the Gate Time setting. 

The Gate Time is set to 10 and the Intensity is equal to IT.

See also: 
Cary page 
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Understanding Average Time and Gate Time for Phosphorescence 
Scans—Scan 
For Phosphorescence scans, there is a relationship between Average Time (the time for which data is averaged) and 
Gate Time (the overall reading time of the emission signal).  

Averaging is calculated as follows: 

The data point at each wavelength will be the average of the signals from a number of gate time measurements that 
occur during this averaging time, that is: 
Averaging Time/Gate Time 

These signals are accumulated from successive decay curves so that the actual time taken to generate a point at a 
single wavelength will be approximately: 
(Averaging Time/Gate Time x Total Decay Time) 

In phosphorescence mode, the Averaging Time ranges from the Gate Time to a maximum of 1000 s. 

See also: 
Understanding Average Time and Gate Time for Phosphorescence scans  
Scan Application   
Cary page  
Options dialog 

Note: 
Gate Time is not used if you select Fluorescence as the Data Mode. 
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Average Time is set on the Cary page of the Setup dialog. Gate Time is set on Options page, which is accessible 
from the Cary page. 

The following diagrams highlight the relationship between Average Time and Gate Time. 

Example 1 

When the Average Time and Gate Time are set to the same value: 

where: 

Example 2 

When the Average Time is set to three times the Gate Time: 

Average Time/Gate Time 1

Intensity
1 (Area IA,
IB)

Total Decay Time 40 ms
Delay Time 10 ms
Average Time 20 ms
Gate Time 20 ms

Average Time/Gate Time 3
Intensity (Area IA) 1A1 + 1A2 + 1A3 

_____________ 
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where: 

 3 

Intensity  (Area IB) 1B1 + 1B2 + 1B3 
_____________ 

 3 

Total Decay Time 40 ms
Delay Time 10 ms
Average Time 60 ms
Gate Time 20 ms
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How many flashes should I perform?—Scan 
The Number of Flashes option is set in the Bio-/Chemi-luminescence/Phosphorescence Options dialog. To access 
the dialog, select the Options button from the Cary page. 

If you are measuring phosphorescence samples that have a relatively long decay time (that is, a number of seconds), 
you can setup the Cary Eclipse to pulse the lamp multiple times, as this will increase the intensity of the 
phosphorescent signal (refer to Example 1, below). For short lived phosphorescent samples, multiple flashes will not 
impact on the intensity of the signal, and therefore only one flash is required (refer to Example 2, below). 

Example 1 
The above example shows that the sample does not decay before the instrument lamp flashes again. Therefore setting 
multiple flashes will result in an increase in the intensity of the signal. 

Example 2 
The above example shows that the sample decays in less time than the time it takes the instrument to flash the lamp 
again. Therefore, setting more than 1 flash, in the No. of Flashes field will not increase the intensity of the signal. 

See also: 
Understanding Gate Time for Bio-/Chemi-luminescence scans  
Scan Application  
Cary page 
Options dialog 

Note 
The Options button is only visible on the Cary page if you have selected Bio-/Chemi-luminescence or 
Phosphorescence as the Data mode.

See also:   
Bio-/Chemi-luminescence/Phosphorescence Options
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Display Options | S/N or CAT mode | Cycle mode | Smoothing | Excitation filter | Emission filter | PMT Detector voltage | Corrected spectra
| Status display 

Use the Options page to set up your filters and set the detector voltage. You can also use this page to select the way 
the collected data is displayed in the Graphics area, and the type of smoothing applied (if any). 

To access the Options page, select the Options command from the Setup menu. You can also access the page from 
the Setup dialog, by selecting the Options tab. To access the Setup dialog, select the Setup button from the Scan 
Application window or the Setup command from the Setup menu. 

Options—Scan 

Display Options Overlay traces 
Select this option to superimpose the collected data of each sample in the run in one graph box. If 
you select this option, a graph box is created at the start of the collect in the Graphics area and 
each sample’s data is overlaid in that box as the data is collected. Traces will always be overlaid in 
the same graph, regardless of what accessory is used. 
Clear this option to display all of the traces in individual graphs. 

Y minimum 
Enter the minimum Y value to be displayed on the graph axis during the data collection. 

Y maximum 
Enter the maximum Y value to be displayed on the graph axis during the data collection. 

Note 
This option is not available if you have selected Cycle mode or if you have selected the 
Wellplate on the Accessory page. Display Options for the Wellplate are specified on the 
Wellplate Accessory page.

S/N or CAT 
mode 

Select from one of the following modes. 
Note that the number of scans to be averaged using CAT mode. 

S/N mode 
Select S/N mode to enable signal to noise mode and specify the minimum signal to noise 
performance acceptable during the measurement. 

The Cary Eclipse instrument will control the Averaging Time by waiting at each data point and 
averaging the signal until the value set in the S/N field is obtained. This parameter is useful if you 
have areas of low transmission in your scan and wish to have the same level of 'noise' across the 
whole scan. Using signal-to-noise mode means that you don't have to lengthen the data collection 
time by setting a long Averaging Time for the whole scan range. The instrument will average for 
a short time in the areas where there is high light throughput and longer in the areas where the 
light throughput is less. 

If the S/N cannot be obtained in the set S/N Time out, then the instrument will keep collecting 
data, but the Cary Eclipse will display an error message. (A # will appear next to the intensity 
value.) The S/N Time out should therefore be set to a large number (for example, 10 s) to ensure 
that the S/N is met. 

S/N 
This field sets the signal-to-noise ratio that the Cary needs to achieve before moving to the next 
data collection point.  

Time out 
This sets the time period for which you want the Cary to average the signal in an attempt to reach 
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the ratio set in the Acceptable S/N entry field. If the specified ratio is not met in this time period 
then the instrument will record an error message and continue onto the next data point.  

CAT mode 
Select CAT (Computer Averaging of Transients) mode to average multiple scans. This enables 
better signal to noise ratios to be obtained. If this mode is selected, a series of scans (set in the No. 
of scans field) will be collected and a trace of these scans will be displayed. At the end of each 
scan, the averaging algorithm is applied and the result is updated and stored in the Trace 
Preferences dialog, however individual scans are not stored in this dialog. The standard deviation, 
which is also calculated for each point in the resultant trace, is displayed in the Trace Preferences 
Audit Log.  

You can use CAT mode in conjunction with multiple samples. When it is used with the plate 
reader or multicell holder, the number of scans are collected at each cell/well before moving on to 
the next scan. 

No. of scans 
Enter the number of scans to be used for the CAT. 

Cycle mode Selecting Cycle mode enables you to collect scans as a function of time to determine whether the 
spectrum is changing. (By contrast, the Kinetics application enables you to determine whether a 
single wavelength is changing over time.) When you select Cycle mode the following options are 
enabled: 

No. of scans 
Enter the number of scans to be performed per cell/well. 

Time 
The Time option enables you to set the time interval between each successive scan. If the time 
entered is less than the time required to complete a scan, the scans are performed continuously 
with no delay. 
The time at which each data point is plotted is stored with the trace, so that a post-run 3-D plot of 
Intensity vs wavelength vs time can be generated. The time of the first data point of the trace 
should be displayed in the User Data Form alongside the trace name with the heading of 'Time 
(min)'. 

Smoothing Select Smoothing to apply smoothing to the ratioed intensity signal using the algorithms defined 
below. You can select one of the three types of smoothing that can be performed during a run. 
Only the smoothed trace is displayed during data collection, however the ratioed data is also saved 
with the experiment. 

Smoothing is used to reduce variability in data or noise. If you select smoothing, there will be a 
time delay in displaying data as number of points equal to the filter size need to be collected before 
the first data point can be averaged and displayed. 

Type 

Savitzky-Golay 
Savitzky-Golay smoothing is used to obtain good noise reduction with sharp peaks. However, 
Peak edges can be distorted with rapid intensity changes.  

This algorithm will take the number of Filter points, apply the Savitzky and Golay smoothing 
algorithm  and display the smoothed value at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_SG'. 

Tell me more about Savitzky-Golay smoothing 

Boxcar average 
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Boxcar averaging can be used when the change in intensity is minimal. 

This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_Box'. 

Tell me more about Boxcar averaging 

Moving average 
Moving averaging is recommended for time scans. It provides good noise reduction by improving 
signal to noise levels. 

This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_Mov'. 

Tell me more about Moving average 

Factor 
Enter the Factor (also known as Filter size), which determines the number of points that will be 
used in the smoothing procedures. The higher the Factor (and thus the number of points used), the 
greater the amount of smoothing that will be performed.  

Factors must be odd values. For Boxcar and Moving averages, the range is 3–101. For Savitzky-
Golay smoothing, the range is 5–101.  

Excitation filter Set the excitation filter for the Scan measurement. To do this, select the down arrow to the right of 
the field and select an option from the list. 

A range of filter settings are available: 

Auto 
If you select the Auto option, the filter wheel will be automatically moved to the appropriate 
position for the selected excitation wavelength. It is recommended that you set the filter to Auto 
(which is the default setting).  

Open 
If you select Open no filter is used. 

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 

250–395, 335–620, 550–1110, 695–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you can select 
your filter manually. Otherwise it is recommended that you set the filter to Auto. 

Emission filter Set the emission filter for the Scan measurement. To do this, select the down arrow to the right of 
the field and select an option from the list. 

A range of filter settings are available: 

Open 
If you select Open no filter is used. In order to minimize steps in the spectra, it is recommended 
that you set the filter to Open (which is the default setting).  

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 
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250–395, 295–1110, 360–1110, 430–1110, 550–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you can select 
your filter manually. Otherwise it is recommended that you set the filter to Auto. 

3%T Attenuator 
Select 3%T Attenuator to decrease the fluorescence intensity and thus the amount of light going 
to the emission PMT. This setting is useful for highly fluorescent samples when you are using 
wide slits. 

Auto 
If you select the Auto option, the filter wheel will be automatically moved to the appropriate 
position for the selected emission wavelength.  

PMT Detector 
Voltage 

Set the EHT or sample detector PMT. To do this, select one of the following: 

Low 
Sets the PMT Detector voltage to a pre-defined value of 400 v. Typically you would select this 
setting if you are reading highly emitting samples. 

Medium 
Sets the PMT Detector voltage to a pre-defined value of 600 v. Typically you would select this 
setting if you are reading moderately emitting samples. 

High 
Sets the PMT Detector voltage to a pre-defined value of 800 v. Typically you would select this 
setting if you are reading low emitting samples. 

Manual 
Enables you to enter any PMT voltage in the adjacent Volts field. 

Volts 
Enter the PMT voltage in the adjacent field. Note that this option is only available if you have 
selected Manual as the PMT Detector voltage. 

Tip 
Increasing or decreasing the PMT Detector Voltage by 10% will double or halve the 
fluorescence intensity observed.

Corrected 
spectra 

Select this option to enable the Emission or Excitation spectrum to be corrected. 
If you select this option you will be prompted when you close the Setup dialog to select a spectra 
to collect. To do this, from the Commands menu point to Correction Curves, and then choose 
from the options of Excitation (200…600 nm), Emission (200…600 nm) or Emission (>600 nm). 
The instrument will store the relevant Intensity/Wavelength data in the Varian/Cary Eclipse 
WinFLR/Correction Curves directory on the drive on which the Cary Eclipse software is installed.
The file will be saved as either Excorr.csv, Emcorr_190 to 600.csv or Emcorr_>600.csv, 
depending upon the Correction Curve you have selected. 

The Corrected Spectra option is not available if you have selected Synchronous as the Scan mode
on the Cary page. 

Status Display Select this check box to display the Status Display window, where you can view the status of 
various parameters during the data collection.

See also: 
Scan Application  
Setup  
Accessories  
Trace Preferences  
Status Display 
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About Smoothing—Scan 
Savitzky-Golay | Boxcar average | Moving average 

Smoothing  

Savitzky-Golay 

Savitzky-Golay smoothing is used to obtain good noise reduction with sharp peaks. The equation constants are 
specific to Filter Size. The constants for each filter size are published in the Savitzky-Golay paper (A. Savitzky, 
M.J.E. Golay, Anal. Chem., 36 (1964) 1627). The equation also requires that Filter Sizes entered must be odd values,
between 5 and 101.

Example 

Result 

The first smoothed data point will be: 
(x3, (Y1*a1+Y2*a2+Y3*a3+Y4*a4+y5*a5)/b), 

the next: 
(x4, (y2*a1+y3*a2+y4*a3+y5*a4+y6*a5)/b) …  
(xn-2, sum(yn-4*a1+yn-3*a2+yn-2*a3+yn-1*a4+yn*a5)/b), 

where a1..a5, b are constants defined by Savitzky and Golay. 

Each smoothed point is calculated using the previous and next data points. For this reason, calculations cannot be 
performed on the very first and very last data points in a data set. Hence, smoothed traces will lack the first and last X 
values of the original trace. 

Boxcar average 

Boxcar averaging can be used when the change in intensity is minimal.

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size (Factor) 5

Page 20 of 149Scan Home Page

   



Example 

Result 

The first smoothed data point will be: 
(x3, sum(Y1:y5)/5), 

the next: 
(x8, sum(y6:y10)/5) … (xn-2, sum(yn-4:yn)/5). 

If there are not enough points at the end of the data set to complete the filter size, then these points will be ignored, 
hence, the gap at the end may be larger than the gap in the beginning. 

Moving average 

Moving averaging is recommended for time scans. It provides good noise reduction by improving signal to noise 
levels. 

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size (Factor) 5
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Example 

Result 

The first smoothed data point will be: 
(x3, sum(Y1:y5)/5), 

the next: 
(x4, sum(y2:y6)/5) … (xn-2, sum(yn-4:yn)/5). 

Use the Accessories page to enable you to set up the accessory parameters associated with the data collection. 

To access the Accessories page, select the Accessories command from the Setup menu. You can also access the 
page from the Setup dialog, by selecting the Accessories tab. To access the Setup dialog, select the Setup button 
from the Scan Application window or the Setup command from the Setup menu. 

The Accessories page will vary, depending upon what accessory button you have selected from the following: 

Multicell/Temperature
Wellplate
Polarizer

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size (Factor) 5

Accessories—Scan 

See also: 
Cary  
Scan Application 
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Multicell/Temperature accessories—Scan 
The Multicell/Temperature accessory page is displayed when you select the Multicell/Temperature tab on the 
Accessories page. 

The page comprises the following:  

Multicell Holder 

Select this option to use the Multicell Holder and cells with the Cary Eclipse.  

Temperature Control 

Select Temperature Control to specify the temperature parameters for your analysis. 

Note 
By selecting this accessory you will prohibit the use of some combinations of other accessories that are also 
controlled by the Accessory Controller Board.

Multi-zero If you select Multi-zero, a Multi-zero will be performed when the Zero button is selected in the 
Scan Application window. A reading will be taken at the set Averaging Time at the specified 
wavelengths of one or both monochromators and at every selected cell position. These readings 
will be offset to zero and subsequent readings will have the corresponding offset value subtracted 
from each cell.

Reset Select Reset to drive the Multicell Holder to cell position 1, which is its fully retracted or zero 
position.

Go to cell… Select Go to cell to open the Multi Cell Changer dialog. You can use this dialog to manually 
move the Multicell Holder accessory to a new cell. To do this, simply select the corresponding 
button of the cell you require in the Multi Cell Changer dialog. The Multicell Holder will move 
the selected cell to the measurement position in the sample compartment. 

The Multi Cell Changer dialog is ‘modeless’ which means that it can remain open even once you 
have cleared the Setup dialog. This enables you to use the Rapid Read command to perform a 
reading at the cell specified in the Cell Changer. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse will 
display the intensity reading corrected by the determined zero-offset amount for that cell. 

Note 
You can use this option to check the intensity of a cell or perform a scan at a particular cell.

Note 
The Temperature Control option does not control temperature accessories that are not listed in the Device 
field. For example, if you have selected the Temperature Control option and set the Device to None because 
you have a different temperature control accessory, the Cary Eclipse software will not control that accessory. 
However, it will monitor the temperature and prompt the software to start when the accessory reaches the 
temperature listed in the Temperature field.

Device Select the device that will be used to control the water temperature. 

The options available will depend upon whether or not you have selected the Multicell holder 
option. 

If you have selected the Multicell holder, the 
following Device options will be available for 

If you have not selected the Multicell holder, 
the following Device options will be available 
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Temperature Display 

Select this option to view Temperature Display information in the Status Display window. 
The Temperature Display option is only available if you have selected the Temperature Control option. 

None 
Select this option if you are using a Temperature Control device not listed in this field (for 
example, a third party water bath). Note that the Cary Eclipse software will not control the 
accessory. The software will simply monitor the temperature and prompt the software to start 
when the accessory reaches the temperature listed in the Temperature field. 

PCB 150 Water Bath 
Select this option if you are using the PCB 150 water bath. 

Single cell peltier 
Select this option if you are using the Single cell peltier.  

Temperature controller 
Select this option if you are using the Temperature controller. 

selection: 

Temperature controller
PCB 150 water bath
None

for selection: 

Single cell peltier
PCB 150 Water bath
None

Temperature Set the temperature at which the reaction will be performed. The default value is 20.00° C. 

When you select OK to close the Setup dialog, all buttons in the Scan Application window will be 
disabled until the temperature recorded by the Monitor device is within ± 0.5°C of the temperature 
range. 

If Zero or Start is selected, and the temperature is not within ± 0.5°C of the temperature range, 
then the system will wait for the temperature to fall within the temperature range before continuing 
with the measurement. Whilst waiting for the temperature, there will be a display on the status line 
at the bottom of the Scan Application window giving the current temperature and the elapsed time 
waiting to reach the set temperature. 

Port Select from COM1, COM2, COM3 or COM4. 
This option is only available if you have selected PCB 150 Water bath as the Device.

Monitor Select which device will be used to monitor the reaction temperature. The options in this field will 
change depending on the Device selected. 
Device selected Monitor options available
None Probe 1, Probe 2, Probe 3, Probe 4
PCB 150 water bath PCB 150, Probe 1, Probe 2, Probe 3, Probe 4
Single cell peltier Block, Probe 1, Probe 2, Probe 3, Probe 4
Temperature controller Block, Probe 1, Probe 2, Probe 3, Probe 4

Block/ PCB 150 Select this option to view the temperature of the Block or the PCB 150 in the Status Display 
window. This option is not available if you have selected None as the Device option. 

Note that the PCB 150 option is only displayed if you have selected the PCB 150 Water Bath as 
the Device option without the Multicell holder. 

Probes Select one or more of these options to view the temperature of the Probes in the Status Display 
window.
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Status Display 

Select this check box to display the Status Display window. This window allows you to view the status of various 
parameters during the data collection. 

Multi Cell Changer—Scan 
Use the Multi Cell Changer dialog to manually move the Multicell Holder accessory to a new cell. To access the 
Multi Cell Changer dialog, select the Go to cell button from the Multicell/Temperature Accessories page. 

The dialog comprises the following: 

Wellplate accessory—Scan 
The Wellplate accessory page is displayed when you select the Wellplate tab on the Accessories page. 

The page comprises the following:  

Wellplate reader 

Select this option to use the wellplate reader with the Cary Eclipse. 

See also: 
Multi Cell Changer 
PCB 150 
Cary page  
Scan Application 
Status Display window

Multicell 
changer 

To manually move the Multicell Holder accessory to a new cell, simply select the corresponding  
button of the cell you require in the Multi Cell Changer dialog. The Multicell Holder will move the 
selected cell to the measurement position in the sample compartment. 

The Multi Cell Changer dialog is ‘modeless’ which means that it can remain open even once you 
have cleared the Setup dialog. This enables you to use the Rapid Read command to perform a 
reading at the cell specified in the Cell Changer. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse will display 
the intensity reading corrected by the determined zero-offset amount for that cell. 

Note 
You can use this option to check the intensity of a cell or perform a scan at a particular cell.

See also: 
Multicell/Temperature Accessories 
Rapid Read

Q. Why is the wellplate reader option unavailable?
A. The multicell holder, temperature control and/or polarization accessory has been selected. As you cannot
place any of these accessories and the wellplate reader in the Cary Eclipse sample compartment at the same
time, you must clear other accessory selections before selecting the wellplate reader.

Plate format Select the type of wellplate to be used. The default options are 6 wells, 12 wells, 24 wells, 48 
wells, 96 wells, 192 wells or 384 wells. 
The graphical representation of the wellplate will change according to the number of wells chosen.
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Status Display 

Select this check box to display the Status Display window. This window allows you to view the status of various 
parameters during the data collection. 

Display Options—Scan 
Use the Display Options page to set up the display parameters associated with the Wellplate Reader. 

The Display Options page is accessible from the Wellplate Accessories page by selecting the Display Options 
button. 

Auto-zero Select this option to perform an auto-zero when the Zero button is selected from the Scan 
Application window. A zero reading will be taken at the selected well position using the current 
method setup. To select the well position to be zeroed, use the Select Well option. 

These readings will be offset to zero and subsequent readings will have this single value subtracted 
from each well in the sequence. The reading is taken only once, stored, and subtracted from the 
ratioed intensity reading. 

Select well Choose Select well to open the Go To well dialog where you can select the well position to be 
zeroed. This option is only available if you have selected Auto-zero.

Well Displays the well position of the well selected for auto-zeroing. This field is not editable.
Display options Select this option to open the Display Options dialog where you can set up the display parameters 

associated with the wellplate reader.
Sample names Select Sample Names to open the wellplate Sample List dialog where you can enter or modify 

the sample names. Highlight one or more wells on the wellplate reader diagram to view and 
change their sample information.

Go to well Select this option to open the Go To Well dialog.
Well position Displays the well position that the mouse cursor is pointing to. This field is not editable.
Reset Select Reset to move the wellplate reader to the first well position defined by the read sequence.
Park Select Park to move the wellplate reader to the Park position. The wellplate reader accessory is 

moved clear of the sample compartment to enable you to easily access all wells.
Wellplate 
reader diagram 

The wellplate reader diagram represents the number of wells present for the chosen wellplate 
configuration. 

The labels for the rows will be 1 .. 12 and for the columns A .. H (for a 96 wellplate). Similar 
labels will occur for different wellplates according. The sequence for numbering the read order 
will be from A1 to A12, B12 - B1, C1 - C12…etc for a 96 wellplate. A similar sequence will be 
for other plates.  

To select or clear a single well, simply click or right-click on it. 

To select or clear a block of wells, hold down the left mouse and drag around the block required. 
All wells within the area will be selected or cleared. 

See also: 
Accessories page  
Go To Well dialog  
Display Options dialog  
Wellplate Sample List dialog  
About the Wellplate Reader   
Status Display 
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The page comprises the following: 

Display 

Use the Wellplate Sample List dialog to enter or modify the sample names of each well in the Wellplate reader. 

The Wellplate Sample List is accessible from the Wellplate Accessories page by selecting the Sample Names 
button. 

The page comprises the following: 

Individual 
graphs 

Select this option to display the collected data of each sample in individual graph boxes, rather 
than overlaid on each other in one box. 

At the start of a scan, a separate box is created for each sample. Similarly, the collected data for 
each sample is displayed in a separate graph box. 

Overlay all 
traces 

Select this option to superimpose the collected data of each sample in the run in one graph box. 

One box is created at the start of the collect in the Graphics area and each sample’s data is overlaid 
in that box as the data is collected. 

User defined Select this option if you wish to specify the exact number of traces to be included on one graph. 
Number of traces per graph 
Enter the number of traces to be displayed per graph. 

Overlay rows Select Overlay rows to view overlaid graphs of the wells 
you have selected. Wells in the same row of the wellplate 
reader will be overlaid. If you had selected wells as 
shown in the adjacent diagram, a total of  seven graphs 
would be displayed (as seven rows contain selected 
wells). The first graph would contain overlaid scans of 
well A1 and A6, the second graph would contain a scan 
of well B8, etc.

Overlay 
columns 

Select Overlay columns to view overlaid graphs of the 
wells you have selected. Wells in the same column of the 
wellplate reader will be overlaid. If you had selected 
wells as shown in the adjacent diagram, a total of 11 
graphs would be displayed (as 11 rows contain selected 
wells). The first graph would contain overlaid scans of 
well A1 and D1, the second graph would contain a scan 
of well H2, etc.

See also: 
Wellplate Accessories 

Wellplate Sample List—Scan 

No. of samples Displays the total number of samples that have been selected from the Wellplate Reader diagram 
on the Wellplate Accessories page. This field is not editable.

Sample table The sample table lists the Sample Names and Well numbers of the selected samples. 
Sample Name 
Samples are named numerically, depending upon where they are located on the Wellplate Reader 
diagram. The sequence for numbering the Sample Name order is to read from A1 to A12, B1 to 

Page 27 of 149Scan Home Page



Go To Well—Scan 
You can use the Go To Well dialog to manually move the Wellplate Reader accessory to a new well. This enables 
you to check the intensity of a well or perform a read at a particular well. 

The Go To Well page is accessible from the Wellplate Accessories page by selecting the Select well or Go To Well
button. 

The Go To Well dialog is ‘modeless’ which means that it can remain open even once you have cleared the Setup 
dialog. This enables you to use the Rapid Read command to perform a reading at the selected well. 

If you move to a new well after you have performed a Multi-zero, the Cary Eclipse will display the intensity reading 
corrected by the determined zero-offset amount for that well. 

The page comprises the following: 

B12, C1 to C12…etc for a 96 wellplate. Therefore, if the B2 cell is selected, its corresponding 
Sample Name will be Sample 14. 

To modify the name of a sample, highlight the sample name and type in a new name. You can enter 
up to 20 characters for each name. 

Well 
Displays the position of the well corresponding to the Sample Name. This field is not editable. 

Import names Select Import Names to display the Open dialog which you can use to select a text file to import 
into the Sample Names column. 

How to import sample names into the Wellplate Sample List 
Increment Select Increment to copy and increment the sample names in the Sample Name list. This will save 

you from entering each sample name individually when the names consist of a descriptor followed 
by a number. 

To use the increment option, highlight the name that you want to increment and select Increment. 
The Cary Eclipse will increment the names of all the files proceeding the first highlighted name. 

Example: 
In this example, Sample B1 is highlighted when the Increment button is selected. 

Sample Name Becomes
Samp A  Samp A

 Sample B Sample B1
Sample C Sample B2
Sample D Sample B3
Sample E Sample B4

See also: 
Wellplate Accessories page  
About the Wellplate Reader  
How to import sample names into the Wellplate Sample List 

Wellplate 
reader diagram 

The Wellplate Reader diagram represents the number of wells present for the chosen wellplate 
configuration. 
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Polarizer accessory—Scan 
The Polarizer accessory page is displayed when you select the Polarizer tab on the Accessories page. 

The page comprises the following:  

Polarizer 

Select this option to use the Polarizer with the Cary Eclipse. 

Status Display 

The labels for the rows will be 1 .. 12 and for the columns A .. H (for a 96 wellplate). Similar labels 
will occur for different wellplates according. The sequence for numbering the read order will be 
from A1– A12, B12– B1, C1– C12, etc for a 96 wellplate. A similar sequence will be for other 
plates. 

To move the Wellplate Reader accessory to a new well, simply click on the corresponding well on 
this diagram. The Wellplate Reader will move the selected well to the measurement position in the 
sample compartment. 

To select or clear a single well, simply click or right-click on it. 

To select or clear a block of wells, hold down the cursor and drag around the block required. All 
wells within the area will be selected or cleared. 

X, Y, Well Displays the Well Position that the mouse cursor is pointing to. This field is not editable.
Reset Select Reset to move the Wellplate Reader to the first well position, which is well A1.
Park Select Park to move the Wellplate Reader to the Park position. When the accessory is in the park 

position you have full access to the Wellplate Reader platform. This is useful for inserting or 
removing wellplates from the accessory. 

See also: 
Wellplate Accessory page  
About the Wellplate Reader 

Q. Why is the Polarization option unavailable?
A. The Wellplate accessory has been selected. As you cannot place both the Wellplate accessory and the
Polarization accessory in the Cary Eclipse sample compartment at the same time, you can only select one of
these accessories.

Measurement Select from the following measurement types: Polarization, Anisotropy or Other.
G Factor The G Factor is a value that reflects the polarization bias of the emission monochromator. It is 

dependant upon the emission wavelength. If you do not select the G Factor option, then a G-factor 
value must be collected. If you do select the G Factor option then the value entered is used at the 
emission wavelength in subsequent polarization or anisotropy calculations. 
The G Factor option is not available if you select Other as the Measurement type. 

Determining the G Factor 

A check to see whether there is a valid G Factor that corresponds to the emission wavelength is 
performed when you select OK to exit the Setup dialog. If the G Factor is not valid, the following 
prompt is displayed:  
‘The current G Factor is not valid at the emission wavelength. Press the G Factor button to 
determine a new grating factor.’ 
Select OK to clear this dialog and select the G Factor button from the Scan Application window. 
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Select this check box to display the Status Display window. Use this window to view the status of various parameters 
during the data collection. 

Operator | Options | Peaks | X-Y Pairs Table | Show Status Display 

Use the Reports page to set up the report parameters associated with data collection. 

From the Setup menu, select Reports to access the Reports page. You can also access the page from the Setup 
dialog by selecting the Reports tab. To access the Setup dialog, select the Setup button from the Scan Application 
window. 

The page comprises the following: 

Operator 

Options 

This group enables you to select the information to include in your report. 

See also:  
PCB 150 
Accessories page

Reports—Scan 

Name Enter the instrument operator name in this text entry field. Use the arrow to the right of this field 
to view and select one of the last ten entries in this field. 

Note 
In GLP mode the system will automatically enter the operator’s name and this field will not 
be editable.

Comment Enter operator details and comments in this text entry field.

Auto Print Select Auto Print to print a report automatically during the data collection. 
If Auto Print is selected, then the system will send the report information to the specified printer
(s) as well as the Report area. However if Auto Print is not selected, the report will only be sent to
the Report area and can be viewed by selecting Report in the View menu.

To automatically obtain a copy of the graphics, you will need to select both the Auto Print and 
Graph options (see below). In this case, all graphical information displayed on screen will be 
printed with the report. Therefore it is advisable to arrange the graphical information as you 
require on screen, prior to printing.  
For example, if you require a single graph print out, then the Single/Multi Graph option in the 
Graph menu should be changed to the correct setting. 

Parameters Select this option to include the method setup parameters within your report.
User data form Select this option to include in the report any information entered in the User Data Form.
Graph Select Graph to include any graphs or graphic information associated with your report. 

If you require a printout of the displayed graphics only, you must ensure that only this option is 
selected. Press the Clear Report button to clear any information in the Report area before you 
print otherwise this will be included in your printout. 
% Page Height 
Enter the size at which you want the graph to be printed, as a percentage of total page height. For 
example, if you want graphical information to take up half of the page, enter 50% in this field.

Company Logo Check this option to include your company logo in the report. 
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Peaks 

Use the Peak options to select how the traces will be labeled in your report. 

X-Y Pairs Table

A company logo will only be included if you have added one on the Company page of the  
System Information Application. 

Hot Tip 
If you have not included a Company logo, select the Header/Footer button to open the 
System Information Application and use the Add Logo option to add a logo.

Header/ Footer Select the Header/Footer button to open the System Information application where you can enter 
the Header and Footer information to be included in your report. You can also enter any 
additional comments, and add a logo to your report. Once you have made all your changes, select 
OK to exit the System Information application and return to the Reports page of the Scan 
application.

Focused trace Select this option to apply the Report selections to the focused trace only.
All traces Select this option to apply the Report selections to all visible traces.

Maximum 
Peaks 

Select Maximum to calculate the maximum peak in the trace/s and include the peaks in your 
report.

All peaks Select All to calculate all peaks above the peak threshold in the trace/s and include the peaks in 
your report.

Label peaks Select this if you wish the peaks on the graph to be labeled with the co-ordinates selected in the 
Peak Labels dialog (X and Y, X only, Y only).

Peak type This parameter selects the type of peaks that will be included in your report. Select from the 
following options: 

Peaks 
The Cary Eclipse will report maximum points only. A peak is defined by a maximum in the first 
derivative. 

Valleys 
The Cary Eclipse will report minimum points only. A valley is defined by a minimum in the first 
derivative. 

Peaks Valleys 
The Cary Eclipse will report both maximum and minimum points.  It is mainly used in odd 
number derivatives where the X intercept defines a peak.  

Zero Cross 
The Cary Eclipse will report the points at which the trace crosses over the zero ordinate line. A 
zero-crossing peak type is where the continuum crosses the X axis, that is at Y=0. This choice is 
useful for odd derivative scans calculated in the Maths window. For example, the zero crossing 
points of a first derivative scan correspond to the peaks and valleys in the trace.  

Threshold Enter the Threshold value, which is the value that defines what peaks/valleys will be displayed in 
the report. The difference in intensity between a valley, the highest peak and the adjacent valley is 
measured and, if this difference is greater than the threshold it is reported on the trace.

Label options Select this option to open the Label Options dialog where you can select how the labels will be 
displayed in the report.
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Select this if you want to print a table showing the X-Y pairs of the collected data in your report. 

Status Display 

Select this check box to display the Status Display window, where you can view the status of your instrument during 
the data collection. 

Report Toolbar—Scan 
Use the Report toolbar buttons to gain quick access to many of the Edit menu options. You can also use the toolbar to 
cut, copy and paste information and to change the look of your report. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Reports. To display or hide 
the toolbar's text labels, point to the Toolbar option in the View menu and select Text Labels. 

The following commands can be accessed from the Reports Toolbar: 

Data Interval Actual 
Select Actual to report the X-Y pairs table for the trace at the actual Data Interval at which the 
data was collected. 

Interpolated 
Select Interpolated to report the X-Y pairs table for the trace at an interpolated data interval. 
Enter this data interval in the adjacent field. If no data has been collected at the interval you enter, 
the Cary Eclipse software will interpolate the data to produce an X-Y result. 

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, Microsoft Word 
or Microsoft Excel) into the report area of the of the Lifetimes application. To edit these objects, simply 
double click on them to open the associated application in which they were created. 

See also: 
Scan Application   
View menu  
User Data Form  
Single/Multi Graph 
Peak Labels  
Label Options dialog  
Maths window 

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Edit Report Click this button to edit the report. 
This command is also accessible by pressing CTRL+R.

Undo If available, this undoes the last action. 
This command is also accessible by pressing CTRL+Z.

Cut Click this button to remove the highlighted text and place it on the Windows Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Click this button to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.
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Create Report—Scan 
Select the Create Report button to access Report options. 

The Create Report button is accessible from the Scan Application window. When you select this option, the Setup 
dialog will appear, containing the following page:  

Reports

Clear Report—Scan 
Select Clear Report to remove the contents of the Report area. If you have saved the report, selecting this option 
does not delete the contents of the report, the information is simply removed from the Report Area. 

You can select the Clear Report button from the Scan Application window or the Clear Report command from 
Commands menu.  

Label Options—Scan 
Use the Label Options dialog to select how labels will be displayed in the report. To access the Label Options 
dialog, select Label Options from the Reports page of the Setup dialog. 

The dialog comprises the following: 

Paste Click this button to insert the contents of the Windows Clipboard (text only) at the cursor. 
Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Click this button to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
This option is only available once you select Edit Report and there is text highlighted 
in the Report area. 

Font Click this button to change the font of new or selected text in the report. For existing text, 
simply highlight the text in the report, select this button and make your changes in the Font 
dialog. When you select OK, the appearance of the highlighted text in the report will alter 
to reflect your font changes. 
This command is also accessible by pressing CTRL+F.

Preview Click this button to display the Print Preview dialog where you can view the current report 
as it will be printed.

See also:
Scan Application window
Setup

See also: 
Scan Application 
Commands menu

X and Y 
Labels 

Select this if you wish the peaks on the graph to be labeled with both the X and Y co-ordinates.

Y Label Select this if you wish the peaks on the graph to be labeled with only the Y co-ordinates.

X Label Select this if you wish the peaks on the graph to be labeled with only the X co-ordinates.
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Peak Labels—Scan 
Use the Peak Labels dialog to set up the peak information that will be included in your report. 

From the Graph menu, select Peak Labels to access the dialog. Note that this option is only available when a trace 
is visible. 

The dialog comprises the following: 

Text 
orientation 

Use the slider bar underneath the graph to select the position of the label on the graph. This 
option is not available if you have selected No Labels.

Y Decimals Use this option to select the number of decimal places to appear in your Y co-ordinates.

X Decimals Use this option to select the number of decimal places to appear in your X co-ordinates.

Font Select Font button to access the Font dialog where you can set the size and style of the text that 
will appear on the labels. This option is not available if you have selected No Labels.

Hot Tip 
The selections you make in the Peak Labels dialog are applied to the selected graph(s). To select multiple 
graphs, hold down the CTRL key and select the graphs. You can also use the SHIFT key to select a range of 
graphs. When the shift key is held down, all graphs in between the first and last graph chosen are selected. 

Peak Style This parameter selects the type of peaks that will be reported by the Cary Eclipse software. Select 
from the following options: 

Peaks 
The Cary Eclipse will report maximum points only. 

Valleys 
The Cary Eclipse will report minimum points only. 

Peaks Valleys 
The Cary Eclipse will report both maximum and minimum points. 

Zero Cross 
The Cary Eclipse will report the points at which the trace crosses over the zero ordinate line. A 
zero-crossing peak type is where the continuum crosses the X axis, that is at Y=0. This choice is 
useful for odd derivative scans calculated in the Maths window. For example, the zero crossing 
points of a first derivative scan correspond to the peaks and valleys in the trace.  

Note 
When determining Peaks, Valleys or Peaks Valleys the Cary Eclipse software nominates 
the highest data point of a peak as the peak position and the lowest data point of the valley 
as the valley point. It does not interpolate between points. Thus, if your data points are 
relatively far apart (large Data Interval), the reported peak or valley may not be entirely 
accurate. 

However, when you use the zero crossing points to calculate the peak and valley positions, 
the data is interpolated and a more accurate peak position may be obtained. 

Hot Tip 
Taking a first derivative of a noisy scan will reduce the noise and assist in locating the 
peaks more accurately.

Threshold Enter the Threshold value, which is the value that defines what peaks/valleys will be displayed. 
The difference in intensity between a valley, the highest peak and the adjacent valley is measured 
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How to use advanced reporting options—Scan 
This outlines ways to fully customize your reports. Options available include: 

Including header and footer information
Including a logo
Editing the text in the report
Viewing the report on screen before printing
Cutting and pasting to a word processor

Including header and footer information 

You can have text appearing at the top and bottom of every page in your report. To specify what the text should be, 
do the following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then select System 
Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter the header and footer information in the Header and Footer fields.

and, if this difference is greater than the threshold it is reported on the trace. To include 
Peaks/Valleys in your reports, ensure that you have the Label Peaks option selected on the 
Reports page of the Setup dialog. 

See also: 
Peak Picking

Maximum Select Maximum to calculate the maximum peak in the trace/s. Select one of the  Label options 
(X and Y labels, Y label, X label) to display the maximum peak on the trace. To include the 
maximum peak in your report, ensure that you have the Maximum Peaks option selected on the 
Reports page of the Setup dialog.

All Select All to calculate all peaks above the peak threshold in the trace/s. Select one of the Label 
options (X and Y labels, Y label, X label) to display the maximum peak on the trace. To include 
the maximum peak in your report, ensure that you have the All Peaks option selected on the 
Reports page of the Setup dialog.

X and Y 
Labels 

Select this if you wish the peaks on the graph to be labeled with both the X and Y co-ordinates.

Y Label Select this if you wish the peaks on the graph to be labeled with only the Y co-ordinates.

X Label Select this if you wish the peaks on the graph to be labeled with only the X co-ordinates.

No Labels When selected, no peaks will be labeled with co-ordinates. 

Position Use the slider bar underneath the graph to select the position of the label on the graph. This 
option is not available if you have selected No Labels.

Y Decimals Use this option to select the number of decimal places to appear in your Y co-ordinates. This 
option is not available if you have selected No Labels.

Font Select the Font button to access the Font dialog where you can set the size and style of the text 
that will appear on the labels. This option is not available if you have selected No Labels.

See also: 
Maths window  
Maths How To  
Reports 
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Step 3 

Click OK to implement your changes. 

Including a logo 

You can include a logo on the first page of your report. To specify what the logo should be, do the following: 

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then select System 
Information. The System Information application appears with the Company page displayed. 

Step 2 

Enter a logo using the Add Logo button. This logo will always be included on the front page of reports. 

Step 3 

Click OK to implement your changes. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can then add, delete 
and change text in the Report area. 

Viewing the report on the screen before printing 

You can view a report before printing it. To do this, from the File menu select Print Preview. You can then ensure 
that the report format is correct before you print it. 

Cutting and pasting to a word processor 

To have complete control over how your report looks you may wish to copy it to a word processor program, such as 
Microsoft Word. To do this: 

Step 1 

Open a report. 

Step 2 

From the Edit menu, choose Edit Report. 

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application.

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The Administrator
of the system will have to change your privileges before you can edit reports.

Hot Tip 
Use the arrow keys at the bottom of the Print Preview screen to change pages.
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Step 3 

Click in the Report area and highlight the text you want to export to your word processor. 

Step 4 

Right-click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text into a 
document. 

Storage | Auto convert | Email | Status display 

Use the Auto store page to specify if and when data will be stored, and in what format. You can also use this page to 
set up the system to automatically send an email at the end of a read. 

To access the Auto store page, select the Auto store command from the Setup menu. You can also access the page 
from the Setup dialog, by selecting the Auto store tab. To access the Setup dialog, select the Setup button from the 
Scan Application window or the Setup command from the Setup menu. 

The page comprises the following: 

Storage 

Auto convert 

Use the Auto convert options to convert your data into an ASCII file format that can be opened in spreadsheet 
programs such as Microsoft Excel. 

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to alter the look of your graphs 
How to display a trace that is not appearing

Auto store—Scan 

Off Select this if you do not wish to be automatically prompted to save collected data. 
Note 
If you wish to store your unsaved data manually, choose Save Data As… from the File 
Menu to save your data after the run is complete. You can save your data as a Batch or Data 
file.

On; prompt at 
start 

Select this to display the Windows Save as dialog at the start of the collect where you can enter 
the Batch filename for your data.

On; prompt at 
end 

Select this to display the Windows Save as dialog at the end of a collect where you can enter the 
Batch filename for your data.

None Select None if you do not need to generate an ASCII file.
ASCII (csv) Select this option to save the data as a comma delimited ASCII Spreadsheet file (*.CSV) file. Only 

the currently collected data is converted. 

ASCII files are stored in the same folder as the data file from which they were generated and 

Page 37 of 149Scan Home Page



Email 

Select the Email check box and enter the Email details to send an email to a person once the read is completed. This 
useful facility can be used to alert you to the completion of the read, particularly if you are working away from the 
laboratory where the Cary Eclipse instrument is. You can also attach the collected data to the email. 

Status display 

Select this check box to display the Status display window, where you can view the status of your instrument during 
the data collection. 

How to email your results—Scan 

designated the same filename as the method used to collect the data plus the extension ‘CSV’. 
ASCII (csv) 
with log 

Select this option to save the data as a comma delimited ASCII Spreadsheet file (*.CSV) file. Only 
the currently collected data is converted. The key method parameters used to collect the data are 
also saved in this file. 

ASCII files are stored in the same folder as the data file from which they were generated and 
designated the same filename as the method used to collect the data plus the extension ‘CSV’. 

Note 
If you choose to auto-convert the data to an ASCII file but you have set the Storage option 
to Off, then the ASCII file will be saved with the following format: 
DATE TIME. CSV 

The date and time will appear in the same form that is set in the Windows Regional Settings 
Properties dialog that is accessed from the Windows Control Panel. 

For example, 22_4_97 1;32;08.CSV 

Tell me more about ASCII Spreadsheet Files 

Note 
You must set up the email Host and Port options on the Email options page of the System Information 
application in order for the email facility to work correctly.

To Enter the recipient's email address. You can enter more than one recipient in this field.
From Enter your email address (or the email address associated with the computer on which the Cary 

Eclipse software is installed.
Subject Enter the subject of your email (or leave this field blank if you do not wish to include a subject).
Cc Enter the email address of any recipient you want to copy the email to.
Message Enter your message.
Attached… Use the Attached button include a file attachment in your email. To do this, select Attached and 

browse your computer to select a file, using the Windows® Open dialog that appears.
Attach current 
data 

Select this option to attach the data that has been collected during the run to the email.

How to email your results  

See also: 
Scan Application  
Save As dialog   
Status Display 
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You may wish to send an email to a person once the read is completed. This useful facility can be used to alert you to 
the completion of the read, particularly if you are working away from the laboratory where the Cary Eclipse 
instrument is. 

To do this: 

Step 1 

Ensure that you have set up the Host and Port options on the Email options page of the System Information 
application in order for the email facility to work correctly. 

Step 2 

From the Setup menu, select Auto Store. The Auto Store page is displayed. 

Step 3 

Select the Email check box to enable the email options. 

Step 4 

In the To field, enter the recipient's email address (for example, rchandler@varianinc.com). To enter multiple 
recipients, simply type a comma ',' between each email address. 

Step 5 

In the From field, enter the email address of the computer on which the Cary Eclipse software is installed. This may 
be your email address, or a communal email address, if the Cary Eclipse software is installed on a computer that has 
multiple users. 

Step 6 

Enter information in the Subject and Message fields as required. 

Step 7 

Select Attach current data. The data that has been collected during the run will be attached to the email. 

Step 8 

Select OK to clear the Auto Store dialog. Your email will be sent once the run has been completed. 

Performing scans—Scan 
Starting a scan
Sample Name dialog

Hot Tip 
You can attach other documents to your email. To do this, select the Attached button and browse your 
computer to select a file, using the Open dialog that is displayed.

See also: 
Auto Store 
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Cell Loading Guide
Sync Start dialog
Start/Stop buttons
Pre-scan dialog
Go To dialog
G-Factor dialog
Rapid Result dialog
Zero dialog
Commands menu
How to perform a fluorescence scan
How to perform a bio-/chemi-luminescene scan
How to perform a phosphorescence scan

Information about starting a scan—Scan 
The sequence that occurs when you select Start to commence the scan depends upon your storage and accessory 
selections. 

Storage selections 

Options selections 

Accessory selections 

If you have selected … as the Storage 
option on the Auto Store page

The following occurs

On, prompt at start The Windows Save As dialog will appear as soon as you select Start. You 
can save the current method, collected data, report and graph template as a 
Batch file.

On, prompt at end The Windows Save As dialog will appear at the end of the data collection. 
You can save the current method, collected data, report and graph 
template as a Batch file.

Off The Windows Save As dialog will not appear.

If you have selected … on the 
Options page

The following is displayed

Cycle mode The Sample Name dialog will appear when you select Start, prompting 
you to load the sample and enter your sample name. Select OK to display 
the Sync Start dialog and commence the kinetics run.

If you have selected … on the 
Accessories page

The following is displayed

No accessories The Sample Name dialog is displayed when you select Start, prompting 
you to load the sample and enter your sample name. Select OK to display 
the Sync Start dialog and commence the kinetics run.

Multicell Holder The Cell Loading Guide dialog is displayed. Enter the sample name of 
each activated cell then select OK to display the Sync Start dialog. 

When you select OK to clear the Cell Loading Guide dialog, the cell 
changer will move to cell position 4, enabling you to easily access all of 
the cell positions and load your samples. 

Wellplate Reader
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Sample Name—Scan 
If you are using a single cell holder, the Sample Name dialog is displayed once you select the Start button to 
commence an analysis. 

The page comprises the following: 

Cell Loading Guide—Scan 
If you are using a Multicell holder, the Cell Loading Guide dialog appears once you click the Start button to 
commence an analysis. 

The Cell Loading Guide dialog prompts you to insert blank samples in the Multicell Holder to collect the scans. You 
can also use the dialog to name the samples in each selected cell in the Multicell Holder.  

The dialog comprises the following: 

Polarizer A sequence of dialogs will display, prompting you to move the Excitation 
and Emission polarizers to specific angles and take readings.

See also: 
Sample Name 
Cell Loading Guide 
Sync Start 
Start/Stop Instrument buttons 
Setup 
Accessories 
Auto Store

Sample Name Enter the name of the sample to be used in the scan run. Click on the arrow to the right of the field 
to view and select the most recently entered sample names. 
Once you have entered the Sample Name, select OK to commence the scan run. 

If you have selected Cycle Mode on the Options page, the the Sync Start dialog will be displayed 
after the Sample Name dialog. In Cycle Mode, the Cary Eclipse will automatically increment the 
Sample Name. 

See also: 
Cell Loading Guide  
Sync Start 

Loading 
Guide/Sample 
Name entry

Enter the names of the sample to be used in the scan run in each available field. This sample name 
will be used as the Name of Trace in the Trace Preferences dialog. 

Note 
The Cell Loading Guide dialog appears only if you have 
selected the Multicell Holder option on the Accessories page 
of the Setup dialog. Only cells selected in the Multicell Holder 
diagram on the Accessories page will be available in the 
Loading Guide. 

In the adjacent example, cells 1—3 will be available in the 
Loading Guide dialog, as they have been selected in the 
Multicell Holder diagram. 
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Sync Start—Scan 
Use the Sync Start dialog to synchronize the start of a reaction and the start of the a scan cycle run. The Cycle mode 
is selected on the Options page of the Setup dialog. 

Before displaying the Sync Start dialog, the Cary Eclipse will set up all the instrument and graphing parameters so 
that data collection can start as soon as the countdown finishes or you select OK. 

The sequence for a Sync Start is as follows:  

Set up your data collection parameters
Select the Start button (and load the samples if necessary)
Once the Sync Start dialog is displayed, add your active reagent
Commence the data collection by selecting the OK button

The Sync Start dialog comprises the following: 

The following buttons may be displayed at the top of the Scan Application. The Start and Connect buttons will 
change depending upon the status of the instrument. For example, if the instrument is ready for a run, the Start button 
will be visible to indicate that the system is ready to commence a run. 

Once you have entered the Sample Name, select OK to display the Sync Start dialog and 
commence the Scan run. 

See also: 
Accessories page 
Sample Name page

Count Down This field displays a two minute countdown in seconds. If you want to start your data collection 
before the two minute countdown ends, select the OK button. Alternatively, you can wait for the 
countdown to end and the data collection will start automatically. 

Note 
If you are using a Multicell Holder and you select OK, the system will automatically reset 
this accessory and immediately start the data collection.

Reset Slide Click this button to drive the Multicell Holder to its zero point (Cell position 1).
See also: 
Cary page  
How to perform a fluorescence scan in cycle mode 

Start/Stop instrument buttons—Scan 

Select Start to commence a scan run using the current Setup parameters. 
If any unsaved data exists in the Graphics area you will be prompted to save the data. If 
you chose not to save, any unsaved data, pictures and labels will be deleted when you start 
the scan.

If another application is already online with the Cary Eclipse, the Start button will change 
to Connect, and you will need to select Connect to bring this application online before the 
Start button will re-appear. (You will not be able to connect if the other application is 
collecting data.)

Select this to end a scan. 
If you have selected Storage On in the Auto Store page of the Setup dialog, all data 
collected is automatically stored in the file specified in the Batch name field of the 
Windows Save As dialog before or after the run commenced. 
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Pre-scan—Scan 
Select Pre-scan to determine the optimum instrument parameters to be used for your sample. At the end of this 
collection sequence the software will report the optimum Ex and Em wavelengths and PMT voltage. Once you are 
satisfied with the parameters, the software will automatically update your method setup to reflect these new 
parameters. 

The Pre-scan dialog comprises the following: 

Type of scatter 

Select he type of scatter you wish to search for from the following: 

Use the Go To Wavelength dialog to temporarily change the instrument to a new excitation or emission wavelength. 
You would mainly use this dialog if you want to quickly go to a wavelength and check the intensity reading of the 
sample. The lamp will flash continuously in this mode. This option is only available if the instrument is not currently 
collecting data. 

To access the Go To Wavelength dialog, select the Go To Wavelength command from the Commands menu. You 
can also select F4 to open the dialog. 

The Go to Wavelength page comprises the following: 

See also: 
Graphics area 
Commands menu

To access the Pre-scan option, select the Pre-scan command from the Graph menu, or select the Pre-
scan button from the Scan Application window.

Rayleigh 
scatter 

Rayleigh scatter refers to the scatter of the excitation light. It is displayed at the peak of the 
excitation wavelength.

Raman scatter Raman scatter refers to scatter due to the solvent. Its peak is at a fixed energy from the excitation 
wavelength, and is solvent dependent. Thus, the type of solvent used must be selected from the 
Solvent list.

2nd order Second order scatter refers to the scatter of higher order excitation light. Its peak is a multiple of 
the excitation wavelength.

See also: 
Graph menu  
Scan Application

Go To Wavelength—Scan 

Note 
This is not the wavelength used in the application method. If your method uses a wavelength that is different 
from the 'Go to wavelength' setting you select, then when you select Start the system will change to the 
wavelength selected (as set on the Cary page of the Setup dialog). 

Excitation Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go To the instrument will 
change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white light). 
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G-Factor—Scan
Select G-Factor to calculate the G Factor. You will be prompted to move your polarizers (Em and Ex) and perform 
the IHV and IHH measurements. At the end of the sequence the system will calculate the subsequent polarization
measurements which will be performed when you select the Start button. 

The G-Factor command is only available if you have selected the Polarizer accessory on the Accessories page. Once 
this option is selected, you can then select the G-Factor button from the Scan Application window or the G-Factor 
command from Commands menu.  

Rapid Result—Scan 
Use the Rapid Result dialog to take a reading of a blank and sample/s, without having to change the current 
application method. You can use the Multi Cell Changer dialog to specify the cell you want to read. This means that 
between runs, while new samples are being prepared and loaded, other samples can quickly be measured. The result 
is printed in the Report area. 

To access the Rapid Result dialog, select the Rapid Result command from the Commands menu or press F6. 

Zero—Scan 

You can then use this light for aligning accessories. 
Emission Wavelength 

Enter the new wavelength in this numeric entry field. When you select Go To the instrument will 
change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm (white light). 
You can then use this light for aligning accessories. 

Go To Click Go To once you have entered a new wavelength, to change the instrument to the entered 
value.

See also: 
Function Keys

See also: 
Accessories page 
Scan Application

Excitation Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Emission Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Zero Click Zero to change the wavelength to the entered value and measure a blank.
Result Click Result to change the wavelength to the entered value and measure a sample. The X,Y results 

are corrected for the blank and appear in the reports area.
See also: 
Multi Cell Changer  
Commands menu 
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Use the Zero button to zero the current intensity value. The intensity value will be reset to zero and all subsequent 
results will have the value that was reset to zero subtracted from them. You can use the Zero command before 
commencing a data collection if you want your data to start at 0  intensity. The Cary Eclipse will prompt you to load 
a blank before performing the zero. 

Before you select Zero, ensure that you have placed the blank solution in the cell positions that are currently in the 
cell path. 

When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the Scan 
Application window. 

Select the Clear Zero command from the Commands menu to remove zero correction and thus remove the 
subtraction effect. 

Use the Commands menu to access major operational commands in the Scan application . The menu is accessible 
from the menu line at the top of the Scan Application window. 

Alternatively you can use function key shortcuts for some of the commands. These appear next to the item in the 
Commands menu. Note that not all commands appear as both button and menu items. 

The following commands are accessible from the Commands menu: 

To access the Zero option, select the Zero command from the Commands menu, or select the Zero 
button from the Scan Application window. 

See also: 
Scan Application window 
Commands menu 
Cell Loading Guide

Commands menu—Scan 

Hot Tip 
If you access these commands using the Commands menu, rather than from the application buttons, you can 
remove these buttons from your application window. To do this, clear the Buttons command in the View 
menu. This will enlarge the Graphics area, making viewing and selection of scans easier. 

Tell me how to remove or display the command buttons 

Command What it does…
Start Select this to start a data collection using the currently set up parameters. 

Note 
If the Connect command is displayed in place of the Start command, this indicates that 
another Cary Eclipse application is in use and has control of the Cary Eclipse instrument. 
To make the Scan application active so that you can perform a read, you will need to select 
Connect. However, you will not be able to select Connect if another application is 
collecting data.

Stop Select this to stop the data collection.  
If you have selected Storage On in the Auto Store page of the Setup dialog, all data collected is 
automatically stored in the file specified in the Batch name field of the Windows Save As dialog 
before or after the run commenced. 

Clear Zero Select this option to clear the Zero command. When you select the Zero command (from the 
Commands menu or by pressing F5), the intensity at that time will be reset to zero and all 
subsequent results will have the intensity value that was reset to zero subtracted from them. 
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Selecting Clear zero cancels this zeroing (and thus subtraction) effect.
Pre-scan Select Prescan to determine the optimum instrument parameters to be used for your sample. At 

the end of this collection sequence the software will report the optimum Ex and Em wavelengths 
and PMT voltage. Once you are satisfied with the parameters, the software will automatically 
update your method setup to reflect these new parameters.

Reset Select this command to re-initialize the instrument. This will perform the same initializing 
procedure that is performed when the instrument is powered on.

Rapid Result Select this to display the Rapid Result dialog. Use this dialog to take a reading of a blank and 
multiple sample readings without changing the application method. This means that between runs, 
while new samples are being prepared and loaded, other samples can quickly be measured. 
This command can also be accessed by pressing F6.

Zero Select this to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use 
the Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell positions 
that are currently in the cell path.

Correction 
Curves 

To collect correction factors, select from one of the following: 

Excitation (220...660 nm) 
If you select this option, the Cary Eclipse will do the following: 

1. Set the emission mono to 640 nm and prompt you to insert a concentrated RhB solution
2. Perform an excitation scan from 220 to 600 nm

The excitation correction factors will then be calculated and stored to the following file path on 
the directory on which the Cary Eclipse software is installed: Varian/Cary Eclipse 
WinFLR/Correction Curves/Excorr.csv. 

Emission (220...660 nm) 
If you select this option, the Cary Eclipse will do the following: 

1. Prompt you to insert a diffuesr
2. Perform a synchronous scan from 220 to 600 nm (with delta set to 0 nm)

The emission correction factors will then be calculated and stored to the following file path on the 
directory on which the Cary Eclipse software is installed: Varian/Cary Eclipse 
WinFLR/Correction Curves/Excorr.csv.  

Emission (>660 nm) 
An NIST calibrated source is required to perform this correction.  

Example of uncorrected and corrected scans.  
Go to… Select Go To… to display the Go To Wavelength dialog where you can change the instrument to 

a new wavelength. Use this command if you want to quickly go to a wavelength to check the 
intensity reading. 
This command is only available if the instrument is not currently collecting data. It can also be 
accessed by pressing F4. 

Note 
This is not the wavelength used in the application method. If your method uses a 
wavelength that is different from the 'Go To wavelength', then when you select Start the 
system will change to the wavelength selected. (In most applications, this is set in the Cary 
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How to perform a fluorescence scan—Scan 
This demonstrates how to perform a wavelength scan in fluorescence mode. 

Start the Scan application
Set up data collection parameters
Set up instrument parameters such as Data Mode and Scan Setup
Set up visual system monitoring
Set up the scan options
Make sure that no accessories are selected
Set up reporting and printing requirements
Set up storage of collected data before run
Set up email options
Finish Setup
Zero the instrument
Start the Scan run
Save the collected data

Start the Scan application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan Application is 
displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select the Setup button to display the Setup dialog and specify the method parameters for a new method. 

Set up instrument parameters such as Data Mode and Scan Setup  

tab of the Setup dialog.) 

G-Factor Select this option to calculate the G Factor. The system will prompt you to move your polarizers 
(Em and Ex) perform a couple of measurements, i.e., IHV and IHH. At the end of the sequence the
system will calculate the subsequent polarization measurements which will be performed when 
you select the Start button.

ADL 
Command 

Select this to display the ADL Command Line window where you can execute an ADL 
command or ADL program. (You can also press Alt-Y to display this dialog.)

Rerun ADL Select this to run the ADL command or program in the ADL Command Line window again. 
(You can also press Alt-X to rerun programs.)

See also: 
Scan Application  
Auto Store  
Rapid Result 
Go To Wavelength dialog  
G Factor  
ADL Command Line 

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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Step 3 [Setup dialog | Cary page] 

a. Set the Data Mode to Fluorescence.

b. Set the Scan Setup mode to Emission. During the emission scan, the excitation monochromator is set to a
fixed wavelength and the emission monochromator is scanned over a wavelength range.

c. Set the X Mode to Wavelength (nm).

d. Enter an Excitation (nm) value that is within the region where the fluorescent molecule to be scanned will
absorb light. For purposes of this procedure, Anthracene will be used as an example and therefore a value of
360 nm should be set.

e. Enter an Excitation slit (nm) value of 5 and an Emission slit (nm) value of 5. Slits determine the resolution of
the spectrum and therefore are used in conjunction with the PMT Detector Voltage (set on the Options page)
to determine concentration. If a compound is highly fluorescent and has reasonable signal intensity (as is the
case for Anthracene) the slits can be set quite narrow.

f. Enter a Start (nm) value of 370 nm and enter a Stop (nm) value of 520 nm.
The Start (nm) value should be set to the Excitation (nm) value plus the sum of the slits. In this example, as the
Excitation value is 360 nm, and the sum of the slits is 10 nm, the Start (nm) value is set to 370.
Typically the Stop (nm) value should be set to 150–200 nm greater than the Start (nm) value.

g. If selected, clear the 3-D Mode check box.

h. Set the Scan Control to Medium.

Set up visual system monitoring  

Step 4 [Setup dialog | Cary page] 

Select the Status Display check box so that you can view various instrument parameters during the scan. 

Set up the scan options  

Step 5 [Setup dialog | Options page]  

a. Select the Options tab to display the Options page.

b. In the Display Options group, select the Overlay traces check box to overlay the results of the traces on one
graph.

c. If selected, clear the CAT or S/N Mode, Cycle Mode and Smoothing check boxes.

d. Set the Excitation filter to Auto. This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

e. Set the Emission filter to Open in order to minimize steps in the spectra.

f. Set the PMT Detector Voltage to Medium. This setting can later be adjusted if results are over-range. If the
signal is too high, decrease the PMT Detector Voltage. If the signal is too low, increase the PMT Detector
Voltage.

Make sure that no accessories are selected  

Step 6 [Setup dialog | Accessories page] 
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Ensure that no options are selected on any of the tabs of the Accessories page. 

Set up reporting and printing requirements  

Step 7 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements for this
method.

i. Enter your name in the Name entry field.
ii. If required, enter any comments relating to your experiment in the Comment field.

iii. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a graph in the generated report.

b. Set up the Peaks reporting options.

i. Select Maximum peaks to report the peak with the largest peak threshold that exceeds the peak
Threshold value.

ii. Select All peaks to report all peaks meeting the Peak type criterion and exceeding the Threshold value.

iii. Select the Peak type and specify the peak Threshold.

c. If required, select the X-Y Pairs table check box. You can use the Actual Data Interval by which the data
was collected or you can make the Cary Eclipse Interpolate the points to a new interval.

Set up storage of collected data before run  

Step 8 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto store page. Use this page to set up whether the collected data is
to be saved, and if so, when the Cary Eclipse should store the information.

b. Select Storage option of On; Prompt at end.

c. Select the Auto convert option you require.
If you select Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data collection
the system will automatically generate a report and store the data both in the Cary Eclipse format as well as
ASCII XY pairs format in the current folder.

Set up email options  

Step 9  

Refer to How to email your results for instructions on setting up the email options. 

Finish Setup  

Note 
If Auto print is selected, the system will send the report information to the specified printer as well a
displaying it in the Report area. However if Auto print is not selected, the report will be displayed in
area only. The Report area can be viewed by selecting the Report command from the View menu.
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Step 10 

Once you are satisfied with your method setup select OK to confirm any changes you have made and close the Setup
dialog. 

Zero the instrument  

Step 11 

a. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

b. Click the Zero button to zero the system. Alternatively, select Zero from the Commands menu to perform a
zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the
Scan Application window.

Start the Scan run  

Step 12 

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands menu.
The Sample Name dialog is displayed.

b. Place the sample in the sample compartment of the Cary Eclipse instrument.

c. In the Sample Name dialog, enter the appropriate name for you sample and select OK. The scan will
commence and the trace will appear in the Graphics area.

Save the collected data  

Step 13  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this scan run.

c. Select Save. The data will be stored as a Batch file.

How to perform a bio-/chemi-luminescene scan—Scan 
This demonstrates how to perform a wavelength scan in bio-/chemi-luminescene mode. 

Start the Scan application
Set up data collection parameters
Set up instrument parameters
Set up visual system monitoring
Set up the display and filter options
Make sure that no accessories are selected
Set up reporting and printing requirements
Set up storage of collected data before run
Set up email options
Finish Setup
Zero the instrument
Start the Scan run

See also:
Scan How To
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Save the collected data

Start the Scan application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan Application is 
displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select the Setup button to display the Setup dialog and specify the method parameters for a new method. 

Set up instrument parameters such as Data Mode and Scan Setup  

Step 3 [Setup dialog] | Cary page]  

a. Set the Data Mode to Bio-/Chemi-luminescence.

b. Select the Options button to display the Bio-/Chemi-luminescence Options dialog. Enter the Gate time to
200 ms. The Gate Time is the overall reading time of the emission signal and is typically set to between 100–
500 ms.

c. Select OK to clear the Bio-/Chemi-luminescence Options dialog and return to the Cary page. Note that in the
Scan setup group, the Excitation and Synchronous options are unavailable as the lamp does not flash for a
Bio-/Chemi-luminescence scan. Therefore, it is set to Emission mode.

d. Set the X Mode to Wavelength (nm).

e. Enter a Start (nm) value of  300 nm and enter a Stop (nm) value of between 750 nm.
The Start (nm) value should be set to the Excitation (nm) value plus the sum of the slits.

f. Enter an Emission slit (nm) value of 10. Slits determine the resolution of the spectrum and therefore are used
in conjunction with the PMT Detector Voltage (set on the Options page) to determine concentration.

g. In the Scan control group, set the Averaging time to 0.20000 s and the Data interval to 1.0000 nm.

Set up visual system monitoring  

Step 4 [Setup dialog | Cary page] 

Select the Status Display check box so that you can view various instrument parameters during the scan. 

Set up the display and filter options  

Step 5 [Setup dialog | Options page]  

a. Select the Options tab to display the Options page.

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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b. In the Display Options group, select the Overlay traces check box to overlay the results of the traces on one
graph.

c. If selected, clear the CAT or S/N Mode, Cycle Mode and Smoothing check boxes.

d. Set the Emission filter to Open in order to minimize steps in the spectra.

e. Set the PMT Detector Voltage to High. A High setting is recommended as luminescence spectra are
generally quite weak and therefore require a sensitive system to detect them. This setting can later be adjusted
if results are over-range. If the signal is too high, decrease the PMT Detector Voltage.

Make sure that no accessories are selected  

Step 6 [Setup dialog | Accessories page] 

Make sure that no options are selected on any of the tabs in the Accessories page. 

Set up reporting and printing requirements  

Step 7 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements for this
method.

i. Enter your name in the Name entry field.
ii. If required, enter any comments relating to your experiment in the Comment field.

iii. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a graph in the generated report.

b. Set up the Peaks reporting options.

iii. Select Maximum peaks to report the peak with the largest peak threshold that exceeds the peak
Threshold value.

i. Select All peaks to report all peaks meeting the Peak type criterion and exceeding the Threshold value.
ii. Select the Peak type and specify the peak Threshold.

c. If required, select the X-Y Pairs table check box. You can use the Actual Data Interval by which the data
was collected or you can make the Cary Eclipse Interpolate the points to a new interval.

Set up storage of collected data before run  

Step 8 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto store page. Use this page to set up whether the collected data is
to be saved, and if so, when the Cary Eclipse should store the information.

Note 
If Auto print is selected, the system will send the report information to the specified 
printer as well as displaying it in the Report area. However if Auto print is not selected, 
the report will be displayed in the Report area only. The Report area can be viewed by 
selecting the Report command from the View menu.
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b. Select Storage option of On; Prompt at end.

c. Select the Autoconvert option you require.
If you select Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data collection
the system will automatically generate a report and store the data both in the Cary Eclipse format as well as
ASCII XY pairs format in the current folder.

Set up email options  

Step 9 

Refer to How to email your results for instructions on setting up the email options. 

Finish Setup  

Step 10 

Once you are satisfied with your method setup select OK to confirm any changes you have made and close the Setup
dialog. 

Zero the instrument  

Step 11 

a. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

b. Click the Zero button to zero the system. Alternatively, select Zero from the Commands menu to perform a
zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the
Scan Application window.

Start the Scan run  

Step 12  

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands menu.
The Sample Name dialog is displayed.

b. In the Sample Name dialog, enter the appropriate name for you sample and select OK. The Scan run will
commence and the corrected trace will appear in the Graphics area.

Save the collected data  

Step 13  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this scan run.

c. Select Save. The data will be stored as a Batch file.

How to perform a phosphorescence scan—Scan 
This demonstrates how to perform a wavelength scan in phosphorescence mode.

See also:
Scan How To
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Start the Scan application
Set up data collection parameters
Set up instrument parameters
Set up visual system monitoring
Set up the display and filter options
Make sure that no accessories are selected
Set up reporting and printing requirements
Set up storage of collected data before run
Set up email options
Finish Setup
Zero the instrument
Start the Scan run
Save the collected data

Start the Scan application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan Application is 
displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select the Setup button to display the Setup dialog and specify the method parameters for a new method. 

Set up instrument parameters such as Data Mode and Scan Setup  

Step 3 [Setup dialog] | Cary page]  

a. Set the Data Mode to Phosphorescence.

b. Select the Options button to display the Phosphorescence Options dialog. The values you enter for the
options in this dialog depend upon the sample you are scanning.

For example, if you were analysing a sample such as Europium (Eu3+), which has a short decay time, it is
recommended that you enter the following values:

However, if you were analysing a sample such as Naphthalene, which is know to have a phosphorescence 
lifetime in the seconds regime, it is recommended that you enter the following values: 

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.

Total decay time: 0.005 s
No. of flashes: 1
Delay time: 0.100 ms
Gate time: 1.0 ms

Total decay time: 2 s
No. of flashes: 10
Delay time: 0.100 ms
Gate time: 500 ms
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c. Once you have made entered the values in the Phosphorescence options dialog, select OK to clear the dialog
and return to the Cary page.

d. Set the Scan Setup mode to Emission. During the emission scan, the excitation monochromator is set to a
fixed wavelength and the emission monochromator is scanned over a wavelength range.

e. Set the X Mode to Wavelength (nm). Set the following parameters for EuropiumIII:

f.

Set the following parameters for Naphthalene: 

g. If selected, clear the 3-D Mode check box.

Set up visual system monitoring  

Step 3 [Setup dialog | Cary page] 

Select the Status Display check box so that you can view various instrument parameters during the scan. 

Set up the display and filter options  

Excitation (nm) 340 The Excitation (nm) value must be within the region where 
the phosphorescent molecule to be scanned will absorb light.

Excitation slit (nm) 20 Slits determine the resolution of the spectrum and therefore 
are used in conjunction with the PMT Detector Voltage (set 
on the Options page) to determine concentration. If a 
compound is not highly phosphorescent (as is the case for 
Europium) the slits need to be set quite wide.

Emission slit (nm) 20
Start (nm) 360 The Start (nm) value should be set to the Excitation (nm) 

value plus the sum of the slits. In this example, as the 
Excitation value is 340 nm, and the sum of the slits is 20 nm, 
the Start (nm) value is set to 360. 
Typically phosphorescence samples should be scanned to 
above 600 nm, and preferably to between 700–750 nm, even 
if they fluoresce at as low as 300 nm. 

Stop (nm) 700-750 

Excitation (nm) 290 The Excitation (nm) value must be within the region where 
the phosphorescent molecule to be scanned will absorb light.

Excitation slit (nm) 10 Slits determine the resolution of the spectrum and therefore 
are used in conjunction with the PMT Detector Voltage (set 
on the Options page) to determine concentration. If a 
compound is not highly phosphorescent (as is the case for 
Europium) the slits need to be set quite wide.

Emission slit (nm) 20
Start (nm) 310 The Start (nm) value should be set to the Excitation (nm) 

value plus the sum of the slits. In this example, as the 
Excitation value is 340 nm, and the sum of the slits is 20 nm, 
the Start (nm) value is set to 360. 
Typically phosphorescence samples should be scanned to 
above 600 nm, and preferably to between 700–750 nm, even 
if they fluoresce at as low as 300 nm. 

Stop (nm) 800
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Step 4 [Setup dialog | Options page] 

a. Select the Options tab to display the Options page.

b. In the Display Options group, select the Overlay traces check box to overlay the results of the traces on one
graph.

c. If selected, clear the CAT or S/N Mode, Cycle Mode and Smoothing check boxes.

d. Set the Excitation filter to Auto. This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

e. Set the Emission filter to Open in order to minimize steps in the spectra.

f. Set the PMT Detector Voltage to High. A High setting is recommended for low emitting samples. This
setting can later be adjusted if results are over-range. If the signal is too high, decrease the PMT Detector
Voltage.

Make sure that no accessories are selected  

Step 5 [Setup dialog | Accessories page] 

In this example we are not using any accessory so ensure that no options are selected on any of the tabs in the 
Accessories page. 

Set up reporting and printing requirements  

Step 6 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements for this
method.

i. Enter your name in the Name entry field.
ii. If required, enter any comments relating to your experiment in the Comment field.

iii. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a graph in the generated report.

b. Set up the Peaks reporting options.

iii. Select Maximum peaks to report the peak with the largest peak threshold that exceeds the peak
Threshold value.

i. Select All peaks to report all peaks meeting the Peak type criterion and exceeding the Threshold value.
ii. Select the Peak type and specify the peak Threshold.

c. If required, select the X-Y Pairs table check box. You can use the Actual Data Interval by which the data
was collected or you can make the Cary Eclipse Interpolate the points to a new interval.

Note 
If Auto print is selected, the system will send the report information to the specified 
printer as well as displaying it in the Report area. However if Auto print is not selected, 
the report will be displayed in the Report area only. The Report area can be viewed by 
selecting the Report command from the View menu.
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Set up storage of collected data before run 

Step 7 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto store page. Use this page to set up whether the collected data is
to be saved, and if so, when the Cary Eclipse should store the information.

b. Select Storage option of On; Prompt at end.

c. Select the Autoconvert option you require.
If you select Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data collection
the system will automatically generate a report and store the data both in the Cary Eclipse format as well as
ASCII XY pairs format in the current folder.

Set up email options  

Step 8 

Refer to How to email your results for instructions on setting up the email options. 

Finish Setup  

Step 9 

Once you are satisfied with your method setup select OK to confirm any changes you have made and close the Setup
dialog. 

Zero the instrument  

Step 10 

1. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

2. Click the Zero button to zero the system. Alternatively, select Zero from the Commands menu to perform a
zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the
Scan Application window.

Start the Scan run  

Step 11  

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands menu.
The Sample Name dialog is displayed.

b. Place the sample in the sample compartment of the Cary Eclipse instrument.

Note: 
This step is only necessary if there is background phosphorescence.

Note: 
You MUST close the sample compartment prior to commencing a phosphorescence scan, as phosphorescence 
scanning is not immune to room light.
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c. In the Sample Name dialog, enter the appropriate name for you sample and select OK. The Scan run will
commence and the corrected trace will appear in the Graphics area.

Save the collected data  

Step 12  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this scan run.

c. Select Save. The data will be stored as a Batch file.

Viewing run progress and results—Scan 
Reports page
Reports toolbar
Create Report
Clear Report
Label Options dialog
Peak Labels dialog
How to use the advanced reporting options
View menu
Edit menu
Status display
User Data Form
Print Preview dialog
Print

View menu—Scan 
The View menu is accessible from the menu line at the top of the Scan Application window. 

The following commands can be accessed from the View menu: 

See also:
Scan How To

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open it. Any data 
will be displayed in the Graphics area.

Command Use this to…

Toolbars Select this option to toggle the Graphics and Reports toolbar on and off. You can also select to 
display or hide the toolbar Text Labels.

Buttons Select this option to toggle the left-hand button display (button area) on and off.

Graphics Select this option to toggle the Graphics area on and off. 

Report Select this option to toggle the Report area on and off.

Report 
Vertical 

If the Graphics option is selected, select Report Vertical to display the Graphics area, Report 
area and/or ADL Editor side by side vertically.
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Edit menu—Scan 
Use the Edit menu to copy, cut, paste and delete information. You can also use the menu to access the Report editing 
commands. The menu is accessible from the menu line at the top of the Scan Application window. 

The following commands can be accessed from the Edit menu: 

ADL Select this option to toggle the ADL Editor on and off.

ADL Vertical If the ADL and Report options are selected, select ADL Vertical to display the ADL Editor 
vertically on the right hand side of the Report area.

ADL Quick 
Reference 

This displays the Quick Reference window which you can use to easily add a command in the 
correct syntax to your ADL program. A detailed description of all the commands in the Quick 
Reference is available by selecting the Help button on this window.

ADL Hooks Select this to activate a link (or hook) to an ADL program at a specific point in the application, 
and then run that ADL program. For example, ADL hooks have been supplied to run specific 
programs: 

on start-up of the Cary Eclipse software;
when the system goes online or offline;
when the Start button is selected;
when a run finishes;
when a zero is performed etc.

For the hook to work, ADL Hooks must be selected, and the appropriate ADL file for the 
application must be present in the Varian/Cary Eclipse WinFLR/ADL folder on the drive on 
which the Cary Eclipse software is installed. 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Hints Select this option to toggle the Hints bubble text on and off. Hint text appears when you place the 
arrow cursor over a field, button or text entry field for a short period. It offers a quick explanation 
of the item’s function.

Status Display Select this option to display the Status Display window, where you can view the status of various 
parameters during the data collection.

See also: 
ADL Hooks 
How to insert ADL commands using the Quick Reference

Note 
These commands are also accessible from the Report Toolbar. From the View menu, point to Toolbars and 
select Report to display the Report Toolbar. 

Command Button What it does… 
Undo If available, this undoes the last action that was performed in the report area. 

This command is also accessible by pressing CTRL+Z.
Cut Select this command to remove the highlighted text and place it on the Windows 

Clipboard. 
This command is also accessible by pressing CTRL+X.

Page 59 of 149Scan Home Page

   file://C:\Documents and Settings\cary\Local Settings\Temp\~hhF1E6.htm



Status Display—Scan 
Use the Status Display window to view the status of your scan during the data collection. Depending upon settings 
you have for the scan, the following parameters may be displayed:  

Current Excitation Wavelength (nm)
Current Emission Wavelength (nm)
Excitation Slit Width (nm)
Emission Slit Width
PMT Voltage (V)

To access the Status Display window, select Status Display from the View menu, or from any page of the Setup 
dialog. You can choose to view the Status Display window at any time during a data collection. 

User Data Form—Scan 

Copy Select this command to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.

Paste Select this command to insert the contents of the Windows Clipboard (text only) at the 
cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Select this command to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
This option is only available once you select Edit Report and there is text 
highlighted in the Report area. 

Select All Select this option to highlight all text in the Report area. 
This command is also accessible by pressing CTRL+A.

Font This enables you to change the font of new or selected text in the report. For existing text, 
simply highlight the text in the report, select Font and make your changes in the Font 
dialog. When you select OK, the appearance of the highlighted text in the report will alter 
to reflect your font changes. 
This command is also accessible by pressing CTRL+F. 

Note 
You do not have to select Edit Report to use this command. 

Edit Report Select this option to edit the report. 
This command is also accessible by pressing CTRL+R.

Clear Report Select this command to remove the contents of the Report area. If you have saved the 
report, selecting this option does not delete the contents of the report, the information is 
simply removed from the Report area.

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, Microsoft Word 
or Microsoft Excel) into the report area of the of the Scan application. To edit these objects, simply double 
click on them to open the associated application in which they were created. 

See also: 
Scan Application 

See also: 
Status Line  
View menu  
Setup dialog
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Use the User Data Form to enter extra information about the traces in the highlighted graph box. For example, you 
might want to record information about the experimental conditions you used to collect the data. 

The dialog comprises the following: 

Print Preview—Scan 
Use the Print Preview dialog to view the current report before you print it. From the File menu, select Print Preview 
to access the dialog. 

The contents of the Graphics area appear first in the preview area followed by the contents of the Report area. You 
can reduce or enlarge the print preview on screen. To do this, click the left mouse button in the preview area to toggle 
through the five available views. Click the right mouse button in the preview area to return to the full page view.  

The page comprises the following commands: 

To access the User Data Form, select the User Data Form command from the Graph menu, or select the 
User Data Form button on the Graphics toolbar. The User Data Form command is only available if you 
have selected a graph box.

Data Name This column lists the names of each visible trace in the highlighted graph box. They will be 
labeled according their Sample Name.

Other Columns Use these columns for recording additional information about the experimental conditions you 
used to collect the data. For example, if you are interested in time based data, you can record the 
time at which the sample was run. You do not need to include an entry for each corresponding 
sample name. Use the first row in the column to enter a name for the parameter (for example, 
'Time'). 

You can choose to view these selected data points as a separate group of traces. To do this, open 
the Trace Preferences  dialog and in the Select trace list, select the group of traces you wish to 
view. Trace groups will be named according to their column heading in the User Data Form (in 
the above example, it would be 'Time'). You can view traces as standard 2D graphs, or as contour 
or 3D graphs. 

Note 
You must enter a column heading, or else the data in that column will not be saved.

See also: 
Graph menu  
Graphics toolbar  
Trace Preferences 
Contour graphs  
3D graphs 

First arrow Use this arrow to view the first page of the report. 

Previous 
arrow

Use this arrow to view the previous page of the report. 

Next arrow Use this arrow to view the next page of the report. 

Last arrow Use this arrow to view the last page of the report. 
Q. Why are the arrow buttons grayed out?
A. The buttons will be grayed out if the report has only one page of data.

Print Use this to display the Windows Print dialog where you can choose the printer and pages 
to print as well as the number of copies you wish to print.
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Print—Scan 
Use the Print dialog to select the printer and pages to print of the currently displayed report as well as the number of 
copies you wish to print. From the File menu, select Print to access the dialog. 

All graphical information displayed on screen will be printed with the report, therefore it is advisable to edit the 
report on the screen prior to printing. You can also preview the report prior to printing by using the Print Preview 
command. 

If you require a printout of the graphics in the Graphics area only, select the Clear Report button to erase the 
contents of the Report area before you print. 

Performing Calculations—Scan—Scan 
Maths Calculator
Maths Operations
Maths How To
User Data Form

Maths window 
Calculation Field | Selected/Focused Trace | Trace | Display Options | Functions

Use the Maths window to perform mathematical manipulations on collected traces. In addition, it can act as a simple 
numeric calculator. 

The Maths window comprises the following: 

See also: 
Print

Note 
The options on the Report page are used to generate the contents of the Report area during a run or on a 
recalculation. If Auto Print has been selected the Cary Eclipse will automatically print a report at the end of a 
data collection. 

See also: 
Edit Report

To access the Maths window, select the Calculator command from the Graph menu, or select the 
Calculator button on the Graphics toolbar. 
The Maths window is only available in the Kinetics, Lifetimes, Scan and Validate applications.

Calculation 
display field 

View the current calculation, including the trace/s being used, the trace operation being carried out 
and any functions that have been applied to the trace. 

Hot Tip 
Click on the down arrow adjacent to this field to view the last ten unique calculations that 
have taken place. Use this list to keep track of previous manipulations and repeat 
calculations quickly by simply selecting and then applying the desired calculation.

Selected 
Trace/Focused 
Trace 

Choosing either of these options selects the highlighted (red) trace in the current Graph box for 
manipulation. When choosing between these options, use this simple rule: 

Use the Selected Trace option when the selected calculation is only to be applied to one
trace.
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Use the Focused Trace option when the same calculation is to be applied to a number of
traces.

The following example illustrates the difference between these options. 

To perform the same manipulation on several traces:  

a. Highlight a trace by clicking on it with the mouse. The trace will become red.
b. Select Selected Trace, Apply and then = to plot the result of the calculation
c. Highlight the next trace and repeat step b.

OR  

a. Highlight the first trace.
b. Select Focused Trace, Apply and then = to plot the result of the calculation;
c. Highlight the next trace and select the = button to perform the same calculation on the

newly selected trace.
Trace Use the Trace group options to select the operation to be performed on the traces, the filter size 

and the interval (where applicable). 
Click Apply to insert the selected operation into the equation 
Click = (equals) to display the result of the calculations. 

Operation 
Click on an operation to find out more about it 

Anisotropy
Polarization
Sum Function
Mean
Boxcar Averaging
Moving Average
Savitzky-Golay
Spline
Deriv 1
Deriv 2
Deriv 3
Deriv 4

Display 
Options 

Select whether the results of the operation performed on the trace will be viewed in a New Graph 
box or in the Selected Graph box. If you choose the Selected Graph option, you will be able to 
directly compare the results with existing traces.

Functions This group contains number and function buttons that can be used as a standard calculator in 
addition to being applied to traces. 

To use the functions: 

1. select a trace or value
2. select either a second trace or number
3. select the equals (=) button to display the result

All the basic mathematical functions are available (addition, subtraction, multiplication and 
division), as well as logarithm (Log) and square root (Sqrt) functions. When used as a calculator, 
the results of equations appear in the Report area. 

Additional 
buttons 

C 
Click C to clear the entire operation in the calculation display field. 
CE 
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Click CE to clear the last entry entered in the calculation display field. 
= 
Click = (equals) to start the operation shown in the calculation display field.

See also: 
Maths Home Page 
Maths How To

Maths Operations 

The following operations can be selected on the Maths window. To access the Maths window, select the 
Calculator command from the Graph menu, or select the Calculator button on the Graphics toolbar.

Anisotropy, 
Polarization 
and Sum 
Function 

The term Anisotropy refers to an unequal angular distribution about a point in space. Anisotropy 
also refers specifically to a simple expression for measuring the degree of polarization of the 
fluorescence.  It is almost identical to the expression for polarization apart from having a factor of 
two in the denominator.  Anisotropy is usually represented by the lowercase letter " r ", while 
polarization by an uppercase  " P ". 

The two expressions are listed below: 

Anisotropy 
r = (Ivv - GIvh) / (Ivv + 2GIvh) 

Polarisation 
P = (Ivv - GIvh) / (Ivv + GIvh) 

where 

Ivv equals the intensity of fluorescence with excitation polarizer = vertical, emission polarizer = 
vertical 
Ivh equals the intensity of fluorescence with excitation polarizer = vertical, emission polarizer = 
horizontal 

G is a factor that accounts for the polarization bias of the instrument. In particular it accounts for 
the wavelength-dependent polarization bias of the emission side of the instrument (dominated by 
the polarization bias of the emission grating). 

The G factor is given by:  
G = Ihv/Ihh 

where 

Ihv equals the intensity of fluorescence with excitation polarizer = horizontal, emission polarizer 
= vertical 

Ihh equals the intensity of fluorescence with excitation polarizer = horizontal, emission polarizer 
= horizontal 

The expression for the anisotropy is a quotient.  The denominator of the expression, as given by 
Ivv + 2GIvh is the ‘sum’ function, and actually represents the total emission unbiased by any 
sample polarization effects. 

Mean The Mean operation allows the average of two or more traces to be taken and the resulting trace to 
be plotted. The mean of the traces can also be used in conjunction with other functions. 

The equation used in mean calculations is: 
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(scan 1 + scan 2...+ scan x)/x 

The calculation is performed over the common X range of the traces and the trace with the most 
dense data is used to determine the data points. The other traces are interpolated at the relevant 
data points. 

Boxcar 
Averaging 

This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 

For example, for the following: 

 The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x8, sum(y6:y10)/5) ….. (xn-2, 
sum(yn-4:yn)/5). 

If there are not enough points at the end of the data set to complete the filter size, then these points 
will be ignored, hence, the gap at the end may be larger than the gap in the beginning. There will 
be a gap before the first point and after the last point of the smoothed continuum, with respect to 
the original unsmoothed data. This algorithm is only valid for evenly x-spaced data points.  

Within a time scan, (e.g., Advanced collect in kinetics) the data points may be unevenly spaced 
between different stages.  Each stage will be treated as a new collect, hence, there may be large 
gaps between stages.  If there are not enough points at the end of a stage to complete the filter 
size, then these points are ignored, hence, there may be large gaps at the end of a stage.  The filter 
size will be limited to odd numbers, with the minimum of 3 to a maximum of 101. 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5

Moving 
Average 

This algorithm will take the number of points as defined by the Filter size, and average these, 
displaying the average at the middle X-point of the filter. 

For example, for the following: 

The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x4, sum(y2:y6)/5) ….. (xn-2, 
sum(yn-4:yn)/5). There will be a gap before the first point and after the last point of the smoothed 
continuum, with respect to the original unsmoothed data. This algorithm is only valid for evenly 
x-spaced data points. Within a time scan, (e.gg, Advanced collect in kinetics), the data points may
be unevenly spaced between different stages. This will be treated by interpolation of data from the
previous stage so as to give evenly spaced data points into the next stage. If there is not enough
data for interpolation, then the next stage will be treated as a new collect, hence, there may be
gaps and further delays in displaying the point. The filter size will be limited to odd numbers, with
the minimum of 3 to a maximum of 101.

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5

Savitzky-Golay The Savitzky-Golay technique operation enables  you to reduce the noise in the currently selected 
Maths scan by using smoothing. 

When you select this operation you will be prompted to enter a Filter Size from 5 to 101. The 
larger the Filter Size, the more data points that will be smoothed. 

You will also need to enter an Interval. The Interval refers to how many of the averaged points 

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an even number.
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Maths How To… 
How to perform a spectral subtraction
How to perform a mean calculation
How to smooth a trace
How to derive a trace

Displaying data graphically—Scan 
Graphics area
Graphics How To
Graph menu
Graphics toolbar
Graph Labels
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label
Graph Pictures

will be plotted on the smoothed trace. The smaller the interval, the more detail there will be in the 
trace. 

Consider selecting an Interval of 1. This would mean that when the smoothed continuum is 
plotted, every smoothed point will be displayed. 

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select Smooth in the Operation field.

Spline 
Deriv 1–4 The Deriv operations allow you to obtain derivatives of a selected scan. The derivative can be of 

the orders 1 to 4. The resulting trace is then plotted.  The Savitzky-Golay technique is used for 
derivative calculations. 

On selection of the Deriv operation you will be prompted to enter a Filter Size from 5 to 101. The 
Filter Size refers to the number of points around a particular point that will be averaged to produce 
a new derived Y value. The lower the Filter Size, the more data points that will be used in the 
derivative trace. 

You will also need to enter an Interval. The Interval refers to how many of the derived points will 
be plotted on the resulting trace. The smaller the Interval, the more detail there will be in the trace. 

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an even number.

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select one of the ‘Derivs’ in the Operation field.

See also: 
About smoothing

See also:
Maths Home Page
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Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture
Trace Preferences dialog
Trace Preferences menu
How to select the focused trace
How to display a trace
How to remove a trace from a graph
How to remove a trace from the trace list
Graph Preferences dialog
2D Graph Preferences
Contours Graph Preferences
How to alter the look of your graphs
Cursor Modes dialog
How to track the focused trace
Axes Scales dialog
How to scale your graph manually
How to scale your graph automatically
Viewing Graphs
Single/Multi Graph
Individual Data and Overlay Data
User Data Form
Peak Labels
Peak Picking
Contour Graphs
How to create a contour graph
How to create a contour slice
3D Graphs
Examples of 3D collects
Graphics Templates
How to create a graphics template

Graphics area—Scan 
The Graphics area of the Scan application appears in the top half of the Scan Application and is used to display traces 
of collected data. In the Cary Eclipse system, the term 'graph' refers to the plotting area and is represented by a set of 
axes. The rectangular area surrounding the graph is referred to as the graph box. A graph will appear in the Graphics 
area when you select Start to commence a Scan. 

To display or hide the Graphics area, select the Graphics command on the View menu. Double-clicking on the 
Graphics area enables you to toggle between half or full size display areas. 

You can access the functions associated with the Graphics area by doing the following:  

selecting one of the Graphics toolbar buttons;
selecting a command from the Graph menu; or
clicking the right mouse button in the Graphics area and select a command from the menu

You can customize the graphics area to suit your requirements in the following ways:

Note 
Not all functions are available on every menu.
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Note 
All of the commands and dialogs listed are accessible from the Graph menu. 

To… Use the… Tell me how…

Change the axes scaling automatically Autoscale graph command How to scale your graph automatically

Change the axes scaling manually Axes Scales dialog How to scale your graph manually

Modify the graph appearance (axes, 
trace)

Graph Preferences dialog How to alter the look of your graphs 

How to specify the number of tick 
marks and decimal places for your X 
and Y axes 

Add a new graph to the display Add graph command

Remove a graph from the display Remove graph command

View single or multiple graphs Single/multiple graph command

Resize a graph box Cursor How to resize graph boxes

Track the focused trace Cursor Mode dialog How to track the focused trace 

Select the focused trace Cursor How to select the focused trace

Display a trace in the graph Trace Preferences dialog How to display a trace that is not 
appearing in a graph box

Remove a trace from a graph Trace Preferences dialog How to remove a trace from a graph

Remove a trace from the trace list Trace Preferences dialog How to remove a trace from the trace 
list

Zoom in and out on the graph Zoom In and Zoom Out 
commands

How to zoom a graph

Add a label to the graph box Add Label dialog How to add a label to a graph

Edit labels in the graph box Edit Label dialog How to edit a label

Move labels in the graph box Cursor How to move a label

Resize labels in the graph box Cursor How to resize a label

Delete labels from the graph box Delete Annotation command How to delete a label

Add a picture to the graph box Add Picture dialog How to add a picture to a graph

Move pictures in the graph box Cursor How to move a picture

Resize pictures in the graph box Cursor How to resize a picture

Replace pictures in the graph box Edit Picture dialog How to replace a picture

Delete pictures from the graph box Delete annotation command How to delete a picture

Save the Graphics area you have set 
up as a graphics template

Save As dialog (from the File 
menu)

How to create a graphics template
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Graphics How To—Scan 
Graphics 

How to alter the look of your graphs
How to create a graphics template

Traces  

How to create a contour graph
How to create a slice from a contour graph
How to display a trace
How to track the focused trace
How to select the focused trace
How to remove a trace from a graph
How to remove a trace from the trace List

Sizing and scale  

How to resize graph boxes
How to scale your graph manually
How to scale your graph automatically
How to zoom a graph

Labels  

How to add a label
How to edit a label
How to delete a label
How to move a label
How to resize a label

Pictures  

How to add a picture
How to move a picture
How to delete a picture
How to replace a picture
How to resize a picture

Introduction 

Use the Graph menu to view data in various graphical formats or in multiple graphs in the Graphics area. You can 
double-click on the Graphics area to toggle the display through graph and report to graph only.  

In the Cary Eclipse system, the term 'graph' refers to the plotting area and is represented by a set of axes. The 

Note 
The red trace in any graph box is the one on which all information appears and the one used for the cursor 
tracking. It is called the focused trace. 

See also: 
Graphics Toolbar

Graph menu—Scan 
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rectangular area surrounding the graph is referred to as the graph box. A graph will appear in the Graphics area when 
you select Start to commence a scan. 

The Graph menu can be accessed in the following ways: 

from the main menu at the top of the Scan Application window
by clicking the right mouse button in a graph box or the Graphics area

Menu commands 

The following commands can be accessed from the Graph menu: 

Note 
The red trace in any graph box is the one on which all information appears and the one used for the cursor 
tracking. It is called the focused trace.

Command Button What it does…

Print XY 
point 

Select this to print the cursor's current X and Y coordinates in the report area. 
This option is only available from the Graph menu that appears when you right-
click in a graph box.

Copy Graph Select Copy Graph to copy the entire Graphics area to the Windows Clipboard. All of 
the graphs in the Graphics area will be copied to the Clipboard.

Paste to 
Graph 

Select Paste to graph to paste the contents of the Windows Clipboard into the Graphics 
area. Text is pasted as a label, graphics are pasted as pictures.

Add Graph  Select Add graph to add a new graph box to the Graphics area. You may want to do this 
if you have, for example, a graph containing existing data and you want to collect some 
new data in a new graph.

Remove 
Graph  

Select Remove graph to delete the selected graph box from the Graphics area. The 
graph box is removed, but the data is not deleted and is still available from the Trace 
Preferences window. 
You may want to use remove graph if you have a large number of graph boxes open but 
only want to focus on some of these. 

Note 
You can remove multiple graph boxes by first holding down the CTRL key and 
selecting the graphs to be removed and then selecting the Remove Graph button 
or menu item. Use the SHIFT key to highlight a range of graphs for removal.

Clear All 
Traces 

Select Clear All Traces to delete all traces from the graph/s. Note that selecting this 
option simply turns off the Visible property for the traces in the Trace Preferences 
window. You can redisplay the traces by making the traces Visible again in the Trace 
Preferences window.

Add Label  Select Add Label to display the Add Label dialog where you can enter a text label to be 
placed on a graph or in the background of the Graphics area. 

Add Picture Select Add Picture to display the Add Picture dialog where you can select a picture, 
bitmap or chemical structure to be placed on a graph or in the background of the 
Graphics area. 

Edit 
Annotation 

Select Edit Annotation to alter the content or look of the selected annotation, (either a 
label or a picture) in the Graphics area. 

Note 
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If the selected annotation is a label, selecting Edit Annotation will open the Edit Label 
dialog where you can change the text of the selected label. 
If the selected annotation is a picture, selecting Edit Annotation will open the Edit 
Picture dialog where you can replace the selected picture with a new picture. 

This option can only be activated if an annotation is selected.

Delete 
Annotation  

Select Delete Annotation to remove an annotation, (such as a label or a picture) from 
the Graphics area. 
You can use this menu option to remove highlighted annotations in the Graphics area 
such as labels, pictures and ruler/fit information. 

Note 
This option can only be activated if an annotation is selected.

Trace 
Preferences 

Select this command to display the Trace Preferences dialog where you can select the 
trace(s) to display in the selected graph.

Graph 
Preferences 

Select this command to display the Graph Preferences dialog where you can change the 
appearance of your graph. Any changes you make to the appearance of the graph will be 
applied to all graphs.

Cursor 
Mode… 

Select this command to display the Cursor Modes dialog where you can choose the type 
of cursor to be used on the screen. For example, you can select to use a free cursor that 
can move anywhere in the graph or exactly trace the focused scan (red scan).  
Alternatively, you can select a cursor that enables you to draw a line from one point to 
another to determine the slope using either the Least Squares method or the Point to 
Point method.

Axes 
Scales…  

Select this command to display the Axes Scales dialog where you can set the scale range 
for the X and Y axes.

Auto scale 
graph 

To automatically scale the graph, point to one of the following options: 

Autoscale[XY] 
Select Autoscale[XY] to automatically scale collected data by scaling the Y height and X 
width to full screen. 

Autoscale[X] 
Select Autoscale[X] to automatically scale collected data by scaling the X width to full 
screen. 

Autoscale[Y] 
Select Autoscale[Y] to automatically scale collected data by scaling the Y height to full 
screen. 

Zoom Out Select Zoom Out to Zoom back to the original X and Y ranges which were used to 
collect the data (i.e. the method setup conditions of the focused scan).  
For example, the system will revert back to the X and Y ranges set in the method if you 
zoom in and out during a data collection.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note 
The graph highlighted in the Multi Graph view will be displayed when you toggle 
the Single Graph option.

Auto Select Auto Arrange Graphs to view and arrange all graphs simultaneously. 
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Graphics Toolbar—Scan 
Use the Graphics toolbar buttons to gain quick access to many of the Graph menu options. You can also use the 
toolbar to select the graph you want to view and to change the look of your graphs. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Graphics. To display or 
hide the toolbar's text labels, point to the Toolbars option in the View menu and select Text Labels. 

Arrange 
Graphs 

Note 
You can move graph boxes manually by clicking the left mouse button outside the 
graph axes and dragging the graph box to a new position. You can also resize 
graphs.

User Data 
Form  

Select User Data Form to display the User Data Form where you can enter extra 
information about the traces in the highlighted graph box. For example, you might want 
to record information about the experimental conditions you used to collect the data, 
such as the pH at which data was collected.

Peak Labels Select this to the Peak Labels dialog where you can select various labeling and peak 
reporting functions.

Calculator Select Calculator to display the Maths window where you can perform mathematical 
manipulations on collected traces. In addition, it can act as a simple numeric calculator.

Contour 
graph 

Once you have generated a graph of data, you can select the Contour graph button to 
generate a Contour graph of this data.  

XY slice Once you have generated a Contour graph, you can generate an XY slice of the data, 
which will enable you to view a XY scan of a particular point of the XY graph. 

YZ slice Once you have generated a Contour graph, you can generate an YZ slice of the data, 
which will enable you to view a YZ scan of a particular point of the YZ graph. 

3D graph Once you have generated a graph of data, you can select the 3D graph button to generate 
a 3D graph of this data. The 3D Grams application by Galactic software® will be 
displayed. 

History List This displays a list of the current graphs. 

See also: 
Add Label   
Add Picture   
Edit Label   
Edit Picture   
Trace Preferences  
Graph Preferences   
Cursor Modes  
Axes Scales   
Single/Multi Graph  
User Data Form   
Peak Labels  
Maths window   
Contour graphs  
3D graph  
Graphics Toolbar 
Graphics area
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The following commands can be accessed from the Graphics Toolbar: 

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Trace 
Preferences  

Click this button to display the Trace Preferences dialog where you can select the trace
(s) to display in the selected graph.

Graph 
Preferences 

Click this button to display the Graph Preferences dialog where you can change the 
appearance of your graph. Any changes you make to the appearance of the graph will be 
applied to all graphs.

Cursor Mode Click this button to display the Cursor Modes dialog where you can choose the type of 
cursor to be used on the screen. For example, you can select to use a free cursor that can 
move anywhere in the graph or exactly trace the focused scan (red scan).  Alternatively, 
you can select a cursor that enables you to draw a line from one point to another to 
determine the slope using either the Least Squares method or the Point to Point method.

Axes Scales… Click this button to display the Axes Scales dialog where you can set the scale range for 
the X and Y axes.

Autoscale
[XY] 

Click the Autoscale[XY] button to automatically scale collected data by scaling the 
ordinate (Y) height and abscissa (X) width to full screen.

Autoscale[X] Click the Autoscale[X] button to automatically scale collected data by scaling the 
abscissa (X) width to full screen.

Autoscale[Y] Click the Autoscale[Y] button to automatically scale collected data by scaling the 
ordinate (Y) height to full screen.

Zoom Out Click the Zoom Out button to Zoom back to the original X and Y ranges which were 
used to collect the data (i.e. the method setup conditions of the focused scan).  
For example, the system will revert back to the X and Y ranges set in the method if you 
zoom in and out during a data collection.

Add Label Click this button to display the Add Label dialog where you can enter a text label to be 
placed on a graph or in the background of the Graphics area. 

Add Picture  Click this button to display the Add Picture dialog where you can select a picture, bitmap 
or chemical structure to be placed on a graph or in the background of the Graphics area.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note 
The graph highlighted in the Multi Graph view will be displayed when you toggle 
the Single Graph option.

Auto 
Arrange 
Graphs 

Click the Auto Arrange Graphs button to view and arrange all graphs simultaneously. 
Note 
You can move graph boxes manually by clicking the left mouse button outside the 
graph axes and dragging the graph box to a new position. You can also resize 
graphs.

Add Graph Click this button to add a new graph box to the Graphics area. You may want to do this if 
you have, for example, a graph containing existing data is displayed and you want to 
collect some new data in a new graph.

Remove 
Graph 

Click this button to delete the selected graph box from the Graphics area. The graph box 
is removed, but the data is not deleted and is still available from the Trace Preferences 

Page 73 of 149Scan Home Page

   file://C:\Documents and Settings\cary\Local Settings\Temp\~hhF1E6.htm



Graph Labels—Scan 
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label

Use the Add Label dialog to place a label on your graph or into the background of the Graphics area. 

To add a label to a graph box, you must have at least one trace Visible in the graph box. (You can select which traces 
you want to make visible in the Trace Preferences dialog.) If you are viewing multiple graphs, the label will be 
placed in the graph box that is currently selected. However, you can add a label outside of a graph box in the 
background of the Graphics area at any time. 

window. 
You may want to use remove graph if you have a large number of graph boxes open but 
only want to focus on some of these. 

Note 
You can remove multiple graph boxes by first holding down the CTRL key and 
selecting the graphs to be removed and then selecting the Remove Graph button or 
menu item. Use the SHIFT key to highlight a range of graphs for removal.

Clear All 
Graphs 

Click this button to delete all traces from the graph/s. Note that selecting this option 
simply turns off the Visible property for the traces in the Trace Preferences window. 
You can redisplay the traces by making the traces Visible again in the Trace Preferences 
window.

User Data 
Form 

Click this button to display the User Data Form where you can enter extra information 
about the traces in the highlighted graph box. For example, you might want to record 
information about the experimental conditions you used to collect the data, such as the pH 
at which data was collected.

Calculator Click this button to display the Maths window where you can perform mathematical 
manipulations on collected traces. In addition, it can act as a simple numeric calculator.

See also: 
Trace Preferences   
Graph Preferences   
Cursor Modes   
Axes Scales   
Add Label   
Add Picture   
Single/Multi Graph  
User Data Form   
Maths window  
Graph menu 
Graphics Area 
Graphics How to

Add Label—Scan 
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The Add Label dialog comprises the following: 

Use the Edit Label dialog to alter the content or look of your label. 

To access the Edit Label dialog, right-click on the label you wish to change and select Edit Annotation from the 
menu. 

The dialog comprises the following: 

Q. Can I add a label that will print with all my graphs.
A. Yes, you can add your label to the background of the Graphics area. To do this, right-click on a section of the
background (gray area) and select Add Label from the menu. (You will notice that this menu has less options
than the menu that appears when you right-click on a graph.) In the Add Label dialog, enter the label to be
added to all graphs and select OK. The label will appear in the background of the Graphics area.

To access the Add Label dialog, select the Add Label command from the Graph menu, or select the Add 
Label button on the Graphics toolbar.

To selected 
trace

Select this option to associate a label with the selected trace. When you associate a label with a 
trace and make the trace visible in the Graph box, the label will also be displayed with the trace.

To selected 
graph

Select this option to associate the label with the selected graph. When you associate a label with a 
graph, the label will always be displayed in the Graph box, regardless of what traces are visible.

Selected trace This will identify the trace that is currently selected and display the name of the trace.
Font… Click Font to open the Windows Font dialog. In this dialog you can specify the font type, style 

and size to be used for the label.
Label Use the Label field to enter the text for the label. You can enter as many lines of text as you 

require.
Hot Tip 
If you wish to include certain XY co-ordinates on the graph as a label, position your cursor at the appropriate 
place, right-click and select Add Label from the menu. When the Add Label dialog appears, the co-ordinate 
positions will be added to the Label field. 
Note 
When you save the data (as a Batch or Data file) the label is saved with its associated trace or graph. Labels 
outside graph boxes can be saved in a graphics template. To do this, choose Graph Template as the Save As 
type in the Save As dialog. 
See 'Example of a Graphics Template'.
See also: 
Trace Preferences  
Graph menu  
Graphics toolbar  
How to add a label to a graph 
How to move a label 
How to edit a label   
How to resize a label  
How to delete a label

Edit Label—Scan 

Font Select Font to open the Font dialog, where you can specify the font type, style and size to be used 
for the label.

Label Use the Label field to alter the text for the label. 

See also: 
How to edit a label 
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How to add a label to a graph—Scan 
You can add a label to your graph or Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area background. 

Step 2 

Click the Add Label button on the toolbar or right-click on the graph and select Add Label from the menu. The Add 
Label dialog will appear. 
The Add Label command is also accessible from the Graph menu. 

Step 3 

Click the Font button. The Windows Font dialog appears. Select the font type, size and style you require for your 
label. A sample of the font style appears in the Sample field. When you are satisfied with your selections, select OK 
to return to the Add Label dialog. 

Step 4 

Enter the label in the Label field and select OK. The label will be displayed on the selected graph. If necessary, you 
can move a label so that it is more appropriately placed on your graph. 

How to edit a label—Scan 
Step 1  

Place the cursor on the label and click the left mouse button to select the label. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu. Alternatively you can select the 
Edit Annotation command from the Graph menu. The Edit Label dialog is displayed. 

Step 3  

Use the Edit Label dialog to change the label.

How to add a label to a graph 
How to resize a label 
How to move a label

Note 
There must be at least one trace Visible in the graph box before you can add a label to it.

See also: 
How to move a label 
How to edit a label  
How to resize a label

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label selection. Try 
zooming in and clicking in a different part of the label.
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For example, if you want to change the font size of the label, select the Font button. In the Size field, scroll through 
the available sizes for the font and select the size you require. Alternatively, highlight the currently selected size in 
the Size entry field and enter the size you require. Click the OK button in this dialog to return to the Edit Label 
dialog. 

Step 4  

Click OK to clear the Edit Label dialog. Your label will appear with the new font size. 

How to move a label—Scan 
To move a label so that it is more appropriately placed on your graph or Graphics area background, do the following: 

Step 1  

Place the cursor on the label. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the label to the correct position and release the mouse button. The label will be displayed at the new position. 

How to resize a label—Scan 
To resize a label so that it is more appropriately sized on your graph or Graphics area background, do the following: 

Step 1  

Select the label by clicking on it with the mouse. A border will be displayed around the label to indicate it is selected.

See also: 
How to add a label to a graph 
How to move a label  
How to resize a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic selection. Try 
zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label  
How to resize a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic selection. Try 
zooming in and clicking in a different part of the picture.
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Step 2  

Position the cursor over one of the corner edges of the label until the cursor becomes a diagonal double-headed 
arrow. Click and hold down the left mouse button. 

Example of label showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the label by dragging the mouse. The label text will also be resized. Release the 
mouse button when the label and text are the correct size. 

How to delete a label—Scan 
To delete a label from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the label and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. Alternatively, 
you can select the Delete Annotation command from the Graph menu. The label will be deleted from the graph or 
Graphics area. 

Graph Pictures—Scan 
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label selection. Try 
zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label
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How to delete a picture

Use the Add Picture dialog to insert a picture or bitmap into the Graphics area. The picture can be added as a 
background picture or to a particular graph box. 

To add a picture to a graph box you must have at least one trace Visible in the graph box. (You can select which 
traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple graphs, the picture will 
be placed in the graph box that is currently selected. However, you can add a picture outside of a graph box in the 
Graphics area at any time. 

The Add Picture dialog comprises the following commands: 

Use the Edit Picture dialog to change a picture you have inserted into the Graphics area. 

To access the Edit Picture dialog, right-click on the picture you wish to change and select Edit Annotation from the 
menu. 

Add Picture—ScanScan Application 

Q. Can I add a picture that will print with all my graphs.
A. Yes, you can add your picture to the background of the Graphics area. To do this, right-click on a section of
the background and select Add Picture from the menu. (You will notice that this menu has less options than the
menu that appears when you right-click on a graph.) In the Add Picture dialog, load the picture to be added to
all graphs and select OK. The picture will appear in the background of the Graphics area.

To access the Add Picture dialog, select the Add Picture command from the Graph menu, or select the Add 
Picture button on the Graphics toolbar.

To selected 
trace

Select this option to associate a picture with the selected trace. When you associate a picture with a 
trace and make the trace visible in the Graph box, the label will also be displayed with the trace.

To selected 
graph

Select this option to associate the picture with the selected graph. When you associate a picture 
with a graph, the label will always be displayed in the Graph box, regardless of what traces are 
visible.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer for the 
picture you want to insert. The picture must be one of the following formats: DIB, JPG, PGEG, 
BMP, EMF or WMF. 

If you are viewing multiple graphs the picture will be placed on the graph that is currently 
selected. If no graph is selected, the picture will be placed on the Graphics area background.  

When you save the data (as a Batch or Data file) the picture is saved with its associated trace or 
graph. Pictures outside graph boxes can be saved in a graphics template. To do this, choose Graph 
Template as the Save As type in the Save As dialog. 
See Example of a Graphics Template. 

See also: 
How to add a picture to a graph 
How to move a picture   
How to resize a picture 
How to delete a picture 
How to replace a picture

Edit Picture—Scan 
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The Edit Picture dialog comprises the following commands: 

How to add a picture to a graph—Scan 
You can add a picture to your graph or the Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area background. 

Step 2 

Click the Add Picture button on the toolbar or right-click on the graph and select Add Picture from the menu. The 
Add Picture dialog will appear. 
The Add Picture command is also accessible from the Graph menu. 

Step 3 

Click the Load button. The Windows Open dialog appears. 

Step 4 

Browse through your directories to find the picture you want to insert. All pictures must be in the bitmap format and 
will have the extension .BMP. 

Step 5 

Highlight the .BMP that you want to insert and select Open. 

Step 6 

The Add Picture dialog will appear showing a preview of the bitmap. If the bitmap is the correct one select the OK 
button. The bitmap will be placed onto the graph. 

You can move a picture so that it is more appropriately placed on your graph. 

To selected 
trace/ graph

Displays whether you originally selected to add the picture to a trace or a graph. This option is not 
editable.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer for the 
picture you want to insert. The selected picture will replace the current picture. The picture must 
be one of the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

See also: 
How to replace a picture 
How to add a picture 
How to move a picture   
How to resize a picture 
How to delete a picture

Note 
There must be at least one trace Visible in the graph box before you can add a picture to it.

Note 
You should take care not to add a bitmap that is too big as it will obscure part or all of your graph.
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How to replace a picture—Scan 
To change a picture that you have added to a graph or Graphics area background do the following: 

Step 1  

Move the cursor to the picture and select the left mouse button to select it. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu or select Edit Annotation from 
the Graph menu. The Edit Picture dialog is displayed. 

Step 3  

From the Edit Picture dialog, select the Load button. The Windows Open dialog is displayed. 

Step 4  

Browse through your directories to find the picture to replace the current bitmap. Picture files must be in one of the 
following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

Step 5  

Highlight the file that you want to insert and select Open to return to the Edit Picture dialog. 

Step 6  

The Edit Picture dialog will display a preview of the bitmap. If the bitmap is the correct one select the OK button. 
The bitmap will be placed onto the graph. If you need to, move the picture so that it is more appropriately placed on 
your graph. 

How to move a picture—Scan 
To move a picture so that it is more appropriately placed on your graph or Graphics area background, do the 
following: 

Step 1  

See also: 
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic selection. 
Try zooming in and clicking in a different part of the picture.

Note 
Do not to add a bitmap that is too big as it will obscure part or all of your graph. 

See also: 
How to add a picture to a graph 
How to move a picture 
How to delete a picture
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Place the cursor on the picture. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the picture to the correct position and release the mouse button. The picture will be displayed at the new 
position. 

How to resize a picture—Scan 
To resize a picture so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the picture by clicking on it with the mouse. A border will be displayed around the picture to indicate it is 
selected. 

Step 2  

Position the cursor over one of the corner edges of the picture until the cursor becomes a diagonal double-headed 
arrow. Click and hold down the left mouse button. 

Example of picture showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the picture by dragging the mouse. The picture will also be resized. Release the 
mouse button when the picture is the correct size. 

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic selection. 
Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic selection. 
Try zooming in and clicking in a different part of the picture.

See also: 
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How to delete a picture—Scan 
To delete a picture from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the picture and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. Alternatively, 
you can select the Delete Annotation command from the Graph menu. The picture will be deleted from the graph or 
Graphics area. 

Trace Preferences table | Trace Options | Trace Audit Log 

A single graph box can display many traces. Use the Trace Preferences dialog to select the trace(s) to display (make 
Visible) in the selected graph box.  

The dialog comprises the following: 

Trace Preferences table 

How to add a picture to a graph  
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic selection. 
Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to move a picture 
How to zoom a graph  
How to resize a picture

Trace Preferences—Scan 

To access the Trace Preferences dialog, select the Trace Preferences command from the Graph menu, or 
select the Trace Preferences button on the Graphics toolbar.

Hot Tip 
The Trace Preferences menu is also available on clicking the right mouse button anywhere in the trace 
listing.

Visible Use the Visible field to select which traces will appear on the selected graph. To select or clear 
the Visible field, simply click the left mouse button in this column. A tick will appear next to 
traces that are to be displayed in the selected graph. 

If you are in single graph view, all selected traces will appear on the one graph. If you are in 
Multi Graph view the traces will appear on the graph that is currently selected.  
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Trace Options 

Trace Audit Log 

Hot Tip 
To make all traces Visible, right-click on the table and select the Select All command from 
the menu. Then right-click on the table again and select the Show Traces command from 
the menu.

Color The Color field enables you to view the color of each trace that appears on the selected graph.  To 
change the color of a trace, highlight it, click the right mouse button in the Trace Preferences 
table and select Change Trace Color. You can then select a color from the Color dialog that is 
displayed. 

The red trace in any graph box is the one on which all information appears. This trace, which is 
used for the cursor tracking, is called the focused trace and it is always red. When you select a 
trace in the Color column it will become the focused trace in the selected graph box.  

Note 
When you change the trace line width in the Graph Preferences dialog it also will change 
the width of the color trace line in this dialog.

Name of trace The Name of Trace field contains a description of the traces currently available for display in the 
selected graph box.

Filename This field displays the filename and path for the trace. If the name is too long to appear in the field 
you can use the keyboard arrow keys to scroll to the end of the filename or you can resize the 
Trace Preferences window. If the file path for a trace shows 'not saved' then the trace is unsaved 
data and is only stored in memory.

Select Traces You can choose to include all traces of the graph you have produced in the Contours or 3D graph 
or a subset of these traces. The subsets you can choose from will depend upon the data points you 
have entered next to the samples in the User Data Form. For example, if you have included time 
based data points under the Data name of 'Time', this group of data points will be included in the 
Select trace list under the heading of 'Time'.

Note 

The following options are only visible if you have selected the Contour Graph button  or the 3D Graph 

button  to create a Contour or 3D graph.
Z Start Enter the value at which the Z axis will be started. Generally, this is the Start Excitation 

Wavelength that was entered on the Cary page of the Setup dialog. 
If you have selected All Traces, this option will not be available. Instead the axes will start at the 
first point you have defined for the selected traces. (These points are defined in the User Data 
Form.) For example, if you have selected to view Time traces only, the first data point for these 
traces will be used as the first point on the Z axis.

Z Interval Enter the interval, or the value between each point on the Z axis. Generally, this is the Delta that 
was entered on the Cary page of the Setup dialog. 
If you have selected All Traces, this option will not be available. Instead the intervals will be 
placed evenly amongst the data points you have defined for the selected traces. (These data points 
are defined in the User Data Form.) Note that the intervals may not correspond to actual data 
points.

Z Axis Enter a label for the Z axis. This label will be displayed in the graph area. 
If you have selected All Traces, this option will not be available. Instead the Data name you 
have assigned in the User Data Form will be used as the Z axis label.
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The Trace Audit Log displays information about the highlighted trace. This includes instrument parameters and data 
form information relating to the trace that has been selected. It also logs all information about data manipulation. 
When more than one trace is highlighted, the Trace Audit Log will display information about the trace that was first 
selected. 

Trace Preferences menu—Scan 
The Trace Preferences menu is displayed when you click the right mouse anywhere on the Trace Preferences table. 
The menu contains the following commands: 

How to select the focused trace—Scan 
To select the scan that you want to be the focused (red) trace, do one the following: 

From the Graph, click the left mouse button on the trace that you want to make the focused trace.

From the Graph Legend (if displayed), click the left mouse button on the trace that you want to make the
focused trace.

From the Trace Preferences dialog, click in the Color column of the trace that you want to make the focused
trace.

See also: 
Trace Preferences menu  
Contour graphs  
Contour Graph Preferences  
3D graphs 
User Data Form  
Graph menu   
Graphics toolbar 

Command What it does…
Select All This selects or highlights all the traces in the listed on the Trace Preferences page.
Select None This de-selects all the traces in the listing.
Show Traces Select Show Traces to make all of the traces currently highlighted ‘Visible’, meaning that they 

will be displayed in the current graph box.
Hide Traces Select Hide Traces to remove the ‘Visible’ property from all the traces currently highlighted, 

which will remove them from the current graph box.
Delete Traces Select Delete Traces to delete all the highlighted traces in all graphs. Note that if you save the 

data file before you select Delete Traces, the traces are not deleted from the saved file, and they 
can be retrieved at a later date. 
Selecting Delete Traces will delete the traces from the application memory, and it is 
recommended that you select this option if you need to free up memory on your computer. 

Note 
If the application is controlled by the GLP Administration application, you will be 
prompted to save an unsaved data file before it is removed from the application. 

Change Trace 
Color 

Select Change Trace Color to display the Windows Color dialog where you can change the 
color of the currently highlighted trace(s). The focused trace will remain red while it retains the 
focus, and will revert to the selected color when the focus is moved.

See also: 
Trace Preferences page 
Graph Preferences page 
How to remove a trace from the trace list 
How to remove a trace from a graph
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How to display a trace that is not appearing in the graph box—Scan 
Step 1 

Click on the graph in the Graphics area. 

Step 2 

Select the Trace Preferences button  from the Graphics toolbar, or select Trace Preferences from the Graph 
menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you wish to see and select the Visible option. A tick will appear in the Visible column to indicate 
that it will now be displayed.  

If you wish to make multiple traces visible, do the following: 

a. Hold down the CTRL key select all the traces that you want to display.

b. Click the right mouse button and select the Show Traces command from the drop-down menu. Ticks will
appear next to the selected traces to indicate that they will now be displayed.

Step 4 

Press OK to clear the Trace Preferences dialog. The selected trace(s) will be displayed. 

How to remove a trace from a graph—Scan 
Step 1 

Select a graph in the Graphics area. 

Step 2 

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the Graph menu. 
The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you no longer wish to see and select the Visible option. The tick will be removed from the Visible
column to indicate that it will not be displayed.  

If you wish to make multiple traces visible, do the following: 

Note 
Select the Show Legend check box in the Graph Preferences dialog to display the Graph Legend. 

See also: 
How to track the focused trace 
How to view a particular trace

See also: 
How to remove a trace from a graph 
How to remove a trace from the trace list
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a. Hold down the CTRL key select all the traces that you no longer want to display.

b. Click the right mouse button and select the Hide Traces command from the drop-down menu. The ticks will
be removed from the selected traces to indicate that they will not be displayed.

Step 4 

Select OK to clear the Trace Preferences dialog. The trace will be removed from the graph. 

How to remove a trace from the trace list—Scan 
If your graphs contain unwanted traces, you may wish to delete them (rather than simply making them invisible) in 
order to free up application memory and aid system performance. 

Step 1  

Select a graph in the Graphics area. 

Step 2  

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the Graph menu. 
The Trace Preferences dialog is displayed. 

Step 3  

Select the trace to be removed by clicking on it. 

Step 4  

Click the right mouse button to display the Trace Preferences menu. 

Step 5  

Select Delete Traces to delete the sample from the trace list. You will be prompted to confirm this action. 

Step 6  

Select OK to clear the Trace Preferences dialog. The trace will be removed from all graphs. 

Graph Preferences—Scan 
Use the Graph Preferences dialog to change the appearance of your 2D or Contours graph.  

Any changes you make to the appearance of the graph will apply to all graphs until the settings are changed again. 

See also: 
How to display a trace that is not appearing in the graph box 
How to remove a trace from the trace list

See also: 
How to remove a trace from a graph 
How to display a trace that is not appearing in the graph box

To access the Graph Preferences dialog, select the Graph Preferences command from the Graph menu, or 
select the Graph Preferences button on the Graphics toolbar.
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The Graph Preferences dialog comprises the following tabbed pages:  

2D Graph
Contours

2D Graph Preferences—Scan 
Axes Preferences | Advanced Options | Trace Style | Show Legend 

Use the 2D Graph Preferences dialog to change the appearance of your 2D graphs. 

All graphs will appear labeled with the X axis label being horizontal and the Y axis vertical. You cannot change the 
orientation of these labels. However you can alter the font and size of the axes and their labels. Any changes you 
make to the appearance of the graph will apply to all graphs until the settings are changed again. 

The 2D Graph Preferences dialog comprises the following:  

Axes Preferences 

Advanced Options 

See also: 
Graph menu 
Graphics toolbar 
Graphics area 
Graphics How To

To access the 2D Graph Preferences page, select the 2D Graph tab from Graph Preferences dialog. To 
access the Graph Preferences dialog, select the Graph Preferences command from the Graph menu, or 
select the Graph Preferences button on the Graphics toolbar.

Axes Color Select the color that you want to assign to the axes of the graph/s from the drop down list.

Axes Width Select the width of the axes from the drop down list. The width, which is in pixels, ranges 
between one and five pixels.

Grid Style Select the style of grid for the graph from the drop down list. If you do not wish to include a grid 
on the graph, select None.

Plot Area 
Color

Select the color to be used as the background of the graph from the drop down list. If you do not 
want a background color on the graph, select White.

Trace Width Select the width of the trace from the drop down list. The width is given in pixels and ranges 
between one and five pixels.

Font Click the Font button to display the Windows Font dialog where you can define the font style for 
the axes of the graph/s. The style and size of the font will be applied to all graph. The style, name 
and point size of the font appears on the font button.

Preview Box Preview any changes you make to the axes preferences in the preview box. The changes shown in 
this box will not be made until you select OK.

Auto tick 
marks

The Auto tick marks option enables you to approximately set how many tick marks (or points) 
will be included on the graph axes. The tick marks generated will be whole, rounded, even 
numbers. The Auto tick marks option is not available if you have selected Major ticks. 

Y-axis
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Trace Style 

Show Legend 

Contours Graph Preferences—Scan 
Axes Preferences | Advanced Options | Trace Style | Legend 

Introduction 

Use the Contours page to change the appearance of your Contours graph. 

Use the Y-axis slider bar to increase or decrease the number of tick marks (or points) to be 
included on the Y axis. 

X-axis
Use the X-axis slider bar to increase or decrease the number of tick marks (or points) to be
included on the X axis.

Major ticks Use the Major Ticks option to enable you to set exactly how many ticks (or points) will be 
added to the X and Y axes. The number of marks you specify will be divided by the axis range, 
which can result in odd numbers on the axis. Note that any changes are not reflected in the graph 
bitmap at the top of the screen.

Decimals Use the Decimals option to set the number of X and Y decimal places to be displayed on the 
axes. To set the number of decimal places, select the Decimal option and enter the number in the 
Y-axis and X-axis combo boxes. Note that any changes are not reflected in the graph bitmap at
the top of the screen.

Points Select Points to display each individual data point collected by the Cary Eclipse on the graph.

Points and  
solid lines

Select Points and Solid Lines to display each individual data point collected by the Cary Eclipse 
on the graph. Additionally, an interpolated line that connects the points will be drawn.

Solid lines If you select Solid Lines, the Cary Eclipse system will interpolate the data between the actual, 
collected data points and show the data as a continuous line.

Style cycles 
automatically

If you select Style Cycles Automatically, the Cary Eclipse system will display each of the above 
three trace styles. This makes it easier to differentiate between traces, especially on black-and-
white printers.

Show Legend Select Show Legend to display a legend in the right side of each graph box. 
A single left click on a sample name or example line within the legend will make it the focused or 
red scan. Information about the trace will be displayed below the X axis. 

Hot Tip 
Double-clicking on the legend will automatically display the Trace Preferences window, 
allowing you to view more detailed information about your trace (e.g. audit log, File name, 
etc.). 

See also: 

Graph Preferences  
Graph menu 
Graphics toolbar 
Graphics area 
Graphics How To 
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Any changes you make to the appearance of the graph will apply to all graphs until the settings are changed again. 

The Contours page comprises the following:  

Axes Preferences  

Advanced Options 

Trace Style 

Legend 

To access the Contours page, select the Contours tab from the Graph Preferences dialog. To access the 
Graph Preferences dialog, select the Graph Preferences command from the Graph menu, or select the 
Graph Preferences button on the Graphics toolbar.

Axes Color Select the color that you want to assign to the axes of the graph/s from the drop down list.

Grid Style Select the style of grid for the graph from the drop down list. If you do not wish to include a grid 
on the graph, select None.

Plot Area 
Color 

Select the color to be used as the background of the graph from the drop down list. If you do not 
want a background color on the graph, select White.

Plot Axes Font Select the font size to be used for the plot axes. Select from Small, Medium or Large text.

Line colors If you choose to view the Contour graph as a series of lines rather than colors (by setting the 
Trace Style to Solid Lines), you can select the line color which will be displayed on the Contour 
graph. To do this, select a color from the drop down list. 

Preview Box Preview any changes you make to the axes preferences in the preview box. The changes shown in 
this box will not be made until you select OK.

Major ticks Use the Major Ticks option to enable you to set exactly how many ticks (or points) will be 
added to the X and Y axes. The number of marks you specify will be divided by the axis range, 
which can result in odd numbers on the axis. Note that any changes are not reflected in the graph 
bitmap at the top of the screen.

Decimals Use the Decimals option to set the number of X and Y decimal places to be displayed on the 
axes. To set the number of decimal places, select the Decimal option and enter the number in the 
Y-axis and X-axis combo boxes. Note that any changes are not reflected in the graph bitmap at
the top of the screen.

Solid lines If you select Solid Lines, the Contours graph will be displayed as a series of lines. You can 
choose to label these lines by selecting the Data labels option.

Colors If you select Colors, the Contours graph will be displayed as a series of evenly spread colored 
bands. You can set the number of colors to be included, ranging from 2–200. 

Hot Tip: 
Increasing the number of colors will increase the file size and printing time. If you are 
printing out Contour graphs, it is recommended that you limit the number of colors (for 
example, to 28).

Position Select where to position the legend. Choose from Left, Right, Top or Bottom. Select None if you 
do not wish to display a legend.
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How to alter the look of your graphs—Scan 
Step 1 

Click the Graph Preferences button  on the Graphics toolbar, or select Graph Preferences from the Graph 
menu. The Graph Preferences dialog is displayed. 

Step 2 

Use the available options available to choose your preferred appearance for the graphs. A preview box in the top 
right-hand corner will demonstrate how the graphs will appear. 

Step 3 

Select OK to clear the Graph Preferences dialog and update all graphs to reflect your selections. 

Step 4 

To re-use your graphics setup at a later date, save the setup as a graphics template. 

Use the Cursor Modes dialog to choose the type of cursor to be used on screen. For example, you can select to use a 
free cursor that can move anywhere in the graph.  

The dialog comprises the following: 

Decimals Select the number of decimal points to be included in points on the legend. 

See also: 
Contour Graphs  
Contour Graph Preferences  
Graph menu 
Graphics toolbar 
Graphics area

Note 
You can also add labels and pictures to your graphs to alter their appearance. 

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture 
How to resize graph boxes 
How to make a graphics template

Cursor Modes—Scan 

To access the Cursor Modes dialog, select the Cursor Modes command from the Graph menu, or select the 
Cursor Modes button on the Graphics toolbar.

Free The Free cursor is not confined to a particular trace on the graph. It can move anywhere in a 
graph box, and its ‘X,Y’ position is shown in the bottom right-hand side of the Graphics area. 
You can use the Free cursor to zoom in on a particular part of a graph. 
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How to track the focused trace—Scan 
To track the focused (red) trace in the graph: 

Step 1  

Click the Cursor Modes button  from the Graphics toolbar, or select Cursor Mode from the Graph menu. The 
Cursor Modes dialog will appear. 

Step 2  

Select Track and select the OK button. 

Step 3  

Place the blue tracking cursor in the graph box you require. 

Step 4  

Move the cursor left and right across the graph box to trace the focused (red) scan. The cursor coordinates change (in 
the X, Y field at the bottom left hand corner of the Graphics area) as you move along the curve. 

Use the Axes Scale dialog to manually change the axes range. This can assist in zooming in on a particular part of the 

Note 
The Free cursor moves from point to point in the selected graph box. Hence you need to be 
careful when positioning the cursor over a scan to obtain an accurate (X,Y) reading. It is 
recommended that you use the Track cursor mode for this.

Track Use the Track cursor to exactly trace the focused (red) scan in a graph box. The cursor position 
is displayed in the X and Y at the bottom right-hand side of the Graphics area. 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the 
required position. Click the left mouse button, press ALT on the keyboard, then release the 
mouse button.

Track 
Intensity

Select the Track Intensity option if you want to associate an intensity value with the tracking. 
The cursor will then track from point to point on the continuum between the intensity value you 
enter. The default value will be 50% of the maximum intensity of the focused continuum.

Peaks/ Valleys Choose from the options of Peaks, Valleys or Peaks Valleys to move the cursor from peak to 
peak, valley to valley or from one peak/valley to the next.

See also: 
How to zoom a graph 
How to track the focused trace

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the required position. 
Press 'Alt' on the keyboard, then release the mouse button. 

See also: 
How to select the focused trace 
How to view a particular trace

Axes Scales—Scan 
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graph. 

The dialog comprises the following: 

X Axis 

Y Axis 

Z Axis 

How to scale your graph manually—Scan 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

Click the Axes Scales button  on the toolbar, or select Axes Scales from the Graph menu. The Axes Scales 
dialog id displayed. 

Step 3  

Type in the new ranges for the X and Y axes in the format ‘n-n’, or choose an option for each from the drop-down 
list. 

Step 4  

To access the Axes Scale dialog, select the Axes Scale command from the Graph menu, or select the Axes 
Scale button on the Graphics toolbar.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the X axis, in the format n1 - n2 (where n1 is the start 

of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can access by 
selecting the down arrow adjacent to the Scale field.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the Y axis, in the format n1 - n2 (where n1 is the start 

of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can access by 
selecting the down arrow adjacent to the Scale field.

Mode View the current units for the Z axis.
Scale Use the Scale field to enter a new range for the Y axis, in the format n1 - n2 (where n1 is the start 

of the scale and n2 is the end of the scale). 
See also: 
How to scale your graph manually 
How to scale your graph automatically 
How to zoom a graph
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Select OK. The axes on the selected graph will change to reflect your chosen settings. 

How to scale your graph automatically—Scan 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

To autoscale the graph, select one of the following:  

Click the Autoscale XY button  on the toolbar to autoscale both X and Y axes.  

Click the Autoscale X button  on the toolbar to autoscale the X axis only.  

Click the Autoscale Y button  on the toolbar to autoscale the Y axis only.  

The focused trace will be scaled according to the option selected. 

Viewing graphs—Scan 
Single/Multi Graph
Individual Data and Overlay Data

Single/Multi Graph—Scan 
Select this option to toggle between a display of either one or multiple graph boxes in the Graphics area. Note that up 
to 100 graphs can be displayed in the Graphics area at the one time.  

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale a graph automatically

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale your graph manually

The Single/Multi Graph option is accessible from the Graph menu or the Graphics toolbar.
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Example of a single graph box display 

Example of a multi graph box display 

Individual Data and Overlay Data options—Scan 

See also: 
Graph menu 
Graphics toolbar 
Graphics How To

Overlay Data selected 
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Peak Picking—Scan 

With Peak Style set to 'Peaks' and Peak Threshold set to 'x', peak B is not detected. This is because the ordinate value 
on the right-hand side of peak B has not decreased by a minimum of 'x'. 

The Peak Threshold, 'x' is reduced, but peak B is still not detected. This is because the ordinate value on the left-hand 
side of the peak does not decrease by a minimum of 'x'. 

Peaks A and B are now detected. This is because the Peak Threshold value, 'x' is less than or equal to the decrease in 
the ordinate value on both sides of these peaks. 

You can use the Cary Eclipse software to create contour graphs of your collected data traces. You can use contour 
graphs to quickly display maps of an excitation versus emission matrix for your sample of interest. Contour maps 
enable you to quickly identify peaks, whether you are looking at a single component with many peaks or a mixture of 
peaks. 

Contour graphs can be viewed as lines or as bands of color. You can select the graph settings on the Contour page of 
the Graph Preferences dialog. You can choose to include all traces of the graph you have produced in the Contours 

Individual Data selected 

Contour Graphs—Scan 
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graph or a subset of these traces. The subsets you can choose from will depend upon the data points you have entered 
next to the samples in the User Data Form. For example, if you have included time based data points under the Data 
name of 'Time', this group of data points will be included in the Select trace list under the heading of 'Time'. 

In the example below, the contour graph is being viewed as bands of color. With the use of the legend on the right, 
you can quickly identify the most intense by its color, in this case a deep red. 

An example of a contour graph, viewed as colored bands 

In the example below, the contour graph is being viewed as solid lines. In this case you would determine the most 
intense peak by firstly identifying the centres of contours and then comparing the intensity values for each of these 
centres. The centre with the highest intensity will be the highest peak. 
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An example of a contour graph, viewed as solid lines 

To select a Contour Graph, simply click on any part of the graph (the plotting area). You can then apply many of the 
standard graph features available from Graphics toolbar. These include choosing a cursor mode, setting the X and Y 
axes scales, zooming the graph, viewing single or multiple graphs and deleting the graph. To move a contour graph, 
click on the graph box (the surrounding gray area), hold down your mouse and move the graph as required. 

Once you have created a contour graph, you can also create XY and/or YZ slices of the contour graph at any point 
you select.  

How to create a contour graph—Scan 
You can use the Cary Eclipse software to create contour graphs of your collected data traces. 

To create a contour graph: 

Step 1 

Select an existing data trace. 

Step 2 

From the Graphics toolbar, select the Contour Graph button . The Trace Preferences dialog is displayed. 

Step 3 

In the Select Traces field of the Trace Preferences dialog, select the type of data traces you wish to display. By 
default, this will be set to All Traces, however you can select a subset of traces. The subsets you can choose from 
will depend upon the data points you have entered next to the sample names in the User Data Form. For example, if 
you have included time based data points under the Data name of 'Time', this group of data points will be included in 
the Select trace list under the heading of 'Time'. 

Step 4 

If you have selected All Traces, enter the Z Start and Z Interval values. These values correspond to the starting 
point of the graph and the interval between points. 
Enter a label for the axis in the Z Axis field. 

Step 5 

Select OK to clear the Trace Preferences dialog. The contour graph will be displayed in the graphics area. 

To select a contour graph, simply click on any part of the graph (the plotting area). You can then apply many of the 
standard graph features available from Graphics toolbar. These include choosing a cursor mode, setting the X and Y 
axes scales, zooming the graph, viewing single or multiple graphs and setting the graph preferences. To move a 
contour graph, click on the graph box (the surrounding gray area), hold down your mouse and move the graph as 
required. 

See also: 
How to create a contour graph   
How to create a slice from a contour graph  
Contour Graph Preferences  
Trace Preferences  
User Data Form 

Page 98 of 149Scan Home Page

   file://C:\Documents and Settings\cary\Local Settings\Temp\~hhF1E6.htm



How to create a slice from a contour graph—Scan 
You can use the Cary Eclipse software to create a slice from a contour graph. 

To create a slice of a contour graph: 

Step 1 

Select an existing contour graph. To do this, simply click in the plotting area of the graph. 

Step 2 

From the Graphics toolbar, select the XY Slice button . The XY Slice dialog is displayed. 

or 

From the Graphics toolbar, select the YZ Slice button . The YZ Slice dialog is displayed. 

Step 3 

The XY Slice and YZ Slice dialogs will prompt you to click on an area of the contour graph to create a slice. Select 
OK to clear this dialog. The Graphics display will be updated to include a blank Slice Graph. 

Step 4 

Click on the points of the contour graph that you want to add to the slice graph. A graph of the XY and/or YZ point 
will be added to the appropriate graph. You can add as many points as you like. 

3D Graphs—Scan 
The 3D Grams application by Galactic software® is included in the Cary Eclipse software. You can use the software 
to create 3D graphs of your collected data traces. 3D graphs are useful when you are analyzing an unknown sample. 
3D graphs enable you to quickly produce distinct peaks of samples that may be emitting at a number of different 
wavelengths. Using the 3D graph, you will be able to determine the most suitable excitation and emission 
wavelengths for a sample. 

You can choose to include all traces of the graph you have produced in the 3D graph or a subset of these traces. The 
subsets you can choose from will depend upon the data points you have entered next to the samples in the User Data 
Form. For example, if you have included time based data points under the Data name of 'Time', this group of data 
points will be included in the Select trace list under the heading of 'Time'.

See also: 
Contour Graphs  
Contour Graph Preferences  
Trace Preferences 

Hot Tip: 
You can create both XY and YZ slices of the same point on the contour graph. To do this, select both the XY 
Slice button and YZ Slice button before selecting any points on the contour graph. 

See also: 
How to create a contour graph  
Contour Graphs  
Contour Graph Preferences  
Trace Preferences 
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An example of a 3D graph 

Examples of 3D collects—Scan 

Excitation scan mode 3D example 

Scan setup: Excitation scan mode 

3D mode 

Em. stop = 550 nm, Ex. increment = 10 nm 

The system will perform excitation scans at each of the following emission monochromator wavelengths:

See also: 
Trace Preferences  
User Data Form  
Contour Graphs 

X mode nm
Start 400
Stop 500
Em. 500 nm
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Emission scan mode 3D example 

Scan setup: Emission scan mode 

3D mode 

Ex. stop = 360 nm, Ex. increment = 120 nm 

The system will perform emission scans at each of the following excitation monochromator wavelengths: 

Synchronous scan mode 3D example 

Scan setup: Synchronous scan mode 

X mode nm
Start 360
Stop 400
Ex. 300 nm

Start 300
Stop 400
Delta 20 nm
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3D mode 

Delta stop = 40 nm, Increment = 5 nm 

The system will perform five synchronous scans, using the following Delta nm values: 

Example of a Graphics Template—Scan 
By using the Add Label command in the Cary Eclipse graphics system, you can customize a graphics template such 
as the one shown below: 

20 nm
Ex. monochromator: 300–400 nm
Em. monochromator: 320–420 nm

25 nm
Ex. monochromator: 300–400 nm
Em. monochromator: 325–425 nm

30 nm
Ex. monochromator: 300–400 nm
Em. monochromator: 330–430 nm

35 nm
Ex. monochromator: 300–400 nm
Em. monochromator: 335–435 nm

40 nm
Ex. monochromator: 300–400 nm
Em. monochromator: 340–440 nm

See also: 
Cary  
Example of a synchronous scan
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The above is created as follows: 

The graph on the left is the collected data.
The text on the top right is a multi-line label (added using the Add Label command).
The logo is an inserted picture (added using the Add Picture command).

How to make a graphics template—Scan 
A graphics template lets you set up and store the style of a graphics report for future use. You can do this by adding 
labels and pictures to the background of the Graphics area and altering any axes styles etc. One advantage of this 
over the application's built-in reporting features is that you have more flexibility as to where you can position graph 
boxes and any text that you may want to appear (e.g. operator name, batch number etc.) and also where you add 
pictures, e.g. company logos etc. 

Step 1 

Start the application and open the data file from which you want to make a graphics template. Alternatively, collect 
some new data. 

Step 2 

Make as many graph boxes as you require in your template by using the Add Graph function. 

Step 3 

Adjust the graph boxes to the correct size and position them as you want them to appear in the template. 

Step 4 

Do any of the following, if required: 

Change the appearance of the graph boxes in the Graph Preferences dialog

See also:
Add Label
How to make a graphics template
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Use the Add Label function to append text to the Graphics area
Use the Add Picture function to add pictures, such as your company's logo to the Graphics area

Step 5 

From the File menu, select Print Preview. Use the Print Preview dialog displayed to check the template that you 
have created. 

Step 6 

When you are satisfied with the appearance of the graphics, select the Save As… command from the File menu. The 
Save As dialog is displayed. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and select 'Graph 
Template' to list all the template files. Ensure that the Save only focused trace check box is cleared. 

Step 8 

Enter a name for the template in the File name field. 

Step 9 

Select OK to save the graphic template. The template will be used each time you create a new file. 

Examples—Scan 
Example of an emission scan
Example of an excitation scan
Example of a synchronous scan
Examples of 3D collects

Example of an Excitation Spectrum—Scan 
Select Emission to perform an emission scan. During the scan, the excitation monochromator is set to a fixed 
wavelength and the emission monochromator is scanned over a wavelength range. This results in a fluorescence 
excitation spectrum. 

The excitation spectrum is a plot of intensity at a particular emission wavelength against the wavelengths of the 
exciting light. When collecting an excitation spectrum you need to determine where you have to excite the system to 
see fluorescence at the chosen emission wavelength. 

The Emission selection is set on the Cary page. The following is an example of an Excitation Spectrum.

Note 
You can also make a graphic template in a similar manner from existing data. No data will be saved in the 
template. 

See also: 
Example of a Graphics Template 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture
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Example of an Emission Spectrum—Scan 
Select Excitation to perform an excitation scan, which is a qualitative absorption spectrum. During the scan, the 
emission monochromator is set to a fixed wavelength and the excitation monochromator is scanned over a 
wavelength range. This is often referred to as the emission spectrum or the fluorescence spectrum. 

Emission spectrums are characteristic of molecular structure and environment of material. The shape of the 
fluorescence spectrum is independent of the excitation wavelength because the emission always originates from the 
lowest excited state. The spectrum is often a “mirror image” of the absorption spectrum. 

The Excitation selection is set on the Cary page. The following is an example of an emission spectrum.

See also: 
Example of an Emission Spectrum 
Cary page 
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Example of a synchronous scan—Scan 
If you select to perform a Synchronous scan, the excitation and emission monochromators will be scanned 
synchronously with a fixed delta (which is a real number and may be zero), between both monochromators. The 
Synchronous Scan mode can be used to resolve multi-component mixtures. 

This option is available from the Cary page of the Scan Application if you select Fluorescence or Phosphorescence 
as the Data Mode. 

Flowchart of a Synchronous Scan 

See also: 
Example of an Excitation Spectrum 
Cary page 
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Example using a Fluorescein and RhB mixture 

The emission scan of the mixture of Fluorescein and RhB 

The separated scans of Fluorescin (red line) and RhB (blue line) 
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A synchronous scan of Fluorescein and RhB 

Example of a Corrected Spectra—Scan 
The Correction Curves command is selected from the Commands menu. The following is an example of 
uncorrected and corrected spectra. 

File Management—Scan 
File menu
Open dialog
Save As dialog

See also: 
Cary page  
Examples of Excitation, Emission and Synchronous 3D collects

See also: 
Commands menu 
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Filename extensions
ASCII spreadsheet file
Auto Store page
How to export collected data
How to combine data files into a batch file

File menu—Scan 
Use the File menu to open or save a method or data file, print or preview a report, or exit the Cary Eclipse 
application. 

The following commands can be accessed from the File menu: 

Open—Scan 
Look in | File name | Files of type | Overlay Data | Open 

Use this dialog to open a file previously saved by the application. To access the Open dialog, select Open or Open 

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open it. Any data 
will be displayed in the Graphics area.

Command What it does…
New Select New to clear all method information and report information and create a new file 

containing the default settings for the application. The Save As dialog will be displayed for you to 
enter the name of the new file and select a location.

Open 
Method… 

Select Open Method to display the Open dialog where you can search for and load a stored 
method. 

Open… Select Open to display the Open dialog where you can search for and load method, data, report, 
graph template and batch files, as well as other file types compatible with the Cary Eclipse 
software. When you load a batch file, the method which collected the data is loaded as well as the 
associated report and graphics layout.

Save Method 
As… 

Select this option to display the Save As dialog and store the current method. You can use the 
Save As dialog to store the method, data, report, or graphics template separately or together as a 
Batch file. The data can also be saved as a comma delimited ASCII Spreadsheet file.

Save As… Select this option to display the Save As dialog and store the collected data. You can use the Save 
As dialog to store the method, data, report, or graphics template separately or together as a Batch 
file. The data can also be saved as a comma delimited ASCII file.

Print Setup… Select this option to display the Windows Print Setup dialog where you can select the printer, 
printer page size and orientation.

Print 
Preview… 

Select this option to display the Print Preview dialog where you can view the current report as it 
will be printed.

Print… Select this option to display the Windows Print dialog where you can choose the printer and pages 
to print as well as the number of copies you wish to print.

Explorer… Select this option to run Windows Explorer. This may help you locate method and data files.
History List This displays a list of the four most recently opened files.
Exit Select this option to exit the Scan application. 

 
See also: 
Filename Extensions 
ASCII Spreadsheet File
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Method from the File menu. 

Look in The Look In field lists the available folders and files. Click the down arrow on the right of this 
field to view the location of the current folder in your computer's hierarchy. You can also select a 
new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In field. 

Note 
To open the folder in the level that is one higher than the current folder, select  on the 
toolbar.

Look in list 
box  

The Look In List Box, which is directly below the Look In field, displays the folders and files in 
the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted text entry 
field that appears and press Enter. Then double-click on the new folder to open it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the date the file 
was last modified.
Click to preview the selected trace before you load it into the application.

File name Enter the name of the file you want to open in this field. The easiest way to do this is to find the 
file in the Look in list box and then select the file. However, you can type the full path of a file 
and then select Open to open the file.

Files of type Click on the arrow on the right of this field to view a list of the different types of application files 
that can be opened in the list box. 
Methods (*.FMSW) Choose this file type to open a Method file. Only the method is loaded. 

No data is loaded.
Data (*.FDSW) Choose this file type to open a Data file. Only the data is loaded. The 

method that was used to collect the data is not loaded. The last used 
method or default method will be displayed.

Report (*.FRSW) Choose this file type to open a Report file. You can view the report in 
the Report area.

Graph Template 
(*.FGSW) 

Choose this file to open a Graph Template file. The file will set up the 
layout of the Graphics area including any bitmaps as well as the range 
and style of the graph axes.

Batch (*.FBSW) Choose this file type to open a Batch file. A Batch file includes data, 
the method used to collect the data, report and graphics setup.

Spreadsheet Ascii 
(*.CSV)

This will open ASCII files that contain single comma delimited files 
with two or more columns.

GRAMS (*.SPC) Choose this file type to open a Cary Eclipse GRAMS data file. This 
allows you to use data files collected using a Cary Eclipse GRAMS 
system. The method that was used to collect the data is not loaded.

ADL (*.ADL) This will open and run program files generated in the Applications 
Development Language (ADL). 

All files (*.*) This enables you to view all files in the directory so that you can open 
any compatible file.

Tell me more about Filename Extensions
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Save As—Scan 
Look in | File name | Files of type | Save 

Use the Save As dialog to save the data, method, report or graphics template individually or together as a Batch file. 

Traces (or data) that are currently ‘Visible’ in the Graphics area are saved, regardless of how they are displayed (full 
screen graph box or tile).  

For example, if six graph boxes are displayed in the Graphics area and each graph box has one Visible trace then all 
six traces will be saved.  

If you do not wish to save particular traces, make them not Visible in the Trace Preferences dialog. To save only the 
focused trace, select the Save only focused trace check box. 

The Save As dialog comprises the following: 

Overlay Data Select this check box to overlay individual data files in one graph box. If this is not checked the 
data from each file will appear in individual graph boxes. This option is only available if the 
Open dialog has been accessed by selecting 'Open…' from the File menu. 

Hot Tip 
Use the SHIFT or Control key to select multiple data files.

Open This button opens the highlighted file/s or the files listed in the File name field.

See also: 
File menu 
ASCII Spreadsheet File

Note 
This dialog appears when you select either the Save Method As.. or Save Data As… menu option in the File 
menu. When you select Save Method As… this dialog appears with 'Methods' displayed in the Files of type 
field. When you select Save Data As… this dialog appears with 'Batch' displayed in the Files of type field.

Look In The Look In field lists the available folders and files. Click the down arrow on the right of this 
field to view the location of the current folder in your computer's hierarchy. You can also select a 
new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In field. 

Note 
To open the folder in the level that is one higher than the current folder, select  on the 
toolbar.

Look in list 
box 

The Look In List Box, which is directly below the Look In field, displays the folders and files in 
the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted text entry 
field that appears and press Enter. Then double-click on the new folder to open it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the date the file 
was last modified.
Click to preview the selected trace before you load it into the application.
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Filename extensions—Scan 
The Cary Eclipse system uses the filename extension to distinguish between data types (e.g. method or report) and 
also to differentiate applications. (e.g. Concentration or Kinetics). 

The Syntax for file extensions is: 

File Name Enter the name of the file you want to save in this field. 
You can also type the full path of a file then select the Save button to save the file. 

Files of Type  Click on the arrow on the right of this field to view a list of the different types of application files 
that can be opened in the list box. 
Methods (*.FMSW) Choose this file type to only save the current Method. Any collected 

data is not stored.
Data (*.FDSW) Choose this file type to only save the data currently Visible in the 

Trace Preferences dialog (for any graph box). Note that the method 
used to collect the data is not stored with the data.

Report (*.FRSW) Choose this file type to only save the contents currently shown in the 
Report area..

Graph Template 
(*.FGSW) 

Choose this file type to save the layout of the Graphics area as a 
template. For example, any bitmaps you have added to your Graphics 
area will be saved as well as the range and style of the graph axes.

Batch (*.FBSW) Choose this file type to save the data that is currently Visible in the 
Trace Preferences dialog (for any graph box), the method used to 
collect the data and the currently displayed report all together as a 
Batch file. The graphics setup is also stored. 

Spreadsheet Ascii 
(*.CSV)

Choose this file type to save the raw intensity data currently Visible in 
the Trace Preferences dialog (for any graph box) as a comma delimited 
ASCII Spreadsheet file (*.CSV) file. The data is saved as XY pairs 
delimited by a comma. 

Note 
This file type can be easily imported into a spreadsheet program. 
For example, Microsoft Excel. You can also double-click on the 
stored *.CSV file from Microsoft Explorer to load Excel 
automatically with the ASCII XY data displayed.

GRAMS (*.SPC) Choose this file type to only save the data currently Visible in the 
Trace Preferences dialog (for any graph box) as a Cary Eclipse 
GRAMS data file.

Tell me more about Filename Extensions

Save Click this button to save the file currently present in the File name field in the directory specified 
in the Look in field.

 
See also: 
File menu

Letter Represents Available Options
First Type of analysis F Fluorescence

Second Type of file B Batch
D Data
G Graph Template
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The following files may be opened and saved in the Scan Application: 

M Method
R Report

Third and fourth Application identifier AB Advanced Reads
CN Concentration
KN Kinetics
LT Lifetimes
RT Ratio
SR Simple Reads
SW Scan
TM Thermal
VO Validate

Note 
Selecting All Files in the Windows Open dialog will list all available file types. 

Extension Available action File type
*.FMSW Open/Save A method file (*.FMSW) consists of the software setup by 

which data is collected.
*.FDSW Open/Save A data file (*.FDSW) contains data collected that is currently 

visible in the Trace Preferences dialog (for any graph box). 
*.FRSW Open/Save A report file (*.FRSW) contains the report generated by the 

Cary Eclipse about the data.
*.FGSW Open/Save A graph template file (*.FGSW) contains information that sets 

up the layout of the Graphics area including any bitmaps as 
well as the range and style of the graph axes.

*.FBSW Open/Save A batch file (*.FBSW) contains the collected data that was 
Visible in the Trace Preferences dialog (for any graph box), the 
method by which the data was collected and the report and 
graphics template.

*.CSV Open/Save An ASCII spreadsheet file (*.CSV) has the same extension for 
all applications. It consists of raw intensity data (that was 
currently Visible in the Trace Preferences dialog (for any 
graph box) saved as XY comma-delimited pairs. This file can 
be imported into a spreadsheet program such as Microsoft 
Excel.

Data.* Open A Cary DOS (Data.*) file is the equivalent of a Cary Windows 
Data file—it does not contain any Batch information.

*.ADL Open An ADL file (*.ADL) is a program file generated in the 
Applications Development Language (ADL). 

*.SPC Open/Save A Cary GRAMS file (*.SPC ) is the equivalent of a Cary 
Eclipse Windows Data file—it does not contain any Batch 
information.

*.FADL Open An Eclipse ADL (*.FADL) file is a program file generated in 
the Applications Development Language (ADL) specifically 
for the Cary Eclipse. Eclipse ADL files will be associated with 
the relevant Eclipse application. When creating ADL files for 
the Cary Eclipse, it is recommended that you save them with 
the FADL extension.
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ASCII Spreadsheet file (*.CSV)—Scan 
An ASCII Spreadsheet file consists of raw intensity data saved as XY comma-delimited pairs. You can choose to 
import or export Cary Eclipse files to ASCII files, which can then be imported in spreadsheet programs such as 
Microsoft Excel. 

The format is as follows:  

Line 1 contains the sample name plus a comma
Line 2 contains X and Y labels. The name of the X label must be the same as that used to label the graph. For
example, in Scan, the graph label is Wavelength (nm).
Lines 3 and onward contain the X,Y data
After the last line of X,Y pairs there must be a blank line separating the data from any text audit strings or the
end of the file.

For example, if a scan file was collected as: 
nm = 700, intensity = 0.1392 
nm = 698, intensity = 0.1388 
nm = 696, intensity = 0.1245 
etc. 

It would appear as follows in the ASCII file: 

Microsoft’s Excel generates a CSV file with the above format. 

There is also an alternative format for CSV files. For example, 

How to export collected data—Scan 

See also: 
Open 
Save As

  Scan, 
  Wavelength (nm); Intensity (a.u.) 
 700, 0.1392, 
 698, 0.1388, 
 696, 0.1245, 

  Scan, 
  etc. 

  Scan 
  Wavelength (nm); Intensity (a.u.) 
  700,0.1392 
  698,0.1388 
  696,0.1245 

  Scan, 
  etc. 

See also: 
Save As 
Open 
How to export collected data
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If you want to export data from a Cary Eclipse application into a third-party application, then you simply need to 
save your data as an Spreadsheet ASCII (*.CSV) file or a Rich Text Format (*.RTF) file. Spreadsheet ASCII files are 
recommended if you are planning to use the data in a spreadsheet program such as Microsoft® Excel. Rich Text 
Format files are recommended if you are planning to open the data in a word processor program such as Microsoft® 
Word. 

To export collected data: 

Step 1  

From the File menu, select Save As. The Save As dialog is displayed. 

Step 2  

Click on the down arrow next to the Files of type list box and select the Spreadsheet ASCII (*.CSV) or Rich Text 
Format (*.RTF) option. 

Step 4  

Type the name of your new file in the File name field. 

Step 5  

Select Save to export your data to this new file. 

How to combine data files into a batch file—Scan 
To combine a number of data files into a batch file, do the following: 

Step 1  

Select Open… from the File menu to display the Windows Open dialog. 

Step 2  

A list of stored batch files will appear. Select the down arrow to the right of the Files of type field and select 'Data' to 
list all the data files. 

Step 3  

Select the Overlay Data check box. 

Step 4  

Highlight the data files that you require. Hold down the CTRL key to select multiple files. 

Step 5 

Select Open. The highlighted data files will load into the application and appear in the same graph box. 

Step 6 

Select Save As… from the File menu to display the Windows Save As dialog. 

Step 7 
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A list of stored data files will appear. Select the down arrow at the right of the Files of type field and select 'Batch' to 
list all the batch files. Ensure that the Save only focused trace check box is cleared. 

Step 8 

In the File name field, type in the file name for your new batch file. 

Step 9 

Select Save to create the new batch file. The current method will be stored with the batch file. 

All the data files are now combined into the one batch file. 

Software and Screen features—Scan 
Menu line
Status display
Status line
Buttons
Function keys
Right mouse menu
How to remove or display the command buttons

Menu line—Scan 
  File menu 
  Edit menu 
  View menu 
  Commands menu 
  Setup menu 
  Graph menu 
  Help menu 

Status line—Scan 
The Status Line is displayed at the very bottom of the Scan Application window. The line will display the following 
information (from left to right): 

The major commands in this application can be accessed both from the menu items at the top of the main window 
and from the application buttons. These buttons, which appear in the left side of the Scan Application window, 
comprise the following: 

Hardware Status This field displays status messages indicating the current instrument activity.
Sequence Information This field displays status messages indicating the current system activity.
Current Results This field displays information on the last reading.

Buttons—Scan 

Hot Tip 
If you wish to access these commands from the main menus, rather than from these buttons, you can remove 
the Command buttons from your application window. To do this, clear the Buttons command in the View 
menu. This will enlarge the Graphics area, making viewing and selection of scans easier. 
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Function keys—Scan 
The function keys at the top of your keyboard perform basic Cary Eclipse operations simply and quickly.  

Button Enables you to…
Setup Click this button to display the Setup dialog where you can set up the collection, storage and 

analysis parameters for the scan. You can also set up any accessories that you may have and 
define the reporting options.

Zero Select this to zero the current ordinate value. 
This command can also be accessed by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell positions 
that are currently in the cell path.

Pre-scan Select this to determine the optimum instrument parameters to be used for your sample. At the 
end of this collection sequence the software will report the optimum Ex and Em wavelengths and 
PMT voltage. Once you are satisfied with the parameters, the software will automatically update 
your method setup to reflect these new parameters.

Clear Report Select Clear Report to remove all of the text that appears in the Report area. If you have saved 
the report, you can view the information again. To do this, simply open the report file using the 
Open… command in the File menu.

Create report Select Create Report to display the Reports page of the Setup dialog. You can use this page to 
enter and select information that will appear in the report.

Print Select Print to display the Windows Print dialog where you can choose what printer the report 
will be printed to. You can also select what pages to print as well as the number of copies you 
wish to print. 
This command can also be accessed by pressing CTRL+P. 

Note 
The options on the Reports page are used to generate the contents of the Report area during 
a run or on a recalculation. If Auto Print has been selected the Cary Eclipse will 
automatically print a report at the end of a data collection.

See also: 
Commands menu 
Setup dialog 
Reports page 

Function 
key 

What it does

F1 This displays the Help for the current dialog or window.
F4 Press F4 to display the Go To Wavelength dialog.
F5 Press F5 to perform an instrument Zero. The current intensity value will be reset to zero and all 

subsequent results will have the value that was reset to zero subtracted from them. You can use the 
Zero command before selecting Start if you want your data to start at 0 intensity. 
This command is also accessible from the Commands menu or by selecting the Zero button. 

Select the Clear Zero command from the Commands menu to remove zero correction. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell positions that 
are currently in the cell path.

F6 Press F6 to display the Rapid Result dialog where you can read a blank and multiple sample readings 
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Right mouse menu—Scan 
The following commands are accessible by clicking the right mouse button on editable fields in the Cary Eclipse 
software. 

How to remove or display the command buttons—Scan 
The command buttons (Setup, Zero, Pre-scan, Clear Report, Create Report and Print) appear on the left side of 
the Scan Application window. 

To remove the command buttons 

Step 1 

From the Scan Application window, select the View menu. 

Step 2 

Clear the Buttons menu item. 

The buttons will disappear from the application screen, giving you more room to display reports. 

To show the command buttons 

Step 1 

From the Scan Application window, select the View menu. 

Step 2 

without changing the application method. 
This command is also accessible from the Commands menu.

F9 If the application is online, press F9 to start a data collection. This is equivalent to selecting the Start 
button. If the application is not online, you will need to press F9 to first connect to the Cary Eclipse. 
Then press F9 to start the data collection. 
This command is also accessible from the Commands menu or by selecting the Start button. 

Note 
You will not be able to perform a Connect if another application is collecting data.

F12 Select this to stop the current measurement. This is equivalent to selecting the Stop button. This 
command is also accessible from the Commands menu or by selecting the Stop button.   

See also: 
Go To Wavelength dialog 
Zero 
Rapid Result dialog  
Start/Stop Instrument Buttons

Undo If available, this reverts to the previous value before the Edit on the field.
Cut If available, this cuts the highlighted text to the clipboard.
Copy If available, this copies the highlighted text to the clipboard.
Paste If available, this pastes the text from the clipboard to the cursor position.
Delete If available, this deletes the highlighted text/number.
Select All If available, this selects all entries.
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Select the Buttons menu item. 

The buttons will re-appear in the application screen. 

ADL—Scan 
ADL Command Line
ADL Hooks
How to insert ADL commands

Introduction to ADL 

Use the ADL Command Line to run Single-line or Multi-line Applications Development Language (ADL) 
commands that enable you to perform functions over and above that of the existing program functionality.  

ADL is not a general purpose programming language. It has been developed specifically by Varian to meet the needs 
of spectroscopists. It can be used to handle all the data collected from the Cary Eclipse—both photometric values and 
entire data collections. ADL programs that you develop should be stored with the extension 'ADL'. 

To access the ADL Command Line, select the ADL Command item from the Commands menu. You can also press 
ALT+Y to open the dialog. 

Software controls 

ADL Command Line—Scan 

Note 
Full documentation on ADL programming is available in the ADL Online Help.  
Click the button below to view this Help. 

Single Line Selecting this lets you enter ADL commands on a single line into the Command Line entry box. 
Q. Can I enter more than one ADL command on a single line?
A. Yes, provided that the commands are separated by a semicolon ‘;’.

Multi-line The Multi-line capability enlarges the Command Line entry box. Use the Multi-line capability to 
create a more complex ADL program by adding a series of commands over multiple lines. When 
Multi-line mode is selected, the Quick Reference option becomes available.

Quick 
Reference 

Select Quick Reference to open the Quick Reference dialog where you can easily add a command 
in the correct syntax to your ADL program. This option is only available for Multi-line commands. 

A detailed description of all the commands in the Quick Reference is available by selecting the 
Help button on the Quick Reference dialog. 

Show me How to insert ADL commands using the Quick Reference.

Browse Select Browse to access the Open dialog where you can browse for and select an existing ADL 
program to load and run.

Command Line 
(entry box) 

This entry box enables you to use ADL commands. You can enter single ADL commands into this 
field, or you can enter a series of ADL commands. If you have the entry type set to Single Line, 
you can review previous ADL entries by selecting the down arrow to the right of the list box. 
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ADL Hooks—Scan 
The ADL Hooks command is accessible from the View menu. 

Instead of writing a full ADL program you can use ADL hooks to link into an existing application. This is 
particularly useful if you want to make small changes to the way an application works, e.g. you want to pop up a 
dialog for the user to enter some specific data before the run starts. ADL hooks are links at specific points in an 
application at which you can run an ADL program. For example, ADL hooks have been supplied to run the following 
ADL programs:  

The ADL commands in the Command Line are executed when you select OK. 

Note 
On entering this window, the Cary Eclipse will recall the last command or program executed 
from the Command Line entry box. The ADL commands entered in the last executed 
program are typically stored in the Varian\Cary Eclipse WinFLR\ADL directory on the 
drive on which the Cary Eclipse software is installed.
Hot Tip 
You can rerun the ADL commands in the Command Line entry box from any screen in the 
Scan application by pressing ALT-X or selecting Re-run ADL from the Commands menu. 

 
See also: 
ADL Hooks

Note 
Full documentation on ADL programming is available in the ADL Online Help.  
Click the button below to view this Help.      

Hook Description

SW_Startup.ADL This is run when the Scan application starts. For this to to work the application must be 
started from a batch or method file that has ADL Hooks on.

SW_PreSeq.ADL This runs when the Start button is selected.

SW_PostSeq.ADL This runs at the end of the Start button sequence.

SW_Online.ADL This runs when Cary Eclipse is detected online.

SW_OffLine.ADL This runs when Cary Eclipse goes offline.

SW_Zero.ADL This runs when the Zero button is selected.

SW_Recalc.ADL This runs when the Recalculate button is selected.

SW_Shutdown.ADL This runs when the application is shutting down.

SW_PreRead.ADL This runs just before a read is taken.

SW_PostRead.ADL This runs just after a read is taken (It has the reading result stored in the UserResult 
variable.)

SW_PreSetup.ADL This runs when the Setup button is selected.

SW_PostSetup.ADL This runs when the OK button on the Setup dialog is selected.

SW_CellChange.ADL This runs instead of the Cary Eclipse driving the Multicell Holder. It enables you to 
add your own instructions for the Cary Eclipse Multicell Holder or to use your own 
cell changing accessory.

Page 120 of 149Scan Home Page

   file://C:\Documents and Settings\cary\Local Settings\Temp\~hhF1E6.htm



How to insert ADL commands using the Quick Reference—Scan 
The Quick Reference window is accessed from the ADL Command window. It enables you to easily add a command 
in the correct syntax to your ADL program. To do this: 

Step 1 

Press Alt-Y to open the ADL Command Line window. 

Step 2 

Select the Multi-line option. The Command Line entry box will expand to take multiple lines of ADL commands and 
the Quick Reference check box is displayed. 

Step 3 

Select the Quick Reference check box. The Quick Reference window is displayed. 

Step 4 

If necessary, use the Go To field to jump to the appropriate part of the Quick Reference listing. 

Step 5 

Highlight the command you require in the Quick Reference list. 

Step 6 

Click the Insert in ADL button. The selected ADL command will appear in the Command Line entry box. 

Step 7 

Where necessary, alter the defaults supplied by the inserted Quick Reference command in the Command Line entry 
box to suit your program. 

Step 8 

Repeat steps 4–7 to add more commands as required. 

SW_PreScan.ADL This runs just prior to the running of a scan.

SW_PostScan.ADL This runs just after a scan has been run.

SW_EmisHigh.ADL This runs when the menu item Correction Curves > Emission (500–900) option is 
selected from the Commands menu.

SW_PreUserRecalc.ADL This runs just after the Create Report button has been selected. 

SW_UserRecalc.ADL This runs just prior to the calculations. It can also be used to replace the calculations.

SW_PostUserRecalc.ADL This is run after the Create Report sequence has been completed

SW_TraceName.ADL Allows the name of the sample to be obtained from an ADL file, instead of being entered by 
typing into the sample loading dialog. This only works for single samples. 

SW_UserPreCalc.ADL This runs just prior to the calculations. Any pre-processing of data should be done here.

SW_UserPostCalc.ADL This runs after the calculations. Any post processing of data should be done here
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Help and Safety information—Scan 
Help menu
Safety home page

Help menu—Scan 
Use the Help menu to view the online Help and software information for this application. 

Safety Home Page 
Click on the desired index entry to view the Help. 

About Safety
Lamp module
Ultraviolet radiation
Electrical hazards — Cary Eclipse
Panels, covers and modules
Other precautions
Warnings and cautions
Warning symbols
Color coding
Information symbols
FCC advisory
CE compliant products

Scan How To—Scan 
Select the procedure you require below for a step-by-step informative guide on running the application software. 

Setup, calculations and reports 

How to perform a fluorescence scan
How to perform a fluorescence scan in cycle mode
How to perform a fluorescence scan in signal-to-noise mode
How to perform a phosphorescence scan
How to perform a phosphorescence scan in cycle mode

See also: 
ADL Command Line

Command What it does…
Scan Help Select this to display the Scan Home Page. This contains a list of online Help topics specific to 

the Scan Application.
Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.
Tip of the day View useful tips about using your Cary Eclipse instrument and software.
Eclipse Tour Select this to display the Cary Eclipse Multimedia Online Help. This will give you an animated 

introduction to the Cary Eclipse software and hardware.
About… Select About to access a dialog that displays information about the application as well as Varian 

email and Internet contact information.  
To clear this About dialog, select OK.
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How to perform a phosphorescence scan in signal-to-noise mode
How to perform a bio-/chemi-luminescence scan
How to perform a bio-/chemi-luminescence scan in cycle mode
How to perform a bio-/chemi-luminescence scan in signal-to-noise mode
How to use advanced reporting options
How to generate a report from previously collected data

Other 

How to email your results
How to export collected data
How to combine data files into a batch file
How to import sample names
How to remove or display the command buttons
How to insert ADL commands using the Quick Reference

How to perform a fluorescence scan in cycle mode—Scan 
This demonstrates how to perform a fluorescence wavelength scan in cycle mode. 

Start the Scan application
Set up data collection parameters
Set up instrument parameters such as Data Mode and Scan Setup
Set up visual system monitoring
Set up the cycle mode and filter options
Make sure that no accessories are selected
Set up reporting and printing requirements
Set up storage of collected data before run
Set up email options
Finish Setup
Zero the instrument
Start the Scan run
Save the collected data

Start the Scan application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan Application is 
displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select the Setup button to display the Setup dialog and specify the method parameters for a new method. 

Set up instrument parameters such as Data Mode and Scan Setup  

See also:
Scan Application Home Page
Graphics How To

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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Step 3 [Setup dialog | Cary page] 

a. Set the Data mode to Fluorescence.

b. Set  the Scan setup mode to Emission. During the emission scan, the excitation monochromator is set to a
fixed wavelength and the emission monochromator is scanned over a wavelength range.

c. Set the X Mode to Wavelength (nm).

d. Enter an Excitation (nm) value that is within the region where the fluorescent molecule to be scanned will
absorb light. For purposes of this example, Anthracene will be used as an example and therefore a value of
360 nm should be set.

e. Enter an Excitation slit (nm) value or 5 and an Emission slit (nm) value of 5. Slits determine the resolution of
the spectrum and therefore are used in conjunction with the PMT Detector Voltage (set on the Options page)
to determine concentration. If a compound is highly fluorescent and has reasonable signal intensity (as is the
case for Anthracene) the slits can be set quite narrow. If

f. Enter a Start (nm) value of 370 nm and enter a Stop (nm) value of 520 nm.
The Start (nm) value should be set to the Excitation (nm) value plus the sum of the slits. In this example, as the
Excitation value is 360 nm, and the sum of the slits is 10 nm, the Start (nm) value is set to 370.
Typically the Stop (nm) value should be set to 150–200 nm greater than the Start (nm) value.

g. If selected, clear the 3-D Mode check box.

Set up visual system monitoring  

Step 4 [Setup dialog | Cary page] 

Select the Status Display check box so that you can view various instrument parameters during the scan. 

Set up the cycle mode and filter options  

Step 5 [Setup dialog | Options page]  

a. Select the Options tab to display the Options page.

b. Select the Cycle mode option. This option enables you to collect scans as a function of time to determine
whether the spectrum is changing. (By contrast, the Kinetics application enables you to determine whether a
single wavelength is changing over time.)
If this option is not available, clear the CAT or S/N mode check box.

c. Enter a No. of scans value of 15 to set the number of scans to be performed per cell/well.

d. Enter a Time value of 1.0000 to set the interval between each successive scan. If the time entered is less than
the time required to complete a scan, the scans are performed continuously with no delay.

e. Set the Excitation filter to Auto and the Emission filter to Open.

f. Set the PMT Detector voltage to Medium. This setting can later be adjusted if results are over-range. If the
signal is too high, decrease the PMT Detector Voltage. If the signal is too low, increase the PMT Detector
Voltage.

Make sure that no accessories are selected  

Step 6 [Setup dialog | Accessories page] 
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Make sure that no options are selected on any of the tabs of the Accessories page. 

Set up reporting and printing requirements  

Step 7 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements for this
method.

i. Enter your name in the Name entry field.
ii. If required, enter any comments relating to your experiment in the Comment field.

iii. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a graph in the generated report.

b. Set up the Peaks reporting options.

i. Select Maximum peaks to report the peak with the largest peak threshold that exceeds the peak
Threshold value.

ii. Select All peaks to report all peaks meeting the Peak type criterion and exceeding the Threshold value.

iii. Select the Peak type and specify the peak Threshold.

c. If required, select the X-Y Pairs table check box. You can use the Actual Data interval by which the data
was collected or you can make the Cary Eclipse Interpolate the points to a new interval.

Set up storage of collected data before run  

Step 8 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto store page. Use this page to set up whether the collected data is
to be saved, and if so, when the Cary Eclipse should store the information.

b. Select Storage option of On; prompt at end.

c. Select the Auto convert option you require.
If you select Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data collection
the system will automatically generate a report and store the data both in the Cary Eclipse format as well as
ASCII XY pairs format in the current folder.

Set up email options  

Step 9  

Refer to How to email your results for instructions on setting up the email options. 

Finish Setup  

Note 
If Auto print is selected, the system will send the report information to the specified printer as well a
displaying it in the Report area. However if Auto print is not selected, the report will be displayed in
area only. The Report area can be viewed by selecting the Report command from the View menu.
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Step 10 

Once you are satisfied with your method setup select OK to confirm any changes you have made and close the Setup
dialog. 

Zero the instrument  

Step 11 

a. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

b. Click the Zero button to zero the system. Alternatively, select Zero from the Commands menu to perform a
zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the
Scan Application window.

Start the Scan run  

Step 12 

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands menu.
The Sample name dialog is displayed.

b. In the Sample name dialog, enter the appropriate name for you sample and select OK. The Sync Start dialog
is displayed.

c. The Sync Start dialog displays a two minute countdown in seconds. If you want to start your data collection
before the two minute countdown ends, add your active reagent and select the OK button. Alternatively, you
can add your active reagent and wait for the countdown to end. The data collection will start automatically.

Save the collected data  

Step 13  

a. Once the run is finished, select the Save as command from the File menu.

b. In the File name field, enter a file name for this scan run.

c. Select Save. The data will be stored as a Batch file.

How to perform a fluorescence scan in signal-to-noise mode—Scan 
This demonstrates how to perform a fluorescence wavelength scan in signal-to-noise mode. 

Start the Scan application
Set up data collection parameters
Set up instrument parameters such as Data Mode and Scan Setup
Set up visual system monitoring
Set up the display, signal-to-noise and filter options
Make sure that no accessories are selected

See also:
Scan How To
Cary
Options
Reports
Auto store
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Set up reporting and printing requirements
Set up storage of collected data before run
Set up email options
Finish Setup
Zero the instrument
Start the Scan run
Save the collected data

Start the Scan application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan Application is 
displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select the Setup button to display the Setup dialog and specify the method parameters for a new method. 

Set up instrument parameters such as Data Mode and Scan Setup  

Step 3 [Setup dialog | Cary page]  

a. Set the Data mode to Fluorescence.

b. Set  the Scan setup mode to Emission. During the emission scan, the excitation monochromator is set to a
fixed wavelength and the emission monochromator is scanned over a wavelength range.

c. Set the X Mode to Wavelength (nm).

d. Enter an Excitation (nm) value that is within the region where the fluorescent molecule to be scanned will
absorb light. For purposes of this example, Anthracene will be used as an example and therefore a value of
360 nm should be set.

e. Enter an Excitation slit (nm) value or 5 and an Emission slit (nm) value of 5. Slits determine the resolution of
the spectrum and therefore are used in conjunction with the PMT Detector Voltage (set on the Options page)
to determine concentration. If a compound is highly fluorescent and has reasonable signal intensity (as is the
case for Anthracene) the slits can be set quite narrow. If

f. Enter a Start (nm) value of 370 nm and enter a Stop (nm) value of 520 nm.
The Start (nm) value should be set to the Excitation (nm) value plus the sum of the slits. In this example, as the
Excitation value is 360 nm, and the sum of the slits is 10 nm, the Start (nm) value is set to 370.
Typically the Stop (nm) value should be set to 150–200 nm greater than the Start (nm) value.

g. If selected, clear the 3-D Mode check box.

Set up visual system monitoring  

Step 4 [Setup dialog | Cary page] 

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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Select the Status Display check box so that you can view various instrument parameters during the scan. 

Set up the display, signal-to-noise and filter options  

Step 5 [Setup dialog | Options page]  

a. Select the Options tab to display the Options page.

b. In the Display options group, select the Overlay traces check box to overlay the results of the traces on one
graph.

c. Select the CAT or S/N mode option. If this option is not available, clear the Cycle mode and/or Smoothing
check boxes.

d. Set the Mode to S/N mode.
You will be informed that the Scan control on the Cary page will be set to Manual. Select OK to continue.

e. Set the S/N value to 600 and the Time out (s) value to 1.000. The Cary Eclipse instrument will control the
Averaging Time by waiting at each data point and averaging the signal until the value set in the S/N field is
obtained. This parameter is useful if you have areas of low transmission in your scan and wish to have the
same level of 'noise' across the whole scan.

f. Set the Excitation filter to Auto and the Emission filter to Open.

g. Set the PMT Detector voltage to Medium. This setting can later be adjusted if results are over-range. If the
signal is too high, decrease the PMT Detector Voltage. If the signal is too low, increase the PMT Detector
Voltage.

Make sure that no accessories are selected  

Step 6 [Setup dialog | Accessories page] 

Make sure that no options are selected on any of the tabs of the Accessories page. 

Set up reporting and printing requirements  

Step 7 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements for this
method.

i. Enter your name in the Name entry field.
ii. If required, enter any comments relating to your experiment in the Comment field.

iii. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a graph in the generated report.

b. Set up the Peaks reporting options.

Note 
If Auto print is selected, the system will send the report information to the specified printer as well a
displaying it in the Report area. However if Auto print is not selected, the report will be displayed in
area only. The Report area can be viewed by selecting the Report command from the View menu.
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i. Select Maximum peaks to report the peak with the largest peak threshold that exceeds the peak
Threshold value.

ii. Select All peaks to report all peaks meeting the Peak type criterion and exceeding the Threshold value.

iii. Select the Peak type and specify the peak Threshold.

c. If required, select the X-Y Pairs table check box. You can use the Actual Data interval by which the data
was collected or you can make the Cary Eclipse Interpolate the points to a new interval.

Set up storage of collected data before run  

Step 8 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto store page. Use this page to set up whether the collected data is
to be saved, and if so, when the Cary Eclipse should store the information.

b. Select Storage option of On; Prompt at end.

c. Select the Auto convert option you require.
If you select Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data collection
the system will automatically generate a report and store the data both in the Cary Eclipse format as well as
ASCII XY pairs format in the current folder.

Set up email options  

Step 9  

Refer to How to email your results for instructions on setting up the email options. 

Finish Setup  

Step 10 

Once you are satisfied with your method setup select OK to confirm any changes you have made and close the Setup
dialog. 

Zero the instrument  

Step 11 

a. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

b. Click the Zero button to zero the system. Alternatively, select Zero from the Commands menu to perform a
zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the
Scan Application window.

Start the Scan run  

Step 12 

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands menu.
The Sample name dialog is displayed.

b. In the Sample name dialog, enter the appropriate name for you sample and select OK. The scan will
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commence and the trace will appear in the Graphics area. 

Save the collected data  

Step 13  

a. Once the run is finished, select the Save as command from the File menu.

b. In the File name field, enter a file name for this scan run.

c. Select Save. The data will be stored as a Batch file.

How to perform a phosphorescence scan in cycle mode—Scan 
This demonstrates how to perform a phosphorescence wavelength scan in cycle mode. 

Start the Scan application
Set up data collection parameters
Set up instrument parameters
Set up visual system monitoring
Set up the cycle mode and filter options
Make sure that no accessories are selected
Set up reporting and printing requirements
Set up storage of collected data before run
Set up email options
Finish Setup
Zero the instrument
Start the Scan run
Save the collected data

Start the Scan application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan Application is 
displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select the Setup button to display the Setup dialog and specify the method parameters for a new method. 

Set up instrument parameters such as Data Mode and Scan Setup  

See also:
Scan How To
Cary
Options
Reports
Auto store

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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Step 3 [Setup dialog] | Cary page] 

a. Set the Data Mode to Phosphorescence.

b. Select the Options button to display the Phosphorescence Options dialog. The values you enter for the
options in this dialog depend upon the sample you are scanning.

For example, if you were analysing a sample such as Europium (Eu3+), which has a very short
phosphorescence lifetime, it is recommended that you enter the following values:

However, if you are analysing a sample such as Napthalene, which is know to have a standard 
phosphorescence lifetime, it is recommended that you enter the following values: 

c. Once you have made entered the values in the Phosphorescence options dialog, select OK to clear the dialog
and return to the Cary page.

d. Set the Scan Setup mode to Emission. During the emission scan, the excitation monochromator is set to a
fixed wavelength and the emission monochromator is scanned over a wavelength range.

e. Set the X Mode to Wavelength (nm).

f. Enter an Excitation (nm) value of 340 nm. The Excitation (nm) value must be within the region where the
phosphorescent molecule to be scanned will absorb light.

g. Enter an Excitation slit (nm) value of 10 and an Emission slit (nm) value of 10. Slits determine the resolution
of the spectrum and therefore are used in conjunction with the PMT Detector Voltage (set on the Options
page) to determine concentration. If a compound is not highly phosphorescent (as is the case for Europium) the
slits need to be set quite wide.

h. Enter a Start (nm) value of  360 nm and enter a Stop (nm) value of between 700 to 750 nm.
The Start (nm) value should be set to the Excitation (nm) value plus the sum of the slits. In this example, as the
Excitation value is 340 nm, and the sum of the slits is 20 nm, the Start (nm) value is set to 360.
Typically phosphorescence samples should be scanned to above 600 nm, and preferably to between 700–
750 nm, even if they fluoresce at as low as 300 nm.

i. If selected, clear the 3-D Mode check box.

Set up visual system monitoring  

Step 3 [Setup dialog | Cary page] 

Select the Status Display check box so that you can view various instrument parameters during the scan. 

Set up the cycle mode and filter options  

Total decay time: 0.005 s
No. of flashes: 1
Delay time: 0.100 ms
Gate time: 5.000 ms

Total decay time: 1 s
No. of flashes: 10
Delay time: 0.100 ms
Gate time: 5.000 ms
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Step 5 [Setup dialog | Options page] 

a. Select the Options tab to display the Options page.

b. Select the Cycle mode option. This option enables you to collect scans as a function of time to determine
whether the spectrum is changing. (By contrast, the Kinetics application enables you to determine whether a
single wavelength is changing over time.)
If this option is not available, clear the CAT or S/N mode check box.

c. Enter a No. of scans value of 15 to set the number of scans to be performed per cell/well.

d. Enter a Time value of 1.0000 to set the interval between each successive scan. If the time entered is less than
the time required to complete a scan, the scans are performed continuously with no delay.

e. Set the Excitation filter to Auto. This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

f. Set the Emission filter to Open in order to minimize steps in the spectra.

g. Set the PMT Detector Voltage to High. A High setting is recommended for low emitting samples. This
setting can later be adjusted if results are over-range. If the signal is too high, decrease the PMT Detector
Voltage.

Make sure that no accessories are selected  

Step 5 [Setup dialog | Accessories page] 

Ensure that no options are selected on any of the tabs in the Accessories page. 

Set up reporting and printing requirements  

Step 6 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements for this
method.

i. Enter your name in the Name entry field.
ii. If required, enter any comments relating to your experiment in the Comment field.

iii. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a graph in the generated report.

b. Set up the Peaks reporting options.

iii. Select Maximum peaks to report the peak with the largest peak threshold that exceeds the peak
Threshold value.

i. Select All peaks to report all peaks meeting the Peak type criterion and exceeding the Threshold value.

Note 
If Auto print is selected, the system will send the report information to the specified 
printer as well as displaying it in the Report area. However if Auto print is not selected, 
the report will be displayed in the Report area only. The Report area can be viewed by 
selecting the Report command from the View menu.
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ii. Select the Peak type and specify the peak Threshold.

c. If required, select the X-Y Pairs table check box. You can use the Actual Data Interval by which the data
was collected or you can make the Cary Eclipse Interpolate the points to a new interval.

Set up storage of collected data before run  

Step 7 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto store page. Use this page to set up whether the collected data is
to be saved, and if so, when the Cary Eclipse should store the information.

b. Select Storage option of On; Prompt at end.

c. Select the Autoconvert option you require.
If you select Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data collection
the system will automatically generate a report and store the data both in the Cary Eclipse format as well as
ASCII XY pairs format in the current folder.

Set up email options  

Step 8 

Refer to How to email your results for instructions on setting up the email options. 

Finish Setup  

Step 9 

Once you are satisfied with your method setup select OK to confirm any changes you have made and close the Setup
dialog. 

Zero the instrument  

Step 10 

1. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

2. Click the Zero button to zero the system. Alternatively, select Zero from the Commands menu to perform a
zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the
Scan Application window.

Start the Scan run  

Step 11  

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands menu.
The Sample name dialog is displayed.

b. In the Sample name dialog, enter the appropriate name for you sample and select OK. The Sync Start dialog
is displayed.

Note: 
You MUST close the sample compartment prior to commencing a phosphorescence scan, as phosphorescence 
scanning is not immune to room light.
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c. The Sync Start dialog displays a two minute countdown in seconds. If you want to start your data collection
before the two minute countdown ends, add your active reagent and select the OK button. Alternatively, you
can add your active reagent and wait for the countdown to end. The data collection will start automatically.

Save the collected data  

Step 12  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this scan run.

c. Select Save. The data will be stored as a Batch file.

How to perform a phosphorescence scan in signal-to-noise mode—Scan 
This demonstrates how to perform a phosphorescence wavelength scan in signal-to-noise mode. 

Start the Scan application
Set up data collection parameters
Set up instrument parameters
Set up visual system monitoring
Set up the display, signal-to-noise and filter options
Make sure that no accessories are selected
Set up reporting and printing requirements
Set up storage of collected data before run
Set up email options
Finish Setup
Zero the instrument
Start the Scan run
Save the collected data

Start the Scan application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan Application is 
displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select the Setup button to display the Setup dialog and specify the method parameters for a new method. 

Set up instrument parameters such as Data Mode and Scan Setup  

Step 3 [Setup dialog] | Cary page]  

See also:
Scan How To

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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a. Set the Data Mode to Phosphorescence.

b. Select the Options button to display the Phosphorescence Options dialog. The values you enter for the
options in this dialog depend upon the sample you are scanning.

For example, if you were analysing a sample such as Europium (Eu3+), which has a very short
phosphorescence lifetime, it is recommended that you enter the following values:

However, if you are analysing a sample such as Napthalene, which is know to have a standard 
phosphorescence lifetime, it is recommended that you enter the following values: 

c. Once you have made entered the values in the Phosphorescence options dialog, select OK to clear the dialog
and return to the Cary page.

d. Set the Scan Setup mode to Emission. During the emission scan, the excitation monochromator is set to a
fixed wavelength and the emission monochromator is scanned over a wavelength range.

e. Set the X Mode to Wavelength (nm).

f. Enter an Excitation (nm) value of 340 nm. The Excitation (nm) value must be within the region where the
phosphorescent molecule to be scanned will absorb light.

g. Enter an Excitation slit (nm) value of 10 and an Emission slit (nm) value of 10. Slits determine the resolution
of the spectrum and therefore are used in conjunction with the PMT Detector Voltage (set on the Options
page) to determine concentration. If a compound is not highly phosphorescent (as is the case for Europium) the
slits need to be set quite wide.

h. Enter a Start (nm) value of  360 nm and enter a Stop (nm) value of between 700 to 750 nm.
The Start (nm) value should be set to the Excitation (nm) value plus the sum of the slits. In this example, as the
Excitation value is 340 nm, and the sum of the slits is 20 nm, the Start (nm) value is set to 360.
Typically phosphorescence samples should be scanned to above 600 nm, and preferably to between 700–
750 nm, even if they fluoresce at as low as 300 nm.

i. If selected, clear the 3-D Mode check box.

Set up visual system monitoring  

Step 3 [Setup dialog | Cary page] 

Select the Status Display check box so that you can view various instrument parameters during the scan. 

Set up the display, signal-to-noise and filter options  

Step 5 [Setup dialog | Options page]  

Total decay time: 0.005 s
No. of flashes: 1
Delay time: 0.100 ms
Gate time: 5.000 ms

Total decay time: 1 s
No. of flashes: 10
Delay time: 0.100 ms
Gate time: 5.000 ms
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a. Select the Options tab to display the Options page.

b. In the Display options group, select the Overlay traces check box to overlay the results of the traces on one
graph.

c. Select the CAT or S/N mode option. If this option is not available, clear the Cycle mode and/or Smoothing
check boxes.

d. Set the Mode to S/N mode.
You will be informed that the Scan control on the Cary page will be set to Manual. Select OK to continue.

e. Set the S/N value to 600 and the Time out (s) value to 1.000. The Cary Eclipse instrument will control the
Averaging Time by waiting at each data point and averaging the signal until the value set in the S/N field is
obtained. This parameter is useful if you have areas of low transmission in your scan and wish to have the
same level of 'noise' across the whole scan.

f. Set the Excitation filter to Auto. This will automatically move the filter wheel to the appropriate position for
the selected excitation wavelength.

g. Set the Emission filter to Open in order to minimize steps in the spectra.

h. Set the PMT Detector Voltage to High. A High setting is recommended for low emitting samples. This
setting can later be adjusted if results are over-range. If the signal is too high, decrease the PMT Detector
Voltage.

Make sure that no accessories are selected  

Step 5 [Setup dialog | Accessories page] 

Ensure that no options are selected on any of the tabs of the Accessories page. 

Set up reporting and printing requirements  

Step 6 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements for this
method.

i. Enter your name in the Name entry field.
ii. If required, enter any comments relating to your experiment in the Comment field.

iii. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a graph in the generated report.

b. Set up the Peaks reporting options.

iii. Select Maximum peaks to report the peak with the largest peak threshold that exceeds the peak

Note 
If Auto print is selected, the system will send the report information to the specified 
printer as well as displaying it in the Report area. However if Auto print is not selected, 
the report will be displayed in the Report area only. The Report area can be viewed by 
selecting the Report command from the View menu.
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Threshold value. 
i. Select All peaks to report all peaks meeting the Peak type criterion and exceeding the Threshold value.

ii. Select the Peak type and specify the peak Threshold.

c. If required, select the X-Y Pairs table check box. You can use the Actual Data Interval by which the data
was collected or you can make the Cary Eclipse Interpolate the points to a new interval.

Set up storage of collected data before run  

Step 7 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto store page. Use this page to set up whether the collected data is
to be saved, and if so, when the Cary Eclipse should store the information.

b. Select Storage option of On; Prompt at end.

c. Select the Autoconvert option you require.
If you select Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data collection
the system will automatically generate a report and store the data both in the Cary Eclipse format as well as
ASCII XY pairs format in the current folder.

Set up email options  

Step 8 

Refer to How to email your results for instructions on setting up the email options. 

Finish Setup  

Step 9 

Once you are satisfied with your method setup select OK to confirm any changes you have made and close the Setup
dialog. 

Zero the instrument  

Step 10 

a. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

b. Select the Zero button to zero the system. Alternatively, select Zero from the Commands menu to perform a
zero. The system will perform an instrument zero on the blank solution. When the result is zeroed, the word
'Zeroed' will appear in the Y display box in the top left corner of the Scan Application window.

Start the Scan run  

Step 11  

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands menu.
The Sample Name dialog is displayed.

Note: 
You MUST close the sample compartment prior to commencing a phosphorescence scan, as phosphorescence 
scanning is not immune to room light.
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b. Place the sample in the sample compartment of the Cary Eclipse instrument.

c. In the Sample Name dialog, enter the appropriate name for you sample and select OK. The Scan run will
commence and the corrected trace will appear in the Graphics area.

Save the collected data  

Step 12  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this scan run.

c. Select Save. The data will be stored as a Batch file.

How to perform a bio-/chemi-luminescene scan in cycle mode—Scan 
This demonstrates how to perform a bio-/chemi-luminescene wavelength scan in signal-to-noise mode. 

Start the Scan application
Set up data collection parameters
Set up instrument parameters
Set up visual system monitoring
Set up the display, cycle mode and filter options
Make sure that no accessories are selected
Set up reporting and printing requirements
Set up storage of collected data before run
Set up email options
Finish Setup
Zero the instrument
Start the Scan run
Save the collected data

Start the Scan application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan Application is 
displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select the Setup button to display the Setup dialog and specify the method parameters for a new method. 

Set up instrument parameters such as Data Mode and Scan Setup  

Step 3 [Setup dialog] | Cary page]  

See also:
Scan How To

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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a. Set the Data Mode to Bio-/Chemi-luminescence.

b. Select the Options button to display the Bio-/Chemi-luminescence Options dialog. Enter the Gate time to
200 ms. The Gate Time is the overall reading time of the emission signal and is typically set to between 100–
500 ms.

c. Select OK to clear the Bio-/Chemi-luminescence Options dialog and return to the Cary page. Note that in the
Scan setup group, the Excitation and Synchronous options are unavailable as the lamp does not flash for a
Bio-/Chemi-luminescence scan. Therefore, it is set to Emission mode.

d. Set the X Mode to Wavelength (nm).

e. Enter a Start (nm) value of  300 nm and enter a Stop (nm) value of between 750 nm.
The Start (nm) value should be set to the Excitation (nm) value plus the sum of the slits.

f. Enter an Emission slit (nm) value of 10. Slits determine the resolution of the spectrum and therefore are used
in conjunction with the PMT Detector Voltage (set on the Options page) to determine concentration.

Set up visual system monitoring  

Step 4 [Setup dialog | Cary page] 

Select the Status Display check box so that you can view various instrument parameters during the scan. 

Set up the display, cycle mode and filter options  

Step 5 [Setup dialog | Options page]  

a. Select the Options tab to display the Options page.

b. In the Display options group, select the Overlay traces check box to overlay the results of the traces on one
graph.

c. Select the CAT or S/N mode option. If this option is not available, clear the Cycle mode and/or Smoothing
check boxes.

d. Set the Mode to S/N mode.
You will be informed that the Scan control on the Cary page will be set to Manual. Select OK to continue.

e. Set the S/N value to 600 and the Time out (s) value to 1.000. The Cary Eclipse instrument will control the
Averaging Time by waiting at each data point and averaging the signal until the value set in the S/N field is
obtained. This parameter is useful if you have areas of low transmission in your scan and wish to have the
same level of 'noise' across the whole scan.

f. Set the Emission filter to Open in order to minimize steps in the spectra.

g. Set the PMT Detector Voltage to High. A High setting is recommended for low emitting samples. This
setting can later be adjusted if results are over-range. If the signal is too high, decrease the PMT Detector
Voltage.

Make sure that no accessories are selected  

Step 6 [Setup dialog | Accessories page] 

Make sure that no options are selected on any of the tabs in the Accessories page.
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Set up reporting and printing requirements 

Step 7 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements for this
method.

i. Enter your name in the Name entry field.
ii. If required, enter any comments relating to your experiment in the Comment field.

iii. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a graph in the generated report.

b. Set up the Peaks reporting options.

iii. Select Maximum peaks to report the peak with the largest peak threshold that exceeds the peak
Threshold value.

i. Select All peaks to report all peaks meeting the Peak type criterion and exceeding the Threshold value.
ii. Select the Peak type and specify the peak Threshold.

c. If required, select the X-Y Pairs table check box. You can use the Actual Data Interval by which the data
was collected or you can make the Cary Eclipse Interpolate the points to a new interval.

Set up storage of collected data before run  

Step 8 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto store page. Use this page to set up whether the collected data is
to be saved, and if so, when the Cary Eclipse should store the information.

b. Select Storage option of On; Prompt at end.

c. Select the Autoconvert option you require.
If you select Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data collection
the system will automatically generate a report and store the data both in the Cary Eclipse format as well as
ASCII XY pairs format in the current folder.

Set up email options  

Step 9 

Refer to How to email your results for instructions on setting up the email options. 

Finish Setup  

Step 10 

Note 
If Auto print is selected, the system will send the report information to the specified 
printer as well as displaying it in the Report area. However if Auto print is not selected, 
the report will be displayed in the Report area only. The Report area can be viewed by 
selecting the Report command from the View menu.
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Once you are satisfied with your method setup select OK to confirm any changes you have made and close the Setup
dialog. 

Zero the instrument  

Step 11 

a. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

b. Click the Zero button to zero the system. Alternatively, select Zero from the Commands menu to perform a
zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the
Scan Application window.

Start the Scan run  

Step 12  

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands menu.
The Sample Name dialog is displayed.

b. In the Sample Name dialog, enter the appropriate name for you sample and select OK. The Scan run will
commence and the corrected trace will appear in the Graphics area.

Save the collected data  

Step 13  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this scan run.

c. Select Save. The data will be stored as a Batch file.

How to perform a bio-/chemi-luminescene scan in signal-to-noise mode—
Scan 
This demonstrates how to perform a bio-/chemi-luminescene wavelength scan in signal-to-noise mode. 

Start the Scan application
Set up data collection parameters
Set up instrument parameters
Set up visual system monitoring
Set up the display, signal-to-noise and filter options
Make sure that no accessories are selected
Set up reporting and printing requirements
Set up storage of collected data before run
Set up email options
Finish Setup
Zero the instrument
Start the Scan run
Save the collected data

See also:
Scan How To
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Start the Scan application  

Step 1 

Click the Windows Start button, point to Programs, Cary Eclipse and then select Scan. The Scan Application is 
displayed. 

Set up data collection parameters  

Step 2 [Setup dialog] 

Select the Setup button to display the Setup dialog and specify the method parameters for a new method. 

Set up instrument parameters such as Data Mode and Scan Setup  

Step 3 [Setup dialog] | Cary page]  

a. Set the Data Mode to Bio-/Chemi-luminescence.

b. Select the Options button to display the Bio-/Chemi-luminescence Options dialog. Enter the Gate time to
200 ms. The Gate Time is the overall reading time of the emission signal and is typically set to between 100–
500 ms.

c. Select OK to clear the Bio-/Chemi-luminescence Options dialog and return to the Cary page. Note that in the
Scan setup group, the Excitation and Synchronous options are unavailable as the lamp does not flash for a
Bio-/Chemi-luminescence scan. Therefore, it is set to Emission mode.

d. Set the X Mode to Wavelength (nm).

e. Enter a Start (nm) value of  300 nm and enter a Stop (nm) value of between 750 nm.
The Start (nm) value should be set to the Excitation (nm) value plus the sum of the slits.

f. Enter an Emission slit (nm) value of 10. Slits determine the resolution of the spectrum and therefore are used
in conjunction with the PMT Detector Voltage (set on the Options page) to determine concentration.

g. In the Scan control group, set the Averaging time to 0.20000 s and the Data interval to 1.0000 nm.

Set up visual system monitoring  

Step 4 [Setup dialog | Cary page] 

Select the Status Display check box so that you can view various instrument parameters during the scan. 

Set up the display, signal-to-noise and filter options  

Step 5 [Setup dialog | Options page]  

a. Select the Options tab to display the Options page.

b. In the Display options group, select the Overlay traces check box to overlay the results of the traces on one
graph.

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the Scan 
Application.
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c. Select the CAT or S/N mode option. If this option is not available, clear the Cycle mode and/or Smoothing
check boxes.

d. Set the Mode to S/N mode.
You will be informed that the Scan control on the Cary page will be set to Manual. Select OK to continue.

e. Set the S/N value to 600 and the Time out (s) value to 1.000. The Cary Eclipse instrument will control the
Averaging Time by waiting at each data point and averaging the signal until the value set in the S/N field is
obtained. This parameter is useful if you have areas of low transmission in your scan and wish to have the
same level of 'noise' across the whole scan.

f. Set the Emission filter to Open in order to minimize steps in the spectra.

g. Set the PMT Detector Voltage to High. A High setting is recommended for low emitting samples. This
setting can later be adjusted if results are over-range. If the signal is too high, decrease the PMT Detector
Voltage.

Make sure that no accessories are selected  

Step 6 [Setup dialog | Accessories page] 

Make sure that no options are selected on any of the tabs in the Accessories page. 

Set up reporting and printing requirements  

Step 7 [Setup dialog | Reports page]  

a. Select the Reports tab to display the Reports page where you can specify your reporting requirements for this
method.

i. Enter your name in the Name entry field.
ii. If required, enter any comments relating to your experiment in the Comment field.

iii. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a graph in the generated report.

b. Set up the Peaks reporting options.

iii. Select Maximum peaks to report the peak with the largest peak threshold that exceeds the peak
Threshold value.

i. Select All peaks to report all peaks meeting the Peak type criterion and exceeding the Threshold value.
ii. Select the Peak type and specify the peak Threshold.

c. If required, select the X-Y Pairs table check box. You can use the Actual Data Interval by which the data
was collected or you can make the Cary Eclipse Interpolate the points to a new interval.

Note 
If Auto print is selected, the system will send the report information to the specified 
printer as well as displaying it in the Report area. However if Auto print is not selected, 
the report will be displayed in the Report area only. The Report area can be viewed by 
selecting the Report command from the View menu.
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Set up storage of collected data before run 

Step 8 [Setup dialog | Auto Store page]  

a. Select the Auto Store tab to display the Auto store page. Use this page to set up whether the collected data is
to be saved, and if so, when the Cary Eclipse should store the information.

b. Select Storage option of On; Prompt at end.

c. Select the Autoconvert option you require.
If you select Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data collection
the system will automatically generate a report and store the data both in the Cary Eclipse format as well as
ASCII XY pairs format in the current folder.

Set up email options  

Step 9 

Refer to How to email your results for instructions on setting up the email options. 

Finish Setup  

Step 10 

Once you are satisfied with your method setup select OK to confirm any changes you have made and close the Setup
dialog. 

Zero the instrument  

Step 11 

a. Place the blank solution in the sample compartment of the Cary Eclipse instrument.

b. Click the Zero button to zero the system. Alternatively, select Zero from the Commands menu to perform a
zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the
Scan Application window.

Start the Scan run  

Step 12  

a. Select the Start button to commence a data collection. Alternatively, select Start from the Commands menu.
The Sample Name dialog is displayed.

b. In the Sample Name dialog, enter the appropriate name for you sample and select OK. The Scan run will
commence and the corrected trace will appear in the Graphics area.

Save the collected data  

Step 13  

a. Once the run is finished, select the Save As command from the File menu.

b. In the File name field, enter a file name for this scan run.
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c. Select Save. The data will be stored as a Batch file.

How to generate a report from previously stored data—Scan 
Step 1 

Select Open… from the File menu to display the Windows Open dialog. 

Step 2 

A list of previously stored files will appear. If this is not a list of batch files, select the down arrow at the right of the 
Files of type list box and select 'Batch' to list all the batch files. 

Step 3 

Select the Batch file you require then select Open. 

The system will automatically retrieve the collected data into the Graphics area. The method that was used to collect 
the data will also be retrieved. 

Step 4 

Select the Recalculate button to display the Setup dialog. 

Step 5 

Select the Reports tab and on the Reports page specify the information you would like to include in the report. 
Select Auto Print if you require the new report to print to the Reports area and to a printer. 

Step 6 

Click OK to display the results in the Report area (and send to the printer if Auto Print is selected). 

How to import sample names into the Wellplate sample list—Scan 
If you want to import sample names into the Wellplate sample list in the Scan application, then you simply need to 
enter your data in a *.txt file and then import this file into the Wellplate sample list dialog. The data should be 

See also:
Scan How To

Note 
You can also retrieve data from Methods (*.FMKN), Data (*.FDKN), Report (*.FRKN), Spreadsheet ASCII 
(*.CSV), GRAMS (*.SPC) and Rich Text Format (*.RTF) file types.

Note 
If you require a printout of only the current graphics in the Graphics area of a previously stored data file: 

a. Select the Clear Report option in the Commands menu to clear any text that may be displayed in the
Report area.

b. Press the Print button to obtain a printout of the graphics.

Alternatively tick only the Graph check box in the Reports page to obtain a printout of graphics only. 

See also: 
How to use advanced reporting options
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entered in the following manner: 

Each sample name and Well position in the imported file must be on a separate line. Enter the Well position on the 
line immediately after its corresponding Sample Name. Note that any tabs in the file are ignored.   

To illustrate this procedure, the following Sample name file (shown on the left) will be used. The picture on the right 
shows the wells that will be selected for inclusion in the Wellplate sample list. Note that you do not need to include 
the well positions, as they are entered automatically (in this case Sample_name1–Sample_name6 will correspond to 
wells A1–A6 and Sample_name7–Sample_name12 will correspond to wells B1–B6). 

To import sample names: 

Step 1 

Enter your data into a text editor (e.g. Notepad) and save it as a text (*.TXT) file. Refer to Figure 1 for an example of 
the correct format for entering the text. 

Step 2 

From the Scan Application window, select the Setup button to display the Setup dialog. 

Step 3 

Select the Accessories tab to display the Accessories page. Select the Wellplate tab and from the Wellplate page.  

Step 5 

From the Wellplate diagram, select the wells to be included in your analysis. (Refer to Figure 2.) These wells will be 
included in the Wellplate sample list. 

Step 6 

Select the Sample names button to display the Wellplate sample list. 

Step 7 

 [leave blank] 
  Sample_name1 
  Sample_name2 
  Sample_name3 
  Sample_name4 
  Sample_name5 
  Sample_name6 
  Sample_name7 
  Sample_name8 
  Sample_name9 
  Sample_name10 
  Sample_name11 
  Sample_name12

Figure 1 
An example of a Sample name text file. 

Figure 2 
An example of the wells selected on the Wellplate Accessories page. 

Note: 
The first line of the text file you create is not included when you import the sample names list. Therefore you 
should leave this line blank.
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Select the Import Names button. The Open dialog is displayed. 

Step 8 

Browse for you text file and select Open to open the file. The Sample Names and their corresponding Well position 
will appear in the Sample Name table. 

How to resize graph boxes—Scan 
Step 1  

Click on the graph that you want to resize so that the highlight box appears around it. 

Step 2  

Move the cursor to the edge of the highlight box and place it over one of the square marks (e.g. ) in the box until it 
turns into a double headed arrow ( ). 

Step 3  

Click and hold the left mouse button and drag the box to the desired size. 

Step 4  

Release the left mouse button. 

How to zoom a graph—Scan 
To zoom a graph, do the following: 

Step 1  

Click on the  button on the toolbar, or select Cursor Mode from the Graph menu. The Cursor Modes dialog 
will appear. 

Step 2  

Select Free and select the OK button. 

Step 3  

Click and hold down left mouse button in the highlighted graph box. 

Step 4  

Drag the mouse sideways and up or down. You will see a zoom box made up of a dotted line appear on the screen. 
(See picture below.) 

See also: 
Wellplate sample list  
Wellplate Accessories page  
About the Wellplate Reader 

See also: 
How to alter the look of your graphs
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The dotted line is a zoom box. 

Step 5  

Release the left mouse button. The area defined by the zoom box will be redrawn to fill the entire graph box, and the 
scans within the box will be enlarged accordingly. The abscissa (X) and ordinate (Y) coordinates displayed below the 
graph will also be changed to reflect the positions of the corners of the zoom box. 

You can repeat this process if you need to zoom in even further. 

How to take the derivative of a trace 
Some uses of derivatives are:  

To resolve partly overlapping peaks
To quantitatively determine trace compounds
To characterize pure compounds
Purity testing

To take the derivative of a collected trace and plot the result, follow these steps: 

Step 1 

Click on the trace to be smoothed. It will become red (highlighted). 

Step 2 

Click the Selected Trace or Focused Trace button. The name of the highlighted trace will appear in the calculation 
display field. 

Step 3 

In the Trace group, select your derivative order in the Operation field. Choose from derivatives 1 to 4 (Deriv1, 
Deriv2, Deriv3, Deriv4). You may have to scroll to find the derivative you require. 

Step 4 

Enter a Filter Size and an Interval in the corresponding fields. 

Step 5 

In the Display Options group, select New Graph to plot the result in a new graph box, or Selected Graph to plot the 

Hot Tip 
To move the box on the screen, hold down the left and right mouse buttons together. You can then position the 
box anywhere in the graph box. Releasing the right mouse button will still allow you to resize the zoom box.

Note 
The system may limit the extent to which you can Zoom. 
See also: 
How to scale your graph manually 
How to scale your graph automatically
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result in the current graph box. 

Step 6 

Click the Apply button in the Trace group. Your Deriv selection will be displayed before the trace name in the 
calculation display field. 

Step 7 

Click on the equals (=) button. The result will be displayed in the Graphics area. 

How to smooth a trace 
To smooth a collected trace and plot the result, follow these steps: 

Step 1 

Click on the trace to be smoothed. It will become red (highlighted). 

Step 2 

Click on the Maths button in the toolbar (it's on the far right) or select the Maths menu. 

Step 3 

Click the Selected Trace or Focused Trace button. The name of the highlighted trace will appear in the calculation 
display field. 

Step 4 

In the Trace group, select Smooth in the Operation field. (You may have to scroll to find it.) 

Step 5 

Enter a Filter Size and an Interval in the corresponding fields. 

Step 6 

In the Display Options group select New Graph to plot the result in a new graph box, or Selected Graph to plot the 
result in the current graph box. 

Step 7 

Click the Apply button in the Trace group. The word ‘Smooth’ will appear before the trace name in the calculation 
display field. 

Step 8 

Click on the equals (=) button. The result will be displayed in the Graphics area.

See also: 
About derivatives
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Simple Reads Home Page 

Introduction 

Use the Simple Reads application to perform simple fluorescence, phosphorescence and bio/chemi-
luminescence readings of samples. In addition, simple mathematical operations can be performed (via 
the User Collect option) on readings performed at multiple wavelengths. 

To access the Simple Reads Application, click the Windows Start button, point to Programs, Cary 
Eclipse and then select Simple Reads. 

Software controls 

To… Use the… Show me…
Get ready to read Setup dialog How to perform a measurement at a single

wavelength
How to perform measurements at two
wavelengths and subtract the result

Read samples Commands menu How to perform a measurement at a single
wavelength
How to perform measurements at two
wavelengths and subtract the result

View read progress and 
results

Report Area
Print Preview

How to open a previously stored report
How to use the advanced reporting options

To find out about… See the… Show me…
Simple Reads 
Application

Simple Reads
application

File management Open
Save As
Filename
extensions

Screen features Report area
Toolbar
Status Line

How to remove or display the command
buttons

ADL ADL Command
Line
ADL Hooks

How to insert ADL commands using the
Quick Reference

Help and safety 
information

Help menu
Safety Home Page

Simple Reads Application 
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The application comprises the following:

Instrument 
Status 
Readings 

The Instrument Status Readings, which display the Y and X values of the graph axes 
are displayed in the top left and right corners of the Simple Reads Application 
Window. 

Y value 
Displays the current Y value, usually intensity. This value is continually updated 
during a data collection. 

X value 
Displays the current X value, which is the current reading for the time. On the Cary 
page of the Setup dialog, choose whether to display the time value in minutes or 
seconds. 

Read button Select Read to perform a simple read using the current Setup parameters. 
The results of the read will be displayed in the report area. 

Simple Reads 
Report 

In the Simple Reads Report area you can view the current report. The report may list 
the results of your readings and the parameters (for example, ordinate mode and 
wavelengths) used to collect the results. 

You can copy the generated report onto the Windows clipboard. To do this, highlight 
the report (or the relevant section) and press CTRL+C. You can then paste the report 
into a word processor such as Microsoft® Word. 

Hot Tip 
You can edit the Simple Reads Report by pressing CTRL+R or selecting the 
Edit Report command from the Edit menu.

Setup Select Setup to display the Setup dialog where you can enter the instrument and 
wavelength parameters and the filter and voltage options for a Simple Reads run.  
This command is also accessible from the Setup menu.

Zero Select Zero to zero the current intensity value. To start your data at 0 intensity, select 
Zero prior to selecting the Read button.  
This command is also accessible from the Commands menu or by pressing the F5 
function key.

Clear report Select Clear report to clear all the text in the Report area.  
This command is also accessible from the Edit menu.

Print Select Print to display the Windows Print dialog where you can select the printer that 
the report will be printed to. You can also choose which pages to print in the currently 
displayed report as well as the number of copies you wish to print. 
This command is also accessible from the File menu. 

Read Select Read to commence a Simple Reads measurement using the current Setup 
parameters. 
This command is also accessible from the Commands menu.

Hot Tip 
By becoming familiar with these commands (Setup, Zero, Clear report, Print), you can remove 
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Getting ready to read—Simple Reads 
Setup dialog
Setup menu
Cary page
User Collect Example
Bio-/Chemi-luminescence and Phosphorescence Options dialog
Gate Time for Bio-/Chemi-luminescence
Gate Time for Phosphorescence
How many flashes?
Options page

Use the Setup dialog to set up your instrument for a Simple Reads measurement.  

The dialog consists of the following tabbed pages:  

Cary
Options

Use the Setup menu to access the parameters for setting up a Simple Read measurement. 

the Command buttons from the Simple Reads window. This will automatically enlarge the 
Report area, making viewing results easier. To do this, cancel the Buttons item in the View menu. 

Menus The Simple Reads Application also contains the following menus:  
File, Edit, View, Commands, Setup, Help 

 
See also: 
Keyboard function keys 
Setup dialog  
Zero 
User Collect 
User Collect Examples 
Simple Reads Home Page Index

Setup—Simple Reads 

To access the Setup dialog select the Setup button from the Simple Reads Application 
window or the Setup command from the Setup menu.

See also:
Simple Reads Application
Setup menu

Setup menu—Simple Reads 

Command What it does
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Use the Cary page to set up the Cary Eclipse instrument parameters associated with a Simple Reads 
measurement. 

To access the Cary page, select the Setup command from the Setup menu. You can also access the 
page from the Setup dialog, by selecting the Cary tab. To access the Setup dialog, select the Setup 
button from the Simple Reads Application window or the Setup command from the Setup menu. 

The page comprises the following: 

Instrument setup 

Wavelength setup 

Setup Choose Setup to display the Setup dialog, where you can set up your instrument for a 
Simple Reads measurement. The Setup dialog can also be accessed by selecting the 
Setup button from the Simple Reads Application window.

See also: 
Setup

Cary—Simple Reads 

Data mode Fluorescence 
Fluorescence refers to the emission of light from an excited single state. The 
fluorescence signal is measured when the lamp flashes. Fluorescence mode has 
excitation, emission and synchronous scan modes. 

Bio-/Chemi-luminescence 
Bio-/Chemi-luminescence refers to bio- or chemi-luminescence, where the emission is 
generated via a chemical or biochemical reaction. The lamp does not flash in Bio-
/Chemi-luminescence mode. Emission is the only scan mode of bio-/chemi-
luminescence. 

Phosphorescence 
Phosphorescence refers to the emission of light from an excited triplet state. 
Phosphorescence is measured after the lamp has stopped flashing. Phosphorescence 
mode has excitation, emission and synchronous scan modes. 

Options Click Options to open the Options dialog where you can set parameters such as the 
Decay, Delay and Gate times for your sample. 

Note 
The Options button is only visible if you have selected Bio-/Chemi-
luminescence or Phosphorescence as the Data Mode.

Ex. 
Wavelength 
(nm) 

Set the wavelength of the excitation monochromator, which is the wavelength value at 
which you want to excite your sample. To set the monochromators to zero order 
(white light), from the Commands menu, point to Zero Order and select Excitation. 
A tick next to this option indicates that it is selected. Clear this option to return to 
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monochromator light. 
Hot Tip 
Click the arrow to the right of the field to quickly select the most recent 
wavelength entries. 

Em. 
Wavelength 
(nm) 

Set the wavelength of the emission monochromator, which is the wavelength value at 
which your sample emits. To set the monochromators to zero order (white light), from 
the Commands menu, point to Zero Order and select Emission. A tick next to this 
option indicates that it is selected. Clear this option to return to monochromator light. 

Hot Tip 
Click the arrow to the right of the field to quickly select the most recent 
wavelength entries.

User Collect Select User Collect to change the Em. Wavelength field to an entry field in which you 
can enter an ADL command. The Syntax for ADL commands is: 

Read (Ex. wavelength, Em. Wavelength) 

Use this entry field to carry out multiple sample reads at various wavelengths and then 
apply simple mathematical equations to generate a result. You can pre-define the ADL 
User Collect commands present in the drop down list on the Edit tab in System 
Information. 

This allows an ADL command to be entered which applies a mathematical expression 
to the intensity value collected. The most recent user collect entries will be saved in 
the drop down list to a maximum of 10. 

Hot Tip 
You can perform multi-ratio and multi-equation reads using the User Collect 
option. That is, you can calculate more than one ratio or equation in the one 
read, rather than performing separate reads for each ratio or equation. For multi-
ratios, use this format: 

Read(355, 405)/Read(355/480) etc. 

An example of a multi-equation might be: 

          2.1*Read(340, 510)/Read(405, 600);  
          7.5*Read(350,450)-4.5*Read(525, 610)+ 
          25.5*Read(600, 750) 

The semi-colon (;) separates each ratio or equation. In addition to the results of 
each ratio or equation, the raw readings for each wavelength used will also be 
reported. 

Ex. Slit (nm) Set the slit width of the excitation monochromator

Em. Slit 
(nm) 

Set the slit width of the emission monochromator
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User Collect examples—Simple Reads 
You can extend the functionality of your Cary Eclipse instrument by using the built-in Read command. 
This command enables you to change the instrument to a different wavelength and take a reading. You 
can combine this command with the mathematical operators: ‘+’, ‘–’, ‘*’ and ‘/’. This is illustrated in 
the examples below. 

Read(500) 

This will cause the system to change the wavelength to 500 nm and then take a reading. The result will 
be printed in the Report area. 

260 nm/280 nm ratio 

Read(260)/Read(280) 
In many Life Science settings such as medical institutions and university research departments, nucleic 
acids are extracted from living cells and are then purified. In these fields of science it is imperative that 
the samples collected are free from contamination by other molecules such as proteins and chemicals 

Ave time (s) Set the amount of time, in seconds, for which data is averaged. To do this, enter the 
amount in the Ave. time field, or use the up/down arrows to the fight of the field to 
increase or decrease the time. The averaged result is displayed in the report. 

When setting the Ave Time, consider the following:  

The longer the Ave Time, the longer the signal will be averaged

A longer Ave Time will result in more precise results as the averaging of the
signal reduces any contribution of background ‘noise’.

Averaging is calculated as follows: 

For fluorescence: 
the number of readings averaged are taken from consecutive flashes at 80 Hz where: 
number of consecutive flashes = averaging time/0.0125. 

For phosphorescence: 
the intensity readings are taken from different decays, where: 
number of decays = averaging time/gate time. 

For bio-/chemi-luminescence: 
a signal is collected every Gate time, and (averaging time/gate time) signals are 
averaged at each data interval  

Understanding Average Time and Gate Time 

See also: 
Simple Reads Application 
Options dialog   
User Collect examples
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like phenol. To determine the purity and type of nucleic acid in a sample, it is necessary to calculate the 
ratio of intensity values, read at 260 and 280 nm. At 260 nm nucleic acid bases strongly absorb and at 
280 nm proteins and other contaminating materials absorb light. 

For pure DNA the 260/280 is 1.8 and for pure RNA the 260/280 is 2.0. Values significantly lower than 
these indicate contamination of the sample, which may require the customer to perform a further sample 
clean-up. 

The above User Collect statement causes the system to first take a reading at 260 nm, then change to 280 
nm and take a second reading. The system then divides the reading at 260 nm by the reading at 280 nm 
and prints the result in the Report area. 

260 nm/280 nm ratio, with background correction at 320 nm 

(Read(260)—Read(320))/(Read(280)—Read(320)) 
Neither nucleic acids or proteins absorb light at 320 nm, so this wavelength is used to correct the 
readings taken at both 260 nm and 280 nm. The same ratio values of 1.8 for pure DNA and 2.0 for pure 
RNA apply for 320 nm background corrected 260/280 data. 

The above statement causes the instrument to perform a 260/280 ratio, with 320 nm background 
correction. The system first takes readings at 260 nm, 280 nm and 320 nm. It then subtracts the reading 
at 320 nm from the readings at 260 and 280 nm, and divides the result. The final answer is printed in the 
Report area. 

Warburg-Christian1 calculations

Nucleic acid and protein concentrations can be determined, in mg/mL, using the factors and equations of 
Warburg and Christian. Warburg and Christian determined these equations and factors based on the 
relationship between the molar absorptivity values of a yeast RNA and protein called enolase, 
determined at 260 nm and 280 nm with background correction at 320 nm. 

The User Collect statements for the Warburg-Christian calculations are: 

Protein concentration 
( 1552 * (Read(280)—Read(320)) )—(757.3 * (Read(260)—Read(320)) )' Protein Conc 

This expression causes the instrument to take readings at 260 nm, 280 nm and 320 nm. The 
mathematical operations defined in the expression are then performed on each of these readings and the 
result is printed in the Report area.  

Nucleic acid concentration 
( -36.0 * (Read(280)—Read(320)) ) + (62.9 * (Read(260)—Read(320)) ) 'Nucleic Acid Conc

This expression causes the instrument to take readings at 260 nm, 280 nm and 320 nm. The 
mathematical operations defined in the expression are then performed on each of these readings and the 
result is printed in the Report area. 

Note 
The single quote at the end of the equation indicates a comment that is ignored by the instrument.
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References: 
1. Warburg, O. and Christian, W. (1942) Biochem. Z., 310, 384.

Dialog controls | Example of the options

Use the Bio-/Chemi-luminescence/Phosphorescence Options dialog to set up the parameters 
associated with these two measurement modes. 

To access the Bio-/Chemi-luminescence/Phosphorescence Options dialog, select the Options button 
from the Cary page. 

Dialog controls 

The Bio-/Chemi-luminescence/Phosphorescence Options dialog comprises the following options: 

Note 
The single quote at the end of the equation indicates a comment that is ignored by the instrument.

Hot Tip 
If you are performing a large number of DNA/RNA analyses, then you may prefer to use the RNA-
DNA application for Cary Eclipse instruments available in the Bio package.

Bio-/Chemi-luminescence/Phosphorescence 
Options—Simple Reads 

Note 
The Options button is only visible on the Cary page if you have selected Bio-/Chemi-
luminescence or Phosphorescence as the Data Mode.

Total decay 
time 

Enter, in seconds, the total decay time for your sample. The total decay time is the time 
that it takes for the phosphorescence signal to decay to dark levels (zero). The lamp 
will not flash again until the total decay time has elapsed. 
The range is 0.001–1800.000 s. 

Note 
This option is not available in Bio-/Chemi-luminescence mode.

No. of flashes Enter the number of lamp flashes required, which is how many times the lamp flashes 
consecutively before the delay time is counted. 

If you are measuring phosphorescence samples that have a relatively long decay time 
(that is, a number of seconds), you can setup the Cary Eclipse to pulse the lamp 
multiple times, as this will increase the intensity of the phosphorescent signal. For short 
lived phosphorescent samples, multiple flashes will not impact on the intensity of the 
signal, and therefore only one flash is required. 

How many flashes should I perform? 

Note 
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Example of the Bio-/Chemi-luminescence/Phosphorescence Options 

Understanding Gate Time for Bio-/Chemi-luminescence scans—
Simple Reads 

This option is not available in Bio-/Chemi-luminescence mode.

Delay time Enter, in milliseconds, the delay time for your sample. The delay time is the time that 
elapses between the last flash and the beginning of data collection. The default value is 
0.100 ms, which is the time it takes for the lamp intensity to decay to zero. Setting a 
delay time ensures that there is no lamp effects in the phosphorescence decay curve. 
The range is 0.000–5000.000 s. 

Note 
This option is not available in Bio-/Chemi-luminescence mode.

Gate time Enter, in milliseconds, the gate time for your sample. The gate time is the overall 
reading time of the emission signal. 
The range is from 10µs–10s. 

Understanding Average Time and Gate Time for Phosphorescence scans  
Understanding Gate Time for Bio-/Chemi-luminescence scans  

See also: 
Cary page
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Gate Time is set on Options page, which is accessible from the Cary page.

The following diagram highlights the Gate Time setting. 

The Gate Time is set to 10 and the Intensity is equal to IT.

Understanding Average Time and Gate Time for 
Phosphorescence—Simple Reads 
For Phosphorescence scans, there is a relationship between Average Time (the time for which data is 
averaged) and Gate Time (the overall reading time of the emission signal).  

Averaging is calculated as follows: 

The intensity readings are taken from different decays, where: 
Number of Decays = Averaging Time/Gate Time 

Average Time is set on the Cary page of the Setup dialog. Gate Time is set on Options page, which is 
accessible from the Cary page. 

The following diagrams highlight the relationship between Average Time and Gate Time.

See also: 
Understanding Average Time and Gate Time for Phosphorescence scans  
Simple Reads Application   
Cary page   
Options dialog   
User Collect examples

Note: 
Gate Time is not used if you select Fluorescence as the Data Mode. 
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Example 1 

When the Average Time and Gate Time are set to the same value: 

where: 

Example 2 

When the Average Time is set to five times the Gate Time: 

Average Time/Gate Time 1

Intensity 1 (Area I1)

Total Decay Time 20 ms
Delay Time 10 ms
Average Time 5 ms
Gate Time 5 ms

Average Time/Gate Time 5
Intensity A1 + A2 + A3 + A4 + A5 

____________________ 

5 

Page 11 of 36Simple Reads Home Page

 



where: 

Total Decay Time 20 ms
Delay Time 10 ms
Average Time 5 ms
Gate Time 25 ms

See also: 
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How many flashes should I perform?—Simple Reads 
The Number of Flashes option is set in the Bio-/Chemi-luminescence/Phosphorescence Options 
dialog. To access the dialog, select the Options button from the Cary page. 

If you are measuring phosphorescence samples that have a relatively long decay time (that is, a number 
of seconds), you can setup the Cary Eclipse to pulse the lamp multiple times, as this will increase the 
intensity of the phosphorescent signal (refer to Example 1, below). For short lived phosphorescent 
samples, multiple flashes will not impact on the intensity of the signal, and therefore only one flash is 
required (refer to Example 2, below). 

Example 1 
The above example shows that the sample does not decay before the instrument lamp flashes again. 
Therefore setting multiple flashes will result in an increase in the intensity of the signal. 

Understanding Gate Time for Bio-/Chemi-luminescence scans  
Simple Reads Application   
Cary page   
Options dialog   
User Collect examples

Note 
The Options button is only visible on the Cary page if you have selected Bio-/Chemi-
luminescence or Phosphorescence as the Data mode.
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Example 2 
The above example shows that the sample decays in less time than the time it takes the instrument to 
flash the lamp again. Therefore, setting more than 1 flash, in the No. of Flashes field will not increase 
the intensity of the signal. 

Use the Options page to set up the Cary Eclipse filters and the PMT Detector voltage. 

The Options page is accessible from the Setup dialog by selecting the Options tab. To access the Setup
dialog, select the Setup button from the Simple Reads Application window, or select of the Setup 
command from the Setup menu. 

Reading samples—Simple Reads 

See also:   
Bio-/Chemi-luminescence/Phosphorescence Options

Options—Simple Reads 

Excitation 
Filter 

Set the excitation filter for the Simple Reads measurement. To do this, select the down 
arrow to the right of the field and select an option from the list.

Emission 
Filter 

Set the emission filter for the Simple Reads measurement. To do this, select the down 
arrow to the right of the field and select an option from the list.

PMT 
Detector 
voltage 

Set the EHT or sample detector PMT. To do this, select one of the following: 

Low 
Sets the PMT Detector voltage to a pre-defined value of 400 v. 

Medium 
Sets the PMT Detector voltage to a pre-defined value of 600 v. 

High 
Sets the PMT Detector voltage to a pre-defined value of 800 v. 

Manual 
Enables you to enter any PMT voltage in the adjacent Volts field. 

Volts 
Enter the PMT voltage in the adjacent field. Note that this option is only available if 
you have selected Manual as the PMT Detector voltage. 

Note 
The reference detector EHT is assigned according to the instrument settings, and 
will be determined when you select OK to exit the Setup dialog.  
The intensity may be doubled with every 10% increase in EHT on the sample 
detector.

See also: 
Setup  
Simple Reads Application 
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Go To dialog
Rapid Result dialog
Zero dialog
Commands menu
How to perform a measurement at a single wavelength
How to perform measurements at two wavelengths and subtract the result

Use the Go To Wavelength dialog to temporarily change the instrument to a new excitation or emission 
wavelength. You would mainly use this if you wanted to quickly go to a wavelength to check the 
intensity reading of the sample. The lamp will flash continuously in this mode. This option is only 
available if the instrument is not currently collecting data. 

To access the Go To Wavelength dialog, select the Go To Wavelength command from the Commands 
menu. You can also select F4 to open the dialog. 

Use the Rapid Result dialog to take a reading of a blank and sample/s, without having to change the 
current application method. The result is printed in the Report area. 

To access the Rapid Result dialog, select the Rapid Result command from the Commands menu. You 
can also select F6 to open the dialog. 

Go To Wavelength—Simple Reads 

Note 
This is not the wavelength used in the application method. If your method uses a wavelength that is 
different from the Go To Wavelength, then when you select Read the system will change to the 
wavelength selected. (This is set on the Cary page of the Setup dialog.) 

Excitation Wavelength 
Enter the new wavelength in this numeric entry field. Select Go To or press ENTER 
and the instrument will change to the new value. 

Zero order 
If this check box is selected, then the Cary Eclipse will be driven to 0 nm (white light). 
You can then use this light for aligning accessories. 

Emission Wavelength 
Enter the new wavelength in this numeric entry field. Select Go To or press ENTER 
and the instrument will change to the new value. 

Zero order 
If this check box is selected, then the Cary Eclipse will be driven to 0 nm (white light). 
You can then use this light for aligning accessories. 

Go To Select Go To once you have entered a new wavelength, to change the instrument to the 
entered value.

See also: 
Function Keys

Rapid Result—Simple Reads 
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Zero—Simple Reads 
Use the Zero button to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use the Zero 
command before commencing a data collection if you want your data to start at 0  intensity. The Cary 
Eclipse will prompt you to load a blank before performing the zero. 

Before you select Zero, ensure that you have placed the blank solution in the cell positions that are 
currently in the cell path. 

When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the 
Simple Reads Application window. 

Select the Clear Zero command from the Commands menu to remove zero correction and thus remove 
the subtraction effect. 

Use the Commands menu to access the commands for performing a Simple Read. 

Commands in this application can be accessed both from the menu items at the top of the main window 
and from the application buttons. Alternatively you can use function key shortcuts for some of the 
commands. These appear next to the item in the Commands menu. Note that not all commands appear 
as both button and menu items. 

Excitation Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Emission Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Zero Click Zero to change the wavelength to the entered value and measure a blank.
Result Click Result to change the wavelength to the entered value and measure a sample. The 

X,Y results are corrected for the blank.

To access the Zero option, select the Zero command from the Commands menu, or select 
the Zero button from the Simple Reads Application window. 

See also: 
Simple Reads Application 
Commands menu

Commands menu—Simple Reads 

Hot Tip 
By becoming familiar with these commands, you can remove the Command buttons from the 
Simple Reads window. This will automatically enlarge the Report area, making viewing results 
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The following commands are accessible from the Commands menu: 

easier. 

How to remove or display the command buttons  

Command What it does…
Read Select this to commence a Simple Reads measurement using the current Setup 

parameters. This command is also accessible by pressing F9. 
Note 
If the Connect command is displayed in place of the Read command, this 
indicates that another Cary Eclipse application is in use and has control of the 
Cary Eclipse instrument. To make the Simple Reads application active so that 
you can perform a read, you will need to select Connect. However, you will not 
be able to select Connect if another application is collecting data.

Clear Zero Select this option to clear the Zero command. When you select the Zero command 
(from the Commands menu or by pressing F5), the intensity at that time will be reset 
to zero and all subsequent results will have the intensity value that was reset to zero 
subtracted from them. Selecting Clear zero cancels this zeroing (and thus subtraction) 
effect.

Zero Order Excitation 
Select this command to set the excitation monochromator to zero order (white light). 

Emission 
Select this command to set the emission monochromator to zero order (white light). 

Reset 
Rapid Result Select this to display the Rapid Result dialog where you can read a blank and multiple 

sample readings without changing the application method. 
This command is also accessible by pressing F6.

Zero Select this to zero the current intensity value. The intensity value will be reset to zero 
and all subsequent results will have the value that was reset to zero subtracted from 
them. You can use the Zero command before selecting Start if you want your data to 
start at 0 intensity. 
This command is also accessible by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Go to Select this to display the Go To Wavelength dialog and change the instrument to a 
new wavelength. 
This command is also accessible by pressing F4.

ADL 
Command 

Select this to display the ADL Command Line window where you can execute an 
ADL command or ADL program. (You can also press Alt-Y to display this dialog.) 
This command is also accessible by pressing CTRL+Y.

Re-run ADL Select this to run the ADL command or program in the ADL Command Line window 
again. (You can also press Alt-X to rerun programs.) 
This command is also accessible by pressing CTRL+X.
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How to perform a measurement at a single wavelength—Simple 
Reads 
This demonstrates how to read samples at a single wavelength. 

Follow the steps through, adjusting them to meet the requirements of your particular data collection.  

The procedure consists of the following steps:  

Start the application
Set up instrument parameters
Read the sample
Print the results

Start the application 

Step 1 

On the Windows Taskbar click Start, then point to Programs, Cary Eclipse and select Simple Reads 
to open the Simple Reads application. 

Step 2 

Make sure that the sample compartment is clear (or you have a blank in position) and zero the 
instrument by selecting the Zero button. 

Set up the instrument parameters 

Step 3 

Select the Setup button or select the Setup command from the Setup menu to display the Cary page of 
the Setup dialog. 

Step 4 

In the Instrument Setup group, select the Data Mode you require. Choose from Fluorescence, Bio-
/Chemi-luminescence or Phosphorescence. 

Step 5 

See also: 
Rapid Result   
Go To Wavelength   
ADL Command Line   
Function keys

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the 
Simple Reads application.
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In the Wavelength Setup group, enter the required excitation and emission wavelengths at which you 
want to perform the read. 

Step 6 

Select the OK button. The instrument will change to the new wavelength. 

Read the sample 

Step 7 

Insert the sample into the sample compartment. 

Step 8 

Wait while the instrument changes to the specified wavelength. The current wavelength is displayed in 
the Intensity status display at the top and right of the application window. 

Step 9 

Select the Read button to perform the read. The result will be displayed in the Report area.  

Print the results 

Step 10 

To print the contents of the Report area, select the Print button. 

How to perform measurements at two wavelengths and subtract 
the result—Simple Reads 
With the User Collect function you can extend the Simple Reads application to carry out simple 
mathematical functions on the results of readings performed on a sample at various wavelengths. 

To do this:  

Start the application
Set up instrument parameters
Read the sample
Print the results

Start the application 

Step 1 

On the Windows Taskbar click Start, then point to Programs, Cary Eclipse and select Simple Reads

See also: 
How to perform measurements at two wavelengths and subtract the result
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to open the Simple Reads application. 

Step 2 

Make sure that the sample compartment is clear (or you have a blank in position) and zero the 
instrument by selecting the Zero button. 

Set up instrument parameters 

Step 3 

Select the Setup button or select the Setup command from the Setup menu to display the Cary page of 
the Setup dialog. 

Step 4 

In the Instrument Setup group, select the Data Mode you require. Choose from Fluorescence, Bio-
/Chemi-luminescence or Phosphorescence. 

Step 5 

Select User Collect. The Em. Wavelength field will change to enable you to enter a simple Read 
command. You can also select a default command from the drop down list. To do this, select the arrow 
on the right side of this field. 

User collect example: 

Read(340, 400)-Read(340, 450) 
This reads the intensity at Excitation monochromator = 340, Emission monochromator = 
400 and subtracts the intensity read at Excitation monochromator = 340 and Emission 
monochromator = 450. This reading is performed at each data point. 

Step 7 

Set the slit widths of the excitation and emission monochromators in the Ex. Slit and Em. Slit fields. 

Step 8 

Enter the averaging time, which is the time for which data is averaged. 

Step 9 

Select the OK button. The User Collect statement will appear in the Report area. 

Read the sample 

Note 
If you are running a GLP system you may be prompted to enter a password before accessing the 
Simple Reads application.
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Step 10 

Insert the sample into the sample compartment. 

Step 11 

Select the Read button to perform photometric measurements on the sample at the specified wavelength. 

The value for each sample read will appear in the Report area as well as the result of the User Collect 
equation.  

Print the results 

Step 12 

To print the contents of the Report area, select the Print button. 

Viewing run progress and results—Simple Reads 
View menu
Edit menu
Print Preview dialog
How to open a previously stored report
How to use advanced reporting options

View menu—Simple Reads 
Use the View menu to show or hide toolbars, buttons, reports and other items in the Simple Reads 
Application window. 

See also: 
How to perform a measurement at a single wavelength

Command What it does…
Toolbars Show or hide the following toolbars or toolbar items: 

Report 
View the Report toolbar which contains shortcuts for common report editing functions 
such as cutting and pasting text, changing text fonts and preview the report. 

Text Labels 
View the text labels associated with the Report toolbar. Note that the Report toolbar 
must be visible for these labels to be displayed. 

Buttons Select this command to toggle the left-hand button display (button area) on and off.
Report Select this command to view the Simple Read report.
ADL Select this command to toggle the ADL Editor on and off.
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Edit menu—Simple Reads 
Use the Edit menu to perform simple text functions such as copying, pasting and formatting text. 

ADL vertical If the ADL and Report options are selected, select ADL Vertical to display the ADL 
Editor vertically on the right hand side of the Report area.

ADL Quick 
reference 

This displays the Quick Reference window where you can easily add a command in 
the correct syntax to your ADL program. A detailed description of all the commands 
in the Quick Reference is available by selecting the Help button.

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Hints Select this command to toggle the Hints bubble text on and off. The bubble text 
appears when you place the arrow cursor over a field, button or text entry field for a 
short period. It offers a quick explanation of the item’s function.

See also: 
Report toolbar   
How to insert ADL commands using the Quick Reference

Hot Tip 
The buttons shown below can be made visible in the Simple Reads Application window by 
selecting the View menu, pointing to Toolbars and then selecting Report. 

Command Button What it does…
Undo If available, this undoes the last action. 

This command is also accessible by pressing CTRL+Z.
Cut Select this command to remove the highlighted text and place it on the 

Windows Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Select this command to copy the highlighted text onto the Windows Clipboard.
This command is also accessible by pressing CTRL+C.

Paste Select this command to insert the contents of the Windows Clipboard (text 
only) at the cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Select this command to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
This option is only available once you select Edit Report and there is 
text highlighted in the Report area. 

Select All Select this option to highlight all text in the Report area. 
This command is also accessible by pressing CTRL+A.
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Print Preview—Simple Reads 
Use the Print Preview dialog to view the contents and layout of current report before you print it. 

To access the Print Preview dialog, select the Print preview command from the File menu. 

You can reduce or enlarge the print preview on screen. Click the left mouse button in the preview area to 
toggle through the five available views. Click the right mouse button in the preview area to return to the 
full page view. 

Use the scroll bars to the right and bottom of the report to move around the preview.  

Font This enables you to change the font of new or selected text in the report. For 
existing text, simply highlight the text in the report, select Font and make your 
changes in the Font dialog. When you select OK, the appearance of the 
highlighted text in the report will alter to reflect your font changes. 
This command is also accessible by pressing CTRL+F. 

Note 
You do not have to select Edit Report to use this command. 

Edit Report Select this option to edit the report. 
This command is also accessible by pressing CTRL+R.

Clear 
Report 

Select this command to remove the contents of the Report area. If you have 
saved the report, selecting this option does not delete the contents of the 
report, the information is simply removed from the Report Area.

Create 
Report 

Select this command to create a new report. 

See also: 
Simple Reads Application 

Note 
The scroll bars are not available for the full page view. 

Command Button What it does
First arrow Use this arrow to view the first page of the report.

Previous 
arrow 

Use this arrow to view the previous page of the report.

Next arrow Use this arrow to view the next page of the report. 

Last arrow Use this arrow to view the last page of the report.

Print Use this to display the Windows Print dialog where you can choose the 
printer and pages to print as well as the number of copies you wish to print. 

Q. Why are all of the arrow buttons grayed out?
A. All of the buttons will be grayed out if the report has only one page of data.
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How to open a previously stored report—Simple Reads 
Step 1 

Select Open… from the File menu to display the Windows Open dialog. 

Step 2 

Click the down arrow at the right of the Files of type list box and select Report (*.FRSR) from the list. 
A list of previously stored report files will be displayed. 

Step 3 

Select the report file you require and select Open. The system will display the report information in the 
Report area. 

How to use advanced reporting options—Simple Reads 
This outlines ways to fully customize your reports. Options available include:  

Including header and footer information
Including a logo
Editing the text in the report
Viewing the report on screen before printing
Cutting and pasting to a word processor

Including header and footer information 

You can have text appearing at the top and bottom of every page in your report. To specify what the text 
should be, do the following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then 
select System Information. The System Information application appears with the Company page 
displayed. 

Step 2 

Enter the header and footer information in the Header and Footer fields. 

Step 3 

Click OK to implement your changes. 

Including a logo 

See also: 
How to use advanced reporting options
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You can include a logo on the first page of your report. To specify what the logo should be, do the 
following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then 
select System Information. The System Information application appears with the Company page 
displayed. 

Step 2 

Enter a logo using the Add Logo button. This logo will always be included on the front page of reports. 

Step 3 

Click OK to implement your changes. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can 
then add, delete and change text in the Report area. 

Viewing the report on the screen before printing 

You can view a report before printing it. To do this, from the File menu select Print Preview. You can 
then ensure that the report format is correct before you print it. 

Cutting and pasting to a word processor 

To have complete control over how your report looks you may wish to copy it to a word processor 
program, such as Microsoft Word. To do this: 

Step 1 

Open a report. 

Step 2 

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application.

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The
Administrator of the system will have to change your privileges before you can edit reports.

Hot Tip 
Use the arrow keys at the bottom of the Print Preview screen to change pages.
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From the Edit menu, choose Edit Report.

Step 3 

Click in the Report area and highlight the text you want to export to your word processor. 

Step 4 

Right-click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text 
into a document. 

File Management—Simple Reads 
File menu
Open dialog
Save As dialog
Filename extensions

File menu—Simple Reads 
Use the File menu to open, save or print a report, or exit the Simple Reads application. 

Hot Tip 
Highlight a report file (*.FRSR) in Windows® Explorer and simply drag and drop it onto the 
application to open it. The data will be displayed in the Report area. 

Command What it does
New… Select this command to clear the current report and create a new one. 

This command is also accessible by pressing CTRL+N.
Open 
method… 

Select this command to display the Open dialog and load a stored method file. Method 
files have the file extension ‘.FMSR’. 
This command is also accessible by pressing CTRL+M.

Open data… Select this command to display the Open dialog and load a stored data file. Data files 
have the file extension ‘.FMSR’. 
This command is also accessible by pressing CTRL+O.

Save method 
as… 

Select this command to display the Save As dialog and store the current method. 
Methods are saved with the extension ’.FMSR’. 
This command is also accessible by pressing CTRL+S.

Save data 
as… 

Select this command to display the Save As dialog and store the current report. Data is 
saved with the extension ’.FMSR’.

Print setup… Select this command to display the Windows Print Setup dialog where you can select 
the printer, printer page size and orientation.
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Use the Open dialog to open a method or report file previously saved by the application. 

To access the Open dialog, select the Open method or Open data command from the File menu. You 
can also select CTRL+M (for a method) or CTRL+O (for data) open the dialog. 

Print 
preview… 

Select this command to display the Print Preview dialog to view the current report 
before you print it.

Print… Select this command to display the Windows Print dialog where you can choose the 
printer and pages to print as well as the number of copies you wish to print. 
This command is also accessible by pressing CTRL+P.

Explorer… Select this command to run Windows Explorer. This may help you locate report files.
History list This displays a list of the four most recently opened files.
Exit Select this command to close the Simple Reads application. You will be prompted if 

there is any unsaved data in the report.

See also: 
Open   
Save As   
Print Preview 

Open—Simple Reads 

Look in This field lists the available folders and files. Click the down arrow on the right of this 
field to see how the current folder fits in the hierarchy on your computer. 

To view the contents of a folder, select it. The folders and files in the selected folder are 
displayed the list box below. 

Note 
To open the folder one level higher, select  on the toolbar.

Look in list 
box  

This lists the folders and files in the selected location. To view the contents of a folder, 
double-click it. The following buttons of the Look in toolbar can assist you in locating 
the appropriate file. 

Click to create a new folder. Type the name of the new folder in the highlighted 
text entry field that appears and press Enter. Then double-click on the new folder 
to open it.
Click to display the directory structure of the drive.

Click to display the files as a list.
Click to display files as a detailed list including the file size, file type and the date 
the file was last modified.
Click to preview the selected trace before you load it into the application.

File name Enter the name of the file you want to open in this field. The easiest way to do this is to 
find the file in the Look in list box and then select the file. However, you can also type 
the full path of a file. Then select the Open button to open the file. 
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Use the Save As dialog to save the method or data. 

To access the Save As dialog, select the Save method as or Save data as command from the File menu. 
You can also select CTRL+S (for a method) to open the dialog. 

Files of type  Click on the arrow on the right of this field to view a list of all application files that can 
be opened in the list box. 

This is useful for reducing the list of files displayed to only those files in which you are 
interested. 

Methods (*.FMSR), Report (*.FRSR) 
In the Simple Reads application, you may open Method or Report files only. 

Open This button opens the highlighted file/s or the files listed in the File name field.
See also: 
Filename extensions

Save As—Simple Reads 

Save in This field lists the available folders and files. Click the down arrow on the right of this 
field to see how the current folder fits in the hierarchy on your computer. 

To view the contents of the folder, select it. The folders and files in the selected folder 
are displayed the list box below. 

Note 
To open the folder one level higher, select  on the toolbar.

Save in list 
box 

This lists the folders and files in the selected location. To view the contents of a folder, 
double-click it. The following buttons of the Look in toolbar can assist you in locating 
the appropriate file. 

Click to create a new folder. Type the name of the new folder in the highlighted 
text entry field that appears and press ENTER. Then double-click on the new 
folder to open it.
Click to display the directory structure of the drive.

Click to display the files as a list.
Click to display files as a detailed list including the file size, file type and the date 
the file was last modified.
Click to preview the selected trace before you load it into the application.

File name Enter the name of the file you want to save in this field. 
You can also type the full path of a file then select the Save button to save the file. 

Files of type Use this field to specify the type of file you are saving. Click on the arrow on the right 
of this field to display the list of all the available file types that this application can 
recognize. 

Methods (*.FMSR), Report (*.FRSR) 
In the Simple Reads application, you may save Method or Report files only. 
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Filename extensions—Simple Reads 
The Cary Eclipse system uses the filename extension to distinguish between data types (e.g. method or 
data) and also to differentiate applications. (e.g. Concentration or Kinetics). 

The Syntax for file extensions is: 

The following files may be opened and saved in the Simple Reads Application: 

Save Select Save to save the file currently present in the File name field in the directory 
specified in the Look in field

See also: 
File menu  
Filename extensions

Letter Represents Available Options
First Type of analysis F Fluorescence

Second Type of file B Batch
D Data
G Graph Template
M Method
R Report

Third and fourth Application identifier AB Advanced Reads
CN Concentration
KN Kinetics
LT Lifetimes
RT Ratio
SR Simple Reads
SW Scan
TM Thermal
VO Validate

Extension Available action File type
*.FMSR Open/Save A method file (*.FMSR) consists of the software setup 

by which data is collected.
*.FRSR Open/Save A report file (*.FRSR) contains the report generated by 

the Cary Eclipse about the data.

Note 
Selecting All Files in the Windows Open dialog will list all available file types. 

See also: 
Open 
Save As
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Software and Screen features—Simple Reads 
Report toolbar
Status line
Function keys
How to remove or display the command buttons

Report Toolbar—Simple Reads 
The Report toolbar is part of the Simple Reads Application. To display the Report toolbar, click the 
View menu, point to Toolbars and then select Report. 

Status line—Simple Reads 
As displayed on the screen from left to right: 

Button Command What it does
Edit Select this option to edit the report.

Undo If available, this undoes the last action.

Cut Select this command to remove the highlighted text and place it on the 
Windows Clipboard.

Copy Select this command to copy the highlighted text onto the Windows Clipboard.

Paste Select this command to insert the contents of the Windows Clipboard (text 
only) at the cursor. Any highlighted text will be replaced.

Delete Select this command to remove selected text in the Report area. 
Note 
This option is only available once you select Edit Report.

Font This enables you to change the font of new or selected text in the report. For 
existing text, simply highlight the text in the report, select Font and make your 
changes in the Font dialog. When you select OK, the appearance of the 
highlighted text in the report will alter to reflect your font changes. 

Note 
You do not have to select Edit Report to use this command. 

Preview Click this button to open the Print Preview dialog where you can view the 
report as it will be printed.

Hardware 
Status 

This field displays status messages indicating the current instrument activity.

Sequence 
Information 

This field displays status messages indicating the current system activity.

Current 
Results 

This field displays information on the last reading.
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Function key—Simple Reads 
The function keys at the top of your keyboard perform basic Cary Eclipse operations simply and 
quickly.  

How to remove or display the command buttons—Simple Reads 
The command buttons (Setup, Zero, Clear Report and Print) appear on the left side of the Simple 
Reads Application window. 

To remove the command buttons 

Step 1 

From the Simple Reads Application window, select the View menu. 

Step 2 

Function 
key 

What it does

F4 Press this key to display the Go To Wavelength dialog. 
This command is also accessible by selecting the Commands menu and then selecting Go 
to.

F5 Press F5 to perform an instrument zero. The current intensity value will be reset to zero and 
all subsequent results will have the value that was reset to zero subtracted from them. You 
can use the Zero command before selecting Start if you want your data to start at 0 
intensity. 
This command is also accessible from the Commands menu or by selecting the Zero 
button. 

Select the Clear Zero command from the Commands menu to remove zero correction.  

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

F6 Press this key to display the Rapid Result dialog where you can read a blank and multiple 
sample readings without changing the application method. 
This command is also accessible by selecting the Commands menu and then selecting 
Rapid Result.

F9 If the application is online, press this key to perform a read. This is equivalent to selecting 
the Start button. If the application is not online, press F9 to first connect to the Cary 
Eclipse before you can press F9 to start the data collection. 
This command is also accessible by selecting the Start button. 

Note 
You will not be able to perform a Start if another application is collecting data.

See also: 
Rapid Result 
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Clear the Buttons menu command. 

The buttons will be removed from the application screen, giving you more room to display reports. 

To show the command buttons 

Step 1 

From the Simple Reads Application window, select the View menu. 

Step 2 

Select the Buttons menu command. 

The buttons will re-appear in the application screen. 

ADL—Simple Reads 
ADL Command Line
ADL Hooks
How to insert ADL commands

Introduction to ADL 

Use the ADL Command Line to run Single-line or Multi-line Applications Development Language 
(ADL) commands that enable you to perform functions over and above that of the existing program 
functionality.  

ADL is not a general purpose programming language. It has been developed specifically by Varian to 
meet the needs of spectroscopists. It can be used to handle all the data collected from the Cary Eclipse—
both photometric values and entire data collections. ADL programs that you develop should be stored 
with the extension 'ADL'. 

To access the ADL Command Line, select the ADL Command item from the Commands menu. You can 
also press ALT+Y to open the dialog. 

Software controls 

ADL Command Line—Simple Reads 

Note 
Full documentation on ADL programming is available in the ADL Online Help.  
Click the button below to view this Help. 

Single Line Selecting this lets you enter ADL commands on a single line into the Command Line 
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The ADL Hooks command is accessible from the View menu.  

Instead of writing a full ADL program you can use ADL hooks to link into an existing application. This 
is particularly useful if you want to make small changes to the way an application works, e.g. you want 
to pop up a dialog for the user to enter some specific data before the run starts. ADL hooks are links at 
specific points in an application at which you can run an ADL program. For example, ADL hooks have 
been supplied to run the following ADL programs:  

entry box. 
Q. Can I enter more than one ADL command on a single line?
A. Yes, provided that the commands are separated by a semicolon ‘;’.

Multi-line The Multi-line capability enlarges the Command Line entry box. Use the Multi-line 
capability to create a more complex ADL program by adding a series of commands 
over multiple lines. When Multi-line mode is selected, the Quick Reference option 
becomes available.

Quick 
Reference 

Select Quick Reference to open the Quick Reference dialog where you can easily add a 
command in the correct syntax to your ADL program. This option is only available for 
Multi-line commands. 

A detailed description of all the commands in the Quick Reference is available by 
selecting the Help button on the Quick Reference dialog. 

Show me How to insert ADL commands using the Quick Reference.

Browse Click Browse to browse your release CD for ADL programming examples that you can 
load and run. Alternatively, you can select and load ADL programs that you may have 
created.

Command 
Line (entry 
box) 

This entry box enables you to use ADL commands. You can enter single ADL 
commands into this field, or you can enter a series of ADL commands. If you have the 
entry type set to Single Line, you can review previous ADL entries by selecting the 
down arrow to the right of the list box. 

The ADL commands in the Command Line are executed when you select OK. 

Note 
On entering this window, the Cary Eclipse will recall the last command or 
program executed from the Command Line entry box. The ADL commands 
entered in the last executed program are stored in the Adl folder (accessed from 
the Varian/Cary Eclipse softwarefolder) as CaryEquation.ADL.
Hot Tip 
You can rerun the ADL commands in the Command Line entry box 
(CaryEquation.ADL) from any screen in the Simple Reads application by 
pressing Alt-X or select Rerun ADL from the Commands menu. The 

 
See also: 
ADL Hooks

ADL Hooks—Simple Reads Application 

Note 
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How to insert ADL commands using the Quick Reference—
Simple Reads 
The Quick Reference window is accessed from the ADL Command window. It enables you to easily add 
a command in the correct syntax to your ADL program. To do this:  

Step 1 
From the Commands menu, choose ADL Command or press Alt-Y to open the ADL Command Line 
window. 

Step 2 
Click the Multi-line option. The Command Line entry box will expand to take multiple lines of ADL 
commands and the Quick Reference check box will appear. 

Step 3 
Select the Quick Reference check box. The Quick Reference window will appear. 

Step 4 
Highlight the command you require in the Quick Reference. If necessary, use the Go To options to jump 

Full documentation on ADL programming is available in the ADL Online Help.  
Click the button below to view this Help.      

Hook Description

SR_Startup.ADL This is run when the Simple Reads application starts. For this to to work the 
application must be started from a batch or method file that has ADL Hooks on.

SR_PreSeq.ADL This runs when the Start button is selected.

SR_PostSeq.ADL This runs at the end of the Start button sequence.

SR_Online.ADL This runs when Cary Eclipse is detected online.

SR_OffLine.ADL This runs when Cary Eclipse goes offline.

SR_Zero.ADL This runs when the Zero button is selected.

SR_Shutdown.ADL This runs when the application is shutting down.

SR_PreRead.ADL This runs just before a read is taken.

SR_PostRead.ADL This runs just after a read is taken (It has the reading result stored in the 
UserResult variable.)

SR_PreSetup.ADL This runs when the Setup button is selected.

SR_PostSetup.ADL This runs when the OK button on the Setup dialog is selected.

SR_CellChange.ADL  This runs instead of the Cary Eclipse driving the Multicell Holder. It 
enables you to add your own instructions for the Cary Eclipse Multicell 
Holder or to use your own cell changing accessory.
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to the appropriate part of the Quick Reference listing.

Step 5 
Click the Insert into ADL button. The selected ADL command will appear in the Command Line entry 
box. 

Step 6 
Where necessary, alter the defaults supplied by the inserted Quick Reference command in the Command 
Line entry box to suit your program. 

Step 7 
Repeat steps 4–7 to add more commands as required. 

Help and Safety information—Simple Reads 
Help menu
Safety home page

Help menu—Simple Reads 
Use the Help menu to view the online Help and software information for this application. 

Safety Home Page 
Click on the desired index entry to view the Help. 

About Safety
Lamp module
Ultraviolet radiation
Electrical hazards — Cary Eclipse
Panels, covers and modules
Other precautions
Warnings and cautions
Warning symbols

Command What it does
Simple Reads 
Help 

Select this to display the Simple Reads Home Page. This contains a list of online Help 
topics specific to this application.

Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.
Tip of the 
day 

Select this option to view the tips of the day.

Eclipse Tour Select this to display the Cary Eclipse Multimedia Online Help. This will give you an 
animated introduction to the Cary Eclipse software and hardware.

About… Select About to access a dialog that displays information about the application as well 
as Varian email and Internet contact information. 
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Color coding
Information symbols
FCC advisory
CE compliant products

Simple Reads How To 
Select the procedure you require below for a step-by-step informative guide on running the application 
software.  

Complete Procedures 

How to perform a measurement at a single wavelength
How to perform measurements at two wavelengths and subtract the result

Other 

How to remove or display the command buttons
How to insert  ADL commands using the Quick Reference
How to open a previously stored report
How to use advanced reporting options

See also:
Simple Reads application
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System Information Home Page 
The Cary Eclipse System Information application enables you to control information that is used by all 
applications such as company details, email host options and the way in which hints are displayed in the 
various applications. The information stored here is then made available to the reporting functions of all 
the other applications. For example, if you store your company's logo here it can be printed on a report 
issued from any application. 

To access the System Information Application, from the Windows Taskbar click the Windows Start 
button, point to Programs, Cary Eclipse and then select System Information. The System Information 
application appears. 

The System Information Application comprises the following tabbed pages:  

Company
Hints
Email Options

The System Information Application also contains the following menus:  

File
View
Help

Use the Company page to enter company data for use throughout the system. To access the Company 
page, select the Company tab from the System Information application window. 

The page comprises the following: 

Company Information 

See also:
System Information How To's

Company—System Information 

Note 
The details entered on this tab are stored when you select OK.

Header Enter the text you wish to appear at the top of any reports printed from Cary Eclipse 
applications.  
Information regarding the date the report was generated and the number of pages in the 
report are automatically included in the header of any report produced. 

Comments Enter any additional information you wish to be included in your reports, for example, 
company details such as name and address. This information will be added to the first 
page of the report only.

Footer Enter the text you wish to appear at the bottom of any reports printed from Cary 
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Logo Information 

Hints—System Information 
Use this page to change the properties of Hints. To access the Hints page, select the Hints tab from the 
System Information application window. 

The page comprises the following: 

Hint Properties 

Use the Hint properties to alter the timing and background color of the displayed Hint text. To do this, 
increase or decrease the pause times by selecting the slider bar and moving it to the left to decrease the 
pause or to the right to increase the pause: 

Eclipse applications.
Hot Tip 
To alter the appearance of your text, change the settings in the Font dialog which 
can be accessed by right-clicking in the above fields.

Add Logo The Add Logo option enables you to include your company logo (or other graphic) in 
your reports. The logo will be added to the first page of the report between the Header 
and Comments information. 

Click this option to open the Open dialog. Use the Open dialog to locate and select 
your company logo file (or other graphic) that will be included in Cary Eclipse reports. 
The file must be in one of the following graphics formats:  

bitmap (BMP)
icon (ICO)
enhanced Metafile (EMF)
metafile (WMF)

Images up to 200 x 50 (width x height) pixels in size are recommended. 
Hot Tip 
As an alternative to selecting the Add Logo button, you can drag and drop images 
straight into the gray area from Windows Explorer. 
Use the Print Preview command (accessible from the File menu) to ensure that 
the logo is displayed correctly.

Clear Logo This deletes the selected logo. 

See also: 
System Information home page 
How to enter a company logo

Hint Hide 
Pause 

Sets the amount of time before the Hint will be hidden, (i.e. sets how long the Hint will 
remain visible).

Page 2 of 6System Information Home Page

   file://C:\Documents and Settings\cary\Local Settings\Temp\~hhD57B.htm



Email Options—System Information 
In order for the Cary Eclipse's email facility to work correctly, you must set up the options on this page. 
The Email Options page is accessible from the System Application window by selecting the Email 
Options tab. 

The page comprises the following: 

Menu line—System Information 
File menu
View menu
Help menu

File menu—System Information 
The File menu comprises the following menu commands: 

Hint Pause Sets the period of time between when the mouse pointer is placed over an item and 
when the Hint appears.

Hint Short 
Pause 

Selects the amount of time to wait before displaying a Hint if a Hint is already showing 
in the screen.

Hint Color Click Hint Color to open the Windows Color dialog where you can change the color of 
the Hint background. You can select from the basic colors displayed or create your own 
color by selecting the Design Custom Colors button. 
Click OK to confirm your selection.

Test Area Place the mouse cursor in this area to preview the Hint properties. 

Reset Hint 
Defaults 

Click this button to reset the Hints to the default system values.

See also: 
View menu  
System Information

Hot tip: 
It is recommended that you contact your System Administrator to assist you with setting up the 
email options.

Mail host Enter the Mail Host for the computer on which the Cary Eclipse software is installed. 
The Mail Host will be listed in your email program, under the same or a similar title 
such as ‘Mail Server’ or ‘SMTP Server’.

Port Enter the Port number. This is usually set to 25.

See also: 
System Information home page 
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View menu—System Information 
The View menu comprises the following menu commands: 

Help menu—System Information 
The Help menu enables you to view the online help and software information for this application. The 
menu comprises the following commands: 

Command What it does
Print Setup Select Print Setup to display the Windows Print Setup dialog where you can select 

the printer, printer page size and orientation.  
Print 
Preview 

Select Print Preview to display the Print Preview dialog where you can view the 
current report.  

Print Select Print to display the Windows Print dialog where you can select the printer and 
pages to print as well as the number of copies you wish to print. This command is also 
accessible by pressing CTRL+P.

Explorer Select Explorer to open Windows Explorer. This may help you locate method and 
data files.  

Exit Select Exit to close the System Information application.  

See also:  
Print Preview   
System Information Home Page

Command What it does
Hints Select this if you want the software to display Hints. 

A ‘Hint’ is a dialog containing a brief explanation of an item (e.g. a tab option, a data 
entry field, etc.), that appears when the mouse pointer is held over that item. 

See also: 
Hints 
System Information home page

Command What it does
System 
Information 
Help 

Select this to display the System Information Home Page. This contains a list of online 
Help topics specific to this application.

Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.
About Select this option to access a dialog that displays information about the application as 

well as Varian email and Internet contact information.  

See also: 
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Print Preview—System Information 
Use the Print Preview dialog to view the contents and layout of current report before you print it. 

To access the Print Preview dialog, select the Print Preview command from the File menu. 

You can reduce or enlarge the print preview on screen. Click the left mouse button in the preview area to 
toggle through the five available views. Click the right mouse button in the preview area to return to the 
full page view. 

Use the scroll bars to the right and bottom of the report to move around the preview.  

System Information How To 
Select this procedure for a step-by-step informative guide on importing company logos.  

How to enter a company logo

How to enter a company logo—System Information 
Step 1 

System Information home page

Note 
The scroll bars are not available for the full page view. 

Command Button What it does
First arrow Use this arrow to view the first page of the report.

Previous 
arrow 

Use this arrow to view the previous page of the report.

Next arrow Use this arrow to view the next page of the report. 

Last arrow Use this arrow to view the last page of the report.

Print Use this to display the Windows Print dialog where you can choose the 
printer and pages to print as well as the number of copies you wish to print.

Q. Why are all of the arrow buttons grayed out?
A. All of the buttons will be grayed out if the report has only one page of data.
See also: 
File menu 

See also:
System Information home page
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On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then 
select System Information. The System Information application appears. 

Step 2 

On the Company page, select your logo by doing the following:  

a. Click the Add Logo button to display the Open dialog.

b. Select the directory containing your logo in the Look in field.

c. Enter the name of your logo in the File name field. You can use Bitmap, Icon, Enhanced Metafile
and Metafile file types. Images should be no larger than 200 x 50 (width x height) pixels.

d. Click Open to clear Open dialog. Your logo will appear in the gray area just below the Company
Information fields.

If you are not satisfied with the current logo, select Clear Logo to delete it and repeat Step 2 to
select a different logo.

Step 3 

When you have made your logo selection, select OK to exit the System Information application. Your 
logo will be present in any application reports when Company Logo is selected on the Reports page. 
The logo will be displayed on the first page of your reports, underneath the header information. 

Note 
If you are running the Cary Eclipse software under Windows NT you need to be logged on as an 
Administrator in order to specify the logo in the System Information application. 

Hot Tip
As an alternative to steps a–d above, you can drag and drop images straight into the gray area from
Windows Explorer.

Note 
In the Simple Reads application, the Logo will be automatically selected, as the Report page is 
not available. 

See also: 
Company page
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Thermal Home Page 

To… Use the… Show me…
Get ready to collect data Setup dialog

Perform data collections Commands menu How to perform a run and determine Tm
using Derivative calculations
How to perform a run and determine Tm
using Hyperchromicity calculations

View run progress and 
results

Status Display
Reports
Print Preview

How to generate a report from previously
collected data
How to use advanced reporting options

Display data graphically Graphics Area
Graph menu

Graphics How To

Perform calculations Analyze page How to perform Derivative calculations on
previously stored data
How to perform Hyperchromicity
calculations on previously stored data
How to use the ruler during Hyperchromicity
calculations  
How to perform post run calculations on
stored data

To find out about… See the… Show me…
Thermal Application Thermal

application
File management Open

Save As
Filename
extensions
Auto Store

How to export collected data
How to email your results

Screen features Buttons
Toolbar
Status Line
Menu Line

How to remove or display the command
buttons

Examples Example of a user collect
Example of a multi-stage thermal run

ADL ADL Command
Line
ADL Hooks

Help and safety 
information

Help menu
Safety Home Page

Accessories Multicell Holder
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Introduction 

The Thermal application allows you to perform thermal analyses on DNA using one of the Cary 
accessories with temperature control. Once the data is collected, you can choose to calculate the melting 
temperature, Tm, by either the derivative or hyperchromicity methods. The hyperchromicity methods also 
allow you to determine thermodynamic parameters such as ΔS, ΔH and ΔG. 

Use the Thermal application to measure the increase or decrease in emission intensity as a function of 
time. From this you can obtain an intensity versus time plot. In addition, you can also perform 
polarization measurements as a function of temperature.  

To access the Thermal Application, click the Windows Start button, point to Programs, Cary Eclipse 
and then select Thermal. 

Software controls 

The application comprises the following: 

Automated and
Manual Polarizer

Thermal Application 

Instrument 
Status 
Readings 

The Instrument Status Readings, which display the Y and X values of the graph axes are 
displayed in the top left and right corners of the Thermal Application Window. 

Y value 
Displays the current Y value, usually intensity. This value is continually updated during 
a data collection. 

X value 
Displays the current X value, which is the current reading for the Temperature.  

Start and 
Stop buttons 

The Start and Stop buttons at the top of the Thermal Application window are used to 
start and stop instrument analyses. These buttons can also be accessed from the 
Commands menu. 

Tell me more about the Start and Stop buttons 
Graphics 
area 

The Graphics area refers to the plotting area of the application. It can contain traces of 
collected data, labels and pictures. In the Cary Eclipse system, the term 'graph' refers to 
the plotting area and is represented by a set of axes. The rectangular area defined by the 
axes is referred to as a graph box. 

To display or hide the Graphics area, select the Graphics command on the View menu. 
Double-clicking on the Graphics area enables you to toggle between half or full size 
display sizes. To manually size the Graphics area, place the mouse cursor over the 
border between the Graph and Report areas until the cursor changes to a double arrow (
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Validation of your Cary Eclipse for the Thermal application 
Two Validation files are shipped with the Thermal application to enable you to validate the software. The 
files are stored on your CD in a Validation subdirectory. 

To validate your software, you should Open each file in turn and select the Recalculate button. The 
results calculated by the Cary Eclipse should match those given in the validation files listed below. These 

). Then hold down the mouse and drag it up or down to resize the areas.  

Tell me more about the Graphics area  
Report area Use the Thermal Report area to view the current report. The report may include the 

results of your data collection, the method parameters used to collect the results and any 
graphics you have included. You can select the information to include in your report in 
the Reports tab of the Setup dialog. 

To display or hide the Report area, select the Report command from the View menu. 
Double-clicking on the Report area enables you to toggle between half or full size 
display sizes. To manually size the Report area, place the mouse cursor over the border 
between the Graph and Report areas until the cursor changes to a double arrow ( ). 
Then hold down the mouse and drag it up or down to resize the areas. 

You can copy the generated report onto the Windows clipboard. To do this, highlight 
the report (or a relevant section of it) and press CTRL+C. You can then paste the report 
into a word processor such as Microsoft® Word. 

Hot Tip 
You can edit the Thermal Report by pressing CTRL+R or selecting the Edit 
Report command from the Edit menu.

Commands The Thermal Application window contains the following commands, all of which can 
also be accessed from the various menus in the application. 

Click on the buttons to view information about them: 

Hot Tip 
By becoming familiar with these commands (Setup, Zero, etc.), you can remove 
these buttons from the Thermal window. This will enlarge the Report area and 
make it easier to view results. To do this, clear the Buttons item in the View 
menu. 

Menus The Thermal Application contains the following menus:  
File, Edit, View, Commands, Setup, Graph, Help

See also: 
Status Display 
Status Line 
Keyboard function keys 
Thermal home page
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results were determined by exporting the data to a spreadsheet program and performing the same 
calculation as that used in the Thermal application.   

Thermal hyperchromicity calculation validation.FBTM

Thermal derivative calculation validation.FBTM

Getting ready for a run—Thermal 
Setup dialog
Setup menu
Cary page
User collect example
Bio-/Chemi-luminescence and Phosphorescence Options dialog
Gate Time for Bio-/Chemi-luminescence
Gate Time for Phosphorescence
How many flashes?
Options page
About smoothing
Accessories page
Multicell/Temperature accessory
Multicell Changer
Automated and Manual Polarization Accessories
Analyze page
Information on van't Hoff calculations
Reports page
Report toolbar
Clear Report
How to use the advanced reporting options
Auto Store page
How to email the results

Use the Setup dialog to set up your instrument and accessories for a Thermal run. You can also use the 
dialog to set up the Analysis, Report and Storage parameters associated with the run. 

The Setup dialog comprises the following tabbed pages:  

Cary
Options
Accessories
Analyze
Reports
Auto Store

Setup—Thermal 

To access the Setup dialog select the Setup button from the Thermal Application window 
or the Setup command from the Setup menu. 
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Use the Setup menu to access the parameters for setting up a Thermal read. 

Example of a User Collect—Thermal 
You can extend the functionality of your Cary Eclipse instrument by using the built-in Read command. 
This command enables you to change the instrument to a different wavelength and take a reading. You 
can combine this command with the mathematical operators: ‘+’, ‘–’, ‘*’ and ‘/’. This is illustrated in the 
example below. 

Read(340, 400)-Read(340, 450) 
This reads the intensity at Excitation monochromator = 340 nm, Emission monochromator = 400 nm and 
subtracts the intensity read at Excitation monochromator = 340 nm and Emission monochromator = 450 
nm . This reading and/or calculation is performed at each temperature. 

The User collect command can be selected on the Cary page of the Setup dialog. Enter the Read 

See also: 
Thermal Application

Setup menu—Thermal 

Command What it does…
Setup Choose Setup to display the Setup dialog where you can set up your instrument for a 

Thermal measurement. The Setup dialog can also be accessed from the Setup command 
button.

Cary Choose Cary to display the Cary page. You can use this page to set up the instrument 
parameters associated with the data collection.

Options Choose Options to display the Options page where you can set up your filters and set 
the detector voltage. You can also use this page to select the way the collected data is 
displayed in the Graphics area, and the type of smoothing applied (if any).

Accessories Choose Accessories to display the Accessories page. You can use this page to set up 
the accessory parameters associated with the data collection.

Analyze Choose Analyze to display the Analyze page where you can select from various 
mathematical equations and set the parameters used to generate the calculation of 
reaction rates.

Reports Choose Reports to display the Reports page. You can use this page to set up the report 
parameters associated with data collection.

Auto Store Choose Auto Store to display the Auto Store page where you can specify if and when 
data will be stored, and in what format.

See also: 
Setup  
Cary  
Options  
Accessories  
Analyze  
Reports  
Auto Store 
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command in the User collect result field.

Dialog controls | Example of the options

Use the Bio-/Chemi-luminescence/Phosphorescence Options dialog to set up the parameters associated 
with these two measurement modes. 

To access the Bio-/Chemi-luminescence/Phosphorescence dialog, select the Options button from the 
Cary page. 

Dialog controls 

The Bio-/Chemi-luminescence/Phosphorescence Options dialog comprises the following options: 

Note: 
User collect can not be used with the Auto Polarizer Accessory. 

See also: 
Cary

Bio-/Chemi-luminescence/Phosphorescence 
Options—Thermal 

Note 
The Options button is only visible on the Cary page if you have selected Bio-/Chemi-
luminescence or Phosphorescence as the Data Mode.

Total decay 
time 

Enter, in seconds, the total decay time for your sample. The total decay time is the time 
that it takes for the phosphorescence signal to decay to dark levels (zero). The lamp will 
not flash again until the total decay time has elapsed. 
The range is 0.001–1800.000 s. 

Note 
This option does not apply to Bio-/Chemi-luminescence mode.

No. of flashes Enter the number of lamp flashes required, which is how many times the lamp flashes 
consecutively before the delay time is counted. 

If you are measuring phosphorescence samples that have a relatively long decay time 
(that is, a number of seconds), you can setup the Cary Eclipse to pulse the lamp multiple 
times, as this will increase the intensity of the phosphorescent signal. For short lived 
phosphorescent samples, multiple flashes will not impact on the intensity of the signal, 
and therefore only one flash is required. 

How many flashes should I perform? 

Note 
This option does not apply to Bio-/Chemi-luminescence mode.
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Example of the Bio-/Chemi-luminescence/Phosphorescence Options 

Understanding Gate Time for Bio-/Chemi-luminescence scans—
Thermal 
Gate Time is set on Options page, which is accessible from the Cary page.

Delay time Enter, in milliseconds, the delay time for your sample. The delay time is the time that 
elapses between the last flash and the beginning of data collection. The default value is 
0.100 ms, which is the time it takes for the lamp intensity to decay to zero. Setting a 
delay time ensures that there is no lamp effects in the phosphorescence decay curve. 
The range is 0.000–5000.000 s. 

Note 
This option does not apply to Bio-/Chemi-luminescence mode.

Gate time Enter, in milliseconds, the gate time for your sample. The gate time is the overall 
reading time of the emission signal. 
The range is from 10µs–10s 

Understanding Average Time and Gate Time for Phosphorescence scans   
Understanding Gate Time for Bio-/Chemi-luminescence scans  

See also: 
Cary page
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The following diagram highlights the Gate Time setting.

The Gate Time is set to 10 and the Intensity is equal to IT.

Understanding Average Time and Gate Time for 
Phosphorescence Scans—Thermal 
For Phosphorescence scans, there is a relationship between Average Time (the time for which data is 
averaged) and Gate Time (the overall reading time of the emission signal).  

Averaging is calculated as follows: 

The data point at each wavelength will be the average of the signals from a number of gate time 
measurements that occur during this averaging time, that is: 
Averaging Time/Gate Time 

These signals are accumulated from successive decay curves so that the actual time taken to generate a 
point at a single wavelength will be approximately: 
(Averaging Time/Gate Time x Total Decay Time)

See also: 
Understanding Average Time and Gate Time for Phosphorescence scans  
Thermal Application   
Cary page  
Options dialog 
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In phosphorescence mode, the Averaging Time ranges from the Gate Time to a maximum of 1000 s.

Average Time is set on the Cary page of the Setup dialog. Gate Time is set on Options page, which is 
accessible from the Cary page. 

The following diagrams highlight the relationship between Average Time and Gate Time. 

Example 1 

When the Average Time and Gate Time are set to the same value: 

where: 

Note: 
Gate Time is not used if you select Fluorescence as the Data Mode. 

Average Time/Gate Time 1

Intensity
1 (Area IA,
IB)

Total Decay Time 20 ms
Delay Time 10 ms
Cycle Time 1 sec
Stop Time 3 sec
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Example 2 

When the Average Time is set to five times the Gate Time: 

Average Time 5 ms
Gate Time 5 ms

Average Time/Gate Time 5
Intensity (Area I2) A1 + A2 + A3 + A4 + 

A5
__________________ 

        5 

Page 10 of 130Thermal Home Page

 



where: 

Total Decay Time 20 ms
Delay Time 10 ms
Cycle Time 1 sec
Stop Time 3 sec
Average Time 25 ms
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How many flashes should I perform?—Thermal 
The Number of Flashes option is set in the Bio-/Chemi-luminescence/Phosphorescence Options 
dialog. To access the dialog, select the Options button from the Cary tab page. 

If you are measuring phosphorescence samples that have a relatively long decay time you can setup the 
Cary Eclipse to pulse the lamp multiple times, as this will increase the intensity of the phosphorescent 
signal (refer to Example 1, below).  

Example 1 
The above example shows that the sample does not decay before the instrument lamp flashes again. 
Therefore setting multiple flashes will result in an increase in the intensity of the signal. 

For short lived phosphorescent samples, multiple flashes will not impact on the intensity of the signal, 
and therefore only one flash is required (refer to Example 2, below).

Gate Time 5 ms

See also: 
Understanding Gate Time for Bio-/Chemi-luminescence scans  
Thermal Application  
Cary page 
Options dialog 

Note 
The Options button is only visible on the Cary page if you have selected Bio-/Chemi-
luminescence or Phosphorescence as the Data mode.
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Example 2 
The above example shows that the sample decays in less time than the time it takes the instrument to 
flash the lamp again. Therefore, setting more than 1 flash, in the No. of Flashes field will not increase the 
intensity of the signal. 

Display Options | Smoothing | Excitation Filter | Emission Filter | PMT Detector Voltage | Status Display 

Use the Options page to set up your filters and set the detector voltage. You can also use this page to 
select the way the collected data is displayed in the Graphics area, and the type of smoothing applied (if 
any). 

From the Setup menu, select Options to access the Options page. You can also access the page from the 
Setup dialog by selecting the Options tab. To access the Setup dialog, select the Setup button from the 
Thermal Application window. 

See also:   
Bio-/Chemi-luminescence/Phosphorescence Options

Options—Thermal 

Display 
Options 

Overlay traces 
Select this option to superimpose the collected data of each sample in the run in one 
graph box. If you select this option, a graph box is created at the start of the collect in 
the Graphics area and each sample’s data is overlaid in that box as the data is collected. 
Clear this option to display all of the traces in individual graphs. 

Y minimum/Y maximum 
Enter the minimum and maximum Y values to be displayed on the graph axis. The 
software will update the Y axes to reflect these settings during the thermal run. 

Smoothing Select Smoothing to reduce the noise of your collected data. When you select this 
option, smoothing will be applied to the intensity signal using the algorithms defined 
below. You can select one of the three types of smoothing that can be performed during 
a run. Only the smoothed trace is displayed during data collection, however the 
unsmoothed data is also saved with the experiment. 

Type 
Savitzky-Golay 
This algorithm will take the number of Filter points, apply the Savitzky and Golay 
smoothing algorithm  and display the smoothed value at the middle X-point of the filter.
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The naming of the smoothed trace will be 'Sample name_SG'. 

Tell me more about Savitzky-Golay smoothing 

Boxcar average 
This algorithm will take the number of points as defined by the Filter size, and average 
these, displaying the average at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_Box'. 

Tell me more about Boxcar averaging 

Moving average 
This algorithm will take the number of points as defined by the Filter size, and average 
these, displaying the average at the middle X-point of the filter. 
The naming of the smoothed trace will be 'Sample name_Mov'. 

Tell me more about Moving average 

Filter size 
Enter the Filter size, which determines the number of points that will be used in the 
smoothing procedures. The higher the filter size (and thus the number of points used), 
the greater the amount of smoothing that will be performed.  

Filter sizes must be odd values. For Boxcar and Moving averages, the range is 3–101. 
For Savitzky-Golay smoothing, the range is 5–101.  

Excitation 
filter 

Set the excitation filter for the Thermal measurement. To do this, select the down arrow 
to the right of the field and select an option from the list. 

A range of filter settings are available: 

Auto 
If you select the Auto option, the filter wheel will be automatically moved to the 
appropriate position for the selected excitation wavelength. It is recommended that you 
set the filter to Auto (which is the default setting).  

Open 
If you select Open no filter is used. 

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 

250–395, 335–620, 550–1110, 695–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you can 
select your filter manually. Otherwise it is recommended that you set the filter to Auto. 

Emission 
filter 

Set the emission filter for the Thermal measurement. To do this, select the down arrow 
to the right of the field and select an option from the list. 

A range of filter settings are available: 

Auto 
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About Smoothing—Thermal 

If you select the Auto option, the filter wheel will be automatically moved to the 
appropriate position for the selected emission wavelength. It is recommended that you 
set the filter to Auto (which is the default setting).  

Open 
If you select Open no filter is used. 

Closed 
If you select Closed, a blank filter is used to prevent light from getting through. 

250–395, 295–1110, 360–1110, 430–1110, 550–1110 
If you are looking at a wavelength range that is within one of these filter ranges, you can 
select your filter manually. Otherwise it is recommended that you set the filter to Auto. 

3%T Attenuator 
Select 3%T Attenuator to decrease the fluorescence intensity and thus the amount of 
light going to the emission PMT. This setting is useful for highly fluorescent samples 
when you are using wide slits. 

PMT Detector 
Voltage 

Set the sample PMT high voltage. To do this, select one of the following: 

Low 
Sets the PMT Detector voltage to a pre-defined value of 400 v. Typically you would 
select this setting if you are reading highly emitting samples. 

Medium 
Sets the PMT Detector voltage to a pre-defined value of 600 v. Typically you would 
select this setting if you are reading moderately emitting samples. 

High 
Sets the PMT Detector voltage to a pre-defined value of 800 v. Typically you would 
select this setting if you are reading low emitting samples. 

Manual 
Enables you to enter any PMT voltage in the adjacent Volts field. 

Volts 
Enter the PMT voltage in the adjacent field. Note that this option is only available if you 
have selected Manual as the PMT Detector voltage. 

Tip 
Increasing or decreasing the PMT Detector Voltage by 10% will approximately 
double or halve the fluorescence intensity observed.

Status Display Select this check box to display the Status Display window. This window allows you to 
view the status of various parameters during the data collection.

See also: 
Setup 
Status Display window
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Savitzky-Golay | Boxcar average | Moving average

Savitzky-Golay 

Savitzky-Golay smoothing is used to obtain good noise reduction with sharp peaks. The equation 
constants are specific to Filter Size. The constants for each filter size are published in the Savitzky-Golay 
paper (A. Savitzky, M.J.E. Golay, Anal. Chem., 36 (1964) 1627). The equation also requires that Filter 
Sizes entered must be odd values, between 5 and 101. 

Example 

Result 

The first smoothed data point will be: 
(x3, (Y1*a1+Y2*a2+Y3*a3+Y4*a4+y5*a5)/b), 

the next: 
(x4, (y2*a1+y3*a2+y4*a3+y5*a4+y6*a5)/b) …  
(xn-2, sum(yn-4*a1+yn-3*a2+yn-2*a3+yn-1*a4+yn*a5)/b), 

where a1..a5, b are constants defined by Savitzky and Golay. 

Each smoothed point is calculated using the previous and next data points. For this reason, calculations 
cannot be performed on the very first and very last data points in a data set. Hence, smoothed traces will 
lack the first and last X values of the original trace. 

Boxcar average 

Boxcar averaging can be used when the change in intensity is minimal.

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size 5
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Example 

Result 

The first smoothed data point will be: 
(x3, sum(Y1:y5)/5), 

the next: 
(x8, sum(y6:y10)/5) … (xn-2, sum(yn-4:yn)/5). 

If there are not enough points at the end of the data set to complete the filter size, then these points will be 
ignored, hence, the gap at the end may be larger than the gap in the beginning. 

Moving average 

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size 5
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Example 

Result 

The first smoothed data point will be: 
(x3, sum(Y1:y5)/5), 

the next: 
(x4, sum(y2:y6)/5) … (xn-2, sum(yn-4:yn)/5). 

Use the Accessories page to set up the accessory parameters associated with the data collection. 

From the Setup menu, select Accessories to access the Accessories page. You can also access the page 
from the Setup dialog by selecting the Accessories tab. To access the Setup dialog, select the Setup 
button from the Thermal Application window. 

The Accessories page will vary, depending upon two things. Firstly which radio button is selected in the 
Collect Temperatures group box, eg. Ramps, Go to or Thermal Cycles and will also vary depending on 
which accessory is selected on the Accessory tab. 

Data (x1, y1), (x2, y2), (x3, y3) … (xn,yn)
Filter size 5

Accessories—Thermal 
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Multicell/Temperature
Manual and Automated Polarizer Accessories

The Multicell and Temperature accessory page is displayed when you select the Multicell/Temperature 
tab on the Accessories page. 

The page comprises the following: 

Multicell Holder 

Select this option to use the Multicell Holder and cells with the Cary Eclipse.  

Note
If the Ramps or Thermal Cycle mode is selected on the Cary tab, the precise thermal requirements
when ramping at a fixed rate require that the Peltier Multicell Holder Accessory be used with the
Temperature Controller Accessory. No other thermal accessories may be used in these two modes.

See also: 
Cary page

Multicell and Temperature accessories—Thermal 

 
Note 
If you select the Ramps or Thermal Cycles radio button on the Cary tab you can only use the 
Peltier 4 Position Multicell Holder Accessory. If you select the Go To radio button you can use any 
of the thermostatted Eclipse accessories.

Multi-zero If you select Multi-zero, a Multi-zero will be performed when the Zero button is 
selected in the Thermal Application window. Because cuvettes can have different 
intensities, and samples vary, this field is used when you require all blank readings to 
consistently start at zero intensity. 

A reading will be taken at the set Averaging Time at the set Ex. and Em. wavelengths 
and at every selected cell position. These readings will be offset to zero and subsequent 
readings will have the corresponding offset value subtracted from each cell. 

Reset Select Reset to drive the Multicell Holder to cell position 1, which is its fully retracted 
or zero position. 

Go to cell… Select Go to cell to open the Multicell Changer dialog. You can use this dialog to 
manually move the Multicell Holder accessory to a new cell. To do this, simply select 
the corresponding button of the cell you require in the Multi Cell Changer dialog. The 
Multicell Holder will move the selected cell to the measurement position in the sample 
compartment. 

The Multicell Changer dialog is ‘modeless’ which means that it can remain open even 

Note 
The Multicell Holder checkbox must be unchecked to use the Go to cell option.

Page 19 of 130Thermal Home Page

 



Temperature Control 

Select this option to use the Temperature Controller with the Cary Eclipse. 

once you have cleared the Setup dialog. This enables you to use the Rapid Read 
command to perform a reading at the cell specified in the Cell Changer. 

If you move to a new cell after you have performed a Multi-zero thermal, the Cary 
Eclipse will display the intensity reading corrected by the determined zero-offset amount 
for that cell. 

 
Note 
You can use this option to check the intensity of a cell or start a thermal run at a 
particular cell.

 
Note 
When the Thermal application is opened the Multicell peltier and Temperature controller are 
selected by default.

 
Note 
The Temperature Control option does not control temperature accessories that are not listed in the 
Device field. For example, if you have selected the Temperature Control option and set the Device
to None because you have a different temperature control accessory, the Cary Eclipse software will 
not control that accessory. However, it will monitor the temperature and prompt the software to start 
when the accessory reaches the temperature listed in the Temperature field.

Device Select the device that will be used to control the solution temperature. If the device 
options are not available ensure that Go To is selected on the Cary tab. 

The options available will depend upon whether or not you have selected the Multicell 
holder option or the Single Cell holder option. 

None 
Select this option if you are using a Temperature Control device not listed in this field 
(for example, a third party water bath). Note that the Cary Eclipse software will not 
control the accessory. The software will simply monitor the temperature and prompt the 
software to start when the accessory reaches the temperature listed in the Temperature 
field. 

PCB 150 Water Bath 

If you have selected the Multicell holder, 
the following Device options will be 
available for selection: 

Temperature controller
PCB 150 water bath
None

If you have selected the Single Cell holder, 
the following Device options will be 
available for selection: 

Single cell peltier
PCB 150 Water bath
None
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Temperature Display 

Select this option to view Temperature Display information in the Status Display window. 
The Temperature Display option is only available if you have selected the Temperature Control option. 

Status Display 

Select this check box to display the Status Display window. Use this window to view the status of 
various parameters during the data collection. 

Use the Multi Cell Changer dialog to manually move the Multicell Holder accessory to a new cell 
position. To access the Multi Cell Changer dialog, select the Go to cell button from the 
Multicell/Temperature Accessories page. 

The dialog comprises the following: 

Select this option if you are using the PCB 150 water bath. 

Single cell peltier 
Select this option if you are using the Single cell peltier. 

Temperature controller 
Select this option if you are using the Temperature controller. 

Port  Select from COM1, COM2, COM3 or COM4. 
This option is not available if you have selected None as the Device.

Monitor Select which device will be used to monitor the measurement temperature. Select from 
Block, Probe 1, Probe 2, Probe 3 or Probe 4. 
Note that the the options in this field may change depending on the Device selected.

Block/ 
PCB 150 

Select this option to view the temperature of the Block (if you have selected the Single 
Cell Peltier device) or the PCB 150 (if you have selected the PCB 150 Water Bath) in 
the Status Display window.

Probes Select one or more of these options to view the temperature of the Probes in the Status 
Display window.

See also: 
Accessories  
Multi Cell Changer 
Status Display

Multi Cell Changer—Thermal 

Note 
The Go to cell button is only available when the Multicell Holder checkbox is unchecked.

Multicell 
changer 

To manually move the Multicell Holder accessory to a new cell, simply select the 
corresponding  button of the cell you require in the Multi Cell Changer dialog. The 
Multicell Holder will move the selected cell to the measurement position in the sample 
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Polarizer accessory—Thermal 
Two types of polarizer accessories are available for the Cary Eclipse: (1) the Manual Polarizer Accessory 
and (2) the Automated Polarizer Accessory, either can be used with the Multicell Accessory. Click on the 
links above for installation instructions for these accessories. 

The Polarizer accessory page is displayed when you select the Polarizer tab on the Accessories page 
after you have selected "Go To" on the Cary tab. If you are using the manual or automatic polarizer 
accessories, this page enables you to setup the polarizers. 

The Manual and Automatic Polarizer accessories enable you to monitor the change in polarization of the 
fluorescence from a compound over a range of temperatures. 

Polarizer 

Select this option to use the Polarizer with the Cary Eclipse. 

compartment. 

The Multi Cell Changer dialog is ‘modeless’ which means that it can remain open even 
once you have cleared the Setup dialog. This enables you to use the Rapid Read 
command to perform a reading at the cell specified in the Cell Changer. 

If you move to a new cell after you have performed a Multi-zero scan, the Cary Eclipse 
will display the intensity reading corrected by the determined zero-offset amount for that 
cell. 

Note 
You can use this option to check the intensity at a cell position or perform a 
reading at a particular cell.

Note 
You can use the Multi Cell Changer with the automatic and manual polarizer 
accessories.

See also: 
Multicell/Temperature Accessories  
Rapid Read

Q. Why is the Polarization option unavailable?

A. The User Collect option has been selected on the Cary page. The Polarizer accessory can be
used for both single and mulitwavelength measurements but is not available for User collect
measurements.

A. The Ramps or Thermal Cycles option has been selected on the Cary page. You cannot use the
Polarizer accessory if you are using either of these temperature ramping options. You must select
"Go To" on the Cary Page.

Measurement Select from the following measurement types: Polarization or Anisotropy.
G Factor The G Factor is a value that reflects the polarization bias of the emission 

monochromator. It is dependant upon the emission wavelength. If you do not select the 
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Status Display 

Select this check box to display the Status Display window. Use this window to view the status of various 
parameters during the data collection. 

Derivative | Hyperchromicity | Post-Run Smoothing | Show Status Display 

The Analyze tab enables you to select the calculation used to estimate the thermal melting temperature 
(ie, the temperature at which the strands in the DNA separate (Tm)). 

Two methods are available to calculate Tm:  

The Derivative Method
The Hyperchromicity Method

None 

When this is selected, noTm calculations will be performed. 

Derivative 

The Derivative method calculates and plots the first derivative of the selected thermal. 

The point at which the derivative plot peaks, (i.e. maximum absolute gradient on the original plot), is 
reported as the Tm value, and the original plot will be marked with an arrow to indicate this point. 

G Factor option, then a G-factor value must be collected. If you do select the G Factor 
option then the value entered is used at the emission wavelength in subsequent 
polarization or anisotropy calculations. 
If Multiwavelength is selected on the Cary tab then G Factors must be measured at all 
emission wavelengths; the manual entry G Factor field is not available. 

Determining the G Factor 

On exiting the Setup dialog a G Factor validity test is performed.  If the G Factor is not 
valid, the following prompt is displayed:  
‘The current G Factor is not valid at the emission wavelength. Press the G Factor button 
to determine a new grating factor.’ 
Select OK to clear this dialog and select the G Factor button from the Thermal 
Application window. 

See also: 
Manual Polarizer accessory  
Automated Polarizer accessory 
Accessories page

Analyze—Thermal 

Note 
There are situations, where there are multiple transitions within a single run, resulting in more than 
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When you select Derivative the following options are available: 

Hyperchromicity 

The Hyperchromicity option enables you to calculate multiple parameters using hyperchromicity 
calculations. 

When you select Hyperchromicity the following options are available:

one peak. Thus multiple calculations are made.

Autocalculate Select this option to enable the system to collect data and automatically perform a 
derivative calculation at the end of each run. Otherwise you can perform the 
calculation manually, once the run is completed.

Interval A derivative calculation involves the selection of points from a plot, from which a 
derivative calculation is performed. Selection of these points is dependent upon the 
Interval chosen. Also, the Savitzky-Golay method can only be used if the data points 
are equidistant, i.e. the same X distance from each other. In cases where data is not 
equidistant the Interval is used to create an equidistant data set prior to performing the 
Savitzky-Golay calculation. 

Example: 
If a data interval of ‘1’ is chosen, then data will be taken every 1 °C over the entire 
range of the continuum. 

The selected data points are then used to generate a separate continuum on which a 
derivative calculation is performed. 

The selection of the Derivative Interval is dependent on the rate of data collection. If 
data is collected every 0.1 °C then a Derivative Interval of 0.1 °C will give the most 
accurate result. A Derivative Interval of a less value than 0.1 °C will be no more 
accurate and will produce the same result. 

Filter Size This sets the derivative Filter Size. 

The derivative calculation uses a Savitzky-Golay smoothing technique where a 
number of points surrounding an individual point are averaged to produce a new, 
derivative point. The Filter Size will be automatically adjusted so that it is a multiple 
of the total number of data points  

Note 
The larger the Filter Size, the more data points that are included in the filter for 
the derivative calculation.

Low/High 
Calculation 
Limits 

Low and High Calculation Limits are used to define the range over which a derivative 
calculation is performed. The selection of these limits is only applicable when 
performing a derivative calculation using Autocalculate. 

Q. Why are the Derivative group options grayed out?
A. Select the Derivative radio button to activate these.
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Post-Run Smoothing  

Signal noise from biological material will cause interference and noise within the system. Smoothing, 
applied to the absorbance value, gives the ability to smooth a data curve. This is achieved with the use of 
a Savitzky-Golay smoothing filter. 

When you select Smoothing the following options are available: 

Vant Hoff 
Calculation 

Select this option to calculate a Vant Hoff curve and activate the Hyperchromicity 
group.

Self 
Complementary 

Select this option to generate a Self complementary sequence.

Non Self 
complementary 

Select this option to generate a Non-self complementary sequence

Total Conc of 
Strands (µM) 

Specify the total concentration of DNA strands by entering a number in the numeric 
field (µM units).

Molecularity Specify the Molecularity (the number of DNA strands) by selecting a number from 
the drop-down list. The range is 1–3, for example when using double stranded DNA 
the molecularity would be 2.

Delta G 
Calculations 

Select this checkbox to perform Delta G (ΔG) and K  calculations and access the 
temperature parameters for these calculations.

Number of 
Temperatures 

Enter the required number of temperatures at which you want to calculate ΔG. The 
number of rows that appear in the Temperatures table will depend on the number 
set.

Temperatures 
table 

This table enables you to enter the temperatures at which you want to calculate ΔG. 

Stage 
This lists each temperature number. 

°C 
Enter the required temperatures in these numeric fields. 

Interval Selection of a smoothing interval is independent of the data collection interval. Data 
can be collected at one rate and smoothed at another. For example, data collection can 
be performed every half of a degree, however smoothing can be applied every two 
degrees. 

Type the number in this numeric field to select the smoothing interval. The larger the 
number the smoother the data will become, but you will start to lose detail as you 
increase the interval. 

Filter Size Set the filter size by entering a value in the numeric field. 

The smoothing algorithm uses a Savitzky-Golay smoothing technique where a number 
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Show Status Display 

Select this checkbox to display the Status Display window. This window allows you to view the status of 
your Thermal run during the data collection 

More information on van't Hoff Calculations 
Tm value from alpha curve °C and K
K at various temperatures from alpha curve
Delta S (ΔS) and Delta H (ΔH) from van't Hoff plot
Delta G (ΔG) and K
K (Tm) calculations

Calculating theTm value from alpha curve °C and K 

The Cary firstly converts the intensity versus temperature data to a form that expresses the fraction of 
hybridized strands remaining as a function of temperature. 

By specifying the lower and upper limits of the linear region of the Associated DNA part of the curve, a 
linear least squares line is calculated and is extrapolated to both ends of the melting curve. 

Similarly by specifying the lower and upper limits of the linear region of the Dissociated DNA part of the 
curve, a linear least squares line is calculated and is extrapolated to both ends of the melting curve. 

If x is the distance from the curve to the upper line and y is the distance from the lower line to the curve, 
then: 

alpha(T) = x/(x+y) 

where alpha is the fraction of strands remaining hybridized at a given temperature. 

From the displayed alpha curve you are able to select the region which will be used to calculate the Tm 
value. 

A linear least squares line is drawn between the selected points and the value of temperature, where a = 
0.5, is calculated to give the Tm value. 

of points surrounding an individual point are averaged to produce a new, smoothed 
point. 

Note 
The larger the filter size, the more data points that are included in the filter for 
smoothing. 

See also: 
Savitzky-Golay 
Example of Thermal trace with derivative 
More Information on van't Hoff calculations 
How to perform Derivative calculations from previously stored data 
How to perform Hyperchromicity calculations from previously stored data
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The Tm value is automatically reported in °C and K.

K at various temperatures from alpha curve  

To calculate the equilibrium constants as a function of temperature, K(t), you must know the values of a 
(alpha). This can be calculated according to either of the following equations: 

Self complementary sequence
Non-self complementary sequence

You will be required to specify: 

Molecularity (i.e. the number of strands) of the hybrid
Total concentration of strands.

Self complementary sequence 
The general equilibrium equation shown below indicates how self complementary sequences form n-mer 
structures: 

nA « A(n) 

In this type of situation the following formula is used to calculate the equilibrium constant: 

where: 

a(T) = the fraction of strands remaining hybridized at a given temperature  
n = the molecularity  
Ct = total concentration of strands 

Non-self complementary sequence 
The general equilibrium equation shown below indicates how non-self complementary sequences form n-
mer structures: 

In this type of situation the following formula is used to calculate the equilibrium constant: 

where: 

a(T)  = the fraction of strands remaining hybridized at a given temperature 

             a(T) 
K
(T) = ------------------------

 (n*Ct(n-1)) * (1–a(T))n

A(1) + A(2) + A(3) + ....... + A(n) « A(1)A(2)A(3)...A(n)

 a(T) 
K(T)= ------------------------------------------

    (Ct/n)(n-1) * (1–a(T))n
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n = the molecularity  
Ct = total concentration of strands 

Delta S (ΔS) and Delta H (ΔH) from van't Hoff plot 
The parameters chosen are used to calculate a van't Hoff plot (i.e. Ln(K(T)) vs 1000/T(K)). 

By selecting a lower and upper region of the calculated plot, a linear least squares line is calculated and 
extrapolated to both ends of the van't Hoff plot. 

The slope and intercept of the calculated line gives the enthalpy and entropy of the hybrid formation (ΔH° 
and ΔS°, respectively) according to the following equations: 

slope = –ΔH°/R 

intercept = ΔS°/R 

where R is the gas constant = 1.986 calories/mole.K 

Delta G (ΔG) and K at various temperatures 
If selected, this enables you to choose the various temperatures (in °C) at which ΔG (free energy) and K 
(equilibrium constant) are calculated. 

ΔG = ΔH – T (ΔS)  

K(T) = e(ΔG / –RT)

where: 

ΔH = the enthalpy of the hybrid formation  
ΔS = the entropy of the hybrid formation  
T = temperature 
R = the gas constant (1.986 calories/mole K) 

Enter the required Number of Temperatures at which you want to calculate ΔG and K. 

Fill in the required temperatures in the numeric fields. 

K (Tm) calculations  

The calculated alpha curve is used to report the following parameters: 

K(Tm) experimental 
K(Tm) from first principles 
K(Tm) experimental/K(Tm) from first principles.

Note 
ΔH° is reported in Kcal/mol and KJ/mol units. ΔS° is reported in cal/mol/K and as J/mol/K units.
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where the calculation of K(Tm) from first principles, is dependent on the type of sequence being 
analyzed. 

K(Tm), from first principles, is calculated using one of the following equations. 

Self complementary sequences 

Non-self complementary sequences 

Operator | Options | X-Y Pairs Table | Status Display 

Use the Reports page to set up the report parameters associated with data collection. 

From the Setup menu, select Reports to access the Reports page. You can also access the page from the 
Setup dialog by selecting the Reports tab. To access the Setup dialog, select the Setup button from the 
Thermal Application window. 

The page comprises the following: 

Operator 

Options 

1 
K
(T) = ------------------------

      n*(Ct/2n) (n-1)

              1
K
(T) = ------------------------

       (Ct/2n) (n-1)

Reports—Thermal 

Hot Tip 
You can view your generated report before you print it out using the Print Preview command in 
the File menu 

If you decide to make changes to the report layout, select  (Edit Report) from the Report 
toolbar. This enables you to directly edit the report.

Name Enter the instrument operator name in this text entry field. Use the arrow to the right of 
this field to view and select one of the last ten entries in this field. 

Note 
In GLP mode the system will automatically enter the operator’s name and this 
field will not be editable.

Comment Enter operator details and comments in this text entry field.
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This group enables you to select the information to include in your report.

X-Y Pairs Table

Select this if you want to print a table showing the X-Y pairs of the collected data in your report. 

Auto Print Select Auto Print to print a report automatically during the data collection. 
If Auto Print is selected, then the system will send the report information to the 
specified printer(s) as well as the Report area. However if Auto Print is not selected, 
the report will only be sent to the Report area and can be viewed by selecting Report in 
the View menu. 

To automatically obtain a copy of the graphics, you will need to select both the Auto 
Print and Graph options (see below). In this case, all graphical information displayed 
on screen will be printed with the report. Therefore it is advisable to arrange the 
graphical information as you require on screen, prior to printing.  
For example, if you require a single graph print out, then the Single/Multi Graph 
option in the Graph menu should be changed to the correct setting. 

Parameters Select this option to include the method setup parameters within your report.

User data 
form 

Select this option to include in the report any information entered in the User Data 
Form.

Graph Select Graph to include any graphs or graphic information associated with your report. 

If you require a printout of the displayed graphics only, you must ensure that only this 
option is selected. Select the Clear Report button to clear any information in the 
Report area before you print otherwise this will be included in your printout. 
% Page Height 
Enter the size at which you want the graph to be printed, as a percentage of total page 
height. For example, if you want graphical information to take up half of the page, enter 
50% in this field.

Company 
Logo 

Check this option to include your company logo in the report. 
A company logo will only be included if you have added one on the Company page of 
the System Information Application. 

Hot Tip 
If you have not included a Company logo, select the Header/Footer button to 
open the System Information Application and use the Add Logo option to add a 
logo.

Header/ 
Footer 

Select the Header/Footer button to open the System Information application where 
you can enter the Header and Footer information to be included in your report. You can 
also enter any additional comments, and add a logo to your report. Once you have made 
all your changes, select OK to exit the System Information application and return to the 
Reports page of the Thermal application.

Focused 
trace 

Select this option to apply the Report selections to the focused trace only.

All traces Select this option to apply the Report selections to all visible traces.
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Status Display 

Select this check box to display the Status Display window, where you can view the status of your 
thermal run during the data collection. 

Report Toolbar—Thermal 
Use the Report toolbar buttons to gain quick access to many of the Edit menu options. You can also use 
the toolbar to cut, copy and paste information and to change the look of your report. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Reports. To 
display or hide the toolbar's text labels, point to the Toolbar option in the View menu and select Text 
Labels. 

The following commands can be accessed from the Reports Toolbar: 

Data Interval Actual 
Select Actual to report the X-Y pairs table for the trace at the actual Data Interval at 
which the data was collected. 

Interpolated 
Select Interpolated to report the X-Y pairs table for the trace at an interpolated data 
interval. Enter this data interval in the adjacent field. If no data has been collected at the 
interval you enter, the Cary Eclipse software will interpolate the data to produce an X-Y 
result. 

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, 
Microsoft Word or Microsoft Excel) into the report area of the of the Thermal application. To edit 
these objects, simply double click on them to open the associated application in which they were 
created.

See also: 
User Data Form 
View menu  
Status Display window

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Edit Report Click this button to edit the report. 
This command is also accessible by pressing CTRL+R.

Undo If available, this undoes the last action. 
This command is also accessible by pressing CTRL+Z.

Cut Click this button to remove the highlighted text and place it on the Windows 
Clipboard. 
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Clear Report—Thermal 
Select the Clear Report command to remove the contents of the Report Area in the Thermal Application 
window. If you have saved the report, selecting this option does not delete the contents of the report, the 
information is simply removed from the Report Area. 

How to use advanced reporting options—Thermal 
This outlines ways to fully customize your reports. Options available include:  

Including header and footer information
Including a logo
Editing the text in the report
Viewing the report on screen before printing
Cutting and pasting to a word processor

Including header and footer information 

You can have text appearing at the top and bottom of every page in your report. To specify what the text 
should be, do the following:  

This command is also accessible by pressing CTRL+X.
Copy Click this button to copy the highlighted text onto the Windows Clipboard. 

This command is also accessible by pressing CTRL+C.
Paste Click this button to insert the contents of the Windows Clipboard (text only) at 

the cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Click this button to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
This option is only available once you select Edit Report and there is text 
highlighted in the Report area. 

Font Click this button to change the font of new or selected text in the report. For 
existing text, simply highlight the text in the report, select this button and make 
your changes in the Font dialog. When you select OK, the appearance of the 
highlighted text in the report will alter to reflect your font changes. 
This command is also accessible by pressing CTRL+F.

Preview Click this button to display the Print Preview dialog where you can view the 
current report as it will be printed.

To access the Clear Report option, select the Clear Report command from the 
Commands menu, or select the Clear Report button from the Thermal Application 
window. 

See also: 
Thermal Application 
Commands menu
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Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then 
select System Information. The System Information application appears with the Company page 
displayed. 

Step 2 

Enter the header and footer information in the Header and Footer fields. 

Step 3 

Click OK to implement your changes. 

Including a logo 

You can include a logo on the first page of your report. To specify what the logo should be, do the 
following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then 
select System Information. The System Information application appears with the Company page 
displayed. 

Step 2 

Enter a logo using the Add Logo button. This logo will always be included on the front page of reports. 

Step 3 

Click OK to implement your changes. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can 
then add, delete and change text in the Report area. 

Viewing the report on the screen before printing 

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application so as to comply
with GLP regulations.

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The
Administrator of the system will have to change your privileges before you can edit reports.
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You can view a report before printing it. To do this, from the File menu select Print Preview. You can 
then ensure that the report format is correct before you print it. 

Cutting and pasting to a word processor 

To have complete control over how your report looks you may wish to copy it to a word processor 
program, such as Microsoft Word. To do this: 

Step 1 

Open a report. 

Step 2 

From the Edit menu, choose Edit Report. 

Step 3 

Click in the Report area and highlight the text you want to export to your word processor. 

Step 4 

Right-click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text 
into a document. 

Storage | Auto convert | Email | Status display 

Use the Auto Store page to specify if and when data will be stored, and in what format. You can also use 
this page to set up the system to automatically send an email at the end of a read. 

From the Setup menu, select Auto store to access the Auto store page. You can also access the page 
from the Setup dialog by selecting the Auto store tab. To access the Setup dialog, select the Setup 
button from the Thermal Application window. 

The page comprises the following: 

Storage 

Hot Tip 
Use the arrow keys at the bottom of the Print Preview screen to change pages.

Auto Store—Thermal 

Off Select this if you do not wish to be automatically prompted to save collected data. 
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Auto convert 

Use the Auto convert options to convert your data into an ASCII file format that can be opened in 
spreadsheet programs such as Microsoft Excel. 

Email 

Select the Email check box and enter the Email details to send an email to yourself or a colleague once 
the read is completed. This useful facility can be used to alert you to the completion of the read, 
particularly if you are working away from the laboratory where the Cary Eclipse instrument is located. 
You can also attach the newly collected data to the email.

Note 
If you wish to store your unsaved data manually, choose Save Data As… from the 
File Menu to save your data after the run is complete. You can save your data as a 
Batch or Data file.

On; Prompt 
At Start 

Select this to display the Windows Save As dialog at the start of the collect where you 
can enter the Batch filename for your data.

On; Prompt 
At End 

Select this to display the Windows Save As dialog at the end of a collect where you can 
enter the Batch filename for your data.

None Select None if you do not need to generate an ASCII file.
ASCII (csv) Select this option to save the data as a comma delimited ASCII Spreadsheet file (*.CSV) 

file. Only the currently collected data is converted. 

ASCII files are stored in the same folder as the data file from which they were generated 
and designated the same filename as the method used to collect the data plus the 
extension ‘CSV’. 

ASCII (csv) 
with log 

Select this option to save the data as a comma delimited ASCII Spreadsheet file (*.CSV) 
file. Only the currently collected data is converted. The key method parameters used to 
collect the data are also saved in this file. 

ASCII files are stored in the same folder as the data file from which they were generated 
and designated the same filename as the method used to collect the data plus the 
extension ‘CSV’. 

Note 
If you choose to auto-convert the data to an ASCII file but you have set the 
Storage option to Off, then the ASCII file will be saved with the following format:
DATE TIME. CSV 

The date and time will appear in the same form that is set in the Windows 
Regional Settings Properties dialog that is accessed from the Windows Control 
Panel. 

For example, 22_4_97 1;32;08.CSV 
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Status display 

Select this check box to display the Status Display window, where you can view the status of your 
thermal run during the data collection. 

How to email your results—Thermal 
You may wish to send an email to a person once the read is completed. This useful facility can be used to 
alert you to the completion of the read, particularly if you are working away from the laboratory where 
the Cary Eclipse instrument is. 

To do this: 

Step 1 

Ensure that you have set up the Host and Port options on the Email options page of the System 
Information application in order for the email facility to work correctly. 

Step 2 

From the Setup menu, select Auto Store. The Auto Store page is displayed. 

Step 3 

Select the Email check box to enable the email options.

Note 
You must set up the email Host and Port options on the Email options page of the System 
Information application in order for the email facility to work correctly.

To Enter the recipient's email address. You can enter more than one recipient in this field.
From Enter your email address (or the email address associated with the computer on which 

the Cary Eclipse software is installed.
Subject Enter the subject of your email (or leave this field blank if you do not wish to include a 

subject).
Cc Enter the email address of any recipient you want to copy the email to.
Message Enter your message.
Attached… Use the Attached button include a file attachment in your email. To do this, select 

Attached and browse your computer to select a file, using the Windows® Open dialog 
that appears.

Attach 
current data 

Select this option to attach the data that has been collected during the run to the email.

How to email your results 

See also: 
Thermal Application window   
Save As dialog   
Status Display window 
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Step 4 

In the To field, enter the recipient's email address (for example, rchandler@varianinc.com). To enter 
multiple recipients, simply type a comma ',' between each email address. 

Step 5 

In the From field, enter the email address of the computer on which the Cary Eclipse software is 
installed. This may be your email address, or a communal email address, if the Cary Eclipse software is 
installed on a computer that has multiple users. 

Step 6 

Enter information in the Subject and Message fields as required. 

Step 7 

Select Attach current data. The data that has been collected during the run will be attached to the email.

Step 8 

Select OK to clear the Auto Store dialog. Your email will be sent once the run has been completed. 

Performing runs—Thermal 
Starting a run
Accessory selection
Sample Name dialog
Cell Loading Guide
Sync Start dialog
Start/Stop buttons
Go To dialog
Go To Temperature dialog
Rapid Result dialog
Commands menu
How to perform a run and determine Tm using Derivative calculations
How to perform a run and determine Tm using Hyperchromicity calculations

Information about starting a run—Thermal 
The sequence that occurs when you select Start to commence the thermal run depends upon your storage 

Hot Tip 
You can attach other documents to your email. To do this, select the Attached button and browse 
your computer to select a file, using the Windows® Open dialog that is displayed.

See also: 
Auto Store 
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and accessory selections. 

Storage selections 

Accessory selections 

If you have selected … as the 
Storage option on the Auto Store 
page

The following occurs

On, prompt at start The Windows Save As dialog will appear as soon as you select 
Start. You can save the current method, collected data, report and 
graph template as a Batch file.

On, prompt at end The Windows Save As dialog will appear at the end of the data 
collection. You can save the current method, collected data, report 
and graph template as a Batch file.

Off The Windows Save As dialog will not appear.

If you have selected … on the 
Accessories page

The following dialog is displayed

No accessories The Sample Name dialog will appear when you select Start, 
prompting you to load the sample and enter your sample name. 
Select OK to display the Sync Start dialog and commence the 
thermal run.

Multicell Holder The Cell Loading Guide dialog will appear. Enter the sample 
name of each activated cell then select OK to display the Sync 
Start dialog. 

When you select OK to clear the Cell Loading Guide dialog, the 
cell changer will move to cell position 4, enabling you to easily 
access all of the cell positions and load your samples. 

If you need to start data collection immediately: 
Load the cells into the cell changer and select Reset Slide from the 
Sync Start dialog. The cell changer will move to cell position 1. 
You should then add the reactants to the cells as quickly as 
possible, close the lid and select  OK on the Sync Start dialog. The 
collect will start immediately without performing another reset 
command. 

If you do not need to start the data collection immediately: 
Add the reactants to all the cuvettes and select OK on the Sync 
Start dialog. The system will automatically reset the cell changer 
to cell position 1 and start measurements on the selected cuvettes.  

Manual and Automated 
Polarizers

The system will drive to the set temperature and then check for a 
valid G Factor. If the G Factor is not valid, the following prompt is 
displayed:  
‘The current G Factor is not valid at the emission wavelength. 
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Sample Name—Thermal 
The software selects the multicell accessory by default on opening the Thermal application. 

If you are using a single cell peltier accessory, select the Go to radio button on the Cary tab and uncheck 
the multicell holder option on the Accessories tab in the Setup dialog. The Sample Name dialog appears 
once you select the Start button to commence an analysis. 

The page comprises the following: 

Cell Loading Guide—Thermal 
If you are using a Multicell Holder (selected by default on opening the Thermal application), the Cell 
Loading Guide dialog appears once you select the Start button to commence an analysis. 

The Cell Loading Guide dialog prompts you to insert blank samples in the Multicell Holder to collect 
the Thermal melts. You can also use the dialog to name the samples in each selected cell in the Multicell 
Holder.  

The dialog comprises the following: 

Press the G Factor button to determine a new grating factor.’ 
Once the G Factor has been validated, the Cell Loading Guide is 
displayed.

See also: 
Sample Name 
Cell Loading Guide 
Sync Start 
Start/Stop buttons 
Setup 
Accessories 
Auto Store

Sample Name Enter the name of the sample to be used in the thermal run. Click on the arrow to the 
right of the field to view and select the most recently entered sample names. 
Once you have entered the Sample Name, select OK to display the Sync Start dialog 
and commence the thermal run. 

 
See also: 
Cell Loading Guide

Loading 
Guide/Sample 
Name entry

Enter the names of the sample to be used in the thermal run in each available field. This 
sample name will be used as the Name of Trace in the Trace Preferences dialog. 

Note 
The Cell Loading Guide dialog appears only if you 
have selected the Multicell Holder option on the 
Accessories page of the Setup dialog. Only cells 
selected in the Multicell Holder diagram on the 
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Sync Start—Thermal 
Use the Sync Start dialog to synchronize the start of a reaction and the start of the thermal data collection. 
Before displaying the Sync Start dialog, the Cary Eclipse will set up all the instrument and graphing 
parameters so that data collection can start as soon as the countdown finishes or you select OK. 

The sequence for a Sync Start is as follows:  

Set up your data collection parameters
Click the Start button (and load the samples if necessary)
Once the Sync Start dialog is displayed, add your active reagent
Commence the data collection by selecting the OK button

The dialog comprises the following: 

The following buttons may be displayed at the top of the Thermal Application window. The Start, 
Pause, Continue and Connect buttons will change depending upon the status of the run. For example, if 
a run has not been started, the Start button will be visible to indicate that the system is ready to 
commence a run. 

Once you have entered the Sample Name, select OK to display the Sync Start dialog 
and commence the Thermal run. 

Accessories page will be available in the Loading 
Guide. 

In the adjacent example, cells 1—3 will be available in 
the Loading Guide dialog, as they have been selected in 
the Multicell Holder diagram. 

See also: 
Accessories 
Sample Name

Count Down This field displays a two minute countdown in seconds. If you want to start your data 
collection before the two minute countdown ends select the OK button. Alternatively, 
you can wait for the countdown to end and the data collection will start automatically. 

Note 
If you are using a Multicell Holder and you select the OK button, the system will 
automatically Reset this accessory and immediately start the thermal run.

Reset Slide Click this button to drive the Multicell Holder to its zero point (Cell position 1).

Start/Stop Instrument buttons—Thermal 

Select Start to commence a thermal run using the current Setup parameters. 
If any unsaved data exists in the Graphics area you will be prompted to save 
the data. If you choose not to save, any unsaved data, pictures and labels will 
be deleted when you start the thermal run. 
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Zero—Thermal 
Use the Zero button to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use the Zero 
command before commencing a data collection if you want your data to start at 0  intensity. The Cary 
Eclipse will prompt you to load a blank before performing the zero. 

Before you select Zero, ensure that you have placed the blank solution in the cell positions that are 
currently in the cell path. 

When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the 
Thermal Application window. 

Select the Clear Zero command from the Commands menu to remove zero correction and thus remove 
the subtraction effect. 

When a thermal run is started, the Start button will change to Pause. 

The Pause button is displayed in place of the Start button once you have 
selected Start to commence a run. Click Pause to temporarily suspend the data 
collection, so that you can modify your solutions during the thermal run. 
While the system is in the paused state, it will continue to keep track of the 
elapsed time, however data collection will stop until the Continue button is 
selected. 

The benefit of using Pause instead of Stop is that you are able to add a 
secondary substrate to your thermal solution(s) and then continue to monitor a 
secondary reaction, without having to Stop and Start the collect again. It also 
means that you will not get a spike in your data when you open the sample 
compartment to add the reagent. 

When a thermal run is paused, the Pause button will change to Continue. 

The Continue button is displayed in place of the Pause button when you have 
paused the run. Click Continue to proceed with the thermal run after it has 
been paused. 

Once you select Continue, is selected the button changes back to Pause. 

If another application is already online with the Cary Eclipse, the Start button 
will change to Connect, and you will need to select Connect to bring this 
application online before the Start button will re-appear. (You will not be able 
to Connect if the other application is collecting data.)

Select this to end a thermal run. 
If you have selected Storage On in the Auto Store page of the Setup dialog, 
all data collected is automatically stored in the file specified in the Batch name 
field of the Windows Save As dialog before or after the run commenced. 

 
See also: 
Graphics area 
Commands menu
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Use the Go to Wavelength dialog to temporarily change the instrument to a new excitation or emission 
wavelength. You would mainly use this dialog if you want to quickly go to a wavelength and check the 
intensity reading of the sample. The lamp will flash continuously in this mode. This option is only 
available if the instrument is not currently collecting data. 

To access the Go to Wavelength dialog, select the Go To Wavelength command from the Commands 
menu. You can also select F4 to open the dialog. 

The Go to Wavelength page comprises the following: 

Use the Go to Temperature dialog to change the current temperature to a new value. 

To access the Zero option, select the Zero command from the Commands menu, or select 
the Zero button from the Thermal Application window. 

See also: 
Thermal Application 
Commands menu 
Cell Loading Guide

Go to Wavelength—Thermal 

Note 
This is not the wavelength used in the application method. If your method uses a wavelength that is 
different from the 'Go to wavelength' setting you select, then when you select Start the system will 
change to the wavelength selected. (In most applications, this is set in the Cary page of the Setup 
dialog.) 

Excitation Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go to the 
instrument will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm 
(white light). You can then use this light for aligning accessories. 

Emission Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go to the 
instrument will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm 
(white light). You can then use this light for aligning accessories. 

Go To Click Go to once you have entered a new wavelength, to change the instrument to the 
entered value.

See also: 
Commands menu  
Function Keys

Go to Temperature—Thermal 
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The Set Temp button is only accessible if you are using a thermostatted accessory. (On the Accessories 
page, the Temperature control option must be selected.) 

You can access the Go to Temperature dialog prior to starting a run or once a run is in progress. 

This dialog enables you to drive the Multicell Holder or Single Cell Holder block to the temperature 
entered in the Go to Temperature field. 

To change the current temperature of a run in progress: 

1. Access the Set Temp button by selecting the Pause button to pause the run. You can then select
the Set Temp button.

2. In the Set temp field, enter the temperature you want the instrument to change to. Select OK to
return to the Thermal Application window.

3. Select Continue to proceed with the run.

Use the Rapid Result dialog to take a reading of a blank and sample/s, without having to change the 
current application method. You can use the Multi Cell Changer dialog to specify the cell you want to 
read. This means that between runs, while new samples are being prepared and loaded, other samples can 
quickly be measured. The result is printed in the Report area. 

To access the Rapid Result dialog, select the Rapid Result command from the Commands menu or 
press F6. 

To access the Go to Temperature dialog, select the Set temp button from the Thermal 
Application window or the Set temp command from the Commands menu.

Hot Tip 
By using the Temperature probe accessory, you can determine the exact temperature of the solution 
within the cell. The start will be delayed until the solution has reached the required temperature.
Hot Tip 
You can use this dialog to equilibrate your samples at the Start temperature before performing a 
Temperature run. Normally, the Multicell Holder or Single Cell Peltier will drive to the Start 
temperature when you press OK on the Setup dialog. If you then press Start immediately, the Cary 
will start collecting data soon as it determines the block temperature has reached the set value. 
However, this may not give the sample time to equilibrate.

See also:
Thermal Application

Rapid Result—Thermal 

Excitation Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 
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Use the Commands menu to access major operational commands in the Thermal application . The menu 
is accessible from the menu line at the top of the Thermal Application window. 

Alternatively you can use function key shortcuts for some of the commands. These appear next to the 
item in the Commands menu. Note that not all commands appear as both button and menu items. 

The Commands menu comprises the following commands: 

Emission Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Zero Click Zero to change the wavelength to the entered value and measure a blank.
Result Click Result to change the wavelength to the entered value and measure a sample. The 

X,Y results are corrected for the blank and the results are displayed in the Report 
window.

See also: 
Multi Cell Changer  
Commands menu 

Commands menu—Thermal 

Hot Tip 
If you access these commands using the Commands menu, rather than from the application 
buttons, you can remove these buttons from your application window. To do this, clear the 
Buttons command in the View menu. This will enlarge the Graphics area, making viewing and 
selection of thermals easier. 

Tell me how to remove or display the command buttons  

Command What it does…
Start Select this to start a data collection using the currently set up parameters. 

If the Connect command is displayed in place of the Start command, this indicates that 
another Cary Eclipse application is in use and has control of the Cary Eclipse 
instrument. To make the Thermal application active so that you can perform a read, you 
will need to select Connect. However, you will not be able to select Connect if another 
application is collecting data. 

Stop Select this to stop the data collection. 
If you have selected Storage On in the Auto Store page of the Setup dialog, all data 
collected is automatically stored in the file specified in the Batch name field of the 
Windows Save As dialog before or after the run commenced. 

Clear Zero Select this option to clear the Zero command. When you select the Zero command 
(from the Commands menu or by pressing F5), the intensity at that time will be reset to 
zero and all subsequent results will have the intensity value that was reset to zero 
subtracted from them. Selecting Clear zero cancels this zeroing (and thus subtraction) 
effect.
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Zero order… Select the Zero order command to set one of the monochromators to zero order. If you 
use this command to zero either the excitation or emission monochromators, this will 
override the Ex. Wavelength or Em. Wavelength set on the Cary page. The Cary 
Eclipse software will use the zero setting when collecting data. 

The Zero order command is generally used during alignment procedures.  

Excitation 
Select this command to set the excitation monochromator to zero order (white light). 

Emission 
Select this command to set the emission monochromator to zero order (white light). 

Reset Select this command to re-initialize the instrument. This will perform the same 
initializing procedure that is performed when the instrument is powered on.

Rapid Result Select this to display the Rapid Result dialog. Use this dialog to take a reading of a 
blank and multiple sample readings without changing the application method. This 
means that between runs, while new samples are being prepared and loaded, other 
samples can quickly be measured. 
This command can also be accessed by pressing F6.

Zero Select this to zero the current intensity value. The intensity value will be reset to zero 
and all subsequent results will have the value that was reset to zero subtracted from 
them. You can use the Zero command before selecting Start if you want your data to 
start at 0 intensity. 
This command is also accessible by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Go to… Select Go To… to display the Go To Wavelength dialog where you can change the 
instrument to a new wavelength. Use this command if you want to quickly go to a 
wavelength to check the intensity reading. 
This command is only available if the instrument is not currently collecting data. It can 
also be accessed by pressing F4. 

Note 
This is not the wavelength used in the application method. If your method uses a 
wavelength that is different from the 'Go To wavelength', when you select Start, 
the system will change to the wavelength selected in the current method. (In most 
applications, this is set in the Cary page of the Setup dialog.) 

Set temp Select Set temp to open the Set Temperature dialog where you can change the 
temperature during a thermal run. 

The Set temp command button is only accessible if you are using a thermostatted 
accessory. (On the Accessories page, the Temperature control option must be 
selected.) Once you have started a run, select the Pause button to pause the run and then 
select the Set temp command. 

ADL 
Command 

Select this to display the ADL Command Line window where you can execute an 
ADL command or ADL program. (You can also press Alt-Y to display this dialog.)

Rerun ADL Select this to run the ADL command or program in the ADL Command Line window 
again. (You can also press Alt-X to rerun programs.)
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How to perform a run and determine Tm using Derivative 
calculations—Thermal 
This demonstrates how to perform a Thermal run using a simple collect (single stage or single ramp rate) 
and automatically calculate Tm from the first derivative. 

Follow the steps through adjusting them to meet the requirements of your particular Thermal run.  

Start the Thermal application
Set up data collection parameters
Set up instrument parameters such as wavelengths, slit width, etc.
Set up accessories
Set up a derivative method of analysis
Set up your reporting and printing requirements
Set up storage of collected data
Set up visual system monitoring
Finish Setup
Equilibrate the sample
Start the Thermal run
Cary actions after the run
Save your data

Start the Thermal application  

Step 1 

On the Windows Taskbar click Start to display the Start Menu. 

Step 2 

Move the cursor over the Programs menu item to display the Programs menu. 

Step 3 

Select Thermal in the Cary Eclipse menu. 

Step 4 

Select your instrument type (if necessary) and press OK to open the Thermal application. 

See also: 
Thermal Application window 
Auto Store  
Zero  
Cary page  
Rapid Result   
Go To Wavelength 
Set Temperature  
ADL Command Line 
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(Alternatively, you can double click on the Thermal icon in the Cary Eclipse folder on the desktop.)

Set up data collection parameters  

Step 5 [Setup dialog] 

Select the Setup menu or click the Setup… button to display the Setup dialog and specify the method 
parameters for a new method. 

Set up instrument parameters such as wavelengths, slit width, etc. 

Step 6 [Setup dialog | Cary tab]  

a. Select the Cary tab and specify the instrument set-up for your analysis. For example selecting
Fluorescence from the drop down menu.

b. In the Wavelength setup enter the excitation and emission wavelengths that you want monitored.

c. In the Wavelength setup enter the required excitation and emission slit widths.

Step 7 [Setup dialog | Cary tab]  [Collect Temperatures] Field  

a. Select the Ramps radio button.

b. Select Simple Collect to set a single rate of temperature change for the entire Thermal run. Select
Advanced Collect for more than one stage of temperature ramping.

c. Set up the rate parameters such as the start and stop temperatures, the rate of temperature ramping,
and the hold times at the start and end temperatures.

d. In the Ave Time field enter the time(s) you require the instrument to excite the sample and record
an emission for each data point.

e. In the Cary tab specify the Collect Temperatures parameters.

Step 8 [Setup dialog | Options tab]  

Note 
If you are running a GLP system, you may be prompted to enter a password before accessing the 
Thermal application. 

Note 
For slow changes in temperature (i.e. slow ramp rates) it is recommended that a long Ave Time (e.g. 
2 seconds) is set.

Note
Once you press OK to exit the Setup dialog, the Cary will drive the temperature to the specified Start
Temperature. The Start button becomes enabled once the monitoring device (Temperature probe or
block probe) indicates that the temperature is within 0.5°C of the specified start temperature.
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a. In the Display Options group, select the way in which you want the data displayed as it is collected.
Choose the Overlay Data radio button to superimpose the collected data of each sample in the
Thermal run in one graph box.

b. Deselect the Overlay Data radio button to plot individual graphs for each thermal melt sample.

c. Adjust the PMT voltage if necessary to increase or decrease the fluorescence intensity recorded.

Set up accessories  

Step 9 [Setup dialog | Analyze tab] Lost-run smoothing  

a. Select the Analyze tab.

b. Select Smoothing and nominate the smoothing Interval and Filter Size to control the number of
measurement points to be averaged if required.

Set up a derivative method of analysis  

Step 10 [Setup dialog | Analyze tab] Lost-run smoothing  

a. Select the Derivative radio button to choose the derivative method to calculate the temperature at
which 50% of the DNA strands have separated (Tm).

b. Select the Autocalculate checkbox to automatically perform a derivative calculation on collected
data at the end of each run.

c. Now set the parameters to define the range over which to calculate and plot the first derivative of
the selected thermal. To do this, first enter the Interval at which data is sampled in order to perform
a derivative calculation.

d. A derivative calculation involves the collection of points from a plot. Selection of these points is
dependent upon the data interval chosen. The data points are then used to generate a separate trace
from which a derivative calculation is performed. The selection of the Derivative Interval is
dependent on the rate of data collection. If data is collected every 0.1 °C then a derivative interval
of 0.1 °C will give the most accurate result  Enter the Filter Size you require for the derivative
calculation.

The derivative uses a Savitzky Golay technique where a number of points surrounding an
individual point are averaged to produce a new, smoothed point. For example, a five point
derivation uses the two data points before and after each data point.

Note
If you are unsure of the expected change in fluorescence intensity during your thermal ramp, you
can use the Set Temperature button to quickly ramp the temperature to a value at which you expect
the intensity to be largest. Then adjust the PMT HV so that the intensity at this temperature is
approximately 750 a.u..

Note 
You can also perform the derivative calculation manually, once the run is completed.
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e. In the Low Calculation Limit entry field, enter the temperature where you want to start the
calculation of the derivative for the plot.

f. In the High Calculation Limit entry field, enter the temperature where you want to end the
calculation of the derivative for the plot.

Set up your reporting and printing requirements  

Step 11 [Setup dialog | Report tab] 

Select the Reports tab and specify your reporting requirements.  

a. Enter your name in the Name entry field.

b. Enter a comment relating to your experiment in the Comment entry field

c. Set up your report style by selecting the appropriate radio buttons in the Options group.

For example, select the Auto Print checkbox to obtain a printout of your report automatically.
Select the Parameters checkbox to include your method parameters in the report.
Select the Graph checkbox to include a the graphics in the generated report.

d. Select the Autoconvert option you require.

If you choose Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data
collection the system will automatically generate a report and store the data both in the Cary format
as well as ASCII XY pairs format in the current folder.

Set up storage of collected data  

Step 12 [Setup dialog I Auto Store tab]  

a. Select the Auto Store tab.

b. Select Storage Off.

Set up visual system monitoring  

Step 13 [Setup dialog] 

Select the Show Status Display checkbox to display various information fields on your current reaction.

Note 
The larger the filter size, the more data points that are included in the filter for smoothing.

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as 
well as the Report area. However if Auto Print is not selected, the report will only be sent to the 
Report area and can be viewed by selecting the Report option in the View menu.

Page 49 of 130Thermal Home Page

 



Finish Setup  

Step 14 

Once you are satisfied with your method setup click OK to save any changes made and close the Setup 
dialog. The Cary will start to dive the temperature to the Start temperature. 

Equilibrate the sample 

Step 15 

Make sure that the Cary has reached the Start temperature and has been at this temperature for 2–3 
minutes. 

Start the Thermal run  

Step 16  

a. Push the Start button to start a data collection. Alternatively you can select Start in the Commands
menu. The system will display a Loading Guide dialog box.

b. Load your sample into the appropriate cell holder.

c. Enter the name of your sample in the text entry field then press OK.

The Cary will wait for the specified Hold time and then perform the Thermal run.  

Cary actions after the run 

Step 17  

If Autocalculate (Derivative group) was selected on the Analyze tab of the Setup dialog box, a derivative 
calculation will be performed at the end of the data collection.  

The sample under investigation, with corresponding Tm values, will appear in the Report area as well as 
parameters used to generate the selected data file, Temperature profile, and the method used to contain 
the Tm value. 

A plot will appear in the Graphics area indicating the original temperature data as well as a plot of the 
first derivative of the selected thermal. The point at which the derivative plot peaks (i.e. maximum or 
minimum gradient on the original plot) is reported as the Tm value and the original plot is marked with 
an arrow to indicate this point.  

To view a plot of the collected data, from the View menu select the Graph option. 

You may use the Recalculate button to reanalyze your data using different parameters if you wish. 

Save your data  

Step 18  
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a. Click on the File menu item and select Save Data As…

b. Click in the  Files of Type field and select Batch.

c. Enter the file name for this Thermal run in the File name field.

d. Click Save.

The data will be stored as a Batch file. 

How to perform a run and determine Tm using Hyperchromicity 
calculations— Thermal 
This demonstrates how to perform a Thermal run with multiple temperature ramps and determine Tm 
using a Hyperchromicity calculation. 

Follow the steps through, adjusting them to meet the requirements of your particular Thermal run.  

Start the Thermal application
Set up the data collection parameters
Set up instrument parameters such as wavelengths, slit width, etc.
Set up accessories
Set up your hyperchromicity method of analysis
Set up your reporting and printing requirements
Set up storage of collected data
Set up visual system monitoring
Finish Setup
Equilibrate the Samples
Start the Thermal run
Cary prompts after the run
Save your data
Hyperchromicity calculations

Start the Thermal application  

Step 1 

On the Windows Taskbar click Start to display the Start Menu. 

Step 2 

Move the cursor over the Programs menu item to display the Programs menu. 

Step 3 

Select Thermal in the Cary Eclipse menu.

See also: 
Example of Thermal trace with derivative 
How to perform Derivative calculations from previously stored data
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Step 4 

Select your instrument type (if necessary) and press OK to open the Thermal application. 
(Alternatively, you can double click on the Thermal icon in the Cary Eclipse folder on the desktop.) 

Set up data collection parameters  

Step 5 [Setup dialog] 

Select the Setup menu or click the Setup… button to display the Setup dialog and specify the method 
parameters for a new method. 

Set up instrument parameters such as wavelengths, slit width, etc. 

Step 6 [Setup dialog | Cary tab]  

a. Select the Cary tab and specify the instrument set-up for your analysis. For example selecting
Fluorescence from the drop down menu.

b. In the Wavelength setup enter the excitation and emission wavelengths that you want monitored.

c. In the Wavelength setup enter the required excitation and emission slit widths.

Step 7 [Setup dialog | Cary tab]  [Collect Temperatures] Field  

a. Select the Ramps radio button.

b. Select Simple Collect to set a single rate of temperature change for the entire Thermal run. Select
Advanced Collect for more than one stage of temperature ramping.

c. Set up the rate parameters such as the start and stop temperatures, the rate of temperature ramping,
and the hold times at the start and end temperatures.

d. In the Ave Time field enter the time(s) you require the instrument to excite the sample and record
an emission for each data point.

e. In the Cary tab specify the Collect Temperatures parameters.

Note 
If you are running a GLP system, you may be prompted to enter a password before accessing the 
Thermal application. 

Note 
For slow changes in temperature (i.e. slow ramp rates) it is recommended that a long Ave Time (e.g. 
2 seconds) is set.

Note
Once you press OK to exit the Setup dialog, the Cary will drive the temperature to the specified Start
Temperature. The Start button becomes enabled once the monitoring device (Temperature probe or
block probe) indicates that the temperature is within 0.5°C of the specified start temperature.
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Step 8 [Setup dialog | Options tab]  

a. In the Display Options group, select the way in which you want the data displayed as it is collected.
Choose the Overlay Data radio button to superimpose the collected data of each sample in the
Thermal run in one graph box.

b. Deselect the Overlay Data radio button to plot individual graphs for each thermal melt sample.

c. Adjust the PMT voltage if necessary to increase or decrease the fluorescence intensity recorded.

Set up accessories  

Step 9 [Setup dialog | Analyze tab] Lost-run smoothing  

a. Select the Analyze tab.

b. Select Smoothing and nominate the smoothing Interval and Filter Size to control the number of
measurement points to be averaged if required.

Set up your hyperchromicity method of analysis  

Step 10 [Setup dialog | Analyze tab]  

a. Check the Hyperchromicity option to calculate the temperature at which 50% of the DNA strands
have separated (Tm).

b. Check Vant Hoff Calculation to calculate a van't Hoff plot (Ln(K(T)) vs 1000/T(deg K)) and
activate the Hyperchromicity group.

c. Select the Self Complementary radio button if the DNA molecule being analyzed consists of
identical strands. Otherwise, select Non Self Complementary.

d. Enter the concentration in the Total Conc of Strands entry field.

e. Enter the Molecularity (i.e. the number of strands) of the hybrid. For example, enter '2' in this field
if the DNA molecule being analyzed consists of two strands.

f. Check the Delta G checkbox to perform Delta G (ΔG or free energy) and K (equilibrium constant)
calculations.

Note
If you are unsure of the expected change in fluorescence intensity during your thermal ramp, you
can use the Set Temperature button to quickly ramp the temperature to a value at which you expect
the intensity to be largest. Then adjust the PMT HV so that the intensity at this temperature is
approximately 750 a.u..

Note 
The hyperchromicity calculation is performed once the run is completed as the user needs to select 
their region of interest from the graph.
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g. In the Number of Temperatures field that is now accessible, specify the number of temperatures at
which you would like to perform the ΔG and K calculations. The number set here is reflected in the
Temperature table below this field.

h. Enter the temperature at which you would like to calculate ΔG sfn K in each cell in the
Temperature table.

Set up your reporting and printing requirements  

Step 11 [Setup dialog | Report tab] 

Select the Reports tab and specify your reporting requirements.  

a. Enter your name in the Name entry field.

b. Enter a comment relating to your experiment in the Comment entry field

c. Set up your report style by selecting the appropriate radio buttons in the Options group.

For example, select the Auto Print checkbox to obtain a printout of your report automatically.
Select the Parameters checkbox to include your method parameters in the report.
Select the Graph checkbox to include the graphics in the generated report.

d. Select the Autoconvert option you require.

If you choose Select for ASCII (csv) or Select for ASCII (csv) with Log, then at the end of the data
collection the system will automatically generate a report and store the data both in the Cary format
as well as ASCII XY pairs format in the current folder.

Set up storage of collected data  

Step 12 [Setup dialog I Auto Store tab]  

a. Select the Auto Store tab.

b. Select Storage Off.

Set up visual system monitoring  

Step 13 [Setup dialog] 

Select the Show Status Display checkbox to display various information fields on your current reaction. 

Finish Setup  

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as 
well as the Report area. However if Auto Print is not selected, the report will only be sent to the 
Report area and can be viewed by selecting the Report option in the View menu.
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Step 14 

Once you are satisfied with your method setup click OK to save any changes made and close the Setup 
dialog. The Cary will start to dive the temperature to the Start temperature. 

Equilibrate the sample 

Step 15 

Make sure that the Cary has reached the Start temperature and has been at this temperature for 2–3 
minutes. If you enter a hold time in the Stage 1 Hold field, the system will wait and equilibrate at this 
temperature for the hold time before proceeding with the ramp. It is not necessary to wait to press the 
Start button. 

Start the Thermal run  

Step 16  

a. Push the Start button to start a data collection. Alternatively you can select Start in the Commands
menu. The system will display a Loading Guide dialog box.

b. Load your sample into the appropriate cell holder.

c. Enter the name of your sample in the text entry field then press OK.

The Cary will wait for the specified Hold time and then perform the Thermal run.  

Cary prompts after the run 

Step 17  

a. At the end of the run, depending on what you have set in Step 14, the User Data Form may appear.
If it does, then fill-in the appropriate entries in the columns provided for each sample trace and
press OK.The calculation equation will appear in the report.

b. Next the Cary will prompt you to use the Thermal ruler to define various limits for the
hyperchromicity calculations. (See the following sections).

Save your data  

Step 18  

a. Click on the File menu item and select Save Data As…

b. Click in the  Files of Type field and select Batch.

c. Enter the file name for this Thermal run in the File name field.

d. Click Save.
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The data will be stored as a Batch file. 

Hyperchromicity calculations 

Step 19  

a. An Attention dialog will appear asking you to select the Associated DNA limits using the Ruler.
Press the OK button on this dialog. The cursor changes to ruler mode.

b. Place your mouse on the Thermal curve at one end of the linear region of the Associated DNA part
of the curve (prior to transition). Click and hold down the left mouse button, then drag the mouse
along the curve and release the left mouse button at the other end of the linear region.

The software will automatically calculate a linear least squares line between the selected points and
extrapolate to both ends of the melting curve.

c. An Associated DNA Limits dialog will appear displaying the upper and lower limits which you
selected with the Thermal Ruler. Press the OK button to accept the calculated line.

d. An Attention dialog will then appear asking you to select the Deassociated DNA limits using the
Ruler, press the OK button on this dialog. The cursor changes to ruler mode.

e. Place your mouse on the Thermal curve at one end of the linear region of the Deassociated DNA
part of the curve (after the transition). Click and hold down the left mouse button, then drag the
mouse along the curve and release the left mouse button at the other end of the linear region.

The software will automatically calculate a linear least squares line between the selected points and
extrapolate to both ends of the melting curve.

f. A Dissociated DNA Limits dialog will appear displaying the upper and lower limits which you
selected with the ruler. Press the OK button to accept the calculated line. The Linear Region
Associated and Dissociated correction points are displayed in the Report area.

Using the lines calculated in the previous steps the software will now automatically create a 
second graph box and display the calculated Alpha curve.  

g. An Attention dialog will appear asking you to select the range on the Alpha curve which will be
used for the Tm calculation. Press the OK button to make your selection.

h. Place your mouse on the alpha curve at one end of the linear region. Click and hold down the left

Note 
The Associated and Dissociated DNA Limits dialogs allow you to re-select your limits if you are 
not satisfied with the linear least squares lines drawn in the graph box. To do this, click the Retry 
button on either dialog and select another region. If you wish to exit from the calculation mode, 
click Cancel. The ruler trace is removed from the graph. 

Note 
If the two extrapolated lines cross at any point, a warning will appear. Click Cancel and repeat steps 
(a) to (f) above and re-select the linear regions. Click Ignore to proceed with the calculation using
the regions you have selected.
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mouse button, then drag the mouse along the curve and release the left mouse button at the other 
end of the linear region. 

i. An Alpha Tm Limits dialog box will appear displaying the selected limits. Click the Retry button
to re-select the limits if required. Press the OK button to accept the selected ranges.

A linear least squares line is drawn between the selected points and the value of temperature where
a = 0.5 is calculated to give the Tm value. (The Tm value is automatically reported in °C and K.)

If you have chosen the van't Hoff Calculation method to calculate Delta G and K:  

j. Using the data calculated in step (j) above, the system automatically creates a third graph box
displaying a van't Hoff plot. An Attention dialog will appear asking you to select the required range
on the van't Hoff plot to calculate Delta G and K. Press the OK button on this dialog.

k. Place your mouse on the van't Hoff curve at one end of the linear region. Click and hold down the
left mouse button, then drag the mouse along the curve and release the left mouse button at the
other end of the linear region.

l. A van't Hoff Limits dialog box will also appear displaying the upper and lower limits that you
selected with the ruler. Press the OK button to accept the calculated line. Alternatively you can
select the Retry button to re-select the limits using the ruler.

A linear least squares line is calculated between these points and is extrapolated to both ends 
of the van't Hoff plot. The slope and intercept of the calculated line gives the enthalpy and 
entropy of the hybrid formation (Delta H° and Delta S° respectively). 

The software will automatically send the results, using the calculated alpha curve, to the 
Report area including:  

K(Tm) experimental
K(Tm) from first principles
K(Tm) experimental/K(Tm) from first principles

Step 20 

Step 20 will be repeated for each sample trace measured. 

How to use the ruler during Hyperchromicity calculations—
Thermal 
You are required to use the ruler during Hyperchromicity calculations after Thermal data is collected to 

Note 
If there is an error in the van't Hoff calculation you will be prompted to re-select the linear region.

See also: 
Hyperchromicity ruler steps 
How to use the ruler during Hyperchromicity calculations 
How to perform Hyperchromicity calculations on previously stored data
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manually select linear regions of the currently displayed curve. This is done by clicking on the recalculate 
button and checking the Hyperchromicity checkbox.  

The upper and lower limits of the selected linear region of the Associated and Deassociated DNA region 
of a Thermal curve are used to calculate a linear least squares line between the selected points. The upper 
and lower limits of the linear region on the Alpha curve are used for the Tm calculation. The upper and 
lower limits of the linear region on the van't Hoff curve are used to determine Delta G and K. 

During Hyperchromicity calculations the Ruler cursor is automatically selected for you when you press 
the OK button on any Attention dialog box. Follow the steps below to use the ruler. 

To use the ruler:  

Step 1 

Select a region of the trace that is relatively straight and then place the cursor on the first point on the 
trace where you wish to start drawing the ruler. 

Step 2 

Press and hold down the left mouse button. 

Step 3 

Move the cursor to the second point on the trace. You will see the ruler line drawing as you move the 
cursor. 

Step 4 

Release the mouse button.  

The Limits dialog box for the currently displayed curve appears enabling you to view the X value of the 
start and end positions of the region that you selected. 

If you are not satisfied with the selected range, click the Retry button to repeat Steps 3 to 6 and select 
another range. 

Step 5 

Click the OK button. 

Note 
If you wish to exit from the Ruler mode, click Cancel. The ruler trace is removed from the graph.

See also: 
Hyperchromicity ruler steps 
How to perform a run and determine Tm using Hyperchromicity calculations 
How to perform Hyperchromicity calculations on previously stored data 
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Viewing run progress and results—Thermal 
Reports page
Reports toolbar
View menu
Edit menu
Status display
Print Preview dialog
Print

The View menu is accessible from the menu line at the top of the Thermal Application window. 

The following commands can be accessed from the View menu: 

View menu—Thermal 

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open 
it. Any data will be displayed in the Graphics area.

Command What it does…
Toolbar Select this option to toggle the Graphics and Reports toolbar on and off. You can also 

select to display or hide the toolbar Text Labels.
Buttons Select this option to toggle the left-hand button display (button area) on and off.
Graphics Select this option to toggle the Graphics area on and off. 
Report Select this option to toggle the Report area on and off.
Report 
Vertical 

If the Graphics option is selected, select Report Vertical to display the Graphics area, 
Report area and/or ADL Editor side by side vertically.

ADL Select this option to toggle the ADL Editor on and off.
ADL Vertical If the ADL and Report options are selected, select ADL Vertical to display the ADL 

Editor vertically on the right hand side of the Report area.
ADL Quick 
Reference 

This displays the Quick Reference window where you can easily add a command in 
the correct syntax to your ADL program. A detailed description of all the commands in 
the Quick Reference is available by selecting the Help button.

ADL Hooks Select this to activate a link (or hook) to an ADL program at a specific point in the 
application, and then run that ADL program. For example, ADL hooks have been 
supplied to run specific programs: 

on start-up of the Cary Eclipse software;
when the system goes online or offline;
when the Start button is selected;
when a run finishes;
when a zero is performed etc.
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Edit menu—Thermal 
Use the Edit menu to copy, cut, paste and delete information. You can also use the menu to access the 
Report editing commands. The menu is accessible from the menu line at the top of the Thermal 
Application window. 

The following commands can be accessed from the Edit menu: 

For the hook to work, ADL Hooks must be selected, and the appropriate ADL file for 
the application must be present in the ADL folder in the directory. 

Note 
Full documentation on ADL programming is available in the ADL Online Help.  
Click the button below to view this Help.      

Hints Select this option to toggle the Hints bubble text on and off. The bubble text appears 
when you place the arrow cursor over a field, button or text entry field for a short 
period. It offers a quick explanation of the item’s function.

Status 
Display 

Select this option to display the Status Display window, where you can view the status 
of various parameters during the data collection.

See also: 
Thermal Application 
Graphics area   
Status Display  
ADL Hooks 
How to insert ADL commands using the Quick Reference

Note 
Some options are only available once you select Edit Report. 

Command Button What it does… 
Undo If available, this undoes the last action. 

This command is also accessible by pressing CTRL+Z.
Cut Select this command to remove the highlighted text and place it on the Windows 

Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Select this command to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.

Paste Select this command to insert the contents of the Windows Clipboard (text only) 
at the cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Select this command to remove selected text in the Report area. This option is 
only available once you select Edit Report and there is text highlighted in the 
Report area. 
This command is also accessible by pressing DEL.
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Status Display—Thermal 
Use the Status Display window to view the status of your thermal run during the data collection. 
Depending upon settings you have for the Thermal run, the following parameters may be displayed: 

To access the Status Display window, select Status Display from the View menu, or from any page of 
the Setup dialog. You can choose to view the Status Display at any time during a thermal run. 

Select All Select this option to highlight all text in the Report area. 
This command is also accessible by pressing CTRL+A.

Font This enables you to change the font of new or selected text in the report. For 
existing text, simply highlight the text in the report, select Font and make your 
changes in the Font dialog. When you select OK, the appearance of the 
highlighted text in the report will alter to reflect your font changes. You do not 
have to select Edit Report to use this command. 
This command is also accessible by pressing CTRL+F.

Edit Report Select this option to edit the report. 
This command is also accessible by pressing CTRL+R.

Clear 
Report 

Select this command to remove the contents of the Report area. If you have 
saved the report, selecting this option does not delete the contents of the report, 
the information is simply removed from the Report area.

Recalculate Use the pages accessible from the Recalculate option to perform re-calculations 
on data that has been analyzed. 

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, 
Microsoft Word or Microsoft Excel) into the report area of the of the Thermal application. To edit 
these objects, simply double click on them to open the associated application in which they were 
created. 

See also: 
Thermal Application  
Recalculate 

Excitation Wavelength (nm): 0.02
Emission Wavelength (nm): 0.02
Ex. Slit Width (nm): 5
Em. Slit Width (nm): 5
Excitation Filter: Auto
Emission Filter: Open
Emission PMT (V): 600
Monitoring device: Block
Block Temperature: 0.00
Current Cell: 1

See also: 
View menu  
Setup  
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Print Preview—Thermal 
Use the Print Preview dialog to view the current report before you print it. From the File menu, select 
Print Preview to access the dialog. 

The contents of the Graphics area appear first in the preview area followed by the contents of the Report 
area. You can reduce or enlarge the print preview on screen. To do this, click the left mouse button in the 
preview area to toggle through the five available views. Click the right mouse button in the preview area 
to return to the full page view.  

The page comprises the following commands: 

Print—Thermal 
Use the Print dialog to select the printer and pages to print of the currently displayed report as well as the 
number of copies you wish to print. 

All graphical information displayed on screen will be printed with the report, therefore it is advisable to 
edit the report on the screen prior to printing. You can also preview the report prior to printing by using 
the Print Preview command. 

If you require a printout of the graphics in the Graphics area only, select the Clear Report button to erase 
the contents of the Report area before you print. 

Status Line

First arrow Use this arrow to view the first page of the report. 

Previous 
arrow

Use this arrow to view the previous page of the report. 

Next arrow Use this arrow to view the next page of the report. 

Last arrow Use this arrow to view the last page of the report. 
Q. Why are the arrow buttons grayed out?
A. The buttons will be grayed out if the report has only one page of data.

Print Use this to display the Windows Print dialog where you can choose the printer 
and pages to print as well as the number of copies you wish to print.

See also: 
File menu

To access the Print option, select the Print command from the File menu, or select the 
Print button from the Thermal Application window. 

Note 
The options on the Report page are used to generate the contents of the Report area during a run or 
on a recalculation. If Auto Print has been selected the Cary Eclipse will automatically print a 
report at the end of a data collection. 
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Performing Calculations—Thermal 
Recalculate
How to perform post run calculations on previously stored data
How to generate a report from previously stored data
How to use advanced reporting options
Analyze
Maths Calculator
Maths Operations
Maths How To
User Data Form

How to perform Derivative calculations on previously stored 
data— Thermal 

Retrieve the data
Set up recalculation
Set up for Derivative recalculations

Retrieve the data  

Step 1 

Select Open Data… from the File menu to display the Windows Open dialog box.  

Step 2 

A list of previously stored Batch files will appear. Select the Batch file you require then click the Open 
button.  

The system will automatically retrieve the collected data into the Graphics area. The method that was 
used to collect the data will also be retrieved. 

Step 3 

Select the sample you want to investigate. 

Set up recalculation  

See also: 
Print Preview 
Report page  
Edit Report 
Thermal Application

Note 
Recalculations are only performed on 'Visible' traces.
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Step 4 

Click the Recalculate button to display the Setup dialog box. The Analyze, Calculations and Reports tabs 
will appear to allow you to set up the analysis, calculation and report parameters. 

Step 5 

Select the Reports tab to ensure that the method will report exactly what you require. For example, 
Parameters, Results etc. 

Step 6 

Select the Analyze tab to enter the recalculation parameters. 

Set up for Derivative recalculations  

Step 7 

Select the Derivative radio button to choose the derivative method to calculate the temperature at which 
50% of the DNA strands have separated (Tm). In the Interval entry field, specify the interval at which 
data is collected in order to perform a derivative calculation. 

A derivative calculation involves the collection of points from a plot. Selection of these points is 
dependent upon the data interval chosen. The data points are then used to generate a separate trace from 
which a derivative calculation is performed. 

The selection of the Derivative interval is dependent on the rate of data collection. If data is collected 
every 0.1 °C then a derivative interval of 0.1 °C will give the most accurate result. 

Step 8 [Setup dialog | Calculations tab] 

Select the Calculations tab to enter the calculation parameters.  

Step 9 

Click OK to exit the Setup dialog.   

Step 10 

Select the Derivative button and Derivative calculation fields as required. 

Step 11 

Click OK to exit the Set up dialog. 

The software will calculate and plot the first derivative of the selected sample. The point at which the 

Note 
If the selected sample contains results from a previous calculation a confirmation dialog will appear 
warning you that these will be deleted. Click OK to delete the calculations. 
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derivative plot peaks (i.e. maximum or minimum gradient on the original plot) is reported as the Tm 
value and the original plot is marked with Tm to indicate this point. The calculation results will also be 
displayed in the Report area. 

How to perform Hyperchromicity calculations on previously 
stored data—Thermal 

Retrieve the data
Set up recalculation
Set up other recalculations and normalizations
Set up for Hyperchromicity recalculations
Hyperchromicity recalculation procedure

Retrieve the data  

Step 1 

Select Open Data… from the File menu to display the Windows Open dialog box.  

Step 2 

A list of previously stored Batch files will appear. Select the Batch file you require then click the Open 
button.  

The system will automatically retrieve the collected data into the Graphics area. The method that was 
used to collect the data will also be retrieved. 

Step 3 

Select the sample you want to investigate. 

Set up recalculation  

Note 
The first derivative is also calculated and plotted for all other 'Visible' traces in the Graphics area. 
Select Single/Multi Graph in the Graph menu to toggle to the Multi-graph mode and view other 
samples in the current Batch file. 

See also: 
Example of Thermal trace with derivative 
How to perform Hyperchromicity calculations on previously stored data

Note 
You can also retrieve data from other file types.

Note 
Recalculations are only performed on 'Visible' traces
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Step 4 

Click the Recalculate button to display the Setup dialog box. The Analyze, Calculations and Reports tabs 
will appear to allow you to set up the calculation, analysis and report parameters. 

Step 5 

Select the Reports tab to ensure that the method will report exactly what you require. For example, 
Parameters, Results etc. 

Set up for Hyperchromicity recalculations  

Step 6 

Select the Analyze tab to enter the recalculation parameters. 

Step 7 

Select the Hyperchromicity radio button to choose the Hyperchromicity method to calculate the 
temperature at which 50% of the DNA strands have separated (Tm).  

a. Check the Vant Hoff Calculation to obtain a van't Hoff plot (Ln(K(T)) vs 1000/T(K)) and activate
the Hyperchromicity group.

b. Select the Self Complementary radio button if the DNA molecule being analyzed consists of
identical strands. Otherwise select Non Self Complementary.

c. Enter the concentration in the Total Conc of Strands entry field.

d. Enter the Molecularity (i.e. the number of strands) of the hybrid. For example, enter '2' in this field
if the DNA molecule being analyzed consists of two strands.

e. Check the Delta G checkbox to perform Delta G (ΔG or free energy) and K (equilibrium constant)
calculations.

f. In the Number of Temperatures field that is now accessible, specify the number of temperatures at
which you would like to perform the Delta (Δ) G and K calculations. The number set here is
reflected in the Temperature table below this field.

g. Enter the required temperature in each cell in the Temperature table and click OK.

Hyperchromicity recalculation procedure 

Hot Tip 
Before commencing, enlarge the Graphics area. To do this, double click on the Graphics area with 
the left mouse button.

Note 
If the selected sample contains results from a previous calculation a confirmation dialog will appear 
warning you that these will be deleted. Click OK to delete the calculations. 
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Step 8  

a. An Attention dialog will appear asking you to select the Associated DNA limits using the Ruler.
Press the OK button on this dialog. The cursor changes to ruler mode.

b. Place your mouse on the Thermal curve at one end of the linear region of the Associated DNA part
of the curve (prior to transition). Click and hold down the left mouse button, then drag the mouse
along the curve and release the left mouse button at the other end of the linear region.

The software will automatically calculate a linear least squares line between the selected points and
extrapolate to both ends of the melting curve.

c. An Associated DNA Limits dialog will appear displaying the upper and lower limits which you
selected with the Thermal Ruler. Press the OK button to accept the calculated line.

d. An Attention dialog will then appear asking you to select the Deassociated DNA limits using the
Ruler, press the OK button on this dialog. The cursor changes to ruler mode.

e. Place your mouse on the Thermal curve at one end of the linear region of the Deassociated DNA
part of the curve (after the transition). Click and hold down the left mouse button, then drag the
mouse along the curve and release the left mouse button at the other end of the linear region.

The software will automatically calculate a linear least squares line between the selected points and
extrapolate to both ends of the melting curve.

f. A Dissociated DNA Limits dialog will appear displaying the upper and lower limits which you
selected with the ruler. Press the OK button to accept the calculated line. If you are not happy with
the linearity, reselect a linear region using the Retry button. The Linear Region Associated and
Dissociated correction points are displayed in the Report area.

Using the lines calculated in the previous steps the software will now automatically create a 
second graph box and display the calculated Alpha curve.  

g. An Attention dialog will appear asking you to select the range on the Alpha curve which will be
used for the Tm calculation. Press the OK button to make your selection.

h. Place your mouse on the alpha curve at one end of the linear region. Click and hold down the left
mouse button, then drag the mouse along the curve and release the left mouse button at the other
end of the linear region.

Note 
The Associated and Dissociated DNA Limits dialogs allow you to re-select your limits if you are 
not satisfied with the linear least squares lines drawn in the graph box. To do this, click the Retry 
button on either dialog and select another region. If you wish to exit from the calculation mode, 
click Cancel. The ruler trace is removed from the graph. 

Note 
If the two extrapolated lines cross at any point, a warning will appear. Click Cancel and repeat steps 
(a) to (f) above and re-select the linear regions. Click Ignore to proceed with the calculation using
the regions you have selected.
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i. An Alpha Tm Limits dialog box will appear displaying the selected limits. Click the Retry button
to re-select the limits if required. Press the OK button to accept the selected ranges.

A linear least squares line is drawn between the selected points and the value of temperature where
a = 0.5 is calculated to give the Tm value. (The Tm value is automatically reported in °C and K.)

If you have chosen the van't Hoff Calculation method to calculate Delta G and K:  

j. Using the data calculated in step (i) above, the system automatically creates a third graph box
displaying a van't Hoff plot. An Attention dialog will appear asking you to select the upper and
lower limits on the van't Hoff plot to calculate Delta G and K. Press the OK button on this dialog.

k. Place your mouse on the van't Hoff curve at one end of the linear region. Click and hold down the
left mouse button, then drag the mouse along the curve and release the left mouse button at the
other end of the linear region.

l. A van't Hoff Limits dialog box will also appear displaying the upper and lower limits that you
selected with the ruler. Press the OK button to accept the calculated line. Alternatively you can
select the Retry button to re-select the limits using the ruler.

A linear least squares line is calculated between these points and is extrapolated to both ends 
of the van't Hoff plot. The slope and intercept of the calculated line gives the enthalpy and 
entropy of the hybrid formation (Delta H° and Delta S° respectively). 

The software will automatically send the results, using the calculated alpha curve, to the 
Report area including:  

K(Tm) experimental
K(Tm) from first principles
K(Tm) experimental/K(Tm) from first principles

Recalculate—Thermal 
Use the pages accessible from the Recalculate option to perform re-calculations on data that has been 
analyzed. These re-calculations can be made using new Setup parameters. For example you may wish to 
change the order of a reaction. You can also use the Recalculate button to access Report options. 

When you select this option, the Setup dialog will appear, containing the following tabbed pages: 

Note 
If there is an error in the van't Hoff calculation you will be prompted to re-select the linear region.

See also: 
Hyperchromicity ruler steps 
How to use the ruler during Hyperchromicity calculations 
How to perform Derivative calculations on previously stored data

To access the Recalculate option, select the Recalculate button from the Thermal 
Application window.
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Analyze
Reports

How to perform post run calculations on previously stored data—
Thermal 

Retrieve the data
Set up the recalculation
Print the report

Retrieve the data  

Step 1 

From the File menu, select Open to display the Windows Open dialog.  

Step 2 

A list of previously stored Batch files will appear. Select the Batch file you require then select Open.  

The system will automatically retrieve the collected data into the Graphics area. The method that was 
used to collect the data will also be retrieved. 

Set up the recalculation  

Step 3 

Select the Recalculate button to display the Setup dialog. The Analyze and Reports pages will be 
displayed to enable you to set up the recalculation parameters. 

Step 4 

Select the Analyze tab to access the Analyze page where you can set the analysis parameters you require.

For example, select the Auto Calculate option to automatically perform a rate calculation on collected 
data at the end of each run. 

Step 5 

a. Select the Reports tab to display the Reports page where you can specify your reporting
requirements for this method.

b. Enter your name in the Name field.

See also:
Thermal Application

Note 
You can also retrieve data from Data (*.FDTM), Method (*FMTM) and Spreadsheet ASCII 
(*.CSV) file types.
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c. Enter a comment relating to your experiment in the Comment field (optional).

d. Set up your report style by selecting the appropriate check boxes in the Options group.

For example, select the Auto Print check box to obtain a printout of your report automatically.
Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a calibration graph in the generated report.

Step 6 

Select OK to clear the Setup dialog and start the recalculations. The results will be displayed in the 
Report area. 

Print the report  

Step 7  

a. From the File menu, select Print. The Windows Print dialog is displayed.

b. Set up your printing parameters and select OK to print your report.

How to generate a report from previously stored data—Thermal 
Step 1 

Select Open… from the File menu to display the Windows Open dialog.  

Step 2 

A list of previously stored files will appear. If this is not a list of batch files, select the down arrow at the 
right of the Files of type list box and select 'Batch' to list all the batch files.  

Step 3 

Select the Batch file you require then select Open.  

The system will automatically retrieve the collected data into the Graphics area. The method that was 
used to collect the data will also be retrieved. 

Note 
If Auto Print is selected, then the system will send the report information to the specified printer as 
well as the Report area. However if Auto Print is not selected, the report will only be sent to the 
Report area and can be viewed by selecting the Report command from the View menu.

See also:
How to generate a report from previously collected data

Note 
You can also retrieve data from Methods (*.FMTM), Data (*.FDTM), Report (*.FRTM), 
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Step 4 

Select the Recalculate button to display the Setup dialog.  

Step 5 

Select the Reports tab and on the Reports page specify the information you would like to include in the 
report. Select Auto Print if you require the new report to print to the Reports area and to a printer. 

Step 6 

Click OK to display the results in the Report area (and send to the printer if Auto Print is selected). 

Maths window 
Calculation Field | Selected/Focused Trace | Trace | Display Options | Functions

Use the Maths window to perform mathematical manipulations on collected traces. In addition, it can act 
as a simple numeric calculator. 

The Maths window comprises the following: 

Spreadsheet ASCII (*.CSV), GRAMS (*.SPC) and Rich Text Format (*.RTF) file types.

Note 
If you require a printout of only the current graphics in the Graphics area of a previously stored data 
file: 

a. Select the Clear Report option in the Commands menu to clear any text that may be
displayed in the Report area.

b. Press the Print button to obtain a printout of the graphics.

Alternatively tick only the Graph check box in the Reports page to obtain a printout of graphics 
only. 

See also: 
How to use advanced reporting options

To access the Maths window, select the Calculator command from the Graph menu, or select the 
Calculator button on the Graphics toolbar. 
The Maths window is only available in the Kinetics, Lifetimes, Scan and Validate applications.

Calculation 
display field 

View the current calculation, including the trace/s being used, the trace operation being 
carried out and any functions that have been applied to the trace. 

Hot Tip 
Click on the down arrow adjacent to this field to view the last ten unique 
calculations that have taken place. Use this list to keep track of previous 
manipulations and repeat calculations quickly by simply selecting and then 
applying the desired calculation.

Selected Choosing either of these options selects the highlighted (red) trace in the current Graph 
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Trace/Focused 
Trace 

box for manipulation. When choosing between these options, use this simple rule: 

Use the Selected Trace option when the selected calculation is only to be applied
to one trace.
Use the Focused Trace option when the same calculation is to be applied to a
number of traces.

The following example illustrates the difference between these options. 

To perform the same manipulation on several traces:  

a. Highlight a trace by clicking on it with the mouse. The trace will become red.
b. Select Selected Trace, Apply and then = to plot the result of the calculation
c. Highlight the next trace and repeat step b.

OR  

a. Highlight the first trace.
b. Select Focused Trace, Apply and then = to plot the result of the calculation;
c. Highlight the next trace and select the = button to perform the same calculation

on the newly selected trace.
Trace Use the Trace group options to select the operation to be performed on the traces, the 

filter size and the interval (where applicable). 
Click Apply to insert the selected operation into the equation 
Click = (equals) to display the result of the calculations. 

Operation 
Click on an operation to find out more about it  

Anisotropy
Polarization
Sum Function
Mean
Boxcar Averaging
Moving Average
Savitzky-Golay
Spline
Deriv 1
Deriv 2
Deriv 3
Deriv 4

Display 
Options 

Select whether the results of the operation performed on the trace will be viewed in a 
New Graph box or in the Selected Graph box. If you choose the Selected Graph option, 
you will be able to directly compare the results with existing traces.

Functions This group contains number and function buttons that can be used as a standard 
calculator in addition to being applied to traces. 

To use the functions: 
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1. select a trace or value
2. select either a second trace or number
3. select the equals (=) button to display the result

All the basic mathematical functions are available (addition, subtraction, multiplication 
and division), as well as logarithm (Log) and square root (Sqrt) functions. When used 
as a calculator, the results of equations appear in the Report area. 

Additional 
buttons 

C 
Click C to clear the entire operation in the calculation display field. 
CE 
Click CE to clear the last entry entered in the calculation display field. 
= 
Click = (equals) to start the operation shown in the calculation display field.

See also: 
Maths Home Page 
Maths How To

Maths Operations 

The following operations can be selected on the Maths window. To access the Maths window, 
select the Calculator command from the Graph menu, or select the Calculator button on the 
Graphics toolbar.

Anisotropy, 
Polarization 
and Sum 
Function 

The term Anisotropy refers to an unequal angular distribution about a point in space. 
Anisotropy also refers specifically to a simple expression for measuring the degree of 
polarization of the fluorescence.  It is almost identical to the expression for polarization 
apart from having a factor of two in the denominator.  Anisotropy is usually represented 
by the lowercase letter " r ", while polarization by an uppercase  " P ". 

The two expressions are listed below: 

Anisotropy 
r = (Ivv - GIvh) / (Ivv + 2GIvh) 

Polarisation 
P = (Ivv - GIvh) / (Ivv + GIvh) 

where 

Ivv equals the intensity of fluorescence with excitation polarizer = vertical, emission 
polarizer = vertical 
Ivh equals the intensity of fluorescence with excitation polarizer = vertical, emission 
polarizer = horizontal 

G is a factor that accounts for the polarization bias of the instrument. In particular it 
accounts for the wavelength-dependent polarization bias of the emission side of the 
instrument (dominated by the polarization bias of the emission grating). 

The G factor is given by:  
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G = Ihv/Ihh 

where 

Ihv equals the intensity of fluorescence with excitation polarizer = horizontal, emission 
polarizer = vertical 

Ihh equals the intensity of fluorescence with excitation polarizer = horizontal, emission 
polarizer = horizontal 

The expression for the anisotropy is a quotient.  The denominator of the expression, as 
given by Ivv + 2GIvh is the ‘sum’ function, and actually represents the total emission 
unbiased by any sample polarization effects. 

Mean The Mean operation allows the average of two or more traces to be taken and the 
resulting trace to be plotted. The mean of the traces can also be used in conjunction with 
other functions. 

The equation used in mean calculations is: 

(scan 1 + scan 2...+ scan x)/x 

The calculation is performed over the common X range of the traces and the trace with 
the most dense data is used to determine the data points. The other traces are 
interpolated at the relevant data points. 

Boxcar 
Averaging 

This algorithm will take the number of points as defined by the Filter size, and average 
these, displaying the average at the middle X-point of the filter. 

For example, for the following: 

 The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x8, sum(y6:y10)/5) 
….. (xn-2, sum(yn-4:yn)/5). 

If there are not enough points at the end of the data set to complete the filter size, then 
these points will be ignored, hence, the gap at the end may be larger than the gap in the 
beginning. There will be a gap before the first point and after the last point of the 
smoothed continuum, with respect to the original unsmoothed data. This algorithm is 
only valid for evenly x-spaced data points.  

Within a time scan, (e.g., Advanced collect in kinetics) the data points may be unevenly 
spaced between different stages.  Each stage will be treated as a new collect, hence, 
there may be large gaps between stages.  If there are not enough points at the end of a 
stage to complete the filter size, then these points are ignored, hence, there may be large 
gaps at the end of a stage.  The filter size will be limited to odd numbers, with the 
minimum of 3 to a maximum of 101. 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5

Moving 
Average 

This algorithm will take the number of points as defined by the Filter size, and average 
these, displaying the average at the middle X-point of the filter. 
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For example, for the following: 

The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x4, sum(y2:y6)/5) 
….. (xn-2, sum(yn-4:yn)/5). There will be a gap before the first point and after the last 
point of the smoothed continuum, with respect to the original unsmoothed data. This 
algorithm is only valid for evenly x-spaced data points. Within a time scan, (e.gg, 
Advanced collect in kinetics), the data points may be unevenly spaced between different 
stages. This will be treated by interpolation of data from the previous stage so as to give 
evenly spaced data points into the next stage. If there is not enough data for 
interpolation, then the next stage will be treated as a new collect, hence, there may be 
gaps and further delays in displaying the point. The filter size will be limited to odd 
numbers, with the minimum of 3 to a maximum of 101. 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5

Savitzky-
Golay 

The Savitzky-Golay technique operation enables  you to reduce the noise in the 
currently selected Maths scan by using smoothing. 

When you select this operation you will be prompted to enter a Filter Size from 5 to 
101. The larger the Filter Size, the more data points that will be smoothed.

You will also need to enter an Interval. The Interval refers to how many of the averaged 
points will be plotted on the smoothed trace. The smaller the interval, the more detail 
there will be in the trace. 

Consider selecting an Interval of 1. This would mean that when the smoothed 
continuum is plotted, every smoothed point will be displayed. 

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an
even number.

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select Smooth in the Operation field.

Spline 
Deriv 1–4 The Deriv operations allow you to obtain derivatives of a selected scan. The derivative 

can be of the orders 1 to 4. The resulting trace is then plotted.  The Savitzky-Golay 
technique is used for derivative calculations. 

On selection of the Deriv operation you will be prompted to enter a Filter Size from 5 to 
101. The Filter Size refers to the number of points around a particular point that will be
averaged to produce a new derived Y value. The lower the Filter Size, the more data
points that will be used in the derivative trace.

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an
even number.
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Maths How To… 
How to perform a spectral subtraction
How to perform a mean calculation
How to smooth a trace
How to derive a trace

User Data Form—Thermal 
Use the User Data Form to enter extra information about the traces in the highlighted graph box. For 
example, you might want to record information about the experimental conditions you used to collect the 
data. 

The dialog comprises the following: 

Displaying data graphically—Thermal 
Graphics area

You will also need to enter an Interval. The Interval refers to how many of the derived 
points will be plotted on the resulting trace. The smaller the Interval, the more detail 
there will be in the trace. 

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select one of the ‘Derivs’ in the Operation
field.

See also: 
About smoothing

See also:
Maths Home Page

To access the User Data Form, select the User Data Form command from the Graph menu, or 
select the User Data Form button on the Graphics toolbar. The User Data Form command is 
only available if you have selected a graph box.

Data Name This column lists the names of each visible trace in the highlighted graph box. 

Use the extra columns for recording additional information about the experimental 
conditions you used to collect the data, eg. pH. 

Other 
Columns 

Use this to record the name of the parameter in which you are interested as a column 
heading, (for example, pH, ionic concentration, substrate concentration etc.). 

Note 
You must enter a column heading, or else the data in that column will not be 
saved.

See also: 
Graph menu  
Graphics toolbar
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Graphics How To
Graph menu
Graphics toolbar
Graph Labels
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label
Graph Pictures
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture
Trace Preferences dialog
Trace Preferences menu
How to select the focused trace
How to display a trace
How to remove a trace from a graph
How to remove a trace from the trace list
Graph Preferences dialog
How to alter the look of your graphs
Cursor Modes dialog
How to track the focused trace
Axes Scales dialog
How to scale your graph manually
How to scale your graph automatically
Single/Multi Graph
User Data Form
Graphics Templates
How to create a graphics template

The Graphics area of the Thermal application appears in the top half of the Thermal Application window 
and is used to display traces of collected data. In the Cary Eclipse system, the term 'graph' refers to the 
plotting area and is represented by a set of axes. The rectangular area surrounding the graph is referred to 
as the graph box. A graph will appear in the Graphics area when you select Start to commence a Thermal 
run. 

To display or hide the Graphics area, select the Graphics command on the View menu. Double-clicking 
on the Graphics area enables you to toggle between half or full size display sizes. 

You can access the functions associated with the Graphics area by doing the following:  

Graphics area—Thermal 

Page 77 of 130Thermal Home Page

 



selecting one of the Graphics toolbar buttons;
selecting a command from the Graph menu; or
clicking the right mouse button in the Graphics area and select a command from the menu

You can customize the graphics area to suit your requirements in the following ways: 

Note 
Not all functions are available on every menu.

Note 
All of the commands and dialogs listed are accessible from the Graph menu. 

To… Use the… Tell me 
how…

Change the axes scaling automatically Autoscale graph command How to scale 
your graph 
automatically

Change the axes scaling manually Axes Scales dialog How to scale 
your graph 
manually

Modify the graph appearance (axes, trace) Graph Preferences dialog How to alter 
the look of 
your graphs 

How to 
specify the 
number of 
tick marks 
and decimal 
places for 
your X and 
Y axes 

Add a new graph to the display Add graph command

Remove a graph from the display Remove graph command How to 
remove 
graphs 

View single or multiple graphs Single/multiple graph 
command

Resize a graph box Cursor How to 
resize graph 
boxes

Track the focused trace Cursor Mode dialog How to track 
the focused 
trace 
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Select the focused trace Cursor How to 
select the 
focused trace

Display a trace in the graph Trace Preferences dialog How to 
display a 
trace that is 
not 
appearing in 
a graph box

Remove a trace from a graph Trace Preferences dialog How to 
remove a 
trace from a 
graph

Remove a trace from the trace list Trace Preferences dialog How to 
remove a 
trace from 
the trace List

Zoom in and out on the graph Zoom In and Zoom Out 
commands

How to zoom 
a graph

Add a label to the graph box Add Label dialog How to add a 
label to a 
graph

Edit labels in the graph box Edit Label dialog How to edit a 
label

Moving labels in the graph box Cursor How to move 
a label

Resizing labels in the graph box Cursor How to 
resize a label

Delete labels from the graph box Delete Annotation command How to 
delete a label

Add a picture to the graph box Add Picture dialog How to add a 
picture to a 
graph

Move pictures in the graph box Cursor How to move 
a picture

Resizing pictures in the graph box Cursor How to 
resize a 
picture

Replace pictures in the graph box Edit Picture dialog How to 
replace a 
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Graphics How to—Thermal 

Traces  

How to track the focused trace
How to select the focused trace
How to display a trace that is not appearing in a graph box
How to remove a trace from a graph
How to remove a trace from the trace List

Sizing and scale  

How to resize graph boxes
How to scale your graph manually
How to scale your graph automatically
How to alter the look of your graphs
How to zoom a graph

Labels  

How to add a label to a graph
How to edit a label
How to delete a label
How to move a label

Pictures  

How to add a picture to a graph
How to move a picture
How to delete a picture
How to replace a picture

picture

Delete pictures from the graph box Delete annotation command How to 
delete a 
picture

Save the Graphics area you have set up as a graphics 
template

Save As dialog (from the 
File menu)

How to 
create a 
graphics 
template

Note 
The red trace in any graph box is the one on which all information appears and the one used for the 
cursor tracking. It is called the focused trace. 

See also: 
Toolbar 
Graphics How To
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Introduction 

Use the Graph menu to view data in various graphical formats or in multiple graphs in the Graphics area. 
You can double-click on the Graphics area to toggle the display through graph and report to graph only.  

In the Cary Eclipse system, the term 'graph' refers to the plotting area and is represented by a set of axes. 
The rectangular area surrounding the graph is referred to as the graph box. A graph will appear in the 
Graphics area when you select Start to commence a Thermal run. 

The Graph menu can be accessed in the following ways:  

from the main menu at the top of the Thermal Application window
by clicking the right mouse button in a graph box or the Graphics area

Menu commands 

The following commands can be accessed from the Graph menu: 

Graph menu—Thermal 

Note 
The red trace in any graph box is the one on which all information appears and the one used for the 
cursor tracking. It is called the focused trace.

Menu 
command 

Button Enables you to…

Print XY 
point 

Select this to print the cursor's current X and Y coordinates in the report area. 
Note: 
This option is only available from the Graph menu that appears when you 
right-click in a graph box.

Copy 
Graph 

Select Copy Graph to copy the entire Graphics area to the Windows Clipboard. 
All of the graphs in the Graphics area will be copied to the Clipboard.

Paste to 
Graph 

Select Paste to Graph to paste the contents of the Windows Clipboard into the 
Graphics area. Text is pasted as a label, graphics are pasted as pictures.

Add Graph  Select Add Graph to add a new graph box to the Graphics area. You may want 
to do this if you have, for example, a graph containing existing data and you 
want to collect some new data in a new graph.

Remove 
Graph  

Select Remove Graph to delete the selected graph box from the Graphics area. 
The graph box is removed, but the data is not deleted and is still available from 
the Trace Preferences window. 
You may want to use remove graph if you have a large number of graph boxes 
open but only want to focus on some of these. 

Note: 
You can remove multiple graph boxes by first holding down the CTRL 
key and selecting the graphs to be removed and then selecting the Remove 
Graph button or menu item. Use the SHIFT key to highlight a range of 
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graphs for removal.

Clear All 
Traces 

Select Clear All Traces to delete all traces from the graph/s. Note that selecting 
this option simply turns off the Visible property for the traces in the Trace 
Preferences window. You can redisplay the traces by making the traces Visible 
again in the Trace Preferences window.

Add Label  Select Add Label to display the Add Label dialog where you can enter a text 
label to be placed on a graph or in the background of the Graphics area. 

Add Picture Select Add Picture to display the Add Picture dialog where you can select a 
picture, bitmap or chemical structure to be placed on a graph or in the 
background of the Graphics area. 

Edit 
Annotation 

Select Edit Annotation to alter the content or look of the selected annotation, 
(either a label or a picture) in the Graphics area. 

If the selected annotation is a label, selecting Edit Annotation will open the 
Edit Label dialog where you can change the text of the selected label. 
If the selected annotation is a picture, selecting Edit Annotation will open the 
Edit Picture dialog where you can replace the selected picture with a new 
picture. 

Note: 
This option can only be activated if an annotation is selected.

Delete 
Annotation  

Select Delete Annotation to remove an annotation, (such as a label or a picture) 
from the Graphics area. 
You can use this menu option to remove highlighted annotations in the Graphics 
area such as labels, pictures and ruler/fit information. 

Note: 
This option can only be activated if an annotation is selected.

Trace 
Preferences 

Select this command to display the Trace Preferences dialog where you can 
select the trace(s) to display in the selected graph.

Graph 
Preferences 

Select this command to display the Graph Preferences dialog where you can 
change the appearance of your graph. Any changes you make to the appearance 
of the graph will be applied to all graphs.

Cursor 
Mode… 

Select this command to display the Cursor Modes dialog where you can choose 
the type of cursor to be used on the screen. For example, you can select to use a 
free cursor that can move anywhere in the graph or exactly trace the focused 
thermal (red thermal).  Alternatively, you can select a cursor that enables you to 
draw a line from one point to another to determine the slope using either the 
Least Squares method or the Point to Point method.

Axes 
Scales…  

Select this command to display the Axes Scales dialog where you can set the 
scale range for the X and Y axes.

Auto scale 
graph 

To automatically scale the graph, point to one of the following options: 

Autoscale[XY] 
Select Autoscale[XY] to automatically scale collected data by scaling the Y 
height and X width to full screen. 
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Graphics Toolbar—Thermal 
Use the Graphics toolbar buttons to gain quick access to many of the Graph menu options. You can also 
use the toolbar to select the graph you want to view and to change the look of your graphs. 

Autoscale[X] 
Select Autoscale[X] to automatically scale collected data by scaling the X width 
to full screen. 

Autoscale[Y] 
Select Autoscale[Y] to automatically scale collected data by scaling the Y height 
to full screen. 

Zoom Out Select Zoom Out to Zoom back to the original X and Y ranges which were used 
to collect the data (i.e. the method setup conditions of the focused thermal).  
For example, the system will revert back to the X and Y ranges set in the method 
if you zoom in and out during a data collection.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note: 
The graph highlighted in the Multi Graph view will be displayed when 
you toggle the Single Graph option.

Auto 
Arrange 
Graphs 

Select Auto Arrange Graphs to view and arrange all graphs simultaneously. 
Note: 
You can move graph boxes manually by clicking the left mouse button 
outside the graph axes and dragging the graph box to a new position. You 
can also resize graphs.

User Data 
Form  

Select User Data Form to display the User Data Form where you can enter 
extra information about the traces in the highlighted graph box. For example, 
you might want to record information about the experimental conditions you 
used to collect the data, such as the pH at which data was collected.

Maths Select Maths to display the Maths window where you can perform 
mathematical manipulations on collected traces. In addition, it can act as a 
simple numeric calculator.

History List This displays a list of the current graphs. 

See also: 
Add Label   
Add Picture   
Edit Label   
Edit Picture    
Trace Preferences  
Graph Preferences  
Cursor Modes   
Axes Scales   
Single/Multi Graph   
User Data Form   
Maths   
Graphics toolbar 
Graphics area
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To display or hide the toolbar, point to the Toolbars option in the View menu and select Graphics. To 
display or hide the toolbar's text labels, point to the Toolbars option in the View menu and select Text 
Labels. 

The following commands can be accessed from the Graphics toolbar: 

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to…

Trace 
Preferences  

Click this button to display the Trace Preferences window where you can 
select the trace(s) to display in the selected graph.

Graph 
Preferences 

Click this button to display the Graph Preferences dialog where you can 
change the appearance of your graph. Any changes you make to the appearance 
of the graph will be applied to all graphs.

Cursor 
Mode 

Click this button to display the Cursor Modes dialog where you can choose the 
type of cursor to be used on the screen. For example, you can select to use a 
free cursor that can move anywhere in the graph or exactly trace the focused 
scan (red scan).  Alternatively, you can select a cursor that enables you to draw 
a line from one point to another to determine the slope using either the Least 
Squares method or the Point to Point method.

Axes 
Scales…  

Click this button to display the Axes Scales dialog where you can set the scale 
range for the X and Y axes.

Autoscale
[XY] 

Click the Autoscale[XY] button to automatically scale collected data by scaling 
the Y height and X width to full screen.

Autoscale
[X] 

Click the Autoscale[X] button to automatically scale collected data by scaling 
the X width to full screen.

Autoscale
[Y] 

Click the Autoscale[Y] button to automatically scale collected data by scaling 
the Y height to full screen.

Zoom Out Click the Zoom Out button to Zoom back to the original X and Y ranges which 
were used to collect the data (i.e. the method setup conditions of the focused 
scan).  
For example, the system will revert back to the X and Y ranges set in the 
method if you zoom in and out during a data collection.

Add Label  Click this button to display the Add Label dialog where you can enter a text 
label to be placed on a graph or in the background of the Graphics area. 

Add Picture  Click this button to display the Add Picture dialog where you can select a 
picture, bitmap or chemical structure to be placed on a graph or in the 
background of the Graphics area.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
Note: 
The graph highlighted in the Multi Graph view will be displayed when 
you toggle the Single Graph option.
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Auto 
Arrange 
Graphs 

Click the Auto Arrange Graphs button to view and arrange all graphs 
simultaneously. 

Note: 
You can move graph boxes manually by clicking the left mouse button 
outside the graph axes and dragging the graph box to a new position. You 
can also resize graphs.

Add Graph Click this button to add a new graph box to the Graphics area. You may want to 
do this if you have, for example, a graph containing existing data and you want 
to collect some new data in a new graph.

Remove 
Graph 

Click this button to delete the selected graph box from the Graphics area. The 
graph box is removed, but the data is not deleted and is still available from the 
Trace Preferences window. 
You may want to use remove graph if you have a large number of graph boxes 
open but only want to focus on some of these. 

Note: 
You can remove multiple graph boxes by first holding down the CTRL 
key and selecting the graphs to be removed and then selecting the 
Remove Graph button or menu item. Use the SHIFT key to highlight a 
range of graphs for removal.

Clear All 
Graphs 

Click this button to delete all traces from the graph/s. Note that selecting this 
option simply turns off the Visible property for the traces in the Trace 
Preferences window. You can redisplay the traces by making the traces Visible
again in the Trace Preferences window.

User Data 
Form 

Click this button to display the User Data Form where you can enter extra 
information about the traces in the highlighted graph box. For example, you 
might want to record information about the experimental conditions you used to 
collect the data, such as the pH at which data was collected.

Calculator Click this button to display the Maths window where you can perform 
mathematical manipulations on collected traces. In addition, it can act as a 
simple numeric calculator.

See also: 
Add Label   
Add Picture   
Edit Label   
Edit Picture    
Trace Preferences  
Graph Preferences  
Cursor Modes   
Axes Scales   
Single/Multi Graph   
User Data Form   
Maths  
Graphics area 
Graph menu 
Graphics How to
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Graph Labels—Thermal 
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label

Use the Add Label dialog to place a label on your graph or into the background of the Graphics area.  

To add a label to a graph box, you must have at least one trace Visible in the graph box. (You can select 
which traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple 
graphs, the label will be placed in the graph box that is currently selected. However, you can add a label 
outside of a graph box in the background of the Graphics area at any time. 

The Add Label dialog comprises the following: 

Add Label—Thermal 

Q. Can I add a label that will print with all my graphs.
A. Yes, you can add your label to the background of the Graphics area. To do this, right-click on a
section of the background (gray area) and select Add Label from the menu. (You will notice that
this menu has less options than the menu that appears when you right-click on a graph.) In the Add
Label dialog, enter the label to be added to all graphs and select OK. The label will appear in the
background of the Graphics area.

To access the Add Label dialog, select the Add Label command from the Graph menu, or select 
the Add Label button on the Graphics toolbar.

To selected 
trace

Select this option to associate a label with the selected trace. When you associate a label 
with a trace and make the trace visible in the Graph box, the label will also be displayed 
with the trace.

To selected 
graph

Select this option to associate the label with the selected graph. When you associate a 
label with a graph, the label will always be displayed in the Graph box, regardless of 
what traces are visible.

Selected trace This will identify the trace that is currently selected and display the name of the trace.
Font… Click Font to open the Windows Font dialog. In this dialog you can specify the font 

type, style and size to be used for the label.
Label Use the Label field to enter the text for the label. You can enter as many lines of text as 

you require.
Hot Tip 
If you wish to include certain XY co-ordinates on the graph as a label, position your cursor at the 
appropriate place, right-click and select Add Label from the menu. When the Add Label dialog 
appears, the co-ordinate positions will be added to the Label field. 

Note 
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Use the Edit Label dialog to alter the content or look of your label. 

To access the Edit Label dialog, right-click on the label you wish to change and select Edit Annotation 
from the menu. 

The dialog comprises the following: 

How to add a label to a graph—Thermal 
You can add a label to your graph or Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area 
background. 

Step 2 

Click the Add Label button on the toolbar or right-click on the graph and select Add Label from the 
menu. The Add Label dialog will appear. 
The Add Label command is also accessible from the Graph menu.

When you save the data (as a Batch or Data file) the label is saved with its associated trace or 
graph. Labels outside graph boxes can be saved in a graphics template. To do this, choose Graph 
Template as the Save As type in the Save As dialog. 
See Example of a Graphics Template 

See also: 
Trace Preferences dialog  
Graph menu  
Graphics toolbar  
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label  
How to delete a label

Edit Label—Thermal 

Font Select Font to open the Font dialog, where you can specify the font type, style and size 
to be used for the label.

Label Use the Label field to alter the text for the label. 

See also: 
How to edit a label 
How to add a label to a graph 
How to move a label

Note 
There must be at least one trace Visible in the graph box before you can add a label to it.
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Step 3 

Click the Font button. The Windows Font dialog appears. Select the font type, size and style you require 
for your label. A sample of the font style appears in the Sample field. When you are satisfied with your 
selections, select OK to return to the Add Label dialog. 

Step 4 

Enter the label in the Label field and select OK. The label will be displayed on the selected graph. If 
necessary, you can move a label so that it is more appropriately placed on your graph. 

How to edit a label—Thermal 
Step 1  

Place the cursor on the label and click the left mouse button to select the label. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu. Alternatively you 
can select the Edit Annotation command from the Graph menu. The Edit Label dialog is displayed. 

Step 3  

Use the Edit Label dialog to change the label. 

For example, if you want to change the font size of the label, select the Font button. In the Size field, 
scroll through the available sizes for the font and select the size you require. Alternatively, highlight the 
currently selected size in the Size entry field and enter the size you require. Click the OK button in this 
dialog to return to the Edit Label dialog. 

Step 4  

Click OK to clear the Edit Label dialog. Your label will appear with the new font size. 

See also: 
Graphics Area 
How to move a label 
How to edit a label  
How to resize a label

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label 
selection. Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label  
How to resize a label 
How to delete a label
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How to move a label—Thermal 
To move a label so that it is more appropriately placed on your graph or Graphics area background, do 
the following: 

Step 1  

Place the cursor on the label. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the label to the correct position and release the mouse button. The label will be displayed at the new 
position. 

How to resize a label—Thermal 
To resize a label so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the label by clicking on it with the mouse. A border will be displayed around the label to indicate it 
is selected. 

Step 2  

Position the cursor over one of the corner edges of the label until the cursor becomes a diagonal double-
headed arrow. Click and hold down the left mouse button.

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label  
How to resize a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.
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Example of label showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the label by dragging the mouse. The label text will also be resized. 
Release the mouse button when the label and text are the correct size. 

How to delete a label—Thermal 
To delete a label from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the label and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The label will be 
deleted from the graph or Graphics area. 

Graph Pictures—Thermal 
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label 
selection. Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label
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How to delete a picture

Use the Add Picture dialog to insert a picture or bitmap into the Graphics area. The picture can be added 
as a background picture or to a particular graph box. 

To add a picture to a graph box you must have at least one trace Visible in the graph box. (You can select 
which traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple 
graphs, the picture will be placed in the graph box that is currently selected. However, you can add a 
picture outside of a graph box in the Graphics area at any time. 

The Add Picture dialog comprises the following commands: 

Add Picture—Thermal 

Q. Can I add a picture that will print with all my graphs.
A. Yes, you can add your picture to the background of the Graphics area. To do this, right-click on a
section of the background and select Add Picture from the menu. (You will notice that this menu
has less options than the menu that appears when you right-click on a graph.) In the Add Picture
dialog, load the picture to be added to all graphs and select OK. The picture will appear in the
background of the Graphics area.

To access the Add Picture dialog, select the Add Picture command from the Graph menu, or 
select the Add Picture button on the Graphics toolbar.

To selected 
trace

Select this option to associate a picture with the selected trace. When you associate a 
picture with a trace and make the trace visible in the Graph box, the label will also be 
displayed with the trace.

To selected 
graph

Select this option to associate the picture with the selected graph. When you associate a 
picture with a graph, the label will always be displayed in the Graph box, regardless of 
what traces are visible.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer 
for the picture you want to insert. The picture must be one of the following formats: 
DIB, JPG, JPEG, BMP, EMF or WMF. 

If you are viewing multiple graphs the picture will be placed on the graph that is 
currently selected. If no graph is selected, the picture will be placed on the Graphics area 
background. 

Note 
When you save the data (as a Batch or Data file) the label is saved with its associated trace or graph. 
Labels outside graph boxes can be saved in a graphics template. To do this, choose Graph 
Template as the Save As type in the Save As dialog. 
See 'Example of a Graphics Template'. 

See also: 
Trace Preferences  
Graph menu  
Graphics toolbar 
How to add a picture to a graph 
How to move a picture 
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Use the Edit Picture dialog to change a picture you have inserted into the Graphics area.  

To access the Edit Picture dialog, right-click on the picture you wish to change and select Edit 
Annotation from the menu. 

The Edit Picture dialog comprises the following commands: 

How to add a picture to a graph—Thermal 
You can add a picture to your graph or the Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area 
background. 

Step 2 

Click the Add Picture button on the toolbar or right-click on the graph and select Add Picture from the 
menu. The Add Picture dialog will appear. 
The Add Picture command is also accessible from the Graph menu. 

Step 3 

Click the Load button. The Windows Open dialog appears. 

Step 4 

How to delete a picture 
How to resize a picture 
How to replace a picture

Edit Picture—Thermal 

To selected 
trace/ graph

Displays whether you originally selected to add the picture to a trace or a graph. This 
option is not editable.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer 
for the picture you want to insert. The selected picture will replace the current picture. 
The picture must be one of the following formats: DIB, JPG, JPEG, BMP, EMF or 
WMF. 

See also: 
How to replace a picture 
How to add a picture 
How to move a picture  
How to resize a picture 
How to delete a picture

Note 
There must be at least one trace Visible in the graph box before you can add a picture to it.
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Browse through your directories to find the picture you want to insert. All pictures must be in the bitmap 
format and will have the extension .BMP. 

Step 5 

Highlight the .BMP that you want to insert and select Open. 

Step 6 

The Add Picture dialog will appear showing a preview of the bitmap. If the bitmap is the correct one 
select the OK button. The bitmap will be placed onto the graph. 

You can move a picture so that it is more appropriately placed on your graph. 

How to replace a picture—Thermal 
To change a picture that you have added to a graph or Graphics area background do the following: 

Step 1  

Move the cursor to the picture and select the left mouse button to select it. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu or select Edit 
Annotation from the Graph menu. The Edit Picture dialog is displayed. 

Step 3  

From the Edit Picture dialog, select the Load button. The Windows Open dialog is displayed. 

Step 4  

Browse through your directories to find the picture to replace the current bitmap. Picture files must be in 
one of the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

Step 5  

Note 
You should take care not to add a bitmap that is too big as it will obscure part or all of your graph.

See also: 
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.
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Highlight the file that you want to insert and select Open to return to the Edit Picture dialog.

Step 6  

The Edit Picture dialog will display a preview of the bitmap. If the bitmap is the correct one select the 
OK button. The bitmap will be placed onto the graph. If you need to, move the picture so that it is more 
appropriately placed on your graph. 

How to move a picture—Thermal 
To move a picture so that it is more appropriately placed on your graph or Graphics area background, do 
the following: 

Step 1  

Place the cursor on the picture. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the picture to the correct position and release the mouse button. The picture will be displayed at the 
new position. 

How to resize a picture—Thermal 
To resize a picture so that it is more appropriately sized on your graph or Graphics area background, do 
the following: 

Note 
Do not to add a bitmap that is too big as it will obscure part or all of your graph. 

See also: 
How to add a picture to a graph 
How to move a picture 
How to delete a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture
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Step 1  

Select the picture by clicking on it with the mouse. A border will be displayed around the picture to 
indicate it is selected. 

Step 2  

Position the cursor over one of the corner edges of the picture until the cursor becomes a diagonal 
double-headed arrow. Click and hold down the left mouse button. 

Example of picture showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the picture by dragging the mouse. The picture will also be resized. 
Release the mouse button when the picture is the correct size. 

How to delete a picture—Thermal 
To delete a picture from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the picture and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph  
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.
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Alternatively, you can select the Delete Annotation command from the Graph menu. The picture will be 
deleted from the graph or Graphics area. 

Trace Preferences table | Trace Audit Log 

A single graph box can display many traces. This window enables you to select the trace(s) to display 
(make Visible) in the selected graph box.  

The dialog comprises the following: 

Trace Preferences table 

See also: 
How to add a picture to a graph 
How to move a picture 
How to zoom a graph  
How to resize a picture

Trace Preferences—Thermal 

To access the Trace Preferences dialog, select the Trace Preferences command from the Graph 
menu, or select the Trace Preferences button on the Graphics toolbar.

Hot Tip 
The Trace Preferences menu is also available on clicking the right mouse button anywhere in the 
trace listing.

Visible Use the Visible field to select which traces will appear on the selected graph. To select 
or clear the Visible field, simply click the left mouse button in this column. A tick will 
appear next to traces that are to be displayed in the selected graph. 

If you are in single graph view, all selected traces will appear on the one graph. If you 
are in Multi Graph view the traces will appear on the graph that is currently selected. 

Hot Tip 
To make all traces Visible, right-click on the table and select the Select All 
command from the menu. Then right-click on the table again and select the Show 
Traces command from the menu.

Color The Color field enables you to view the color of each trace that appears on the selected 
graph.  To change the color of a trace, highlight it, click the right mouse button in the 
Trace Preferences table and select Change Trace Color. You can then select a color 
from the Color dialog that is displayed. 

The red trace in any graph box is the one on which all information appears. This trace, 
which is used for the cursor tracking, is called the focused trace and it is always red. 
When you select a trace in the Color column it will become the focused trace in the 
selected graph box.  

Note 
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Trace Audit Log 

The Trace Audit Log displays information about the highlighted trace. This includes instrument 
parameters and data form information relating to the trace that has been selected. It also logs all 
information about data manipulation.  When more than one trace is highlighted, the Trace Audit Log 
will display information about the trace that was first selected. 

Trace Preferences menu—Thermal 
The Trace Preferences menu is displayed when you click the right mouse anywhere on the Trace 
Preferences table. The menu contains the following commands: 

When you change the trace line width in the Graph Preferences dialog it also 
will change the width of the color trace line in this dialog.

Name of 
trace 

The Name of Trace field contains a description of the traces currently available for 
display in the selected graph box.

Filename This field displays the filename and path for the trace. If the name is too long to appear 
in the field you can use the keyboard arrow keys to scroll to the end of the filename or 
you can resize the Trace Preferences window. If the file path for a trace shows 'not 
saved' then the trace is unsaved data and is only stored in memory.

See also: 
Graph menu 
Graphics toolbar 
Graph Preferences  
Trace Preferences menu  
How to remove a trace from the trace list 
How to remove a trace from a graph

Select All This selects or highlights all the traces in the listed on the Trace Preferences page.
Select None This de-selects all the traces in the listing.
Show Traces Select Show Traces to make all of the traces currently highlighted Visible, meaning 

that they will be displayed in the current graph box.
Hide Traces Select Hide Traces to remove the Visible property from all the traces currently 

highlighted, which will remove them from the current graph box.
Delete Traces Select Delete Traces to delete all the highlighted traces in all graphs. Note that if you 

save the data file before you select Delete Traces, the traces are not deleted from the 
saved file, and they can be retrieved at a later date. 
Selecting Delete Traces will delete the traces from the application memory, and it is 
recommended that you select this option if you need to free up memory on your 
computer. This is especially relevant for the Thermal application where the data files 
can be quite large. 

Note 
If the application is controlled by the GLP Administration application, you will be 
prompted to save an unsaved data file before it is removed from the application. 

Change Select Change Trace Color to display the Windows Color dialog where you can 
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How to select the focused trace—Thermal 
To select the thermal that you want to be the focused (red) trace, do one the following:  

From the Graph, click the left mouse button on the trace that you want to make the focused trace.

From the Graph Legend (if displayed), click the left mouse button on the trace that you want to
make the focused trace.

From the Trace Preferences dialog, click in the Color column of the trace that you want to make
the focused trace.

How to display a trace that is not appearing in the graph box—
Thermal 
Step 1 

Click on the graph in the Graphics area. 

Step 2 

Select the Trace Preferences button  from the Graphics toolbar, or select Trace Preferences from 
the Graph menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you wish to see and select the Visible option. A tick will appear in the Visible column 
to indicate that it will now be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you want to display.

b. Click the right mouse button and select the Show Traces command from the drop-down menu.

Trace Color change the color of the currently highlighted trace(s). The focused trace will remain red 
while it retains the focus, and will revert to the selected color when the focus is moved.

See also: 
Trace Preferences page 
Graph Preferences page 
How to remove a trace from the trace list 
How to remove a trace from a graph

Note 
Select the Show Legend check box in the Graph Preferences dialog to display the Graph Legend.

See also: 
How to track the focused trace 
How to view a particular trace
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Ticks will appear next to the selected traces to indicate that they will now be displayed. 

Step 4 

Press OK to clear the Trace Preferences dialog. The selected trace(s) will be displayed. 

How to remove a trace from a graph—Thermal 
Step 1 

Select a graph in the Graphics area. 

Step 2 

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the 
Graph menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you no longer wish to see and select the Visible option. The tick will be removed 
from the Visible column to indicate that it will not be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you no longer want to display.

b. Click the right mouse button and select the Hide Traces command from the drop-down menu. The
ticks will be removed from the selected traces to indicate that they will not be displayed.

Step 4 

Select OK to clear the Trace Preferences dialog. The trace will be removed from the graph. 

How to remove a trace from the trace list—Thermal 
If your graphs contain unwanted traces, you may wish to delete them (rather than simply making them 
invisible) in order to free up application memory and aid system performance. 

Step 1  

Select a graph in the Graphics area. 

See also: 
How to remove a trace from a graph 
How to remove a trace from the trace list

See also: 
How to display a trace that is not appearing in the graph box 
How to remove a trace from the trace list
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Step 2  

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the 
Graph menu. The Trace Preferences dialog is displayed. 

Step 3  

Select the trace to be removed by clicking on it. 

Step 4  

Click the right mouse button to display the Trace Preferences menu. 

Step 5  

Select Delete Traces to delete the sample from the trace list. You will be prompted to confirm this action.

Step 6  

Select OK to clear the Trace Preferences dialog. The trace will be removed from all graphs. 

Axes Preferences | Advanced Options | Trace Style | Show Legend 

Introduction 

Use the Graph Preferences dialog to change the appearance of your graph.  

All graphs will appear labeled with the X axis label being horizontal and the Y axis vertical. You cannot 
change the orientation of these labels. However you can alter the font and size of the axes and their 
labels. 

Any changes you make to the appearance of the graph will apply to all graphs until the settings are 
changed again. 

Dialog controls 

The Graph Preferences dialog comprises the following: 

Axes Preferences 

See also: 
How to remove a trace from a graph 
How to display a trace that is not appearing in the graph box

Graph Preferences—Thermal 

To access the Graph Preferences dialog, select the Graph Preferences command from the 
Graph menu, or select the Graph Preferences button on the Graphics toolbar.
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Advanced Options 

Trace Style 

Axes Color Select the color that you want to assign to the axes of the graph/s from the drop down 
list.

Axes Width Select the width of the axes from the drop down list. The width, which is in pixels, 
ranges between one and five pixels.

Grid Style Select the style of grid for the graph from the drop down list. If you do not wish to 
include a grid on the graph, select None.

Plot Area 
Color

Select the color to be used as the background of the graph from the drop down list. If 
you do not want a background color on the graph, select White.

Trace Width Select the width of the trace from the drop down list. The width is given in pixels and 
ranges between one and five pixels.

Font Click the Font button to display the Windows Font dialog where you can define the 
font style for the axes of the graph/s. The style and size of the font will be applied to all 
graph. The style, name and point size of the font appears on the font button.

Preview Box Preview any changes you make to the axes preferences in the preview box. The 
changes shown in this box will not be made until you select OK.

Auto tick 
marks

The Auto tick marks option enables you to approximately set how many tick marks 
(or points) will be included on the graph axes. The tick marks generated will be whole, 
rounded, even numbers. The Auto tick marks option is not available if you have 
selected Major ticks. 

Y-axis
Use the Y-axis slider bar to increase or decrease the number of tick marks (or points) to
be included on the Y axis.

X-axis
Use the X-axis slider bar to increase or decrease the number of tick marks (or points) to
be included on the X axis.

Major ticks Use the Major Ticks option to enable you to set exactly how many ticks (or points) 
will be added to the X and Y axes. The number of marks you specify will be divided by 
the axis range, which can result in odd numbers on the axis. Note that any changes are 
not reflected in the graph bitmap at the top of the screen.

Decimals Use the Decimals option to set the number of X and Y decimal places to be displayed 
on the axes. To set the number of decimal places, select the Decimal option and enter 
the number in the Y-axis and X-axis combo boxes. Note that any changes are not 
reflected in the graph bitmap at the top of the screen.

Points Select Points to display each individual data point collected by the Cary Eclipse on the 
graph.
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Show Legend 

How to alter the look of your graphs—Thermal 
Step 1 

Click the Graph Preferences button  on the Graphics toolbar, or select Graph Preferences from the 
Graph menu. The Graph Preferences dialog is displayed. 

Step 2 

Use the available options available to choose your preferred appearance for the graphs. A preview box in 
the top right-hand corner will demonstrate how the graphs will appear. 

Step 3 

Select OK to clear the Graph Preferences dialog and update all graphs to reflect your selections. 

Step 4 

Points and  
solid lines

Select Points and solid lines to display each individual data point collected by the 
Cary Eclipse on the graph. Additionally, an interpolated line that connects the points 
will be drawn.

Solid lines If you select Solid lines, the Cary Eclipse system will interpolate the data between the 
actual, collected data points and show the data as a continuous line.

Style cycles 
automatically

If you select Style cycles automatically, the Cary Eclipse system will display each of 
the above three trace styles. This makes it easier to differentiate between traces, 
especially on black-and-white printers.

Show Legend Select Show Legend to display a legend in the right side of each graph box. 
A single left click on a sample name or example line within the legend will make it the 
focused or red thermal. Information about the trace will be displayed below the X axis. 

Hot Tip 
Double-clicking on the legend will automatically display the Trace Preferences 
window, allowing you to view more detailed information about your trace (e.g. 
audit log, File name, etc.). 
You can also use the legend to select which trace will be the focused trace. 

See also: 
Graph menu 
Graphics toolbar 
Graphics area 
Graphics How To

Note 
You can also add labels and pictures to your graphs to alter their appearance. 
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To re-use your graphics setup at a later date, save the setup as a graphics template. 

Use the Cursor Modes dialog to choose the type of cursor to be used on screen. For example, you can 
select to use a free cursor that can move anywhere in the graph.  

The dialog comprises the following: 

How to track the focused trace—Thermal 

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture 
How to resize graph boxes 
How to make a graphics template

Cursor Modes—Thermal 

To access the Cursor Modes dialog, select the Cursor Modes command from the Graph menu, or 
select the Cursor Modes button on the Graphics toolbar.

Free The Free cursor is not confined to a particular trace on the graph. It can move 
anywhere in a graph box, and its ‘X,Y’ position is shown in the bottom right-hand side 
of the Graphics area. You can use the Free cursor to zoom in on a particular part of a 
graph. 

Note 
The Free cursor moves from point to point in the selected graph box. Hence you 
need to be careful when positioning the cursor over a thermal to obtain an 
accurate (X,Y) reading. It is recommended that you use the Track cursor mode 
for this.

Track Use the Track cursor to exactly trace the focused (red) thermal in a graph box. The 
cursor position is displayed in the X and Y at the bottom right-hand side of the 
Graphics area. 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the 
cursor to the required position. Click the left mouse button, press ALT on the 
keyboard, then release the mouse button.

Track 
Intensity

Select the Track Intensity option if you want to associate an intensity value with the 
tracking. The cursor will then track from point to point on the continuum between the 
intensity value you enter. The default value will be 50% of the maximum intensity of 
the focused continuum.

Peaks type Choose from the options of Peaks, Valleys or Peaks Valleys to move the cursor from 
peak to peak, valley to valley or from one peak/valley to the next.

See also: 
How to zoom a graph 
How to track the focused trace
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To track the focused (red) trace in the graph:

Step 1  

Click the Cursor Modes button  from the Graphics toolbar, or select Cursor Mode from the Graph 
menu. The Cursor Modes dialog will appear. 

Step 2  

Select Track and select the OK button. 

Step 3  

Place the blue tracking cursor in the graph box you require. 

Step 4  

Move the cursor left and right across the graph box to trace the focused (red) thermal. The cursor 
coordinates change (in the X, Y field at the bottom left hand corner of the Graphics area) as you move 
along the curve. 

Use the Axes Scales dialog to manually change the axes range. This can assist in zooming in on a 
particular part of the graph. 

The dialog comprises the following: 

X Axis 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the required 
position. Press 'Alt' on the keyboard, then release the mouse button. 

See also: 
How to select the focused trace 
How to view a particular trace

Axes Scales—Thermal 

To access the Axes Scales dialog, select the Axes Scales command from the Graph menu, or 
select the Axes Scales button on the Graphics toolbar.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the X axis, in the format n1 - n2 (where n1 is 

the start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can 
access by selecting the down arrow adjacent to the Scale field.
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Y Axis 

How to scale your graph manually—Thermal 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

Click the Axes Scales button  on the toolbar, or select Axes Scales from the Graph menu. The Axes 
Scales dialog id displayed. 

Step 3  

Type in the new ranges for the X and Y axes in the format ‘n-n’, or choose an option for each from the 
drop-down list. 

Step 4  

Select OK. The axes on the selected graph will change to reflect your chosen settings. 

How to scale your graph automatically—Thermal 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the Y axis, in the format n1 - n2 (where n1 is 

the start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can 
access by selecting the down arrow adjacent to the Scale field.

See also: 
Graph menu  
Graphics toolbar  
How to scale your graph manually 
How to scale your graph automatically 
How to zoom a graph

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale a graph automatically
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To autoscale the graph, select one of the following: 

Click the Autoscale XY button  on the toolbar to autoscale both X and Y axes.  

Click the Autoscale X button  on the toolbar to autoscale the X axis only.  

Click the Autoscale Y button  on the toolbar to autoscale the Y axis only.  

The focused trace will be scaled according to the option selected. 

You can use the Single/Multi Graph command to toggle between a display of either one or multiple 
graph boxes in the Graphics area.  

Example of a single graph box display 

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale your graph manually

Single/Multi Graph—Thermal 

The command is accessible from the Graph menu or by selecting the Single/Multi Graph button 
from the Graphics toolbar.
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Example of a multi graph box display 

How to make a graphics template—Thermal 
A graphics template lets you set up and store the style of a graphics report for future use. You can do this 
by adding labels and pictures to the background of the Graphics area and altering any axes styles etc. One 
advantage of this over the application's built-in reporting features is that you have more flexibility as to 
where you can position graph boxes and any text that you may want to appear (e.g. operator name, batch 
number etc.) and also where you add pictures, e.g. company logos etc.  

Step 1 

Start the application and open the data file from which you want to make a graphics template. 
Alternatively, collect some new data. 

Step 2 

Make as many graph boxes as you require in your template by using the Add Graph function. 

Step 3 

Adjust the graph boxes to the correct size and position them as you want them to appear in the template. 

Step 4 

Do any of the following, if required: 

Change the appearance of the graph boxes in the Graph Preferences dialog
Use the Add Label function to append text to the Graphics area
Use the Add Picture function to add pictures, such as your company's logo to the Graphics area

Step 5 

From the File menu, select Print Preview. Use the Print Preview dialog displayed to check the template 
that you have created. 

Step 6 

When you are satisfied with the appearance of the graphics, select the Save As… command from the File
menu. The Save As dialog is displayed. 

Step 7 

Note 
Up to 100 graphs can be displayed in the Graphics area at the one time. 

See also: 
Graph menu   
Graphics toolbar  
Graphics How To
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A list of stored data files will appear. Select the down arrow at the right of the Files of type field and 
select 'Graph Template' to list all the template files. Ensure that the Save only focused trace check box is 
cleared. 

Step 8 

Enter a name for the template in the File name field. 

Step 9 

Select OK to save the graphic template. The template will be used each time you create a new file. 

Example of a Graphics Template—Thermal 
By using the Add Label command in the Cary Eclipse graphics system, you can customize a graphics 
template such as the one shown below: 

The above is created as follows:  

Note 
You can also make a graphic template in a similar manner from existing data. No data will be saved 
in the template. 

See also: 
Example of a Graphics Template 
How to add a label to a graph  
How to add a picture to a graph  
How to move a label  
How to move a picture
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The graph on the left is the collected data.
The text on the top right is a multi-line label (added using the Add Label command).
The logo is an inserted picture (added using the Add Picture command).

Examples—Thermal 
User Collect
Multi-stage thermal run
Example of a graphics template

Example of a multi-stage thermal run—Thermal 
Number of Stages = 3 

The Ave Time is set to 1.0 s 

Graphical representation of data points for the above example 

Stage 1: 10°C - 30° C. The run will commence taking data readings at the set Ave Time of 1.0 s every 
0.5°C. Once the stage one end temperature of 30°C is achieved it will hold this temperature for 5.0 
minutes before proceeding to stage two.  

Stage 2: 30°- 65° C. The run will continue taking data readings at the set Ave Time of 1.0 s every 0.1°C. 
Once the stage two end temperature of 65°C is achieved it will hold this temperature for 2.0 minutes 
before proceeding to stage three.  

Stage 3: 65° - 85° C. The run will continue taking data readings at the set Ave Time of 1.0 s every 0.5°C. 
Once the stage three end temperature of 85°C is achieved it will hold this temperature for 2.0 minutes 
before proceeding to the return to temperature of 20°C.  

See also:
Add Label
How to make a graphics template
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File Management—Thermal 
File menu
Open dialog
Save As dialog
Filename extensions
ASCII spreadsheet file
Auto Store page
How to perform post run calculations on previously stored data
How to combine data files into a batch file
How to export collected data
How to combine data files into a batch file

File menu—Thermal 
Use the File menu to open or save a method or data file, print or preview a report, or exit the Cary Eclipse
application. 

The following commands can be accessed from the File menu: 

See also: 
Example of a User Collect

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open 
it. Any data will be displayed in the Graphics area.

Command What it does…
New Select New to clear all method, report and graphics information and create a new file 

containing the default settings.
Open 
Method… 

Select Open Method to display the Open dialog where you can search for and load a 
stored method. 

Open… Select Open to display the Open  dialog where you can search for and load method, 
data, report, graph template and batch files, as well as other file types compatible with 
the Cary Eclipse software. When you load a batch file, the method which collected the 
data is loaded as well as the associated report and graphics layout.

Save Method 
As… 

Select this option to display the Save As dialog and store the current method. You can 
use the Save As dialog to store the method, data, report, or graphics template separately 
or together as a Batch file. The data can also be saved as a comma delimited ASCII 
Spreadsheet file.

Save As… Select this option to display the Save As dialog and store the collected data. You can 
use the Save As dialog to store the method, data, report, or graphics template separately 
or together as a Batch file. The data can also be saved as a comma delimited ASCII file.

Print 
Setup… 

Select this option to display the Windows Print Setup dialog where you can select the 
printer, printer page size and orientation.

Print Select this option to display the Print Preview dialog where you can view the current 
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Look in | File name | Files of type | Overlay Data | Open 

Use the dialog to open a file previously saved by the application. To access the Open dialog, select Open 
or Open Method from the File menu. 

Preview… report as it will be printed.
Print… Select this option to display the Windows Print dialog where you can choose the 

printer and pages to print as well as the number of copies you wish to print.
Explorer… Select this option to run Windows Explorer. This may help you locate method and data 

files.
History List This displays a list of the four most recently opened files.
Exit Select this option to exit the Thermal application. 

See also: 
Open   
Save As   
Print Preview   
Filename Extensions 
ASCII Spreadsheet File

Open—Thermal 

Look in The Look In field lists the available folders and files. Click the down arrow on the right 
of this field to view the location of the current folder in your computer's hierarchy. You 
can also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In 
field. 

Note 
To open the folder in the level that is one higher than the current folder, select 

 on the toolbar.

Look in list 
box  

The Look In List Box, which is directly below the Look In field, displays the folders 
and files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted 
text entry field that appears and press Enter. Then double-click on the new folder 
to open it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the 
date the file was last modified.
Click to preview the selected trace before you load it into the application.

File name  Enter the name of the file you want to open in this field. The easiest way to do this is to 
find the file in the Look in list box and then select the file. However, you can type the 
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Save As—Thermal 
Look in | File name | Files of type | Save

full path of a file and then select Open to open the file.

Files of type  Click on the arrow on the right of this field to view a list of the different types of 
application files that can be opened in the list box. 
Methods (*.FMTM) Choose this file type to open a Method file. Only the method is 

loaded. No data is loaded.
Data (*.FDTM) Choose this file type to open a Data file. Only the data is 

loaded. The method that was used to collect the data is not 
loaded. The last used method or default method will be 
displayed.

Report (*.FRTM) Choose this file type to open a Report file. You can view the 
report in the Report area.

Graph Template 
(*.FGTM) 

Choose this file to open a Graph Template file. The file will set 
up the layout of the Graphics area including any bitmaps as 
well as the range and style of the graph axes.

Batch (*.FBTM) Choose this file type to open a Batch file. A Batch file includes 
data, the method used to collect the data, report and graphics 
setup.

Spreadsheet Ascii 
(*.CSV)

This will open ASCII files that contain single comma delimited 
files with two or more columns.

GRAMS (*.SPC) Choose this file type to open a Cary Eclipse GRAMS data file. 
This allows you to use data files collected using a Cary Eclipse 
GRAMS system. The method that was used to collect the data 
is not loaded.

ADL (*.ADL) This will open and run program files generated in the 
Applications Development Language (ADL). 

All files (*.*) This enables you to view all files in the directory so that you 
can open any compatible file.

Tell me more about Filename Extensions

Overlay 
Data 

Select this check box to overlay individual data files in one graph box. If this is not 
checked the data from each file will appear in individual graph boxes. This option is 
only available if the Open dialog has been accessed by selecting 'Open…' from the File 
menu. 

Hot Tip 
Use the SHIFT or Control key to select multiple data files.

Open This button opens the highlighted file/s or the files listed in the File name field.

 
See also: 
File menu 
ASCII Spreadsheet File
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Use the Save As dialog to save the data, method, report or graphics template individually or together as a 
Batch file. 

Traces (or data) that are currently ‘Visible’ in the Graphics area are saved, regardless of how they are 
displayed (full screen graph box or tile).  

For example, if six graph boxes are displayed in the Graphics area and each graph box has one Visible 
trace then all six traces will be saved.  

If you do not wish to save particular traces, make them not Visible in the Trace Preferences dialog. To 
save only the focused trace, select the Save only focused trace check box. 

The Save As dialog comprises the following: 

Note 
This dialog appears when you select either the Save Method As or Save As menu option in the File 
menu. When you select Save Method As this dialog appears with 'Methods' displayed in the Files 
of type field. When you select Save As this dialog appears with 'Batch' displayed in the Files of 
type field.

Look In The Look In field lists the available folders and files. Click the down arrow on the 
right of this field to view the location of the current folder in your computer's 
hierarchy. You can also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed in the list box below the Look 
In field. 

Note 
To open the folder in the level that is one higher than the current folder, select 

 on the toolbar.

Look in list 
box 

The Look In list box, which is directly below the Look In field, displays the folders 
and files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted 
text entry field that appears and press ENTER. Then double-click on the new 
folder to open it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the 
date the file was last modified.
Click to preview the selected trace before you load it into the application.

File Name Enter the name of the file you want to save in this field. 
You can also type the full path of a file then select the Save button to save the file. 

Files of Type  Click on the arrow on the right of this field to view a list of the different types of 
application files that can be opened in the list box. 
Methods (*.FMTM) Choose this file type to only save the current method. Any 
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Filename extensions—Thermal 
The Cary Eclipse system uses the filename extension to distinguish between data types (e.g. method or 
data) and also to differentiate applications. (e.g. Concentration or Thermal). 

The Syntax for file extensions is: 

collected data is not stored.
Data (*.FDTM) Choose this file type to only save the data currently Visible in 

the Trace Preferences dialog (for any graph box). Note that the 
method used to collect the data is not stored with the data.

Report (*.FRTM) Choose this file type to only save the contents currently shown 
in the Report area..

Graph Template 
(*.FGTM) 

Choose this file type to save the layout of the Graphics area as a 
template. For example, any bitmaps you have added to your 
Graphics area will be saved as well as the range and style of the 
graph axes.

Batch (*.FBTM) Choose this file type to save the data that is currently Visible in 
the Trace Preferences dialog (for any graph box), the method 
used to collect the data and the currently displayed report all 
together as a batch file. The graphics setup is also stored. 

Spreadsheet Ascii 
(*.CSV)

Choose this file type to save the raw intensity data currently 
Visible in the Trace Preferences dialog (for any graph box) as 
a comma delimited ASCII Spreadsheet file (*.CSV) file. The 
data is saved as XY pairs delimited by a comma. 

Note 
This file type can be easily imported into a spreadsheet 
program. For example, Microsoft Excel. You can also 
double-click on the stored *.CSV file from Microsoft 
Explorer to load Excel automatically with the ASCII XY 
data displayed.

GRAMS (*.SPC) Choose this file type to only save the data currently Visible in 
the Trace Preferences dialog (for any graph box) as a Cary 
Eclipse GRAMS data file.

Tell me more about Filename Extensions

Save only 
focused trace 

Select this option to save only the focused trace in the graph box. If this option is not 
selected, all visible traces in the graph box will be saved.

Save Click this button to save the file currently present in the File name field in the 
directory specified in the Look in field.

See also: 
File menu  
ASCII Spreadsheet file (*.CSV) 

Letter Represents Available Options
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The following files may be opened and saved in the Thermal Application: 

First Type of analysis F Fluorescence

Second Type of file B Batch
D Data
G Graph Template
M Method
R Report

Third and fourth Application identifier AB Advanced Reads
CN Concentration
TM Thermal
LT Lifetimes
RT Ratio
SR Simple Reads
SW Scan
TM Thermal
VO Validate

Extension Available action File type
*.FMTM Open/Save A method file (*.FMTM) consists of the software setup 

by which data is collected.
*.FDTM Open/Save A data file (*.FDTM) contains data collected that is 

currently visible in the Trace Preferences dialog (for any 
graph box). 

*.FRTM Open/Save A report file (*.FRTM) contains the report generated by 
the Cary Eclipse about the data.

*.FGTM Open/Save A graph template file (*.FGTM) contains information 
that sets up the layout of the Graphics area including 
any bitmaps as well as the range and style of the graph 
axes.

*.FBTM Open/Save A batch file (*.FBTM) contains the collected data that 
was Visible in the Trace Preferences dialog (for any 
graph box), the method by which the data was collected 
and the report and graphics template.

*.CSV Open/Save An ASCII spreadsheet file (*.FCSV) has the same 
extension for all applications. It consists of raw intensity 
data (that was currently Visible in the Trace Preferences 
dialog (for any graph box) saved as XY comma-
delimited pairs. This file can be imported into a 
spreadsheet program such as Microsoft Excel.

Data.* Open A Cary DOS (Data.*) file is the equivalent of a Cary 
Windows Data file—it does not contain any Batch 
information.
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ASCII Spreadsheet file (*.CSV)—Thermal 
An ASCII Spreadsheet file consists of raw intensity data saved as XY comma-delimited pairs. You can 
choose to import or export Cary Eclipse files to ASCII files, which can then be imported in spreadsheet 
programs such as Microsoft Excel. 

The format is as follows:  

Line 1 contains the sample name
Line 2 contains X and Y labels. The name of the X label in Thermal is Temperature (°C). The Y
label should be intensity (a.u.)
Lines 3 and onward contain the X,Y data
After the last line of X,Y pairs there must be a blank line separating the data from any text audit
strings or the end of the file.

For example, if a thermal file was collected as: 
Temp (°C) = 94.99, Intensity = 196.775 
Temp (°C) = 94.55, Intensity = 196.620 
Temp (°C) = 94.03, Intensity = 197.256 
etc. 

It would appear as follows in the ASCII file: 

*.ADL Open only An ADL file (*.ADL) is a program file generated in the 
Applications Development Language (ADL). 

*.SPC Open/Save A Cary GRAMS file (*.SPC ) is the equivalent of a 
Cary Eclipse Windows Data file—it does not contain 
any Batch information.

*.FADL Open An Eclipse ADL (*.FADL) file is a program file 
generated in the Applications Development Language 
(ADL) specifically for the Cary Eclipse. Eclipse ADL 
files will be associated with the relevant Eclipse 
application. When creating ADL files for the Cary 
Eclipse, it is recommended that you save them with the 
FADL extension.

Note 
Selecting All Files in the Windows Open dialog will list all available file types. 

See also: 
Open 
Save As

  Thermal, 
  Temp (°C); Intensity (a.u.) 
  30, 0.0255, 
  60, 0.0500, 
  80, 0.0750, 
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Microsoft’s Excel generates a CSV file with the above format. 

There is also an alternative format for CSV files. For example,  

How to combine data files into a batch file—Thermal 
To combine a number of data files into a batch file, do the following: 

Step 1  

Select Open… from the File menu to display the Windows Open dialog. 

Step 2  

A list of stored batch files will appear. Select the down arrow to the right of the Files of type field and 
select 'Data' to list all the data files. 

Step 3  

Select the Overlay Data check box. 

Step 4  

Highlight the data files that you require. Hold down the CTRL key to select multiple files. 

Step 5 

Select Open. The highlighted data files will load into the application and appear in the same graph box. 

Step 6 

  Thermal, 
  Collection time; 
  etc. 

  Thermal 
  Temp (°C); Intensity (a.u.) 
  30, 0.0255 
  60, 0.0500 
  80, 0.0750 

  Thermal, 
  Collection time; 
  etc. 

See also: 
Save As 
Open 
How to export collected data
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Select Save As… from the File menu to display the Windows Save As dialog.

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and 
select 'Batch' to list all the batch files. Ensure that the Save only focused trace check box is cleared. 

Step 8 

In the File name field, type in the file name for your new batch file. 

Step 9 

Select Save to create the new batch file. The current method will be stored with the batch file. 

All the data files are now combined into the one batch file. 

How to export collected data—Thermal 
If you want to export data from a Cary Eclipse application into a third-party application, then you simply 
need to save your data as an Spreadsheet ASCII (*.CSV) file or a Rich Text Format (*.RTF) file. 
Spreadsheet ASCII files are recommended if you are planning to use the data in a spreadsheet program 
such as Microsoft® Excel. Rich Text Format files are recommended if you are planning to open the data 
in a word processor program such as Microsoft® Word. 

To export collected data: 

Step 1  

From the File menu, select Save As. The Save As dialog is displayed. 

Step 2  

Click on the down arrow next to the Files of type list box and select the Spreadsheet ASCII (*.CSV) or 
Rich Text Format (*.RTF) option. 

Step 4  

Type the name of your new file in the File name field. 

Step 5  

Select Save to export your data to this new file. 

Software and Screen features—Thermal 
Menu line
Status display
Status line
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Buttons
Function keys
Right mouse menu
How to remove or display the command buttons

Menu line—Thermal 
 File menu 
 Edit menu 
 View menu 
 Commands menu 
 Setup menu 
 Graph menu 
 Help menu 

Status Line—Thermal 
The Status Line is displayed at the very bottom of the Thermal Application window. The line will display 
the following information (from left to right): 

The major commands in this application can be accessed both from the menu items at the top of the main 
window and from the application buttons. These buttons, which appear in the left side of the Thermal 
Application window, comprise the following: 

Hardware Status This field displays status messages indicating the current instrument activity.
Sequence Information This field displays status messages indicating the current system activity.
Current Results This field displays information on the last reading. 

Thermal Application window

Buttons—Thermal 

Hot Tip 
If you wish to access these commands from the main menus, rather than from these buttons, you 
can remove the Command buttons from your application window. To do this, clear the Buttons 
command in the View menu. This will enlarge the Graphics area, making viewing and selection of 
thermals easier. 

Button Enables you to…
Setup Click this button to display the Setup dialog where you can set up your Cary Eclipse 

for the collection, storage and analysis of the thermal run. You can also set up any 
accessories that you may have and define the reporting options.

Zero Select this to zero the current ordinate value. 
This command can also be accessed by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
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Function keys—Thermal 
The function keys at the top of your keyboard perform basic Cary Eclipse operations simply and quickly. 

positions that are currently in the cell path.

Set Temp Click Set temp to open the Set Temperature dialog where you can change the 
temperature during a thermal run. 

Q. Why is the Set Temp button unavailable?
A. The Set Temp button is only accessible if you are using a thermostatted
accessory. (On the Accessories page, the Temperature control option must be
selected.) Once you have started a run, you can access the Set Temp button by
selecting the Pause button to pause the run. You can then select the Set Temp
button.

Clear Report Select Clear Report to remove all of the text that appears in the Report area. If you 
have saved the report, you can view the information again. To do this, simply open the 
report file using the Open… command in the File menu.

Recalculate Use the pages accessible from the Recalculate option to perform re-calculations on 
data that has been analyzed.

Print Select Print to display the Windows Print dialog where you can choose what printer 
the report will be printed to. You can also select what pages to print as well as the 
number of copies you wish to print. 
This command can also be accessed by pressing CTRL+P. 

Note 
The options on the Report page are used to generate the contents of the Report 
area during a run or on a recalculation. If Auto Print has been selected the Cary 
Eclipse will automatically print a report at the end of a data collection.

See also: 
Thermal Application  
Setup  
Set Temperature  
Recalculate 
Commands menu 

Function 
key 

What it does

F1 This displays the Help for the current dialog or window.
F4 Press F4 to display the Go to Wavelength dialog.
F5 Press F5 to perform an instrument Zero. The current intensity value will be reset to zero and 

all subsequent results will have the value that was reset to zero subtracted from them. You 
can use the Zero command before selecting Start if you want your data to start at 0 
intensity. 
This command is also accessible from the Commands menu or by selecting the Zero button. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.
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Right mouse menu—Thermal 
The following commands are accessible by clicking the right mouse button on editable fields in the Cary 
Eclipse software: 

How to remove or display the command buttons—Thermal 
The command buttons (Setup, Zero, Pre-thermal, Set Temp, Stop Time, Clear Report, Recalculate 
and Print) appear on the left side of the Thermal Application window. 

To remove the command buttons 

Step 1 

From the Thermal Application window, select the View menu. 

Step 2 

Clear the Buttons menu item. 

Select the Clear Zero command from the Commands menu to remove zero correction.  

F6 Press F6 to display the Rapid Result dialog where you can read a blank and multiple sample 
readings without changing the application method. 
This command is also accessible from the Commands menu.

F9 If the application is online, press F9 to start a data collection. This is equivalent to selecting 
the Start button. If the application is not online, you will need to press F9 to first connect to 
the Cary Eclipse. Then press F9 to start the data collection. 
This command is also accessible from the Commands menu or by selecting the Start 
button. 

Note 
You will not be able to perform a Connect if another application is collecting data.

F12 Select this to stop the current measurement. This is equivalent to selecting the Stop button. 
This command is also accessible from the Commands menu or by selecting the Stop button.

See also: 
Go to Wavelength 
Zero  
Rapid Result  
Start/Stop Instrument Buttons

Undo If available, this reverts to the previous value before the Edit on the field.
Cut If available, this cuts the highlighted text to the clipboard.
Copy If available, this copies the highlighted text to the clipboard.
Paste If available, this pastes the text from the clipboard to the cursor position.
Delete If available, this deletes the highlighted text/number.
Select All If available, this selects all entries.
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The buttons will disappear from the application screen, giving you more room to display reports.

To show the command buttons 

Step 1 

From the Thermal Application window, select the View menu. 

Step 2 

Select the Buttons menu item. 

The buttons will re-appear in the application screen. 

ADL—Thermal 
ADL Command Line
ADL Hooks
How to insert ADL commands

Introduction to ADL 

Use the ADL Command Line to run Single-line or Multi-line Applications Development Language 
(ADL) commands that enable you to perform functions over and above that of the existing program 
functionality.  

ADL is not a general purpose programming language. It has been developed specifically by Varian to 
meet the needs of spectroscopists. It can be used to handle all the data collected from the Cary Eclipse—
both photometric values and entire data collections. ADL programs that you develop should be stored 
with the extension 'ADL'. 

To access the ADL Command Line, select the ADL Command item from the Commands menu. You can 
also press ALT+Y to open the dialog. 

Software controls 

ADL Command Line—Thermal 

Note 
Full documentation on ADL programming is available in the ADL Online Help.  
Click the button below to view this Help. 

Single Line Selecting this lets you enter ADL commands on a single line into the Command Line 
entry box. 
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The ADL Hooks command is accessible from the View menu.  

Instead of writing a full ADL program you can use ADL hooks to link into an existing application. This 
is particularly useful if you want to make small changes to the way an application works, e.g. you want to 
pop up a dialog for the user to enter some specific data before the run starts. ADL hooks are links at 
specific points in an application at which you can run an ADL program. For example, ADL hooks have 
been supplied to run the following ADL programs:  

Q. Can I enter more than one ADL command on a single line?
A. Yes, provided that the commands are separated by a semicolon ‘;’.

Multi-line The Multi-line capability enlarges the Command Line entry box. Use the Multi-line 
capability to create a more complex ADL program by adding a series of commands over 
multiple lines. When Multi-line mode is selected, the Quick Reference option becomes 
available.

Quick 
Reference 

Select Quick Reference to open the Quick Reference dialog where you can easily add a 
command in the correct syntax to your ADL program. This option is only available for 
Multi-line commands. 

Show me How to insert ADL commands using the Quick Reference 

A detailed description of all the commands in the Quick Reference is available by 
pressing the Help button on the Quick Reference dialog. 

Browse Select Browse to access the Open dialog where you can browse for and select an 
existing ADL program to load and run.

Command 
Line (entry 
box) 

This entry box enables you to use ADL commands. You can enter single ADL 
commands into this field, or you can enter a series of ADL commands. If you have the 
entry type set to Single Line, you can review previous ADL entries by selecting the 
down arrow to the right of the list box. 

The ADL commands in the Command Line are executed when you select OK. 

Note 
On entering this window, the Cary Eclipse will recall the last command or 
program executed from the Command Line entry box. The ADL commands 
entered in the last executed program are typically stored in the Varian\Cary 
Eclipse WinFLR\ADL directory on the drive on which the Cary Eclipse software 
is installed.
Hot Tip 
You can rerun the ADL commands in the Command Line entry box from any 
screen in the Thermal application by pressing Alt-X or selecting Re-run ADL 
from the Commands menu. 

 
See also: 
ADL Hooks

ADL Hooks—Thermal 

Note 
Full documentation on ADL programming is available in the ADL Online Help.  
Click the button below to view this Help.      
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Hook Description

TM_Startup.FADL This is run when the Thermal application starts. For this to to work the 
application must be started from a batch or method file that has ADL 
Hooks on.

TM_PreSeq.FADL This runs when the Start button is selected.

TM_PostSeq.FADL This runs at the end of the Start button sequence.

TM_Online.FADL This runs when Cary Eclipse is detected online.

TM_OffLine.FADL This runs when Cary Eclipse goes offline.

TM_Zero.FADL This runs when the Zero button is selected.

TM_Recalc.FADL This runs when the Recalculate button is selected.

TM_Shutdown.FADL This runs when the application is shutting down.

TM_PreRead.FADL This runs just before a read is taken.

TM_PostRead.FADL This runs just after a read is taken (It has the reading result stored in the 
UserResult variable.)

TM_PreSetup.FADL This runs when the Setup button is selected.

TM_PostSetup.FADL This runs when the OK button on the Setup dialog is selected.

TM_CellChange.FADL This runs instead of the Cary Eclipse driving the Multicell Holder. It 
enables you to add your own instructions for the Cary Eclipse Multicell 
Holder or to use your own cell changing accessory.

TM_PreStage.FADL This runs prior to each collection stage. It determines the stage by 
checking the UserResult variable as UserResult = stage number.

TM_PreUserRecalc.FADL This runs just after the Recalculate button has been selected and 
performs any pre-processing required prior to a recalculation. If the 
ADL Variable UserBoolean is set to FALSE, it can also replace the 
normal recalculations.

TM_UserRecalc.FADL This runs just prior to the calculations and can also be used to replace 
the calculations.

TM_PostUserRecalc.FADL Runs after the Recalculate sequence has been completed

TM_TraceName.FADL Allows the name of the sample to be obtained from an ADL file, 
instead of being entered by typing into the sample loading dialog. This 
only works for single samples.

TM_UserPreCalc.FADL This runs just prior to the calculations. Any pre-processing of data 
should be done here.

TM_UserPostCalc.FADL This runs after the calculations. Any post processing of data should be 
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How to insert ADL commands using the Quick Reference—
Thermal 
The Quick Reference window is accessed from the ADL Command window. It enables you to easily add 
a command in the correct syntax to your ADL program. To do this: 

Step 1 

Press Alt-Y to open the ADL Command Line window. 

Step 2 

Select the Multi-line option. The Command Line entry box will expand to take multiple lines of ADL 
commands and the Quick Reference check box is displayed. 

Step 3 

Select the Quick Reference check box. The Quick Reference window is displayed. 

Step 4 

If necessary, use the Go To field to jump to the appropriate part of the Quick Reference listing. 

Step 5 

Highlight the command you require in the Quick Reference list. 

Step 6 

Click the Insert in ADL button. The selected ADL command will appear in the Command Line entry 
box. 

Step 7 

Where necessary, alter the defaults supplied by the inserted Quick Reference command in the Command 
Line entry box to suit your program. 

Step 8 

Repeat steps 4–7 to add more commands as required. 

done here.

TM_DuringSeq.FADL Runs when the collect sequence has been paused

TM_PreStage.FADL Runs prior to each stage in a multistage (advanced) run.

TM_PostStage.FADL Runs after each stage in a multistage (advanced) run

See also: 
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Help and Safety information—Thermal 
Help menu
Safety home page

Help menu—Thermal 
Use the Help menu to view the online Help and software information for this application. 

Safety Home Page 
Click on the desired index entry to view the Help. 

About Safety
Lamp module
Ultraviolet radiation
Electrical hazards — Cary Eclipse
Panels, covers and modules
Other precautions
Warnings and cautions
Warning symbols
Color coding
Information symbols
FCC advisory
CE compliant products

Thermal How to… 
Select the procedure you require below for a step-by-step informative guide on running the application 
software. 

ADL Command Line

Command What it does…
Thermal 
Help 

Select this to display the Thermal Home Page. This contains a list of online Help topics 
specific to the Thermal Application.

Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.
Tip of the 
day 

View useful tips about using your Cary Eclipse instrument and software.

Eclipse Tour Select this to display the Cary Eclipse Multimedia Online Help. This will give you an 
animated introduction to the Cary Eclipse software and hardware.

About… Select About to access a dialog that displays information about the application as well 
as Varian email and Internet contact information.  
To clear this About dialog, select OK.

Page 126 of 130Thermal Home Page

 



Procedural 

How to perform a run and determine Tm using Derivative calculations
How to perform Derivative calculations on previously stored data
How to perform a run and determine Tm using Hyperchromicity calculations
How to perform Hyperchromicity calculations on previously stored data
How to use the ruler during Hyperchromicity calculations

General 

How to email your results
How to export collected data
How to combine data files into a batch file
How to remove or display the command buttons
How to insert ADL commands using the Quick Reference

How to resize graph boxes—Thermal 
Step 1  

Click on the graph that you want to resize so that the highlight box appears around it. 

Step 2  

Move the cursor to the edge of the highlight box and place it over one of the square marks (e.g. ) in the 
box until it turns into a double headed arrow ( ). 

Step 3  

Click and hold the left mouse button and drag the box to the desired size. 

Step 4  

Release the left mouse button. 

How to zoom a graph—Thermal 
To zoom a graph, do the following: 

Step 1  

Click on the  button on the toolbar, or select Cursor Mode from the Graph menu. The Cursor 
Modes dialog will appear. 

See also:
Thermal Home Page
Graphics How To

See also: 
How to alter the look of your graphs

Page 127 of 130Thermal Home Page

 



Step 2  

Select Free and select the OK button. 

Step 3  

Click and hold down left mouse button in the highlighted graph box. 

Step 4  

Drag the mouse sideways and up or down. You will see a zoom box made up of a dotted line appear on 
the screen. (See picture below.) 

The dotted line is a zoom box. 

Step 5  

Release the left mouse button. The area defined by the zoom box will be redrawn to fill the entire graph 
box, and the thermals within the box will be enlarged accordingly. The abscissa (X) and ordinate (Y) 
coordinates displayed below the graph will also be changed to reflect the positions of the corners of the 
zoom box. 

You can repeat this process if you need to zoom in even further. 

How to take the derivative of a trace 
Some uses of derivatives are:  

To resolve partly overlapping peaks
To quantitatively determine trace compounds
To characterize pure compounds
Purity testing

To take the derivative of a collected trace and plot the result, follow these steps: 

Hot Tip 
To move the box on the screen, hold down the left and right mouse buttons together. You can then 
position the box anywhere in the graph box. Releasing the right mouse button will still allow you to 
resize the zoom box.

Note 
The system may limit the extent to which you can Zoom. 
See also: 
How to scale your graph manually 
How to scale your graph automatically
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Step 1 

Click on the trace to be smoothed. It will become red (highlighted). 

Step 2 

Click the Selected Trace or Focused Trace button. The name of the highlighted trace will appear in the 
calculation display field. 

Step 3 

In the Trace group, select your derivative order in the Operation field. Choose from derivatives 1 to 4 
(Deriv1, Deriv2, Deriv3, Deriv4). You may have to scroll to find the derivative you require. 

Step 4 

Enter a Filter Size and an Interval in the corresponding fields. 

Step 5 

In the Display Options group, select New Graph to plot the result in a new graph box, or Selected Graph 
to plot the result in the current graph box. 

Step 6 

Click the Apply button in the Trace group. Your Deriv selection will be displayed before the trace name 
in the calculation display field. 

Step 7 

Click on the equals (=) button. The result will be displayed in the Graphics area. 

How to smooth a trace 
To smooth a collected trace and plot the result, follow these steps: 

Step 1 

Click on the trace to be smoothed. It will become red (highlighted). 

Step 2 

Click on the Maths button in the toolbar (it's on the far right) or select the Maths menu. 

Step 3 

Click the Selected Trace or Focused Trace button. The name of the highlighted trace will appear in the 

See also: 
About derivatives
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calculation display field. 

Step 4 

In the Trace group, select Smooth in the Operation field. (You may have to scroll to find it.) 

Step 5 

Enter a Filter Size and an Interval in the corresponding fields. 

Step 6 

In the Display Options group select New Graph to plot the result in a new graph box, or Selected Graph 
to plot the result in the current graph box. 

Step 7 

Click the Apply button in the Trace group. The word ‘Smooth’ will appear before the trace name in the 
calculation display field. 

Step 8 

Click on the equals (=) button. The result will be displayed in the Graphics area. 
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Validate Home Page 

To learn about… Use the… Show me…
Set up Tests Tests dialog

Configure page
How to setup and perform Validation tests
How to care for standard and reference
materials

Performing Tests Installation Tests
Instrument Tests
ASTM
All Tests

How to setup and perform Validation tests

Viewing run progress 
and results

View menu
Status Display
Reports
Print Preview

How to use advanced reporting options

Performing calculations Maths Calculator
User Data Form

Maths How To

Display data graphically Graph menu
Graphics area

Graphics How To

To find out about… See the… Show me…
Validate Application Validate

Application
File management File menu

Open
Save As
Filename
extensions
Auto Store

How to combine data files into a batch file
How to email your results

Software and screen 
features

Menu Line
Buttons
Status Line
Right mouse menu
Function keys

How to remove or display the command
buttons

ADL ADL Command
Line
ADL Hooks

How to insert ADL commands

Help and safety 
information

Help menu
Safety Home Page

See also: 
Validate How To 

Validate Application 
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Introduction 

Use the Validate Application to optimize the settings and validate the accuracy of your Cary Eclipse 
Instrument by executing a number of pre-defined tests. The tests are preset with default parameters that 
comply with international standards for Good Laboratory Practices. You can use this application to 
perform wavelength checks and calibrations of various Cary Eclipse functions. The Validate Application 
can only be used for validating your Cary Eclipse instrument. The application cannot be used to validate 
accessories. 

This application runs the tests in a sequence that ensures that tests requiring your intervention are run 
first. Tests that do not require your intervention are performed last. Consequently you can leave the 
instrument unattended once you no longer needed to change filters or solutions in the sample 
compartments. 

Certified test kits are available from Varian for use with the Validate application. Refer to the Cary 
Eclipse Eclipse Parts and Supplies list for details. 

To access the Validate Application, click the Windows Start button, point to Programs, Cary Eclipse 
Eclipse and then select Validate. 

Software controls 

The application comprises the following: 

Note: 
Due to the sensitivity of the fluorescence technique, Validate tests must be performed with the 
covers on the instrument so as to minimize detection of room light.

Instrument 
Status 
Readings 

The Instrument Status Readings, which display the Y and X values of the graph axes are 
displayed in the top left and right corners of the Validate Application window. 

Y value 
Displays the current Y value, usually intensity. This value is continually updated during 
a data collection. 

X value 
Displays the current X values, in nanometers, for both excitation and emission. 

Start and 
Stop buttons 

The Start and Stop buttons at the top of the Validate Application window are used to 
start and stop instrument analyses. These buttons can also be accessed from the 
Commands menu. 

Tell me more about the Start and Stop buttons 
Graph area The Graphics area refers to the plotting area of the application. It can contain traces of 

collected data, labels and pictures. In the Cary Eclipse Eclipse system, the term 'graph' 
refers to the plotting area and is represented by a set of axes. The rectangular area 
defined by the axes is referred to as a graph box. 

To display or hide the Graphics area, select the Graphics command on the View menu. 
Double-clicking on the Graphics area enables you to toggle between half or full size 
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Use the Tests dialog to set up your instrument for a performance tests. You can use the dialog to 
configure your instrument to check its performance based on the regulatory specifications you select. 

Select the tab you require to display Varian specifications and instrument setup information for each test.

display sizes. To manually size the Graphics area, place the mouse cursor over the 
border between the Graph and Report areas until the cursor changes to a double arrow (

). Then hold down the mouse and drag it up or down to resize the areas. 

Tell me more about the Graph area 
Report area Use the Validate Report area to view the current report. The report may include the 

results of your data collection, the method parameters used to collect the results and any 
graphics you have included. You can select the information to include in your report on 
the Reports page of the Setup dialog. 

You can copy the generated report onto the Windows clipboard. To do this, highlight 
the report (or the relevant section) and press CTRL+C. You can then paste the report 
into a word processor such as Microsoft® Word. 

Hot Tip 
You can edit the Validate Report by pressing CTRL+R or selecting the Edit 
Report command from the Edit menu.

Commands The Validate Application window contains the following commands, all of which can 
also be accessed from the various menus in the application. 

Click on the buttons to view information about them: 

Hot Tip 
By becoming familiar with these commands (Tests, Setup, Zero, etc.), you can 
remove these buttons from the Validate window. This will enlarge the Graphics 
and Report areas and make it easier to view results. To do this, clear the Buttons 
item in the View menu. 

Menus The Concentration Application contains the following menus:  
File, Edit, View, Commands, Setup, Graph, Calibration, Help

See also: 
Validate Home Page  
Keyboard function keys 

Tests—Validate 

To access the Tests option, select the Tests button from the Validate Application window.

Note: 
The tests in the Validate application will have most of their fields disabled, as they will be set to 

Page 3 of 91Validate Home Page

 



Configure
Wavelength Accuracy (Xe)
Wavelength Accuracy (Ho)
Wavelength Reproducibility (Xe)
Wavelength Reproducibility (Ho)
Zero %T Accuracy
Spectral Bandwidth Accuracy
Sensitivity
Stray Light
Maximum Signal to Noise
Stability
ASTM (Detection Limits)

Regulations—Validate 
Regulatory authorities demand that generated analytical data complies with Good Laboratory Practices 
(GLP). A range of performance tests for fluorescence spectrophotometers is specified by the British 
Pharmacopoeia (BP), European Pharmacopoeia, the US Pharmacopoeia (USP) and the Australian Code 
of GMP for Therapeutic Goods (TGA)—Guidelines for Laboratory Instrumentation Appendix D2. 

The specifications in these tests are a minimum set of criteria for a general purpose UV-Vis 
spectrophotometer. You need to use an instrument that meets these specifications for your analyses. 

These performance tests should be performed routinely on a monthly basis or whenever the instrument 
has been disturbed or serviced, or when malfunctioning is suspected. 

Use the Configure page to select the Validate tests you require. 

The page comprises the following: 

values that are appropriate for achieving guaranteed instrument specifications. However, if the Cary 
Eclipse software is under GLP control and you have administrator privileges, you will be able to 
alter these parameters.

See also: 
Regulations 
Validate Application window

See also: 
Tests 
Configure 
Validate Application  
How to perform a validation test

Configure—Validate 

Enable Test 
Suite 

The following test suites are available for selection. The number of tabbed pages 
displayed and the Test Order list will change depending upon the test suite selection. 

To view the tests contained in each of the following suites, select on the links below: 
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The following Installation Tests are available in the Validate application: 

Wavelength Accuracy Ex. Mono (Xe)
Wavelength Accuracy Em. Mono (Xe)
Spectral Bandwidth Accuracy Ex. Slit
Spectral Bandwidth Accuracy Em. Slit
Sensitivity 350/397
Stray Light

Installation Tests
Instrument Tests
ASTM Tests
Enable All Tests

Test Order The Test Order lists all tests associated with the nominated Test Suite in the order in 
which they will be run. You can choose to move tests up and down in the order, or 
disable tests, if you do not wish to perform all of the tests within a suite. 
Double-click on a test in the Test Order list to open the test page. You can then view 
and edit the required the test values. 

Click this button to move the selected test up in the test order.

Click this button to move the selected test down in the test order.

 Click this button to disable the selected test.

Deselect all 
tests 

Select Deselect all tests to disable all validation tests associated with the test suite 
nominated.

Reset  default 
values 

Select Reset all tests to reset all validation test values to their default settings. You will 
be prompted to confirm this selection.

Status display Select this check box to display the Status Display window. This window allows you to 
view the status of your Validate run during the data collection

Auto 
excitation 
PMT voltage 

If you select Auto Excitation PMT voltage the Cary Eclipse instrument will set the 
optimum photomultiplier voltage for the system. The voltages used during the test will 
be displayed on the report.

See also: 
Validate Application 
Status Display  
Regulations

Installation Tests—Validate 

See also: 
Configure 
Validate Application

Wavelength Accuracy (Xe)—Validate 
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Poor wavelength accuracy can produce low quantitative results as the intensity measurement may have 
been made on the side of the peak rather than at the peak. Wavelength accuracy is determined by 
scanning a known wavelength peak and calculating the difference between the theoretical wavelength 
peak and the wavelength peak as reported by the instrument. The tests are each divided into two tests, one 
for the emission monochromator and one for the excitation monochromator. 

There are two methods used to test for wavelength accuracy: 

Xenon (Xe) emission line method
Holmium perchlorate method

The first involves scanning two peaks in the xenon lamp spectrum. The second uses the transmission 
minima in the spectrum of a solution of holium perchlorate. 

Xenon (Xe) emission line method 

This method scans the Xenon (Xe) source emission line at 541.92 nm and 260.54 nm. A ground glass 
filter is placed in the sample position when measuring the wavelength accuracy of the emission 
monochromator. The filter is supplied with the instrument. The application compares the expected 
wavelength peak to that of the theoretical position. The procedure is separated into two tests, consisting 
of the following: 

Validation of the excitation monochromator
Validation of the emission monochromator

Sample required 

Excitation monochromator: 
No sample is required for this tests as it is the signal from the reference PMT that is being monitored. 

Emission monochromator: 
A ground silica screen diffuser must be placed in the sample position. 

Specifications required to pass the test 

Peak < ± 0.5 nm from 541.92 nm 
Peak < ± 1.0 nm from 260.54 nm 

What if my instrument fails to meet the specification? 

Check that you have set the tolerances to values that are within the specifications of the instrument.

Note: 
The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  
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This test is dependent on correct alignment and function of the Xenon source lamp. Check the
lamps and alignment.
Use the wavelength calibration command from within Validate to recalibrate the instrument.
Perform the wavelength accuracy test again.

If it still fails, contact your local Varian Service office, as a service call may be required. 

This test checks the positional accuracy of the slit mechanism. The test is performed by scanning the zero 
order peak and then determining the peak width at half peak height. This is performed on either the 
emission or excitation monochromator in separate tests. 

The emission and excitation monochromators both use a number of slits and they are measured 
separately. All fice available slit options are tested on the emission monochromator. Only three slits can 
be tested on the excitation monochromator, as scanning at zero order at the two largest slit widths (10 nm 
and 20 nm) would result in too much light which could flood the detector. 

Sample required 

Excitation monochromator: 
No sample is required for this tests as it is the signal from the reference PMT that is being monitored. 

Emission monochromator: 
A ground silica screen diffuser must be placed in the cell holder. 

Specifications required to pass the tests 

Excitation and emission monochromators 

See also: 
Configure  
Regulations 
Validate Application

Spectral Bandwidth Accuracy—Validate 

Note: 
The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  

Note: 
It is recommended that the Auto excitation PMT voltage option on the Configure page is selected 
on for the Emission test. The PMT voltages used in the test will be displayed in the report. 

SBW (nm) Minimum Maximum 
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Emission monochromator only 

What if my instrument fails to meet the specification? 

Check the lamp alignment and focus. Refer to the Cary Eclipse on-line help for assistance.
Repeat the test.

If the instrument still does not meet the specification, please contact your local Varian Service office as a 
service call may be required. 

The most common method of determining the sensitivity of a Cary Eclipse instrument is to monitor the 
intensity of the Raman band of water as a function of time and determine the signal-to-noise ratio, 
defined as (mean signal/RMS noise). 

An alternate method for determining instrumental sensitivity involve measuring the signal to noise ratio 
from low concentrations of fluorescent solutions such as fluorescein in 0.01M NaOH 

The tests used are: 

Raman water 350/397, Raman 2, Raman 3
Fluorescein detection limit

acceptable (nm) acceptable (nm)
1.2 1.00 1.50
2.5 2.25 2.75
5 4.50 5.50

SBW (nm) Minimum 
acceptable (nm)

Maximum 
acceptable (nm)

10 9.00 11.00
20 17.00 21.00

See also: 
Configure  
Regulations 
Validate Application

Sensitivity—Validate 

Note: 
The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  
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Raman water 350/397, Raman 2, Raman 3

This method uses the Raman band of water to determine the instrument sensitivity. Distilled water in a 
clean quartz fluorescence cuvette is required to perform this test. The test will report the signal to noise 
ratio. 

What if the signal to noise is lower than expected? 

Ensure that the instrument has been given adequate time to warm up.
Ensure the cell containing water has been placed in the sample position in a clean quartz cuvette.
Perform the sensitivity test again.

If it still fails contact your local Varian Service office as a service call may be required 

Fluorescein detection limit 

This test method employs a low concentration aqueous solution of the fluorescent dye fluorescein to 
assess the instrumental sensitivity. Effectively the test is a limit of detection measurement. The test uses 
parameters similar to the ASTM limit of detection test using quinine sulfate described in section X.XX. 

A solution of fluorescein (acid yellow 73, FW 376.3) in 0.01M NaOH at a concentration of around 1nM 
(1E-09 M) is prepared and the intensity from 10 individual readings averaged. The intensity of the 
solvent blank (0.01 M NaOH) is then measured 10 times and the standard deviation calculated. The limit 
of detection is calculated as 

Three times the standard deviation of the blank measurement is considered to give a minimum sample 
signal. 

What if my detection limit is too high? 

Check that you have entered the correct concentration for the fluorscein solution you are using into
the validate application.
Check the solution used has been prepared correctly and freshly and the cuvette used is clean.
Perform the sensitivity test again.

SDb x 3

_______________ x Fconc
(MFI - MB)

Where SDb= Standard deviation of the blank measurement

MFI= Mean fluorescence intensity

MB= Mean Blank intensity

Fconc = Fluoroscein concentration
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If it still fails contact your local Varian Service office as a service call may be required. 

Stray light is defined as any light that gets to the detector that is not of the selected wavelength. The 
detector cannot distinguish between stray light and light of the selected wavelength and will add the two 
together to give a higher intensity reading than expected. The stray light test measures the ratio of the 
intensity of scattered light detected by the sample PMT at a wavelength which is in the “wings” of the 
excitation peak, as compared to the intensity detected when the emission wavelength is identical to the 
excitation wavelength. 

The stray light test is performed by first setting both excitation and emission wavelengths to 350 nm. A 
reading is then taken before the emission monochromator is set to 371 nm, where no emission would be 
expected to be observed and the values ratioed. 

Sample required 

A ground silica screen must be placed in the cell holder. 

Specifications required for passing the test 

The stray light ratio should be in the range of -0.0005–0.0005 for the instrument to pass the test. 

What if my instrument fails to meet the specification? 

Ensure that the ground glass filter is in place.
Ensure that the sample compartment is tightly sealed. Repeat the test with the room lights turned
off. If the instrument passes the test then there is a light leak in the instrument cover somewhere.
Ensure that the filter is clean and free of any contamination that may fluoresce.

If it still fails, contact your local Varian Service office as a service call may be needed. 

See also: 
Configure  
Regulations 
Validate Application

Stray Light—Validate 

Note: 
The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  

See also: 
Configure  
Regulations 
Validate Application
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The following Installation Tests are available in the Validate application: 

Wavelength Accuracy Ex. Mono (Xe)
Wavelength Accuracy Em. Mono (Xe)
Wavelength Accuracy Ex. Mono (Ho)
Wavelength Accuracy Em. Mono (Ho)
Wavelength Reproducibility Ex. Mono (Xe)
Wavelength Reproducibility Em. Mono (Xe)
Wavelength Reproducibility Ex. Mono (Ho)
Wavelength Reproducibility Em. Mono (Ho)
0%T Accuracy (Rayleigh scatter)
0%T Accuracy (Raman band)
Sensitivity 350/397
Sensitivity Raman 2
Sensitivity Raman 3
Fluorescein detection limit
Stray Light
Maximum Signal to Noise
Stability

Poor wavelength accuracy can produce low quantitative results as the intensity measurement may have 
been made on the side of the peak rather than at the peak. Wavelength accuracy is determined by 
scanning a known wavelength peak and calculating the difference between the theoretical wavelength 
peak and the wavelength peak as reported by the instrument. The tests are each divided into two tests, one 
for the emission monochromator and one for the excitation monochromator. 

There are two methods used to test for wavelength accuracy: 

Xenon (Xe) emission line method

Holmium perchlorate method

The first involves scanning two peaks in the xenon lamp spectrum. The second uses the transmission 
minima in the spectrum of a solution of holium perchlorate. 

Instrument Tests—Validate 

See also: 
Configure 
Validate Application

Wavelength Accuracy (Ho)—Validate 

Note: 
The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 
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Holmium perchlorate method 

This method involves scanning the spectrum of an aqueous solution of 4% w/v holmium oxide in 1.4 M 
perchloric acid and comparing the wavelengths of the transmission minima with those reported in the 
Certificate of Analysis for Holmium (III) oxide in perchloric acid. This test provides a wavelength 
accuracy check independent of the light source. 

A scan of the spectrum of holmium perchlorate is made and the positions of the peaks at the following 
wavelengths: 640.70, 536.70, 485.30, 451.30, 416.40, 361.10, 287.40 and 278.0 nm, are determined. 

A ground glass filter, supplied with the Cary Eclipse is placed in the sample position to perform the 
wavelength accuracy test. After collecting a baseline the holmium perchlorate solution is placed in the 
special holder on the excitation side of the monochromator and a second scan takes place. A new 
continuum is created by taking the ratio of the Holmium perchlorate continuum and the blank continuum. 
From this continuum the positions of the peak maxima, close to the set wavelengths, are determined. 

Sample required 

A sealed 4% w/v aqueous solution of holium (III) oxide (99.5%) dissolved in perchloric acid contained in 
a sealed quartz cuvette, and a ground silica screen diffuser. 

Specification required to pass the test 

Peaks < ± 1.0 nm from certified wavelengths 

What if my instrument fails to meet the specification? 

Check that you have set the tolerances to values that are within the specifications of the instrument.
Use the wavelength calibration command from within Validate to recalibrate the instrument.
Perform the wavelength accuracy test again.

If it still fails, contact your local Varian Service office, as a service call may be required. 

There are two tests for wavelength reproducibility. The first involves scanning the 541.92 nm peak in the 
xenon lamp spectrum. The second involves scanning the 451.30 nm transmission minima in the spectrum 
of a solution of holium perchlorate. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  

See also: 
Configure  
Regulations 
Validate Application

Wavelength Reproducibility (Xe)—Validate 

Note: 
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The test procedure consists of repeating the wavelength accuracy test ten times to validate the wavelength 
reproducibility of each monochromator independently. The procedure is separated into two tests, 
consisting of the following: 

Validation of the excitation monochromator wavelength reproducibility
Validation of the emission monochromator wavelength reproducibility

The test for for xenon consists of repetitively measuring the wavelength of the 541.92 nm xenon lamp 
peak for 10 scans and calculating the difference between the largest and smallest measured wavelength. 

Sample required 

Excitation monochromator: 
No sample is required for this tests as it is the signal from the reference PMT that is being monitored. 

Emission monochromator: 
A ground silica screen diffuser must be placed in the sample position. 

Specifications required to pass the tests 

Difference < 0.2 nm 

There are two tests for wavelength reproducibility. The first involves scanning the 541.92 nm peak in the 
xenon lamp spectrum. The second involves scanning the 451.30 nm transmission minima in the spectrum 
of a solution of holium perchlorate. 

The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  

See also: 
Configure  
Regulations 
Validate Application

Wavelength Reproducibility (Ho)—Validate 

Note: 
The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  
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The test procedure consists of repeating the wavelength accuracy test ten times to validate the wavelength 
reproducibility of each monochromator independently. The procedure is separated into two tests, 
consisting of the following: 

Validation of the excitation monochromator wavelength reproducibility
Validation of the emission monochromator wavelength reproducibility

The test for holium perchlorate consists of repetitively scanning from 448–454 nm to measure the 
transmission minimum in the region. This scan is performed 10 times, and the maximum difference must 
have a magnitude of less than 0.2 nm. 

Sample required 

Excitation monochromator: 
No sample is required for this tests as it is the signal from the reference PMT that is being monitored. 

Emission monochromator: 
A ground silica screen diffuser must be placed in the sample position. 

Specifications required to pass the tests 

Difference < 0.2 nm 

There are two tests for Zero% T accuracy. The tests measure the 'blackness' or absence of light on the 
detection side of the Cary Eclipse instrument. The amount of 'blackness' is affected by the amount of light 
that leaks from outside the instrument as well as the amount of light leaking from the sample chamber 
when the lamp is flashing but the emission filter is in the Closed position. 

To evaluate the 0%T accuracy, two tests are performed. The first, in which the light levels in the sample 
chamber are low, such as looking at the Raman band of water, examines the shot noise of the instrument 
at high sample PMT voltage settings. A second test in which excitation light is scattered off a ground 
silica screen diffuser with the emission wavelength set to equal that of excitation (simulating high 
scattered light levels in the sample compartment) is required to examine the electronic noise at low 

See also: 
Configure  
Regulations 
Validate Application

Zero% T Accuracy—Validate 

Note: 
The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  
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sample PMT voltages. In both cases the 0%T measurements are taken with the instrument's emission 
filter closed. 

The two tests used are: 

Raleigh scattering
Raman band of water

Rayleigh scattering 

Raleigh scattering is phenomenon explained by considering a liquid or gas as being made up of discrete 
molecules containing minute regions of fluctuating reflective index. Any light passing through the 
medium will thus be refracted an number of times, when passing through the medium and continue at 
angles at other than that of the exciting beam. This type of scattering causes light to be emitted from the 
sample at the same wavelength as the excitation wavelength. 

Sample required 

A ground silica screen diffuser is placed in the cell holder to create a highly scattered source. The 
emission filter is closed and the reading from the detector taken. 

Specifications required to pass the test 

-0.01 < Signal < +0.01

What if my instrument fails to meet the specification? 

Check the water was placed in the sample position in a clean quartz fluorescence cuvette.
Check the sample compartment lid was fully closed during the test.
Repeat the test.

If the instrument still does not meet the specification, please contact your local Varian Service office as a 
service call may be required. 

Raman water 

The Raman band of water simulates the fluorescence effect. The Raman effect is observed as a low level 
signal produced at a higher wavelength to that of the excitation wavelength. The effect is caused when 
molecular vibrational energy caused by light scattering is released as a photons at a wavelength different 
to the excitation wavelength. 

As the light emitted at the shifted is of a low intensity the instrument detector PMT voltage is increased. 
This makes the Raman band ideal as a measurement of low signals at a high PMT voltage. 

Sample required 

A clean quartz cuvette containing distilled water in the cell holder to perform this test. The emission filter 
is closed and the reading from the detector taken. 

Specifications required to pass the test 
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-0.01 < Signal < +0.01

What if my instrument fails to meet the specification? 

Check the water was placed in the sample position in a clean quartz fluorescence cuvette.
Check the sample compartment lid was fully closed during the test.
Repeat the test.

If the instrument still does not meet the specification, please contact your local Varian Service office as a 
service call may be required. 

This test measures the maximum instrumental signal-to-noise ratio, which involves measuring the signal-
to-noise from a highly fluorescent sample such as Rhodamine B. 

Sample required 

A Rhodamine B in PMMA block must be placed in the sample position. 

Specifications required to pass the test 

S/N > 1000:1 

What if my instrument fails to meet the specification? 

Check that you have set the tolerances to values that are within the specifications of the Cary
instrument.
Check that the PMMA block was inserted into position.
Perform the maximum signal to noise test again.

If it still fails, contact your local Varian Service office as a service call may be required 

See also: 
Configure  
Regulations 
Validate Application

Maximum Signal to Noise—Validate 

Note: 
The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  

See also: 
Configure  
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The Cary Eclipse Stability test measures for instrument stability as a function of time. The stability test 
involves measuring the signal from a highly fluorescent sample for an extended period of time. The test is 
similar to the maximum signal-to-noise test except that during the stability test, the signal averaging time 
is increased to 10 s and the collection time is increased to 1 hour. 

Instrument Stability is particularly important when the instrument is to be used over long time periods for 
example when performing repetitive sample scans or when using a Wellplate reader accessory. 

Sample required 

A Rhodamine B in PMMA block must be placed in the sample position. 

Specification required to pass the test 

T stab < 0.5% 

What if my instrument fails to meet the specification? 

Ensure that the PMMA block was placed in the sample position
Check that you have set the tolerances to values that are within the specifications of the instrument
Check that the instrument was warmed up before the test commenced
Perform the stability test again

If it still fails, contact your local Varian Service office as a service call may be required. 

The following ASTM Tests are available in the Validate application:

Regulations 
Validate Application

Stability—Validate 

Note: 
The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  

See also: 
Configure  
Regulations 
Validate Application

ASTM Tests—Validate 
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Detection Limits

The Detection Limits test adheres to the requirements for ASTM standard E 579-84 "Standard Test 
Method for Limit of Detection of Fluorescence of Quinine Sulfate". The method employs the signal-to-
noise ratio theory to determine the sensitivity of a fluorescence measuring system in testing for the limit 
of detection (LOD) of quimine sulfate. 

The ASTM standard states that “The practical lower limit of this test method is 1ng of quinine sulfate per 
ml (one part per billion; 1ppb)”. 

Varian does not provide a specification for this test, however it can be used to monitor instrument 
performance over time. 

Sample required 

Quinine sulfate in 0.1 N H2SO4 at a concentration of 10-3 μg/ml (1 ng/ml; 1 ppb) as well as the reagent
blank (0.1 N H2SO4). 

What if my limit of detection is higher than expected? 

Ensure that the Quinine sulfate was placed in the sample position
Check that the solution was prepared correctly and the cuvette was clean
Repeat the test
Perform the limit of detection test again.

If it still fails, contact your local Varian Service office as a service call may be required 

Enable All Tests—Validate 

See also: 
Configure 
Validate Application

Detection Limits—Validate 

Note: 
The parameters on this page will have most of their fields disabled, as they will be automatically set 
to values that are appropriate for achieving guaranteed instrument specifications. Simply select the 
test check box to include it in the Test Order list on the Configure page. 

It is recommended that you leave the Validate parameters at their default settings, however if the 
Cary Eclipse software is under GLP control and you have administrator privileges, you will be able 
to alter these parameters.  

See also: 
Configure  
Regulations 
Validate Application
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The following tests are available in the Validate application:

Wavelength Accuracy Ex. Mono (Xe)
Wavelength Accuracy Em. Mono (Xe)
Wavelength Accuracy Ex. Mono (Ho)
Wavelength Accuracy Em. Mono (Ho)
Wavelength Reproducibility Ex. Mono (Xe)
Wavelength Reproducibility Em. Mono (Xe)
Wavelength Reproducibility Ex. Mono (Ho)
Wavelength Reproducibility Em. Mono (Ho)
0%T Accuracy (Rayleigh scatter)
0%T Accuracy (Raman band)
Spectral Bandwidth Accuracy Ex. Slit
Spectral Bandwidth Accuracy Em. Slit
Sensitivity 350/397
Sensitivity Raman 2
Sensitivity Raman 3
Fluorescein detection limit
Stray Light
Maximum Signal to Noise
Stability
Detection Limits (ASTM)

Use the Setup dialog to set up your report and email options. 

The Setup dialog comprises the following tabbed pages:  

Reports
Auto store

Use the Setup menu to access the following pages. 

See also:
Configure
Validate Application

Setup—Validate 

To access the Setup dialog select the Setup button from the Validate Application window 
or the Setup command from the Setup menu.

Setup menu—Validate 

Command What it does
Setup Select Setup to display the Setup dialog where you can access the Reports and  Auto 

Store pages.
Reports Choose Reports to display the Reports page. You can use this page to set up the report 
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Use the Reports page to set up the report parameters associated with data collection. 

From the Setup menu, select Reports to access the Reports page. You can also access the page from the 
Setup dialog by selecting the Reports tab. To access the Setup dialog, select the Setup button from the 
Validate Application window. 

The page comprises the following: 

Operator 

Options 

This group enables you to select the information to include in your report. 

parameters associated with data collection.
Auto Store Choose Auto Store to display the Auto Store page where you can specify an email 

address to send a message to notify when the Validate run is completed.

See also: 
Reports  
Auto Store   
Validate Application

Reports—Validate 

Name Enter the instrument operator name in this text entry field. Use the arrow to the right of 
this field to view and select one of the last ten entries in this field. 

Note 
In GLP mode the system will automatically enter the operator’s name and this 
field will not be editable.

Comment Enter operator details and comments in this text entry field.

Auto Print Select Auto Print to print a report automatically during the data collection. 
If Auto Print is selected, then the system will send the report information to the 
specified printer(s) as well as the Report area. However if Auto Print is not selected, 
the report will only be sent to the Report area and can be viewed by selecting Report in 
the View menu. 

To automatically obtain a copy of the graphics, you will need to select both the Auto 
Print and Graph options (see below). In this case, all graphical information displayed 
on screen will be printed with the report. Therefore it is advisable to arrange the 
graphical information as you require on screen, prior to printing. 
For example, if you require a single graph print out, then the Single/Multi Graph 
option in the Graph menu should be changed to the correct setting. 

Graph Select Graph to include any graphs or graphic information associated with your report.
If you require a printout of the displayed graphics only, you must ensure that only this 
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Report Toolbar—Validate 
Use the Report toolbar buttons to gain quick access to many of the Edit menu options. You can also use 
the toolbar to cut, copy and paste information and to change the look of your report. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Reports. To 
display or hide the toolbar's text labels, point to the Toolbar option in the View menu and select Text 
Labels. 

The following commands can be accessed from the Report toolbar: 

option is selected. Select the Clear Report button to clear any information in the 
Report area before you print otherwise this will be included in your printout. 
% Page Height 
Enter the size at which you want the graph to be printed, as a percentage of total page 
height. For example, if you want graphical information to take up half of the page, enter 
50% in this field.

Company 
Logo 

Select this option to include your company logo in the report. 
A company logo will only be included if you have added one on the Company page of 
the System Information Application. 

Hot Tip 
If you have not included a company logo, select the Header/Footer button to 
open the System Information Application and use the Add Logo option to add a 
logo.

Header/ 
Footer 

Select the Header/Footer button to open the System Information application where you 
can enter the Header and Footer information to be included in your report. You can also 
enter any additional comments, and add a logo to your report. Once you have made all 
your changes, select OK to exit the System Information application and return to the 
Reports page of the Validate application.

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, 
Microsoft Word or Microsoft Excel) into the report area of the of the Lifetimes application. To edit 
these objects, simply double click on them to open the associated application in which they were 
created.

See also: 
Validate Application   
Peak Labels 
View menu

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Edit Report Click this button to edit the report. 
This command is also accessible by pressing CTRL+R.
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Clear Report—Validate 
Select Clear Report to remove the contents of the Report area. If you have saved the report, selecting 
this option does not delete the contents of the report, the information is simply removed from the Report 
Area. 

You can select the Clear Report button from the Validate Application window or the Clear Report 
command from Commands menu.  

How to use advanced reporting options—Validate 
This outlines ways to fully customize your reports. Options available include:  

Including header and footer information
Including a logo
Editing the text in the report
Viewing the report on screen before printing

Undo If available, this undoes the last action. 
This command is also accessible by pressing CTRL+Z.

Cut Click this button to remove the highlighted text and place it on the Windows 
Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Click this button to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.

Paste Click this button to insert the contents of the Windows Clipboard (text only) at 
the cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Click this button to remove selected text in the Report area. 
This command is also accessible by pressing DEL. 

Note 
The command is only available once you select Edit Report and there is 
text highlighted in the Report area.  

Font Click this button to change the font of new or selected text in the report. For 
existing text, simply highlight the text in the report, select this button and make 
your changes in the Font dialog. When you select OK, the appearance of the 
highlighted text in the report will alter to reflect your font changes. 
This command is also accessible by pressing CTRL+F.

Preview Click this button to display the Print Preview dialog where you can view the 
current report as it will be printed.

See also: 
Print Preview 

 
See also: 
Validate Application 
Commands menu
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Cutting and pasting to a word processor

Including header and footer information 

You can have text appearing at the top and bottom of every page in your report. To specify what the text 
should be, do the following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then 
select System Information. The System Information application appears with the Company page 
displayed. 

Step 2 

Enter the header and footer information in the Header and Footer fields. 

Step 3 

Click OK to implement your changes. 

Including a logo 

You can include a logo on the first page of your report. To specify what the logo should be, do the 
following:  

Step 1 

On the Windows Taskbar, click the Windows Start button, point to Programs, Cary Eclipse and then 
select System Information. The System Information application appears with the Company page 
displayed. 

Step 2 

Enter a logo using the Add Logo button. This logo will always be included on the front page of reports. 

Step 3 

Click OK to implement your changes. 

Editing the text in the report 

You can edit any of the text in the Report area. Just select Edit Report from the Edit menu. You can 
then add, delete and change text in the Report area. 

Q. Why isn't the logo I selected included in my report?
A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to specify the logo in the System Information application.
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Viewing the report on the screen before printing 

You can view a report before printing it. To do this, from the File menu select Print Preview. You can 
then ensure that the report format is correct before you print it. 

Cutting and pasting to a word processor 

To have complete control over how your report looks you may wish to copy it to a word processor 
program, such as Microsoft Word. To do this: 

Step 1 

Open a report. 

Step 2 

From the Edit menu, choose Edit Report. 

Step 3 

Click in the Report area and highlight the text you want to export to your word processor. 

Step 4 

Right-click on the Report area and select Copy from the menu. 

Step 5 

Start up your word processor and use the Paste function (usually under the Edit menu) to place the text 
into a document. 

Use the Auto store page to set up the system to automatically send an email at the end of a read.

Q. The Edit Report option is not available, why not?
A. You do not have reporting editing privileges set in the GLP Administration application. The
Administrator of the system will have to change your privileges before you can edit reports.

Hot Tip 
Use the arrow keys at the bottom of the Print Preview screen to change pages.

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to alter the look of your graphs 
How to display a trace that is not appearing

Auto Store—Validate 
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To access the Auto store page, select the Auto store command from the Setup menu. You can also 
access the page from the Setup dialog, by selecting the Auto store tab. To access the Setup dialog, select 
the Setup button from the Validate Application window or the Setup command from the Setup menu. 

The page comprises the following: 

Email 

Select the Email check box and enter the Email details to send an email to a person once the read is 
completed. This useful facility can be used to alert you to the completion of the read, particularly if you 
are working away from the laboratory where the Cary Eclipse instrument is. You can also attach the 
collected data to the email. 

How to email your results—Validate 
You may wish to send an email to a person once the read is completed. This useful facility can be used to 
alert you to the completion of the read, particularly if you are working away from the laboratory where 
the Cary Eclipse instrument is. 

To do this: 

Step 1 

Ensure that you have set up the Host and Port options on the Email options page of the System 
Information application in order for the email facility to work correctly. 

Step 2 

From the Setup menu, select Auto Store. The Auto Store page is displayed.

Note 
You must set up the email Host and Port options on the Email options page of the System 
Information application in order for the email facility to work correctly.

To Enter the recipient's email address. You can enter more than one recipient in this field.
From Enter your email address (or the email address associated with the computer on which 

the Cary Eclipse software is installed.
Subject Enter the subject of your email (or leave this field blank if you do not wish to include a 

subject).
Cc Enter the email address of any recipient you want to copy the email to.
Message Enter your message.
Attached… Use the Attached button include a file attachment in your email. To do this, select 

Attached and browse your computer to select a file, using the Windows® Open dialog 
that appears.

Attach 
current data 

Select this option to attach the data that has been collected during the run to the email.

See also: 
How to email your results  
Validate Application
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Step 3 

Select the Email check box to enable the email options. 

Step 4 

In the To field, enter the recipient's email address (for example, rchandler@varianinc.com). To enter 
multiple recipients, simply type a comma ',' between each email address. 

Step 5 

In the From field, enter the email address of the computer on which the Cary Eclipse software is 
installed. This may be your email address, or a communal email address, if the Cary Eclipse software is 
installed on a computer that has multiple users. 

Step 6 

Enter information in the Subject and Message fields as required. 

Step 7 

Select Attach current data. The data that has been collected during the run will be attached to the email.

Step 8 

Select OK to clear the Auto Store dialog. Your email will be sent once the run has been completed. 

How to set up tests for validation—Validate 
Start the Validate application
Set up test parameters
Start the Validate run
After the run

Start the Validate application  

Step 1 

On the Windows Taskbar, click the Start button, point to Programs, Cary Eclipse and then select 
Validate. The Validate application appears.

Hot Tip 
You can attach other documents to your email. To do this, select the Attached button and browse 
your computer to select a file, using the Windows® Open dialog that is displayed.

See also: 
Auto Store 
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(Alternatively, you can double-click the Validate button in the Cary Eclipse folder on the desktop.)

Set up test parameters 

Step 2 

From the Validate Application, select the Tests button to open the Tests dialog. The Configure page is 
displayed. 

Step 3 

On the Configure page, ensure that the Auto Excitation PMT voltage option is selected. Selecting this 
option enables the instrument to set the optimum photomultiplier voltage for the system. The voltages 
used during the test will be displayed on the report. 

Step 4 

Select the type of instrument performance tests that you require. The various tests that are available will 
appear as tabs across the top of this dialog. 

If your access privileges are restricted by the GLP application you may find that fields and buttons in this 
dialog are not accessible. See your administrator to gain access. 

Step 5 

Click on each tab and select the tests that you require to be performed by ticking the appropriate 
checkbox. 

Change any parameters that you require to be changed to suit your laboratory in each test. 

If you wish to save the tests you have set up for future use select Save Method As from the File menu. 
The Save As dialog will be displayed to enable you to the method with an FMVO extension. 

Start the Validate run 

Step 6 

Click the Start button or select Start from the Commands menu to commence the testing procedure. 

Follow the instructions on the prompts that appear and select the OK button to continue with the 
performance tests. 

You can select the Cancel button at any time to stop the Validate run. 

Note 
If you are running a GLP system, you may be prompted to enter a password before accessing the 
Validate application.

Note 
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The results for each test are displayed in the Report area immediately after the test is completed. 

After the run 

Step 7 

At the end of the Validate run, the Cary system automatically generates a report file. The report file is 
stored the "Cary Eclipse WinFLR" directory. 

The Report file will be saved with the following format: 

DATE TIME.FRVO 

For example, 

16 Apr 00 3;57;48 PM.FRVO 

The date and time will appear in the same form that is set in the Windows Regional Settings Properties 
dialog box that is accessed from the Windows Control Panel. 

At the end of the Validate run, you can also save your data. To do this, select Save As… from the File 
menu. The Save As dialog will be displayed to enable you to save the current method, data and report in 
a batch file (FBVO). 

How to care for standard and reference materials—Validate 
General care
Cleaning instructions for liquid samples
Re-calibration of liquid samples
Ordering NIST reference materials
Recalibration of NIST filter standards

To maintain optimum optical and reflectance properties of the optical standards, the following care and 
cleaning instructions must be followed. 

General care 

Although the materials used for these standards are quite durable, care should be taken to prevent 
contaminants from contacting the materials surface, such as finger oils from contacting the material 
surface. Always wear clean gloves when handling these materials.

The Validate application will automatically arrange the tests so that tests requiring your 
intervention (for example, placing filters or solutions into the sample compartment) are performed 
early in the Validate run. Tests that do not require your intervention will be performed later in the 
run. The system will advise you when you are no longer required. However, you can change the 
order of the tests if you require.

See also: 
Save As
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The liquid standards must not be allowed to freeze and it is recommended that they be stored within the 
temperature range of 5–50 °C.  

Cleaning instructions for liquid standards 

Dirty cells are the greatest single source of error in spectrophotometry. Avoid handling the cells by the 
polished surfaces. In the event of the faces becoming contaminated, clean by soaking in a neutral 
detergent solution according to the manufacturers instructions. Rinse thoroughly with deionised water 
and dry with ethanol. DO NOT use ACETONE.  
Solution spillage should never be allowed to dry on the cells and should be wiped off with a soft tissue 
paper or lint free cloth. 

Recalibration of liquid standards 

Starna, the recommended supplier of liquid standards, recommend that their liquid standards sets be 
recalibrated every two years. However, most accreditation authorities require that standards be 
recalibrated at least once per year. The calibration of the liquid standards does not usually change 
significantly within this time interval unless the cell becomes cracked, marked or scratched. If this occurs,
the cell will require re-polishing to restore its accuracy. 

For recalibration of the Starna liquid standards, please contact your nearest Starna distributor. 
Alternatively you can contact: 

Starna Pty Ltd. 
PO Box 113,  
Thornleigh,  
NSW 2120,  
AUSTRALIA 

Email: sales@starna.com.au 
FREE CALL: 1 800 252 284
Telephone: +61-2-9484-0033
Facsimile: +61-2-9484-0055

Optiglass Ltd.  
52/54 Fowler Road 
Hainault Industrial Estate 
HAINAULT 
ESSEX 1G6 3UT 
ENGLAND
Telephone: +44 181 501 5550
 Facsimile: +44 181 501 1118

Starna Cells Inc. 
5950 Traffic Way  
ATASCADERO  
CA 93423  
USA
Telephone: 1 805 466 8855
Facsimile: 1 805 461 1575

Starna GmbH 
Postfach 1206 
D-64311 Pfungstadt
WEST GERMANY

Telephone: +49 6157 7953
Facsimile: +49 6157 85564

Starna Ges.mbH Wien 
Skallgasse 20     
A-3403 Klosterneuberg
AUSTRIA

Telephone: 02243 85009

Starna S A R L 
Sopares SA 
Societe Parisienne D'Equipement Scientifique 
51 Bix, Rue Raymond-Lefevre 
94527 Gentilly, CEDEX 
FRANCE
Telephone: +33 1 4986 4401
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Ordering NIST reference materials 

Purchase orders (in English) for all NIST SRMs/ RMs should be directed to: 

Each purchase order should give the number of units, catalogue number, and name of each reference 
material requested. 

Example: 1 each, SRM 930e, Glass Filter Set, Transmittance 

The following information must be included with each order: 
a billing address, a shipping address, name of customer, telephone number, fax number, purchase order 
number, a customer identification number, i.e.., a social security number (SSN) for consumer customers, 
tax identification number (TIN) for commercial customers, or agency code (ALC) for U.S. government 
customers. 

Recalibration for the NIST Filter standards 

For recalibration of the NIST filter standards, please contact your nearest NIST distributor. Alternatively 
you can contact: 

Performing tests—Validate 
Calibration
Start/Stop buttons
Go To dialog

Facsimile: 02243 85019 Facsimile: +33 1 4547 0777

National Institute of Standards and 
Technology Standard 
Reference Materials Program 
Room 204, Building 202 
Gaithersburg, MD 20899-0001 
USA
Telephone: +1-301-975-6776
Facsimile: +1-301-948-3730
Email: SRMINFO@enh.nist.gov

Calibrations Program 
National Institute of Standards and Technology 
Room A104, Building 411 
Gaithersburg, MD 20899-0001 
USA
Telephone: +1-301-975-2002
Facsimile: +1-301-926-2884
Email: CALIBRATIONS@enh.nist.gov
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Rapid Result dialog
Zero dialog
Commands menu
How to set up and perform a Validation test

Calibration menu—Validate 
Use the Calibration menu to open or save a method or data file, print or preview a report, or exit the 
Cary Eclipse application. 

The following commands can be accessed from the Calibration menu: 

The following buttons may be displayed at the top of the Validate Application window. The Start and 
Connect buttons will change depending upon the status of the instrument. For example, if the instrument 
is ready for a a run, the Start button will be visible to indicate that the system is ready to commence a 
run. 

Wavelength 
Calibration

Select this option to perform a wavelength calibration. The Xenon emission lines at 0 nm 
and 541.92 nm are scanned with  both the emission and excitation monochromators to 
ensure that the wavelength scale is accurate. You will be prompted to insert a diffuser 
during the calibration of the emission monochromator. Note that you should perform an 
EHT calibration before a wavelength calibration.

EHT 
Calibration

Select this option to perform an EHT calibration. This will calibrate the signal on the 
excitation reference detector. The instrument will scan across the whole wavelength 
range, at each slit width, using the Xenon emission lines to ensure that the detector 
response is within the required range.

See also: 
Tests

Start/Stop buttons—Validate 

Select Start to commence a Validate run using the selected tests. 
If any unsaved data exists in the Graphics area you will be prompted to save the 
data. If you choose not to save, any unsaved data, pictures and labels will be 
deleted when you start the run.
If another application is already online with the Cary Eclipse, the Start button 
will change to Connect, and you will need to select Connect to bring this 
application online before the Start button will re-appear. (You will not be able to 
connect if the other application is collecting data.)
Select Stop to end a Validate run.

See also: 
Graphics area 
Commands menu 
Auto Store page 
Validate Application 
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Go To Wavelength—Validate 
Use the Go To Wavelength dialog to temporarily change the instrument to a new excitation or emission 
wavelength. You would mainly use this dialog if you want to quickly go to a wavelength and check the 
intensity reading of the sample. The lamp will flash continuously in this mode. This option is only 
available if the instrument is not currently collecting data. 

To access the Go To Wavelength dialog, select the Go To Wavelength command from the Commands 
menu. You can also select F4 to open the dialog. 

The Go to Wavelength page comprises the following: 

Rapid Result—Validate 
Use the Rapid Result dialog to take a reading of a blank and sample/s, without having to change the 
current application method. This means that between runs, while new samples are being prepared and 
loaded, other samples can quickly be measured. The result is printed in the Report area. 

To access the Rapid Result dialog, select the Rapid Result command from the Commands menu or 
press F6. 

Note 
This is not the wavelength used in the application method. If your method uses a wavelength that is 
different from the Go To Wavelength setting you select, then when you select Start the system will 
change to the wavelength selected (as set on the Cary page of the Setup dialog).

Excitation Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go To the 
instrument will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm 
(white light). You can then use this light for aligning accessories. 

Emission Wavelength 
Enter the new wavelength in this numeric entry field. When you select Go To the 
instrument will change to the new value. 

Zero Order 
Select Zero Order to drive the Cary Eclipse fluorescence spectrophotometer to 0 nm 
(white light). You can then use this light for aligning accessories. 

Go To Click Go To once you have entered a new wavelength, to change the instrument to the 
entered value.

See also: 
Commands menu  
Function Keys

Excitation 

Wavelength 
Enter the wavelength at which you want to take a reading. 
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Zero—Validate 
Use the Zero button to zero the current intensity value. The intensity value will be reset to zero and all 
subsequent results will have the value that was reset to zero subtracted from them. You can use the Zero 
command before commencing a data collection if you want your data to start at 0  intensity. The Cary 
Eclipse will prompt you to load a blank before performing the zero. 

Before you select Zero, ensure that you have placed the blank solution in the cell positions that are 
currently in the cell path. 

When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left corner of the 
Validate Application window. 

Select the Clear Zero command from the Commands menu to remove zero correction and thus remove 
the subtraction effect. 

Commands menu—Validate 
Use the Commands menu to access major operational commands in the Validate application . The menu 
is accessible from the menu line at the top of the Validate Application window. 

Alternatively you can use function key shortcuts for some of the commands. These appear next to the 
item in the Commands menu. Note that not all commands appear as both button and menu items. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Emission Wavelength 
Enter the wavelength at which you want to take a reading. 

Zero order 
Select this option to set the excitation monochromator to zero order (white light). 

Zero Select Zero to change the wavelength to the entered value and measure a blank.
Result Select Result to change the wavelength to the entered value and measure a sample. The 

X,Y results are corrected for the blank and appear in the reports area. 

See also 
Commands menu

To access the Zero option, select the Zero command from the Commands menu, or select 
the Zero button from the Validate Application window. 

See also: 
Validate Application 
Commands menu 

 
Hot Tip 
If you access these commands using the Commands menu, rather than from the application buttons, 
you can remove these buttons from your application window. To do this, clear the Buttons 
command in the View menu. This will enlarge the Graphics area, making viewing and selection of 
scans easier. 
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The following commands are accessible from the Commands menu: 

How to remove or display the Command buttons

Command Enables you to…
Start Select this to commence the selected tests. 

Note 
If the Connect command is displayed in place of the Start command, this 
indicates that another Cary Eclipse application is in use and has control of the 
Cary Eclipse instrument. To make the Scan application active so that you can 
perform a read, you will need to select Connect. However, you will not be able to 
select Connect if another application is collecting data.

Stop Select this to stop the Validate run.
Clear Zero Select this option to clear the Zero command. When you select the Zero command 

(from the Commands menu or by pressing F5), the intensity at that time will be reset to 
zero and all subsequent results will have the intensity value that was reset to zero 
subtracted from them. Selecting Clear zero cancels this zeroing (and thus subtraction) 
effect.

Zero Order Select the Zero order command to set one of the monochromators to zero order. The 
Cary Eclipse software will use the zero setting when collecting data. 

The Zero order command is generally used during alignment procedures.  

Excitation 
Select this command to set the excitation monochromator to zero order (white light). 

Emission 
Select this command to set the emission monochromator to zero order (white light). 

Reset Select this command to re-initialize the instrument. This will perform the same 
initializing procedure that is performed when the instrument is powered on.

Rapid 
Result… 

Select this to display the Rapid Result dialog. Use this dialog to take a reading of a 
blank and multiple sample readings without changing the application method. You can 
only do this when the Validate application is not performing instrument tests. 
This command can also be accessed by pressing F6.

Zero Select this to zero the current intensity value. The intensity value will be reset to zero 
and all subsequent results will have the value that was reset to zero subtracted from 
them. You can use the Zero command before selecting Start if you want your data to 
start at 0 intensity. 
This command is also accessible by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Go to… Select Go To… to display the Go To Wavelength dialog where you can change the 
instrument to a new wavelength. Use this command if you want to quickly go to a 
wavelength to check the intensity reading. 
The command is only available if the instrument is not currently collecting data. It can 
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Viewing run progress and results—Validate 
Reports page
Reports toolbar
View menu
Edit menu
Status display
Print Preview dialog
Print
How to use the advanced reporting options

View menu—Validate 
The View menu is accessible from the menu line at the top of the Validate Application window. 

The following commands can be accessed from the View menu: 

also be accessed by pressing F4.
ADL 
Command… 

Select this to display the ADL Command Line window where you can execute an 
ADL command or ADL program. You can also press ALT-Y to display this dialog.

Re-run ADL Select this to run the ADL command or program in the ADL Command Line window 
again. You can also press ALT-X to rerun programs.)

Tests Select this to display the Tests dialog where you can set up performance tests. You can 
use the dialog to configure your instrument to check its performance based on the 
regulatory specifications you select.

See also: 
Validate Application   
Start/Stop buttons  
Rapid Result   
Zero  
Go To Wavelength   
ADL Command Line  

Command Use this to…

Toolbars Select this option to toggle the Graphics and Reports toolbar on and off. You can also 
select to display or hide the toolbar Text Labels.

Buttons Select this option to toggle the left-hand button display (button area) on and off.

Graphics Select this option to toggle the Graphics area on and off.

Report Select this option to toggle the Report area on and off.

Report 
Vertical 

If the Graphics option is selected, select Report Vertical to display the Graphics area, 
Report area and/or ADL Editor side by side vertically.

ADL Select this option to toggle the ADL Editor on and off.

ADL If the ADL and Report options are selected, select ADL Vertical to display the ADL 
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Edit menu—Validate 
Use the Edit menu to copy, cut, paste and delete information. You can also use the menu to access the 
Report editing commands. 

The following commands can be accessed from the Edit menu: 

Vertical Editor vertically on the right hand side of the Report area.

ADL Quick 
Reference 

This displays the Quick Reference window which you can use to easily add a 
command in the correct syntax to your ADL program. A detailed description of all the 
commands in the Quick Reference is available by selecting the Help button on this 
window.

ADL Hooks Select this to activate a link (or hook) to an ADL program at a specific point in the 
application, and then run that ADL program. For example, ADL hooks have been 
supplied to run specific programs: 

on start-up of the Cary Eclipse software;
when the system goes online or offline;
when the Start button is selected;
when a run finishes;
when a zero is performed etc.

For the hook to work, ADL Hooks must be selected, and the appropriate ADL file for 
the application must be present in the Varian/Cary Eclipse WinFLR/ADL folder on the 
drive on which the Cary Eclipse software is installed. 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help.      

Hints Select this option to toggle the Hints bubble text on and off. Hint text appears when 
you place the arrow cursor over a field, button or text entry field for a short period. It 
offers a quick explanation of the item’s function.

Status 
Display 

Select this option to display the Status Display window, where you can view the status 
of various parameters during the data collection.

See also: 
Validate Application 
Graphics area 
ADL Hooks 
How to insert ADL commands using the Quick Reference 
Status Display

Note 
These commands are also accessible from the Report Toolbar. To display the Report Toolbar, 
from the View menu, point to Toolbars and select Report. 
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Status Display—Validate 
Use the Status Display window to view the status of your scan during the data collection. Depending 
upon settings you have for the scan, the following parameters may be displayed:  

Data Mode
Scan Mode
Average time
Current Excitation Wavelength
Reference PMT Voltage (V)

Menu 
command 

Button Enables you to… 

Undo If available, this undoes the last action that was performed in the report area. 
This command is also accessible by pressing CTRL+Z.

Cut Select this command to remove the highlighted text and place it on the Windows 
Clipboard. 
This command is also accessible by pressing CTRL+X.

Copy Select this command to copy the highlighted text onto the Windows Clipboard. 
This command is also accessible by pressing CTRL+C.

Paste Select this command to insert the contents of the Windows Clipboard (text only) 
at the cursor. Any highlighted text will be replaced. 
This command is also accessible by pressing CTRL+V.

Delete Select this command to remove selected text in the Report area. This option is 
only available once you select Edit Report and there is text highlighted in the 
Report area. 
This command is also accessible by pressing DEL. 

Select All Select this option to highlight all text in the Report area. 
This command is also accessible by pressing CTRL+A.

Font This enables you to change the font of new or selected text in the report. For 
existing text, simply highlight the text in the report, select Font and make your 
changes in the Font dialog. When you select OK, the appearance of the 
highlighted text in the report will alter to reflect your font changes. You do not 
have to select Edit Report to use this command.  
This command is also accessible by pressing CTRL+F. 

Edit Report Select this option to edit the report. 
This command is also accessible by pressing CTRL+R.

Clear 
Report 

Select this command to remove the contents of the Report area. If you have 
saved the report, selecting this option does not delete the contents of the report, 
the information is simply removed from the Report area.

Hot Tip 
You can copy a picture, spreadsheet file or document from another application (for example, 
Microsoft Word or Microsoft Excel) into the report area of the of the Validate application. To edit 
these objects, simply double click on them to open the associated application in which they were 
created.
See also: 
Validate Application
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Excitation Slit width
Excitation Filter
Data Interval

To access the Status Display window, select Status Display from the View menu, or from the Configure 
page of the Tests dialog. You can choose to view the Status Display window at any time during a data 
collection. 

Print Preview—Validate 
Use the Print Preview dialog to view the current report before you print it. From the File menu, select 
Print Preview to access the dialog. 

The contents of the Graphics area appear first in the preview area followed by the contents of the Report 
area. You can reduce or enlarge the print preview on screen. To do this, click the left mouse button in the 
preview area to toggle through the five available views. Click the right mouse button in the preview area 
to return to the full page view. 

The page comprises the following commands: 

Print—Validate 
Use the Print dialog to select the printer and pages to print of the currently displayed report as well as the 
number of copies you wish to print. From the File menu, select Print to access the dialog. 

All graphical information displayed on screen will be printed with the report, therefore it is advisable to 
edit the report on the screen prior to printing. You can also preview the report prior to printing by using 
the Print Preview command. 

If you require a printout of the graphics in the Graphics area only, select the Clear Report button to erase 
the contents of the Report area before you print.

See also: 
View menu  
Configure page

First arrow Use this arrow to view the first page of the report.

Previous 
arrow 

Use this arrow to view the previous page of the report.

Next arrow Use this arrow to view the next page of the report.

Last arrow Use this arrow to view the last page of the report. 
Q. Why are the arrow buttons grayed out?
A. The buttons will be grayed out if the report has only one page of data.

Print Use this to display the Windows Print dialog where you can choose the printer 
and pages to print as well as the number of copies you wish to print.

See also: 
Print 
File menu
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Performing calculations—Validate 
Maths Calculator
Maths Operations
Maths How To

Maths window 
Calculation Field | Selected/Focused Trace | Trace | Display Options | Functions

Use the Maths window to perform mathematical manipulations on collected traces. In addition, it can act 
as a simple numeric calculator. 

The Maths window comprises the following: 

Note 
The options on the Report page are used to generate the contents of the Report area during a run or 
on a recalculation. If Auto Print has been selected the Cary Eclipse will automatically print a 
report at the end of a data collection. 

See also: 
Print Preview 
Report 
File menu

To access the Maths window, select the Calculator command from the Graph menu, or select the 
Calculator button on the Graphics toolbar. 
The Maths window is only available in the Kinetics, Lifetimes, Scan and Validate applications.

Calculation 
display field 

View the current calculation, including the trace/s being used, the trace operation being 
carried out and any functions that have been applied to the trace. 

Hot Tip 
Click on the down arrow adjacent to this field to view the last ten unique 
calculations that have taken place. Use this list to keep track of previous 
manipulations and repeat calculations quickly by simply selecting and then 
applying the desired calculation.

Selected 
Trace/Focused 
Trace 

Choosing either of these options selects the highlighted (red) trace in the current Graph 
box for manipulation. When choosing between these options, use this simple rule: 

Use the Selected Trace option when the selected calculation is only to be applied
to one trace.
Use the Focused Trace option when the same calculation is to be applied to a
number of traces.

The following example illustrates the difference between these options. 

To perform the same manipulation on several traces:  
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a. Highlight a trace by clicking on it with the mouse. The trace will become red.
b. Select Selected Trace, Apply and then = to plot the result of the calculation
c. Highlight the next trace and repeat step b.

OR  

a. Highlight the first trace.
b. Select Focused Trace, Apply and then = to plot the result of the calculation;
c. Highlight the next trace and select the = button to perform the same calculation

on the newly selected trace.
Trace Use the Trace group options to select the operation to be performed on the traces, the 

filter size and the interval (where applicable). 
Click Apply to insert the selected operation into the equation 
Click = (equals) to display the result of the calculations. 

Operation 
Click on an operation to find out more about it  

Anisotropy
Polarization
Sum Function
Mean
Boxcar Averaging
Moving Average
Savitzky-Golay
Spline
Deriv 1
Deriv 2
Deriv 3
Deriv 4

Display 
Options 

Select whether the results of the operation performed on the trace will be viewed in a 
New Graph box or in the Selected Graph box. If you choose the Selected Graph option, 
you will be able to directly compare the results with existing traces.

Functions This group contains number and function buttons that can be used as a standard 
calculator in addition to being applied to traces. 

To use the functions: 

1. select a trace or value
2. select either a second trace or number
3. select the equals (=) button to display the result

All the basic mathematical functions are available (addition, subtraction, multiplication 
and division), as well as logarithm (Log) and square root (Sqrt) functions. When used 
as a calculator, the results of equations appear in the Report area. 

Additional 
buttons 

C 
Click C to clear the entire operation in the calculation display field. 
CE 
Click CE to clear the last entry entered in the calculation display field. 
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= 
Click = (equals) to start the operation shown in the calculation display field.

See also: 
Maths Home Page 
Maths How To

Maths Operations 

The following operations can be selected on the Maths window. To access the Maths window, 
select the Calculator command from the Graph menu, or select the Calculator button on the 
Graphics toolbar.

Anisotropy, 
Polarization 
and Sum 
Function 

The term Anisotropy refers to an unequal angular distribution about a point in space. 
Anisotropy also refers specifically to a simple expression for measuring the degree of 
polarization of the fluorescence.  It is almost identical to the expression for polarization 
apart from having a factor of two in the denominator.  Anisotropy is usually represented 
by the lowercase letter " r ", while polarization by an uppercase  " P ". 

The two expressions are listed below: 

Anisotropy 
r = (Ivv - GIvh) / (Ivv + 2GIvh) 

Polarisation 
P = (Ivv - GIvh) / (Ivv + GIvh) 

where 

Ivv equals the intensity of fluorescence with excitation polarizer = vertical, emission 
polarizer = vertical 
Ivh equals the intensity of fluorescence with excitation polarizer = vertical, emission 
polarizer = horizontal 

G is a factor that accounts for the polarization bias of the instrument. In particular it 
accounts for the wavelength-dependent polarization bias of the emission side of the 
instrument (dominated by the polarization bias of the emission grating). 

The G factor is given by:  
G = Ihv/Ihh 

where 

Ihv equals the intensity of fluorescence with excitation polarizer = horizontal, emission 
polarizer = vertical 

Ihh equals the intensity of fluorescence with excitation polarizer = horizontal, emission 
polarizer = horizontal 

The expression for the anisotropy is a quotient.  The denominator of the expression, as 
given by Ivv + 2GIvh is the ‘sum’ function, and actually represents the total emission 
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unbiased by any sample polarization effects. 
Mean The Mean operation allows the average of two or more traces to be taken and the 

resulting trace to be plotted. The mean of the traces can also be used in conjunction with 
other functions. 

The equation used in mean calculations is: 

(scan 1 + scan 2...+ scan x)/x 

The calculation is performed over the common X range of the traces and the trace with 
the most dense data is used to determine the data points. The other traces are 
interpolated at the relevant data points. 

Boxcar 
Averaging 

This algorithm will take the number of points as defined by the Filter size, and average 
these, displaying the average at the middle X-point of the filter. 

For example, for the following: 

 The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x8, sum(y6:y10)/5) 
….. (xn-2, sum(yn-4:yn)/5). 

If there are not enough points at the end of the data set to complete the filter size, then 
these points will be ignored, hence, the gap at the end may be larger than the gap in the 
beginning. There will be a gap before the first point and after the last point of the 
smoothed continuum, with respect to the original unsmoothed data. This algorithm is 
only valid for evenly x-spaced data points.  

Within a time scan, (e.g., Advanced collect in kinetics) the data points may be unevenly 
spaced between different stages.  Each stage will be treated as a new collect, hence, 
there may be large gaps between stages.  If there are not enough points at the end of a 
stage to complete the filter size, then these points are ignored, hence, there may be large 
gaps at the end of a stage.  The filter size will be limited to odd numbers, with the 
minimum of 3 to a maximum of 101. 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5

Moving 
Average 

This algorithm will take the number of points as defined by the Filter size, and average 
these, displaying the average at the middle X-point of the filter. 

For example, for the following: 

The first smoothed data point will be (x3, sum(Y1:y5)/5), the next (x4, sum(y2:y6)/5) 
….. (xn-2, sum(yn-4:yn)/5). There will be a gap before the first point and after the last 
point of the smoothed continuum, with respect to the original unsmoothed data. This 
algorithm is only valid for evenly x-spaced data points. Within a time scan, (e.gg, 
Advanced collect in kinetics), the data points may be unevenly spaced between different 

Data: (x1, y1), (x2, y2), (x3, y3) ….. (xn,yn)
Filer size: 5
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Maths How To… 

stages. This will be treated by interpolation of data from the previous stage so as to give 
evenly spaced data points into the next stage. If there is not enough data for 
interpolation, then the next stage will be treated as a new collect, hence, there may be 
gaps and further delays in displaying the point. The filter size will be limited to odd 
numbers, with the minimum of 3 to a maximum of 101. 

Savitzky-
Golay 

The Savitzky-Golay technique operation enables  you to reduce the noise in the 
currently selected Maths scan by using smoothing. 

When you select this operation you will be prompted to enter a Filter Size from 5 to 
101. The larger the Filter Size, the more data points that will be smoothed.

You will also need to enter an Interval. The Interval refers to how many of the averaged 
points will be plotted on the smoothed trace. The smaller the interval, the more detail 
there will be in the trace. 

Consider selecting an Interval of 1. This would mean that when the smoothed 
continuum is plotted, every smoothed point will be displayed. 

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an
even number.

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select Smooth in the Operation field.

Spline 
Deriv 1–4 The Deriv operations allow you to obtain derivatives of a selected scan. The derivative 

can be of the orders 1 to 4. The resulting trace is then plotted.  The Savitzky-Golay 
technique is used for derivative calculations. 

On selection of the Deriv operation you will be prompted to enter a Filter Size from 5 to 
101. The Filter Size refers to the number of points around a particular point that will be
averaged to produce a new derived Y value. The lower the Filter Size, the more data
points that will be used in the derivative trace.

You will also need to enter an Interval. The Interval refers to how many of the derived 
points will be plotted on the resulting trace. The smaller the Interval, the more detail 
there will be in the trace. 

Q. I cannot enter a particular value; it keeps changing to another number — why?
A. The Savitzky-Golay technique requires an odd number to be entered, not an
even number.

Q. Why can't I see the Filter Size and Interval fields?
A. These will be displayed when you select one of the ‘Derivs’ in the Operation
field.

See also: 
About smoothing
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How to perform a spectral subtraction
How to perform a mean calculation
How to smooth a trace
How to derive a trace

Displaying data graphically—Validate 
Graphics area
Graphics How To
Graph menu
Graphics toolbar
Graph Labels
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label
Graph Pictures
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture
Trace Preferences dialog
Trace Preferences menu
How to select the focused trace
How to display a trace
How to remove a trace from a graph
How to remove a trace from the trace list
Graph Preferences dialog
How to alter the look of your graphs
Cursor Modes dialog
How to track the focused trace
Axes Scales dialog
How to scale your graph manually
How to scale your graph automatically
User Data Form
Peak Labels

Graphics area—Validate 
The Graphics area of the Validate application appears in the top half of the Validate Application and is 
used to display traces of collected data. In the Cary Eclipse system, the term 'graph' refers to the plotting 

See also:
Maths Home Page

Page 44 of 91Validate Home Page

 



area and is represented by a set of axes. The rectangular area surrounding the graph is referred to as the 
graph box. A graph will appear in the Graphics area when you select Start to commence a scan. 

To display or hide the Graphics area, select the Graphics command on the View menu. Double-clicking 
on the Graphics area enables you to toggle between half or full size display sizes. 

You can access the functions associated with the Graphics area by doing the following:  

selecting one of the Graphics toolbar buttons;
selecting a command from the Graph menu; or
clicking the right mouse button in the Graphics area and select a command from the menu

You can customize the graphics area to suit your requirements in the following ways: 

Note 
Not all functions are available on every menu.

Note 
All of the commands and dialogs listed are accessible from the Graph menu. 

To… Use the… Tell me how…

Change the axes scaling 
automatically

Autoscale graph command How to scale your graph 
automatically

Change the axes scaling manually Axes Scales dialog How to scale your graph manually

Modify the graph appearance 
(axes, trace)

Graph Preferences dialog How to alter the look of your 
graphs 

How to specify the number of tick 
marks and decimal places for your 
X and Y axes 

Add a new graph to the display Add Graph command

Remove a graph from the display Remove Graph command How to remove graphs

View single or multiple graphs Single/multiple graph 
command

Resize a graph box Cursor How to resize graph boxes

Track the focused trace Cursor Mode dialog How to track the focused trace

Select the focused trace Cursor How to select the focused trace

Display a trace in the graph Trace Preferences dialog How to display a trace that is not 
appearing in a graph box

Remove a trace from a graph Trace Preferences dialog How to remove a trace from a 
graph
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Validate How To 
Select the procedure you require below for a step-by-step informative guide on running the application 
software: 

How to set and perform a Validation test
How to care for standard and reference materials
How to combine data files into a batch file
How to email your results
How to use advanced reporting options
How to remove the command buttons from the application window
How to insert ADL commands using the Quick Reference

Remove a trace from the trace list Trace Preferences dialog How to remove a trace from the 
trace list

Zoom in and out on the graph Zoom In and Zoom Out 
commands

How to zoom a graph

Add a label to the graph box Add Label dialog How to add a label to a graph

Edit labels in the graph box Edit Label dialog How to edit a label

Moving labels in the graph box Cursor How to move a label

Resizing labels in the graph box Cursor How to resize a label

Delete labels from the graph box Delete Annotation 
command

How to delete a label

Add a picture to the graph box Add Picture dialog How to add a picture to a graph

Move pictures in the graph box Cursor How to move a picture

Replace pictures in the graph box Edit Picture dialog How to replace a picture

Delete pictures from the graph 
box

Delete Annotation 
command

How to delete a picture

Save the Graphics area you have 
set up as a graphics template

Save As dialog (from the 
File menu)

How to create a graphics template

Note 
The red trace in any graph box is the one on which all information appears and the one used for the 
cursor tracking. It is called the focused trace. 

See also: 
Graphics Toolbar 
Graph menu

See also:
Validate Application Home Page
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Graph menu—Validate 

Introduction 

Use the Graph menu to view data in various graphical formats or in multiple graphs in the Graphics area. 
You can double-click on the Graphics area to toggle the display through graph and report to graph only. 

In the Cary Eclipse system, the term 'graph' refers to the plotting area and is represented by a set of axes. 
The rectangular area surrounding the graph is referred to as the graph box. A graph will appear in the 
Graphics area when you select Start to commence a scan. 

The Graph menu can be accessed in the following ways:  

from the main menu at the top of the Validate Application window
by clicking the right mouse button in a graph box or the Graphics area

Menu commands 

The following commands can be accessed from the Graph menu: 

Graphics How To

Note 
The red trace in any graph box is the one on which all information appears and the one used for the 
cursor tracking. It is called the focused trace.

Menu 
command 

Button Enables you to… 

Print XY 
point 

Select this to print the cursor's current X and Y coordinates in the report area. 
This option is only available from the Graph menu that appears when 
you right-click in a graph box.

Copy 
Graph 

Select Copy Graph to copy the entire Graphics area to the Windows 
Clipboard. All of the graphs in the Graphics area will be copied to the 
Clipboard.

Paste to 
Graph 

Select Paste to graph to paste the contents of the Windows Clipboard into 
the Graphics area. Text is pasted as a label, graphics are pasted as pictures.

Add Graph Select Add graph to add a new graph box to the Graphics area. You may 
want to do this if you have, for example, a graph containing existing data and 
you want to collect some new data in a new graph.

Remove 
Graph 

Select Remove graph to delete the selected graph box from the Graphics 
area. The graph box is removed, but the data is not deleted and is still 
available from the Trace Preferences window. 
You may want to use remove graph if you have a large number of graph 
boxes open but only want to focus on some of these. 

Note 
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You can remove multiple graph boxes by first holding down the CTRL 
key and selecting the graphs to be removed and then selecting the 
Remove Graph button or menu item. Use the SHIFT key to highlight a 
range of graphs for removal.

Clear All 
Traces 

Select Clear All Traces to delete all traces from the graph/s. Note that 
selecting this option simply turns off the Visible property for the traces in the 
Trace Preferences window. You can redisplay the traces by making the traces 
Visible again in the Trace Preferences window.

Add Label Select Add Label to display the Add Label dialog where you can enter a text 
label to be placed on a graph or in the background of the Graphics area.

Add Picture Select Add Picture to display the Add Picture dialog where you can select a 
picture, bitmap or chemical structure to be placed on a graph or in the 
background of the Graphics area.

Edit 
Annotation 

Select Edit Annotation to alter the content or look of the selected annotation, 
(either a label or a picture) in the Graphics area. This option is only available 
if an annotation is selected. 

If the selected annotation is a label, selecting Edit Annotation will open the 
Edit Label dialog where you can change the text of the selected label. 
If the selected annotation is a picture, selecting Edit Annotation will open the 
Edit Picture dialog where you can replace the selected picture with a new 
picture. 

Delete 
Annotation 

Select Delete Annotation to remove an annotation, (such as a label or a 
picture) from the Graphics area. This option is only available if an annotation 
is selected. 
You can use this menu option to remove highlighted annotations in the 
Graphics area such as labels, pictures and ruler/fit information. 

Trace 
Preferences 

Select this command to display the Trace Preferences window where you 
can select the trace(s) to display in the selected graph.

Graph 
Preferences 

Select this command to display the Graph Preferences dialog where you can 
change the appearance of your graph. Any changes you make to the 
appearance of the graph will be applied to all graphs.

Cursor 
Mode… 

Select this command to display the Cursor Modes dialog where you can 
choose the type of cursor to be used on the screen. For example, you can 
select to use a free cursor that can move anywhere in the graph or exactly 
trace the focused scan (red scan).  Alternatively, you can select a cursor that 
enables you to draw a line from one point to another to determine the slope 
using either the Least Squares method or the Point to Point method.

Axes 
Scales… 

Select this command to display the Axes Scales dialog where you can set the 
scale range for the X and Y axes.

Auto scale 
graph 

To automatically scale the graph, point to one of the following options: 
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Autoscale[XY] 
Select Autoscale[XY] to automatically scale collected data by scaling the Y 
height and X width to full screen. 

Autoscale[X] 
Select Autoscale[X] to automatically scale collected data by scaling the X 
width to full screen. 

Autoscale[Y] 
Select Autoscale[Y] to automatically scale collected data by scaling the Y 
height to full screen. 

Zoom Out Select Zoom Out to Zoom back to the original X and Y ranges which were 
used to collect the data (i.e. the method setup conditions of the focused scan).
For example, the system will revert back to the X and Y ranges set in the 
method if you zoom in and out during a data collection.

Single/Multi 
Graph 

Select Single/Multi Graph to toggle between displaying one or all graphs. 
The graph highlighted in the Multi Graph view will be displayed when you 
toggle the Single Graph option. 

Auto 
Arrange 
Graphs 

Select Auto Arrange Graphs to view and arrange all graphs simultaneously.
You can move graph boxes manually by clicking the left mouse button 
outside the graph axes and dragging the graph box to a new position. You can 
also resize graphs. 

User Data 
Form 

Select User Data Form to display the User Data Form where you can enter 
extra information about the traces in the highlighted graph box. For example, 
you might want to record information about the experimental conditions you 
used to collect the data, such as the pH at which data was collected.

Peak Labels Select this to the Peak Labels dialog where you can select various labeling 
and peak reporting functions.

Calculator Select Calculator to display the Maths window where you can perform 
mathematical manipulations on collected traces. In addition, it can act as a 
simple numeric calculator.

History List This displays a list of the current graphs. 

See also: 
Graphics toolbar  
Add Label   
Add Picture   
Edit Label   
Edit Picture   
Trace Preferences  
Graph Preferences   
Cursor Modes   
Axes Scales   
User Data Form 
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Graphics Toolbar—Validate 
Use the Graphics toolbar buttons to gain quick access to many of the Graph menu options. You can also 
use the toolbar to select the graph you want to view and to change the look of your graphs. 

To display or hide the toolbar, point to the Toolbars option in the View menu and select Graphics. To 
display or hide the toolbar's text labels, point to the Toolbars option in the View menu and select Text 
Labels. 

The following commands can be accessed from the Graphics Toolbar: 

Peak Labels   
Maths window   
Graphics area 
Graphics How to…

Hot Tip 
To see the name of a button, point to it with the mouse.

Button Menu 
command 

Enables you to… 

Trace 
Preferences  

Click this button to display the Trace Preferences window where you can 
select the trace(s) to display in the selected graph.

Graph 
Preferences 

Click this button to display the Graph Preferences dialog where you can 
change the appearance of your graph. Any changes you make to the appearance 
of the graph will be applied to all graphs.

Cursor 
Mode 

Click this button to display the Cursor Modes dialog where you can choose the 
type of cursor to be used on the screen. For example, you can select to use a 
free cursor that can move anywhere in the graph or exactly trace the focused 
scan (red scan).  Alternatively, you can select a cursor that enables you to draw 
a line from one point to another to determine the slope using either the Least 
Squares method or the Point to Point method.

Axes 
Scales…  

Click this button to display the Axes Scales dialog where you can set the scale 
range for the X and Y axes.

Autoscale
[XY] 

Click the Autoscale[XY] button to automatically scale collected data by scaling 
the ordinate (Y) height and abscissa (X) width to full screen.

Autoscale
[X] 

Click the Autoscale[X] button to automatically scale collected data by scaling 
the abscissa (X) width to full screen.

Autoscale
[Y] 

Click the Autoscale[Y] button to automatically scale collected data by scaling 
the ordinate (Y) height to full screen.

Zoom Out Click the Zoom Out button to Zoom back to the original X and Y ranges which 
were used to collect the data (i.e. the method setup conditions of the focused 
scan).  
For example, the system will revert back to the X and Y ranges set in the 
method if you zoom in and out during a data collection.
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Add Label  Click this button to display the Add Label dialog where you can enter a text 
label to be placed on a graph or in the background of the Graphics area. 

Add Picture  Click this button to display the Add Picture dialog where you can select a 
picture, bitmap or chemical structure to be placed on a graph or in the 
background of the Graphics area.

Single/Multi 
Graph  

Select Single/Multi Graph to toggle between displaying one or all graphs. 
The graph highlighted in the Multi Graph view will be displayed when you 
toggle the Single Graph option.

Auto 
Arrange 
Graphs 

Click the Auto Arrange Graphs button to view and arrange all graphs 
simultaneously. 
You can move graph boxes manually by clicking the left mouse button outside 
the graph axes and dragging the graph box to a new position. You can also 
resize graphs.

Add Graph Click this button to add a new graph box to the Graphics area. You may want to 
do this if you have, for example, a graph containing existing data is displayed 
and you want to collect some new data in a new graph.

Remove 
Graph 

Click this button to delete the selected graph box from the Graphics area. The 
graph box is removed, but the data is not deleted and is still available from the 
Trace Preferences window. 
You may want to use remove graph if you have a large number of graph boxes 
open but only want to focus on some of these. 

Note 
You can remove multiple graph boxes by first holding down the CTRL 
key and selecting the graphs to be removed and then selecting the 
Remove Graph button or menu item. Use the SHIFT key to highlight a 
range of graphs for removal.

Clear All 
Graphs 

Click this button to delete all traces from the graph/s. Note that selecting this 
option simply turns off the Visible property for the traces in the Trace 
Preferences window. You can redisplay the traces by making the traces Visible
again in the Trace Preferences window.

User Data 
Form 

Click this button to display the User Data Form where you can enter extra 
information about the traces in the highlighted graph box. For example, you 
might want to record information about the experimental conditions you used to 
collect the data, such as the pH at which data was collected.

Calculator Click this button to display the Maths window where you can perform 
mathematical manipulations on collected traces. In addition, it can act as a 
simple numeric calculator.

See also: 
Trace Preferences   
Graph Preferences   
Cursor Modes   
Axes Scales   
Add Label   
Add Picture   
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Graph Labels—Validate 
Add Label dialog
Edit Label dialog
How to add a label to a graph
How to edit a label
How to move a label
How to resize a label
How to delete a label

Add Label—Validate 
Use the Add Label dialog to place a label on your graph or into the background of the Graphics area. 

To add a label to a graph box, you must have at least one trace Visible in the graph box. (You can select 
which traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple 
graphs, the label will be placed in the graph box that is currently selected. However, you can add a label 
outside of a graph box in the background of the Graphics area at any time. 

The Add Label dialog comprises the following: 

User Data Form   
Maths   
Graph menu 
Graphics area 
Graphics How To

To access the Add Label dialog, select the Add Label command from the Graph menu, or select 
the Add Label button on the Graphics toolbar.

To selected 
trace

Select this option to associate a label with the selected trace. When you associate a label 
with a trace and make the trace visible in the Graph box, the label will also be displayed 
with the trace. 
When you save the data (as a Batch or Data file) the label is saved with its associated 
trace. 

To selected 
graph

Select this option to associate the label with the selected graph. When you associate a 
label with a graph, the label will always be displayed in the Graph box, regardless of 
what traces are visible. 
When you save the data (as a Batch or Data file) the label is saved with its associated 
graph. 

Selected trace This will identify the trace that is currently selected and display the name of the trace.
Font… Click Font to open the Windows Font dialog. In this dialog you can specify the font 

type, style and size to be used for the label.
Label Use the Label field to enter the text for the label. You can enter as many lines of text as 

you require. 

Q. Can I add a label that will print with all my graphs.
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Edit Label—Validate 
Use the Edit Label dialog to alter the content or look of your label. 

To access the Edit Label dialog, right-click on the label you wish to change and select Edit Annotation 
from the menu. 

The dialog comprises the following: 

How to add a label to a graph—Validate 
You can add a label to your graph or Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area 
background. 

A. Yes, you can add your label to the background of the Graphics area. To do this, right-click on a
section of the background (gray area) and select Add Label from the menu. (You will notice that
this menu has less options than the menu that appears when you right-click on a graph.) In the Add
Label dialog, enter the label to be added to all graphs and select OK. The label will appear in the
background of the Graphics area.

Hot Tip 
If you wish to include certain XY co-ordinates on the graph as a label, position your cursor at the 
appropriate place, right-click and select Add Label from the menu. When the Add Label dialog 
appears, the co-ordinate positions will be added to the Label field. 

See also: 
Trace Preferences dialog 
Graph menu 
Graphics toolbar 
How to add a label to a graph 
How to move a label 
How to edit a label 
How to resize a label 
How to delete a label

Font Select Font to open the Font dialog, where you can specify the font type, style and size 
to be used for the label.

Label Use the Label field to alter the text for the label. 

See also: 
How to edit a label 
How to add a label to a graph 
How to resize a label 
How to move a label

Note 
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Step 2 

Click the Add Label button on the toolbar or right-click on the graph and select Add Label from the 
menu. The Add Label dialog will appear. 
The Add Label command is also accessible from the Graph menu. 

Step 3 

Click the Font button. The Windows Font dialog appears. Select the font type, size and style you require 
for your label. A sample of the font style appears in the Sample field. When you are satisfied with your 
selections, select OK to return to the Add Label dialog. 

Step 4 

Enter the label in the Label field and select OK. The label will be displayed on the selected graph. If 
necessary, you can move a label so that it is more appropriately placed on your graph. 

How to move a label—Validate 
To move a label so that it is more appropriately placed on your graph or Graphics area background, do 
the following: 

Step 1  

Place the cursor on the label. 

Step 2  

Click and hold down the left mouse button. 

Step 3  

Drag the label to the correct position and release the mouse button. The label will be displayed at the new 
position. 

There must be at least one trace Visible in the graph box before you can add a label to it.

See also: 
How to move a label 
How to edit a label  
How to resize a label 

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 
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How to resize a label—Validate 
To resize a label so that it is more appropriately sized on your graph or Graphics area background, do the 
following: 

Step 1  

Select the label by clicking on it with the mouse. A border will be displayed around the label to indicate it 
is selected. 

Step 2  

Position the cursor over one of the corner edges of the label until the cursor becomes a diagonal double-
headed arrow. Click and hold down the left mouse button. 

Example of label showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the label by dragging the mouse. The label text will also be resized. 
Release the mouse button when the label and text are the correct size. 

How to delete a label—Validate 
To delete a label from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the label and click the left mouse button to select it. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label  
How to resize a label

Hot Tip 
If you are having trouble selecting the label, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Labels are transparent so as not to interfere with any traces on graphs. 

See also: 
How to add a label to a graph 
How to edit a label 
How to delete a label
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Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The label will be 
deleted from the graph or Graphics area. 

Graph Pictures—Validate 
Add Picture dialog
Edit Picture dialog
How to add a picture
How to replace a picture
How to move a picture
How to resize a picture
How to delete a picture

Add Picture—Validate 
Use the Add Picture dialog to insert a picture or bitmap into the Graphics area. The picture can be added 
as a background picture or to a particular graph box. 

To add a picture to a graph box you must have at least one trace Visible in the graph box. (You can select 
which traces you want to make visible in the Trace Preferences dialog.) If you are viewing multiple 
graphs, the picture will be placed in the graph box that is currently selected. However, you can add a 
picture outside of a graph box in the Graphics area at any time. 

The Add Picture dialog comprises the following commands: 

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interfering with the label 
selection. Try zooming in and clicking in a different part of the label.

See also: 
How to add a label to a graph 
How to move a label 
How to edit a label  
How to resize a label

To access the Add Picture dialog, select the Add Picture command from the Graph menu, or 
select the Add Picture button on the Graphics toolbar.

To selected 
trace

Select this option to associate a picture with the selected trace. When you associate a 
picture with a trace and make the trace visible in the Graph box, the label will also be 
displayed with the trace.

To selected 
graph

Select this option to associate the picture with the selected graph. When you associate a 
picture with a graph, the label will always be displayed in the Graph box, regardless of 
what traces are visible.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer 
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Edit Picture—Validate 
Use the Edit Picture dialog to change a picture you have inserted into the Graphics area. 

To access the Edit Picture dialog, right-click on the picture you wish to change and select Edit 
Annotation from the menu. 

The Edit Picture dialog comprises the following commands: 

How to add a picture to a graph—Validate 

for the picture you want to insert. The picture must be one of the following formats: 
DIB, JPG, PGEG, BMP, EMF or WMF. 

If you are viewing multiple graphs the picture will be placed on the graph that is 
currently selected. If no graph is selected, the picture will be placed on the Graphics area 
background.  

When you save the data (as a Batch or Data file) the picture is saved with its associated 
trace or graph. 

Q. Can I add a picture that will print with all my graphs.
A. Yes, you can add your picture to the background of the Graphics area. To do this, right-click on
a section of the background and select Add Picture from the menu. (You will notice that this menu
has less options than the menu that appears when you right-click on a graph.) In the Add Picture
dialog, load the picture to be added to all graphs and select OK. The picture will appear in the
background of the Graphics area.

See also: 
Trace Preferences dialog 
Graph menu 
Graphics toolbar 
How to add a picture to a graph 
How to move a picture 
How to resize a picture 
How to delete a picture 
How to replace a picture

To selected 
trace/ graph

Displays whether you originally selected to add the picture to a trace or a graph. This 
option is not editable.

Load Click Load to open the Windows Open dialog. Use this dialog to browse your computer 
for the picture you want to insert. The selected picture will replace the current picture. 
The picture must be one of the following formats: DIB, JPG, JPEG, BMP, EMF or 
WMF. 

See also: 
How to replace a picture 
How to add a picture 
How to move a picture 
How to resize a picture 
How to delete a picture
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You can add a picture to your graph or the Graphics area background. To do this: 

Step 1 

Click on the graph box you require or click outside the graph box(es) to choose the Graphics area 
background. 

Step 2 

Click the Add Picture button on the toolbar or right-click on the graph and select Add Picture from the 
menu. The Add Picture dialog will appear. 
The Add Picture command is also accessible from the Graph menu. 

Step 3 

Click the Load button. The Windows Open dialog appears. 

Step 4 

Browse through your directories to find the picture you want to insert. All pictures must be in the bitmap 
format and will have the extension .BMP. 

Step 5 

Highlight the .BMP that you want to insert and select Open. 

Step 6 

The Add Picture dialog will appear showing a preview of the bitmap. If the bitmap is the correct one 
select the OK button. The bitmap will be placed onto the graph. 

You can move a picture so that it is more appropriately placed on your graph. 

How to replace a picture—Validate 
To change a picture that you have added to a graph or Graphics area background do the following: 

Step 1  

Note 
There must be at least one trace Visible in the graph box before you can add a picture to it.

Note 
You should take care not to add a bitmap that is too big as it will obscure part or all of your graph.

See also: 
How to move a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture 
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Move the cursor to the picture and select the left mouse button to select it.

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu or select Edit 
Annotation from the Graph menu. The Edit Picture dialog is displayed. 

Step 3  

From the Edit Picture dialog, select the Load button. The Windows Open dialog is displayed. 

Step 4  

Browse through your directories to find the picture to replace the current bitmap. Picture files must be in 
one of the following formats: DIB, JPG, JPEG, BMP, EMF or WMF. 

Step 5  

Highlight the file that you want to insert and select Open to return to the Edit Picture dialog. 

Step 6  

The Edit Picture dialog will display a preview of the bitmap. If the bitmap is the correct one select the 
OK button. The bitmap will be placed onto the graph. If you need to, move the picture so that it is more 
appropriately placed on your graph. 

How to move a picture—Validate 
To move a picture so that it is more appropriately placed on your graph or Graphics area background, do 
the following: 

Step 1  

Place the cursor on the picture. 

Step 2  

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

Note 
Do not to add a bitmap that is too big as it will obscure part or all of your graph. 

See also: 
How to add a picture to a graph 
How to move a picture 
How to delete a picture  
How to resize a picture
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Click and hold down the left mouse button.

Step 3  

Drag the picture to the correct position and release the mouse button. The picture will be displayed at the 
new position. 

How to resize a picture—Validate 
To resize a picture so that it is more appropriately sized on your graph or Graphics area background, do 
the following: 

Step 1  

Select the picture by clicking on it with the mouse. A border will be displayed around the picture to 
indicate it is selected. 

Step 2  

Position the cursor over one of the corner edges of the picture until the cursor becomes a diagonal 
double-headed arrow. Click and hold down the left mouse button. 

Example of picture showing the border that indicates it is selected and the arrow to be used for re-sizing 

Step 3  

Increase or decrease the size of the picture by dragging the mouse. The picture will also be resized. 
Release the mouse button when the picture is the correct size. 

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to delete a picture 
How to replace a picture  
How to resize a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.
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How to delete a picture—Validate 
To delete a picture from a graph or Graphics area background, do the following: 

Step 1  

Position the cursor on the picture and click the left mouse button to select it. 

Step 2  

Click with the right mouse button and select Delete Annotation from the drop-down menu displayed. 
Alternatively, you can select the Delete Annotation command from the Graph menu. The picture will be 
deleted from the graph or Graphics area. 

Trace Preferences—Validate 
Trace Preferences table | Trace Audit Log 

A single graph box can display many traces. Use the Trace Preferences dialog to select the trace(s) to 
display (make Visible) in the selected graph box.  

The dialog comprises the following: 

Trace Preferences table 

See also: 
How to add a picture to a graph  
How to move a picture to a graph 
How to delete a picture 
How to replace a picture

Hot Tip 
If you are having trouble selecting the picture, it may be that a trace is interfering with the graphic 
selection. Try zooming in and clicking in a different part of the picture.

See also: 
How to add a picture to a graph 
How to move a picture  
How to resize a picture 
How to zoom a graph

To access the Trace Preferences dialog, select the Trace Preferences command from the Graph 
menu, or select the Trace Preferences button on the Graphics toolbar.

Hot Tip 
The Trace Preferences menu is also available on clicking the right mouse button anywhere in the 
trace listing.

Visible Use the Visible field to select which traces will appear on the selected graph. To select 
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Trace Audit Log 

The Trace Audit Log displays information about the highlighted trace. This includes instrument 
parameters and data form information relating to the trace that has been selected. It also logs all 
information about data manipulation. When more than one trace is highlighted, the Trace Audit Log will 
display information about the trace that was first selected. 

Trace Preferences menu—Validate 
The Trace Preferences menu is displayed when you click the right mouse anywhere on the Trace 
Preferences table. 

or clear the Visible field, simply click the left mouse button in this column. A tick will 
appear next to traces that are to be displayed in the selected graph. 

If you are in single graph view, all selected traces will appear on the one graph. If you 
are in Multi Graph view the traces will appear on the graph that is currently selected. 

Hot Tip 
To make all traces Visible, right-click on the table and select the Select All 
command from the menu. Then right-click on the table again and select the Show 
Traces command from the menu.

Color The Color field enables you to view the color of each trace that appears on the selected 
graph.  To change the color of a trace, highlight it, click the right mouse button in the 
Trace Preferences table and select Change Trace Color. You can then select a color 
from the Color dialog that is displayed. 

The red trace in any graph box is the one on which all information appears. This trace, 
which is used for the cursor tracking, is called the focused trace and it is always red. 
When you select a trace in the Color column it will become the focused trace in the 
selected graph box.  

Note 
When you change the trace line width in the Graph Preferences dialog it also 
will change the width of the color trace line in this dialog.

Name of 
trace 

The Name of Trace field contains a description of the traces currently available for 
display in the selected graph box.

Filename This field displays the filename and path for the trace. If the name is too long to appear 
in the field you can use the keyboard arrow keys to scroll to the end of the filename or 
you can resize the Trace Preferences window. If the file path for a trace shows 'not 
saved' then the trace is unsaved data and is only stored in memory.

See also: 
Graph menu  
Graphics toolbar  
Trace Preferences menu 
Graph Preferences 
How to make multiple traces visible in a graph 
How to remove a trace from the trace list 
How to remove a trace from a graph
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The following commands can be accessed from the menu:

How to select the focused trace—Validate 
To select the scan that you want to be the focused (red) trace, do one the following:  

From the Graph, click the left mouse button on the trace that you want to make the focused trace.

From the Graph Legend (if displayed), click the left mouse button on the trace that you want to
make the focused trace.

From the Trace Preferences dialog, click in the Color column of the trace that you want to make
the focused trace.

How to display a trace that is not appearing in the graph box—
Validate 

Select All This selects or highlights all the traces in the listed on the Trace Preferences page.
Select None This de-selects all the traces in the listing.
Show Traces Select Show Traces to make all of the currently highlighted traces ‘Visible’, meaning 

that they will be displayed in the current graph box.
Hide Traces Select Hide Traces to remove the ‘Visible’ property from all the traces currently 

highlighted. The traces will be removed them from the current graph box.
Delete Traces Select Delete Traces to delete all the highlighted traces in all graphs. Note that if you 

save the data file before you select Delete Traces, the traces are not deleted from the 
saved file, and they can be retrieved at a later date. 
Selecting Delete Traces will delete the traces from the application memory, and it is 
recommended that you select this option if you need to free up memory on your 
computer. 

Note 
If the application is controlled by the GLP Administration application, you will be 
prompted to save an unsaved data file before it is removed from the application.

Change 
Trace Color 

Select Change Trace Color to display the Windows Color dialog where you can 
change the color of the currently highlighted trace(s). The focused trace will remain red 
while it retains the focus, and will revert to the selected color when the focus is moved.

See also: 
Trace Preferences 
Graph Preferences 
How to remove a trace from the trace list 
How to remove a trace from a graph

Note 
Select the Show Legend check box in the Graph Preferences dialog to display the Graph Legend 

See also: 
How to track the focused trace 
How to view a particular trace
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Step 1 

Click on the graph in the Graphics area. 

Step 2 

Select the Trace Preferences button  from the Graphics toolbar, or select Trace Preferences from 
the Graph menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you wish to see and select the Visible option. A tick will appear in the Visible column 
to indicate that it will now be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you want to display.
b. Click the right mouse button and select the Show Traces command from the drop-down menu.

Ticks will appear next to the selected traces to indicate that they will now be displayed.

Step 4 

Press OK to clear the Trace Preferences dialog. The selected trace(s) will be displayed. 

How to remove a trace from a graph—Validate 
Step 1 

Select a graph in the Graphics area. 

Step 2 

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the 
Graph menu. The Trace Preferences dialog is displayed. 

Step 3 

Find that trace that you no longer wish to see and select the Visible option. The tick will be removed 
from the Visible column to indicate that it will not be displayed.  

If you wish to make multiple traces visible, do the following:  

a. Hold down the CTRL key select all the traces that you no longer want to display.
b. Click the right mouse button and select the Hide Traces command from the drop-down menu. The

ticks will be removed from the selected traces to indicate that they will not be displayed.

See also: 
How to remove a trace from a graph 
How to remove a trace from the trace list
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Step 4 

Select OK to clear the Trace Preferences dialog. The trace will be removed from the graph. 

How to remove a trace from the trace list—Validate 
If your graphs contain unwanted traces, you may wish to delete them (rather than simply making them 
invisible) in order to free up application memory and aid system performance. 

Step 1  

Select a graph in the Graphics area. 

Step 2  

Click the Trace Preferences button  on the Graphics toolbar or select Trace Preferences from the 
Graph menu. The Trace Preferences dialog is displayed. 

Step 3  

Select the trace to be removed by clicking on it.  

Step 4  

Click the right mouse button to display the Trace Preferences menu. 

Step 5  

Select Delete Traces to delete the sample from the trace list. You will be prompted to confirm this action.

Step 6  

Select OK to clear the Trace Preferences dialog. The trace will be removed from all graphs. 

Graph Preferences—Validate 
Axes Preferences | Advanced Options | Trace Style | Show Legend 

Introduction 

Use the Graph Preferences dialog to change the appearance of your graph.

See also: 
How to display a trace that is not appearing in the graph box 
How to remove a trace from the trace list

See also: 
How to remove a trace from a graph 
How to display a trace that is not appearing in the graph box
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All graphs will appear labeled with the X axis label being horizontal and the Y axis vertical. You cannot 
change the orientation of these labels. However you can alter the font and size of the axes and their 
labels. 

Any changes you make to the appearance of the graph will apply to all graphs until the settings are 
changed again. 

Dialog controls 

The Graph Preferences dialog comprises the following: 

Axes Preferences 

Advanced Options 

To access the Graph Preferences dialog, select the Graph Preferences command from the 
Graph menu, or select the Graph Preferences button on the Graphics toolbar.

Axes Color Select the color that you want to assign to the axes of the graph/s from the drop down 
list.

Axes Width Select the width of the axes from the drop down list. The width, which is in pixels, 
ranges between one and five pixels.

Grid Style Select the style of grid for the graph from the drop down list. If you do not wish to 
include a grid on the graph, select None.

Plot Area 
Color 

Select the color to be used as the background of the graph from the drop down list. If 
you do not want a background color on the graph, select White.

Trace Width Select the width of the trace from the drop down list. The width is given in pixels and 
ranges between one and five pixels.

Font Click the Font button to display the Windows Font dialog where you can define the 
font style for the axes of the graph/s. The style and size of the font will be applied to all 
graph. The style, name and point size of the font appears on the font button.

Preview Box Preview any changes you make to the axes preferences in the preview box. The 
changes shown in this box will not be made until you select OK.

Auto tick 
marks 

The Auto tick marks option enables you to approximately set how many tick marks 
(or points) will be included on the graph axes. The tick marks generated will be whole, 
rounded, even numbers. The Auto tick marks option is not available if you have 
selected Major ticks. 

Y-axis
Use the Y-axis slider bar to increase or decrease the number of tick marks (or points) to
be included on the Y axis.

X-axis
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Trace Style 

Show Legend 

How to alter the look of your graphs—Validate 
Step 1 

Click the Graph Preferences button on the Graphics toolbar, or select Graph Preferences from the 

Use the X-axis slider bar to increase or decrease the number of tick marks (or points) to 
be included on the X axis. 

Major ticks Use the Major Ticks option to enable you to set exactly how many ticks (or points) 
will be added to the X and Y axes. The number of marks you specify will be divided by 
the axis range, which can result in odd numbers on the axis. Note that any changes are 
not reflected in the graph bitmap at the top of the screen.

Decimals Use the Decimals option to set the number of X and Y decimal places to be displayed 
on the axes. To set the number of decimal places, select the Decimal option and enter 
the number in the Y-axis and X-axis combo boxes. Note that any changes are not 
reflected in the graph bitmap at the top of the screen.

Points Select Points to display each individual data point collected by the Cary Eclipse on the 
graph.

Points and 
solid lines 

Select Points and Solid Lines to display each individual data point collected by the 
Cary Eclipse on the graph. Additionally, an interpolated line that connects the points 
will be drawn.

Solid lines If you select Solid Lines, the Cary Eclipse system will interpolate the data between the 
actual, collected data points and show the data as a continuous line.

Style cycles 
automatically 

If you select Style Cycles Automatically, the Cary Eclipse system will display each of 
the above three trace styles. This makes it easier to differentiate between traces, 
especially on black-and-white printers.

Show Legend Select Show Legend to display a legend in the right side of each graph box. 
A single left click on a sample name or example line within the legend will make it the 
focused or red scan. Information about the trace will be displayed below the X axis. 

Hot Tip 
Double-clicking on the legend will automatically display the Trace Preferences 
window, allowing you to view more detailed information about your trace (e.g. 
audit log, File name, etc.). 

See also: 
Graph menu 
Graphics toolbar 
Graphics area 
Graphics How To
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Graph menu. The Graph Preferences dialog is displayed.

Step 2 

Use the available options available to choose your preferred appearance for the graphs. A preview box in 
the top right-hand corner will demonstrate how the graphs will appear. 

Step 3 

Select OK to clear the Graph Preferences dialog and update all graphs to reflect your selections. 

Step 4 

To re-use your graphics setup at a later date, save the setup as a graphics template. 

Cursor Modes—Validate 
Use the Cursor Modes dialog to choose the type of cursor to be used on screen. For example, you can 
select to use a free cursor that can move anywhere in the graph.  

The dialog comprises the following: 

Note 
You can also add labels and pictures to your graphs to alter their appearance. 

See also: 
How to add a label to a graph 
How to add a picture to a graph 
How to move a label 
How to move a picture 
How to resize graph boxes

To access the Cursor Modes dialog, select the Cursor Modes command from the Graph menu, 
or select the Cursor Modes button on the Graphics toolbar.

Free The Free cursor is not confined to a particular trace on the graph. It can move 
anywhere in a graph box, and its ‘X,Y’ position is shown in the bottom right-hand side 
of the Graphics area. You can use the Free cursor to zoom in on a particular part of a 
graph. 

Note 
The Free cursor moves from point to point in the selected graph box. Hence you 
need to be careful when positioning the cursor over a scan to obtain an accurate 
(X,Y) reading. It is recommended that you use the Track cursor mode for this.

Track Use the Track cursor to exactly trace the focused (red) scan in a graph box. The cursor 
position is displayed in the X and Y at the bottom right-hand side of the Graphics area. 

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the 
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Axes Scales—Validate 
Use the Axes Scale dialog to manually change the axes range. This can assist in zooming in on a 
particular part of the graph. 

The dialog comprises the following: 

X Axis 

Y Axis 

cursor to the required position. Click the left mouse button, press ‘Alt’ on the 
keyboard, then release the mouse button.

Track 
Intensity

Select the Track Intensity option if you want to associate an intensity value with the 
tracking. The cursor will then track from point to point on the continuum between the 
intensity value you enter. The default value will be 50% of the maximum intensity of 
the focused continuum.

Peaks Choose from the options of Peaks, Valleys or Peaks Valleys to move the cursor from 
peak to peak, valley to valley or from one peak/valley to the next.

See also: 
Graph menu  
Graphics toolbar  
How to zoom a graph 
How to track the focused trace

To access the Axes Scale dialog, select the Axes Scale command from the Graph menu, or select 
the Axes Scale button on the Graphics toolbar.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the X axis, in the format n1 - n2 (where n1 is 

the start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can 
access by selecting the down arrow adjacent to the Scale field.

Mode View the current units for the X axis.
Scale Use the Scale field to enter a new range for the Y axis, in the format n1 - n2 (where n1 is 

the start of the scale and n2 is the end of the scale). 
Hot Tip 
The Cary Eclipse will store the ten most recently entered ranges, which you can 
access by selecting the down arrow adjacent to the Scale field.

See also: 
Graph menu 
Graphics toolbar 
How to scale your graph manually 
How to scale your graph automatically 
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How to scale your graph manually—Validate  
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

Click the Axes Scales button  on the toolbar, or select Axes Scales from the Graph menu. The Axes 
Scales dialog id displayed. 

Step 3  

Type in the new ranges for the X and Y axes in the format ‘n-n’, or choose an option for each from the 
drop-down list. 

Step 4  

Select OK. The axes on the selected graph will change to reflect your chosen settings. 

How to scale your graph automatically—Validate 
Step 1  

Click on the graph whose axes you want to change to make it the focused trace. 

Step 2  

To autoscale the graph, select one of the following:  

Click the Autoscale XY button  on the toolbar to autoscale both X and Y axes. 

Click the Autoscale X button  on the toolbar to autoscale the X axis only. 

Click the Autoscale Y button  on the toolbar to autoscale the Y axis only. 

The focused trace will be scaled according to the option selected. 

How to zoom a graph

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale a graph automatically
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User Data Form—Validate 
Use the User Data Form to enter extra information about the traces in the highlighted graph box. For 
example, you might want to record information about the experimental conditions you used to collect the 
data. 

The dialog comprises the following: 

Peak Labels—Validate 
Use the Peak Labels dialog to set up the peak information that will be included in your report. 

From the Graph menu, select Peak Labels to access the dialog. Note that this option is only available 
when a trace is visible. 

The dialog comprises the following: 

Hot Tip 
Select the Zoom Out command to resize the graph to its original settings. 

See also: 
How to zoom a graph 
How to scale your graph manually

To access the User Data Form, select the User Data Form command from the Graph menu, or 
select the User Data Form button on the Graphics toolbar. The User Data Form command is only 
available if you have selected a graph box.

Data Name This column lists the names of each visible trace in the highlighted graph box. 

Use the extra columns for recording additional information about the experimental 
conditions you used to collect the data, eg. pH. 

Other 
Columns 

Use this to record the name of the parameter in which you are interested as a column 
heading, (for example, pH, ionic concentration, substrate concentration etc.). 

Note 
You must enter a column heading, or else the data in that column will not be 
saved.

See also: 
Graph menu 
Graphics toolbar

Hot Tip 
The selections you make in the Peak Labels dialog are applied to the selected graph(s). To select 
multiple graphs, hold down the CTRL key and select the graphs. You can also use the SHIFT key 
to select a range of graphs. When the shift key is held down, all graphs in between the first and last 
graph chosen are selected. 

Peak Style This parameter selects the type of peaks that will be reported by the Cary Eclipse 
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software. Select from the following options: 

Peaks 
The Cary Eclipse will report maximum points only. 

Valleys 
The Cary Eclipse will report minimum points only. 

Peaks Valleys 
The Cary Eclipse will report both maximum and minimum points. 

Zero Cross 
The Cary Eclipse will report the points at which the trace crosses over the zero ordinate 
line. A zero-crossing peak type is where the continuum crosses the X axis, that is at 
Y=0. This choice is useful for odd derivative scans calculated in the Maths window. 
For example, the zero crossing points of a first derivative scan correspond to the peaks 
and valleys in the trace.  

Note 
When determining Peaks, Valleys or Peaks Valleys the Cary Eclipse software 
nominates the highest data point of a peak as the peak position and the lowest data 
point of the valley as the valley point. It does not interpolate between points. 
Thus, if your data points are relatively far apart (large Data Interval), the reported 
peak or valley may not be entirely accurate. 

However, when you use the zero crossing points to calculate the peak and valley 
positions, the data is interpolated and a more accurate peak position may be 
obtained. 

Hot Tip 
Taking a first derivative of a noisy scan will reduce the noise and assist in locating 
the peaks more accurately.

Threshold Enter the Threshold value, which is the value that defines what peaks/valleys will be 
displayed. The difference in intensity between a valley, the highest peak and the 
adjacent valley is measured and, if this difference is greater than the threshold it is 
reported on the trace.  

Maximum Select Maximum to calculate the maximum peak in the trace/s. Select one of the  Label 
options (X and Y labels, Y label, X label) to display the maximum peak on the trace.

All Select All to calculate all peaks above the peak threshold in the trace/s. Select one of the 
Label options (X and Y labels, Y label, X label) to display the maximum peak on the 
trace.

X and Y 
Labels 

Select this if you wish the peaks on the graph to be labeled with both the X and Y co-
ordinates.

Y Label Select this if you wish the peaks on the graph to be labeled with only the Y co-ordinates.
X Label Select this if you wish the peaks on the graph to be labeled with only the X co-ordinates.
No Labels When selected, no peaks will be labeled with co-ordinates. 
Position Use the slider bar underneath the graph to select the position of the label on the graph. 

This option is not available if you have selected No Labels.
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File Management—Validate 
File menu
Open dialog
Save As dialog
Filename extensions
Auto Store page
How to combine data files into a batch file

File menu—Validate 
Use the File menu to open or save a method or data file, print or preview a report, or exit the Cary Eclipse
application. 

The following commands can be accessed from the File menu: 

Y Decimals Use this option to select the number of decimal places to appear in your Y co-ordinates. 
This option is not available if you have selected No Labels.

Font Select the Font button to access the Font dialog where you can set the size and style of 
the text that will appear on the labels. This option is not available if you have selected 
No Labels.

See also: 
Maths window

Hot Tip 
Highlight a method or data file in Explorer and simply drag and drop it onto the application to open 
it. Any data will be displayed in the Graphics area.

Command Enables you to…
Open… Select Open to display the Open dialog where you can search for and load method, 

data, report, graph template and batch files, as well as other file types compatible with 
the Cary Eclipse software. When you load a batch file, the method which collected the 
data is loaded as well as the associated report and graphics layout.

Open 
Method… 

Select Open Method to display the Open dialog where you can search for and load a 
stored method.

Save Method 
As… 

Select this option to display the Save As dialog and store the current method. You can 
use the Save As dialog to store the method, data, report, or graphics template separately 
or together as a Batch file. The data can also be saved as a comma delimited ASCII 
Spreadsheet file.

Save As… Select this option to display the Save As dialog and store the collected data. You can 
use the Save As dialog to store the method, data, report, or graphics template separately 
or together as a Batch file. The data can also be saved as a comma delimited ASCII file.

Print Setup… Select this option to display the Windows Print Setup dialog where you can select the 
printer, printer page size and orientation.

Print 
Preview… 

Select this option to display the Print Preview dialog where you can view the current 
report as it will be printed.
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Open—Validate 
Look in | File name | Files of type | Overlay Data | Open 

Use this dialog to open a file previously saved by the application. To access the Open dialog, select 
Open or Open Method from the File menu. 

Print… Select this option to display the Windows Print dialog where you can choose the printer 
and pages to print as well as the number of copies you wish to print.

Explorer… Select this option to run Windows Explorer. This may help you locate method and data 
files.

History List This displays a list of the four most recently opened files.

Exit Select this option to exit the Validate application. 

See also: 
Open  
Save As   
Print Preview  
Print  
Filename Extensions

Look in The Look In field lists the available folders and files. Click the down arrow on the 
right of this field to view the location of the current folder in your computer's 
hierarchy. You can also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In 
field. 

Note 
To open the folder in the level that is one higher than the current folder, select 

 on the toolbar.

Look in list 
box 

The Look In list box, which is directly below the Look In field, displays the folders 
and files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted 
text entry field that appears and press ENTER. Then double-click on the new 
folder to open it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the 
date the file was last modified.
Click to preview the selected trace before you load it into the application.

File name Enter the name of the file you want to open in this field. The easiest way to do this is to 
find the file in the Look in list box and then select the file. However, you can type the 
full path of a file and then select Open to open the file.
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Save As—Validate 
Look in | File name | Files of type | Save 

Use the Save As dialog to save the data, method, report or graphics template individually or together as a 
Batch file. 

Traces (or data) that are currently ‘Visible’ in the Graphics area are saved, regardless of how they are 
displayed (full screen graph box or tile). 

For example, if six graph boxes are displayed in the Graphics area and each graph box has one Visible 

Files of type Click on the arrow on the right of this field to view a list of the different types of 
application files that can be opened in the list box. 
Methods (*.FMSW) Choose this file type to open a Method file. Only the method is 

loaded. No data is loaded.
Data (*.FDSW) Choose this file type to open a Data file. Only the data is 

loaded. The method that was used to collect the data is not 
loaded. The last used method or default method will be 
displayed.

Report (*.FRSW) Choose this file type to open a Report file. You can view the 
report in the Report area.

Batch (*.FBSW) Choose this file type to open a Batch file. A Batch file includes 
data, the method used to collect the data, report and graphics 
setup.

Spreadsheet Ascii 
(*.CSV)

This will open ASCII files that contain single comma delimited 
files with two or more columns.

All files (*.*) This enables you to view all files in the directory so that you 
can open any compatible file.

Tell me more about Filename Extensions

Overlay 
Data 

Select this check box to overlay individual data files in one graph box. If this is not 
checked the data from each file will appear in individual graph boxes. This option is 
only available if the Open dialog has been accessed by selecting Open… from the File 
menu. 

Hot Tip 
Use the SHIFT or CTRL key to select multiple data files.

Open This button opens the highlighted file/s or the files listed in the File name field.

See also: 
File menu

Note 
This dialog appears when you select either the Save method as… or Save as… menu option in the 
File menu. When you select Save method as… this dialog appears with 'Methods' displayed in the 
Files of type field. When you select Save as… this dialog appears with 'Batch' displayed in the 
Files of type field.
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trace then all six traces will be saved. 

If you do not wish to save particular traces, make them not Visible in the Trace Preferences dialog. To 
save only the focused trace, select the Save only focused trace check box. 

The Save As dialog comprises the following: 

Look In The Look In field lists the available folders and files. Click the down arrow on the right 
of this field to view the location of the current folder in your computer's hierarchy. You 
can also select a new location simply by selecting a different folder. 
The folders and files in the selected folder are displayed the list box below the Look In 
field. 

Note 
To open the folder in the level that is one higher than the current folder, select 

 on the toolbar.

Look in list 
box 

The Look In List Box, which is directly below the Look In field, displays the folders 
and files in the selected location. To view the contents of a folder, double-click it. 

Click to create a new folder. Type the name of the new folder in the highlighted 
text entry field that appears and press ENTER. Then double-click on the new 
folder to open it.
Click to display the directory structure of the drive.

Click to display the files as a list.

Click to display files as a detailed list including the file size, file type and the 
date the file was last modified.
Click to preview the selected trace before you load it into the application.

File Name Enter the name of the file you want to save in this field. 
You can also type the full path of a file then select the Save button to save the file.

Files of Type Click on the arrow on the right of this field to view a list of the different types of 
application files that can be opened in the list box. 
Methods (*.FMVO) Choose this file type to only save the current Method. Any 

collected data is not stored.
Data (*.FDVO) Choose this file type to only save the data currently Visible in 

the Trace Preferences dialog (for any graph box). Note that the 
method used to collect the data is not stored with the data.

Report (*.FRVO) Choose this file type to only save the contents currently shown 
in the Report area..

Batch (*.FBVO) Choose this file type to save the data that is currently Visible in 
the Trace Preferences dialog (for any graph box), the method 
used to collect the data and the currently displayed report all 
together as a Batch file. The graphics setup is also stored.

Spreadsheet Ascii 
(*.CSV)

Choose this file type to save the raw intensity data currently 
Visible in the Trace Preferences dialog (for any graph box) as 
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Filename extensions—Validate 
The Cary Eclipse system uses the filename extension to distinguish between data types (e.g. method or 
report) and also to differentiate applications. (e.g. Concentration or Kinetics). 

The Syntax for file extensions is: 

The following files may be opened and saved in the Validate Application: 

a comma delimited ASCII Spreadsheet file (*.CSV) file. The 
data is saved as XY pairs delimited by a comma. 

Note 
This file type can be easily imported into a spreadsheet 
program. For example, Microsoft Excel. You can also 
double-click on the stored *.CSV file from Microsoft 
Explorer to load Excel automatically with the ASCII XY 
data displayed.

Tell me more about Filename Extensions

Save Click this button to save the file currently present in the File name field in the directory 
specified in the Look in field.

See also: 
File menu 

Letter Represents Available Options
First Type of analysis F Fluorescence

Second Type of file B Batch
D Data
G Graph Template
M Method
R Report

Third and fourth Application identifier AB Advanced Reads
CN Concentration
KN Kinetics
LT Lifetimes
RT Ratio
SR Simple Reads
SW Scan
TM Thermal
VO Validate

Note 
Selecting All Files in the Windows Open dialog will list all available file types. 
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How to combine data files into a batch file—Validate 
To combine a number of data files into a batch file, do the following: 

Step 1  

Select Open… from the File menu to display the Windows Open dialog.  

Step 2  

A list of stored batch files will appear. Select the down arrow to the right of the Files of type field and 
select 'Data' to list all the data files. 

Step 3  

Select the Overlay Data check box. 

Extension Available action File type
*.FMVO Open/Save A method file (*.FMVO) consists of the software setup 

by which data is collected.
*.FDVO Open/Save A data file (*.FDVO) contains data collected that is 

currently visible in the Trace Preferences dialog (for any 
graph box).

*.FRVO Open/Save A report file (*.FRVO) contains the report generated by 
the Cary Eclipse about the data.

*.FBVO Open/Save A batch file (*.FBVO) contains the collected data that 
was Visible in the Trace Preferences dialog (for any 
graph box), the method by which the data was collected 
and the report and graphics template.

*.ADL Open An ADL file (*.ADL) is a program file generated in the 
Applications Development Language (ADL).

*.CSV Open/Save An ASCII spreadsheet file (*.CSV) has the same 
extension for all applications. It consists of raw intensity 
data (that was currently Visible in the Trace Preferences 
dialog (for any graph box) saved as XY comma-
delimited pairs. This file can be imported into a 
spreadsheet program such as Microsoft Excel.

*.FADL Open An Eclipse ADL (*.FADL) file is a program file 
generated in the Applications Development Language 
(ADL) specifically for the Cary Eclipse. Eclipse ADL 
files will be associated with the relevant Eclipse 
application. When creating ADL files for the Cary 
Eclipse, it is recommended that you save them with the 
FADL extension.

See also: 
Open 
Save As
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Step 4  

Highlight the data files that you require. Hold down the CTRL key to select multiple files. 

Step 5 

Select Open. The highlighted data files will load into the application and appear in the same graph box. 

Step 6 

Select Save As… from the File menu to display the Windows Save As dialog.  

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and 
select 'Batch' to list all the batch files. Ensure that the Save only focused trace check box is cleared  

Step 8 

In the File name field, type in the file name for your new batch file. 

Step 9 

Select Save to create the new batch file. The current method will be stored with the batch file. 

All the data files are now combined into the one batch file. 

Software and Screen features—Validate 
Menu line
Status display
Status line
Buttons
Function keys
Right mouse menu
How to remove or display the command buttons

Menu line—Validate 
 File menu 
 Edit menu 
 View menu 
 Commands menu 
 Setup menu 
 Graph menu 
 Calibration menu 
 Help menu 

Status line—Validate 
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The Status Line is displayed at the very bottom of the Validate Application. The line will display the 
following information (from left to right): 

Buttons—Validate 
The major commands in this application can be accessed both from the menu items at the top of the main 
window and from the application buttons. These buttons, which appear in the left side of the Validate 
Application window, comprise the following: 

Hardware Status This field displays status messages indicating the current instrument activity.
Sequence Information This field displays status messages indicating the current system activity.
Current Results This field displays information on the last reading.

See also: 
Validate Application

Hot Tip 
If you wish to access these commands from the main menus, rather than from these buttons, you 
can remove the Command buttons from your application window. To do this, clear the Buttons 
command in the View menu. This will enlarge the Graphics area, making viewing and selection of 
scans easier. 

Button Enables you to…
Tests Select this to display the Tests dialog where you can set up performance tests. You can 

use the dialog to configure your instrument to check its performance based on the 
regulatory specifications you select.

Setup Click this button to display the Setup dialog where you can set up the report and email 
parameters.

Zero Select this to zero the current ordinate value. 
This command can also be accessed by pressing F5. 

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

Clear Report Select Clear Report to remove all of the text that appears in the Report area. If you 
have saved the report, you can view the information again. To do this, simply open the 
report file using the Open… command in the File menu.

Print Select Print to display the Windows Print dialog where you can choose what printer 
the report will be printed to. You can also select what pages to print as well as the 
number of copies you wish to print. 
This command can also be accessed by pressing CTRL+P. 

Note 
The options on the Reports page are used to generate the contents of the Report 
area during a run or on a recalculation. If Auto Print has been selected the Cary 
Eclipse will automatically print a report at the end of a data collection.

See also: 
Tests 
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Function keys—Validate 
The function keys at the top of your keyboard perform basic Cary Eclipse operations simply and quickly. 

Right mouse menu—Validate 
The following commands are accessible by clicking the right mouse button on editable fields in the Cary 

Setup  
Zero  
Clear report  
Print  
Commands menu 
How to remove or display the Command buttons

Function 
key 

What it does

F1 This displays the Help for the current dialog or window.
F4 Press F4 to display the Go to Wavelength dialog.
F5 Press F5 to perform an instrument Zero. The current intensity value will be reset to zero and 

all subsequent results will have the value that was reset to zero subtracted from them. You 
can use the Zero command before selecting Start if you want your data to start at 0 
intensity. 
This command is also accessible from the Commands menu or by selecting the Zero button. 

Select the Clear Zero command from the Commands menu to remove zero correction.  

Note 
Before you select Zero, ensure that you have placed the blank solution in the cell 
positions that are currently in the cell path.

F6 Press F6 to display the Rapid Result dialog where you can read a blank and multiple sample 
readings without changing the application method. 
This command is also accessible from the Commands menu.

F9 If the application is online, press F9 to start a data collection. This is equivalent to selecting 
the Start button. If the application is not online, you will need to press F9 to first connect to 
the Cary Eclipse. Then press F9 to start the data collection. 
This command is also accessible from the Commands menu or by selecting the Start 
button. 

Note 
You will not be able to perform a Connect if another application is collecting data.

F12 Select this to stop the current measurement. This is equivalent to selecting the Stop button. 
This command is also accessible from the Commands menu or by selecting the Stop 
button.  

See also: 
Go to Wavelength 
Zero 
Rapid Result 
Start/Stop buttons
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Eclipse software. 

How to remove or display the command buttons—Validate 
The command buttons (Tests, Setup, Zero, Clear Report and Print) appear on the left side of the Validate 
Application window. 

To remove the command buttons 

Step 1 

From the Validate Application window, select the View menu. 

Step 2 

Clear the Buttons menu item. 

The buttons will disappear from the application screen, giving you more room to display reports. 

To show the command buttons 

Step 1 

From the Validate Application window, select the View menu. 

Step 2 

Select the Buttons menu item. 

The buttons will re-appear in the application screen. 

ADL—Validate 
ADL Command Line
ADL Hooks
How to insert ADL commands

ADL Command Line—Validate 

Introduction to ADL 

Undo If available, this reverts to the previous value before the Edit on the field.
Cut If available, this cuts the highlighted text to the clipboard.
Copy If available, this copies the highlighted text to the clipboard.
Paste If available, this pastes the text from the clipboard to the cursor position.
Delete If available, this deletes the highlighted text/number.
Select All If available, this selects all entries.
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Use the ADL Command Line dialog to run Single-line or Multi-line Applications Development 
Language (ADL) commands that enable you to perform functions over and above that of the existing 
program functionality. 

ADL is not a general purpose programming language. It has been developed specifically by Varian to 
meet the needs of spectroscopists. It can be used to handle all the data collected from the Cary Eclipse—
both photometric values and entire data collections. ADL programs that you develop should be stored 
with the extension 'ADL'. 

To access the ADL Command Line dialog, select the ADL Command item from the Commands menu. 
You can also press ALT+Y to open the dialog. 

Software controls 

Note 
Full documentation on ADL programming is available in the ADL Online Help. 
Click the button below to view this Help. 

Single Line Selecting this lets you enter ADL commands on a single line into the Command Line 
entry box. 
You can enter more than one ADL command on a single line simply by separating the 
commands by a semicolon ‘;’. 

Multi-line The Multi-line capability enlarges the Command Line entry box. Use the Multi-line 
capability to create a more complex ADL program by adding a series of commands over 
multiple lines. When Multi-line mode is selected, the Quick Reference option becomes 
available.

ADL Quick 
Reference 

Select Quick Reference to open the Quick Reference dialog where you can easily add a 
command in the correct syntax to your ADL program. This option is only available for 
Multi-line commands. 

Show me How to insert ADL commands using the Quick Reference 

A detailed description of all the commands in the Quick Reference is available by 
selecting the Help button on the Quick Reference dialog. 

Browse Select Browse to access the Open dialog where you can browse for and select an 
existing ADL program to load and run.

Command 
Line (entry 
box) 

This entry box enables you to use ADL commands. You can enter single ADL 
commands into this field, or you can enter a series of ADL commands. If you have the 
entry type set to Single Line, you can review previous ADL entries by selecting the 
down arrow to the right of the list box. 

The ADL commands in the Command Line are executed when you select OK. 

Note 
On entering this window, the Cary Eclipse will recall the last command or 
program executed from the Command Line entry box. The ADL commands 
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ADL Hooks—Validate 
The ADL Hooks command is accessible from the View menu. 

Instead of writing a full ADL program you can use ADL hooks to link into an existing Cary Eclipse 
application. This is particularly useful if you want to make small changes to the way an application 
works, e.g. you want to pop up a dialog for the user to enter some specific data before the run starts. ADL 
hooks are links at specific points in an application at which you can run an ADL program. For example, 
ADL hooks have been supplied to run the following ADL programs:  

entered in the last executed program are typically stored in the Varian\Cary 
Eclipse WinFLR\ADL directory on the drive on which the Cary Eclipse software 
is installed.
Hot Tip 
You can rerun the ADL commands in the Command Line entry box from any 
screen in the Validate application by pressing ALT-X or selecting Re-run ADL 
from the Commands menu.

See also: 
Commands menu 
ADL Hooks

Note 
Full documentation on ADL programming is available in the ADL Online Help.  
Click the button below to view this Help.      

Hook Description

VO_Startup.ADL This is run when the Validate application starts. For this to to work the application 
must be started from a batch or method file that has ADL Hooks on.

VO_Startup.ADL This is run when the application is started. This command will only work if the 
application has been started from a batch or method file.

VO_PreSeq.ADL This runs when the Start button is selected.

VO_PostSeq.ADL This runs at the end of the Start button sequence.

VO_Online.ADL This runs when Cary Eclipse is detected online.

VO_OffLine.ADL This runs when Cary Eclipse goes offline.

VO_Zero.ADL This runs when the Zero button is selected.

VO_Recalc.ADL This runs when the Recalculate button is selected.

VO_Shutdown.ADL This runs when the application is shutting down.

VO_PreRead.ADL This runs just before a read is taken.

VO_PostRead.ADL This runs just after a read is taken (It has the reading result stored in the 
UserResult variable.)
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How to insert ADL commands using the Quick Reference—
Validate 
The Quick Reference window is accessed from the ADL Command window. It enables you to easily add 
a command in the correct syntax to your ADL program. To do this: 

Step 1 

Press Alt-Y to open the ADL Command Line window. 

Step 2 

Select the Multi-line option. The Command Line entry box will expand to take multiple lines of ADL 
commands and the Quick Reference check box is displayed. 

Step 3 

Select the Quick Reference check box. The Quick Reference window is displayed. 

Step 4 

If necessary, use the Go To field to jump to the appropriate part of the Quick Reference listing. 

Step 5 

Highlight the command you require in the Quick Reference list. 

Step 6 

Click the Insert in ADL button. The selected ADL command will appear in the Command Line entry 
box. 

Step 7 

Where necessary, alter the defaults supplied by the inserted Quick Reference command in the Command 
Line entry box to suit your program. 

Step 8 

Repeat steps 4–7 to add more commands as required. 

Help and Safety information—Validate 

VO_PreSetup.ADL This runs when the Setup button is selected.

VO_PostSetup.ADL This runs when the OK button on the Setup dialog is selected.

See also: 
ADL Command Line
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Help menu
Safety home page

Help menu—Validate 
Use the Help menu to view the online Help and software information for this application. 

Safety Home Page 
Click on the desired index entry to view the Help. 

About Safety
Lamp module
Ultraviolet radiation
Electrical hazards — Cary Eclipse
Panels, covers and modules
Other precautions
Warnings and cautions
Warning symbols
Color coding
Information symbols
FCC advisory
CE compliant products

Graphics How To 
Graphics 

How to alter the look of your graphs
How to make a graphics template

Traces 

How to select the focused trace
How to track the focused trace
How to display a trace that is not appearing in a graph box
How to remove a trace from a graph

Validate Help Select this to display the Validate Home Page. This contains a list of online Help topics 
specific to the Validate Application.

Help Topics Select this to display the Cary Eclipse Windows Online Help Home Page.
Tip of the day View useful tips about using your Cary Eclipse instrument and software.
Eclipse Tour Select this to display the Cary Eclipse Multimedia Online Help. This will give you an 

animated introduction to the Cary Eclipse software and hardware.
About… Select About to access a dialog that displays information about the application as well 

as Varian email and Internet contact information. 
To clear this About dialog, select OK.
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How to remove a trace from the trace list

Sizing and scaling 

How to resize graph boxes
How to scale your graph manually
How to scale your graph automatically
How to zoom a graph

Labels 

How to edit a label
How to move a label
How to add a label to a graph
How to delete a label

Pictures 

How to add a picture
How to replace a picture
How to move a picture
How to delete a picture

How to edit a label—Validate 
Step 1  

Place the cursor on the label and click the left mouse button to select the label. 

Step 2  

Click the right mouse button and select Edit Annotation from the drop-down menu. Alternatively you 
can select the Edit Annotation command from the Graph menu. The Edit Label dialog is displayed. 

Step 3  

Use the Edit Label dialog to change the label.  

For example, if you want to change the font size of the label, select the Font button. In the Size field, 
scroll through the available sizes for the font and select the size you require. Alternatively, highlight the 
currently selected size in the Size entry field and enter the size you require. Click the OK button in this 
dialog to return to the Edit Label dialog. 

Step 4  

Hot Tip 
If you are having trouble selecting the label it may be that a trace is interferring with the label 
selection. Try zooming in and clicking in a different part of the label.
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Click OK to clear the Edit Label dialog. Your label will appear with the new font size. 

How to track the focused trace—Validate 
To track the focused (red) trace in the graph: 

Step 1  

Click the Cursor Modes button  from the Graphics toolbar, or select Cursor Mode from the Graph 
menu. The Cursor Modes dialog will appear. 

Step 2  

Select Track and select the OK button. 

Step 3  

Place the blue tracking cursor in the graph box you require.  

Step 4  

Move the cursor left and right across the graph box to trace the focused (red) scan. The cursor coordinates 
change (in the X, Y field at the bottom left hand corner of the Graphics area) as you move along the 
curve. 

How to make a graphics template—Validate 
A graphics template lets you set up and store the style of a graphics report for future use. You can do this 
by adding labels and pictures to the background of the Graphics area and altering any axes styles etc. One 
advantage of this over the application's built-in reporting features is that you have more flexibility as to 
where you can position graph boxes and any text that you may want to appear (e.g. operator name, batch 
number etc.) and also where you add pictures, e.g. company logos etc.  

Step 1 

Start the application and open the data file from which you want to make a graphics template. 

See also: 
How to add a label to a graph 
How to move a label 
How to delete a label  
How to resize a label

Hot Tip 
If you wish to fix the cursor on a particular position on the curve, move the cursor to the required 
position. Press ALT  on the keyboard, then release the mouse button. 

See also: 
How to select the focused trace 
How to view a particular trace
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Alternatively, collect some new data. 

Step 2 

Make as many graph boxes as you require in your template by using the Add Graph function. 

Step 3 

Adjust the graph boxes to the correct size and position them as you want them to appear in the template. 

Step 4 

Do any of the following, if required: 

Change the appearance of the graph boxes in the Graph Preferences dialog
Use the Add Label function to append text to the Graphics area
Use the Add Picture function to add pictures, such as your company's logo to the Graphics area

Step 5 

From the File menu, select Print Preview. Use the Print Preview dialog displayed to check the template 
that you have created. 

Step 6 

When you are satisfied with the appearance of the graphics, select the Save As… command from the File
menu. The Save As dialog is displayed. 

Step 7 

A list of stored data files will appear. Select the down arrow at the right of the Files of type field and 
select 'Graph Template' to list all the template files. Ensure that the Save only focused trace check box is 
cleared. 

Step 8 

Enter a name for the template in the File name field. 

Step 9 

Select OK to save the graphic template. The template will be used each time you create a new file. 

Note 
You can also make a graphic template in a similar manner from existing data. No data will be saved 
in the template. 

See also: 
How to add a label to a graph 
How to add a picture to a graph  
How to move a label 

Page 89 of 91Validate Home Page

 



How to resize graph boxes—Validate 
Step 1  

Click on the graph that you want to resize so that the highlight box appears around it. 

Step 2  

Move the cursor to the edge of the highlight box and place it over one of the square marks (e.g. ) in the 
box until it turns into a double headed arrow ( ). 

Step 3  

Click and hold the left mouse button and drag the box to the desired size. 

Step 4  

Release the left mouse button. 

How to zoom a graph—Validate 
To zoom a graph, do the following: 

Step 1  

Click on the  button on the toolbar, or select Cursor Mode from the Graph menu. The Cursor 
Modes dialog will appear. 

Step 2  

Select Free and select the OK button. 

Step 3  

Click and hold down left mouse button in the highlighted graph box.  

Step 4  

Drag the mouse sideways and up or down. You will see a zoom box made up of a dotted line appear on 
the screen. (See picture below.) 

How to move a picture

See also: 
How to alter the look of your graphs
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The dotted line is a zoom box. 

Step 5  

Release the left mouse button. The area defined by the zoom box will be redrawn to fill the entire graph 
box, and the scans within the box will be enlarged accordingly. The abscissa (X) and ordinate (Y) 
coordinates displayed below the graph will also be changed to reflect the positions of the corners of the 
zoom box.  

You can repeat this process if you need to zoom in even further. 

Hot Tip 
To move the box on the screen, hold down the left and right mouse buttons together. You can then 
position the box anywhere in the graph box. Releasing the right mouse button will still allow you to 
resize the zoom box. 

Note 
The system may limit the extent to which you can Zoom. 

See also: 
How to scale your graph manually 
How to scale your graph automatically
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Accessories 
If you need information on installing, aligning or using a Cary Eclipse accessory, follow the appropriate link 
below. (If there is not a link for the accessory you are interested in either of these two sections, then you will 
need to refer to the operation manual shipped with the accessory): 

Accessories supplied as standard with the Cary Eclipse 

These accessories are supplies with your Cary Eclipse instrument. Click on each link to find out what their 
applications are and how to use them. 

Attenuator
Diffuser
Single Cell Standard and Cell Base

Accessories that are optional with the Cary Eclipse 

You can buy these accessories from Varian as they are not shipped as part of the standard instrument package. 
Many of these accessories are application specific and may not applicable for all users. Click on each link to 
find out what their applications are and how to use them. 

Thermal Accessories 

Ambient 4 Position Multicell Holder Accessory
Cryostat (Optistat DN)
Peltier 4 Position Multicell Holder Accessory
Single Cell Holder (Peltier Thermostatted)
Single Cell Holder (Water Thermostatted)
Temperature Probes (Series II)
Water 4 Position Multicell Holder Accessory
Water Circulator (PCB-150 - for use with Single Cell - Water Thermostatted)

Polarization Accessories 

Automated Polarization Accessory
Manual Polarization Accessory

Other Accessories 

Fast Filter Accessory
Fiber Optic Coupler
Rapid Mix Accessory (RX.2000)
Solid Sample Holder Accessory
Wellplate Reader

Note 
The Cary Eclipse Help contains many video clips. Links to these clips are marked by 
a video camera icon. Click on the icon to run the video.
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Attenuator and Diffuser 
Table of Contents 

Introduction
The Attenuator  
The Diffuser  

Specifications
Getting Started
Unpacking
Installation
Parts and Supplies

Introduction 

The Attenuator 

Figure 1 - The Attenuator 

The attenuator is a rectangular piece of mesh that has 1.5 Abs attenuation. The attenuator is inserted into the 
filter slides and can be inserted on both the excitation and emission sides. 

The attenuator is used with highly scattering samples. 

The Diffuser 
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Figure 2 - The Diffuser 

The diffuser is a piece of silica ground on both faces held in a triangular cuvette configuration. It provides a 
scattered signal which is independent of wavelength from red to UV. 

The diffuser is mainly used in conjunction with the Validate software: 

The diffuser can also be used to set up corrected emission spectra, the rhodamine sample (which can be 
purchased seperately) must be used to setup the corrected excitation spectra beforehand. 

Specifications 
The Attenuator 

- 1.5 Abs attenuation
- Can be used with both the excitation and emission slides

The Diffuser 

- Fine grounding on both faces

Getting started 

Unpacking 

The attenuator and the diffuser are both shipped with the Cary Eclipse as standard. 

Installation 
The Attenuator 

The attenuator can slide into both the excitation and the emission filter slides in the Cary Eclipse sample 

- samples producing a lot of stray light - emission wavelength reproducibility

- emission spectral bandwidths - emission wavelength accuracy
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compartment. 

The Diffuser 

The diffuser fits into the single cell holder that is also shipped as standard with the Cary Eclipse. 

Parts and Supplies 

Single Cell Standard and Cell Base 
Table of Contents 

Introduction
Getting Started

Unpacking  
Installation
Parts and Supplies

Introduction 
The standard single cell holder is shipped with the Cary Eclipse.  

Descriptions Part Number
Quartz silica diffuser 01 106748 00
Attenuator, 1.5Abs 01106775 00
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Figure 1 - Standard Single Cell Holder and Base 

Although the standard cell holder does not have temperature control, it does have a number of useful features.  
There are height and tilt adjustments as well at a cuvette lifting feature which will ensure that you don't get any 
marks on your cuvettes. 

Getting started 

Unpacking 

Unpack the accessory, and check that you have received the following: 

Cell Holder
Hexagonal ball driver

Installation 
Step 1 

 See how to perform steps 1 to 3 

Make sure that the sample compartment is empty. 

Step 2 

Position the single cell base on the locating pins. 

Step 3 
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Lock the cell base by turning the lever to the right. 

Step 4 

 See how to perform steps 4 and 5 

Place the single cell holder on the cell base so that the groove points to the left wall of the sample 
compartment. 

Step 5 

Secure the cell holder by tightening the spring loaded thumb screw. 

For Cuvette Height Adjustment 

Step 1 

 See how to perform height adjustment procedure 

Turning the height adjustment screw in a clockwise direction will raise the cuvette. 

Step 2 

Turning the height adjustment screw in an anti-clockwise direction will lower the cuvette platform. 

For Cuvette Pitch Adjustment 

Step 1 

 See how to perform pitch adjustment procedure 

Turning the pitch adjustment in a anti-clockwise direction will raise the front of the cell holder. 

Step 2 

Turning the pitch adjustment in an clockwise direction will lower the front of the cell holder. 

Parts and Supplies 

Note 
To lower the cuvette you will have to push the cuvette down because of the tension created by the cell 
holder.

Note 
The pitch adjustment screw requires a hex key.
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Fast Filter Accessory 
Table of Contents 

Safety information
Introduction
Unpacking notes
Specifications
Installation
Maintenance and Cleaning

Safety information 
Before using this accessory, you must read the Safety Practices and Hazards in your Cary Eclipse Hardware 
Manual. 

A link to the Safety section is also available on the main page of the Cary Eclipse online Help and Videos CD. 

If the equipment is used in a manner not specified by the manufacturer, your safety may be at risk. 

Introduction 
The Fast Filter accessory for the Varian Cary Eclipse Fluorescence spectrophotometer provides a solution for 
ratiometric applications. Such measurements require rapid sequential measurement of fluorescence intensity at 
two (or four) different excitation or emission wavelengths. The wavelengths selected are determined by filters, 
which are fitted into the accessory. 

The accessory consists of four metal arms extending from a central wheel. Each arm is labeled as 1, 2, 3 or 4 
by holes etched into the wheel, just below the filter position, (Figure 3a). 

Either two or four bandpass filters may be mounted on the filter wheel (one filter per arm). If only two filters 
are used, they must be mounted in opposite positions, either positions 1 and 3 or positions 2 and 4. The solid 
black discs must be mounted in the two remaining filter positions. This is to ensure the filter wheel is balanced.

Unpacking notes 
Your accessory is packed in foam-lined cardboard boxes. Check that you have received all of the items in the 
accessory kit by referring to the packing list included with the shipment (Figure 1). 

Please follow the filter manufacturer's recommendation with regard to which side of the filter should face the 
light source. This is particularly important for excitation filters.

Descriptions P/N
Single cell holder. Spare. 01 106647 00
Single cell holder base. Spare. 02 101672 00
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Figure 1. (i) The Fast Filter accessory (ii) 2 x black solid discs 

Installation 
Installation of the Fast Filter accessory can be divided into three stages: 

1. Installing the filters and the black discs in the accessory

2. Installing the accessory in the instrument

3. Configuring the accessory using the software

Installing the filters in the accessory 

Step 1 

Using your fingers, carefully unscrew the knurled nut (Figure 2 (i)) in the center of the black plastic filter 
locking wheel (Figure 2 (ii)) and remove the locking wheel from the accessory. 

Figure 2.  (i) Knurled nut  (ii) Filter locking wheel
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Step 2 

Filters now need to be placed in the accessory. There are four filter positions, each labeled 1 to 4 by holes 
etched into the arms of the filter holder, (Figure 3a). 

Figure 3a. Filter positioning 

All four filter positions MUST be used in the accessory to ensure the filter wheel is balanced. If two filters are 
to be used, they must be placed in opposite positions in the filter holder. If you place a filter in position 1, the 
second filter must be placed in position 3 and the black discs must be placed in positions 2 and 4. If you place 
filters in positions 2 or 4 the black discs must be placed in positions 1 and 3. 

Lay the accessory horizontally, and carefully place the filters and solid black discs into the arms of the wheel, 
ensuring they are pressed against the arm ends, (Figure 3b). 

Please follow  the filter manufacturer's recommendation with regard to which side of the filter should face the 
light source. This is particularly important for excitation filters. 
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Figure 3b. (i) & (iii) Correctly fitted black discs (ii) & (v) Correctly fitted filters (iv) Replaced Filter locking 
wheel 

Step 3 

Replace the plastic locking wheel removed in Step 1, ensuring the bandpass filters and black discs remain 
positioned at the arm ends, (Figure 3b). 

Replace the knurled nut and rotate in a clockwise direction until finger tight. DO NOT over tighten. 

For example use the table shown below to record this information. 

Installing the accessory in the instrument 

Step 1 

Turn the instrument off and remove any accessories from the sample compartment. 

Step 2 

Prepare to remove the outer cover of the instrument by flipping up the four black plastic clasps located on each 
side of the instrument. Two of these are labeled (iv) and (v) in Figure 3. 

Step 3 

Remove the sample compartment front door and, using your thumb, lift the circular cover plate in the base of 
the instrument to expose a plastic clasp, (Figure 3 (ii)). Flip the clasp up.

Note 
Ensure you record the position in which each filter is mounted. The software requires this information at 
a later stage.

FILTER CENTRE WL (nm) 
Position Excitation Emission

1
2
3
4
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Figure 3.  (i) Circular cover plate (removed) (ii) Front clasp (iii) Sample compartment front door (removed) 
(iv) Right-hand side plastic clasps. The remaining two clasps are located in the same positions as (iv) and (v)
on the opposite side of the instrument.

Step 4 

Carefully remove the instrument outer cover by lifting it upwards away from the instrument base. 

Step 5 

This step varies slightly depending on whether the accessory is to be installed into the excitation or the 
emission fast filter positions. 

With the instrument cover removed, the black metal inner cover is now visible. You will be able to see two 
plates each secured by two black screws to the top of the instrument. These represent the positions for either 
excitation or emission measurement. The black plate labeled (i) in Figure 4 covers the chamber in which the 
accessory needs to be fitted to operate as an excitation fast filter. Remove the appropriate black plate by 
unscrewing the black screws. 
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Figure 4. (i) Plate covering accessory chamber (emission) (ii) & (iii) Black screws (iv) Black thumb screw (v) 
Filter wheel orientation (vi) Accessory chamber (excitation) with cover removed (vii) & (viii) Alignment of the 
male and female D-plugs 

Installing the Fast Filter accessory in the Excitation position 

To install the accessory in the Excitation position, hold the accessory above the excitation chamber, located to 
the right of the sample compartment. 

Orientate the accessory so the male D-plug located on the accessory is aligned with the female D-plug (Figure 
4 (vii)) inside the excitation chamber. 

Orientate the filter wheel as shown in Figure 4 (v) so the arms of the filter wheel form a diagonal cross. 

Carefully lower the accessory into the excitation chamber, raising the edge nearest the male D-plug on a 30° 
angle so that the opposite edge of the accessory touches the excitation chamber first (Figure 5 below). Once the 
edge is positioned, lower the male D-plug so that it is sitting on top of the female D-plug in the excitation 
chamber. 

Figure 5. The edge nearest the male D-plug is raised at a 30° angle with the opposite edge touching the 
excitation chamber. 

To secure the Fast Filter accessory gently push down on top of the accessory base directly above the two D-
plugs. Once the plugs mate, tighten the black thumbscrews. The accessory is now fitted in the excitation 
position. 

Installing the Fast Filter accessory in the Emission Position 

To install the accessory in the Emission position, hold the accessory above the emission chamber, (Figure 4 
(i)). Orientate the accessory so the male D-plug located on the accessory is aligned with the female D-plug 
(Figure 4 (vii)) inside the emission chamber. 

Orientate the filter wheel as shown in Figure 4 (v) so the arms of the filter wheel form a diagonal cross.
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Carefully lower both edges of the accessory into the emission chamber ensuring the male and female D-plugs 
are aligned. Once the accessory is sitting in the emission chamber gently push down on top of the accessory 
base plate directly above the two D-plugs. Once the plugs mate, tighten the black thumbscrews. The accessory 
is now fitted in the emission position. 

Step 6 

Secure the Fast Filter accessory in the chamber by tightening the two black thumbscrews (Figure 4 (iv)). The 
Fast Filter accessory is now correctly fitted and you can replace the instrument cover. 

Step 7 

Carefully replace the instrument cover and flip down the four black plastic clamps to secure, and the front 
black plastic clamp to secure them. Replace the circular cover. (This is the reverse of steps 4, 3 and 2 in order). 

Step 8 

Install the accessory you would like to use with your Cary Eclipse, for example the singe cell holder or 
multicell holder. 

Step 9 

If required, replace the sample compartment front door and close the sample compartment lid. 

Configuring the accessory using the software 

The Fast Filter accessory is designed to be operated by the Ratio Application provided in the Cary Eclipse Bio 
Software. 

Step 1 

Open the Ratio Application. 

Step 2 

Turn on the instrument. 

Step 3 

From the main Ratio window, select the Setup button to display the Setup dialog. From the Collection Type 
drop-down menu on the Cary page of the Setup dialog window, select either Excitation fast filter or Emission 
fast filter, depending on whether you have installed the Fast Filter accessory in the excitation or emission 
positions respectively (refer to Figure 6). 

Note 
If the Fast Filter accessory is removed it is important that the black cover plate be replaced and secured 
using the two black screws.
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Figure 6. Instructing the instrument to drive the Fast Filter accessory fitted to the excitation monochormator 
chamber. 

On the Accessories page of the Setup dialog, select the Fast Filter option to display the Fast Filter page 
(Figure 7). In this example the software will automatically calculate the result of Filter 3/Filter 1 and the result 
of Filter 4/Filter 2. 

Figure 7. Instructing the Ratio software to drive the Fast Filter accessory.
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Select the result 1 checkbox if you inserted bandpass filters into positions 1 and 3 of the filter wheel, or result 2 
for positions 2 and 4. Alternatively select both checkboxes if you inserted filters in all 4 positions of the filter 
wheel. 

Step 4 

You are now ready to use the Ratio application to gather data. For more information about the Ratio or other 
Cary software applications, select the 'Help' button. 

Accessory Removal 
If you need to remove the Fast Filter accessory from the instrument to add or change filters, grasp the 
accessory base on the right end of the long edge and lift gently. Once the D-plug is disconnected, the accessory 
may be carefully removed. 

If the accessory is not being re-inserted, be sure to replace the black metal cover over the fast filter chamber, 
and tighten the locking screws. 

Specifications 
For environmental and power supply requirements, refer to your instrument operating instructions. This 
product is suitable for indoor use only. 

Maintenance and Cleaning 
Keep your accessory safely packed in its original box when not in use. Avoid unnecessary handling. For 
maintenance and cleaning, please refer to the manufacturer's instructions. 

Technical Assistance 
For technical assistance regarding this accessory, please contact fluorescence@varianinc.com or look for other 
Varian contacts. 

Note 
The text fields in the lower half of the tab are for graph labeling purposes only and have no effect on the 
ratio values calculated.

Weight
Packed 877.5 g (7.93 lb)
Unpacked 377.5 g (0.83 lb)
Dimensions (W x D x H)
Packed 220 x 220 x 220 m (8.66 x 8.66 x 8.66 in)
Unpacked 110 x 220 x 220 m (4.33 x 8.66 x 8.66 in)

See also: 
Automated Polarizer Instruction sheet
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Fiber Optic Coupler Accessory 
Table of Contents 

Safety information
Introduction
Unpacking notes
Installation
Alignment
Operation
Specifications
Maintenance and Cleaning
Technical assistance

Safety information 
Before using this accessory, you must read the Safety Practices and Hazards in your Cary Eclipse Hardware 
Manual. 

A link to the Safety section is also available on the main page of the Cary Eclipse online Help and Videos CD. 

If the equipment is used in a manner not specified by the manufacturer, your safety may be at risk and the 
protection provided by the equipment may be impaired. 

Introduction 
The Fibre Optic Coupler is an accessory that enables the use of a fibre optic probe with the Cary Eclipse. This 
allows the user to examine the fluorescent properties of samples at locations remote from the instrument via an 
optical guide. 

Unpacking notes 
Your accessory is packed in foam-lined cardboard boxes. Check that you have received all of the items in the 
accessory kit by referring to the packing list included with the shipment. 

Installation 
To install the Fiber Optic Coupler in the sample compartment, follow these steps: 

Step 1 

Turn the Cary Eclipse instrument power off using the switch on the front right side of the instrument. You may 
leave the PC turned on. 

Step 2 

Remove the sample compartment lid by sliding it all the way back. You will feel some resistance, but keep 
pushing to remove it completely. Remove the front panel by sliding it upwards. Ensure that the sample 
compartment is empty. 
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Step 3 

Carefully remove all of the packaging foam and accessory components from the box. 

CAUTION: When handling the Fiber Optic Coupler, avoid placing fingers or thumbs in the coupler entrance, 
as they will touch the flat mirror. Always lift using the handle (Figure 1 (i)). 

Step 4 

Ensure that the fastening lever (Figure 1 (vii)) is in the open position (i.e., to the left), and place the Fiber Optic 
Coupler in the sample compartment. 

Figure 1. Fiber Optic Coupler accessory
(i) Handle (v) Focus control (one of two) - DO NOT ADJUST.
(ii) Holding screw (one of two) (vii) Stabilizing screw
(iii) Aligning adjuster (one of four) (vii) Fastening lever in open position
(iv) Key hole (one of two)
Insert: Close up of the stabilizing screw.
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Align the two locating holes on the base of the accessory with the locating pins on the floor at the rear of the 
sample compartment. Move the fastening lever from left to right to lock the accessory into position. 

Step 5 

Adjust the stabilizing screw on the accessory base (Figure 1 (vi)), to stabilize the accessory. To do this, use 
your fingers to screw the top screw (Figure 1, insert) clockwise until there is no side-to-side movement, then 
tighten the locking nut to lock the accessory into this position. 

Step 6 

Attach the special sample compartment lid for use with the accessory onto the top of the instrument, by sliding 
it on from the back. 

Step 7 

To connect the long Fibre Optic Probe (part number 79 100430 00, see Figure 2) to the coupler accessory: 

a. Carefully remove the protective plastic caps from the two connector ends (Figure 2 (ii)) of the probe.

b. Loosen the holding screws (Figure 1 (ii)) on the Fiber Optic accessory by turning them anticlockwise.

Figure 2. Fiber Optic Probe (i) Cable plug (ii) Connector ends (iii) Probe tip (iv) Remote read button (v) Metal 
join 

c. Swing open the small cover on the sample compartment lid. Support the end of the probe to which a
probe tip will be attached (Figure 2 (iii)). While supporting this end, carefully thread the two connector
ends of the probe and the cable plug (Figure 2 (ii) and (i) respectively) down through the hole.

d. Insert the two connector ends into the two key holes (Figure 1 (iv)) in the coupler accessory, ensuring
that the metal pins are pointing directly upwards. (It does not matter which connector end is inserted into
which slot.) Push the ends as far as they will go so that the face on the end of the connectors presses up
against a metal shop.

e. Tighten the holding screws until finger-tight. Check that the probe connectors are securely held in place.
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CAUTION: Fasteners should be finger-tight only. Do not over-tighten or you may damage the connectors. 

f. Connect the cable plug to the D-shaped 25 pin port on the left side of the rear sample compartment wall.

g. Secure the probe in the sample compartment lid by tightening the thumb screw up against the metal join
(Figure 2 (v) and 3 (i)). Then close the small cover (Figure 3 (ii)).

Figure 3. Securing the probe in the sample compartment lid. 

h. Replace the front panel that you removed in step 2 and close the sample compartment lid.

i. Screw a probe tip onto the end of the probe (Figure 2 (ii)). You may use either a solid sample probe tip
(part number 79 100432 00, Figure 4), or a liquid probe tip (10 mm or 20mm - both are available as a
single kit, part number 99 101045 00, see Figure 4 (ii)).

Note
If you are using a liquid probe tip and are going to align the accessory, leave the tip off, as it needs to be
off for alignment.

(i) (ii) 
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Figure 4. (i) Connection of a solid sample probe tip to the Fibre Optic Probe (ii) Connection of a liquid probe 
tip to the Fibre Optic Probe 

Alignment  

To ensure that the fibre optic system will operate at maximum performance, it is necessary to optimize the 
efficiency with which light passes through the coupling device before experimentation begins. 

To align the accessory: 

Step 1 

Turn the Eclipse instrument power on using the switch on the front right side of the instrument. 

Step 2 

Start the Align application by clicking Start in the Windows Taskbar, then Programs/Cary Eclipse/Align. 

Step 3 

Any fluorescent material can be used for alignment. We recommend using the supplied white alignment card. 

If using the solid sample tip, clamp the probe against a white area on the card/fluorescent material. The solid 
sample tip should be oriented as depicted in Figure 5. 

Figure 5. Close up of the solid tip as it should be positioned against the white alignment card. 

If using a liquid probe tip, ensure the probe is removed. Hold the end of the probe against the card/fluorescent 
material at an angle of approximately 45° to avoid scattered  excitation light. Use a clamp to hold the probe in 
this position. 

Step 4 

Warning 
To prevent eye damage, avoid looking at the light beam.

Note 
Alignment needs to be done only once—there is no need to align the coupler each time the accessory is 
removed and re-installed.
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In the Align application, click the Cary tab. If using the white card, set the parameters as depicted in Figure 6 
then click Apply. If using a different fluorescent material, set appropriate excitation and emission wavelengths.

Figure 6. Align application Cary page settings for alignment using a white card. 

Step 5 

To maximize the "Int" (intensity) reading in the top left corner of the screen (hence the amount of light 
reaching the detector), you may need to turn the gold adjusters (Figure 1 (iii)). To do this: 

a. Slide back the lid enough to remove the sample compartment front panel.

b. Using the supplied 5.5 mm spin-tight, slowly turn the vertical excitation adjuster to the left. If the
intensity reading starts to decrease, turn the adjuster to the right.

c. Keep turning the adjuster in the direction that causes the intensity value to increase. When you reach a
point where the value starts to decrease, you have just passed the point of maximum intensity. Turn the
adjuster very slightly back the other way to find this maximum value.

d. Repeat steps (b) and (c) for the horizontal excitation adjuster to maximize the signal. Then, repeat 
steps (b) through (d) until turning either adjuster in any direction results in a decrease in intensity.  

CAUTION: Do not alter any other screws on the accessory, especially the two focus controls (Figure 1 (v)). 

e. Now that you have optimized the light entering the excitation fibers, you will need to maximize the

Tip 
You may find it easier to view the intensity reading graphically. To do this, click the Graph tab. Zoom 
in on the graph for a more precise view of the intensity.

Page 21 of 79Cary Eclipse accessory list

   file://C:\Documents and Settings\cary\Local Settings\Temp\~hh15A7.htm



fluorescence emission reaching the detector. To do this, repeat steps (b) to (d) for the emission vertical 
and horizontal gold adjusters. 

The instrument is over-range if the reading reaches 1000 a.u. If this occurs, it will be necessary to reduce 
the photo-multiplier tube (PMT) voltage on the Cary page in order to continue the alignment procedure. 
As a guide, a 10% change in PMT voltage causes a two-fold change in the intensity measured. 

Step 6 

Once you have maximized the intensity using the adjusters, the coupler is satisfactorily aligned. Replace the 
front panel, close the lid and close the Align application. 

If using the liquid probe tip, you can now screw the tip onto the end of the probe (Figure 4 (ii)). 

Operation 
To use the Fibre Optic Coupler: 

Step 1 

Start the application you will be using and set the instrument parameters according to your analytical 
requirements. 

Step 2 

Present the probe to the sample and press the red Remote Read button (Figure 2 (iv)) on the probe to start the 
data collection. 

Specifications 
For environmental and power supply requirements, refer to your Eclipse operating instructions. This product is 
suitable for indoor use only. 

Maintenance and Cleaning 
The outside of the Fibre Optic Coupler should be kept clean by wiping with a damp cloth (dampened with 
water or alcohol). Do not use abrasive cleaning agents. 

Rinse the probe tips and the end of the probe with water after use and dry before storing. Avoid bending the 
cable sharply as this can damage the cable.

Weight
Packed 3.75 kg    8.27 lb
Unpacked 2.25 kg 4.96 lb
Dimensions (W x D x H)

Packed (includes lid) 330 x 260 x 470 mm 12.9 x 10.2 x 18.5 
in

Unpacked 160 x 160 x 160 mm 6.3 x 6.3 x 6.3 in
Lid unpacked 350 x 210 x 50 mm 13.8 x 8.3 x 2.0 in
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Technical Assistance 
For technical assistance regarding this accessory, please contact: 

Varian Optical Spectroscopy Instruments, 
P.O. Box 222, 
Clayton South, Victoria, Australia, 3169 

or email: fluorescence@varianinc.com 

Alternatively please see the contacts page for your local Varian office. 

Rapid Mix (RX.2000) Accessory 
Table of Contents 

Introduction
Specifications
Installation
Operation
Parts and Supplies

Introduction 
The Rapid Mix accessory is a stop flow accessory that allows the user to start measuring reagents as soon as 
they have been mixed.  This is an obvious advantage for reactions which are short-lived. 

See also: 
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The Rapid Mix (RX.2000) accessory 

The syringes are mounted on a rigid drive platform ensuring that the flow is stopped precisely and 
instantaneously. This platform and the syringe mounting blocks are extremely resistant to chemical attack. 

Reagents travel in this inert sample circuit through an umbilical cord to the flow cell where they are mixed by a 
high efficiency T-format mixer.  

Specifications 

Installation 

 See how to perform steps 1 to 5 

Step 1 

Place the Rapid Mix Accessory on top of the Cary Eclipse instrument with the syringe end of the accessory at 
the front. 

Step 2 

Insert the Rapid Mix Accessory cuvette into either the single cell standard, single cell peltier or single cell 
water thermostatted accessories (the single cell standard is shown in video). 

Step 3 

Connect the 5-pin DIN connector of the cable (supplied with the accessory) to the rapid mix accessory. 

Step 4 

Dead Time 6ms
Optical Pathlengths 2mm and 10mm for absorbance/circular dichroism
Window Sizes 30mm and 6mmfor fluorescence detection
Cell material Spectrosil
Circular Dichroism Triple-annealed observation cell eliminating birefringence
Beam height 15mm from base of cuvette (other beam heights supplied on request)
Min. Vol./Shot/Reagent 100µl
Prime Volume 260µl with standard 60cm umbilical
Syringe Volume 2.5ml with canted seals as standard
Ratio mixing Up to 25:1 by using different size syringes

Temperature Range 0 - 60°C  displayed to within 0.1°C  with high and low adjustable 
alarms

Triggering Anti-bounce, TTL, open-collector and switch-contact
Flow Circuit Biocompatible and chemically inert
Construction Constructed from chemically resistant materials throughout

Anaerobic Facilities An anaerobic accessory (AA.1) is available to facilitate the rigorous 
exclusion of oxygen

Drive System Manually or pneumatically driven (optional accessory DA.1)
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Connect the 25-pin end of the cable to the 25-pin connection at the front of the Cary Eclipse. 

Step 5 

Cover the sample compartment with a black cloth to ensure that no light can enter the sample compartment 
when measuring samples. 

Operation 
For instructions on how to use the Rapid Mix Accessory (RX.2000), refer to the documentation supplied with 
the accessory. 

Parts and Supplies 

Solid Sample Holder Accessory 
Table of Contents 

Safety information
Introduction
Unpacking notes
Installation
Operation
Specifications
Maintenance and Cleaning

Safety information 
Before using this accessory, you must read the Safety Practices and Hazards in your Cary Eclipse Hardware 
Manual. 

A link to the Safety section is also available on the main page of the Cary Eclipse online Help and Videos CD. 

If the equipment is used in a manner not specified by the manufacturer, your safety may be at risk and the 
protection provided by the equipment may be impaired. 

Introduction 
The Solid Sample Holder for the Cary Eclipse is an accessory that enables you to perform fluorescence 
measurements on solid samples. 

It consists of a vertical sample mounting "slide" supported by optical rails attached to the accessory baseplate. 

Three optional kits are available for mounting specific types of solid sample. They are: 

Edge mounting kit (part number 99 101029 00)

Descriptions Part Number
Rapid Mix Accessory RX2000 79 100410 00
Pneumatic Drive For RX2000 79 100411 00
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Powder holder and single crystal holding kit (part number 99 101030 00)
Cuvette holder kit (part number 9 101031 00)

Unpacking notes 
Your accessory is packed in foam-lined cardboard boxes. Check that you have received all of the components 
listed in the packing list included with the shipment. 

Installation 
If you ordered the Solid Sample Holder without any of the additional (optional) mounting kits, follow the 
standard installation procedure. 

If you ordered one of the optional kits, follow the installation procedure that corresponds to your kit. 

Edge Mounting kit installation
Powder holder and single crystal holding kit installation.
Cuvette holder kit installation

Standard installation 

Step 1 

Attach the slide to the accessory base (Figure 1). To do this: 

a. Completely remove the lower half of the clamping mechanism by taking out the screw that holds the two
parts together (Figure 2 (ii)).

Figure 1. The Solid Sample Holder accessory
a) The "slide" d) Optional cuvette holder
b) The accessory base e) Optional edge mounter
c) Clamps used for attaching samples f) Optional powder holder
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Figure 2. showing the screw (ii) separating the lower half of the clamping mechanism (i), and the groove (iii) 
where the optical rail fits. 

b. Slide the lower half of the clamp under the two optical rails on the accessory base. Orient it so that the
cut-out edge is facing the angular adjustment locking screw (Figure 3 (iii)).

PUT PHOTO HERE 

Figure 3. showing (i) how to position the lower half of the clamp (outlined in white) under the optical rails (ii) 
on the accessory base. Locating holes (iv), Varian label (v) and fastening lever (vi) are also labeled. 

c. Re-attach the upper half of the clamp mechanism to the lower half by placing the locating pin into the
hole in the centre of the lower piece, and inserting and tightening the screw that you removed in step (a).
The face of the slide should point towards the Varian label (Figure 3 (v)) on the base of the accessory.

Step 2 

Use the rods, clamps and screws contained in the remaining small box (part number 99 101037 00), in 
combination with the tapped holes in the slide face, to mount your sample. 

Step 3 

You can now place your assembled accessory and sample into the sample compartment. To do this: 

a. Ensure that the Eclipse sample chamber is empty.

b. Ensure that the Solid Sample Holder baseplate fastening lever (Figure 3 (vi)) is in the open position (that
is, pointing towards the white scale marks).

c. Align the two locating holes on the base of the accessory (Figure 3 (iv)) with the locating pins on the
floor at the rear of the sample compartment.

d. Move the fastening lever from left to right to lock the accessory into position.
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Edge Mounting kit installation 

If you ordered the optional Edge mounting kit (part number 99 101029 00), follow the installation procedure 
below. 

Step 1 

Follow step 1 of the standard installation procedure. 

Step 2 

Remove the standard slide by loosening the two screws at the top of the slide holder and sliding the face all the 
way across. 

Step 3 

Slide the edge mounting slide face onto the top of the slide holder. The edge mounting pieces attached to the 
slide should be facing the Varian label (Figure 3 (v)) on the accessory base, and the white grading marks 
should be at the top. 

For larger samples, unscrew the two bottom edge mounting pieces using the supplied hexagonal ball 
screwdriver and remove the top edge mounting piece by unscrewing the thumb screw. Replace these with the 
supplied large edge mounting pieces. (The piece with the two small guiding pins is the one that is positioned in 
the center of the slide face. The pins allow it to slot into the tracks. 

Step 4 

Slot your sample into the "V" created by the bottom two edge mounting pieces. Then loosen the screw that 
holds the central edge mounting piece in place and slide this piece down to secure the sample. 

Step 5 

Follow step 3 of the standard installation procedure. 

Powder holder and single crystal holding kit installation. 

If you ordered the optional Powder holder and single crystal holder and single crystal holding kit (part number 
99 101030 00), follow the appropriate installation procedure below. 

To install the single crystal holder:  

Step 1 

Follow step 1 of the standard installation procedure. 

Step 2 

Attach the crystal holder (Figure 4) to the slide face using the two screws provided. The three-holder side 
should form a "shell". Place your crystal into the hole that most securely holds your crystal. 

Page 28 of 79Cary Eclipse accessory list

   file://C:\Documents and Settings\cary\Local Settings\Temp\~hh15A7.htm



Figure 4. The single crystal holder: 

Step 3 

Follow step 3 of the standard installation procedure. 

To install the powder holder: 

Step 1 

Follow step 1 of the standard installation procedure 

Step 2 

Attach the rectangular plate with a semi-circle cut out of it to the face of the slide. Do this using the four screws
and the hexagonal ball screwdriver. Ensure the flat side of the plate is facing away from the slide. 

Step 3 

Position the powder receptacle (Figure 5 (iii)) with the small silver rod pointing upwards. 

Step 4 

Using gloves or lens tissue, carefully place a silica disc (Figure 5 (ii)) into the powder holder receptacle. 
Beware of contaminating the disc with fingerprints. 

Step 5 

Put some sample into the powder receptacle, ensuring a thin layer is covering the silica. 

Step 6 

Place the powder receptacle into the larger powder holder "shell" (Figure 5 (iv)). To do this: 

a. Grasp the small silver rod of the powder receptacle between the thumb and forefinger.

b. Lift the powder receptacle, keeping it horizontal at all times to avoid spilling the powder.

Note 
The kit comes with a spare silica disc and a spare powder holder receptacle. 
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c. Place  the receptacle into the centre of the shell cavity.

Step 7 

Ensuring that the protruding black metal column (Figure 5 (v)) is on the inside, (in order to securely press the 
sample up against the silica disc), screw the lid (Figure 5 (i)) of the powder holder onto the shell. 

Figure 5. Exploded view of the powder holder. The sample sits between the silica disc (ii) and the column of 
the lid (v). 

Step 8 

Take the assembled powder holder and slide the rim (Figure 5 (vi)) into the semi-circle groove on the accessory 
slide face created in step 2. 

Step 9 

Follow step 3 of the standard installation procedure. 

Cuvette holder kit installation 

If you ordered the optional Cuvette holder kit (part number 99 101031 00), follow the installation procedure 
below. 

Step 1 

Note 
When disassembling the powder holder, ensure that the silica disc is facing down when you unscrew the 
lid, to prevent spillage of powder.
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Follow step 1 of the standard installation procedure. 

Step 2 

Attach the cell holder to the slide by aligning the two holes on the cell holder with the two holes at the bottom 
of the slide and using the hexagonal ball screwdriver to screw in two screws. Ensure that the open side of the 
cell holder is facing outwards. 

Step 3 

Insert the cuvette containing the sample 

Step 4 

Follow step 5 of the standard installation procedure. 

Operation 
The solid sample holder accessory provides both rotational and translational adjustment of the sample. The 
angle of incidence of the excitation may be varied from 20–35°. This is the angle between the exciting light 
and a line perpendicular to the surface of the sample mounting slide (Figures 6 and 7). The angle of incidence 
is indicated by the position of the corner of the "stage" relative to the graduated markings on the accessory 
baseplate (Figure 6). The markings are at intervals of one degree. The largest mark indicates an angle of 
incidence of 30°. 

Figure 6. a) Angular adjustment locking screw b) Corner of stage. Markings indicate the angle of incidence of 
the exciting light in the sample mounting slide. 

Figure 7. Angle of incidence of excitation. a) Normal b) Angle of incidence c) Excitation d) Slide
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To alter the angle of incidence: 

Step 1 

Loosen the angular adjustment thumbscrew (large thumbscrew). 

Step 2 

Rotate the stage to the desired orientation. 

Step 3 

Lock the stage into position by rotating the thumbscrew until finger-tight. 

It is recommended that you use the Kinetics application to perform this procedure. Alternatively, you can use 
the Advanced Reads application. 

To optimize measurement of a particular sample with the solid sample holder accessory, it is recommended 
that you initially monitor both the fluorescence intensity and the signal intensity at the excitation wavelength. 
Rotate the accessory "stage" (Figure 6 (b)) to alter the angle of incidence of the exciting light. 

Samples of varying depth may be moved to the focal position by loosening the thumbscrew that tightens the 
clamps around the optical rails, and sliding the entire mount forward or backward as required. This ensures the 
exciting light interacts with the sample directly in front of the emission window thus enhancing the collection 
of emission. 

The contribution to the total signal from scattered exciting light is inherently greater when measuring opaque 
solids as compared to clear (non-scattering) liquids measured at the traditional right angle orientation. For this 
reason, it is highly recommended that excitation and emission filters be used. This can be achieved using the 
Eclipse software by setting both the "Excitation filter" and "Emission filter" selections on the Options tab of 
Setup to AUTO. If required, further reduction of scattered excitation could be achieved by placing appropriate 
cut-off and/or bandpass filters in the filter holders provided in the instrument sample chamber. 

Specifications 

Maintenance and Cleaning 
All cleaning should be done with a soft cloth. If necessary, this cloth can be dampened with water or a mild 
detergent to clean black painted surfaces. Do not use organic solvents or abrasive cleaning agents. 

Weight
Packed 3.4 kg 7.4 lbs
Unpacked 1.5 kg 3.35 lbs
Dimensions (W x D x 
H)

Packed 290 x 250 x 250 
mm 11.42 x 9.84 x 9.84 in

Unpacked 190 x 190 x 200 
mm 7.48 x 7.48 x 7.78 in
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Wellplate Reader 
Table of Contents 

Introduction
Installation
Alignment
Operation
Parts and Supplies

Introduction 
The Cary Eclipse Wellplate reader is an extremely versatile accessory and performs as efficiently as part of the 
Cary Eclipse instrument as many independent wellplate readers do on their own. 

Installation 
Step 1 

 See how to perform steps 1 to 4 

See also: 
Other Accessories 

Figure 1 - The Wellplate Reader 

The Cary Eclipse Wellplate reader is capable of handling up 
to 384 well wellplates but can also handle custom 
wellplates.  The Wellplate Reader is computer controlled in 
the X-Y planes with mechanical adjustment in the Z plane. 
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Make sure that the sample compartment is empty. 

Step 2 

Position the wellplate reader on the locating pins at the rear of the sample compartment. 

Step 3 

Turn the fastening lever to the left. 

Step 4 

Connect the accessory cable to the 15-pin port which is located on the left wall of the sample compartment. 

Step 5 

 See how to perform steps 5 to 8 

Install the top cover for the Wellplate Reader by sliding it along the rails at the top of the sample compartment 
and tighten the knob to secure the cover. Leave the sample compartment open. 

Step 6 

Loosen the extended section of the sample compartment (which is attached to the Wellplate Reader). This is 
achieved by loosening the thumbscrews underneath the front of the accessory. 

Step 7 

Close the hinged section of the extended cover and lift the section attached to the accessory so that it fits neatly 
into the hinged section. 

Step 8 

Tighten the thumbscrews underneath the front of the accessory to hold the extended section of the sample 
compartment permanently in place. 

Alignment 
The top left, top right and bottom right well positions of a wellplate are used for the purposes of alignment. For 
the purposes of this example, a 96 wellplate and a 384 wellplate will be used. Thus the A1, A12 and H12 
positions (96) or A1, A24 and P24 positions (384) are used for alignment.  

The Wellplate Reader should be aligned whenever you change brands or types of wellplates. Manufacturers of 
wellplates have varying dimensions between wells and the dimensions also change when you swap from a 96 
well to a 384 well plate. You cannot move the Wellplate Reader out of alignment by manually pushing the 
wellplate platform—it remembers alignment coordinates and will reset itself at the start of a run.  

To align a wellplate:  

Step 1  
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From the Align Application window, select the Wellplate (Wellplate) tab to access the Wellplate (Wellplate) 
page.  

Step 2  

From the Plate type field, select the Plate type you require. Alternatively, you can create or modify a plate 
using the Plate format dialog.  

How to create or modify a wellplate format 

Step 3  

Place a fluorescing solution in Wells A1, A12 and H12. Fill the well to at least three-quarters (3/4) full.  

Step 4  

Select the A1 well position on the Wellplate Reader diagram to drive the Wellplate reader to this well. To do 
this, simply click in the well. The well will change color, to indicate that it is selected (as shown below). 

Step 5  

Select the Cary tab to display the Cary page. On this page, do the following:  

a. Set excitation and emission wavelength parameters that are relevant for the solution you are using.

b. Set the Emission filter option to Auto.
c. Set the Excitation filter option to Auto.
d. Adjust the PMT Voltage as required, ensuring that the intensity signal does not go over-range.
e. Select Apply to update the instrument parameters.

Step 6  

Select the Wellplate (Wellplate) tab to display the Wellplate (Wellplate) page. On this page, do the 
following: 

a. Select Auto-align to commence the auto-align procedure that will align the wellplate.

Tip: 
To minimize collecting scattered excitation light, you should ensure that the excitation and emission
wavelengths are at least the sum of the excitation and emission slit widths. For example, if you are 
an Excitation slit of 5 nm and an Emission slit of 10 nm, set the emission wavelength at least 15 nm
greater than the Excitation wavelength. 

Note: 
If the signal over-ranges during the auto-align procedure, decrease the PMT Voltage value on the C
page and then re-perform the Auto-align. 
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b. Once the alignment procedure is completed correctly, select the A1 well position on the Wellplate
Reader diagram to drive the Wellplate reader to this well.

Step 7  

Select the Cary tab to display the Cary page. On this page, do the following:  

a. Set the excitation wavelength to visible light (for example, 540 nm).
b. Select Apply.

Step 8  

Visually determine whether the image of the beam is within the well. 

If the beam is within the well, do the following: 

a. Select the Wellplate (Wellplate) tab to display the Wellplate (Wellplate) page.
b. Select Save Plate to save the current settings.

The wellplate is now aligned and ready for use. However, if you would like to obtain the optimum performance 
from your wellplate reader, go to Step 9. Otherwise, go to Step 11. 

If the beam is NOT within the well, (this may occur for 384 wellplates) do the following: 

a. Select the Wellplate (Wellplate) tab to display the Wellplate (Wellplate) page.
b. Use the Arrow buttons to move the plate so that the beam image is within the well and does not clip the

sides.
c. When you are satisfied with the visual alignment, select Save A1.
d. Select the A12 (96) or A24 (384) well position on the Wellplate Reader diagram to drive the Wellplate

reader to this well. Confirm that the image is within this well. If the image is not within the well, drive
back to well A1, re-adjust the beam image and re-save the A1 setting.

e. Select H12 (96) or P24 (384) well position on the Wellplate Reader diagram to drive the Wellplate
reader to this well. Confirm that the image is within this well. If the image is not within the well, drive
back to well A1, re-adjust the beam image and re-save the A1 setting.

f. Once you are satisfied that the beam is image is within all well positions, select Save Plate to save the
current settings.

The wellplate is now aligned and ready for use. However, if you would like to obtain the optimum performance 
from your wellplate reader, go to Step 9. Otherwise, go to Step 11. 

Step 9  

a. Select the Cary tab to display the Cary page. On this page, set the Ave. time to 0.1 s.

2. Select the Wellplate (Wellplate) tab to display the Wellplate (Wellplate) page. On this page, select the
A1 well position on the Wellplate Reader diagram to drive the Wellplate reader to this well.

3. Select the Graph tab to display the Graph page. You will need to monitor the signal intensity on the

Note: 
To obtain the optimum performance from your wellplate reader, you can perform the following steps (9 
and 10). However, these steps are OPTIONAL. If you do not wish to perform these steps, go to Step 11.
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graph while you are performing the adjustment procedure outlined below. Your aim is to maximize the 
intensity. 

Step 10 

You need to adjust the emission optics controls, which are located on the right side of the Wellplate Accessory 
(when you are looking at it). Using the spanner (part number 72 100153 00) provided in the Wellplate 
Accessory kit, adjust the vertical and horizontal alignment screws (refer to Figure 2, below). 

Monitor the intensity signal on the Graph page, and continue to adjust the alignment screws until you can 
reach a maximum intensity. 

Caution 
Do not adjust any other screws as this may change the focal point of the accessories. Only adjust the vertical 
and horizontal emission alignment screws. 

The Wellplate Reader alignment is now fully optimized. 

Figure 2 - The emission alignment screws 
1. Vertical alignment screw     2. Horizontal alignment screw

Step 11 

From the File menu, select Exit to close the Align application. You can now select the aligned plate in all Cary 
Eclipse applications that use a Wellplate accessory. 

Hot Tip 

You may need to change the graph scale when performing the alignment. To do this, select 

from the Graph toolbar and enter the required scale. Alternatively, select  to automatically 
scale the axes.

You can use this alignment configuration to read all plates of the same type and volume.  The plate will 
not have to be auto-aligned again as long as the same plate type/brand is used. However, if the volume is 
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Operation 
Refer to the Kinetics, Scan and Advanced Reads software help sections for specific operational details. 

Parts and Supplies 

Ambient 4 Position Multicell Holder Accessory 
Table of Contents 

Safety information
Introduction
Unpacking notes
Installation
Operation
Specifications
Maintenance and Cleaning

Safety information 
Before using this accessory, you must read the Safety Practices and Hazards in your Cary Eclipse Hardware 
Manual. 

A link to the Safety section is also available on the main page of the Cary Eclipse online Help and Videos CD. 

If the equipment is used in a manner not specified by the manufacturer, your safety may be at risk and the 
protection provided by the equipment may be impaired. 

Introduction 

varied and the height of the plate changed, by either adding or removing the spacer, the signal should be 
maximized for optimum performance. 

Descriptions Part Number
Wellplate Reader Accessory 00 100754 00
96 White sterile non treated 10pk 66 100223 00
96 White non-sterile high binding 10pk 66 100224 00
96 Black non-sterile high binding 10pk 66 100225 00
384 White non-sterile high binding 10pk 66 100226 00
384 Black non-sterile high binding 10pk 66 100227 00
96 White non-sterile high binding 25pk 66 100228 00
96 Black non-sterile high binding 25pk 66 100229 00
384 White non-sterile high binding 25pk 66 100230 00
384 Black non-sterile high binding 25pk 66 100231 00
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The Ambient 4 Position Multicell holder for the Cary Eclipse is an accessory that permits fluorescence 
measurements on up to four samples at a time. 

Unpacking notes 
Make sure that all of the adhesive tape, plastic and cardboard is removed before operating the Ambient 
Multicell Holder. 

Installation 
Step 1 

Turn the Cary Eclipse instrument power off using the switch on the front right side of the instrument. You may 
leave the PC turned on. 

Step 2 

Slide the top panel of the sample compartment all the way back and completely remove the front panel by 
sliding it upwards. Ensure that the sample compartment is empty. 

Step 3 

Lift the Multicell Holder by the handle, holding the end of the cable in your other hand. Reset the accessory at 
the front of the sample compartment in order to allow access to the D-shaped, 25 pin port at the left side of the 
rear sample compartment wall. Connect the cable plug to the 25 pin port. 

Step 4 

Ensure that the fastening lever is in the open position (i.e., to the left). Align the two holes on the base of the 
accessory with the locating pins on the floor sample compartment. Move the fastening lever from left to right 
to lock the accessory into position. 

Step 5 

Replace the front panel ensuring the accessory cable is tucked neatly into the sample compartment. The 
accessory is now ready for use. 

Operation 
Operation of the accessory is through the Cary Eclipse software. 

To use the multicell holder: 

Step 1 

From the Setup dialog, select the Accessories tab to access the accessories page.  

Step 2 

Note 
To remove the accessory, turn the instrument off and then follow the above procedure in reverse.
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Select the Multicell holder option and from the cell diagram, select the number of cells to use. 

Step 3 

To display the temperature of items in the Status Display window, select these from the Temperature display 
option. 

Step 4 

Select OK to exit the Setup window. 

Step 5 

Select Start to begin data collection. 

Specifications 
For environmental and power supply requirements, refer to your Cary Eclipse Hardware Operation manual 
(part number 85 101758 00). This product is suitable for indoor use only. 

Connections 

25-pin D-range connector on flying lead

Maintenance and Cleaning 
All cleaning should be done with a soft cloth. If necessary, this cloth can be dampened with water or a mild 
detergent to clean black painted surfaces. Do not use organic solvents or abrasive cleaning agents. 

Cryostat - Variable Temperature Liquid Nitrogen 
Optistat DN

Table of Contents  

Weight
Packed 9.0 kg 19.8 lb
Unpacked 2.8 kg 6.2 lb
Dimensions (W x D x H)

Packed 765 x 360 x 325 
mm 30.1 x 14.2 x 12.8 in

Unpacked 160 x 185 x 170 
mm 6.3 x 7.3 x 6.7 in

See also: 
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Introduction
Specifications
Installation
Operation
Parts and Supplies

Introduction 
The Oxford Instruments "Optistat DN", a variable temperature liquid nitrogen cryostat, is designed for variable 
temperature (77-320°K, +/- 0.1°K) optical spectroscopy measurements and electrical measurements requiring 
optical access.  Varian provides a mount and covers for the Optistat DN so that it may be used in the Cary 
Eclipse instrument. 

Figure 1 - The Optistat DN Cryostat and its measurements 

Specifications 
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Further specifications for the Optistat DN Cryostat can be found in the manual supplied with the cryostat. 

Installation 
Step 1 

Make sure that the sample compartment is empty. 

Step 2 

 See how to perform steps 2 to 4 

Position the cryostat holder on the locating pins in the Cary Eclipse sample compartment (the fastening lever 
should be positioned closest to the front of the instrument). 

Step 3 

Turn the fastening level of the cryostat holder to the right. This will lock the base plate into position. 

Step 4 

Place the O-ring (supplied with the cryostat holder) around the cryostat.  

Step 5 

 See how to perform steps 5 to 8 

Insert the rear section of of the cryostat sample compartment lid from the back of the instrument by sliding it 
along the rails at the top of the sample compartment. 

Step 6 

Position the Cryostat in the cryostat holder and tighten the cryostat holder thumb screws so that they are finger 
tight. Do not over-tighten. 

Sample space (mm) 20 dia
Temperature range (K) 77 - 320°
High temperature with OPTIHT option** (K) 500
Temperature stability (K) ±0.1°K
Cool down time from ambient (min) 15
Liquid nitrogen capacity (l) 1.2
Hold time at 77 K (hr) 15
Sample change time (min) 5
Weight (kg) 5

Note: 
For operation between 320 and 500 K, high temperature sapphire windows are required on the inner 
window ports.
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Step 7 

Make adjustments to the O-ring so that it fits into the groove of the rear section of the sample compartment lid. 

Step 8 

Slide the rear section of the lid so that it sits right against the cryostat and tighten the thumbscrew. 

Step 9 

 See how to perform steps 9 and 10 

Insert the front section of the sample compartment lid. Position the O-ring so that it fits neatly into the groove 
of the front section of the sample compartment lid. 

Step 10 

Insert the front sample compartment panel. 

Operation 
Operation instructions for the Optistat DN Cryostat can be found in the manual supplied with the instrument. 

Parts and Supplies 

Peltier 4 Position Multicell Holder Accessory 
Table of Contents 

Safety information
Introduction
Unpacking notes
Installation
Operation
Specifications
Maintenance and Cleaning

Safety information 
Before using this accessory, you must read the Safety Practices and Hazards in your Cary Eclipse Hardware 
Manual. 

Note 
The O-ring fits into the grooves of both the front and rear sections of the special cryostat sample 
compartment lid.

Descriptions Part Number
Oxford Cryostat holder and lid accessory 00 100763 00
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A link to the Safety section is also available on the main page of the Cary Eclipse online Help and Videos CD. 

If the equipment is used in a manner not specified by the manufacturer, your safety may be at risk and the 
protection provided by the equipment may be impaired. 

Introduction 
The Peltier-thermostatted 4 Position Multicell Holder for the Cary Eclipse is an accessory that permits the 
fluorescence measurements on up to four samples, while precisely controlling the temperature and rate of 
stirring. 

Unpacking notes 
Make sure that all of the adhesive tape, plastic and cardboard is removed before operating the Peltier Multicell 
Holder. 

Installation 
Step 1 

Turn the Cary Eclipse instrument power off using the switch on the front right side of the instrument. You may 
leave the PC turned on. 

Step 2 

Slide the top panel of the sample compartment all the way back and completely remove the front panel by 
sliding it upwards. Ensure that the sample compartment is empty. 

Step 3 

Lift the Multicell Holder by the handle and hold the end of the hose in your other hand. Reset the accessory at 
the front of the sample compartment in order to allow access to the D-shaped, 25 pin port at the left side of the 
rear sample compartment wall. Connect the cable plug to the 25 pin port. 

Step 4 

Ensure that the fastening lever is in the open position (i.e., to the left). Hold the extended nose (the black metal 
flange which contains the stirring controls, see Figure 1) and align the two holes on the base of the accessory 
with the locating pins on the floor at the rear of the sample compartment. Move the fastening lever from left to 
right to lock the accessory into position. 
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Figure 1. Peltier 4 Position Multicell Holder accessory 

Step 5 

Ensure the two black locking latches at the back of the extended nose are pointing upwards (unlocked, see 
Figure 1). Position the extended nose into place by aligning its locating pins with the holes in the front of the 
sample compartment floor. Lock the extended nose into position by pushing the locking latches downwards. 

Step 6 

Slide the special door for thermostatted accessories (part number 99 101032 00) into position ensuring the 
electrical cable is tucked neatly into the sample compartment. 

Step 7 

Connect the hose ends to the Temperature Controller inlet and outlet connections. 

Step 8 

Connect the circular communications plug to the 14 pin socket on the Temperature Controller. 

Step 9 

Note 
The Peltier Multicell Holder must be used only with a Varian Temperature Controller 
(part number 00 100386 00).

Note 
You may need to rotate the communications plug before it will slot into the communications socket, as it 
has been designed to be inserted in one position only.
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Ensure the Temperature Controller has sufficient liquid for optimal operation. 

Operation 
Operation of the accessory is through the Cary Eclipse software, with the exception of the stirrer control which 
is located on the front of the extended nose. 

To use the multicell holder: 

Step 1 

From the setup dialog, select the Accessories tab to access the accessories page. 

Step 2 

Select the Multicell holder option and from the cell diagram, select the number of cells to use. 

Step 3 

To enable temperature control (optional) 

a. Select the Temperature Control check box. From the Device option, select Temperature Controller.

b. Enter the required temperature and select the monitor. This monitor will allow data collection to begin
when the temperature of the monitoring device is within ± 0.5°C.

Step 4 

To display the temperature of other items in the Status Display window, select these items from the 
Temperature display option. Figure 2 (below) shows a typical setup of the multicell peltier accessory. 

Step 5 

Select OK to exit the Setup window. 

Step 6 

Select Start to begin the data collection. 

Note 
The temperature probe holder (see Figure 1) that spans the two black spots on the multicell holder 
should be removed when inserting or removing cuvettes.
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Figure 2. Accessories tab showing a typical setup of the multicell holder accessory 

Specifications 
For environmental and power supply requirements, refer to your Cary operating instructions. This product is 
suitable for indoor use only. 

Connections 

25-pin D-range connector on flying lead.
14 pin circular lead (connect to Varian Temperature Controller)
2 water circulation tubes (connect to Varian Temperature Controller)

Maintenance and Cleaning 

Weight
Packed 10.4 kg 22.9 lb
Unpacked 4.2 kg 9.3 lb
Dimensions (W x D x H)
Packed 765 x 360 x 325 mm 30.1 x 14.2 x 12.8 in
Unpacked 180 x 320 x 180 mm 7.1 x 12.6 x 7.1 in
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All cleaning should be done with a soft cloth. If necessary, this cloth can be dampened with water or a mild 
detergent to clean black painted surfaces. Do not use organic solvents or abrasive cleaning agents. 

Single Cell Holder (Peltier Thermostatted) 
Table of Contents 

Introduction
Specifications
Getting Started

Unpacking  
Installation

Cuvette pitch adjustment  
Alignment  
Setting the temperature  

Operation
Maintenance
Trouble Shooting

Introduction 
The single cell peltier is an electronically controlled thermostatting single cell accessory capable of controlling 
the temperature to within +/- 0.1°C.  It provides excellent temperature reproducibility, stability and accuracy. 

The single cell peltier has a temperature range of 0-100°C, but this range can be extended below 0°C with the 
aid of a refrigerated water bath. Accurate temperature setting and temperature feedback is provided through the 
Cary Eclipse Software interface. 

Other accessories that can be used in conjunction with the Peltier Single Cell Accessory are:  

Cell Base
Temperature Probe

Specifications 
The performance specifications of the Peltier Single Cell accessory are: 

Temperature reproducibility ± 0.1 °C
Temperature stability ± 0.1 °C
Temperature accuracy ± 0.1 °C
Temperature range 0-100 °C

The temperature display range is between 0 and 100 °C 

Getting started 

See also: 
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Unpacking 

Unpack the accessory, and check that you have received the following: 

Peltier Cell Holder (with ribbon cable attached)
Temperature control module
Hexagonal ball driver
Tubing and connectors
Euroflux 600 water pump

Installation 
You will need: 

The standard Cary Eclipse cell holder base
The length of silicone rubber tubing provided
Alternate sample compartment front panel (P/N 01 106483 90)
A circulating water bath or tap water

To install the Peltier Cell Holder:  

Step1  

 See how to perform steps 1 to 4 

Position the peltier accessory on the bench, next to your Cary Eclipse.  

Step 2 

Remove the top and front panels from the Cary Eclipse sample compartment and make sure that the sample 
compartment is empty.  

Step 3 

Place the cell holder on the cell holder base, aligning the notches in the cell holder with the raised black knobs 
in the cell holder base. 

Step 4 

Tighten the thumbscrew to secure the cell holder to the cell holder base. 

Step 5 

 See how to perform steps 5 

Take the small diameter tubing provided and cut it in half. Attach the tubing to the connectors on the cell 
holder (item 4 in Figure 1). 

Note 
Placing the cell holder on the cell holder base and attaching the tubing and ribbon cable to the cell holder 
should occur outside the sample compartment.
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Step 6 

Attach the two large rubber tubes to the ends of the small tubes using the two white connectors provided. 

Step 7 

Attach one of the large tubes to the water pump outlet. 

Step 8 

Place the other large tube in the water reserve with the pump. 

Step 9 

 See how to perform step 9 

Connect the cell holder to the peltier accessory using the ribbon cable (item 5 in Figure 1). 

Step 10 

If available, fit the alternate sample compartment front panel to the instrument. When you place the cell holder 
and base into the sample compartment, ensure that the tubing and the ribbon cable from the cell holder 
protrude through the cutout at the bottom of the sample compartment front panel. 

Step 11 

If you intend to use the remote read switch (supplied with the alternate sample compartment front panel) to 
take readings: 

(a) Plug the cable attached to the alternate sample compartment front panel into the port in the left hand wall
of the sample compartment.

(b) Plug the remote read cable into the port on the front of the alternate sample compartment front panel.

Step 12  

Install the cell holder and cell holder base in the sample compartment as follows: 

 See how to perform steps 12 to 14  

(a) Place the cell holder base in the sample compartment, aligning the two locating holes over the two
locating pins in the floor of the sample compartment.

Note 
The out-flow of the cell holder must flow back into the water reserve or the water reserve will empty.

Note 
The water flows from the water pump in the water reserve to the cell holder, the from the cell holder, 
back into the water reserve.
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(b) Move the cell base lever to the right.

Step 13 

Connect the RS-232C cable to the back of the peltier accessory. Connect the other end of the cable to a COM 
port at the back of your PC (they are usually marked |0|0| ). 

Step 14 

Replace the power cable at the back of the PC. 

Step 15 

If you connected the cable to a COM port other than COM port 1 on your PC you will need to change the 
software settings in the Cary Eclipse software. 

a. Startup the application you are going to use the Single Cell Peltier Accessory with and click
the Setup button.

b. Select the Accessories tab and check the Temperature Control group check box.
c. Select  Automatic Temperature Setting.
d. Select Single Cell Peltier
e. Click on the Port drop-down list
f. Select the port that you have connected the cable to.
g. Click OK to close the Setup dialog.

You should now align the cell holder. 

For Cuvette Pitch Adjustment 

Step 1 

 See how to perform pitch adjustment procedure

Figure 1: Cell Holder components:
1. Alignment hole and notch 2. Adjustment screw
3. Thumbscrew 4. Tubing connectors
5. Ribbon cable attachment
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Turning the pitch adjustment in a anti-clockwise direction will raise the front of the cell holder. 

Step 2 

Turning the pitch adjustment in an clockwise direction will lower the front of the cell holder. 

Alignment 

Once the cell holder is installed in the sample compartment you need to align it in the light path for maximum 
light throughput. 

To align the cell holder: 

Step 1  

Start the Align application by clicking the Start button in the Windows Taskbar and selecting Programs/Cary 
Eclipse /Align. 

Step 2 

Select the Cary tab. 

Step 3 

In the Instrument Parameters group, set the excitation wavelength to 0 nm (white light) by checking the Zero 
Order check box. 

Step 4 

Click Apply. (The green power indicator on the instrument should start flashing to indicate that the instrument 
is active.) 

Step 5 

Place a cell in the cell holder. 

Step 6 

Select the Graph tab and adjust the pitch screw to find the maximum intensity. 

You should now set the required temperature. 

Setting the temperature 

To set the temperature:  

The temperature setting for the peltier accessory is controlled from the software.   

Step 1  

Note 
The pitch adjustment screw requires a hex key.
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Ensure that the voltage switch on the rear of the peltier accessory is set to the correct value for your location 
(120 or 230 V), connect the supplied power cord to the peltier accessory and the mains power supply, and turn 
the mains power on. 

Step 2 

Click on the Setup button in the Cary Eclipse application that is open. 

Step 3 

Click on the Accessories tab. 

Figure 1 - The Accessories tab (highlighting temperature control) 

Step 4 

Click on the Multicell/Temperature button (the number of buttons in the Accessories tab will vary depending 
upon the application that is open). 

Step 5 

1 Accessories tab 2 Multicell/Temperature button
3 Temperature control group box 4 Temperature display group box
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Check the Temperature control check box and select Single Cell Peltier from the drop-down list. Make sure 
that the COM port that is shown in the Port drop-down list matches the port that you have the peltier accessory 
connected to. 

Step 6 

The temperature of the peltier accessory can be set by clicking on the up or the down arrow (as shown in 
Figure 1). The up and down arrows can be found next to the Temperature (°C) entry field. Alternatively, you 
can enter a temperature directly into the Temperature (°C) entry field. 

Step 7 

You can get a constant read out of the Block temperature - both the temperature it is set to and its actual 
temperature along with the temperature of up to four probes. This is controlled in the Temperature display 
group box (also shown in Figure 1). 

When the temperature has stabilized the cell holder is ready for use. 

You may monitor the temperature of the cell contents by using the Cary Eclipse Temperature Probe accessory 
(part number 00 100408 00). Refer to the Temperature Probe instructions for further details. 

Stirring 

Switch on the STIR button and set the agitation speed (from 0-9). An agitation speed of 0 activates the stirrer. 

Operation 
To use the cell holder:  

Step 1  

 See how to perform step 1  

Place a cell in the cell holder. 

Step 2 

Set up your water circulating system to provide a flow rate of 0.5 litres per minute. 

Step 3 

Allow sufficient time for the cell and sample to warm to the specified temperature. This may take up to thirty 
minutes, depending on the nature of the solution. 

Step 4 

When all the components of the system are at the required temperature you may commence the measurement.

Note 
The time taken for the temperature to stabilize will depend upon several factors, including the ambient 
temperature, the viscosity of the solution and the required temperature.
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Maintenance 
Regularly inspect the accessory to check for water leaks or degradation of the tubing. Replace when necessary. 

Troubleshooting 

Spare parts 
The following spare parts are available from Varian. Only Varian supplied parts should be used, unless 
otherwise specified.  

Single Cell Holder (Water Thermostatted) 
Table of Contents 

Introduction
Specifications
Installation
Alignment

Pitch and Height Adjustment 
Cuvette Pitch Adjustment
Cuvette Height Adjustment

Alignment procedure  
Setting the temperature
Operation

Introduction 
The Water Thermostatted Single Cell Accessory enables users to efficiently maintain cells at a specific 
temperature.  This is achieved with the use of a constant flow of water to the accessory from a water bath.  The 
PCB-150 can be used with the Water Thermostatted Single Cell Accessory or a third party water bath can be 
used. 

The accessory is not only capable of handling regular cuvettes but can also handle micro-cells as well. 

Specifications 

Problem   Solution
Water leaks inside 
the sample 
compartment.

Circulate hot water through the system and try to determine the source 
of the leak. 
Inspect the tubing and check that it is securely fitted to the Cell Holder. 
You may wish to use a sealant around the connections, but ensure that 
it does not absorb light at the wavelengths you are working at.

Description Part number
Single Cell Holder—Peltier Thermostatted 00 100764 00
Cary Eclipse Alternate sample compartment front 
panel 

01 106790 90
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The performance characteristics of the accessory are dependant on the specifications of the water bath that is 
used with the accessory.  These performance characteristics can be achieved with the use of the PCB-150. 

Temperature range 20-60 °C
Temperature accuracy ± 0.1 °C
Reproducibility ± 0.05 °C
Program ramp

Installation 
Step 1 

Make sure that the sample compartment is empty. 

Step 2 

Position the cell holder base on the two locating pins at the rear of the Cary Eclipse sample compartment. 

Step 3 

Turn the fastening lever to the right. 

Step 4 

Position the water thermostatted cell holder on the sample compartment base so that the groove in the cell 
holder points to the left wall of the sample compartment. 

Step 5 

Tighten the thumb screw of the water thermostatted cell holder 

Step 6 

Attach the PCB-150 to the Water Thermostatted Cell Holder and the Cary Eclipse according to the PCB-150 
instructions. 

Alignment 

Pitch and Height Adjustment 

Once the Water Thermostatted Cell Holder is installed in the sample compartment you need to align it in the 
light path for maximum light throughput. 

For Cuvette Pitch Adjustment 

Step 1 

 See how to perform pitch adjustment procedure
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Turning the pitch adjustment in a anti-clockwise direction will raise the front of the cell holder. 

Step 2 

Turning the pitch adjustment in an clockwise direction will lower the front of the cell holder. 

For Cuvette Height Adjustment 

Step 1 

 See how to perform height adjustment procedure 

Turning the height adjustment screw in a clockwise direction will raise the cuvette. 

Step 2 

Turning the height adjustment screw in an anti-clockwise direction will lower the cuvette platform. 

Alignment procedure 

Step 1 

Start the Align application by clicking the 'Start' button in the Windows Taskbar and selecting Programs > 
Cary Eclipse > Align. 

Step 2 

Select the Cary Tab 

Step 3 

In the Instrument Parameters group, set the excitation wavelength to 0 nm (white light) by enabling the Zero 
Order check box. 

Step 4 

Click 'Apply'. (the green power indicator on the instrument should start flashing to indicate that the instrument 
is active.) 

Step 5 

Place a cell in the Water Thermostatted Cell Holder.

Note 
The pitch adjustment screw requires a hex key.

Note 
To lower the cuvette you will have to push the cuvette down because of the tension created by the cell 
holder.
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Step 6 

Select the Graph Tab and adjust the pitch screw on the cell holder to find the maximum intensity. 

Setting the temperature 
See the PCB-150 instructions for how to set the temperature. 

Operation 
To use the Water Thermostatted Cell Holder:  

Step 1  

Place a cell in the Water Thermostatted Cell Holder. 

Step 2 

Allow sufficient time for the cell and sample to warm to the specified temperature. This may take up to thirty 
minutes, depending on the nature of the solution. 

Step 3 

When all the components of the system are at the required temperature you may commence the measurement. 

Water 4 Position Multicell Holder Accessory 
Table of Contents 

Safety information
Introduction
Unpacking notes
Installation
Operation
Specifications
Maintenance and Cleaning

Safety information 
Before using this accessory, you must read the Safety Practices and Hazards in your Cary Eclipse Hardware 
Manual. 

A link to the Safety section is also available on the main page of the Cary Eclipse online Help and Videos CD. 

If the equipment is used in a manner not specified by the manufacturer, your safety may be at risk and the 
protection provided by the equipment may be impaired. 

Introduction 
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The Water-thermostatted 4 Position Multicell holder for the Cary Eclipse is an accessory that permits 
fluorescence measurements on up to four samples, while controlling the temperature and rate of stirring. 

Unpacking notes 
Make sure that all of the adhesive tape, plastic and cardboard is removed before operating the Peltier Multicell 
Holder. 

Installation 
Step 1 

Turn the Cary Eclipse instrument power off using the switch on the front right side of the instrument. You may 
leave the PC turned on. 

Step 2 

Slide the top panel of the sample compartment all the way back and completely remove the front panel by 
sliding it upwards. Ensure that the sample compartment is empty. 

Step 3 

Lift the Multicell Holder by the handle and hold the end of the hose in your other hand. Reset the accessory at 
the front of the sample compartment in order to allow access to the D-shaped, 25 pin port at the left side of the 
rear sample compartment wall. Connect the cable plug to the 25 pin port. 

Step 4 

Ensure that the fastening lever is in the open position (i.e., to the left). Hold the extended nose (the black metal 
flange which contains the stirring controls, see Figure 1) and align the two holes on the base of the accessory 
with the locating pins on the floor at the rear of the sample compartment. Move the fastening lever from left to 
right to lock the accessory into position. 
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Figure 1. Water 4 Position Multicell Holder accessory 

Step 5 

Ensure the two black locking latches at the back of the extended nose are pointing upwards (unlocked, see 
Figure 1). Position the extended nose into place by aligning its locating pins with the holes in the front of the 
sample compartment floor. Lock the extended nose into position by pushing the locking latches downwards. 

Step 6 

Slide the special door for thermostatted accessories (part number 99 101032 00) into position ensuring the 
electrical cable is tucked neatly into the sample compartment. 

Step 7 

Before the accessory can be thermostatted you need to connect the hoses to the Varian PCB-150 Circulating 
Water Bath or other appropriate circulating water bath. To do this, connect the two black hose ends to the bath 
inlet and outlet connections. Ensure the water bath has sufficient liquid for circulation before you turn the bath 
on. 

Step 8 

Connect the nine pin end of the communication cable to a free serial port at the rear of the PC (e.g., COM 1). 
Connect the other end of this cable to the plug at the rear of the PCB-150. 

Note 
The temperature probe holder (see Figure 1) that spans the two black posts on the multicell holder 
should be removed when inserting or removing cuvettes.
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Operation 
Operation of the accessory is through the Cary Eclipse software, with the exception of the stirrer control which 
is located on the front of the extended nose. 

To use the multicell holder: 

Step 1 

From the Setup dialog, select the Accessories tab to access the accessories page. (See Figure 2). 

Figure 2. Accessories tab showing a typical setup of the multicell holder accessory. 

Step 2 

Select the Multicell holder option and from the cell diagram, select the number of cells to use. 

Step 3 

To enable the temperature control (optional) 

a. If using the PCB-150 water bath:
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Step 4 

To display the temperature of other items in the Status Display window, select these items from the 
Temperature display option. Figure 2 shows a typical setup of the multicell water accessory. 

Step 5 

Click OK to exit the Setup window. 

Step 6 

Select Start to begin data collection. 

Specifications 
For environmental and power supply requirements, refer to your Cary Eclipse Hardware Operation manual 
(part number 85 101758 00). This product is suitable for indoor use only. 

Connections 

25-pin D-range connector on flying lead
2 water circulation tubes (connect to Varian PCB-150 Circulating Water Bath or other appropriate
circulating water bath)

Maintenance and Cleaning 

i. Select the Temperature Control check box.
ii. In the Device list, click the PCB-150 Water bath.
iii. In the Port list, click the appropriate COM port. This is the port you connected the
communication cable to at the back of the PC.
iv. Enter the required temperature and select the monitor. This monitor will only allow data
collection to begin when the temperature of the monitoring device is within ± 0.5°C of the
temperature specified.

b. If using a non-Varian water bath:
i Select the Temperature Control check box
ii In the Device list, click None.
iii. Enter the required temperature and select the monitor. This monitor will only allow data
collection to begin when the temperature of the monitoring device is within ± 0.5°C of the
temperature specified.

Weight
Packed 9.8 kg 21.6 lb
Unpacked 3.6 kg 7.9 lb
Dimensions (W x D x H)

Packed 765 x 360 x 325 
mm 30.1 x 14.2 x 12.8 in

Unpacked 180 x 320 x 180 
mm 7.1 x 12.6 x 7.1 in
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All cleaning should be done with a soft cloth. If necessary, this cloth can be dampened with water or a mild 
detergent to clean black painted surfaces. Do not use organic solvents or abrasive cleaning agents. 

Water Circulator (PCB-150) 
Table of Contents 

Introduction
Specifications
Getting started

Unpacking  
Installation
Setting the temperature
Operation
Maintenance

Introduction 
The PCB-150 (Peltier Controlled Cryobath, part number 00-100740-00) is a water circulator suitable for use 
with thermostatted cell holders such as the water-thermostatted single cell holder. 

Specifications 

Getting started 

Unpacking 

Unpack the accessory, and check that you have received the following: 

Water circulator unit
Power cord
Water tubes
Connectors.

Caution 

See also: 

Temperature range 20-60 °C
Temperature accuracy ± 0.1 °C
Reproducibility ± 0.05 °C
RS232C interface (communication protocol available 

on request to 
fluorescence@varianinc.com)
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Inspect all parts for damage during transit. Any damage should be reported immediately. Please refer to the 
accessory by model (PCB-150),  part number (79 100296 00) and serial number (printed on the side of the 
packing box).. 

Installation 
You will need the following to install the PCB-150 water circulator: 

A star headed screwdriver
Syringe or other device to fill the unit with water
De-ionized water
Thermostatted cell holder

To install the PCB-150 unit:  

Step 1 

Position the unit on the laboratory bench, next to your Cary Eclipse. 

Step 2  

 See how to perform steps 2 and 3.  

Unscrew the cap screw present in the ‘Water Fill’ inlet on the rear panel of the unit using a star head 
screwdriver.  

Step 3  

Using a syringe or a similar hand pump, inject approximately 50 mL of de-ionized water into the ‘Water Fill’ 
inlet.  

Step 4 

Replace the cap screw. 

Step 5 

 See how to perform step 5 

Connect the water tubes to the ‘Water In’ and ‘Water Out’ connectors on the rear panel of the unit. 

Step 6 

 See how to perform step 6 

Note
This section assumes you have already installed the thermostatted cell holder you will be using in the
sample compartment of your Cary Eclipse instrument, as per the instructions provided with the
accessory.

S

S

S
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Ensure that the voltage switch is set to the correct value for your location (120 or 230V), and connect the 
power cord to the unit and to the mains power supply. 

Step 7 

 See how to perform step 7 

Connect the free ends of the water tubes to the tubing leading from the Cary Eclipse sample compartment. 

Step 8 

Switch the unit on by setting the power button (on the front of the unit) to ‘I’. 

This will start the pump on the water circulator, and water will start circulating through the tubing and the cell 
holder.  

If the water level alarm comes on at this stage (the button lights up and an alarm sounds) you may need to top 
up the water level in the unit. Press the Water Level Alarm button to stop the alarm sounding. The light will 
remain on until the unit is filled with sufficient water. 

You should now set the required temperature. 

Setting the temperature 
The temperature setting for the PCB-150 is controlled from the software.  

To set the temperature:  

Step 1 

Click on the Setup button in the  

Step 2 

Click on the Accessories tab. 

S
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Figure 1 - The Accessories tab (highlighting temperature control) 

Step 3 

Click on the Multicell/Temperature button (the number of buttons in the Accessories tab will vary depending 
upon the application that is open). 

Step 4 

Check the Temperature control check box and select PCB-150 from the drop-down list. Make sure that the 
Com port that is shown in the Port drop-down list matches the port that you have the PCB-150 connected to, at 
the back of the computer. 

Step 5 

The temperature of the PCB-150 can be set by clicking on the up or the down arrow (as shown in Figure 1). 
The up and down arrows can be found next to the Temperature (°C) entry field. Alternatively, you can enter a 
temperature directly into the Temperature (°C) entry field. 

Step 6 

1 Accessories tab 2 Multicell/Temperature button
3 Temperature control group box 4 Temperature display group box
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Can can get a constant read out of the PCB-150 temperature - both the temperature it is set to and its actual 
temperature along with the temperature of up to four probes. This is controlled in the Temperature display 
group box (also shown in Figure 1). 

Operation 
To use the PCB-150 water circulator: 

Step 1  

Load your sample(s) in the cell holder as described in the instructions provided with the cell holder. 

Step 2 

Allow sufficient time for the cell(s) and solution(s) to warm to the specified temperature. This may take up to 
thirty minutes, depending on the nature of the solution(s). 

Step 3 

When all the components of the system are at the required temperature, close the sample compartment lid 
(optional for the Cary 50) and commence the measurement. 

You may monitor the temperature of the cell contents by using the Cary Temperature Probe accessory (part 
number 00 100408 00). Refer to the Temperature Probe manual for further details. 

Maintenance 
Regularly inspect the accessory to check for water leaks or degradation of the tubing. Replace when necessary. 

Part number 00 100775 00 

Table of Contents 
Safety information
Introduction
Unpacking notes
Specifications
Installation
Maintenance and Cleaning

Safety Information 
Before using this accessory, you must read the Safety Practices and Hazards section in your Cary Eclipse 
Hardware Manual. 

Automated  Polarizer 

Installation category 1
Pollution degree 2
Safety Class 3 (EN61010-1)
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A link to the Safety section can also be found on the main page of your instrument Help and Videos CD. 

If the equipment is used in a manner not specified by the manufacturer, your safety may be at risk. 

Introduction 
The Automated Polarization accessory for the Varian Cary Eclipse Fluorescence spectrophotometer provides a 
solution for polarization applications. Such measurements require exciting the sample with vertically polarized 
light and sequentially measuring the intensity of fluorescence through an analysing polarizer, oriented 
vertically and then horizontally. 

The accessory consists of four metal arms extending from a central wheel (Figure 1 (i)). Each arm is labeled as 
1, 2, 3 or 4 by holes etched into the wheel, just below the filter position, (Figure 3a). 

Two polarizers are mounted on the polarizer wheel (one polarizer per arm). Polarizers must be mounted in 
either positions 1 and 3 or positions 2 and 4. Solid black discs must be mounted in the remaining empty 
positions. This is to ensure the polarization wheel is balanced. 

Unpacking Notes 
Your acccessory is packed in a foam-lined cardboard box. Inside the box you will find a wooden case that 
contains 2 vertical and 2 horizontal polarizers (Figure 1 (ii)), a plastic bag containing 4 black plastic discs 
(Figure 1 (iv)), and 2 cardboard boxes, each containing a motorized wheel, into which the polarizers must be 
mounted. Check that you have received all of the items in the accessory kit by referring to the packaging list 
included with the shippment (Figure 1). 

Figure 1. i) & iii) Two automated polarizers  ii) Vertical and horizontal polarizers  iv) Four black discs 

Specifications 
For environmental and power supply requiremnents, refer to your instrument operating instructions. This 
product is suitable for indoor use only. 

Page 68 of 79Cary Eclipse accessory list

file://C:\Documents and Settings\cary\Local Settings\Temp\~hh15A7.htm



Installation 
Installation of the Automated Polarization accessory can be divided into three stages: 

1. Installing the polarizers and black discs in the two motorized polarizer wheels.

2. Installing the motorized wheels in the instrument.

3. Configuring the accessory using the software.

Installing the polarizers in the two automated polarizer accessories 

Step 1 

Using your fingers, carefully unscrew the knurled nut (Figure 2 (i)) in the centre of the plastic polarizer locking 
wheel (Figure 2 (ii)) and remove the locking wheel from the accessory. 

Figure 2. i) Knurled nut  ii) Polarizer locking wheel 

Step 2 

Polarizers now need to be placed in the accessories. There are four spaces, each labeled 1 to 4 by holes etched 
into the arms of the polarizer holder, (Figure 3a).
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Figure 3a. Polarizer positioning 

All four polarizer positions must be filled, using 2 polarizers and 2 black discs. By default the software will 
require you to place the polarizers in positions 1 and 3 in the polarizer holder. Each polarizer end is labeled 
with a "V" or "H" to identify if they are "vertical" or "horizontal" polarizers, (Figure 3b). Place the vertical 
polarizer in position 1 and the horizontal polarizer in position 3. The remaining two positions are filled with the 
black discs. 

Lay one of the motorized wheels horizontally so that the metal arm is facing upwards. Carefully place the 
polarizer marked "V", vertical, into position 1 and the horizontal, "H" polarizer into position 3 so that the tip of 
the polarizer that contains the label is pointing out from the centre of the arm. Place a black disc in each of the 
remaining two positions, (position 2 and 4) (Figure 3b). Repeat this for the second polarization accessory. 

Figure 3b. (i) & (iv) Fitted black discs (ii) Replaced Polarizer locking wheel (iii) & (v) Correctly fitted 

Note 
The polarizers must be mounted in the motorized holding wheel so that the "V" or "H" label is facing 
away from the metal mounting, arm facing towards the user, (Figure 3b (vi)).
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polarizers (vi) Polarizer labeling. In this example the accessory is fitted with two polarizers. They are placed 
with "Vertical" in position 1 and "Horizontal" in position 3, as shown. The solid black discs are placed in 
positions 2 and 4. 

Step 3 

Replace the plastic locking wheel(s) removed in Step 1, ensuring the polarizers remain positioned at the arm 
ends (Figure 3b). 

Replace the knurled nut(s) and rotate in a clockwise direction until finger tight. DO NOT over tighten. 

Installing the accessory in the instrument 

Step 1 

Turn the instrument off and remove any existing accessories from the sample compartment. 

Step 2 

Prepare to remove the outer cover of the instrument by flipping up the four black plastic clasps located at each 
side of the instrument. Two of these are labeled (iv) and (v) in Figure 4. 

Figure 4. (i) Circular cover plate (removed) (ii) Front black clasp (iii) Sample compartment front door 
removed (iv) Right hand side black plastic clasps. Here three of the five black plastic clasps have been flipped 
up in order to release the cover. The remaining two clasps are located in the same position as (iv) and (v) on 
the opposite side of the instrument. 

Step 3 

Remove the sample compartment front door and, using your thumb, lift the circular cover plate in the base of 
the instrument to expose  a black plastic clasp, (Figure 4 (ii)). Flip the clasp up. 

Step 4 

Carefully remove the instrument outer cover by lifting it upwards away from the instrument base. 

Step 5 
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With the instrument cover removed, the black metal inner covers are now visible (Figure 5). You will be able 
to see two plates, each secured by two black screws to the top of the instrument. Remove both the black plates 
by unscrewing the two black screws. These represent the positions for either excitation or emission 
measurement. An Automated Polarization accessory must be placed in both the excitation and emission 
chambers. The black plate labeled (i) in Figure 5 covers the emission chamber. The second black plate, closest 
to the front of the instrument, covers the excitation chamber. 

Figure 5. (i) Plate covering accessory chamber (emission) (ii) & (iii) Black screws (iv) Black thumb screw (v) 
Polarizer wheel orientation (vi) Accessory chamber (excitation) with cover removed (vii) & (viii) Alignment of 
the male and female D-plugs 

Installing an Automated Polarization accessory in the Excitation position 

To install an Automated Polarization accessory in the Excitation position, hold the accessory above the 
excitation chamber, located to the right of the sample compartment. 

Orientate the accessory so that male D-plug located on the accessory is aligned with the female D-plug (Figure 
5 (vii) & (viii)) inside the excitation chamber. 

Orientate the polarizer wheel as shown in Figure 5 (v) so the arms of the wheel form a diagonal cross. 

Carefully lower the accessory into the excitation chamber, raising the edge nearest the male D-plug on a 30° 
angle so the edge nearest the male D-plug on a 30° angle so that the opposite edge of the accessory touches the 
excitation chamber first (Figure 6). Once the edge is positioned, lower the male D-plug so that it is sitting on 
top of the female D-plug in the excitation chamber.
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Figure 6. The edge nearest the male D-plug is raised at a 30° angle with the opposite edge touching the 
excitation chamber. 

To secure the Automated Polarization accessory gently push down on top of the accessory base directly above 
the two D-plugs. Once the plugs mate, tighten the black thumbscrews. The accessory is now fitted in the 
excitation position. 

Installing an Automated Polarization accessory in the Emission Position 

To install an Automated Polarization accessory in the Emission position, hold the accessory above the emission 
chamber, (Figure 5 (i)). Orientate the accessory so the male D-plug located on the accessory is aligned with the 
female D-plug (Figure 5 (vii)) inside the emission chamber. 

Orientate the polarizer wheel as shown in Figure 5 (v) so the arms of the polarizer wheel form a diagonal cross.

Carefully lower both the edges of the accessory into the emission chamber ensuring the male and female D-
plugs are aligned. Once the accessory is sitting in the emission position chamber gently push down on top of 
the accessory base plate directly above the two D-plugs. Once the plugs mate, tighten the black thumbscrews. 
The accessory is now fitted in the emission position. 

Step 6 

Once the two Automated Polarization accessories are secured by tightening the two black thumbscrews you 
can replace the instrument cover. 

Step 7 

Once the instrument cover is replaced flip down the four black plastic clamps and the front black plastic clamp 
to secure the cover. Replace the circular cover. (This is the reverse of steps 4, 3 and 2 in order). 

Step 8 

Install the accessory you would like to use with your Cary Eclipse, for example the single cell holder or 
multicell holder. 
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Step 9 

If required, replace the sample compartment front door and close the sample compartment lid. 

Configuring the accessory using the software 

The Automated Polarization accessory is to be operated by the Thermal Application provided in the Cary 
Eclipse Bio Software. 

Step 1 

Open the Thermal Application 

Step 2 

Turn on the instrument 

Step 3 

From the main Thermal window, select the Setup button to display the Setup dialog. On the Cary tab, select Go 
To in the Collect Temperatures group. 

Note 
If the Automated Polarization accessories are removed it is important that the black cover plates be 
replaced and secured using the black screws.

Note 
An ADL is required to operate the Automated Polarization accessory in the Scan and Advanced Reads 
applications. The ADL can be downloaded from http://www.varianinc.com/osi/fluoro/adl/
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Figure 7. Software setup to allow the use of the automated polarizers, which are fitted in the excitation and 
emission monochromator chambers. 

On the Accessories page of the Setup dialog, select the Polarizer check box and select the Auto radio button. 
Under Accessory Setup, select the Excitation polarizer and set position 1 to "Vertical" and position 3 to 
"Horizontal" on the polarization position diagram-that is, set position 1 to "V" and position 3 to "H". Select the 
Emission polarizer and set position 1 to the "Vertical" ("V") position and set position 3 to the 
"Horizontal" ("H") position. 
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Figure 8. Configuring the Thermal Application for use with the Automated Polarizers in the excitation 
position. 

Step 4 

You are now ready to use the automated polarizer with the Thermal Application. For more information about 
the Thermal or other Cary software applications, click the 'Help' button. 

Accessory Removal 

If you need to remove the Automated Polarizer accessories from the instrument to add or change polarizers, 
grasp the accessory base on the right of the end of the long edge and lift gently. Once the D-plug is 
disconnected, the accessory may be carefully removed. 

If the accessories are not being re-inserted, be sure to replace the black metal covers over the polarization 
chambers, and tighten the locking screws. 

Maintenance and Cleaning 
Keep your accessory safely packed in its original box when not in use. Avoid unneccessary handling. If dust or 
fingerprints are observed on either surface of the polarizer, it should be cleaned using the following procedure. 

Remove the polarizer from the motorized mounting wheel.
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Moisten a piece of lint free tissue (such as a lens tissue) with 1-2 drops of spectroscopic grade methanol 
(NEVER drop solvent directly onto the polarizer). 

Gently wipe the upper surface of the polarizer clean (be careful not to use excessive force). 

Repeat the cleaning procedure on the lower surface using a fresh piece of lens tissue. 

Technical Assistance 
For technical assistance regarding this accessory, please contact fluorecence@varianinc.com 

Part number 00 10761 00 
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Safety Information 
Before using this accessory, you must read the Safety Practices and Hazards section in your Cary Eclipse 
Hardware Manual. 

A link to the Safety section can also be found on the main page of the Cary Eclipse online help system. 

If the equipment is used in a manner not specified, the protection provided by the equipment may be impaired. 

Introduction 
One of the most effective ways of studying the rotational motion of molecules in solution is by using 
fluorescence polarization. With the Manual Polarizer Accessory, you can calculate the polarization and 
anisotropy of a sample. 

Unpacking notes 

See also: 
Accessories 
Information on the Automated Polarizer 
The Manual Polarizer

Manual Polarizer 

Installation category 1
Pollution degree 2
Safety Class 3 (EN61010-1)
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Specifications 
This product is suitable for indoor use only. 

The polarizers are made of thin film polarizing material. 

Wavelength range 

275-750nm

Weight 

Dimensions (W x D x H) 

Installation 
Step 1 

Clear the sample compartment 

Step 2 

To fit the polarizer to the right-hand corner of the sample compartment, locate the accessory in the tow locating 
pin holes. 

Step 3 

Tighten the thumb screw to secure the polarizer frame. 

The Manual Polarizer Accessory comes complete with a wooden, high 
density foam lined box. Ensure that the Manual Polarizer Accessory is 
packed away in this box after each use so that it is not damaged.

Packed 1.03 kg (2.3 lb)
Unpacked 0.3 kg (0. 66lb)

Packed 200 x 115 x 113 mm (7.9 x 4.5 x 4.5 in)

Note 
The polarizers are delicate pieces of equipment and clearing the sample compartment is a safety 
precaution to ensure that the polarizers can be inserted easily.
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Polarizer Angles 

The two polarizers can be set to four possible angles. 

Vertical (V) 

The V located at the top of the polarizer indicates vertical or 0°. 

35° 

The first notch in a clockwise direction is 35°. 

55° 

The second notch in an anti-clockwise direction is 55° (magic angle 54.7°). 

Horizontal (H) 

The third notch in an anti-clockwise direction is 90° or horizontal. 

Operation 

For operational instructions, refer to the Cary Eclipse Online Help System. 

Maintenance and Cleaning 
All cleaning should be done with a soft cloth. If necessary, this cloth can be dampened with water or a mild 
detergent to clean black painted surfaces. Do not use organic solvents or abrasive cleaning agents. 

Note 
If you do come into contact with the silica lens, it can be cleaned with spec grade methanol and lens 
tissue.

See also: 
Accessories 
Information on the Manual Polarizer 
The Automated Polarizer
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Tips and Tricks 
The list below shows some useful techniques that can be used with the Cary Eclipse software. 

Right-click for menus  

If you right-click in the graphics or report area you can quickly access the appropriate menu commands for that 
area. 

Can't find a file you know that you stored? 

If you can't find a file in the directory that you stored it in it may be because the wrong file type is selected in the 
File, Open dialog box. Just type *.* in the file name field and press Enter. There are two file types in which data 
can be stored—Data files and Batch files. The Data file type stores only the traces that are visible when you 
select Save. The Batch file type stores the traces as well as the current method so that the method will be loaded 
when you retrieve the data in the batch file. 

Creating your own screen saver 

The Cary software installs a screen saver called VarianMM. You can use this screen saver to display a video or a 
message on the PC when it is not in use.  To use it as a screen saver follow these steps:  

1. Click the Windows Start button.
2. Select Settings, Control panel, Display.
3. Select the Settings tab.
4. Check that the Color Palette is set to High color (16 bit) or greater. Click Apply. Select "Apply settings without

restarting". Click OK to keep the settings.
5. Select the Screen saver tab.
6. Select VarianMM from the drop down list in the Screen Saver field.
7. Click Settings.
8. Right-click on the Play list area.
9. Select Add...

10. Find and select the .AVI or .MPG file it hat you would like to use as a screen saver. Click OK.
11. Select Double size from the drop down list in the Video Size field. Click OK.
12. Click Preview. The screen saver will run.
13. If you want to use this screen saver select OK.

Retrieving files to overlay 

The Batch vs Data file system also has implications for retrieving traces to overlay on the screen. If you want to 
overlay two traces which have been stored in different files one of them needs to be a Data file i.e they can't both 
be Batch files. As a Batch file loads a method as well as the traces you can only load one batch file at a time. If 
you have traces in a Batch file that you want to overlay on other traces in another batch file, open up one of the 
files and save the traces as a Data file. You will then be able to overlay the Data file's traces on the Batch file 
traces. 

Another trick: Start off with Batch file as the file type selected in the File, Open dialog box. Select the file to use. 
Then change the file type selection to Data. Press OK and the system will extract the Data files and load them 
without the Batch information. 

Note:
You can play any series of .AVI or .MPEG files using the VarianMM screen saver. 
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Previewing a report on screen before printing

After you have used the Recalculate button to generate a Report select the File, Print preview menu command to 
see how the report will look when it is printed. Use the arrow keys at the bottom to scroll through the pages. 

Cut and paste a report to a word processor for extra formatting control 

If you want to control where page breaks happen or you want the extra formatting capabilities that a word 
processor offers you can cut and paste a Cary Eclipse report into a word processor. First, use the Recalculate 
button to generate the report. Then right-click on the report area in the Cary Eclipse software. Choose 'Select all' 
from the menu. Right-click again and select 'Copy'. Switch to your word processor and paste. To get graphics in 
the report switch back to the Cary Eclipse software, right-click on the graphics area and select Copy graph from 
the menu. Switch to your word processor, position the cursor where you want the graph and select paste. 

Sending an electronic copy of the report to others 

If you want to send (by email for example) a report to someone else you have several options: 

You can use the File | Save Data As option to save a report file, and then send them this file. However, they 
will need to have the application that you used to generate the report files loaded on their PC. 

You can export the report to a Word processor as described above. 

You can print the report to an Acrobat .pdf file. The recipient only needs to have a copy of the Acrobat reader 
which can be downloaded for free from the web at www.adobe.com.  

To print to a .PDF file from an application you will need to purchase the Adobe Acrobat program. When you 
have Acrobat Acrobat installed you will be able to select Acrobat PDFWriter as the printer in the Print dialog. 
This will automatically create a .PDF file for you.  

Importing sample names with weight and volume information 

In the Advanced Reads and Concentration applications, you can import sample names into the application with 
weight and volume corrections already applied. Simply separate the sample name, volume and weight by a 
comma. (e.g. My Sample in Methanol, 1.0001, 101.) Duplicates and triplicate information can be similarly 
imported. See the online Help for Samples tab of either Advanced Reads and Concentration for more information.

Autoscaling graphs 

You can Autoscale the focused traces of multiple graph boxes simultaneously. To do this, first select the graph 
boxes you require by:  

holding down the Ctrl key and selecting each required graph box;  
holding down the Shift key and selecting any graph box to select all graph boxes; or,  
holding down the Shift key and selecting any graph box to select all graph boxes, then deselecting those not 
required by selecting them whilst holding down the Ctrl key.  

Once you have selected the graph boxes to be Autoscaled, select the appropriate Autoscale icon or Autoscale 
menu entry. 

Another trick: The three methods of selecting graph boxes mentioned above can also be used in other ways in 
addition to Autoscaling. For example, if you wanted to delete all but one graph box, you could hold down the Shift 
key and click on any graph to select all graph boxes, then hold down the Ctrl key and deselect the graph you wish 
to keep. Clicking on the Remove Graph toolbar icon (or Graph menu item) would delete all selected graph boxes. 

Keeping Graph Preferences settings 
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To store the Settings from the Graph Preferences dialog, such as axes color, and width, so that the system 
remembers these settings every time an application is opened you will need to do the following:  

1. Open the application of interest
2. Add a graph to the graphics area
3. Open the graph preferences dialog and setup all your graph settings
4. From the file menu select the Save Data As menu and save your settings as a batch file. For example

'Kinetics Default settings.fbkn'.
5. Create a shortcut on the desktop for this batch file.
6. Next time you want to open this application, rather than selecting the icon in the Cary Eclipse folder on the

desktop, select the shortcut (e.g. 'Kinetics Default settings.fbkn') icon instead and you will get your graph
preferences load automatically.

Setting up to use a specific brand of wellplate (wellplate) 

If you consistently use a specific brand of wellplate you may wish to save time by setting up a profile for that plate. 
Each brand has slightly different dimensions and well positions. To create a profile, refer to How to create or 
modify a wellplate format. Once you have created your own profile you will be able to use it in all appropriate Cary 
Eclipse applications. 

Note: 
This needs to be done separately for each application.
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Maintenance 

This Help deals with the maintenance procedures for the Cary Eclipse Fluorescence Instrument. You should refer 
to your PC and printer/plotter manuals for their maintenance practices. 

Any maintenance procedures not specifically mentioned here should be carried out only by Varian-trained, 
Varian-qualified or Varian-authorized service engineers.  

Cleaning your instrument  
How to install and remove the lamp module  
How to align the lamp module  
How to replace/check a fuse    
How to care for flowcells 

Warning This instrument contains electrical circuits, devices, and components operating at dangerous 
voltages. Contact with these circuits, devices and components can cause death, serious 
injury, or painful electrical shock. 

Operators and other unauthorized personnel must never remove the main cover. This must be 
opened only by Varian-trained, Varian-qualified, or Varian-approved service engineers. 

See also: 
Warning Symbols
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Cleaning your instrument 
Any spills in the sample compartment should be wiped up immediately as well as any deposits on the sample 
compartment windows. The exterior surfaces of the Cary Eclipse spectrophotometer should be kept clean. 

All cleaning should be done with a soft cloth. If necessary, this cloth can be dampened with water or a mild 
detergent. Do not use organic solvents or abrasive cleaning agents.
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How to care for flow cells 
General care of flow cells 

It is important to inspect the flow cell regularly and ensure that it is kept clean and free from bubbles. If the cell is 
not clean, or if air bubbles are allowed to remain in the cell, the analytical results may be wrong, and the zero 
position may drift.  

Cleaning instructions for flowcells 

Step 1 

Prepare a general wetting solution of Tween* 80 in water (5 to 10% v/v) and run this solution through the cell at 
regular intervals. If the routine sampler is not to be used for an extended period, this wetting solution should be 
pumped into the flowcell to keep all tubes and cell walls coated. The system should be thoroughly rinsed with 
distilled water immediately before use. 

Step 2 

If a stronger treatment is required, a solution of KOH in methanol can be used (about 1N KOH). Rinse the system 
briefly with this solution and flush thoroughly with distilled water. Do not leave the KOH/methanol in contact with 
the cell for long periods.  

Step 3 

To remove air bubbles, proceed as follows:  

a. Purge the cell completely with air several times.

b. Flush the cell thoroughly with Tween* 80 solution or KOH/methanol solution. Rinse thoroughly with distilled
water.

c. Flush the cell thoroughly as in step (a) before using the cell.

Tween* 80 is a registered Trademark of J.T. Baker Chemical Co. 
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How to install and remove the lamp module 
This section describes how to replace the lamp module on the Cary Eclipse. Before changing the lamp module, 
ALWAYS disconnect the Cary Eclipse from the  PC. 

Removing the lamp module | Installing a new lamp module 

Lamp module removal 

To remove the lamp module:  

Step 1 

Disconnect the Cary Eclipse from the mains power supply. 

    See how to perform steps 2 to 5. 

Step 2 

Undo the five clips - two on either side of the instrument, and the clip at the front of the instrument, under the 
circular plug. 

Step 3 

Remove the instrument cover. 

Step 4 

Facing the front of the Eclipse—turn the instrument onto its right side to give access to the base. 

Step 5 

On the base of the instrument, undo and remove the four thumb screws of the lamp module cover. 

    See how to perform steps 6 and 7. 

Warning 

When operating, the lamp module emits high intensity light which can damage eyes. To avoid 
eye damage, never operate the lamp module outside the instrument. 

The lamp module contains components operating at high voltages. To avoid electric shock, 
NEVER disassemble the lamp module.  

MIRRORS 
Even though the mirrors are guarded, be careful removing and installing the lamp module so 
they (and other instrument components) are not damaged.

 
Note: 
Make sure that the sample compartment is empty
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Step 6 

Through the front opening you will see three bolts, each marked with a black dot .  Undo the three bolts until 
they are free to move. 

Step 7 

Move the lamp module towards the front of the instrument to disengage two locating pins at the rear of the lamp 
module. 

    See how to perform steps 8 to 10. 

Step 8 

Partially withdraw the module through the opening in the base. 

Step 9 

Squeeze the clip on the plug and remove the plug from its socket 

Step 10 

Withdraw the lamp module completely  

Lamp module installation 

    See how to perform steps 1 to 3. 

Step 1 

Plug the connector of the new lamp module into the socket in the instrument. 

Step 2 

Fit the lamp module in the base of the Cary Eclipse, ensuring that the two guide pins are correctly located and 
that the wiring is kept clear of the other parts of the instrument. 

Step 3 

Tighten the three bolts through the front opening. 

    See how to perform step 4. 

Step 4 

Replace the bottom panel and tighten the four thumb screws.

 
Note: 
The lamp module must not be disassembled by an operator
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    See how to perform step 5. 

Step 5 

Return the instrument to its upright position, put the cover back on the instrument and latch all five clips. 

Step 6 

Replace the power cable at the rear. 

Step 7 

Turn the PC and the instrument back on. 

After replacing the lamp module you must align the source mirror. 
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How to replace/check a fuse 
When replacing fuses in the Cary Eclipse spectrophotometer, you must observe the following warning: 

The spectrophotometer contains two fuses that are located at the back of the instrument. 

To replace/check a fuse: 

Step 1 

Disconnect the fluorescence spectrophotometer from the power supply. 

Step 2 

Undo the fuse cover - which is located under the instrument's power cable at the rear of the instrument - by 
levering it open with a blade headed screw driver. 

Step 3 

Lift the cover whiling removing the red fuse housing. The red fuse housing contains the two fuses. 

Step 4 

Remove the damaged fuse(s) from and replace it with one that matches the specifications. 

Step 5 

Replace the red fuse housing back into the housing slot and close the fuse housing cover. 

If a fuse blows repeatedly, it may indicate other problems with the Cary Eclipse instrument. You should contact 
your local Varian sales office and arrange a service call. 

Warning For continued protection against the risk of fire, replace only with fuses of the specified type 
and current rating.

Note: 
For the specifications of replacement fuses, see the back of the instrument.

See also: 
Warning Symbols
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How to align the lamp module 

Lamp module alignment 

To align the lamp module:  

Step 1 

 See how to perform steps 1 and 2 

Open the Align application. Select Cary Eclipse then Align. 

Step 2 

Undo the five clips, two on either side of the instrument and the clip at the front of the instrument under the 
circular plug.  Remove the instrument cover. 

Step 3 

 See how to perform steps 3 to 6 

In the Align application, select the Cary tab and set up the instrument parameters as follows: 

Press Apply. 

Warning 

When operating, the lamp module emits high intensity light which can damage eyes. To 
avoid eye damage, never operate the lamp module outside the instrument. 

The lamp module contains components operating at high voltages. To avoid electric 
shock, NEVER disassemble the lamp module.  

Caution 

Mirrors: 
Even though the mirrors are guarded, be careful removing and installing the lamp module 
so they (and other instrument components) are not damaged. 

Note 
The instrument power must be on for the alignment procedure.

Note 
Emission parameters are not important for this procedure.

Ex. Wavelength (nm) 540
Ex. Slit (nm) 1.5
Ave. time (s) 0.1
PMT Voltage Medium
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Step 4 

Select the Graph tab, select the Reference button. 

Step 5 

Click on the Vertical Rescale  button to find the signal range. 

Step 6 

Click on the the Scale button  and enter an upper limit that is 20% higher than the current signal and a lower 
limit that is 20% lower than the current signal.  This will make the lamp module alignment easier when observing 
the graph. 

Step 7 

 See how to perform steps 7 to 11 

Figure 1 
Lamp module adjustment screws 

Adjust the bottom left screw (vertical adjustment) for maximum signal with the 5.5 mm hex driver supplied (you 
may need to adjust the y-axis scaling). 

Note 
The brass adjustment screws for vertical and horizontal adjustment are clearly marked.
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Step 8 

Adjust the top right screw (horizontal adjustment) for maximum signal with the 5.5 mm hex driver supplied (you 
may need to adjust the y-axis scaling). 

Figure 2 
1. Maximum signal level

Step 9 

Select the Lamp tab. 

Step 10 

Click on the Save conditions button to store the instrument parameters. 

Step 11 

Replace instrument cover and fasten the five clips. 
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How to Contact Varian 
If you need to contact your local Varian office or Dealer then select from the list below. Please note that 
these contact details are updated frequently, you can find the latest version on our website at: 
http://www.varianinc.com 

Varian Offices And Dealers—World Regions  

North America
Asia/Pacific
Europe
Middle East
Africa
Central and South America

Varian Optical Spectroscopy Instruments 

Your Cary instrument was designed and manufactured in Australia at Varian's plant in Melbourne. You 
can contact us about anything you like. Here are the contact details: 

Email: fluorescence@varianinc.com 

You can also contact the Fluorescence Product Manager on: 

Varian Offices and Dealers—Africa 

Note that the phone/fax numbers are in the format: + AA BB number, where the '+' refers to the 
international dialing code for your country, 'AA' is the country code and 'BB' is the area code (without 
any leading zeros). 

Egypt
Morocco
South Africa

fax: +61 3 9560 7950
telephone: +61 3 9560 7133
mail: Varian Australia 

679 Springvale Road 
Mulgrave, Victoria, 3170 
Australia

Egypt 
Gulf Scientific Corporation Contact: Mohammed El-Ashry
c/o Akhnaton Trading & Representation Phone: +20 2 5886609
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Varian Offices and Dealers—Asia and Pacific 

Note that the phone/fax numbers are in the format: + AA BB number, where the '+' refers to the 
international dialing code for your country, 'AA' is the country code and 'BB' is the area code (without 
any leading zeros). 

Australia and Head Office
Burma
China
Hong Kong
India

Cairo Fax:+ 20 2 5898643
Mobile: +20 12 3262 182
Email: gsc@intouch.com

Morocco 
Societe d'Exploitation des
Ets Boyer Phone: +212 2266415 
103, Bd. Moulay Yousef Fax: +212 2261149 
Casablanca Morocco Telex: 40723669 

Email: boyer@marocnet.net.ma
South Africa 
SMM Instruments (Pty) Ltd. Phone: +27 11 466 2200 
Kyalami Boulevard Telex: (9)451765 
Kyalami Park, Midrand Fax: +27 11 466 2220 
P.O. Box 11400 ( Mobile 081-0115370) 
Vorna Valley 1686 Email: smm@aztec.co.za 
Republic of South Africa

SMM Instruments Pty. Ltd
P.O. Box No. 30026 Phone: +27 31 295133 
Durban Mayville 4058 Telex: 6 20466 
Republic of South Africa Fax: +27 31 292263 

SMM Instruments Pty. Ltd
P.O. Box 175 Phone: +27 21 9453440 
Sanlamhof 7532 Telex: 526162 
Republic of South Africa Fax: +27 21 9453447 
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Indonesia
Japan
Korea
Malaysia
New Zealand
Pakistan
Philippines
Singapore
Sri Lanka
Taiwan
Thailand
Vietnam

Australia and Head Office  
Varian Australia Pty Ltd, 
679 Springvale Road Phone: + 61 1300 368 274
Mulgrave Victoria 3170 Fax: + 61 1300 658 274 
(P.O. Box 222, Clayton South MDC
Clayton South, VIC. 3169.) Factory enquires should be emailed to: 

webmaster@osi.varian.com
Australian sales enquires: sales@osi.varian.com
Australian service enquires: service@osi.varian.com

Varian Australia Pty Ltd
6/81 Frenchs Forest Road (East) Phone: + 61 1300 368 274
Frenchs Forest, N.S.W. 2086 Fax: + 61 1300 658 274

Varian Australia Pty Ltd
14/43 Lang Parade Phone: + 61 1300 368 274
Milton, Q'LD. 4064 Fax: + 61 1300 658 274

Varian Australia Pty Ltd
Unit 3, 63 Walters Drive Phone: + 61 1300 368 274
Herdsman Business Park Fax: + 61 1300 658 274
Osborne Park, W.A. 6017.

Varian Australia Pty Ltd
Unit 3, 422-424 Torrens Road Phone: + 61 1300 368 274
Kilkenny, S.A. 5009 Fax: + 61 1300 658 274
Burma  
U Tin Hla,
24 Tank Road
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Ywama, Insein
Yangon, Myanmar
China  
Varian Technologies China Limited.
Rm.1201, Jinyu Mansion
129A# Xuanwumen Xidajie, Phone+86 10 66081530, 66081531, 66081532, 

66081533
Xicheng District Fax+86 10 66411534
Beijing 100031, P.R.China Email: varianbj@varianinc.com.cn

Varian Technologies China Limited.
Rm 2005 Shanghai Square Tel +86-21-63756969, 63756930/31/32/33/34/35/36
138# Huaihai Zhong Road Fax+ 86-21-63756848
Shanghai 200021 Email: variansh@varianinc.com.cn

Varian Technologies China Limited.
Rm 3-122 City Square
206# North Nanjing St. Tel +86-24-23341248/49/50
Heping District Fax+ 86-24-23341095
Shenyang 110001, P.R.China Email: variansy@varianinc.com.cn
Hong Kong  
South East Chemicals & Instruments Ltd
1210 Chai Wan Industrial City Phas 1 Phone: + 852 2802 6333
60 Wing Tai Road Fax: + 852 2807 0542
Chai Wan email: sechk@netvigator.com
India  

Varian India Pvt Ltd
Second Floor, ICC Chambers Phone: +91  22  8570181 / 8570787 /  

8570788 / 8575790 / 8576791
Saki Vihar Road, Powai Fax: 91 22  8572183 / 8570792
Mumbai 400 072 Email: varian.mum@ 

rma.sprintrpg.ems.vsnl.net.in

Varian India Pvt Ltd Ph: 91 44 499 5828/499 2172/ 
499 2918

Varian House Fax: 91 44 499 3381
12 Bawa Road Email: varian.mad@ 

rma.sprintrpg.ems.vsnl.net.in
Alwarpet
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Chennai 600018

Varian India Pvt Ltd Phone: +91 11 554844
101 Competent House Fax: +91 11 554 8445
7, Nangal Raya Business Centre Email: varian.del@ 

rma.sprintrpg.ems.vsnl.net.in
New Delhi 110 046
Indonesia  
PT. Unitama Analitaka Perkasa Phone: +62 21 426 8478, 426 8479, 426 8480
Jl Garuda No. 31C Fax: +62 21 426 8481
Jakarta 10610
Japan  

Varian Technologies Japan Phone: +81 3 52321239  
Sumitomo Shibaura Building, 8F,  Telex: 26471  
4-16-36, Shibaura, Minato-Ku Fax: +81 3 52321264  
Tokyo 108, Japan  Email: hitoshi.arimatsu@ 

jp.varian.com  
(Branch office) 
Varian Technologies Japan   
Shin-osaka Doi Building   Phone: +81 6 305 6552 
7-5-25, Nishinakajima Fax: +81 6 305 6556  
Yodogawa-Ku, OSAKA 532, Japan.  Email:minoru.iizuka@ 

jp.varian.com  
Korea  
Varian Technologies Korea Ltd
Shinsa 2nd Bldg., 2F Phone: +82 2 345 22452 
966-5 Daechi Dong Fax: +82 2 34522451 
Kangnam Gu, Email: dykim@vkl.varian.com
Seoul, Korea. 135-280.

Varian Korea Ltd.
433-1 Mogok Dong Phone: +82 333 665 5171 
Songtan-Shi, Kyungki-Do Fax: +82 333 665 0117 
Korea. 459040 Telex: 32106 

Varian Technologies Korea Ltd.,
Daejeon office
Hanjin Officetel 1006 Phone: +82 42 823 4022 
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551-7 Bongmyoung Dong Fax: +82 42 825 8645 
Yusung-Ku,
Daejeon, Korea.

Varian Technologies Korea Ltd.
Sojun Bldg., SF876-6 Dal-Dong Phone: +82 522 654518/9 
Namgu, Ulsan Fax: +82 522 614469 
Jyungnam, Korea. 680-030
Malaysia  
Siber Hegner (M) Sdn Bhd
Unit F601, Phileo Damansara 1 Phone: +603 460 9501
No. 9 Jalan 16/11 off Jalan Damasara Fax: +603 758 4325
46350 Petaling Jaya
New Zealand  
A I Scientific
P.O.Box 35579 Phone: +64 9 478 1351
Browns Bay Fax: +64 9 478 1360
Auckland Mobile: +64 21 633 940
Unit J, 46 Constellation Drive Email: aissinz@ihug.co.nz
Mairangi Bay, Auckland
Pakistan  
Head Office Phone: +92 42 7320309, 7237392, 7323368
We Brothers Scientific Work Telex: 44518 
Rana Chambers 18 Lake Road Fax: +92 42 7235630 
Lahore 54000. Pakistan Email: brothers@ 

paknet1.ptc.pk 

We Brothers Scientific Works
2nd Floor, 65C Phone: +92 21 5899541, 5899542, 5888507
Commercial Area-A Telex: 24649 
Defence II Fax: +92 21 588 8507 
Karachi 75500. Pakistan.

We Brothers Scientific Works Phone: +92 51 277216, 277244
House No.6 Street No. 37 Fax: +92 51 277244
F-6 Near Farooqia Market
Islamabad, Pakistan.
Philippines  
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Molave Trading, Inc. Phone: +63 2 4110360 
P.O. Box No. 590 Telex: 7527495 
Greenhills Post Office Fax: +63 2 924 2094 
Greenhills, San Juan Email: aceroent@ 

mnl.sequel.net 
Metro Manila, Philippines.
Sri Lanka  
Analytical Instruments Put Ltd
2nd floor, Vogue building Phone: +941 575 025
528 Galle Road Fax: +941 573 945
Colombo e-mail: anains@dynanet.lk

Singapore  
SiberHegner (South-East-Asia) Private Limited Ph: +65 274 1222 
102E Pasir Panjang Road, #04-05/12 Fax: +65 273 1503 
Citilink Warehouse Complex, Singapore 118529 Email: kelvin.low@siberhegner.com.sg
Taiwan  
Varian Technologies Asia, Ltd. Phone: +886 22 698 9555
18F - 13, No. 79 Hsin Tai Wu Rd., Sec. 1., Fax: +886 22 698 9678
Hsi Chih, email: contact@ 

tw.varian.com 
Taipei Hsien,Taiwan., R.O.C. 
Thailand  
Thai Unique Co. Ltd. Phone: +66 2 282 9749 
80-82 Pracharthipatai Road Telex: 20775 
Bangkok 10200, Thailand Fax: +66 2 280 1788 

Email: thawatt@ 
mozart.inet.co.th 

Vietnam  
Siber Hegner Machinery Phone: + 84 4 8244 912 or : + 84 4 244 913 
Suite 3 26/3.28, Binh Minh Hotel Fax: + 84 4 8244915 
27 Ly Thai To St
Hanoi Vietnam

Siber Hegner Phone: +848 8223 079
Suite 103 City view building Fax: +848 8223 084
12 Mae Dinh Chi Street, Dist. 1
HO CHI MINH CITY
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Varian Offices and Dealers—Europe 
Note that the phone/fax numbers are in the format: + AA BB number, where the '+' refers to the 
international dialing code for your country, 'AA' is the country code and 'BB' is the area code (without 
any leading zeros).  

Austria
Belgium
Bulgaria
Croatia
Czech Republic
Denmark
Finland
France
Germany
Greece
Hungary
Iceland
Ireland
Italy

Netherlands
Norway
Poland
Portugal
Romania
Russia
Slovak Republic
Slovenija
Spain
Sweden
Switzerland
Turkey
United Kingdom
Yugoslavia

Austria 
Varian GesmbH, Phone: +43 1.699.9669 
Eisgrubengasse 2 Fax: +43 1 699 40 18
A-2334 Vosendorf, Austria Email: varian.vienna@at.varian.com

Belgium 
NV Varian Belgium SA Tel: +32 (0) 15-55 64 60
Mechelsesteenweg 362 Fax: +32(0) 15-55 61 86
2860 Sint-Katelijne-Waver Email: varian.benelux@be.varian.com

Bulgaria  
Spectratech Phone: + 35 92 962 4032
5, Rilski Ezera str Fax: + 35 92 962 4501
BG-1407 Sofia Email: spectratech@planetall.com
Bulgaria
Croatia 
AnAs - Analytical Instruments Phone: +385 1 6600 785
Skokov Prilaz 6/IX Fax: +385 1 6600 785
HR-10010 Zagreb, Croatia Mobile phone: +385 98 27 8851

Email: vladimir.svob@zg.tel.hr
Czech Republic  
Amedis spol. S.R.O. Phone: + 420 2 740 753
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Charkovska 14 Fax: + 420 2 748 191
CZ-10100 Praha 10 Email: amedis@mbox.vol.cz 

Denmark 
Analytical Instruments AS Phone: +45 44 35 02 02
Kirke Värlösevej 14 Fax: +45 44 47 10 32 
DK-3500 Värlöse Email: ai@analytical.dk
Denmark

Finland 
Tamro MedLab Oy. Phone: +358 2044 5120
P.O. Box 11 Fax: +358 2044 54970
FIN-01641 VANTAA
Finland

France 
Varian S.A., Phone: +33 16 986 38 38 
Quartier de Courtaboeuf, Fax: +33 16 928 2308 
B.P. No. 12 Email: sales@fr.varian.com
F-91941, Les Ulis, Cedex,Orsay

FRANCE.
Societe Varian Phone: +33 78 908212 
2 rue de Savoie, B.P. 607 Telex: 380898 
69804 Saint Priest, Cedex,.

Germany 
Varian Deutschland GmbH, Phone: + 49 6151 7030
Alsfelder Strasse 6, Postfach ll 14 35, Fax: +49 6151 703 237
D64289 Darmstadt Telex: 419429 

Email: Andreas.Stroh@de.varian.com
Greece 
FAMAR S.A., 
7, P. Marinopoulou Str Phone: +30 1 988 9200 
Alimos -17456 Telex: 224946 
Athens Fax: +30 1 988 9222 
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Hungary 
LAB-EX Phone: + 36 1 206 2455
Hadak utja 41, Fax: + 36 1 206 2451
H-1119 Budapest Email: labex@mail.matav.hu
P.O. Box 49, H-1509 Budapest 119
Iceland 
Austurbakki hf. Phone: +354 562 8411
P.O.Box 909 Fax: +354 562 8435
121 Reykjavik
ICELAND

Ireland 
JVA Analytical Ltd
Unit 1, Longmile Business Centre Phone: +353-1-4569822
Longmile Road Fax: +353-1-4569825
Dublin 12 E-mail: jva@iol.ie

Italy 
Varian S.p.A., Phone: +39 11 997 9111 
Via Fratelli Varian 54 Fax: +39 11 997 9344 
10040 Leini Telex: 310099 
Torino Italy Email: gianni.guida@it.varian.com 

Netherlands 
Varian Chrompack Benelux Phone: +31 0164 282800 
Analytical Instruments Fax: +31 0164 282828
Boerhaaveplein 7, 4624 VT Bergen op Zoom Email: varian.benelux@nl.varian.com
Postbus 250, 4600 AG Bergen op Zoom

Norway 
Holger Teknologi AS Phone: +47 23 16 94 60
Liakollveien 1 Fax: +47 22 61 10 30
Postboks 122 Holmlia E-mail: post@holger.no
N-1202 OSLO
Norway
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Poland 
Candela s-ka z.o.o.
52 Smiala Str. Phone: + 48 22 394 315 
PL-01-526 Warszawa Fax: + 48 22 393 577 
Poland email: candela@ikp.atm.com.pl 

Portugal  
Emílio de Azevedo Campos & Cª Ldª Phone: +351 22 9578670 
Rua da Senhora Da Penha, 110-114 Telex: 40422376 
44601-901 Senhora da Hora  Fax: +351 22 9578686 

Email: ecampos@eacampos.pt 

Romania 
Mecro System S.R.L.
Arinii Dornei str 2, 27/40 Phone: + 40 1 410 7303 
RO-77533 Bucharest 6 Fax: + 40 1 411 4565

email: mecrosys@dial.kappa.ro
Russia (CIS)   ;
Varian Associates Inc.    Phone: +7 095 9374280
19A, Khlebny per., 121019, Moscow Fax:    +7 095 9374281

Email: varian@glas.apc.org 
Slovenija 
Merel Phone: +386 62 229 7390
Ob Gozdu 25 Fax: +386 62 229 7391
SI-2352 Selnica ob Dravi Email: joze.golic@merel.si

Slovak Republic 
Amedis spol. S.R.O. Phone: + 421 7 5478 9976 (or 9977 or 9978)
Dubravska cesta 9 Fax: + 421 7 5478 9979
SK-84105 Bratislava email: amedis.ba@py.internet.sk
Spain 
Varian Iberica S.L., Phone: +34 91 472 7612 
Avda. Pedro Diez 25, Fax: +34 91 472 5001 
E-28019 Madrid Email: paloma.garcia@es.varian.com
Sweden 
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Varian A.B., Phone: +46 8 445 1620 
Englundavagen 9 Fax: +46 8 445 16 01 
P.O. Box 1099
Solna, Stockholm

Switzerland  
Varian AG         Phone: +41 41 749 88 44 
Chollerstrasse 38 Fax: +41 41 740 33 40 
Postfach  CH-6303, Zug

Turkey 
Terra Analysis and Measurement Phone: +90 312 466 0651 (PBX)
Equipment Trade Co., Inc., Fax: +90 312 466 0652 
Alacam Sokak No. 6/3 Email: terra@ada.net.tr
Cankaya
Ankara, 06690

Terra Analysis and Measurement Phone: +90 216 3103786 
Equipment Trade Co., Inc., Fax: +90 216 3104156 
Yetimhane Sokak 12/5
Altunizade 81190, Istanbul

United Kingdom  
Varian Associates Ltd., Phone: + 44 (0) 1932 898000
28, Manor Road, Fax: +44 (0) 1932 228769 
Walton-on-Thames, Telex: 928070 
Surrey KT 12 2Qf
England

Varian Associates Ltd. Phone: +44 1932 898 111 
The Genesis Centre, Telex: 629815 
Birchwood Science Park South Fax: +44 1925 827 944 
Warrington (Cheshire), England

Yugoslavia  
Global Technology Assistance Phone: +381 11 322 9989

Page 12 of 18How to contact Varian

file://C:\Documents and Settings\cary\Local Settings\Temp\~hhEE60.htm



Varian Offices and Dealers—Middle East 
Note that the phone/fax numbers are in the format: + AA BB number, where the '+' refers to the 
international dialing code for your country, 'AA' is the country code and 'BB' is the area code (without 
any leading zeros).  

Bahrain
Iran
Israel
Jordan
Kuwait
Saudi Arabia
Syria
United Arab Emirates

Beogradska 39/2 Fax: + 381 11 323 4430
YU-11000 Belgrade email: gta@eunet.yu
Republic of Yugoslavia

Bahrain 
Refer to listing for UAE
Iran 
Applied Science Co., Ltd
Office 4, Bldg. 26 Phone: +98 21 878 7710 
Didar Street, Africa Ave. Telex: 88222341 
Tehran - 15188, Fax: +98 21 888 8675 
(P.O. Box 15175-161) Email: asc@vessal.com
Israel 
Israel Scientific Instruments Phone: +972 3 923 2202 
32 Shacham Street Fax: +972 3 922 9750
Amargad Building Email: isirg@netvision.net.il 
Kiryat Matalon
Petah-Tikva 49170
P.O. Box 7790
Jordan 
The Arab Drug Store Phone: +962 6 553 8981
Amin Shocair PH. C. Fax: +962 6 553 2358
P.O. Box No. 208 Email: ads@ads.com.jo
Khalil Salem Street
Telal El Ali,
Amman  11118
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Varian Offices and Dealers—North America 
Note that the phone/fax numbers are in the format: + AA BB number, where the '+' refers to the 
international dialing code for your country, 'AA' is the country code and 'BB' is the area code (without 
any leading zeros).  

Canada
Mexico
Trinidad/Tobago
U.S.A.

Kuwait 
Gulf Scientific Corporation Phone: +965 481 7448/9 
c/o Al-Arfaj Engineering Co. Telex: 22841
P.O. Box No 391 Fax: +965 481 7442/3
Salmiyah 22004 Email: gsckwt@ncc.moc.kw
Saudi Arabia  
Gulf Scientific Corporation Phone: +966 3 858 1851
c/o Dar Establishment Fax: +966 3 858 1479
P.O. Box 5230 Email: gscsaudi@sol.net.sa
Dammam 31421
Syria 
Mimosa, 18, Eid Bldg. Phone: +963 11 333 3276 
Kasr Al-Dyaja Place Fax: +963 11 333 0512 
Abou Roumaneh
P.O. Box No. 5098,
Damascus
United Arab Emirates  
Gulf Scientific Corporation Phone: +971 4 815 720
P.O. Box 17010 Fax: +971 4 816 778
Jebel Ali Email: gsc@emirates.net.ae
Dubai Website: http://www.gsc2000.com

Telex: 48150 GSC JA

Canada  
Varian Canada Inc. Toll free phone:1 800 387 2216 
6705 Millcreek Dr, Unit 5 Phone:+1 905 819 8181 
Mississauga, L5N 5R9 Fax: +1 905 819 8348 
Ontario. Email: dan.williams@varianinc.com

Page 14 of 18How to contact Varian

   file://C:\Documents and Settings\cary\Local Settings\Temp\~hhEE60.htm



Varian Offices and Dealers—Central and South 
America 

Note that the phone/fax numbers are in the format: +AA BB number, where the '+' refers to the 
international dialing code for your country, 'AA' is the country code and 'BB' is the area code (without 
any leading zeros).  

Argentina
Bolivia
Brazil
Chile
Colombia
Costa Rica
Dominican Republic
Ecuador
Guatemala
Honduras
Nicaragua
Panama
Paraguay
Peru

Varian Canada Inc. Phone: +1 514 747- 4848 
6505 Trans-Canada Highway, Suite 100 Fax:+1 514 747- 5566 
St-Laurent, Québec H4T 1S3

Mexico 
Varian S.A. Phone:+52 5 525 4450 or + 52 5 533 5985 
Concepcion Beistegui Bo. 109 Telex:1774410 
Colonia, Del Valle Fax:+52 5 5145383 or + 52 5 523 9472 
Mexico , D.F. 03100
Trinidad/Tobago  
Chromaspec Limited, Phone:+1 809 674 5228 
No. 7, Ninth Avenue Fax:+1 809 674 5228 
Barataria chromasp@trinidad.net
U.S.A. 
Sales and Service
Varian Instruments Phone:1 800 926 3000 
2700 Mitchell Dr. Int'l ph: +1.925.939.2400
Walnut Creek, CA 94598 Int'l fax:+1.925.945.2102

Email: osiusa@varianinc.com.
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Venezuela

Argentina  
Varian Argentina LTD (from June 16th, 1997)
Sucursal Argentina, Phone: +54 11 4783 5306
Av.Ricardo Balbin 2316 Fax: +54 11 4786 5172
1428 Buenos Aires Email: varian@tournet.com.ar
Bolivia 
Arellano Limitada
Avenida 6 de Agosto No. 2240
Edificio Maria Cecilia Mezzanine No. 4 Phone: +591-2-352502
Casilla 1383 Fax: +591-2-352502
LA PAZ, BOLIVIA, email: arellano@latinwide.com

Brazil 
Varian Industria e Comercio Ltda., 
Avenida Dr.
Cardoso de Mello, 1644 Phone: +55 11 820 0444 
CEP 04548005 Telex: 55 11 30405 
SAO PAULO, S.P., BRAZIL Fax: +55 11 820 9350 or +55 11 820 3449 

Email: vlopes@amcham.com.br
Chile 
Merck Quimica Chilena Soc. Ltd. Phone: +56 2 340 0000 
Francisco De Paulo Taforo Fax: + 56 2 340 0199 
1981 Casilla 48D p.labarrera@merck.cl
Santiago, Chile

Colombia  
Walter Rothlisberger Co., LTDA Phone: +57 1 283 3132 
Apartado Aereo 06803 Telex: 43409 
BOGOTA, COLOMBIA Fax: +57 1 282 2872 
Calle 26-A No. 13-A-27
BOGOTA, COLOMBIA

Costa Rica  
Aurum S.A. Phone: + 506 226 9502  / 226 9402
San Francisco de Dos Ríos Fax: + 506 226-9963 
De Unisys 25 m. oeste, Email: aurumsa@sol.racsa.co.cr 
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Edificio esquinero, Planta Alta
San José, Costa Rica
Dominican Republic  
Improfarma S.A.
P.O. Box 434 Phone: +809 562 6381 
SANTO DOMINGO, DOMINICAN REPUBLIC. Fax: +809 565 85443 
(Avenida Lope de Vega # 62).

Ecuador 
I.T.C. Instrumentos Tecnicos Phone: +593 2 453178 
Cientificos Fax: +593 2 442051 
P.O. Box No. 17-08-8583 Sucursal 8
QUITO, ECUADOR

Guatemala  
ABJAY
Apartado Postal 810-A Phone: +502 2 347129 
GUATEMALA CITY, GUATEMALA Cable: ABJAY 
(Avenida Reforma 10-00, Zona 9, Fax: +502 2 320129 
Oficina 201,
GUATEMALA CITY, GUATEMALA).

Honduras  
Servicios Analiticos S. DE R.L
Apartado Postal # 30281 Phone: +504 266 165 
TONCONTIN Fax: +504 267116 
COMAYAGUELA, HONDURAS, C.A.
(Apartado Postal 30281 Toncontin
Comayaguela, HONDURAS, C.A.).

Nicaragua  
Robert Padilla
Apartado Postal 501 Phone: +505 2 74810 
Managua Nicaragua.

Panama 
Importadora DMD, S.A.
(Servicio y Equipo Medico Phone: +507 251247 or + 507 270537 
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Hospitalario S.A.) Telex: 2390 
Apartado 8556 Fax: +507 271246 
Panama 5, Republic of Panama.

Paraguay  
Eberhard Lewkowitz S.R.L. Phone: +595 21 444400/1/2 
Casilla De Correo 523 Telex: 378 PY 
ASUNCION, PARAGUAY Fax: +595 21 444437 
(Alberdi 444, Asuncion, Paraguay) 

Peru 
MERCK PERUANA S.A.,  
Av. Los Frutales nbr 220 Phone: +51 1 437 5440
LIMA 3, PERU. Fax +51 1 437 2955
Venezuela  
Varian Technologies C.A. (VTCA)
Multicentro Paseo El Parral, Piso 3 Phone: +58 41 257 608
Oficinas 3.1 Y 3.2 - El Parral Fax: + 58 41 257 608
Avenida Rio Orinoco email: manez@telcel.net.ve
Valencia, EDO. Carabobo
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Troubleshooting 
The links below display various lists of frequently asked questions from Cary Eclipse users. Hopefully the answer 
to your problem is here.  

Hardware Frequently Asked Questions  

Software Frequently Asked Questions  
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Troubleshooting—Hardware 
The links below display various lists of frequently asked questions from Cary users. Hopefully the answer to your 
problem is here.  

Hardware Frequently Asked Questions 

Instrument error messages  
Accessories  

If you cannot find the answer in any of the lists above, you still have plenty of options available to you to solve the 
problem.  

You can call your local Varian office or Dealer and arrange a service call.  
If you purchased the Telediagnostics capability from Varian then you can arrange for a Telediagnosis by 
Varian. You can find out more about the Telediagnostics package on our Website.  
You can visit Varian's website.  
You can contact the factory where your Cary instrument was made. 
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Instrument error messages 
Q. What should I do if I get an error message that doesn't recommend a course of action?

A. 1. Note the error number.
2. Close the Cary Eclipse software.
3. Turn the Cary Eclipse instrument off.
4. Reboot the computer.
5. Turn the Cary Eclipse instrument on.
6. Restart the Cary Eclipse software.

If the error reoccurs, you may need to contact Varian and notify us of the error number and the 
circumstances that it occurs under. Ideally, you should : 
Save the current method, data and report as a Batch file and send an email to 
fluorescence@varianinc.com which includes the following information: 

The error number  
Details of any accessories you may have installed in the instrument 
The steps you took to produce the error (if known)  

You should also attach a copy of the batch file to the email. 
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General 

Q. I cannot see an OK or Cancel button on a dialog so I cannot set up my method. What do I do?

A. You have your screen resolution set too low. Right-click on the Windows Desktop, select Properties and
select the Settings Tab. Change the Desktop Area setting to 800 x 600. Make sure that the Color Palette
is set to High colour (16 bit).

Q. I cannot find how to set the correct operating (abscissa) mode for my run. How do I set this?

A. Check that you are using the correct application. For example, time-based measurements are performed
in the various kinetics applications.

Q. How do I generate a report from an existing file?

A. Press the Recalculate button and make changes as required in the dialog that appears. When you have
finished, use the Print button or the Print command in the File menu to print your new report. You can
view the report on screen before printing by using the Print Preview command in the File menu.

Q. I want to export my data to a spreadsheet file. When I press Recalculate, the Autoconvert options
are grayed out. How do I do this?

A. You need to use the Save Data As option in the File menu. In the dialog that appears, set the Files of
type field to Spreadsheet ASCII (csv) and your data will be exported. You can also refer to ‘How to export
collected data’ in your application’s Help.

Q. I have saved my sample file, but now I cannot find it in the directory. What has happened?

A. You may have saved the file as a different file type, for example as a Data file rather than a Batch file. To
see all the files in the directory, select Open in the File menu and set the Files of type field to All Files.

Q. How do I include details of the method when I export data to a spreadsheet file?

A. Select the option Select for ASCII (csv) with Log in the Autoconvert group on the Reports tab of the Setup
dialog.

Q. The Cary Eclipse software is running slowly, how do I get it back to normal?

A. You may have too many traces available in the Trace Preferences dialog. Delete any unwanted traces,
and the speed of your application will increase. See ‘How to remove a trace from the trace list’  in your
application’s Help.

Q. I have typed in an ADL program, but it is not carried out when I press the Start button. How can I
apply my ADL program to a data collection?

A. You need to use the User Collect option that is available in some applications on the Cary tab of the
Setup dialog. Enter your ADL commands in the User Result line that appears when you activate User
Collect.

Q. I need to store information about a trace and print it in my report e.g. sample preparation details
such as pH or the reagents used. How do I do this?

A. Use the User Data Form feature. This can be accessed from the Graphics menu or from the toolbar.
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Starting a run 
Q. I have a ‘Connect’ button instead of a ‘Start’ button. What does this mean?

A. Only one Cary Eclipse application can communicate with the instrument at a time. You have another Cary
Eclipse application open that is online with the Cary Eclipse instrument. Provided that the other
application is not collecting data, you can press Connect to make this application go online and the Start
button appear.

Q. I only have one application running, yet I am still seeing a Connect button instead of a Start
button. Why?

A. The Cary Eclipse instrument is still initializing and the System Information application has control over it.
When the initialization has finished, your chosen application will have control and the Start button will
become active.

Q. I have set up a method and want to press Start, but the Start button is grayed out. Why is this?

A. You may be using a thermostattable accessory, and the Cary Eclipse is waiting for this to reach the
required temperature before it allows you to commence the run.

Q. Why do I sometimes get asked twice for a sample name when I press Start?

A. Storage on (Prompt at start) may be selected in the Autostore page of the Setup dialog. The first prompt
by the Cary is for the batch file name into which your data will be stored. The second prompt is for the
name of the trace within the batch file. This appears in the Trace Preferences dialog and in your report.
You cannot change this name once it is entered.

Q. I need to set up the Cary Eclipse to perform a simple calculation during the run. How do I do this?

A. You need to use the User Collect option that is available in most applications on the Cary page of the
Setup dialog. Enter your ADL commands in the User Result line that appears when you activate User
Collect.

Q. How do I store information about a trace and print it in my report e.g. sample preparation details
such as pH or the reagents used?

A. Use the User Data Form feature. This can be accessed from the Graphics menu or from the Graphics
toolbar.

Page 1 of 1Starting a run

mk:@MSITStore:C:\Varian\Cary%20Eclipse%20WinFLR\help\master.chm::/master/Trou...    



Graphics 

General 

Q. I accidentally deleted all my traces from my graph box by pressing Clear All Traces. Can I get
them back?

A. Yes, open the Trace Preferences dialog (via the Graph menu or the toolbar button) and then mark the
traces you require in your graph as Visible.

Q. I can find a Zoom Out button, but not a Zoom In button. How do I enlarge an area of the screen?

A. You need to use the Free Cursor (accessed from the Cursor Mode option in the Graph menu or by

selecting the  toolbar button) and then click and hold down the left mouse to create a box around the 
area of interest. See ‘How to zoom a graph’ in your application’s Help.

Q. Why does choosing to display my traces in different line formats have no effect?

A. The different line formats will only alternate when the Trace Width has been selected at 1 pixel. Style
cycling and Trace Widths are selected in the Graph Preferences dialog accessed from the Graph menu or

by selecting the    toolbar button.

Q. When I autoscale a graph with several traces in it some of the traces are drawn off the edge of the
graph box. How do I autoscale them all?

A. The autoscale function uses the currently focused trace to autoscale. Click on the trace which has the
most variation in terms of Y-scale and then use the autoscale function.

Q. It is frustrating to set up axes colors and widths etc in the Graph Preferences dialog box, only to
find that next time the instrument is turned on they are lost.
Is there a way to save these settings?

A. To store the Settings from the Graph Preferences dialog, such as axes color, and width, so that the
system remembers these settings every time an application is opened you will need to do the following:

1. Open the application of interest
2. Add a graph to the graphics area
3. Open the graph preferences dialog and setup all your graph settings
4. From the file menu select the Save Data As menu and save your settings as a batch file. For example

'Kinetics Default settings.bkn'.
5. Create a shortcut on the desktop for this batch file.
6. Next time you want to open this application, rather than selecting the icon in the Cary Eclipse folder on

the desktop, select the shortcut (e.g. 'Kinetics Default settings.bkn') icon instead and you will get your
graph preferences load automatically.

Note: This needs to be done separately for each application. 

Graph Labeling 
Q. Why can’t I add a label to my graph?

A. You may not have selected the graph box. You need to first click on the graph box you require to select it.
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A black line with eight ‘handles’ will appear around the box. There must also be at least one trace Visible 
in the graph box before you can add a label to it.

Q. How can I store information with my graph so I can print it every time I run a sample? i.e. I do not
want to add labels to every sample trace.

A. The solution is to add the sample information to the graphics background and then save this as a
graphics template. See ‘How to add a label to a graph’ in your application’s Help.

Q. When I use the peak label function every peak in my trace is labeled. I only want the larger peaks
to be tagged. How do I do this?

A. You need to increase the Peak Threshold setting. To do this for an existing graph, press the Recalculate
button and select the button Peak Information in the Reports tab. The Peak Labels dialog will appear.
Click in the Peak Threshold field and increase the value that appears there. Click OK to close the dialog
and then OK to start the recalculation. Your graph will now appear with different peaks labeled.

Q. After I have used the autoscale function some of my peak labels are off the screen. How do I see
them?

A. You need to manually rescale the Y axis of your graph. See ‘How to scale your graph manually’ in your
application’s Help.

Q. One of the labels is in the wrong spot. How do I move it?

A. Simply click the left mouse button on the label to select it (a box will appear around the label), then click
and hold down the left mouse button within the box. Move the mouse up or down or left or right to move
the label.

Q. I can’t select a label, why not?

A. Sometimes, a label may be hard to select as it is partially obscured by a picture or another label. In this
case, you may need to enlarge the area in question by zooming in. Alternatively, try right-clicking on the
label, especially if it is over a trace.

Q. I can find a Zoom Out button, but not a Zoom In button. How do I enlarge an area of the screen so I
can select a label?

A. You need to use the Free Cursor mode and then click and hold down the left mouse to create a box
around the area of interest. See ‘How to zoom a graph’ in your application’s Help.

Q. I need to store additional information about each trace in my batch file and print it in my report. Is
there some way to do this without using Add Label?

A. Yes, use the User Data Form feature. This can be accessed from the Graphics menu or from the toolbar.

Q. I would like to change the names of my sample traces. Can I do this?

A. No, the name you entered as the sample name when you collected the data is the permanent name.

Page 2 of 2Graphics

mk:@MSITStore:C:\Varian\Cary%20Eclipse%20WinFLR\help\master.chm::/master/Trou...    



File Handling 
Q. I have saved my sample file, but now I cannot find it in the directory. What has happened?

A. You may have saved the file as a different format, for example as a Data file rather than a Batch file. To
see all the files in the directory, select Open in the File menu and set the Files of Type field to All Files.

Q. What is the difference between a data file and a batch file?

A. A data file contains only collected traces. A batch file contains collected traces, the method by which the
traces were collected, a graphics template, and a report on the data.

Q. How can I overlay data from two batch files?

A. You need to open the first batch file, make all the traces Visible (in one or more graph boxes), and then
save the traces as a data file (*.Dxx) rather than a batch file (*.Bxx). Next, open the second batch file and
then open the data file you stored in the first step.

Q. I have multiple graph boxes with multiple traces in each. However, I only want to save the traces
in one graph box. How do I do this?

A. Use the Remove Graph button to delete all the other graph boxes from the screen, and then use the Save
Data As option to save the files in the remaining box. Make sure that the Save Only Focused Trace option
is not selected or you will only save the red trace.

Q. I use the same User Collect statement in a number of different methods. Can I store this?

A. Yes, you can store User Collect statements on the Edit tab of the System Information application.

Q. I need to store information about a trace and print it in my report e.g. sample preparation details
such as pH or the reagents used.

A. Yes, use the User Data Form feature. This can be accessed from the Graphics menu or from the toolbar.

Q. I had several traces on the screen and thought that I saved them all. When I retrieve the file I only
get one trace—where are the others?

A. When you saved the file, Save only focused trace at the bottom of the Save as dialog must have been
selected. Make sure that this option is not selected if you want to save all the displayed traces. You can
not retrieve the traces that you did not save.
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Exporting Data 
Q. I want to export my data to a spreadsheet file. When I press Recalculate, the Autoconvert options

are grayed out. How do I export the data?

A. You need to use the Save Data As option in the File menu. In the dialog that appears, set the Files of
Type field to Spreadsheet ASCII (csv) and your data will be exported. You can also refer to ‘How to
export collected data’ in your application’s Help.

Q. I want to export method data with my ASCII file when I collect the data. How do I do this?

A. Check the option Select for ASCII (csv) with Log in the Autoconvert group on the Reports tab before
pressing Start.

Q. Why don’t I see my graphics in the Report area?

A. The Report area normally only shows the text generated by the reporting options. If you want to view a
copy of your report with graphics before you print it, make sure that you have the Graph option selected in
the Reports tab, and then use the Print Preview option on the File menu. Alternatively you can use the
Copy Graph command to copy the Graphics area, and then use Edit report, then Paste, to Paste the
graph into the Report area.

Q. The Cary Eclipse software refuses to open a CSV file, in fact it stops working.

A. Check that the CSV file is using a period '.' to indicate a decimal point and not a comma ','. The numbers
in the XY pairs should be separated by a comma ','.
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Maths Calculator 
Q. My Maths Calculator just does not work properly. What is wrong with it?

A. Your number format in your Window's country settings may be causing problems. To check this, double-
click on the Regional Settings option in your Windows Control Panel. Click the Number tab. Make sure
that the Decimal Symbol field is set to '.' and the Digit Grouping Symbol is set to ' ' (space).

Q. I have created a calculation in the Maths Calculator and selected Apply, but my graph doesn’t
change. Why not?

A. You need to press the ‘=’ button to perform the calculations on your graph. The Apply button adds the
displayed mathematical expression in the Operation field to the calculation that will be performed on your
graph. (The list box at the top of the Maths window displays all the operations that will be performed.)

Q. I have accidentally selected Apply, can I undo this?

A. Yes, select the CE button. This undoes the last ‘Apply’.

Q. I want to delete the current mathematical expression in the Maths window and do a new
calculation. How do I do this?

A. Click the Clear (C) button.

Q. How do I subtract a trace in one data file from another trace in a different data file? I seem to only
be able to open one data file at a time.

A. If you can only open one data file at a time, it is likely that you are trying to open two different batch files.
You need to first save the two traces that you are trying to subtract as data files from the Save As Data
command in the File menu. Set the Files as Type option to Data (*.Dxx) (xx is the two-letter designation
used by your application.). Once both files are saved as data files you will be able to display them both on
screen. The subtraction procedure is described in "How to perform a spectral subtraction" in the maths
module.'.
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User Data Form 
Q. I entered lots of information into the User Data Form and saved the file. But when I re-open the

file, the information is gone. What have I done wrong?

A. You have forgotten to add a heading to the column(s) in the User Data Form. Entries in columns without a
heading are not saved. Use this form like a spreadsheet rather than like a note pad.
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Recalculation and Reports 
Q. I just want to change my report, do I still press the Recalculate button?

A. Yes, but if more than one tab appears in the dialog, just make changes on the Reports tab. When you
have finished, use the Print button or the Print command in the File menu to print your new report.

Q. I need to print additional information on each sample in my report. Is there some way to do this?

A. Yes, use the User Data Form feature. This can be accessed from the Graphics menu or from the toolbar.

Q. I can edit a report and change the data—surely this should not be possible?

A. If you do not want to allow any editing of reports, you need to set up GLP Administration of the
application. From the Home page of the Help, select Software applications > GLP Admin.

Q. How do I put page breaks in a report?

A. The easiest way is to use the Edit report option and cut and paste the report into a Word processor.

Q. Why is the option Edit Report in the Edit menu not available?

A. The application is under GLP Administration control, and editing of reports is not allowed.

Q. Why isn't the logo I selected included in my report?

A. If you are running the Cary Eclipse software under Windows NT you need to be logged on as an
Administrator in order to change  the  logo in the System information application. Once this is done you
can use the system under your normal login ID.

Q. I thought that I had generated a report but I can't see it on the screen, where is it?

A. Double-click on the graph area to display the report beneath the graph. You can double-click again to
remove the report.

Q. Why can't I see a picture of my graphs in the Reports section? I opted to include the graph in the
report.

A. The Reports section displays only text information, not graphics. Use the Print Preview option on the File
menu to view the whole report on screen before printing it.
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Glossary 
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Select the first letter of the word from the list above to jump to appropriate section of the glossary. If the term you 
are looking for starts with a digit or symbol, choose the '#' link. 

- A -

Absorbance (also Optical Density) 

The amount of light that is absorbed by a sample can be expressed as absorbance. 

A= - Log10 (I/Io) 

Absorptivity (also Extinction coefficient or Molar absorptivity) 

The proportionality factor in the Beer-Lambert law, which states that the absorbance of a solute is 
directly proportional to its concentration and the length of the light path through the cell, is called 
Extinction coefficient. 

Actinometry 

The measurement of intensity of radiant energy. Chemical actinometers are substances that respond to 
irradiation in some measurable way that can be related to the intensity of the irradiating source. For 
example, potassium ferrioxalate, when complexed with 1:10 phenanthroline, increases linearly in 
absorbance at 510nm as a function of irradiating time. 

Activation energy (Ea) 

the minimum energy needed to be overcome in a reaction to make it occur. 

Analyte 

An analyte is a component of a sample that has a measurable characteristic. Normally, an analyte is a 
chemical component, whose concentration is calculated by comparing a measured response (e.g. 
absorbance) with a calibrated response curve for the analyte. 

Arrhenius plot 

A graph to determine the activation energy of a system. The natural log of the rate constant, ln(k), is 
plotted against the reciprocal of the temperature in Kelvin, 1/T, with the slope being equal to the Ea/R, 
where R is the gas constant (8.314 JK-1mol-1). 

Assay 

The determination of the concentration of an analyte in a sample. 

Back to Top 

Page 1 of 14Glossary

 



- B -

Bioluminescence 

Refer to Chemiluminescence 

Back to Top 

- C -

Calibration 

Calibration is the determination of the instrument response (usually absorbance) to various 
concentrations of the analyte. A calibration is usually performed by measuring a series of standards 
(samples with known concentrations or path lengths) and then fitting a calibration curve. 

Calibration curve 

The calibration curve is the fitted model (e.g. a straight line) to the function results (e.g. absorbance at a 
specific wavelength) at different concentrations of the standard. The graph showing the fitted curve and 
the used data points is also called calibration curve. Note that the theoretically best calibration curve is 
a straight line, according to the Beer-Lambert law 

Chemiluminescence 

Chemiluminescence occurs when a chemical reaction produces an electronically excited species which 
emits a photon in order to reach the ground state. These sort of reactions can be encountered in 
biological systems; the effect is then known as bioluminescence. 

Color 

Color can be defined as the perception or subjective response by an observer to the objective stimulus 
of radiant energy in the visible range of the spectrum (400 nm to 700 nm). The perceived color depends 
on the absorptive and reflective properties of the object, the energy distribution of the source of 
illumination and the visual sensitivity of the observer. For the measurement of color, see Colorimetry.  

Colorimetry 

Colorimetry has two different meanings: 
i) It is the determination of the concentration of a colored solution by comparing it visually with the color
of a standard solution. By the use of a photometric system the comparison can improved and extended
to solutions that are apparently colorless.
ii) It is the characterization of the color by a spectrophotometric measurement and calculation of, for
example, tristimulus values (X, Y and Z) for the color.

Combinatorial chemistry 

A technique of creating vast number of compounds by reacting a set of starting chemicals in all possible 
combinations. 

Consecutive reactions 

these are reactions that proceed one after each in sequence, eg A ® B® C® D.
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Content uniformity 

Content uniformity is the uniformity of the active ingredient in a preparation. A certain number of units 
are individually assayed and the statistics of the results must meet criteria of an acceptance table. 

Correlation coefficient 

The correlation coefficient (R^2) is calculated for the calibration curve. The correlation coefficient is a 
common measure of the exactness of the fit; a perfect calibration curve has a value of 1. 

Back to Top 

- D -

Data interval 

The setting which fixes the interval between wavelength/ wavenumber readings when performing a 
wavelength or wavenumber scan. 

Derivative spectrum 

A derivative spectrum is obtained by the calculation of the first or higher derivatives of the absorbance 
with respect to the wavelength. The first derivative is the rate of change of absorbance against the 
wavelength. 

DNA melt 

Many biological molecules (proteins, DNA) are very large and have a native three-dimensional state. 
This three-dimensional state is maintained partly by the stereochemistry of chemical bonding and partly 
by weak intramolecular hydrogen bonding. On heating, the weak bonds can break and the molecule 
loses some or all of its three-dimensional structure. This is the process of thermal denaturation. 

Back to Top 

- E -

Emission 

The release of light from a fluorochrome when an electron falls from an excited state to a lower energy 
state of the molecule. 

Emission spectrum 

A plot of emitted light wavelength versus the relative intensity of emitted light. Essentially a plot of 
wavelength versus the probability that the emitted light will have the energy of that wavelength. 

Energy of a photon of light 

E = hc/l, where "h" is Planck's constant, "c" is the speed of light, and "l" is the wavelength of the light.
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Energy transfer 

The transfer of energy between molecules in an excited state. 

Enzyme activity 

In most preparations, the actual molar concentration of enzymes is unknown. Consequently, the 
amount of enzyme present can be expressed only in terms of its activity. To standardize the reporting of 
enzyme activities, the Commission on Enzymes of the International Union of Biochemistry has defined 
a standard unit: 

One International Unit (1 U) of enzyme is that amount which catalyzes the formation of 1 µmole of 
product per minute under defined conditions. 

The concentration of enzyme in an impure preparation can be expressed in terms of units/ml and the 
specific activity of the preparation as units/mg protein. As an enzyme is purified, the specific activity will 
increase to a limit (that of the pure enzyme). 

Enzyme assay 

Enzyme assays are an indirect method of analyzing one compound or group of compounds in a 
complex matrix. By careful selection of the enzyme, it will be known that whatever change occurs to the 
sample after the addition of the enzyme is due only to reaction of the specific compound or compounds. 
This selectivity is the basis of enzyme assays. 

Enzyme assays can be divided broadly into two types: rate assays and end-point assays. 

With rate assays all other parameters that have an influence on the rate are controlled at a constant 
level, the rate of reaction will then be directly proportional only to the substrate concentration. 

With end-point assays the conditions are selected so that the conversion of substrate to product is 
complete within a reasonable period of time (5 to 20 minutes). The difference between initial 
absorbance and final absorbance is directly proportional to the amount of substrate. 

Enzyme mechanisms 

Enzyme mechanistic studies use rate information obtained from kinetic measurements to determine the 
mechanism by which an enzymatic reaction proceeds. Mechanisms are determined by studying the 
effect of variations in substrate concentration and inhibitors on the initial rate of reaction. 

Excitation 

The absorption of light energy by a fluorochrome, during which an electron in the fluorochrome 
molecule is boosted to a higher energy level. 

Excitation spectrum 

A plot of incident-light wavelength versus the total fluorescence emitted. Essentially a plot of incident 
wavelength versus the probability of excitation. 

Excited state 

The electronic state reached by a molecule upon the absorption of energy. This state is usually more 
reactive than the ground state and so the molecule undergoes some process to get rid of this excess 
energy, such as a photochemical reaction. 

Exponential decay 
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A mathematical expression describing the decay of an unknown or variable, such as concentration, as 
a function of the exponent, e. 

Extinction coefficient (e) 

The amount of light absorbed. The molar extinction coefficient is the optical density of a one-molar 
solution of the compound through a one-cm light path. The value usually quoted is the molar extinction 
coefficient at the wavelength of maximum absorption. 

Back to Top 

- F -

First-order reaction 

A chemical process whose rate of reaction depends on the concentration of only one reactant raised to 
the power of one. 

Fluorescence 

The emission of light (or other electromagnetic radiation of longer wavelength) by a substance as a 
result of absorption of other radiation. The emission continues only as long as the stimulus producing it 
continues and persists with a half-life of less than about 10-8second 

Fluorochrome 

A fluorescent dye 

Back to Top 

- G -

Ground state 

A most stable state in which a molecule can exist. 

Back to Top 

- H -

Half-life 

The time required to affect 50% of the reactant 

Homogeneous 

A system that consists of a single phase, uniform mixture
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Intensity of light 

The flow of energy per unit area. Intensity is a function of the number of photons per unit area and their 
energy (energy of a photon is inversely proportional to wavelength). 

Irradiating light source 

The source used to irradiate a molecule to initiate a photochemical of photophysical process. 

Irradiating wavelength 

The wavelength at which a molecule is irradiated to produce a photochemical or photophysical process. 
This wavelength is specific to each molecule and depends on the absorption spectrum of the molecule. 

Isosbestic point 

The point in which absorbance vs wavelength spectra intersecting each other, produces no change in 
absorbance value. All spectra cross at this one point. 

Back to Top 

- J -

(empty) 

Back to Top 

- K -

Kinetics 

Kinetics is concerned with the rate at which chemical or physical processes occur. The goal of kinetic 
studies is usually to determine an equation which describes the rate in terms of component 
concentrations and, optionally, other factors such as temperature, surface area, etc.  

Back to Top 

- L -

Luminescence  
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An emission of light occurring at a temperature below that of incandescent bodies. Luminescence 
includes phosphorescence and fluorescence. Luminescence comes about through the ability of certain 
substances to absorb light of relatively high frequency and re-emit it in installments of discrete lower 
frequencies 

Back to Top 

- M -

Maximum 

Refers to the maximum peak in an absorbance spectrum. The derivative at this point equal to zero. 

Mechanism 

The process, or series of processes, leading to a chemical reaction. 

Melting curve 

A melting curve is the change in absorbance with temperature when a DNA or other protein sample 
melts or undergoes denaturation. 

Molar 

A unit of concentration which is defined as the amount of substance, measured in moles, in 1 litre of 
solution. 

Molar absorptivity 

see Absorptivity 

Mole 

The fundamental unit in chemistry used to defined the amount of a substance. 

Monochromatic light 

Light consisting of only one wavelength or color. 

Multicomponent analysis (also MCA) 

Multicomponent analysis is the quantification of more than one component in a sample by UV-Visible 
spectroscopy and a mathematical deconvolution of the spectrum.  

Back to Top 

- N -

Natural bandwidth 
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Natural bandwidth is the width in nm at the half height (50% peak height) of an absorbance peak of a 
sample. 

Noise 

The Noise level is an indication of how stable a reading is. It determines the precision of the 
measurement and the detection limit of the instrument. Noise is measured at a particular wavelength 
and absorbance level. It is specified either as the peak To-peak value. (Maximum deviation on either 
side of the Abs value) or the RMS (root mean square) which is approximately one fifth of the peak-to-
peak value. A poor signal to noise performance makes it very difficult to tell what the real Abs value is 
as it fluctuates. It introduces errors in to both quantitative and qualitative spectroscopy. 

Non-equilibrium 

The stage in which there is a continuous change in concentrations in a reacting system. 

Non-Measurement-Phase-Stepping 

Method of measurement used in the Cary instrument which allows measurement of the samples and 
reference beams at the same grating position (wavelength). 

Back to Top 
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Optical density 

see Absorbance. 

Order of reaction 

A classification of reactions according to their concentration relationships on the rate of reaction. 

Back to Top 
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Peak 

The maxima of an absorbance band are called peaks. Local peaks within an absorbance band are also 
called absorbance shoulders. 

Peltier effect 

The heating or cooling effect produced by passing an electric current through the junction of two 
dissimilar metals, the heating or cooling depending on the direction of the current. This is much more 
effective than using a water bath because the rate of change in temperature is faster and the stability is 
greater over a period of time. 

Phosphorescence 
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The emission of light, occurring from the lowest triplet excited state of a molecule, as the result of 
absorbing radiant energy. This is emission is on a slower time scale than fluorescence, in the order of 
minutes to milliseconds. 

Photochemical reaction 

A chemical reaction that results from the absorption of light. 

Photo-degradation 

The depletion of a molecule of compound as the result of the absorption of light. 

Photometric accuracy 

How accurately the instrument measures. Measurement of photometric accuracy has traditionally been 
measured by the following methods: Chemical standards, such as K2Cr2O7 (accuracy ±0.005 Abs) 
Calibrated neutral density filters (accuracy is within 0.5 - 1% of their stated values or 0.002-0.004Abs). 
The double aperture method is by far the most accurate method. It is sued by major national standards 
laboratories to measure the absolute accuracy of their reference spectrophotometers. This method has 
no limitations on SBW, wavelength or temperature and can yield precisions about 2 orders better than 
the previously mentioned uncertainties. The effects of poor photometric accuracy will be to produce 
incorrect results. 

Photometric linearity 

How accurately the instrument measures absorbance with increasing concentration. The measurement 
of photometric linearity is achieved by measuring the absorbance of successive K2Cr2O7 solutions of 
increasing concentrations, or by measuring the additive absorption of a series of filters. Poor 
photometric linearity will produce incorrect results. 

Photometric reproducibility 

The photometric reproducibility is a measure of the variability of the readings over multiple 
measurements of the same stable sample. 

Photomultiplier tube (PMT) 

A photoelectric cell that converts light into electric current and amplifies the current. 

Photon of light 

A quantum of light. This concept is based on Planck's quantum theory of light, which says that the 
energy of an oscillating system can have only discrete (quantized) values. These values are 
proportional to Planck's constant, h. 

Photophysical processes 

The events leading to the deactivation of a molecule in the excited state, with the exception of chemical 
reactions. 

Pseudo first-order 

A higher order reaction that has one or more reactants in excess, so that that the rate of the reaction 
now depends on the concentration of only one reactant. The reaction now mimics first-order kinetics.
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- Q -

Quantify 

see Assay. 

Quantum efficiency (quantum yield, f ) 

The efficiency at which a fluorochrome converts absorbed light to emitted light (the ratio of the number 
of photons emitted to the number of photons absorbed). 

Quantum yield 

A measure of the efficiency of a process. For a photochemical reaction, the quantum yield of 
photoproduct formation is the amount of product formed divided by the amount of light absorbed by the 
reactant. 

Back to Top 

- R -

Rate calculation 

The rate of a reaction is the velocity of at which a chemical or physical process occurs. Usually an 
equation has to be determined which describes the rate in terms of changes in component 
concentrations. The simplest equation is the one for a zero order reaction, also called a slope, where 
the rate of the reaction is independent of the concentration of the reactants. 

V = k 

where k is the rate constant. 

Another common reaction equation is the first order reaction, where the rate of the reaction is directly 
proportional to the concentration of the reactant: 

V = k × [A] 

The rate is calculated by a mathematical fit of the rate equation itself, or an integrated form of the 
equation, to the measured data. 

Rate constant 

The constant of proportionality in the expression relating the rate of a reaction to the concentration of 
the reactants. 

Rate law 

The empirical equation that describes the relationship between the concentration of reactants and the 
rate of a reaction. 
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Residual 

The residual of a data point in a calibration curve is the difference between the actual analyte value and 
the calculated value when the point is fitted to the calibration curve. 

Resolution 

The spectrophotometer's ability to distinguish between two absorbance bands which are close together. 

Back to Top 

- S -

Second-order reaction 

A chemical process whose rate of reaction depends on the concentration of two reactants. These 
reactants need not be different. 

Side-reactions 

Any unwanted reactions that occur during the investigation of a specific chemical process. 

Signal averaging time 

The amount of time the signal is averaged over for any particular data point. 

Smooth 

Smooth performs an n-point smoothing of a spectrum using Savitsky-Golay algorithm. For each data 
point in the spectrum, the calculation takes a set of data points (the filter length) around the current data 
point and fits a curve of a specified polynomial degree. The fitted curve is then used to calculate the 
new value for the current data point on the smoothed curve. 

Spectral band width (SBW) 

The physical slit width which is used to allow a narrow spectrum into the monochromator. SBW choice 
will affect the resolution of the spectrum obtained. 

Stability, long term 

The drift of the reading per unit time. Measurement is made by recording the Abs value of a sample at 
one wavelength for several hours. The specification indicates the maximum deviation from the correct 
Abs value per unit time. Poor stability introduces errors in the time base measurements. The instrument 
cannot distinguish between slope due to reaction or slope introduced by the instrument. baseline 
corrections can be invalid. 

Steady state assumption (SSA) 

The assumption that the change in concentration of a species with time is effectively zero. This occurs 
when the reagent is in large excess, such as in the case of pseudo first-order reactions. 

Stoichiometric relationship 

Page 11 of 14Glossary



The relationship between the reactants and products in terms of the amount of compound, usually in 
moles, needed for reaction. 

Stokes shift 

The difference in wavelength between the apex of the excitation spectrum (shorter wavelength, higher 
energy) and the apex of the emission spectrum (longer wavelength, lower energy).  

Stopped-flow kinetics 

The investigation into rapid reactions occurring on a sub-second time scale using the stopped-flow 
technique. This requires specialized apparatus and a spectrophotometer that can acquire data at a rate 
of milliseconds to tens-of-milliseconds. 

Stray Light 

The amount of light reaching the detector which is of a wavelength other than that selected. Also called 
Stray radiant energy (RE) . To measure stray light solutions are used which are non transmitting at the 
selected wavelength. (No light of the selected wavelength can reach the detector). Any observed 
transmittance is due only to stray light. The stray light level determines the maximum absorbance the 
instrument is able to measure and changes in band shape. Stray Light also causes deviations form the 
Beer-Lambert Law. 

Back to Top 
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Temperature probe 

A device used for measuring the temperature of the solution inside the cuvette. 

Thermal equilibration 

When the temperature of a solution remains constant to within the specifications of the heating 
accessory and measuring device. For the peltier systems, this is to within 0.05°C of the desired 
temperature. 

Thermal denaturation 

see DNA melt. 

Back to Top 

- U -

Uniform reaction 

A reaction involving the clean inter-conversion of reactants to products. Only one reaction is occurring, 
with no consecutive or side reactions taking place. 

Back to Top 
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- V -

Valley 

The minima of an absorbance band are called valleys.  

Back to Top 

- W -

Wavelength accuracy 

How close the indicated wavelength is to the actual wavelength. measurement is made by scanning the 
D2 emission lines which are known to occur at 485.0 nm and 656.1 nm and observing the wavelengths 
at which these lines actually appear. Poor wavelength accuracy can produce low quantitative results as 
the Abs measurement may be on the side of the peak instead of at the maximum Abs. 

Wavelength of light (l) 

The distance in nanometers between nodes in a wave of light. The wavelength is inversely proportional 
to the energy of the light.l µ 1/E. 

Wavelength repeatability 

The ability of the instrument to correctly return to the set wavelength repeatedly. Measurement is made 
by repeatedly scanning a filter peak. If the wavelength repeatability is good then the same trace should 
be obtained each time. Poor wavelength repeatability will result in errors in quantitative analysis due to 
wavelength shifts. 
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(empty) 
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- Y -

(empty) 
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Introduction 


Use the Scan application to scan samples across a wavelength or wavenumber range and manipulate the 
collected data. You can choose various display modes for the collected data depending on the type of sample you 
are measuring and the Cary Eclipse accessories that you are using. 


To access the Scan Application, click the Windows Start button, point to Programs, Cary Eclipse and then 
select Scan. 


Software controls 


The application comprises the following: 


Scan Application 


Instrument 
Status 
Readings 


The Instrument Status Readings, which display the Y and X values of the graph axes are 
displayed in the top left and right corners of the Scan Application window. 


Y value 
Displays the current Y value, usually intensity. This value is continually updated during a data 
collection. 


X value 
Displays the current X values for both excitation and emission. You can choose to display 
these values as either Angstroms, Wavelengths, Wavenumbers or Electron Volts. Select how 
the values will be displayed on the Cary page of the Setup dialog. 


Start and 
Stop 
buttons 


The Start and Stop buttons at the top of the Scan Application window are used to start and 
stop instrument analyses. These buttons can also be accessed from the Commands menu. 


Tell me more about the Start and Stop buttons


Graphics 
area 


The Graphics area refers to the plotting area of the application. It can contain traces of 
collected data, labels and pictures. In the Cary Eclipse system, the term 'graph' refers to the 
plotting area and is represented by a set of axes. The rectangular area defined by the axes is 
referred to as a graph box. 


To display or hide the Graphics area, select the Graphics command on the View menu. 
Double-clicking on the Graphics area enables you to toggle between half or full size display 
sizes. To manually size the Graphics area, place the mouse cursor over the border between 
the Graph and Report areas until the cursor changes to a double arrow ( ). Then hold down 
the mouse and drag it up or down to resize the areas.  


Tell me more about the Graphics area


Report area Use the Scan Report area to view the current report. The report may include the results of 
your data collection, the method parameters used to collect the results and any graphics you 
have included. You can select the information to include in your report in the Reports tab of 
the Setup dialog. 


To display or hide the Report area, select the Report command from the View menu. Double-
clicking on the Report area enables you to toggle between half or full size display sizes. To 
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manually size the Graphics area, place the mouse cursor over the border between the Graph 
and Report areas until the cursor changes to a double arrow ( ). Then hold down the mouse 
and drag it up or down to resize the areas. 


You can copy the generated report onto the Windows clipboard. To do this, highlight the 
report (or a relevant section of it) and press CTRL+C. You can then paste the report into a 
word processor such as Microsoft® Word. 


Hot Tip 
You can edit the Scan Report by pressing CTRL+R or selecting the Edit Report 
command from the Edit menu.


Commands The Scan Application window contains the following commands, all of which can also be 
accessed from the various menus in the application. 
   
Click on the buttons to view information about them: 


 
  


  


Hot Tip 
By becoming familiar with these commands (Setup, Zero, Pre-scan, etc.), you can 
remove these buttons from the Scan window. This will enlarge the Graphics and Report 
areas and make it easier to view results. To do this, clear the Buttons item in the View 
menu. 


Menus The Scan Application contains the following menus:  
File, Edit, View, Commands, Setup, Help


 
See also: 
Status Display 
Status Line 
Keyboard function keys 
Scan Home Page
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